Revise History

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
<th>Author's Initials</th>
<th>Description of Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>07/26/2011</td>
<td>WWW</td>
<td>General and technical edits; Add CIWS content.</td>
</tr>
</tbody>
</table>

for the
Reference Manual
for
TSD Version 8.9

Source of Information

Application Name to create document:
Adobe Framemaker

Application Version to create document:
Adobe Framemaker 9.0

File Name of Document:
T:\TFMSDOCS\TFMS Reference Manual\TFMS 8.9 RM\TFMS_8.9_RM.pdf

Source of materials not in this file
N/A
TFMS Reference Manual, Version 8.9 Changes

The following is a summary of changes in TFMS Version 8.9.

Weather Enhancements

Enhancements to the Weather commands and functions focus on Corridor Integrated Weather System (CIWS) changes and introduce or affect the following features:

- **Select Weather** - The Select Weather dialog box now provides two radio buttons labeled CIWS and Legacy. The CIWS radio button allows you to display the CIWS version of the Select Weather dialog box and to select CIWS weather products for display. The Legacy radio button allow you to display the Legacy version of the Select Weather dialog box and to select Legacy weather products.

**Select Weather - CIWS Version**

- The CIWS version of the Select Weather dialog box provides the following four basic weather products as options: Precipitation mosaic, Precipitation Forecast mosaic, Echo Tops mosaic, Echo Tops Forecast mosaic. A radio button is provided for each option. These four weather products are mutually exclusive. You can also choose to display none of these four basic weather products by selecting the None radio button.

- A CIWS legend is available for display with each of the CIWS Precipitation and Echo Tops mosaics. The mosaic you select determines the legend that displays. If you display a precipitation mosaic, the legend allows you to specify the minimum level of intensity to be displayed. If you display an echo tops mosaic, the legend allows you to specify the minimum altitude to be displayed.

- The CIWS Precipitation mosaic represents precipitation intensity measured as vertically integrated liquid water and is available in two modes, Standard and Winter mode. The Precipitation mosaic in Standard mode shows up to 6 levels of the current precipitation intensity. One data point in the mosaic represents the precipitation intensity over a 1 km square area. The Select Weather dialog box provides a check box for selecting the mosaic in Winter mode. The Precipitation mosaic in Winter mode provides greater detail for light intensity precipitation showing up to eight levels of liquid precipitation intensity and up to three levels of snow and rain/snow mix phases.

- The WSI San Juan NOWRAD (2km) mosaic is available for display with the Standard or Winter mode CIWS Precipitation mosaic.

- The CIWS Precipitation Forecast mosaic is available in Standard and Winter mode. The mosaic in Standard mode shows up to four levels of forecasted precipitation intensity. The Select Weather dialog box provides a check box for selecting the mosaic in Winter mode. The mosaic in Winter mode shows rain, snow, and rain/snow mix in three levels of forecasted intensity.

- The CIWS Echo Tops mosaic shows the maximum heights of precipitation echos from the NEXRAD radars in 5000 foot increments up to 50,000 feet. The mosaic
shows up to 10 levels of echo tops heights. The Select Weather dialog box provides a check box, Show Topped, for showing the regions where the highest elevation of the NEXRAD radar beam may be below the top of the corresponding storm. Topped areas are displayed in black.

- The CIWS Echo Tops Forecast mosaic shows up to four levels of forecasted heights of echo tops. The Select Weather dialog box provides a check box, Show Topped, for showing the regions where the highest elevation of the NEXRAD radar beam may be below the top of the corresponding storm.

- The CIWS Precipitation Forecast and Echo Tops Forecast products allow you to display their mosaics as an animated loop of forecast images for a selected time period or as a static image for a fixed time interval in the future. The Select Weather dialog box provides Options buttons for specifying the parameters for the animated looping of these forecasts.

- The CIWS PRECIP Forecast Options and the CIWS Echo Tops Forecast Options dialog boxes allow you to specify the time frame at which past images should start and forecast images should end and the time increment between images. The time frame can be from up to two hours in the past to two hours in the future.

- The CIWS Forecast Loop Control dialog box allows you to control the animated looping of forecast images. Using this dialog box you can start and stop animated looping as well as display a static image.

The CIWS version of the Select Weather dialog box provides checkboxes for the following additional weather overlays.

- CIWS calculates, in real time, the accuracy of its past 30, 60, and 120 minute Precipitation and Echo Tops forecasts for the region surrounding major airports. The Forecast Accuracy Scores option on the CIWS version of the Select Weather dialog box allows you to display the calculated accuracy scores associated with the mosaic you are displaying. You can choose to display an Accuracy Scores dialog box showing scores in table format for several airports or you can display scores in data blocks on the map. The Forecast Accuracy Scores section also allows you to display a scoring "region" for each selected airport.

- You can now display a Radar Coverage Map overlay showing the areas covered by the NEXRAD radars. The TSD displays the standard coverage areas as a medium gray overlay and the degraded (extended) coverage areas as a dark gray overlay. Only the standard radar coverage areas display if you are showing the Radar Coverage Map with an Echo Tops mosaic.

- You can now display a Satellite mosaic showing both the visible and infrared images from the GOES satellites in a single mosaic.

- You can now display a Forecast Contours overlay that shows the areas where CWIS predicts an existing storm will be 30, 60, and/or 120 minutes into the future. Forecast contours can be displayed over Precipitation or Echo Tops images. An Options button allows you to open the Forecast Contours Options dialog box. This
dialog box allows you to select a 30, 60, and/or 120 minute forecast contour for display on the TSD.

- You can now display a Verification Contours overlay showing the areas where CWIS predicted a storm would be located in the forecasts that were generated 30, 60, and/or 120 minutes prior to the currently displayed image. Verification contours can be displayed over past and current Precipitation or Echo Tops images and provide a way of visually verifying the accuracy of prior forecasts. An Options button allows you to open the Verification Contours Options dialog box. This dialog box allows you to specify whether you want to show verification contours for forecasts generated 30, 60, or 120 minutes ago.

- You can now display a Growth and Decay Trends overlay showing the areas where storms have grown or decayed in the past 15 to 18 minutes. Areas of growth display as orange cross hatching. Areas of decay display as solid navy blue regions.

- You can now display a Storm Motion overlay that shows the movement of Level 3+ intensity precipitation or echo tops at an altitude of 30,000 ft and above. This overlay uses arrows to show the direction of cell movement and indicates the speed of storm cells, in knots, by displaying numeric values at the tips of the arrows. An Options button allows you to open the Storm Motion Options dialog box. This dialog box allows you to select the colors for the direction and speed arrows and the leading edge and extrapolated position lines of a storm cell.

- You can now display a CIWS Echo Tops Tags overlay showing the measurements of cloud heights at 20,000 feet or higher. The values display in flight level format as hundreds of feet in 1000 foot increments (for example, 200, 210, 320). A Filters button allows you to open the Echo Tops Tags Options dialog box. The Echo Tops Tags Options dialog box allows you to specify the position of the tags relative to the echo tops and the minimum flight level to display the tags.

- The WSI Lightning product showing the most recent lightning strikes for CONUS is available on the CIWS version of the Select Weather dialog box. A color button allows you to open a color palette and change the overlay color.

- The WSI Jet Stream product showing areas where winds are strongest or greater than 70 knots is available on the CIWS version of the Select Weather dialog box. An Options button allows you to open the CIWS Jet Stream Options dialog box and specify the colors for the overlay.

- The Collaborative Convective Forecast Product (CCFP) overlay showing forecast areas where convective weather might occur is available on the CWIS version of the Select Weather dialog box. You can display a CCFP overlay for a 2, 4, or 6 hour forecast with CCFP data blocks and the CCFP legend.
Select Weather - Legacy Version

- The layout of the Legacy version of the Select Weather dialog box has been modified.
- The WSI NOWRAD (8km) product for CONUS, Canada, and San Juan is no longer available as an option.
- The Select Weather dialog box now provides checkboxes for toggling the following options on and off instead of Show and Hide radio buttons:
  - NOWRAD Legend
  - CCFP Legend
  - CCFP Data Blocks
- The Select Weather dialog box now provides checkboxes instead of On and Off radio buttons for toggling the following weather overlays on and off:
  - National Convective Weather Forecast (NCWF) overlay
  - Lightning
  - Tops
  - Jet Stream
- The Select Weather dialog box now provides an Options button for the Lightning overlay. Clicking this button opens the Lightning History dialog box.
- The Select Weather dialog box now provides an Options button for the Jet Stream overlay. Clicking this button opens the Legacy Jet Stream Options dialog box and allows you to select the colors for altitude, speed, and streamlines.

Replay

- The Replay command now allows you to select and replay both CIWS and Legacy weather data.
# Contents

**Introduction** ................................................................................................. Intro-1  
  - About the TFMS ................................................................................ Intro-1  
  - Traffic Situation Display ................................................................ Intro-1  
  - Reference Manual Conventions ................................................ Intro-5  

1. TFMS Basics ............................................................................................... 1-1  
   - Red Hat Linux Operating System ......................................................... 1-1  
   - Window Management - Red Hat Enterprise Linux ............................... 1-2  
   - Using the Workspace Switcher .............................................................. 1-5  
   - Getting Help ....................................................................................... 1-9  

2. TSD Basics ................................................................................................. 2-1  
   - Starting the TSD .................................................................................. 2-1  
   - Issuing TSD Commands ...................................................................... 2-1  
   - TSD Pull–Down Menus ...................................................................... 2-2  
   - Tear–Off Menus .................................................................................. 2-7  
   - Right–Click Menus ............................................................................. 2-7  
   - Semicolon Commands ...................................................................... 2-10  
   - TSD Dialog Boxes ............................................................................ 2-12  
   - Information and Query Boxes ............................................................. 2-17  
   - Quitting the TSD ............................................................................... 2-18  

3. TSD Menu Structures .................................................................................. 3-1  
   - Display Menu ..................................................................................... 3-2  
   - Maps Menu ......................................................................................... 3-3  
   - Flights Menu ...................................................................................... 3-4  
   - Alerts Menu ....................................................................................... 3-5  
   - Weather Menu ................................................................................... 3-7  
   - Reroute Menu .................................................................................... 3-8  
   - FEA/FCA Menu .................................................................................. 3-9  
   - Tools Menu ....................................................................................... 3-11
4. TSD Menu Command Directory ......................................... 4-1

Display Menu.............................................................................. 4-2
Minimize Command ................................................................. 4-4
Show/Hide Times Command ..................................................... 4-5
Adapt Commands ..................................................................... 4-7
  Recall Command ................................................................. 4-7
  Save Command .................................................................. 4-9
Delete Command ................................................................... 4-11
Initialize Command .............................................................. 4-13
Change Colors and Fonts Command ...................................... 4-14
  Semicolon Method ............................................................ 4-14
Redraw Command ................................................................. 4-17
Legend Command .................................................................... 4-18
RVSM Command ..................................................................... 4-19
Quit Command ......................................................................... 4-22

Maps Menu.................................................................................. 4-23
Move Zoom Command ............................................................. 4-25
Show Map Item Command ....................................................... 4-27
Range Rings Command ........................................................... 4-30
Overlays Command ................................................................. 4-35
Lat/Lon Point Command .......................................................... 4-39
Runway Layout Command ....................................................... 4-40
DME Command ........................................................................ 4-42
Projection Command .............................................................. 4-44

Flights Menu............................................................................... 4-46
Show/Hide Flights Command ................................................... 4-47
Select Flights Command ........................................................... 4-50
Show/Hide Flight Count Command .......................................... 4-59
Find Flight Command .............................................................. 4-60
Customize Command .............................................................. 4-63

Alerts Menu.................................................................................. 4-67
Show/Hide Alerts Command ....................................................... 4-69
Select Alerts Command ............................................................ 4-73
Examine Alerts Command ........................................................ 4-75
Map On and Map Off Parameters ........................................................ 4-76
Alarms Command .............................................................................. 4-79
Show NAS Monitor Command ............................................................. 4-82
Preferences Command ........................................................................ 4-134

Weather Menu......................................................................................... 4-136
  Show/Hide Weather Command .............................................................. 4-137
  Select Weather Command .................................................................. 4-138
    Select Weather Dialog Box - CIWS Version .................................. 4-140
    Select Weather Dialog Box - Legacy Version ................................ 4-181
  WX Report Command .......................................................................... 4-198
  RVR Report Command ...................................................................... 4-201

Reroute Menu: Normal Mode ............................................................. 4-203
  Show/Hide Reroutes Command .......................................................... 4-205
  Select Reroutes Command .................................................................. 4-209
  Monitor All Reroutes Command ......................................................... 4-228
  Create Reroute Command .................................................................. 4-282
  Preferences Command .......................................................................... 4-327

Reroute Menu: Reroute Impact Assessment ...................................... 4-333
  Introduction To RRIA ........................................................................ 4-335
  Previewing a Reroute ......................................................................... 4-339
    TSD In Preview Mode ...................................................................... 4-344
    Flight List Tab in Preview/Model Mode ........................................... 4-356
  Modeling a Reroute ........................................................................... 4-369
    Model Mode Indicators .................................................................. 4-370
    Reroute Analysis Tab ...................................................................... 4-374
    Model Reroute Cancellation ............................................................ 4-381
    Miles In Trail (MIT) Restrictions .................................................... 4-391
    Returning to Normal Mode Functioning ........................................ 4-417
  NAS Monitor in Model Mode .............................................................. 4-418
  NAS Monitor Bar Chart in Model Mode ............................................. 4-422
  Examine FEA/FCA in Model Mode ...................................................... 4-424
  FEA/FCA Bar Chart in Model Mode .................................................. 4-426
  Shared Sites Tab ................................................................................ 4-427
Select Reroutes Command ...................................................... 4-430

**FEA/FCA Menu** ........................................................................... 4-431
Show/Hide FEA/FCAs Command .............................................. 4-433
Select FEA/FCA Command ....................................................... 4-435
Create FEA/FCA Command .................................................... 4-442
Recall FEA/FCA File Command .............................................. 4-477
Examine FEA/FCA Command ............................................... 4-480
Preferences Command ............................................................ 4-500
Requesting Reports .............................................................. 4-513

**Tools Menu** ............................................................................. 4-515
Snapshot Commands ............................................................... 4-517
    Capture Command ............................................................. 4-517
    View Command ................................................................. 4-519
    Print Command ................................................................. 4-520
Network Utilities Command ................................................... 4-522
    Site Command................................................................. 4-522
    Reconnect Command ....................................................... 4-524
Replay Command ................................................................... 4-525
Database Commands ............................................................... 4-532
EDCT Commands ................................................................... 4-534
Command Line Command ...................................................... 4-538
Report Manager Command ..................................................... 4-542
Script Command ..................................................................... 4-544
Version Command .................................................................. 4-548

5. **TSD Semicolon Commands** ....................................................... 5-1

**Semicolon Commands: A-D** .................................................... 5-6
    ACTV .......................................................... 5-6
    Adapt ............................................................ 5-8
    Aircraft Color .................................................... 5-10
    Alarm ............................................................ 5-12
    Background Color .................................................... 5-16
    CAPL .......................................................... 5-18
    CAPS .......................................................... 5-20
Clear Weather ................................................................. 5-24
CXSD ................................................................. 5-25

**Semicolon Commands: E-G** .............................................. 5-28
EDCT AC OFF ................................................................. 5-28
EDCT AC ON ........................................................................ 5-30
EDCT Check ........................................................................ 5-32
EDCT CNX ........................................................................... 5-35
EDCT CTALIST ............................................................... 5-38
EDCT Hold .......................................................................... 5-41
EDCT List ........................................................................... 5-43
EDCT Log ........................................................................... 5-46
EDCT Purge ......................................................................... 5-49
EDCT Release ......................................................................... 5-51
EDCT SCS OFF ....................................................................... 5-53
EDCT SCS ON ....................................................................... 5-55
EDCT Show ........................................................................ 5-56
EDCT Slist .......................................................................... 5-60
EDCT Slots ........................................................................ 5-63
EDCT SUB OFF ...................................................................... 5-65
EDCT SUB ON ...................................................................... 5-67
EDCT Sub Print ..................................................................... 5-69
EDCT Sub Show .................................................................... 5-70
EDCT Unassigned Slots ...................................................... 5-72
EDCT Update ........................................................................ 5-74
Examine ............................................................................... 5-77
FPSD ................................................................................... 5-80
GAEL .................................................................................. 5-84
GAES .................................................................................. 5-86
GTP ACID ........................................................................... 5-89
GTP AIRP ............................................................................ 5-92

**Semicolon Commands: H-P** ............................................. 5-94
Help ..................................................................................... 5-94
INHB ................................................................................... 5-95
Jet Stream ............................................................................. 5-97
Lat/Lon Point ....................................................................... 5-99
Lead Lines ................................................................. 5-100
Legend ........................................................................ 5-104
Lightning ................................................................. 5-105
Move .......................................................................... 5-107
NOWRAD2 .............................................................. 5-109
Projection ................................................................. 5-111

Semicolon Commands: R .............................................. 5-113
Radar Tops ................................................................ 5-113
Range Rings ............................................................. 5-114
Range Rings Defaults .............................................. 5-117
Remove .................................................................... 5-119
Replay ...................................................................... 5-122
Request Area .......................................................... 5-128
Request ARRD ........................................................ 5-132
Request Count ........................................................ 5-137
Request FIXL .......................................................... 5-144
Request LIFP ............................................................ 5-148
Request List ............................................................. 5-151
Request Listo ........................................................... 5-161
Request VT ............................................................... 5-164
Restore .................................................................... 5-172
Restore Colors ......................................................... 5-175
Runway Layout ........................................................ 5-176
RVR Report ............................................................... 5-179

Semicolon Commands: S-Z ......................................... 5-181
Save Colors ............................................................. 5-181
Script ...................................................................... 5-182
Select Alerts ............................................................ 5-183
Select Arrivals ........................................................ 5-185
Select Arrivals & Departures .................................... 5-188
Select Data Blocks .................................................. 5-191
Select Departures .................................................... 5-195
Select Flight Group Color ....................................... 5-197
Select Flights .......................................................... 5-201
Select Flights & Color ............................................. 5-205
6. Quick Keys ................................................................. 6-1

7. Preference Sets ........................................................... 7-1
   Using the Preference Set Manager .............................. 7-1
   Restore Preference Set .............................................. 7-5

8. Traffic Management Shell .......................................... 8-1
   Invoking TM Shell ..................................................... 8-1
   TM Shell Commands .................................................. 8-1

9. TFMS Electronic Mail .................................................. 9-1
   Invoke EMail from the Gnome Toolbar ...................... 9-1
   EMail Basics ............................................................ 9-2

10. TFMS Autosend ........................................................ 10-1
    Invoking Autosend from the Gnome Toolbar .............. 10-1
    The Connection Status Indicator ............................ 10-1
    Autosend Basics .................................................... 10-2
    Autosend Pull–Down Menus ..................................... 10-3
    Using the Autosend Function .................................. 10-4
    Ending the Autosend Session ................................. 10-8

11. Route Manager .......................................................... 11-1
    Invoking Route Manager .......................................... 11-1
    Route Manager Commands ...................................... 11-1
    Display Preferred Routes ........................................ 11-5
    Display Major Traffic Flows over a Fix .................... 11-6
    Display Route Parsing Data ..................................... 11-7
    Display Expanded Preferred Routes ......................... 11-8
    Quit the Route Manager Function ......................... 11-9
Appendix A: Request Command Reference............................. A-1
  Data Source Alternatives ............................................. A-2
    OAG ........................................................................ A-2
    BASE ........................................................................ A-2
    FCATA ....................................................................... A-4
  Request Report Options ............................................ A-5
    Arrivals/Departures Option ...................................... A-5
    Multiple Locations .................................................. A-6
  Primary Place of Interest (PPI)—required .................. A-6
  Secondary Place of Interest (SPI)—optional ............... A-7
  Time Period Option .................................................... A-8
  Filter Options .......................................................... A-11
  Count Options .......................................................... A-15
  Column and Sort Options .......................................... A-17
  Remarks Keywords .................................................... A-21
  Equipment Types ....................................................... A-22
    Every ....................................................................... A-24
    Setlen .................................................................... A-24
  Secondary Requests ................................................... A-25
  Request Scripts ........................................................ A-26

Appendix B: Diagnostic Messages........................................B-1
  Sources of Help .......................................................... B-1
  TFMS Diagnostic Messages ......................................... B-1

Glossary ................................................................. Glossary-1

Index ........................................................................... 1-1
Introduction

About the TFMS

The Traffic Flow Management System (TFMS) is a system that the Federal Aviation Administration (FAA) uses in performing traffic flow management. The TFMS functions that you will be accessing directly are described in the following paragraphs.

- Traffic Situation Display (TSD)
- Flight Schedule Monitor (FSM)
- Traffic Management Shell (TM Shell)
- ETMS Electronic Mail (EMail)
- ETMS Autosend
- Route Manager (RMGR)

Traffic Situation Display

The Traffic Situation Display (TSD) allows the traffic manager to graphically display the current position of all instrument flight rule (IFR) flights that are in the air. The TSD also displays the current status of alerts and weather, as well as map overlays such as sectors, fixes, navaids, and airports.

In addition to its main function of displaying aircraft positions, the TSD gives the traffic manager access to the various TFMS databases. The following database servers can be accessed by traffic managers through the TSD:

- **List Server**
  Enables you to generate flight reports that list or count flights scheduled to arrive at, depart from, or traverse specific locations. You can also request fix loading reports, flight plan reports, arrival delay prediction reports, and time verification reports. (This function can also be accessed by TM Shell.)

- **Estimated Departure Clearance Time (EDCT) Server**
  Monitors all ground delay programs that have been implemented and allows you to review their status. (This function can also be accessed by TM Shell.)

- **Schedule Database (SDB) Server**
  Enables you to interact with the Schedule Database, which sends scheduled flight information to be included in today's data and sends lists of flights to and from specific airports for a requested time range.

- **Traffic Database (TDB)**
  Monitors air traffic demands in real time for a large number of National Airspace System (NAS) elements (airports, fixes, and sectors). Periodically generates air traffic reports to support Monitor/Alert features in the Traffic Situation Display (TSD).
• **Delay Advisor GTP Commands**
  Provide access to the Ground Time Predictor (GTP), a system that predicts flight departures based on historical data.

**Flight Schedule Monitor**

Flight Schedule Monitor (FSM) is used in the FAA’s Collaborative Decision Making (CDM) Ground Delay Program Enhancements effort. FSM displays a current picture of air traffic demand at airports to keep traffic flowing as smoothly as possible.

**Traffic Management Shell**

The Traffic Management Shell program (TM Shell) is a tool that allows you to issue many of the non-graphical commands available in the TSD without invoking the TSD. This includes access to the List Server and EDCT functions. The TM Shell also provides other commands that are not available through the TSD.

**ETMS Electronic Mail**

ETMS Electronic Mail (EMail) allows you to construct and send advisories or general messages to addresses on the National Airspace Data Interchange Network (NADIN) and Aeronautical Radio Inc. (ARINC) Network or to another TFMS workstation. You may build a message by entering text or by retrieving previous messages and reports.

**ETMS Autosend**

ETMS Autosend automatically constructs the advisories and data files needed to implement a ground delay program using Fuel Advisory Delay Table (FADT) reports. Constructed files include delay times as well as advisories to be sent through the National Airspace Data Interchange (NADIN) Network and Aeronautical Radio Inc. (ARINC) Network or to other TFMS workstations. Once you have created the advisory, you can send it through ETMS EMail.

**Route Manager**

The Route Manager (RMGR) is an ETMS tool that provides static information on airport/navaid/fix identifiers, preferred routes, major traffic flows, and parsed routes. This information includes the location name and identifier, location latitude/longitude, geographic location, and Air Route Traffic Control Centers (ARTCCs).

**Organization of this Manual**

Volume I of the TFMS Reference Manual consists of a Table of Contents, 13 chapters, appendixes, a glossary, and an index. The TSD accounts for the bulk of this volume. Five chapters are devoted to the TSD, including the two large chapters: TSD Menu Commands (Chapter 4) and TSD Semicolon Commands (Chapter 5).

• **Chapter 1: TFMS Basics.** This chapter starts with an introduction for beginners to the Linux workstations; next it describes how to get started with the TFMS software, including instructions for using the Help menu.
• **Chapter 2: TSD Basics.** This chapter describes generally how to use TSD commands.

• **Chapter 3: TSD Menu Structures.** This chapter lists the names of all TSD commands arranged by function.

• **Chapter 4: TSD Menu Command Directory.** This is a complete description of all TSD menus.
  - Display Menu
  - Maps Menu
  - Flights Menu
  - Alerts Menu
  - Weather Menu
  - Reroute Menu: Normal Mode
  - Reroute Menu: Reroute Impact Assessment
  - FEA/FCA Menu
  - Tools Menu

• **Chapter 5: TSD Semicolon Commands.** This is a complete description of all TSD semicolon commands, organized alphabetically.

• **Chapter 6: Quick Keys.** This is a complete listing of all TSD quick key commands.

• **Chapter 7: Preference Sets.** This chapter describes the use of preference sets, which provide an automated way to save and restore your current TSD workstation setups.

• **Chapter 8: Traffic Management Shell.** This chapter describes how to use the TM Shell program to request and review flight reports, issue EDCT commands, and perform other traffic management functions that do not require graphic displays.

• **Chapter 9: ETMS Electronic Mail.** This chapter describes how to use the EMail program to construct and send advisories or general messages.

• **Chapter 10: ETMS Autosend.** This chapter describes how to use the Autosend program to automatically construct the advisories and data files needed to implement a ground delay program using FADT reports.

• **Chapter 11: Route Manager.** This chapter describes how to use the ETMS Route Manager (RMGR) tool to provide static information on airport/navaid/fix identifiers, preferred routes, major traffic flows, and parsed routes.
The Appendixes

• **Appendix A: Request Command Reference.** This appendix contains an overview of the Request commands, and it describes options that are common to several or all of the Request commands, which can be invoked through the TSD or TM Shell.

• **Appendix B: Diagnostic Messages.** This appendix includes a list of all diagnostic messages that may appear while using the TSD. Diagnostic messages for other ETMS user functions are not listed in this edition.
Reference Manual Conventions

The following conventions are used in this manual.

Procedures

Step-by-step procedures are used when necessary to explain how to perform a specific task. Much procedural information is contained in tables explaining the various TSD dialog boxes.

TSD Menu Command Summary Boxes

Each TSD menu command (Chapter 4) and semicolon command (Chapter 5) description begins with a command summary box. Each type of summary box is shown in the following illustrations.

<table>
<thead>
<tr>
<th>Command</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Show/Hide Flights Command</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Show Flights/Hide Flights</strong> command lets you toggle the flight icons on and off the TSD. Either Show or Hide Flights appears on the Flights menu, depending on whether flights are currently displayed.</td>
<td></td>
</tr>
<tr>
<td><strong>Command</strong></td>
<td><strong>Quick Key Method</strong></td>
</tr>
<tr>
<td>1. Pull down the Flights Menu by clicking <strong>Flights</strong> on the main menu or pressing &lt;Alt&gt; F.</td>
<td>F</td>
</tr>
<tr>
<td>2. Click <strong>Show/Hide Flights</strong> or press F.</td>
<td></td>
</tr>
<tr>
<td><strong>Semicolon Method</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>None</td>
</tr>
</tbody>
</table>
TSD Semicolon Command Summary Boxes

The semicolon commands are presented in alphabetical order in Chapter 5. Each of these also has a summary box, as shown in the following sample.

<table>
<thead>
<tr>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Help command displays a special help file showing quick reference information on the command or topic you have specified. The field is displayed in a window that covers your display.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Command Line Interface</th>
</tr>
</thead>
<tbody>
<tr>
<td>Press ; and enter your command using the following syntax:</td>
</tr>
</tbody>
</table>

For example: HELP REQ
Press <Enter>.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click Help on the main menu bar, or Press &lt;Alt&gt;-H or select Help in dialog boxes.</td>
<td>None</td>
</tr>
</tbody>
</table>

The instructions presented in these command summary boxes assume that you are familiar with the basic procedures for entering commands, including how to use menus, how to access the semicolon command line, and how quick keys and mnemonics function. These procedures are explained in Chapter 2: TSD Basics. Detailed information about each menu and semicolon command, including options, prompts, and explanations of command results, follows the command summary boxes in Chapter 4 and Chapter 5.

User Entry Format

Instructions within the summary box and within tables present specific text that you need to type exactly as it appears in the instructions. This text appears in bold, (e.g., Type A or D). As a rule, the text entry appears in upper case because that is how it appears on the display in the TSD.

When you are instructed to press a single key or key combination that does not result in text appearing on the display (such as to issue a quick key command), the key or key combination is represented by an illustration of the key as it appears on a standard keyboard. For example: Press B.
Text that you type in a semicolon command or in a dialog box appears in bold. For example:

![Command Line](image1)

Variables appear in italics. For example:

![Command Line](image2)

System-generated messages appear like this:

![Confirm Quit](image3)

**TSD Terminology**

- The term **select** refers to making a choice among a group of options or list of items by clicking the option or item. You select text by highlighting it.

- **Preselect** refers to placing the pointer on a map item, such as an airport or navaid, causing that item to become highlighted. If the label is not currently displayed, preselecting also displays the label of the highlighted item.

  **Note:** When an item is preselected, clicking the left button selects it. When selected, the item has a dotted circle around it.

- **Browsing** is the process of preselecting an item and clicking the right button to open a pop-up menu.

- **Mouse buttons** refer to the buttons on either a mouse or a trackball. These buttons serve several purposes on the TSD:
  - The left button selects an item from a menu or dialog box.
  - The middle button drags a window or a selected item to another location.
  - The right button opens a pop-up menu.
• Click refers to depressing and releasing a mouse or trackball button.
  - Unless otherwise stated, click implies the left mouse button.
  - An instruction stating that you should click a mouse button also applies to a trackball button.

• Press refers to pressing and releasing a key on the keyboard.

• Depress refers to pressing and holding down a mouse button.

• A dialog box is a window that allows you to enter information to instruct the TSD. It allows you to enter text and/or click buttons to make choices. The text entry fields and various types of buttons on the TSD dialog box are discussed in Chapter 2, TSD Basics.

• Focus is defined in two ways.
  - Window focus determines which window will accept user input from the keyboard.
  - Keyboard focus determines which component within the window gets keyboard input.

• A pointer is an arrow, hourglass icon, or watch icon whose position is controlled by a trackball or mouse.

• Cursor is used in two ways throughout this document.
  - It is a rectangular box used to indicate which item currently has keyboard focus.
  - It is the vertical bar in a text entry field that indicates where you should begin typing the text.

• Mnemonics are underlined letters on a menu. Pressing <Alt> and the mnemonic key displays a pull-down menu. Pressing the mnemonic key selects a menu item.

Updates to this Manual

When the operational version of the ETMS is updated, you will receive a compact disk that contains the new version of the Reference Manual, Volumes I and II. Also included on the compact disk are the online Help files for the TSD.

Related Documentation and Training Materials

In addition to this manual, the TFMS user documentation set includes the following documents:

TFMS Quick Reference Guide

The TFMS TSD Quick Reference Guide is designed for all TSD users. It identifies all quick key commands and lists the command syntax for semicolon commands. It includes Request command options and examples.
TFMS System Administration Manual
The TFMS System Administration Manual is designed for the person at each site responsible for keeping the TFMS configured and running properly, as well as for any experienced TFMS user. It includes technical background information on the hardware and software that comprise the TFMS as well as instructions for performing various configuration and maintenance tasks.

TFMS Functional Description
The TFMS Functional Description is an overview of the TFMS. This document describes in some detail the logical structure of the system. In particular, it includes sections which identify and explain the hardware configuration, the flow of data, and the various databases which contribute to the function of the system.
1. **TFMS Basics**

The TFMS software runs on a network of RedHat Linux, a version of UNIX. In addition to a Central Processing Unit (CPU), each node is equipped with a color display showing a pointer, a hand-operated pointer device (either a mouse or a trackball), and a keyboard. With these three components, you can perform TSD and other TFMS functions.

**Red Hat Linux Operating System**

The Linux operating system, like HP-UX, is another version of UNIX. At the bottom of the Linux screen displays the Gnome Bottom Edge Panel, which is used to launch applications. The Gnome Bottom Edge Panel gives you access to the TFMS functions, such as TSD, TM Shell, and Email.

A typical GNOME setup includes the Bottom Edge Panel. An example is shown below. Your System Administrator may set your default Bottom Edge Panel according to your local requirements, so your display may appear slightly different.

Clicking the **Red Hat** icon on the Gnome Bottom Edge Panel opens a menu from which you can select the TFMS folder. From TFMS, you can select the TSD and the other TFMS functions. You can also click the **TFMS** shortcut icon on the Bottom Edge Panel to open the TFMS menu.
Window Management - Red Hat Enterprise Linux

This section describes how to manage windows in the Red Hat Enterprise Linux environment using TSD examples. Four common ways of managing windows are:

- Minimizing a Window
- Resizing a Window
- Using Quick Keys
- Managing Workspaces

Window List

Any open window in GNOME is shown in the Window List on the Bottom Edge Panel. In the following example there are four open windows in the Window List - two Terminal windows, a TSD, and a NAS Monitor Control Panel. The TSD window has focus on the display screen so its button is shaded in the Window List.

![Window List Example]

You can toggle between open windows by clicking the appropriate application button on the Window List.

**Note:** The Window List shows open windows for the active workspace only. Workspaces are explained in the Managing Workspaces section.

Minimizing a Window

You can remove a window from the viewable screen without closing it by minimizing the window. For example, to minimize the TSD display click the minimize icon in the top right corner of the window as shown below.

![Minimize Icon]
The window is minimized in the Window List as shown below. Note that the name on the button appears in brackets when a window is minimized.

![Image of TSD minimized window]

To restore the TSD display, click the TSD button in the Window List.

**Note:** It is possible to hide the Bottom Edge Panel with the Autohide feature. If the Bottom Edge Panel is hidden and you minimize your TSD, the TSD button will not appear on the screen unless you mouse-over the bottom of the screen.

If the Autohide feature is turned on and you would like to turn it off:

1. Right-click in a blank area of the Bottom Edge Panel.
2. Select Properties from the right click menu.
3. The Panel Properties dialog box opens. On the Edge Panel tab remove the check in the Autohide checkbox by clicking it.
4. Click Close.

**Resizing Windows**

You can decrease or increase the size of a window provided that it is not maximized. Place the cursor on any corner or side of an active window and, while holding the left mouse button, drag the corner of the window in the direction you want to resize.

**Using Quick Keys**

Pressing `<Alt>` + `<Tab>` allows you to toggle focus between open windows. Pressing `<Alt>` + `<Tab>` displays a palette with all open applications as shown below.

![Image of application icons]

Pressing `<Alt>` + `<Tab>` toggles between the icons on the palette. Release `<Alt>` to bring an application into focus.
Managing Workspaces

To move a window to a new workspace, click the **Window Menu** button located in the top-left corner of any window.

The **Move to Workspace 1** option is grayed out because it is the current workspace. From the Window pull-down menu you can choose to move your current application to all workspaces or to any other individual workspace available on your workstation.

In the sample below the TSD was moved to workspace 2. The background of the current workspace and the window that has focus are highlighted on the Workspace Switcher. To move between workspaces, click a button on the Workspace Switcher.
As shown in the sample below, if you open the Window menu again, you see that Move to Workspace 2 is grayed out because it is now the current workspace.

Using the Workspace Switcher

The Gnome desktop allows for up to 32 workspaces on a workstation. Every workspace that you open on the desktop contains the same desktop background, the same panels, and the same menus. However, you can run different applications and open different windows in each workspace. To help manage your workspaces, you can use the Workspace Switcher.

To access the Workspace Switcher, do the following:

1. Right-click the bottom edge panel.
2. Select Add to Panel.
4. Select Workspace Switcher.
While you can display only one workspace at a time, the workspace switcher displays a visual representation of all workspaces that are running on the desktop. In the workspace switcher, the background of the current workspace is highlighted. To specify the number of workspaces you want to use on the Gnome desktop, use the Workspace Switcher Preferences dialog box.

**Workspace Switcher Preferences**

To set your preferences for the Workspace Switcher:

1. Right-click the **Workspace Switcher**.
2. From the right-click menu select **Preferences**.

   The Workspace Switcher Preferences dialog box opens as shown below.

![Workspace Switcher Preferences Dialog Box](image)

This dialog box allows you to show workspace names, show all workspaces or just the current workspace, and set the number and rows of workspaces.

3. Make the necessary changes and click **Close**.

**Workspace Switcher Content**

Click the checkbox next to **Show workspace names in the switcher** to display the names of the workspace in the Workspace Switcher.

Select one of the following options to determine which workspaces to display in the Workspace Switcher.

- **Show only the current workspace**
  Select this option to display only the current workspace in the Workspace Switcher.

- **Show all workspaces**
  Select this option to display all of the workspaces that are on your Gnome desktop in the Workspace Switcher. Use the Rows field to specify the number of rows to use to display the workspaces.
**Edit Workspace Names**

Use the Workspaces list box to edit the names of the workspaces on your desktop. To edit a workspace name, select the name, click again on the name to highlight it, and type the new name.

![Workspace Switcher Preferences](image)

**Number of Workspaces**

Use the Number of workspaces field to increase or decrease the number of workspaces in the Gnome session.

**Navigating Workspaces**

The background of the button that represents the current workspace is highlighted in the Workspace Switcher. To switch to another workspace, click on the button that represents the workspace. To return to your original workspace, click on the button that represents that workspace in the workspace switcher.

![Workspace Switcher](image)

In the example above, the workspace named TSD 1 is the current workspace. In the Workspace Switcher Preferences, the option to show workspace names is selected, the number of rows to display in the workspace switcher is set to 1, and the number of workspaces is set to 4.
Moving a Window from One Workspace to Another

To move a window to another workspace, click the **Window Menu** button located in the top-left corner of any window.

From the Window pull-down menu you can choose to move your current application to all workspaces or to any other individual workspace available on your workstation.
Getting Help

Invoking TSD Help

To access TSD help, open the TSD. Click Help on the TSD Help menu or press the F1 key to launch the Mozilla browser and open the TSD Help. You can also get specific help by clicking the Help button on an individual dialog box. This dialog box feature will be explained later in this document.

The following example shows the Mozilla browser open to the default TSD Help screen.

Using the TSD Help

Invoking the TSD Help

You can use any of the following methods to invoke the TSD Help:

- Click Help on the TSD Help menu.
- Press the F1 quick key while the focus is on the TSD window.
- Enter HELP on the Command Line.

The Mozilla browser opens to display the TSD Help.
Using Help
The TFMS Help contains a navigation pane and a topic window as shown above. The navigation pane, located on the left-hand side of the screen, allows you to navigate the help system. The topic window, located on the right-hand side of the screen, displays help topic content.

Navigation Pane
The navigation pane contains the following tabs:

- Contents Tab
- Index Tab
- Search Tab
- Glossary Tab

Contents Tab
To scroll through the table of contents for Help, click the Contents tab. The Contents tab displays books and topic pages that represent the categories of information in the TSD Help. When you click a closed book, it opens to display its content (sub-books and topic pages). When you click an open book, it closes. When you click on a topic page, that topic page displays in the topic window.

In the following example, clicking the Using Help book closes the book. Clicking the TSD Menus book and the Maps Menu book opens the Maps Menu book.
Index Tab

To scroll through or search the index, click the Index tab. Type in the search field to find a matching index term or scroll through the list of index terms. Clicking an index term displays its related topic(s). A help topic page will automatically open if there is only one topic related to the index term. If there is more than one related topic a pop-up menu will appear with a list of topics to choose from.

In the following example, EDCT HOLD was entered into the Index search field.

The index display automatically advances to the first entry in the index that matches EDCT HOLD. Clicking EDCT HOLD in the index opens the EDCT HOLD topic page in the topic window.
Search Tab

When you want to search for specific terms or phrases, click the Search tab. Type a search term in the search field and press the <Enter> key on your keyboard. A list of matching topics is generated. Click a topic title to open that topic.

In the following example GAEL was entered into the search field.

The search generated a list of topics related to GAEL. Clicking GAEL opened the GAEL help topic in the topic window.
**Glossary Tab**

For TSD terms and definitions click the **Glossary** tab. The glossary is split into two windows. Click a term in the Term window to view its definition in the Definition window.

In the following example **CAPS** is selected in the Term window and the definitions for CAPS is displayed in the Definition window.

---

**TSD Semicolon Command List**

The following is a list of all TSD commands that have a Command Line Interface:

- **ACTV** Request FBL
- **Adapt** Request IFP
- **Aircraft Color** Request List
- **Alarm** Request List
- **Background Color** Request VT
- **CAPL** Restore
- **CAPS** Restore Colors
Viewing Related Topics

To view information related to a particular help topic, click the Related Topics button at the bottom of a topic page. A related help topic page will automatically open if there is only one related topic. If there is more than one related help topic, a pop-up menu will appear with a list of related topics to choose from.

The following example shows the related topics pop-up menu for the Show/Hide Weather command.

Show/Hide Weather

The Show/Hide Weather command lets you toggle off and on the graphic overlays made with other weather commands. To remove all the weather overlays as if everything was turned off separately, use the Clear Weather Semicolon Command.

1. Pull down the Weather menu by clicking Weather on the main menu or press Ctrl+W.
2. Click Show Weather or Hide Weather or press W.

Note: The Show Weather command takes effect only if weather overlays have been selected in the Select Weather dialog box.
Getting Help from a TSD Dialog Box

As you work in the TSD, you can obtain information about dialog boxes by using the context-sensitive Help. Clicking the Help button on a dialog box opens the TSD help for the topic associated with that dialog box. The help topic explains how to use the fields and controls in that dialog box. The following example shows the Select Reroutes dialog box.

Clicking Help in the Select Reroutes dialog box will open the TSD Help to the Select Reroutes topic page.

Select Reroutes

This topic provides reference information about:

Using the Select Reroutes Dialog Box
Advisory (ADZ) Number
Reroute Information (info) Button
Functions Menu

The Select Reroutes command enables you to choose the reroute sets you want to show on the TSD map. You can specify whether the label, nav aids, and/or fixes for a reroute set display and the color in which the TSD draws each reroute. The Select Reroutes list is sorted first by Domain in the following order: Public, Shared, Local, and Private. You can choose "Name" or reroute "End" time as a secondary sort. This command also allows you to edit, copy, view, or delete a selected reroute, monitor reroutes, view mental reprints, and model a reroute cancellation.

After viewing a specific help topic, you can open the help navigation pane by clicking the Show button in the top-right corner of the topic window.
When you click the **Show** button, the navigation pane opens, as in the following example.

Note: When you click the **Show** button, the navigation pane opens and the **Hide** button appears. To close the navigation pane again, click the **Hide** button.
2. TSD Basics

This chapter provides an introduction to the TSD and includes information about issuing TSD commands and using dialog boxes. It is the first of five chapters devoted entirely to the TSD.

Starting the TSD

To start the TSD application, whatever procedure has been determined by your System Administrator. The default TSD screen is shown below.

Issuing TSD Commands

Once the TSD is running on your node, you are ready to issue commands. There are three different ways to issue these commands: menu, quick key, and semicolon. Menu commands are discussed in Chapter 4; semicolon commands are discussed in Chapter 5. Quick keys (also known as hot keys) for each TSD menu and semicolon command appear within the context of the command summary boxes and are listed in Chapter 6.
TSD Pull–Down Menus

Menus graphically depict a list of command options. At the top of the TSD display is a title bar with the title Traffic Situation Display. Directly below the title bar is the main menu bar with pull-down menus of selectable commands, organized by groups of commands that have something in common. Below the menu bar is the TSD drawing area. To display a pull-down menu, move your pointer to one of the menu items and click on it with the left button. To leave a menu without issuing a command, move the pointer off the menu and click the left button.

Another way to display a pull-down menu on the TSD is to use mnemonics. To display a TSD Main menu item using a mnemonic, press \(<\text{Alt}\>\) and the appropriate underlined letter. For example, to display the Maps pull-down menu from the TSD window press \(<\text{Alt}\>\ M\). With the pull-down menu displayed, you can use these keys to open another menu. For example, with the Maps menu on the display, you can press \(<\text{Alt}\>\ W\) to display the Weather menu.

The following graphic shows a sample pull-down menu for the Maps function. Notice that the mnemonic letter for each command is underlined.

![Sample Pull-down Menu]

Move the pointer to any menu item and click the left button to issue the command. You can also press the mnemonic key, the underlined letter in the command name.

Some commands take effect immediately. Other commands display a solid arrow on the right of the command name, indicating that a sub-menu is available with additional items. Still other menu commands display three dots after the command name. Issuing one of these commands displays a dialog box with further choices. Dialog boxes are explained later in this chapter.

**Note:** When pressing a mnemonic key on a pull-down menu, press only the key without \(<\text{Alt}\>\), which is used only with mnemonic keys on the TSD Main menu.
**File Pull–Down Menu**

An important feature of the TSD is that after you have set up the TSD display the way you want it, you can save the setup for later retrieval. The following settings can be saved using the File/Save command.

- **Flights**
  - FEAs and FCAs
- **Weather**
  - Map items added to the Show Map Items dialog box
- **Alerts**
  - Overlays and their labels
- **Alarms**
  - Reroute Preferences
- **Range Rings**
  - Projection, zoom level
- **Colors**
- **Command Line Request**

The File pull-down menu appears on several TSD dialog boxes.

The Select Flights dialog box shown above is an example of a dialog box with the File pull-down menu. The following menu items are available on all File pull-down menus throughout the TSD and explained in detail in this section.

- **Save**
  - The **Save** command allows you to save current settings for flights, weather, alerts, alarms, Reroute Monitor settings, range rings, or colors to a file.

- **Recall**
  - The **Recall** command retrieves saved files of settings that you previously saved and displays them immediately on the screen.

- **Delete**
  - The **Delete** command erases saved files of settings that you no longer want from the hard disk.

Each of these menu commands is explained in more detail on the following pages.
Save Command
With the menu displayed, click Save or press S.

Save Flight File Dialog Box
After you click Save, a dialog box opens with a list of directory and file names.

To save a file, highlight the filename in the list by clicking on it with the left mouse button, or type it at the Save As prompt. Click OK.

If you just type in a filename, the settings are saved to the standard directory for these settings. You can create a subdirectory by including a slash in the text field. For example, if you enter pk/ad2, the settings are saved in a file named ad2 in the pk subdirectory. Subdirectories are represented by folder icons.

Note: The defaults file contains the TSD defaults and should not be changed. A warning appears if you attempt to save the defaults file or if you save a file as a name that already exists.
Recall Command
The Recall Flight Sets dialog box shows files in the standard directory, as well as any subdirectories under the standard directory. To see the files in a subdirectory, you click on the subdirectory name.

With the menu displayed, click **Recall**, or press **R**.

Recall Flight File Dialog Box
After you click **Recall**, a dialog box opens with a list of file names.

To recall a file, click on its filename in the list or type it in the Selection text field. You may choose to replace or append to the current file. Click **OK**.

Delete Command
With the menu displayed, click **Delete** or press **D**.
Delete Flight File Dialog Box

After you click **Delete**, a dialog box opens with a list of file names.

![Delete Flight File Dialog Box](image)

**Note:** A file named defaults cannot be deleted.

To delete a file, click on the filename in the list. Click **OK**. To select multiple files for deletion, press `<Ctrl>` or `<Shift>`. The Delete Confirmation Dialog box opens. Click **Yes** in this box to delete selected files.

![Delete Confirmation Dialog](image)
Tear–Off Menus

TSD menus are tear-off menus, meaning they can be moved to other locations. Place your pointer on the dashed line of the menu and click the left mouse button. The menu changes to a tear-off menu, as shown below. With the pointer in the title bar of the tear-off menu, depress the middle mouse button, drag the menu to the desired location, and drop it by releasing the button.

To close this menu, click on the Window Menu Button and click Close. You may also close this window by pressing Esc when the window has focus.

Right-Click Menus

Once the pointer is on an item (and in certain other cases), you can click the right mouse button to access right-click menus, which vary according to the item. Like pull-down menus, right-click menus contain a selectable list of command options.

The right-click menu items change according to the item that the pointer is on. There is also a generic right-click menu that appears when the pointer is not on any item and no item is selected. Each type is discussed in this section.

Use Right-click Menus

1. Move your pointer to a flight icon or map item to highlight (preselect) the item.
2. Press and hold down (or click firmly and release) the right mouse button to display a right-click menu for that particular item.
3. Once the right-click menu appears, move the pointer to select the appropriate menu item. Release the right mouse button to issue the command.
Flight Icon Right-click Menu

The right-click menus vary according to what item you select or preselect. For example, if you select a flight icon and depress the right button, you see the following menu.

- **Toggle Data Block**
  Toggles a flight's data block on and off.

- **Toggle Org/Dest**
  Shows the origin and destination airports in the data block.

- **Toggle Route**
  Shows the complete route of a flight.

- **Toggle Draw Route**
  Draws a line on the display representing the route of selected flights.

- **History**
  A dash is drawn each time flights are updated. This allows a flight's track to be displayed.

- **Last TZ**
  Draws an asterisk on the display at the last reported position of the flight and draws a dotted line from the asterisk to the flight icon.

- **Delete Aircraft Icon**
  Removes the icon from the display.

- **Lead Lines**
  Displays dotted lines extending from the airplane icons. This dotted line points in the direction in which the airplane is currently flying. The length of this dotted line is specified in the Customize Flight Display dialog box, discussed in Chapter 4.

- **Change Color**
  Displays the color palette so you can choose a new aircraft icon color.

- **Deselect**
  Deselects the flight.
Map Item Right-click Menu
If you select a map item, such as a major airport, and depress the right mouse button, the right-click menu appears with menu items that are self-explanatory.

Generic Right-click Menus
If you have not preselected or selected a flight or map item, you can access the generic right-click menu:

- **Select Again**
  Selects (highlights) flights and map items that you recently deselected.

- **Move/Zoom**
  Displays the Move/Zoom dialog box, which enables you to change the current location and zoom scale. This function is discussed in detail in Chapter 4, Maps Menu.

- **Undo Move/Zoom**
  Returns the TSD to its previous location and zoom scale, before the Move/Zoom command was issued.

- **Select Flights**
  Displays the Select Flights dialog box, which enables you to specify parameters for flight sets. This function is discussed in detail in Chapter 4, Flights Menu.

- **Create Reroute**
  Displays the Create Reroute dialog box, which enables you to name and define a reroute. This function is discussed in detail in Chapter 4, Reroute Menu.

- **Create FEA/FCA**
  Creates a new FEA or FCA and designates it Private, Shared, or Public. FCAs are public and can be created only at the Command Center.

- **Monitor All Reroutes**
  Displays the Reroute Monitor dialog box, which enables you to monitor the flights involved in public reroutes.
Note: Because the first item on each of the right-click menus is selected by default, you can execute that function without clicking the right button to open the menu. Simply preselect the item and double click the left button. For example, if you preselect a map item and double click, you toggle the item's label on or off.

Semicolon Commands

To issue a semicolon command in the TSD, position the pointer on the TSD display and press the semicolon key. After you press the semicolon key, the Command Line dialog box opens. You enter your command at the prompt, as in the sample.

![Command Line dialog box](image)

Command History Button

The Command History and Reports toggle buttons are located at the bottom of the dialog box. Click on Command History to display a list of recently issued commands, as shown in the sample below. Clicking on one of these commands copies it to the command line, where you can edit or issue the command.

![Command Line dialog box with Command History](image)
Reports Button

Click Reports to display a list of reports generated during the current session, as in the following sample.

![Command Line dialog box](image)

The buttons and the use of the Command Line dialog box are discussed in Chapter 5 and in the Tools Menu section of Chapter 4.
TSD Dialog Boxes

Dialog boxes are windows that let you enter information instructing the TSD on what to do. Dialog boxes enable you to specify choices before issuing a command. The text entry fields in TSD dialog boxes have a white background, letting you know at a glance where you can enter data directly. The following graphic shows a sample dialog box that appears after you issue the Range Rings command on the Maps menu. This dialog box is used here as a representative of the dialog boxes throughout the TSD. Although there are differences, all dialog boxes require some form of user response.

Title Bar

The title bar displays the name of the dialog box and can be used to drag the dialog box to a different location. To do this, with your pointer in the title bar, depress either the left or middle button and drag the dialog box to a new location.

Note: To save space on your screen, you can double-click the title bar to “roll up” TSD dialog boxes. By doing this, the dialog boxes are left open and active but reduced to the size of the title bar while you view changes on the TSD main screen.
The rolled up dialog boxes would appear similar to Create Reroutes in the following example:

![Create Reroute](image.png)

**Note:** To restore the dialog box, double click the title bar.

To enable window rollup action on dialog boxes in Linux, click the Red Hat icon on the Gnome Bottom Edge Panel to open the Red Hat menu. Select **System**, then **Preferences**, then **Windows** to open the Window Preferences dialog box. In the Titlebar Action section, select Rollup from the picklist.

**Menu Bar**

The menu bar shows the pull-down menus available on a specific dialog box. Each menu is discussed in the context of the command itself except for the File menu, which is common to several dialog boxes and discussed on page 2-2. In the sample Select Range Ring dialog box above, the two pull-down menus are File and Range Rings. You can issue commands by clicking on the menu name, moving the pointer to the desired menu item, and clicking the left button.

You can also issue menu commands by pressing their mnemonic keys. For example, pressing `<Alt> F` on the TSD main window pulls down the Flights menu, and pressing `S` opens the Select Flights dialog box.
**Text Entry Field**

The text entry field allows you to use the keyboard to type in information. Entries may consist of filenames, locations, or other types of information appropriate to a specific command. The text cursor, a small vertical line, shows where you enter the appropriate values. If you make an error, backspace to remove characters.

Double clicking on a word in a text field highlights it; triple clicking selects the entire entry. If you type while any or all of the text field is highlighted, you overwrite the highlighted portion. You can also highlight text by dragging the pointer over the text while holding down the left button. When finished entering text, you can press `<Tab>` to move to the next field.

**Value Change Buttons**

Some entry fields have up and down arrow buttons that allow you to increase or decrease the value in the field. Click the **up** arrow button to increase the value or the **down** arrow button to decrease.

**Time Entry**

Not shown in the sample dialog box, a time entry field allows you to type in a time range, expressed in Universal Coordinated Time (UTC). Some time entry fields provide a default value. The time entered is in hhmm format, where the hour value is represented by the first two digits and the minute values by the last two. Some dialog boxes let you enter relative time periods. See the **CAPS** command in on page 5-20.

**Checkboxes**

Checkboxes allow you to choose from predefined selections. To choose a checkbox, move the pointer to either the text string or the box at the left of the selection and click the left mouse button. The checkbox changes to a contrasting color with a check mark, showing it has been selected. Checkboxes are deselected in the same way.

**Radio Buttons**

Not shown in the sample dialog box, radio buttons are used to select one option exclusively from a group of options. When one of these buttons is selected, it automatically deselects the other options.
Push Buttons

Push buttons perform a specific action when selected, indicated by the label on the button. To select a push button, move the pointer onto the button and click the left mouse button. The push buttons defined below are common to many dialog boxes.

- **OK**
  Issues the command, including any changes you have made in the dialog box, and removes the dialog box.

- **Apply**
  Issues the command, but leaves the dialog box up so you can make additional changes.

- **Cancel**
  Removes the dialog box. Any changes you have made in the dialog box are discarded and not applied.

- **Help**
  Displays information on using the dialog box.

Some push buttons have specialized functions, as explained below.

- **Additional dialog boxes**
  Push buttons with three dots after the button name lead to additional dialog boxes. Selecting the button displays the dialog box for you to make further choices.

- **List boxes**
  Push buttons that have three dots and are located next to a text entry field lead to a list of options from which you may select one or more with the left mouse button. Options you select will appear in the text entry field.

- **Option menus**
  Push buttons that have a small rectangle on the right side have pop-up menus that allow you to choose one option, such as the color of the aircraft icons.

![Diagram](image-url)
Scroll Bar

Some lists of options or data are too long to be displayed in a dialog box, so only a portion of the entire list is displayed at any time. On the right side and/or below the list is a scroll bar, as shown in the following illustration:

- To scroll using the arrows for a long list, click the up arrow to move up one line in the list and the down arrow to move down one line. To view data, click the up and down arrows or the left and right arrows to reveal data.

- To scroll using the slider, move the pointer onto the slider, click and drag the slider up or down (or left or right) to move through the list or data and release the button. The position of the slider indicates the relative position of the items displayed within the list.

- To scroll using the trough region, click in the trough above the slider to move up one window or below the slider to move down one window. Click to the left or right of the slider to view data to the left or right in the dialog box.

Focus

The term focus is used in two senses. First, a window has focus, meaning that this window accepts input from the keyboard. To move the focus from one window to another, move the pointer. Depending on how your system administrator has configured your node, you might need to click in the window to get focus. You can tell which window has focus by watching the color of the title bar. If a window has focus, its title bar is shown in its true color rather than a dull color.

The second meaning of the term refers to a text field or button in a dialog box having focus. The item that has focus is the one that receives input from the keyboard.

If a text field has focus, you can enter data into it directly from the keyboard. If a button has focus and you press the <spacebar>, the result is the same as if you had clicked on the button.

The previously shown dialog box depicts a rectangle drawn around the OK button, indicating that this button is the default. While this dialog box has focus, pressing <Enter> has the same effect as clicking the OK button.

- To move the focus forward through a dialog box, press <Tab>.
- To move backward through a dialog box, press <Shift> <Tab>. 
Information and Query Boxes

Other types of dialog boxes are information and query boxes. An information box gives you a brief message and asks for an acknowledgement, as shown in the example below which results from selecting Version on the Tools menu.

A query box is similar to an information box, but it asks you to choose to perform an action or to cancel it. The dialog box that results from selecting Quit in the Display menu is typical of a query box.

Note: Information and query boxes are referred to as dialog boxes within this Reference Manual.
Quitting the TSD

You can exit from the TSD by selecting Quit on the Display menu or by pressing Q.

Clicking Yes on the Confirm Quit dialog box lets you exit the TSD; clicking No keeps the TSD on your screen.

Note: Pressing <Ctrl>Q will quit the TSD without displaying the Confirm Quit dialog box.
3. TSD Menu Structures

This chapter helps you see at a glance the relationships between TSD main menus, pull-down menus, and dialog boxes. Organized by the Main menu, each diagram depicts an individual main menu item, its pull-down menu commands, and the paths, if any, that these commands follow in performing their functions.

The diagrams use certain conventions that are explained here.

The TSD Main menu item is located at the top of the graphic and is presented in a shaded box. For example:

- Pull-down menus are presented in shaded boxes that are smaller than that of the TSD Main Menu items. For example:

- The pull-down menu commands are shown beneath the main menu item and are shown in rectangular boxes. For example:

- Sub-menu commands are displayed to the right of their commands and are shown by smaller rectangular boxes. For example:

- Dialog boxes are shown by special graphical representations. For example:

- Arrows represent the connections between menu items and dialog boxes and menu items and sub-menu items. For example:
Alerts Menu
Continued

NAS Monitor

Functions
Show System Summary System Summary Functions
Show NAS Monitor

Customize

Custom
ARTCC
Canadian

Top
Tier
Show Canadian
Hide/Show Options Panel

Time in Sector
Time in Sector

Functions
Sort
Display
Close

Bar Chart

NAS Monitor Graph

Customize

Hide/Show Options Panel

Alert Report

Hide/Show Examined Flights

Turn Green

Close

Customize

Select Elements

Select Monitored Elements

Show All Baselines
Move Row Up
Move Row Down
Remove Row

Relative/Absolute Time Range

Sort By
Area
Alphanumeric
Manual

Hide/Show Options Panel

Preferences

NAS Monitor Preferences

File

Recall
Save
Delete
Reroute Menu

Hide/Show Reroutes

Select Reroutes

Info

Functions

Edit Reroute

Copy Reroute

Monitor All Reroutes

Reroute Monitor

File

Functions

View

View Model

View Reroute

Delete Reroute

Monitor Reroute(s)

Reroute Monitor

View Model

View Reroute (Model Mode)

Model Reroute Cancellation

Sort By...

Name

End Time

Create Reroute

Create Reroute

File

Functions

View

Preferences

Reroute Preferences

File
FEA/FCA Menu

Show/Hide FEA/FCAs

Select FEA/FCA

Create FEA/FCA

Recall FEA/FCA

Examine FEA/FCA

FEA/FCA Timeline

FEA/FCA Timeline

Functions

Edit FEA/FCA

Edit

Delete FEA/FCA

Delete

Copy FEA/FCA

Copy

Examine FEA/FCA

Examine

Sort by

Continued on the Next Page ...
Tools Menu

Network Utilities

Replay

Database Commands

Continued on the Next Page...
4. **TSD Menu Command Directory**

This chapter covers all TSD pull-down menus, shown below on the TSD display. The individual menus, with their sub-menus and dialog boxes, are explained in detail in this chapter.
Display Menu

Overview

In this section you will learn how to use the commands available on the Display pull-down menu and sub-menus. The section begins with information on resizing, layering, and moving the TSD. Next, it explains the Adapt sub-menu items, which include recalling, saving, and deleting previously created files, as well as changing the colors and fonts of map items. You will learn how to refresh the TSD screen, add text to the bottom of the screen, exit the TSD, and show/hide the Times box.

Each of the following topics corresponds to an item on the Display pull-down menu.

- **Minimize Command**  
  Reduces the TSD to a button on the Window List of the GNOME Bottom Edge Panel. This allows you to work in other windows without exiting the program.

- **Show/Hide Times Command**  
  Toggles the Times box on and off. When toggled on, this box displays the current time and also the most recent update time for flights, alerts, and each displayed type of weather.

Page 4-4

Page 4-5
• **Adapt Commands**  Page 4-7
  Lets you change many aspects of the TSD and save your specified settings to adaptation files

• **Redraw Command**  Page 4-17
  Lets you redraw the TSD display. This function removes any lat/lon points and spurious characters or graphic objects

• **Legend Command**  Page 4-18
  Lets you write text on the bottom of the TSD window

• **RVSM Command**  Page 4-19
  Lets you select Reduced Vertical Separation Minimums (RVSM) display options for the TSD.

• **Quit Command**  Page 4-22
  Exits the TSD
## Minimize Command

The **Minimize** command reduces the TSD to a button on the Window List of the GNOME Bottom Edge Panel. This allows you to work in other windows without exiting the program.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
</table>
| 1. Pull down the Display menu by clicking **Display** on the main menu or pressing `<Alt>` D.  
2. Click **Minimize** or press M. | **None** |

### Semicolon Method

| None |

### Minimized TSD Icon

After you click **Minimize** or press the mnemonic key from the Display menu, the TSD reduces to an icon on the task bar, which is located on the bottom of the screen and looks like the following:

```
 Terminal   Terminal
 [tsd]     NAS Monitor Control Panel

 TSD Minimized
```

**Note:** You can also minimize the TSD by clicking the minimize icon in the upper right corner of the screen.

### Restoring the TSD Display

To restore the TSD display, click the **TSD** button in the Window List.
Show/Hide Times Command

The Show/Hide Times command lets you toggle the display of the Times box on and off. The Times box shows the current time of day and the last update time for any selected overlays of flights, weather, or alerts. Either Show Times or Hide Times appears on the Display menu.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Display menu by clicking Display on the main menu or pressing &lt;Alt&gt; D.</td>
<td></td>
</tr>
<tr>
<td>2. Click Show Times or press T.</td>
<td>None</td>
</tr>
</tbody>
</table>

Semicolon Method

None

Times Box

After you issue the Show Times command, the Times box, which looks like this sample, appears.

![Times Box Sample](image)

Current: 2019  
Flights: 2019  
CIWS Precip: 2018  
Growth/Decay: 2018  
ETOP Tags: 2018  
NOWRAD2_sj: 2016  
CCFP Issued: 1900  
CCFP Valid: 2100  
Lightning: 2015  
NAS Monitors: 2019  
Alerts: 2019  
Time Limit: 2.25

Note: If no overlays are selected, the Times box shows the current time only. You can drag this box to any other place on the display.
When weather data goes out of date, the time values change. The TSD indicates time expirations by displaying them in red. Item labels and times flash in red and black for one minute when they expire.

If valid weather data is unavailable for any weather item except CCFP and NCWF, the Times box shows that weather item’s last update time as N/A for Not Available.

If you display a CCFP weather overlay, the Times box shows both the time that the CCFP was issued and the time for which it is valid. If no valid CCFP forecast data is available, the Times dialog box shows N/A as both the Issued and Valid times. The TSD indicates on the Times dialog box that CCFP data has expired if a time interval of 2.5 hours passes after the last data update.

If you display an NCWF weather overlay, the Times box shows the time for which it is valid. If no valid NCWF forecast data is available, the Times dialog box shows N/A as the Valid time.

If any weather file is received more than 30 minutes early, the TSD will display the time in red in the Times dialog box. Weather data that is more than 12 hours old is considered obsolete and is unavailable for display, except in Replay mode.

When you deselect any of the elements currently shown in the Times box, that element disappears from the display as well as from the Times box. If you pull down the Display menu again, the command name is Hide Times. Issuing this command removes the Times box and changes the command name back to Show Times.

**Times Dialog Box in Model Mode**

When you model a reroute, the Times dialog box displays a bright yellow background color to indicate Model mode as shown in the following image. In this example, weather overlays remain selected to show on the map. Since flights and alerts are disabled during Model mode, the Flights and Alerts times that were previously shown are removed from the dialog box and Model Time displays.
Adapt Commands

The Adapt commands let you change many aspects of the TSD. When you click Adapt, you display a sub-menu with several command options that let you recall a previously created file, save a file, delete a file, return the TSD to its default state, and change the color and font size of map overlays.

<table>
<thead>
<tr>
<th>Recall Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>The <strong>Recall</strong> command lets you change your TSD settings to settings that have been saved to a file.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Menu Method</strong></th>
<th><strong>Quick Key Method</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Display menu by clicking <strong>Display</strong> on the main menu or pressing <strong>&lt;Alt&gt; D</strong>.</td>
<td></td>
</tr>
<tr>
<td>2. Click <strong>Adapt</strong> or press <strong>A</strong>.</td>
<td></td>
</tr>
<tr>
<td>3. Click <strong>Recall</strong> or press <strong>R</strong>.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Semicolon Method</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Request:</td>
</tr>
<tr>
<td><strong>ADAPT filename</strong></td>
</tr>
</tbody>
</table>
After you issue **Recall** using the menu method, the Recall Adaptation File dialog box opens, listing all the current subdirectories and files. The subdirectories are represented by the folder icons.

![Recall Adaptation File dialog box](image)

To access a file within a subdirectory, click the subdirectory icon twice to display the filenames within that subdirectory.

When you click a file icon, that filename appears in the text field. You can also type the name directly into the text field. When you click **OK**, the TSD changes to display the settings you previously specified and saved to that filename.

**Note:** For information on creating a subdirectory, see the **Adapt/Save** command in the following section.

**Quick Key Method to Reset TSD to its Initial State**

When you use the **K** quick key to change the TSD to its initial settings, the TSD displays the following confirmation query.

![Confirmation query](image)

Clicking **Yes** returns you to the TSD display with the same settings that appeared when the TSD was started.
Save Command

The **Save** command lets you save your current TSD settings to an adaptation file with a name you specify. You can choose to put the file into a subdirectory, which is represented by a folder icon.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
</table>
| 1. Pull down the Display menu by clicking **Display** on the main menu or pressing `<Alt>` D.  
  2. Click **Adapt** or press A.  
  3. Click **Save** or press S.             | **None**         |

**Semicolon Method**

|                                      | None |

**Settings that can be saved to an Adaptation File**

You can save the following settings to an Adaptation file and specify a filename for later use:

- Map overlays
- CIWS and Legacy Weather overlays
- Flight sets and their properties
- Items currently specified by the Show Map Item command
- Range rings
- Current center point of the map display
- Zoom scale
- Data block contents
- Alert settings
- Colors and fonts for overlays
- NAS Monitor and FEA/FCA Timeline settings
- Default settings for flight sets and reroutes

**Note:** An FEA/FCA Timeline that was saved to an adaptation file will display when you recall the adaptation file if an FEA/FCA of the same name exists and the FEA/FCA has not expired.
Save Adaptation File Dialog Box
After you issue Save, the Save Adaptation Files dialog box opens.

Creating Files and Subdirectories
The primary files that are saved through the Adapt command are stored in the /ETMS/tsd/adapt directory. You can create another subdirectory to store the files you want to save. To do so, in the Save As text field enter the subdirectory name, followed by a slash (/) and the filename. For example: folder1/myfile.

Saving an Adaptation File
You can also save a file by clicking a filename displayed in the Save Adaptation File dialog box. The filename is displayed in the Save As field, with its subdirectory if there is one. After you click OK, a warning dialog box opens to notify you that the existing file will be overwritten. To overwrite the existing file click OK.
Delete Command

The **Delete** command lets you remove an adaptation file from the list of adaptation files.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Display menu by clicking <strong>Display</strong> on the main menu or pressing <strong>&lt;Alt&gt; D</strong>.</td>
<td>None</td>
</tr>
<tr>
<td>2. Click <strong>Adapt</strong> or press A.</td>
<td><strong>Semicolon Method</strong></td>
</tr>
<tr>
<td>3. Click <strong>Delete</strong> or press D.</td>
<td>None</td>
</tr>
</tbody>
</table>

Delete Adaptation File Dialog Box

After you issue **Delete**, the Delete Adaptation File dialog box opens.

You can select a file by clicking its icon to the left of the filename and clicking **OK**. Pressing **<Ctrl>** or **<Shift>** lets you select multiple files for deletion.
After you issue the Delete command, you see a dialog box asking you to confirm the delete request. Click **Yes** to confirm.

![Delete Confirmation Dialog]

**Note:** Subdirectories cannot be deleted if they contain files. To delete a file within a subdirectory, you need to open the subdirectory by clicking the folder icon twice and clicking the file icon.
Initialize Command

The Initialize command restores the TSD to its default state.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Display menu by clicking Display on the main menu or pressing &lt;Alt&gt; D.</td>
<td>I</td>
</tr>
<tr>
<td>2. Click Adapt or press A.</td>
<td>Semicolon Method</td>
</tr>
<tr>
<td>3. Click Initialize or press I.</td>
<td>None</td>
</tr>
</tbody>
</table>

Initialize Dialog Box

After you issue Initialize, the following dialog box opens. Click Yes to confirm or No to cancel.
The **Change Colors and Fonts** command lets you change the appearance of your display by changing the colors and font sizes of map overlays.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Display menu by clicking <strong>Display</strong> on the main menu or pressing <code>&lt;Alt&gt; D</code>.</td>
<td>None</td>
</tr>
<tr>
<td>2. Click <strong>Adapt</strong> or press <strong>A</strong>.</td>
<td><strong>Semicolon Method</strong></td>
</tr>
<tr>
<td>3. Click <strong>Change Colors and Fonts</strong> or press <strong>C</strong>.</td>
<td>None</td>
</tr>
</tbody>
</table>
Customize Colors and Fonts Dialog Box

After you select Change Colors and Fonts, the Customize Colors and Fonts dialog box opens. The map overlays shown in the Customize dialog box are further described in the Maps/Overlays section of the Maps menu. The Flight Data Block item is further described in the Select Flights section of the Flights menu.

The Change Colors and Fonts command lets you change the colors and font sizes of the TSD map items shown in the Customize Colors and Fonts dialog box. Clicking in the color box of any map item displays a palette of color selections like the example below.

When you click in any of the color boxes on the palette, that box changes to the selected color. Clicking OK or Apply redraws the TSD and changes the map item to your selected color. Clicking the font button to the far right of the map item and clicking OK or Apply changes the font style and size of the map item label.
Changing Fonts
You can use the Customize Colors and Fonts dialog box to change the fonts used in the overlay displays. The font for the particular overlay is listed next to the color box containing the overlay's name and color. Click the font button to open the menu of available fonts.

When you have displayed the fonts menu, select the font you wish that overlay to use. Repeat this procedure for as many overlay elements as necessary, and click **OK** or **Apply**. The overlays redisplay using the font you selected.

Using the File Menu
The File menu in the Customize dialog box lets you recall another file, save a file with your customized colors, styles, and fonts, or delete a current file. This menu functionality is similar to that in several other dialog boxes and is explained in detail in Chapter 2.

Click **Recall** to open a previously saved file; click **Save** to save the current settings to a new or existing file; click **Delete** to delete one or more custom settings files. Each of these functions operates using a dialog box that lists the currently stored files.

**File Menu**
You use the File pull-down menu to save your custom settings to a custom resources file, and to recall or delete a previously saved custom resources file. For more information, refer to the section on File Pull-Down Menu, on page 2-3 in Chapter 2, TSD Basics.
### Redraw Command

The **Redraw** command redraws the TSD screen, causing any spurious characters or graphic objects to disappear. Any latitude/longitude identifiers that have been placed with the Lat/Lon Point command also disappear. All other TSD features remain on the screen.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Display menu by clicking <strong>Display</strong> on the main menu or pressing &lt;Alt&gt; <strong>D</strong>.</td>
<td><strong>D</strong></td>
</tr>
<tr>
<td>2. Click <strong>Redraw</strong> or press <strong>D</strong>.</td>
<td><strong>Semicolon Method</strong></td>
</tr>
</tbody>
</table>

**Display Menu**

**Redraw Command**
Legend Command

The **Legend** command allows you to display text at the bottom of a TSD window. This command may be used to display a legend of colors selected for map elements or flight groups. You may enter up to 256 characters. The legend text is left justified at the bottom of the window and wraps according to the size of the display. The legend text remains on the display until you enter the command again or quit the TSD. Reissuing the command with no text or with one or more spaces deletes any previous legend text.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Display menu by clicking <strong>Display</strong> on the main menu or pressing <code>&lt;Alt&gt; D</code>.</td>
<td></td>
</tr>
<tr>
<td>2. Click <strong>Legend</strong> or press <strong>L</strong>.</td>
<td></td>
</tr>
<tr>
<td><strong>None</strong></td>
<td></td>
</tr>
</tbody>
</table>

**Semicolon Method**

**Input Request:**

`LEGBEND filename`

Legend Dialog Box

After you click **Legend** or press the mnemonic key from the Display menu, the Legend dialog box opens. You can edit the current legend text or enter your text at the Legend Text prompt and click **OK**.
RVSM Functions

RVSM allows controllers to separate properly equipped aircraft in the FL290 to FL410 airspace by as little as 1000 feet vertically, rather than the 2000 foot minimum that is currently required. The term conformant is used to characterize properly equipped aircraft.

Note: FL stands for “Flight Level”

With FAA approval, unequipped aircraft will be able to enter the RVSM airspace, but these aircraft must be vertically separated from all other aircraft by at least 2000 feet. The term non-conformant is used to characterize any unequipped aircraft in the RVSM airspace.

The following TSD functions are enhanced by RVSM: Flights, Alerts, and FEA/FCA. These RVSM enhancements are discussed in their appropriate menu sections.
Select RVSM Display Options Dialog Box

Selecting the RVSM command on the Display menu opens the Select RVSM Display Options dialog box.

![Select RVSM Display Options](image)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| RVSM Non-Conformant indicators for Drawn flights | When this option is selected, squares are drawn around non-conformant flights when they are displayed on the TSD.  
  **Note:** This option is also available on the Customize Flight Display dialog box. |
| RVSM Counts (Timelines, Center Monitor)   | When this option is selected, RVSM flight counts are displayed on the Timelines and Center Monitor. |
| RVSM Sector Alerts                        | When this option is selected, the TSD displays RVSM sector alerts. To see the RVSM Sector Alerts, you must issue the Show Alerts command.  
  **Note:** This option is also available on the Select Alerts dialog box. |
RVSM Status Icon

The RVSM Status icon changes colors to reflect which of the options shown above are on or off.

- Blue: All three display options are ON

- Orange with a diagonal stripe: Any option is OFF.

When you place the mouse pointer on the icon, the TSD displays a tool tip that lists the status of each of the RVSM options. Two examples are shown below.

Clicking the RVSM Status icon, like selecting the RVSM option on the Display menu, opens the Select RVSM Display Options dialog box, shown on the preceding page.
# Quit Command

The **Quit** command lets you end your session on the TSD.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Display menu by clicking <strong>Display</strong> on the main menu or pressing <code>&lt;Alt&gt; D</code>.</td>
<td><strong>Q</strong></td>
</tr>
<tr>
<td>2. Click <strong>Quit</strong> or press <strong>Q</strong>.</td>
<td><strong>Semicolon Method</strong></td>
</tr>
<tr>
<td></td>
<td><strong>None</strong></td>
</tr>
</tbody>
</table>

## Confirm Quit Dialog Box

After you click **Quit** or press the mnemonic key from the Display menu, a confirmation box opens.

Click **Yes** to exit the TSD.

![Confirm Quit Dialog Box](image)

**Note:** Pressing `<Ctrl>Q` will quit the TSD without displaying the Confirm Quit dialog box.
Maps Menu

Overview

This section explains how to use TSD menus to access Maps commands and is divided into the following topics, each of which corresponds to an item on the Maps pull-down menu.

- **Move Zoom Command**  Page 4-25
  Changes the center point and scale of the display

- **Show Map Item Command**  Page 4-27
  Locates and displays map items on the TSD

- **Range Rings Command**  Page 4-30
  Displays a series of concentric rings around specified locations

- **Overlays Command**  Page 4-35
  Shows graphic displays of map items with fixed locations

- **Runway Layout Command**  Page 4-40
  Displays a map of a specified runway
<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>DME Command</td>
<td>4-42</td>
</tr>
<tr>
<td>Displays the distance between specified points</td>
<td></td>
</tr>
<tr>
<td>Projection Command</td>
<td>4-44</td>
</tr>
<tr>
<td>Changes the orientation of the display to another geographic region</td>
<td></td>
</tr>
</tbody>
</table>
Move Zoom Command

The Move/Zoom command lets you change the center point of your display to any ARTCC, TRACON, sector, airport, navaid, fix, SUA, lat/lon point, fix-radial-distance, or specific flight ID you want. You may also change the scale of your display from 20 to 12,800 nautical miles. There are three ways of issuing this command, each working slightly differently.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Maps menu by clicking Maps on the main menu or pressing &lt;Alt&gt; M.</td>
<td>M Move</td>
</tr>
<tr>
<td>2. Click Move/Zoom or press M.</td>
<td>Z Zoom</td>
</tr>
<tr>
<td></td>
<td>U Unzoom</td>
</tr>
<tr>
<td></td>
<td>X Undo Move/Zoom</td>
</tr>
</tbody>
</table>

Semicolon Method

Input Request:

- Move or M
- Zoom or Z

Dynamic Sectorization

The TSD centers the display at the center point of the sector as defined by dynamic sectorization if the sector exists. If the sector has been combined into another sector, the TSD centers the display at the center point of the baseline sector.

If the sector is combined, the TSD re-centers the display as specified above and displays a warning dialog box with the appropriate message.
Move/Zoom Dialog Box

After you click Move/Zoom or press the mnemonic key from the Maps menu, the Move/Zoom dialog box opens.

Enter a location identifier in the Location field and the nautical miles you want in the Zoom Scale field. You can also use the up and down arrows next to the zoom scale field. Click OK to put your changes into effect. The TSD is redrawn with the location and range you entered. Clicking Undo returns the TSD display to its previous settings.

Note: You can also open the Move/Zoom dialog box by placing the pointer on the TSD with nothing selected, clicking the right mouse button to display the generic right-click menu and clicking Move/Zoom.

Location Identifiers

You can change the center of your display to any ARTCC, TRACON, sector, airport, navaid, fix, SUA, specific flight ID, lat/lon point, or fix-radial-distance. Formats for the last two items are explained below.

Lat/Lon point Latitude/longitude. Latitude may be followed by N or S; Longitude may be followed by E or W. If these letters are missing, the program assumes N and W. If latitude is following by N or S, longitude must be followed by E or W. For example, 3911/09343W is not valid.

Valid entries include: 3911N/09343W and 3911/09343

Use the format: Fix-radial-distance Fix-radial-distance with no spaces or markers.

For example: M DCA360010
Show Map Item Command

The **Show Map Item** command allows you to display overlays for individual sectors, TRACONS, fixes, pacing airports, terminals, navaids, or ARTCCs.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Maps menu by clicking <strong>Maps</strong> on the main menu or pressing <strong>&lt;Alt&gt; M</strong>.</td>
<td></td>
</tr>
<tr>
<td>2. Click <strong>Show Map Item</strong> or press <strong>S</strong>.</td>
<td></td>
</tr>
<tr>
<td><em><strong>Semicolon Method</strong></em>&lt;br&gt;<strong>Input Request:</strong>&lt;br&gt;<strong>Show</strong> or <strong>SHO</strong></td>
<td></td>
</tr>
</tbody>
</table>

Show Map Items Dialog Box

After you click **Show Map Item** or press the mnemonic or quick key from the menu, the Show Map Items dialog box opens. In the Add field, enter the name of the map item you want to locate. You can enter more than one item in the field by separating each item with a space, as in the example below.
To display these map items, click **Add Typed Items to List**. This moves the items to the List of Map Items to be Shown field.

Whenever you open the Show Map Items dialog box, the List of Map Items to be Shown field shows the items that are currently displayed on the TSD. For example, if airways J79, J154, and J180 appear in the dialog box, and you add or remove airways from this list, the corresponding lines and labels are displayed or removed from the TSD. If you remove airway J79 from this list and add airways J10 and J12, there would be four airways on the current TSD display: J10, J12, J154, and J180. The airway J79 would no longer appear in the list or on the TSD display.

To delete shown map items, two steps are necessary. First, select one or more items and click the **Remove Selected Items from List** button. Click an item to select it and deselect all others. Control-click an item to toggle its selection state. **<Shift>-click** an item to select a range of items. Second, click the **OK** or **Apply** button to complete the process of deleting shown map items. In short, you can manipulate the List of Map Items to be shown by using the **ADD** and **REMOVE** features so that the list contains exactly the items you want shown. Click **OK** or **Apply** to cause this list to be displayed on the TSD.
About the Display

After you enter the airway of your choice in the Show Map Items dialog box, the TSD is redrawn and displays a line of labels for each item entered in the dialog box. A sample display is shown below.

The map items remain on the screen after you click **OK**, but the dialog box closes. The map items and the dialog box remain on the screen after you click **Apply**. Clicking **Cancel** removes all current entries that you have not applied from the list and removes the dialog box from the screen.

File Menu

You can use the File pull-down menu to save map items, recall them later, and delete them. Clicking the appropriate menu item opens a dialog box. For more information, refer to Chapter 2.
Range Rings Command

The **Range Rings** command displays one or more sets of range rings around specified locations on the TSD. The locations may be airports, fixes, navaids, lat/lon points, or fix-radial-distances. You may specify the number of rings you want displayed, up to 200, and the distance between the rings, up to 3,000 nautical miles.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
</table>
| 1. Pull down the Maps menu by clicking **Maps** on the main menu or pressing <Alt> M.  
2. Click **Range Rings** or press R. | Place the pointer on the overlay icon that represents the location for which you want rings displayed to issue the command.  
- To display rings: <Insert>  
- To remove rings: <Delete>  
- To toggle labels on and off: <Ctrl><Insert> |

Semicolon Method

Input Request:  
**RANGE RINGS** or RR  
RRD

Select Range Rings Dialog Box

After you click **Range Rings** or press the mnemonic key from the Maps menu, the Select Range Ring dialog box opens with focus in the Location field of the first range rings set.
Each row in the dialog box defines a range rings set. The dialog box holds at least 64 range rings sets and expands as you define new sets. You can scroll the rows of sets or resize the dialog box.

After you select **Show** and enter your specifications, click **OK** or **Apply** to display the set of range rings. The following table describes each item in the dialog box.

### Select Range Ring

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What you do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show</td>
<td>Toggles specified sets of range rings on and off the display.</td>
<td>Click the button to select or deselect it.</td>
</tr>
<tr>
<td>Label</td>
<td>Toggles labels for the center point and distance of each range rings set.</td>
<td>Click the button to select or deselect it.</td>
</tr>
<tr>
<td>Color</td>
<td>Specifies the colors in which the range rings are displayed.</td>
<td>Click the button to display the color palette and select the desired color.</td>
</tr>
<tr>
<td>Location</td>
<td>Specifies the center point around which the range rings are drawn.</td>
<td>Enter an airport, fix, navaid, lat–lon, or fix–radial–distance. For example: <strong>ORD MALTA JOT 3545/14059 M DCA360010</strong></td>
</tr>
<tr>
<td>Number</td>
<td>Specifies the number of rings you want displayed. The default value is five.</td>
<td>Enter a number (1-200) of rings for display. You can also click the up and down arrows to the right of the field. Each click increases or decreases the number of range rings by one. (Hold the &lt;Shift&gt; key while clicking the up or down arrow to increase or decrease the value by 10.) For example: <strong>5</strong></td>
</tr>
<tr>
<td>Distance</td>
<td>Specifies the distance in nautical miles that you want to separate each ring from the next. The default value is 20 miles.</td>
<td>Click in the field and enter up to four characters (1-3000) for the number of miles. You can also click the up and down arrows to the right of the field. Each click increases or decreases the distance by 10. For example: <strong>20</strong></td>
</tr>
</tbody>
</table>
Selecting Range Rings Sets

Select a range rings set by clicking the row number. That row becomes selected while the other rows are deselected. There are two ways to select a group of sets. One way is to place the pointer on the first row in the group, click and hold the left mouse button, drag the pointer to the last row in the group, and release the mouse button. Another way is to select the first row in the group by clicking the row number, moving the pointer to the row number of the last set in the group, and pressing <Shift> while clicking the left button. All the rows between the first and last set become selected. Pressing <Ctrl> while clicking the row number toggles the row of the selected set.

File Menu

Under the title bar at the top of the dialog box are two pull-down menus: File and Functions. Through the File pull-down menu, you can save the contents of the Select Range Rings dialog box, recall them later, and delete them if desired. For information about the File menu, refer to Chapter 2.

Functions Menu

After you have defined a list of range rings sets, you can use the Range Rings pull-down menu to modify the list. The Functions menu items are explained in this section.

- Add
- Copy
- Delete
- Delete All
- Undo Delete
- Defaults...

Add

Add provides additional rows on the Select Range Ring dialog box for more sets of range rings. The default range rings color and label parameters for the number and distance of range rings are selected. The following sample dialog box shows an added row where you would enter another set of range ring requirements.
Complete the entries in this row and click **OK**. The new set appears on the TSD.

**Copy**

Copies the selected rows of range rings sets and adds them to the top of the current list of sets. If more than one range rings set is selected, the sets are copied in the order that they were selected. The contents of the copied and original sets are identical.

**Delete**

Removes all selected sets of range rings from the Select Range Ring dialog box temporarily. The row clears, and the range rings disappear from the display.

**Delete All**

Erases all sets of range rings from the dialog box and allows you to make a new entry. The rows clear, and the range rings disappear from the display.

**Undo Delete**

Restores the last range rings set(s) that was deleted.

**Defaults**

Displays the Range Rings Defaults dialog box, which lets you define and save the default parameters of range rings sets that are added to the list of range rings. When the Range Rings Defaults dialog box opens, it contains the current default parameters. If no default parameters are defined, the default values in the following sample dialog box are used.
**Range Rings Labels**

The labels represent the distance of each ring from the center point, as well as the distance between rings. If the labels are on and obscure your view of traffic, toggle the labels off using the quick key method. To do so, press `<Ctrl> <Insert>`.

**Error Message**

If the program does not recognize your specifications, an Error dialog box opens with an appropriate message. Click **OK** or press **Esc** to close the Error dialog box. See Appendix B for a list of possible TFMS diagnostic messages.
The Overlays command lets you produce background overlays of map features for display on the TSD.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
</table>
| 1. Pull down the Maps menu by clicking Maps on the main menu or pressing <Alt> M.  
2. Click Overlays or press O. | See the Map Overlays Quick Key table on page 4-38 in this section |

**Map Overlays Dialog Box**

After you click Overlays or press the mnemonic key from the Maps menu, the Map Overlays dialog box opens.

The Map Overlays dialog box lets you select whether Current or Baseline sector boundaries will be drawn when sector overlays are shown. This selection only affects the drawing of sector overlays. It does not affect the drawing of Alert icons on the display.

**Note:** You cannot display a label without selecting its icon. You can, however, display an icon without its label.

For most of the overlay map features available for display, you have the option to Show in the normal way or you can select to Show on Browse when you move the cursor over the map location with your mouse. In the Show on Browse state, map elements that are in the Hide state will be shown when you move the cursor over the map location with your mouse.
In the Map Overlays, successive clicking toggles the selection among Show, Show on Browse and Deselected, as shown in the table below.

### Map Overlays

<table>
<thead>
<tr>
<th>Button Appearance</th>
<th>Effect on Map Overlay</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Checkmark]</td>
<td>Show checkmark: the selected item will be displayed constantly on the map overlay.</td>
</tr>
<tr>
<td>![Browse Arrow]</td>
<td>Show on Browse arrow: the selected item will be displayed when the mouse cursor browses over its location on the map overlay. The browse option is available for Airports, Navaids, Fixes, Airways, Sectors and SUAs.</td>
</tr>
<tr>
<td>![Deselected]</td>
<td>Deselected button: the corresponding item will not be displayed on the map overlay.</td>
</tr>
</tbody>
</table>

If desired, select **Label** to display identifiers for overlay elements. Click **OK** to display your selections on the TSD.
Drawing Sector Overlays

When you select sector overlays to be drawn on the map, an icon appears on the TSD main menu indicating whether the overlays are drawn with Current or Baseline boundaries. The TSD main menu displays the "Current" boundaries icon located at the right of the Tools menu when the Current option is selected.

The tool tip shown below is displayed on the TSD when you hover the cursor over the Current sector overlay icon.

Sector overlays are drawn with current boundaries.
Use the Maps Overlays dialog box to switch overlays to baseline boundaries
(Alerts are always drawn using current boundaries)

The Baseline icon displays when the Baseline option is selected.

The tool tip shown below is displayed on the TSD when you hover the cursor over the Baseline sector overlay icon.

Sector overlays are drawn with baseline boundaries.
Use the Maps Overlays dialog box to switch overlays to current boundaries
(Alerts are always drawn using current boundaries)

Note: The Sector Overlays Drawn section of the Map Overlays dialog box affects the drawing of sector overlays only. It does not affect the drawing of Alert icons on the display. Note also that when you are modeling a reroute and overlays are drawn with Current boundaries, the TSD draws sector overlays based on the sector configuration in the "snapshot" of data generated at the time reroute modeling was started. For more information on reroute modeling, see Chapter 4, Reroute Impact Assessment on page 4-333.
Using Quick Keys

Most of the map item commands available on the Map Overlays dialog box can be accessed by using quick keys, as shown below. Pressing the quick key for a map overlay toggles its display state to show the overlay, hide the overlay, or show only when the element is browsed.

### Map Overlays dialog box

<table>
<thead>
<tr>
<th>Map Overlay</th>
<th>Overlay Quick Key</th>
<th>Label Quick Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Map Labels</td>
<td>~</td>
<td>~</td>
</tr>
<tr>
<td>Pacing Airports</td>
<td>P</td>
<td>&lt;Ctrl&gt; P</td>
</tr>
<tr>
<td>All Airports</td>
<td>Y</td>
<td>&lt;Ctrl&gt; Y</td>
</tr>
<tr>
<td>High NAVAIDs</td>
<td>F4</td>
<td>&lt;Ctrl&gt; F4</td>
</tr>
<tr>
<td>Low NAVAIDs</td>
<td>F5</td>
<td>&lt;Ctrl&gt; F5</td>
</tr>
<tr>
<td>Terminal NAVAIDs</td>
<td>F6</td>
<td>&lt;Ctrl&gt; F6</td>
</tr>
<tr>
<td>Other NAVAIDs</td>
<td>F7</td>
<td>&lt;Ctrl&gt; F7</td>
</tr>
<tr>
<td>Departure Fixes</td>
<td>F3</td>
<td>&lt;Ctrl&gt; F3</td>
</tr>
<tr>
<td>Arrival Fixes</td>
<td>F2</td>
<td>&lt;Ctrl&gt; F2</td>
</tr>
<tr>
<td>Enroute Fixes</td>
<td>F8</td>
<td>&lt;Ctrl&gt; F8</td>
</tr>
<tr>
<td>Jet Airways</td>
<td>J</td>
<td>&lt;Ctrl&gt; J</td>
</tr>
<tr>
<td>Victor Airways</td>
<td>V</td>
<td>&lt;Ctrl&gt; V</td>
</tr>
<tr>
<td>Boundaries</td>
<td>B</td>
<td>None</td>
</tr>
<tr>
<td>Lat/Lon Grid</td>
<td>[ L</td>
<td>None</td>
</tr>
<tr>
<td>ARTCCs</td>
<td>A</td>
<td>&lt;Ctrl&gt; A</td>
</tr>
<tr>
<td>Low Sectors</td>
<td>L</td>
<td>&lt;Ctrl&gt; L</td>
</tr>
<tr>
<td>High Sectors</td>
<td>H</td>
<td>&lt;Ctrl&gt; H</td>
</tr>
<tr>
<td>Superhigh Sectors</td>
<td>S</td>
<td>&lt;Ctrl&gt; S</td>
</tr>
<tr>
<td>Oceanic Sectors</td>
<td>O</td>
<td>&lt;Ctrl&gt; O</td>
</tr>
<tr>
<td>TRACONs</td>
<td>^</td>
<td>&lt;Ctrl&gt; &lt;Shift&gt; ^</td>
</tr>
<tr>
<td>Alert Areas</td>
<td>[ A</td>
<td>&lt;Ctrl&gt; [ A</td>
</tr>
<tr>
<td>MOAs</td>
<td>[ M</td>
<td>&lt;Ctrl&gt; [ M</td>
</tr>
<tr>
<td>Prohibited Areas</td>
<td>[ P</td>
<td>&lt;Ctrl&gt; [ P</td>
</tr>
<tr>
<td>Restricted Areas</td>
<td>[ R</td>
<td>&lt;Ctrl&gt; [ R</td>
</tr>
<tr>
<td>Warning Areas</td>
<td>[ W</td>
<td>&lt;Ctrl&gt; [ W</td>
</tr>
<tr>
<td>All SUAs on</td>
<td>[ +</td>
<td>None</td>
</tr>
<tr>
<td>All SUAs off</td>
<td>[ ‘</td>
<td>None</td>
</tr>
</tbody>
</table>

**Note:** When using quick keys, the TSD displays Current or Baseline sector overlays as specified in the Map Overlays dialog box.
The **Lat/Lon Point** command displays the latitude and longitude coordinates of the geographical location at which the cursor currently points. The values remain until the quick key is pressed to turn them off and the display is refreshed.

### Lat/Lon Point Command

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>1. Move the cursor to the point whose coordinates you wish to find.&lt;br&gt;2. Press .&lt;br&gt;To turn the coordinates off:&lt;br&gt;1. Press D&lt;br&gt;2. This will permanently remove the coordinates from the display.</td>
</tr>
</tbody>
</table>

### Semicolon Method

None
Runway Layout Command

The **Runway Layout** command displays an enlarged map of the runways for an airport you specify, as well as the airport’s official name and location. If a certain airport’s runway layout is unavailable to the TSD, only the official airport name and location appear.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
</table>
| 1. Pull down the Maps menu by clicking **Maps** on the main menu or pressing `<Alt>` M.  
2. Click **Runway Layout** or press W. | None |

**Semicolon Method**

Input Request: **RUNWAY** or **RWY**

Runway Layout Dialog Box

After you click **Runway Layout** or press the mnemonic key from the Maps menu, the Runway Layout dialog box opens. Enter the airport location identifier in the Airport field.
About the Display

Runways are displayed against a green background. The runways are labeled and color-coded. They are numbered in relation to their magnetic direction, rounded to the nearest 10 degrees. The labels include standard designations for parallel runways: L (left), C (center), and R (right).

When you click **Legend**, you see the colors and materials they symbolize.
DME Command

The **DME** command displays the distance in nautical miles between specified points on the TSD and draws a line connecting the points. You can use this command to measure the distance between two points or to measure the cumulative distance along connected line segments.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Maps menu by clicking <strong>Maps</strong> on the main menu or pressing <code>&lt;Alt&gt;</code> <strong>M</strong>.</td>
<td></td>
</tr>
<tr>
<td>2. Click <strong>DME</strong> or press <strong>D</strong>.</td>
<td>None</td>
</tr>
</tbody>
</table>

**Semicolon Method**

None

Distance Measurement Dialog Box

After you click **DME** or press the mnemonic key from the Maps menu, the Distance Measurement dialog box opens.

To measure the distance between two points, place the pointer on one point and click the left mouse button once. Place the pointer on the second point and click the left mouse button again. A line is drawn between the two points while the value, in units of nautical miles, appears in the Distance field in the dialog box.

To measure the cumulative distance along connected line segments, place the pointer on a third point and click the left button once. A line extends from the second point to the third point. The total distance along the two line segments appears in the Distance field. Click on additional points to extend the line as desired. Clicking **Close** removes the line and the dialog box from the display.
Lat/Lon Position

When the Distance Measurement dialog box is open the lat/lon position is displayed in a tool tip on the TSD as shown below. As you move the cursor around the TSD display the lat/lon coordinates change accordingly.
Projection Command

The **Projection** command allows you to choose the geographic region—CONUS, London, Canada, Atlantic, Alaskan, or Chile—around which you would like your display to be oriented or allows the TSD to dynamically change the projection as needed. After you issue the command, the TSD redraws the display so that the geographical boundaries are most accurately represented around the selected region. For most TSD sites the CONUS is the default region.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
</table>
| 1. Pull down the Maps menu by clicking **Maps** on the main menu or pressing `<Alt>` **M**.  
2. Click **Projection** or press **P**. | **None** |

**Semicolon Method**

Input Request: **PROJECTION** or **PROJ**

### Projection Command Dialog Box

After you click **Projection** or press the mnemonic key from the Maps menu, the Projection Command dialog box opens.

**Dynamic Projection**

Dynamic projection is selected by default in the Projection command dialog box. The Projection field is disabled.

![Projection Command Dialog Box](image)

The TSD title bar displays (Dynamic Projection), when Dynamic projection is selected with no named projection.

When the Dynamic Projection is selected, the projection center point automatically changes to be equal to the display center point. As you move the display center point, the projection center point also changes.
Fixed Projection Option

Clicking **Fixed** on the Projection Command dialog box and clicking on the down arrow in the Projection field lets you choose from a pick list of projection center points. The list of projection points is shown below.

Click **OK** to change the projection. The center point of the display changes and the TSD title bar displays the projection you choose. For example, if CONUS is the selected projection the title bar displays CONUS in parentheses.

**Error Message**

If you enter the command incorrectly, or ask for a region that is not available in the dialog box, you get an Error message.

Check the command spelling, verify that the region exists (CONUS, LONDON, CANADA, ATLANTIC, ALASKAN, or CHILE) and reissue the command.
Flights Menu

Overview

This section explains how to use TSD menus to display flights and flight counts, select and filter groups of flights, find a specific flight or flights, and supplement the flight display with additional information. The section is divided into the following topics, each of which corresponds to a selection from the Flights pull-down menu.

- **Show/Hide Flights Command**  
  Turns flight icons off and on  
  Page 4-47

- **Select Flights Command**  
  Limits the appearance of flight icons to a group of flights you select  
  Page 4-50

- **Show/Hide Flight Count Command**  
  Toggles the Flight Count window off and on  
  Page 4-59

- **Find Flight Command**  
  Locates a specific flight icon on the display  
  Page 4-60

- **Customize Command**  
  Lets you add additional lines of text and graphics to selected flight icons  
  Page 4-63
**Show/Hide Flights Command**

Show Flights/Hide Flights command lets you toggle the flight icons on and off the TSD. Either Show or Hide Flights appears on the Flights menu, depending on whether flights are currently displayed.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
<th>Semicolon Method</th>
</tr>
</thead>
</table>
| 1. Pull down the Flights menu by clicking Flights on the main menu or pressing <Alt> F.  
2. Click Show Flights or Hide Flights or press F | F | None |

**Resulting Display**

When you issue Show Flight, if a flight set has been selected, a display like the following appears.

![Flights in Holding Pattern with icons](image)
Depending on the flight set, there are several icons that can appear on the display. The following table explains each icon type.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Det icon. Changes to a jet aircraft icon when zoomed in.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Jet aircraft icon.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Ghost aircraft. No data received for seven minutes</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Heavy aircraft icon.*</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Props aircraft icon.*</td>
</tr>
<tr>
<td>![Icon]</td>
<td>RVSM non-conformant flight icon.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>If Monitor Alert is on, this icon represents either proposed flights or flights estimated to have landed. If Monitor Alert is off, it represents only flights estimated to have landed. A flight estimated to have landed is removed from the display after the next update if no new information has been received.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Racetrack icon. Flights in a holding pattern.</td>
</tr>
</tbody>
</table>

* This icon appears only when you select the Automatic flight icon in the Select Flights dialog box

Solid airplane icons and hollow airplane icons (ghosts) can point in up to 16 directions to show the general direction the flight is traveling in. The solid airplane icons represent flights whose positions have been reported through actual data. If the FTM has not received information about a flight for over seven minutes, its solid airplane icon becomes a ghost, meaning that the flight’s exact position cannot be determined. If the FTM estimates that the flight has landed, its ghost disappears.
The circle icons may appear when Monitor Alert is active and you are showing Examined Flights for an element you are examining. One circle icon can stand for many flights, all of which are scheduled to depart from the same airport between the present time and the time interval for which you are viewing alerted flights.

Data Updates

During transmission of near real-time flight data, updated information transmits to the flight server node at least once every five minutes. However, the positions are estimated between data updates so that the screen display changes every minute.

No Radar Symbol

If no flight data is received from one or more ARTCCs (via the host computer) a No Radar symbol appears at the ARTCC designation on the display. The icon looks like this:
### Select Flights Command

**Select Flights** command lets you create and manipulate flight sets for display on the TSD. You can:

- limit the set of flight icons to one or more groups of flights
- use colors to highlight one or more groups of flights
- specify which icons should represent the flight sets
- save your flight sets for future use

After you issue **Select Flights**, all non-selected flights disappear from the display. Show Flights must be turned on to see your selected flight sets.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Flights menu by clicking <strong>Flights</strong> on the main menu or pressing <code>&lt;Alt&gt;F</code>.</td>
<td></td>
</tr>
<tr>
<td>2. Click <strong>Select Flights</strong> or press <strong>S</strong>.</td>
<td><strong>None</strong></td>
</tr>
</tbody>
</table>

#### Semicolon Method

Input Request:

- **SELECT DATA BLOCKS** or **SDB DEP AD**
- **SELECT FLIGHTS** or **SF**
- **SELECT FLIGHTS AND COLOR** or **SFC**
- **DEFAULT AIRCRAFT COLOR** or **DAC**
- **SELECT COLOR** or **SC**

**Note:** Using the Semicolon method for any of the commands listed above will open a separate dialog box for that command. See Chapter 5 S-Z for complete description on using the Semicolon method for these commands.
Select Flights Dialog Box

When you click Select Flights or press the mnemonic key from the Flights menu, the Select Flights dialog box opens. The focus is in the Arrival field. To move from one field to another, press <Tab>.

![Select Flights Dialog Box](image)

**Note:** You can also open the Select Flights dialog box by placing the pointer on the TSD with no flights selected, clicking the right mouse button to display the generic right-click menu and clicking Select Flights.

Each type of button and text entry field is explained in the following table.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What you do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show</td>
<td>Toggles on and off a display of the flight set specified on the line.</td>
<td>Click the button to toggle a check mark on or off.</td>
</tr>
<tr>
<td>Icon</td>
<td>The Icon choice set lets you choose a flight icon: dot, airplane, or A (Automatic). When automatic is selected, the TSD changes automatically all flight icons in the selected flight set to a symbol representing the aircraft type: Heavy, Jet, or Prop.</td>
<td>Click the button with the left mouse button and click the desired icon type.</td>
</tr>
</tbody>
</table>
## Select Flights (Continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What you do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color</td>
<td>Lets you select a color for the flight set icons.</td>
<td>Click the button to display a color palette. Click your choice of color for the flight icons in the selected flight set.</td>
</tr>
<tr>
<td>Arrival</td>
<td>Limits the selection to flights traveling to any listed airport or to any airport within listed ARTCCs.</td>
<td>Enter one or more airport or ARTCC designators, separated by a space. Enter <strong>UNKW</strong> for unknown destination points. You may enter a maximum of 256 characters.</td>
</tr>
<tr>
<td>Departure</td>
<td>Limits the selection to flights departing from any listed airport or from any airport within listed ARTCCs.</td>
<td>Enter one or more airport or ARTCC designators, separated by a space. Enter <strong>UNKW</strong> for unknown departure points. You may enter a maximum of 256 characters.</td>
</tr>
<tr>
<td>Data Block</td>
<td>Toggles data blocks on and off.</td>
<td>Click the button to toggle a check mark on and off.</td>
</tr>
<tr>
<td>Org Dest</td>
<td>Toggles on and off an additional data block line indicating a flight’s origin and destination. Automatically turns off the Show Route option.</td>
<td>Click the button to toggle a check mark on and off.</td>
</tr>
<tr>
<td>Show Route</td>
<td>Toggles on and off an additional data block line showing the entire flight route text. Automatically turns off the org/dest option.</td>
<td>Click the button to toggle a check mark on and off.</td>
</tr>
<tr>
<td>Draw Route</td>
<td>Toggles on and off a drawing of the route.</td>
<td>Click the button to toggle a check mark on and off.</td>
</tr>
<tr>
<td>Filter</td>
<td>Displays another dialog box from which you can limit the flight display to specific flights, rather than all flights traveling to and from specified locations.</td>
<td>Enter filter option data from the Flight Set Filter table.</td>
</tr>
</tbody>
</table>
Data Block Displays

The following example illustrates a data block with the origin and destination line.

```
NWA661  ← Aircraft Call Sign
370 B727/U ← Altitude*/Aircraft/Equipment
145/375 2714 ← Time until Arrival/Groundspeed, Beacon Code
MAF DTW ← Origin and Destination
*Altitude shown in hundreds of feet
```

The next example illustrates a data block with the flight text route. In this example, the numbers at the end of the flight text [2211] represent the ETA for the flight based on TFMS calculations.

```
NWA661  ← Aircraft Call Sign
370 B727/U ← Altitude*/Aircraft/Equipment
145/375 2714 ← Time until Arrival/Groundspeed, Beacon Code
MAF DU C J66 MOTE R DTW/2211 ← Route
*Altitude shown in hundreds of feet
```

The next example illustrates a data block for a military flight with a two-digit prefix preceding the aircraft information. This field shows the number of aircraft flying in formation with this single call sign. Typically, this prefix is observed for military flights only.

```
UFT4789 ← Aircraft Call Sign
123 10/F 16/I ← Altitude*/Aircraft/Equipment
213/295 ← Time until Arrival/Groundspeed
*Altitude shown in hundreds of feet
```
Filter Button

Click the **Filter** button to the right of the row containing the selected flight set. The Flight Set Filter dialog box opens, similar to the one shown below.
The following table explains the items the Flight Set Filter dialog box.

You may enter a maximum of 256 characters into the text fields in the Flight Set Filter dialog box, except for the lowest and highest Flight Level fields, which are restricted to a maximum of four characters each.

### Flight Set Filter

<table>
<thead>
<tr>
<th>Filter option</th>
<th>Description</th>
<th>What you do</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACIDS</td>
<td>Limits the selection to flights of any listed airline.</td>
<td>Click in the field and enter one or more ACID(s) designators, (including designators ending with the * wildcard) separated by a space.</td>
<td>UAL1191 TWA25* TWA2?</td>
</tr>
<tr>
<td>Fixes Enroute</td>
<td>Limits the selection to flights traversing any listed fix.</td>
<td>Click in the field and enter one or more fix designators separated by a space.</td>
<td>BUCKS</td>
</tr>
<tr>
<td>Sectors Traversed</td>
<td>Limits the selection to flights traversing any listed sector.</td>
<td>Click in the field and enter one or more sector designators, separated by a space.</td>
<td>ZNY10</td>
</tr>
<tr>
<td>ARTCCs Traversed</td>
<td>Limits the selection to flights traversing any listed ARTCC.</td>
<td>Click in the field and enter one or more ARTCC designators, separated by a space.</td>
<td>ZNY ZBW</td>
</tr>
<tr>
<td>Airways Used</td>
<td>Limits the selection to flights using any listed airway.</td>
<td>Click in the field and enter one or more airway designators, separated by a space.</td>
<td>J80</td>
</tr>
<tr>
<td>Beacon Codes</td>
<td>Limits the selection to flights whose beacon codes begin with the specified value(s).</td>
<td>Click in the field and enter one or more beacon codes, including codes ending with the * wildcard, separated by a space. If the beacon code designator has four or more digits (exclusive of the * character), the TSD limits the selection to flights whose Beacon Code exactly matches the designator. The * wildcard character should be used for all beacon codes of fewer than four digits. The text field accepts up to 256 characters, including spaces.</td>
<td>1234 123*</td>
</tr>
<tr>
<td>Aircraft Types</td>
<td>Limits the selection to flights with specific types of aircraft, equipment, and remarks keyword.</td>
<td>Click in the field and enter one or more specific aircraft types, equipment prefix and suffix data, and remarks keywords.</td>
<td>See the A/C Type Filter Options section.</td>
</tr>
</tbody>
</table>
Flight Set Filter (Continued)

<table>
<thead>
<tr>
<th>Filter option</th>
<th>Description</th>
<th>What you do</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lowest Flight Level</td>
<td>Limits the selection to flights with current filed, reported, or both filed and reported altitudes at or above a specified altitude.</td>
<td>Click in the field and specify the flight’s altitude as <strong>F</strong> (filed), <strong>R</strong> (reported), or <strong>B</strong> (both filed and reported). Enter altitude in hundreds of feet.</td>
<td>F200 R250 B250</td>
</tr>
<tr>
<td>Highest Flight Level</td>
<td>Limits the selection to flights with current filed, reported, or both filed and reported altitudes at or below a specified altitude.</td>
<td>Click in the field and specify the flight’s altitude as <strong>F</strong> (Filed), <strong>R</strong> (reported), or <strong>B</strong> (both filed and reported). Enter altitude in hundreds of feet.</td>
<td>F350 R375 B375</td>
</tr>
<tr>
<td>Current/ Future RVSM Status</td>
<td>Limits the selection to current and future flights that RVSM conformant or RVSM non-conformant.</td>
<td>Click <strong>Non-conformant</strong> to eliminate from the flight set any flights that are RVSM conformant, both currently and in the future. Click <strong>Conformant</strong> to eliminate from the flight set any flights that are RVSM non-conformant currently and/or in the future. If you select <strong>All</strong>, the TSD does not filter flights based upon their RVSM status.</td>
<td></td>
</tr>
</tbody>
</table>

* After clicking **OK** in the Flight Set Filter dialog box, you are returned to the Select Flights dialog box. You need to click **OK** again to limit your flight selections to the filtered display.

A/C Type Filter Options

The A/C Type filter option includes aircraft and equipment types. Refer to Appendix A for tables listing sample entries and their descriptions for Remarks Keywords (Appendix A, Page A-21) and Equipment Types including Aircraft Types, Equipment Type Prefix and Equipment Type Suffix (Appendix A, Page A-22).
Flight Set Menu Options

The Flight Set menu lets you perform additional functions, which are defined in the following table.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What you do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Creates an extra line on the Select Flights dialog box. You can create another flight set on this line for display on the TSD.</td>
<td>Click Flight Set and click Add.</td>
</tr>
<tr>
<td>Copy</td>
<td>Adds a copy of a defined flight set to the first line of the Select Flights dialog box. You can edit the fields in the flight set to match your specifications.</td>
<td>Click the number to the left of the row that contains the defined flight set that you want to copy. Click Flight Set and Copy.</td>
</tr>
<tr>
<td>Delete</td>
<td>Removes a defined flight set from the Select Flights dialog box and from the TSD.</td>
<td>Click the number to the left of the row that contains the defined flight set that you want to delete. Click Flight Set and click Delete.</td>
</tr>
<tr>
<td>Delete All</td>
<td>Deletes all flight sets from the Select Flights dialog box and from the TSD.</td>
<td>Click Flight Set and Delete All.</td>
</tr>
<tr>
<td>Undo Delete</td>
<td>Returns the flights just deleted with Delete or Delete All.</td>
<td>Click Flight Set and Undo Delete.</td>
</tr>
<tr>
<td>Top</td>
<td>Establishes the priority order in which flights that meet criteria for more than one flight set are displayed.</td>
<td>Click the number to the left of the row that contains the defined flight set that you want to give top priority to. Click Flight Set and Top.</td>
</tr>
</tbody>
</table>

Saving the Flight Sets

After you select a flight set for display on the TSD, you can save that flight set and recall it later by issuing the Save command on the File pull-down menu on the Select Flights dialog box. The File menu is discussed in Chapter 2.

Ordering Flight Sets

Flight sets are ordered entities in the TSD, with the order of precedence being from the top of the list. Flights that belong to two or more sets are displayed according to the attributes of the top most set. The flight set at the top of the list takes precedence over all other flight sets in that list.
Copy a Flight Set
You can use the Copy command to create a new flight set based on a current flight set.

<table>
<thead>
<tr>
<th>What To Do</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Copy a flight set</strong></td>
</tr>
<tr>
<td>1. Click the left mouse button on the number of the row that contains the flight set you want to copy. This action selects the flight set.</td>
</tr>
<tr>
<td>2. Select <strong>Copy</strong> from the Flight Set menu. The system copies the selected flight set and places the new copy at the top of the list. You can now add additional criteria that define the flight set.</td>
</tr>
</tbody>
</table>

Drag and Drop Functions
You can reorder the position of the flight sets in the Select Flights dialog box by using a function called drag and drop.

<table>
<thead>
<tr>
<th>What To Do</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Reorder a flight set</strong></td>
</tr>
<tr>
<td>1. Click the left mouse button on the number of the row that contains the flight set you want to move. This action selects the flight set.</td>
</tr>
<tr>
<td>2. Hold down the middle mouse button. The pointer changes to a drag icon.</td>
</tr>
<tr>
<td>3. Move the drag icon to reposition it to a new row location.</td>
</tr>
<tr>
<td>4. Release the middle mouse button. The flight set moves to a row directly above the row number you pointed to. For example, if you drag Row 1 to Row 4 with the drag icon and release the middle mouse button, the flight set would be displayed in Row 3.</td>
</tr>
</tbody>
</table>

**Note:** If you drag a row below Row 4, that row will be displayed as Row 4.
Show/Hide Flight Count Command

**Show Flights/Hide Flight Count** command lets you toggle the Flight Count window on and off the TSD. Either Show or Hide Flight Count appears on the Flights menu, depending on whether the Flight Count window is currently on the display.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Flights menu by clicking Flights on the main menu or pressing &lt;Alt&gt; F.</td>
<td>None</td>
</tr>
<tr>
<td>2. Click Show or Hide Flight Count or press C.</td>
<td>None</td>
</tr>
</tbody>
</table>

## Flight Count Dialog Box

When you issue the Show Flight Count command, the Flight Count dialog box opens, showing the total number of active flights in the air, the number of active flights in each currently shown flight set, and the number of those active flights that are visible on the TSD.

In the sample above the first line contains the number of all departing and arriving active flights in the TFMS database. Below that is a flight set previously selected in the Select Flights dialog box. Each flight set shows the number of active flights arriving at and departing from specified airports and the number of those flights that are currently visible on the TSD. Flight icons within each flight set are displayed in the same color. The sample above shows 200 flights arriving at O'Hare Airport, with 176 of those flights visible on the TSD. From Boston, 68 flights are departing, with 65 of those flights visible.
Find Flight Command

The **Find Flight** command lets you specify the aircraft identification number (ACID) or beacon code of flights to locate on the display. When the flight is located, an airplane icon with a data block appears on the display for all occurrences of flights with the specified ACID. In the Find Flight dialog box you can use the File function to save, recall and delete lists of flights.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Flights menu by clicking <strong>Flights</strong> on the main menu or pressing <strong>&lt;Alt&gt; F</strong>.</td>
<td>@</td>
</tr>
<tr>
<td>2. Click <strong>Find Flight</strong> or press <strong>I</strong>.</td>
<td></td>
</tr>
</tbody>
</table>

**Semicolon Method**

None
Find Flight Dialog Box

When you issue Find Flight from the Flights menu or press the quick keys, the Find Flight dialog box opens. You can find a flight based on its beacon code, as well as its ACID. In the dialog box below, the beacon code 1462 has been entered. The number of found flights for a beacon code entry will be displayed. In the sample below, the number of found flights with beacon code 1462 is 3.

When you click OK or Apply, the TSD displays the found flights with their data blocks.

File Menu

The Find Flight dialog box has File Menu options which allows you to save, recall and delete lists of flights. See Chapter 2, TSD Basics (page 2-3) for information on using the File menu.
The following table explains how to use the Find Flight dialog box.

### Find Flight

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What you do</th>
<th>Example</th>
</tr>
</thead>
</table>
| Find Flight(s)           | Specifies the ACID or Beacon Code for the flight or flights to locate on the display. When the flight is located, a flight icon with a data block appears on the display. The flight identifier also appears in the Selected Flights column in the dialog box. | Enter a flight number or Beacon Code.  
Flight number may be entered with a wild card character for all flights for a specified airline, or all flights for a specified airline beginning with specific flight numbers. Click OK.  
Wild card characters are:  
* - any character string  
? - any single character | ACID: UAL214  
UAL2*  
UAL28?  
Beacon Code: 1462 |
| Color of Found Flight    | Specifies the color in which the flights and data blocks should appear.      | Click the button to display a color palette and click the desired color. The color box changes to the new color and after you click OK, all the flights listed in the Found Flights window change to your chosen color. |                    |
| Remove Selected Flight From List | Removes the data blocks from the flights specified by Find Flight and removes the flight identifiers from the Found Flights window. | Click the button to remove the flights from the list.                                         |                    |

**Note:** If a flight is a member of a shown flight set, it is displayed in the color that is defined in Select Flights. However, its data block will be shown.
**Customize Command**

**Customize** command lets you determine some aspects of how flights appear on the TSD by clicking buttons in a dialog box. This command lets you display data blocks and add lines of information to them. Also, you can draw routes, the history for flights currently on the TSD, an asterisk at the position of the last TZ received for a flight, and a lead line for all displayed flights.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Flights menu by clicking <strong>Flights</strong> on the main menu or pressing <strong>&lt;Alt&gt; F</strong>.</td>
<td></td>
</tr>
<tr>
<td>2. Click <strong>Customize</strong> or press <strong>M</strong>.</td>
<td></td>
</tr>
<tr>
<td>None</td>
<td></td>
</tr>
</tbody>
</table>

**Semicolon Method**

None

**Customize Flight Display Dialog Box**

After you have issued Customize, the Customize Flight Display dialog box opens. The dialog box is divided into three areas: Show, Draw, and History.

![Customize Flight Display Dialog Box]

**Note:** This function also affects flights found through the Find Flights command.
The following table explains how to use the Customize Flight Display dialog box.

### Customize Flight Display

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What you do</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Show</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Data Blocks</td>
<td>Identifies the flight, the flight’s altitude, the aircraft type, the ground speed, and the time (in minutes) until arrival. This time is based on the TFMS Estimated Time of Arrival.</td>
<td>Click the button to display a check. Click <strong>OK</strong> to display data blocks for all flights on display. To remove the data blocks, click the button to remove the check and click <strong>OK</strong>.</td>
<td>Leader lines connect each data block with the flight to which it refers.</td>
</tr>
<tr>
<td>Beacon Code</td>
<td>Controls whether the beacon code is shown in the data block.</td>
<td>Click the <strong>Beacon Code</strong> checkbox to display the beacon code in the third line of the flight data block.</td>
<td>One or more data blocks must be displayed to see the effect of this command.</td>
</tr>
<tr>
<td>Org/Dest</td>
<td>Displays an additional line of data block information identifying the flight’s origin and destination. When the command is issued, any data blocks currently displayed are appended with an additional line showing the airports of origin and destination for the flight. The Org/Dest and Route options cannot be selected simultaneously.</td>
<td>Click the <strong>Org/Dest</strong> button, and click <strong>OK</strong> to append the origin/destination information to all data blocks that are currently displayed. To remove the appended lines, click the <strong>Off</strong> button and click <strong>OK</strong>.</td>
<td>One or more data blocks must be displayed to see the effect of this command.</td>
</tr>
<tr>
<td><strong>Show Route</strong></td>
<td>Adds the textual flight route as part of a standard data block. When the command is issued, any data blocks currently displayed are appended with an additional line showing the flight route.</td>
<td>Click the <strong>Route</strong> button, and click <strong>OK</strong> to add the flight route text information to the data blocks. To remove the appended line, click the <strong>Off</strong> button and click <strong>OK</strong>.</td>
<td>One or more data blocks must be displayed to see the effect of this command.</td>
</tr>
</tbody>
</table>
## Customize Flight Display (Continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What you do</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Draw</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Draw Route</td>
<td>Draws the route of every flight which is currently displayed.</td>
<td>Click in the field to display a check. Click OK to draw the routes on the display.</td>
<td>Each route looks like a solid line and appears in the same color as the airplane icon and its data block.</td>
</tr>
<tr>
<td>Last TZ</td>
<td>Graphically identifies the last reported position of each flight and draws a dotted line from that point to the appropriate flight icon.</td>
<td>Click the button and click OK. To remove the dotted line from the display, click Last TZ again. Make sure Show Flights is on.</td>
<td>If no TZ has been received for a flight, the TSD draws nothing for that flight.</td>
</tr>
<tr>
<td>Lead Lines</td>
<td>Displays dotted lines leading from the noses of the airplane icons to forecast the position of flights over a period of time or a distance that you specify.</td>
<td>Click Lead Lines to expand the dialog box to include the Lead Lines Specifications section.</td>
<td>See the following Lead Line section (page 4-66) for procedures on using this section.</td>
</tr>
<tr>
<td>RVSM Non-Conformant Indicators</td>
<td>Draws squares around non-conformant flights when they are displayed on the TSD.</td>
<td>Click in the RVSM Non-Conformant Indicators checkbox.</td>
<td>See the RVSM Non-Conformance Indicators section (page 4-66).</td>
</tr>
<tr>
<td><strong>History</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Collect History every:</td>
<td>Tells the TSD to begin collecting historical data.</td>
<td>Click to display a check. Click the up or down arrow to set the minutes. To stop collecting history, click Collect History every again.</td>
<td>The default frequency in minutes that the TSD should collect the history is 5. You can increment or decrement this number of minutes.</td>
</tr>
<tr>
<td>Draw</td>
<td>Shows the successive positions of a flight at each of the flight’s updates that you established in the Collect History every field.</td>
<td>Click Draw to display a check. If necessary, issue Show Flights. To remove the drawing from the TSD, click Draw again.</td>
<td>The TSD draws a dashed line connecting the flight’s previous locations. The history appears in the same color as the flight icon.</td>
</tr>
</tbody>
</table>

If you turn on Data Blocks using the Customize command, the Org/Dest or Route selections override those selected in the Select Flights dialog box. However, if you do not turn Data Blocks on using the Customize command, the Select Flights dialog box takes precedence.
Using the Lead Lines Specification Section

The Lead Lines Specification section of the dialog box lets you specify the lead time in minutes and the lead distance in nautical miles. The default value for Lead Time is five minutes; the default value for Lead Distance is 40 miles. The following procedure illustrates how to change the values in either the lead time in minutes field or the lead distance in nautical miles field.

<table>
<thead>
<tr>
<th>What To Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change the values</td>
</tr>
<tr>
<td>1. In the Customize Flight Display dialog box, select <strong>Lead Lines</strong> to activate the Lead Lines Specification portion of the dialog box.</td>
</tr>
<tr>
<td><img src="image" alt="Lead Lines Specification" /></td>
</tr>
<tr>
<td>2. Enter the values for either Lead Time or Lead Distance.</td>
</tr>
<tr>
<td>• To change the Lead Time value, click the down arrow and on one of the values that appear on the display. You can also type the value in the text field to the right of the Lead Time button.</td>
</tr>
<tr>
<td>• To change the Lead Distance value, click the down arrow and on one of the values that appear on the display. You can also type the value into the text field.</td>
</tr>
<tr>
<td>3. Click <strong>OK</strong> to implement your changes and to close the Customize Flight Display dialog box.</td>
</tr>
</tbody>
</table>

RVSM Non-Conformant Indicators

When you select the **Non-Conformant Indicators** option, the TSD displays data for non-conformant flights as follows:

- At each airport with inactive flights on the ground, the TSD displays the number of inactive flights predicted to be RVSM non-conformant when they are in any of the objects (sectors or FEA/FCAs) for which flights are being drawn.
- If the data block is shown for examined flights on the ground, the TSD inserts “NC” before each flight that is RVSM non-conformant in at least one of the objects (sectors or FEA/FCAs) for which flights are currently being drawn.
Alerts Menu

Overview

In this section you will learn how to use the commands available on the Alerts menu and sub-menus in Normal mode. The section presents information on displaying alert symbols, selecting and examining alerted elements, acquiring additional information on traffic demands of airports, sectors, and fixes using the NAS Monitor and System Summary, and setting preferences for displaying alerts.

For information on how to use the NAS Monitor in Model mode, see page 4-418 in Chapter 4, Reroute Impact Assessment.

Each of the following topics corresponds to an item on the Alerts pull-down menu.

• **Show/Hide Alerts Command**  Page 4-69
  Toggles the alert symbols on and off the TSD

• **Select Alerts Command**  Page 4-73
  Lets you limit the display of alerted elements to a selected group or groups

• **Examine Alerts Command**  Page 4-75
  Lets you obtain more details about traffic demands on a particular airport, sector, or fix
• **Alarms Command**  
  Lets you turn alarms on or off, specify elements for alarms, and set parameters  

• **Show NAS Monitor Command**  
  Lets you view in one display the alert status of all sectors within selected Centers  

• **Preferences**  
  Lets you define preferences for displaying alerts
The term alerts refers to areas in which the traffic demand is projected to exceed a pre-defined Monitor Alert Parameter (MAP). The following three types of display elements can be placed on alerted status:

1. **Airports**
   Traffic demands are based on the projected numbers of flight arrivals and departures during a time interval. Excessive arrivals or departures trigger alerts independently.

2. **Sectors**
   Traffic demands are based on the greatest number of flights projected to be within the sector at any instant during a particular time interval (peak load.)
A plus (+) or minus (-) sign is appended to a sector label if that sector is not in its baseline form. Right-clicking an alerted sector opens a right-click menu.

If more than one sector is alerted at the pointer location, right-clicking opens a cascading menu with options for all sectors alerted at that location. Each option contains a description of the current configuration for the sector. In the example below, sector ZAB16 currently has sectors ZAB70 and ZAB79 combined into it. The label for sector ZAB16 includes its 3-character Center prefix and the expanded description displays as ZAB16+70,79.

If the RVSM option is selected in the Select Alerts for Display dialog box (Select Alerts menu) or if the RVSM Sector Alerts option is selected in the Select RVSM Display Options dialog box (Display menu, RVSM option), RVSM alerts are displayed on the TSD.
If the sector does not meet the conditions for drawing a standard alert, the TSD draws the sector with a blue horizontal line fill as shown below. The label is displayed with a lighter blue.

If the sector does meet the conditions for drawing a standard alert, the TSD draws the sector as before, but with the addition of a horizontal line in the same color as the sector alert.

3. **Fixes**
Traffic demands are grouped according to the sector altitude limits into which they fall, and are based on the total number of flights projected to encounter the fix during a specific time period and within a certain altitude range.
The following illustration shows the alert element symbols:
Select Alerts Command

The Select Alerts command lets you limit the display of alerted airports, sectors, and fixes to a selected group or groups.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
</table>
| 1. Pull down the Alerts Menu by clicking Alerts on the main menu or pressing <Alt> A.  
2. Click Select Alerts or press S. | None |

Semicolon Method

Input Request: SELECT ALERTS or SA

Select Alerts for Display Dialog Box

After you click Select Alerts or press the mnemonic key from the Alerts menu, the Select Alerts For Display dialog box opens.
The following table explains each item in the Select Alerts For Display dialog box. Make your selections and click **OK** or **Apply**.

**Select Alerts**

<table>
<thead>
<tr>
<th>Item</th>
<th>What you do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Airports: All</td>
<td>Click in the checkbox to display all alerted airports. All airports are selected by default.</td>
</tr>
<tr>
<td>Sectors: Low, High, Superhigh</td>
<td>Click in one or more checkboxes to specify which type of alerted sectors you want to display.</td>
</tr>
<tr>
<td>Fixes: Low, High, Superhigh</td>
<td>Click in one or more checkboxes to specify which type of alerted fixes you want to display.</td>
</tr>
<tr>
<td>RVSM</td>
<td>Click the button to display RVSM alerts.</td>
</tr>
<tr>
<td>Time Limit</td>
<td>Click in the <strong>Time Limit</strong> field and enter the hours directly, or click the up or down arrows to increment or decrement hours and minutes. The standard default time limit is 2.25 hours, but this depends on what has been saved in the defaults file. The maximum time limit is six hours. <strong>Note:</strong> Any changes you make to the Alert Time Limit through the Select Alerts command are reflected in Set Alert Time Limit through the NAS Monitor.</td>
</tr>
</tbody>
</table>

**Note:** Clicking **OK** or **Apply** will automatically Show Alerts. However, if Hide Alerts has been issued, you will not see your selected alerted elements on the TSD when you save and close the Select Alerts for Display dialog box. If alerts are currently drawn on the display, the TSD redraws alert icons to reflect the new time limit.
## Examine Alerts Command

The **Examine Alerts** command lets you obtain more details about traffic demands on a particular airport, fix, or sector.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
</table>
| 1. Pull down the Alerts Menu by clicking **Alerts** on the main menu or pressing <Alt> A.  
2. Click **Examine Alerts** or press E. | Press E with the pointer on the alerted element. |

### Semicolon Method

**Input Request:**

- EXAMINE or E

## Using the Quick Key Option

To display a NAS Monitor with a row showing the alert status for a particular alerted element, place your pointer on that element and press the mnemonic key for the Examine Alerts function. This opens the NAS Monitor that is specified in the NAS Monitor Preference dialog [see the Preferences command on page 4-134] and displays a row for that alert element, as shown below, without first opening the Examine Alert dialog box.
Using the Menu Option

After you click **Examine Alerts**, the Examine Alert dialog box opens. Enter the name of an airport, fix, or sector in the Place field and click the appropriate button to specify the element type.

![Examine Alert Dialog Box](image)

Click **OK** or **Apply**. A NAS Monitor appears for your selected item along with a NAS Monitor Control Panel.

**Map On and Map Off Parameters**

The alert status for sectors is controlled by two Monitor Alert Parameters: MAP On and MAP Off. A sector will become alerted when the peak traffic count exceeds the MAP On value. It will not become unalerted until the peak traffic count becomes equal to or less than the MAP Off value.

If the MAP On and MAP Off parameters are different, you must be careful to interpret the alert status of sectors correctly. In some cases, sectors with the same peak counts and map parameters may have different alert statuses.

**Same MAP On and MAP Off Parameters**

In the example below, the MAP On/MAP Off parameters are the same. The 1930, 1945, 2000, and 2015 intervals are alerted since they are all above the 18 MAP On and MAP Off.

![Custom NAS Monitor](image)
In the next example, notice that the 1930 and 1945 intervals are now unalerted, as the peak count returns to 18.

Different MAP On and MAP Off Parameters

In the next example, the MAP On parameter for sector ZDC35 is 18, and the MAP Off parameter is 16.

The 2030 interval for sector ZDC35 is alerted even though the peak count of 17 is less than the MAP On count of 18. The reason is that this interval was previously alerted. It stays alerted until the peak count is still equal to or less than the MAP Off value of 16.

Note: The 2130 interval for ZDC35 has a count of 17 and is not alerted. The reason is that it never reached a peak count above 18 and, therefore, was never alerted.

Show/Hide Baseline

The NAS Monitor identifies a sector into which one or more other sectors have been combined by displaying a + sign in its row label and displays alert data for the sector in its current configuration. To show a row of data for the sector, and each sector combined into the sector, in its baseline configuration, right-click the row label and select the Show Baseline menu option. Rows of alert data displayed in gray with their element labels in parentheses indicate baseline data. The counts in these rows represent the peak 1-minute counts predicted for the sectors in their baseline configuration. When Hide Baseline is selected after right-clicking the row label, the additional rows are removed from the NAS Monitor and a single row of alert data for the sector in its current configuration displays.

Note: You can also toggle the Show/Hide Baselines option by clicking the Show/Hide All Baselines button or selecting the Show All Baselines option on the Customize menu.
RVSM

If you select RVSM on the Display menu and select RVSM Counts in the resulting Select RVSM Display Options dialog box, the RVSM counts are displayed on the NAS Monitor. The TSD displays the peak one-minute counts of flights that are predicted to be RVSM non-conformant at any time when they are in the examined sector, based on the current configuration of the sector. The TSD displays this count as a white number over a square black background in the cell as shown below.

Alerted Element Colors

The significance of each of the various colors is represented in time bars for each element.

### NAS Monitor Colors

<table>
<thead>
<tr>
<th>Color of time bar segment</th>
<th>What it represents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>No alerts</td>
</tr>
<tr>
<td>Yellow</td>
<td>Alert for proposed flights</td>
</tr>
<tr>
<td>Red</td>
<td>Alert for active flights</td>
</tr>
<tr>
<td>Green with yellow stripe</td>
<td>Previous alert for proposed flights-alert resolved by a Traffic Management Unit (TMU)*</td>
</tr>
<tr>
<td>Green with red stripe</td>
<td>Previous alert for active flights-alert resolved by a Traffic Management Unit (TMU)*</td>
</tr>
<tr>
<td>Uncolored</td>
<td>No data available, or data are being requested</td>
</tr>
</tbody>
</table>

*See the Turn Green option on page 4-128 for additional information.

The total number of flights projected to arrive at, or depart from, or traverse the specified alerted element appears in the dialog box at 15-minute intervals.
### Alarms Command

The **Alarms** command lets you set or see the status of audible and/or visual alarms for Monitor Alert. When Alarms and Show Alerts are on, the system beeps and/or flashes for any alerted element identified in the Alarm Specifications dialog box. While elements remain alerted, the alarm is produced at each update. This command turns the alarm on or off and allows you to see the current status (number of alarms set for alerted elements) or to modify the current alarm settings.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
</table>
| 1. Pull down the Alert menu by clicking **Alerts** on the main menu or pressing **<Alt> A**.  
2. Click **Alarms** or press **L**. | None |

#### Semicolon Method

Input Request:
- **ALARM ON** or **OFF** or **STATUS** or **READ**
Alarms Specifications Dialog Box

When you click Alarms or press the mnemonic key from the Alerts menu, the Alarm Specifications dialog box opens.

[Image of the Alarms Specifications Dialog Box]

- **Alarm Status**: ON or OFF
- **Elements for Which Alarms are to be Issued**
  - Airports
  - Low Fixes
  - High Fixes
  - SuperHigh Fixes
  - Low Sectors
  - High Sectors
  - SuperHigh Sectors
- **Alarm Parameters**
  - Issue Alarms for: Red Alerts, Yellow Alerts
  - Issue Alarms by: Beeping, Flashing
- **Beep Parameters**
  - Length of Tone: 2
  - Number of Tones per Ring: 5
  - Number of Rings: 4
The Alarm Specifications dialog box has four parts:

1. **Alarm Status**
   
   Turns the alarm on or off.
   
   Click **ON** or **OFF**.

2. **Element for which Alarms are to be Issued**
   
   Enter single or multiple names of the appropriate airport, fix, or sector. Use a space between multiple entries.

3. **Alarm Parameters**
   
   Specifies alarms for active and proposed flights.
   
   For active flights, click the button to issue alarms for red alerts. For proposed flights, click the button to issue alarms for yellow alerts. Click a button to specify the alarm as a beep and/or a flash. Note that at least one checkbox must be selected. However, both may be selected.

4. **Beep Parameters**
   
   Controls how a beep sounds.
   
   Enter a number for the length of tone in seconds, number of tones per ring, and the number of rings.

   After you enter these fields, click **OK** or **Apply** to set the alarms.

**File Menu**

You can use the File pull-down menu to save the alarm specifications to be recalled and/or deleted at a later time. For more information, refer to the section on File Pull-Down Menu, on page 2-3 in Chapter 2, TSD Basics.
### Show NAS Monitor Command

The **Show NAS Monitor** command provides access to menu options that let you display peak counts and the alert status for NAS elements.

The process that creates NAS Monitor and System summary is the Almon process, an optional process started by each user’s TSD when these monitors are displayed.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Alert menu by clicking <strong>Alerts</strong> on the main menu or pressing <code>&lt;Alt&gt;</code> A.</td>
<td>None</td>
</tr>
<tr>
<td>2. Click <strong>Show NAS Monitor</strong> or press N.</td>
<td>Semicolon Method</td>
</tr>
<tr>
<td>3. Click one of the commands from the <strong>Show NAS Monitor</strong> sub-menu or press its mnemonic key.</td>
<td>None</td>
</tr>
</tbody>
</table>

See page 4-85 for sub-menu choices.

**Note:** This section describes how to use the NAS Monitor in Normal mode. For information on using the NAS Monitor in Model mode, see page 4-418 in Chapter 4, Reroute Impact Assessment.

### Managing NAS Monitor Windows

NAS Monitor windows are managed separately from their "parent" TSD providing users flexibility working with limited screen space. For example, if a user minimizes the TSD display, the action will have no effect on any open NAS Monitor windows associated with the TSD. If the NAS Monitor Control Panel is minimized, all windows that belong to the NAS Monitor process are minimized together and have no effect on the TSD display.

**Note:** For more information on managing TSD windows in the Red Hat Linux environment see TFMS Basics, Window Management on page 1-2.
To manage multiple windows and efficiently move between an active TSD display and any associated NAS Monitor dialog boxes, the following methods are available.

- **NAS Monitor Button**
- **Quick Keys**
- **Window List**

**NAS Monitor Button**

Use the NAS Monitor button if the TSD display overlays all open NAS Monitor windows and you want to bring all of the windows to the front. The NAS Monitor button displays to the right of the RVSM Status icon on the menu bar when a NAS Monitor is opened. If you position the cursor over the NAS Monitor button, the TSD displays the tool tip, "Bring NAS Monitors to Front," as shown below.

After you click on the NAS Monitor button, any open NAS Monitor windows overlay the display in the order in which they are listed in the NAS Monitor Control Panel with focus on the top most monitor.
Quick Keys

Use the quick keys `<Alt>` and `<Tab>` to display a palette with icons representing all open windows and to give a particular one focus.

Do the following:

1. While holding down the `<Alt>` key, press the `<Tab>` key once to display the palette. The palette displays an icon for each open window. A black line outlines the currently selected window.
2. Hold the `<Alt>` key down and press the `<Tab>` key once to select the next icon on the palette. As you move from one icon to the next, the name of the selected window displays at the bottom of the palette.
3. Release the `<Alt>` key to bring a selected application into focus.

Window List

The Window List on the Bottom Edge Panel displays a button for each open application. You can use the Window List to give a window focus by clicking on its button.

In the following example there are seven open windows in the Window List - two Terminal windows, a TSD, a NAS Monitor Control Panel, and three NAS Monitors. The ZAU NAS Monitor has focus on the display screen so its button is shaded in the Window List.

**Note:** A typical GNOME setup includes the Bottom Edge Panel. Your System Administrator may set your default Bottom Edge Panel according to your local requirements, so your display may appear slightly different.
Opening a NAS Monitor

The NAS Monitor command lets you display peak counts and the alert status for NAS elements that may include all sectors in a Center, selected sectors in a Center, airports, or fixes. Clicking **Show NAS Monitor** on the Alerts menu opens a sub-menu from which you can choose the following NAS Monitor options: Custom, ARTCC, Canadian, and System Summary. Clicking one of the sub-menu options opens the NAS Monitor dialog box and the NAS Monitor Control Panel. The sub-menu options are described as follows:

- **Custom**
  Use the Custom option if you want to manually create a list of sectors, airports, and/or fixes for display on the NAS Monitor. After you select **Custom**, the NAS Monitor dialog box opens with no alert data displayed. Click the **Select Elements** button to access the Select Monitored Elements dialog box and select the elements you want to monitor. See page 4-102 for more information on the Select Monitored Elements dialog box.

- **ARTCC**
  Use the ARTCC option to monitor all sectors in a center selected from an alphabetical list of US centers. The alphabetical list of US centers is a sub-menu of the ARTCC option.

- **Canadian**
  Use the Canadian option to monitor all sectors in a center selected from an alphabetical list of Canadian centers. The alphabetical list of Canadian centers is a sub-menu of the Canadian option.

- **System Summary**
  Use the System Summary option to view a system-wide summary of alert status by ARTCC. You can display the NAS Monitor from the Systems Summary dialog box by clicking on a Center name in the left column of the Systems Summary. The System Summary is discussed in detail on page 4-110.
System Summary Dialog Box

Selecting **System Summary** opens the System Summary dialog box and the NAS Monitor Control Panel. The NAS Monitor Control Panel is displayed whenever a System Summary Dialog or NAS Monitor is displayed. See the section on NAS Monitor Control Panel on page 4-90 for detailed information.

From the Control Panel you can open an additional NAS Monitor or System Summary or bring focus to a selected NAS Monitor or System Summary dialog box.

Using the System Summary Dialog Box

The colors in the System Summary dialog box indicate the highest alert status for any sector in the Center for that 15-minute interval. The numbers indicate how many sectors have a red and/or yellow status within the 15-minute interval. A single number on a yellow interval indicates the number of sectors that have a yellow alert. The two numbers on a red interval indicate the number of sectors with a red alert status followed by the number with a yellow alert status.
To open a NAS Monitor with the selected center as the primary center, click on a **System Summary** row label.

**Note:** When alert data goes out of date on the System Summary dialog box, the last update time in the upper right corner displays in red and flashes for one minute.

**Display Range**

The System Summary dialog box lets you change the amount of alert data displayed by using the display range. To change the display range, click on the number of hours you would like to display, or click anywhere on the blue shaded segment and drag it to the number of hours you would like to display. The display range in the sample below is four (4.00) hours.

![System Summary](image)

**Functions Menu**

Selecting **Functions** opens the Functions menu with the following options.

- Show NAS Monitor
  - This option has the following submenu.
    - Custom
    - ARTCC
    - Canadian
  - Close

You can use the Show NAS Monitor sub-menu to open a NAS Monitor.
Customize Menu

The Customize menu provides the options for customizing the display of data on the System Summary. The following options are available.

- Top
- Tier
- Show Canadian
- Show/Hide Options Panel

**Top**

Use the Top option to select the Center to be shown at the top of the Systems Summary dialog box. You can click the pull-down button in the Top field on the System Summary dialog box to display a list of Centers or select the Top option from the Customize menu and select a center from the submenu. The remaining Centers are arranged by tier from the top center and then alphabetically within each tier.

**Tier**

Use the Tier option to select a group of Centers in geographical proximity to the Top Center. To select a tier, click the pull-down button in the Tier field on the System Summary dialog box or select the Tier option from the Customize menu and select a tier from the submenu. For example, if you select ZNY in the Top field and then click on the Tier arrow and select 1st Tier, you will see ZNY and its first tier Centers.
Selecting 2nd Tier would open a window like the following, with the addition of the second tier Centers.

Show Canadian

To select or deselect Canadian Centers, click in the Show Canadian checkbox on the System Summary dialog box or select the Show Canadian option on the Customize menu.

Show/Hide Options Panel

To show or hide the Options Panel, select or deselect the Show/Hide Options Panel option on the Customize pull-down menu at the top of the NAS Monitor window. The NAS Monitor with the Options Panel hidden looks like the sample below with the ZAB row shown in the top position, and with the options panel hidden.
NAS Monitor Control Panel

Clicking any option on the Show NAS Monitor sub-menu opens both the selected option and the NAS Monitor Control Panel. In the example shown below, the sub-menu option ARTCC and the center ZNY were selected. The name of the selected center is displayed as an icon on the NAS Monitor Control Panel.

![Image of NAS Monitor Control Panel]

On the NAS Monitor Control Panel, you can click the pull-down arrow button to display a list of US Centers presented in alphabetical order followed by Canadian centers in alphabetical order. Clicking a Center name opens the NAS Monitor dialog box for that selection and adds that Center’s icon to the open NAS Monitor Control Panel. Clicking a Center icon brings focus to that Center's NAS Monitor if it is already displayed but covered by another window.

The pull-down list also provides a Custom entry at the top and a Summary entry at the bottom of the list. Select Custom to open a NAS monitor for which you want to manually create a list of NAS elements for display. Select Summary to open the Systems Summary dialog box. The sample below shows the NAS Monitor Control Panel displaying the ZNY and System Summary icons.

![Image of NAS Monitor Control Panel with Custom and Summary options]

Display and Functions Pull–Down Menus

There are three menu items on the Control Panel: Display, Functions and Help.

The Display menu contains two menu items:

1. Adapt
   The Adapt command has a sub-menu of commands: Recall, Save, and Delete. These work in the same manner as the Adapt sub-menu items on other TSD dialog boxes. After you establish your preferences on the NAS Monitor dialog box, explained in the Preferences command, you can save to a file, recall the file, or delete the file.
2. **Close All Monitors**
   Close All Monitors closes all NAS Monitors and System Summaries currently open on your screen.

The **Functions** pull-down menu on the NAS Monitor Control Panel contains the two menu items: **Show NAS Monitor** and **Set Alert Time Limit**.

1. **Show NAS Monitor**
   The Show NAS Monitor command has a sub-menu from which you can choose the following NAS Monitor options: Custom, ARTCC, Canadian, and System Summary. These options are described on page 4-85.

2. **Set Alert Time Limit**
   Clicking the **Set Alert Time Limit** command opens the following dialog box:

   ![Set Alert Time Limit Dialog Box](image)

   The **Set Alert Time Limit** command allows you to change the time limit for displaying alerted NAS elements on the NAS Monitor.

   Clicking on the up or down arrows changes the time limit in quarter-hour increments. You can select a minimum time limit value of 0.25 and a maximum of 6.0 hours.

   **Note:** After you change the Alert Time Limit through the Set Alert Time Limit command, the Alert Time Limit in Select Alerts reflects the change.

The **Help** menu on the NAS Monitor Control Panel provides Help and Version and Site Info options.

The **Version and Site Info** command lets you display a dialog box showing what version of the TSD is associated with an ALMON process. The Version and Site Info dialog box displays the version number, build number, and compile date for the currently running ALMON process. Additionally, the dialog box provides the ALMON process ID, the source sites (local and hub) for alert data, and the process ID of the parent TSD.

1. Pull down the Help menu by clicking **Help** on the NAS Monitor Control Panel or pressing `<Alt> H`.

2. Click **Version and Site Info** or press **V**.
After you click **Version and Site Info** or press the mnemonic key from the Help menu, the Version and Site dialog box displays.
Using the NAS Monitor Dialog Box

The NAS Monitor dialog box displays alert information in table form with NAS elements along one axis and 15-minute time intervals along the other. Each row in the table displays a NAS element label. Monitor/Alert Parameter (MAP) values display to the right of the row label and apply to the first time interval in a row. The rows for sectors display both upper and lower MAP values. Each cell in the table displays the alert status of the corresponding NAS element during the corresponding time interval. The time when Alert data was last updated displays in the Updated field. If Alert data times out, the update time displays in red and flashes for one minute.

A Show Flights checkbox, a flight icon button, and a color button displays to the left of every row in the monitor. Used with the Show Examined Flights button, the Show Flights checkboxes let you select the individual sectors, fixes, or airports for which you want to display flights.
The NAS Monitor title bar displays the name of the selected center or "Custom," if the Custom menu option was selected. The title bar also indicates whether the monitor is set to Relative Time Range or Absolute Time Range. In the previous example, the NAS Monitor title bar indicates that data displays for the center ZNY and that the monitor is set to Relative Time Range.

**NAS Monitor Element Labels**

NAS element labels identify the sectors, fixes, and airports for which alert data displays in the NAS Monitor. NAS element labels are formatted as follows.

### Sectors

If you open a NAS Monitor selecting a primary US center, the row labels for the sectors display without their 3-character center prefix. The rows for all other US or Canadian centers added to the monitor display a label that includes the 3-character center prefix. In the following example, ZDC was selected as the primary center and sectors from center ZNY were added through the Select Elements option. The labels for the sectors in primary center ZDC display without their prefix.
Current and Baseline Sectors

The NAS element label for a current sector may display a + or - sign. A label containing a + sign indicates that the sector contains at least one other sector fully or partially combined into it. If you place the cursor over the label, a tool tip displays with an expanded description of the current configuration of the sector. The tool tip displays the sector ID, a plus symbol, and a comma-separated list of sector IDs for each sector combined into the "parent." In the example below, ZBW48 and ZBW59 is combined into ZBW46. The tool tip for ZBW46 therefore displays as "46+48,59."

If the Show All Baselines option is toggled on, the monitor displays an additional row in gray for the "parent" sector and each sector combined into it. The sector labels for these rows display in parentheses indicating that alert data displays for the sector in its baseline configuration.
If a portion of a sector has been combined into another sector but the rest of the sector remains open, the NAS element label displays a - sign to the right of the sector ID. In the example below, sectors ZOA30 and ZOA33 each have a portion combined into another sector.

**Note:** If a selected sector is partially or fully combined with another sector or sectors, the NAS Monitor will display a row for the "parent" sector into which it is combined, even if the "parent" sector is not specified in Select Elements.
TRACONS

The row for a TRACON on the NAS Monitor displays a label that includes the 3-character TRACON prefix.

Fixes

The row for a fix on the NAS Monitor displays a label that includes the fix ID with the altitude level (L,H,S) in parentheses.
Airports

The row for an airport on the NAS Monitor displays a label that includes the airport ID and indicates Departures (D) or Arrivals (A).
NAS Monitor Right-Click Menu

Pressing the right mouse button on a cell in the NAS Monitor opens the NAS Monitor right-click. When you invoke the Right-Click menu, the location of the mouse pointer when you press the right mouse button and the state of the Show Flights checkbox determine how the NAS Monitor responds.

<table>
<thead>
<tr>
<th>If the Pointer is located:</th>
<th>The NAS Monitor process</th>
</tr>
</thead>
<tbody>
<tr>
<td>In a selected row over a cell that is within the selected cell range or on the row label of the selected row that has the Show Flights checkbox unchecked</td>
<td>Preserves the row and cell selection.</td>
</tr>
<tr>
<td>In a selected row over a cell that is outside the selected cell range of the row that has the Show Flights checkbox unchecked</td>
<td>Preserves the row selection and changes the cell selection to the cell being pointed to.</td>
</tr>
<tr>
<td>On a row label of an unselected row that has the Show Flights checkbox unchecked</td>
<td>Selects the row by highlighting the row label and displays all the visible cells in the row with &quot;Level 2&quot; highlighting</td>
</tr>
<tr>
<td>On a row label in an unselected row that has the Show Flights checkbox checked</td>
<td>Selects the row by highlighting the row label, preserves the Level 1 cell selection but changes the cell highlighting to Level 2</td>
</tr>
<tr>
<td>On a cell in an unselected row that has the Show Flights checkbox unchecked</td>
<td>Selects the row by highlighting the row label and sets the cell highlighting to Level 2</td>
</tr>
<tr>
<td>On a cell within a Level 1 selected cell range of a row that has the Show Flights checkbox checked</td>
<td>Selects the row by highlighting the row label, preserves the Level 1 cell selection but changes the cell highlighting to Level 2</td>
</tr>
<tr>
<td>On a cell outside the Level 1 selected cell range of a row that has the Show Flights checkbox checked</td>
<td>Selects the row by highlighting the row label and sets the cell highlighting to Level 2</td>
</tr>
<tr>
<td>Somewhere other than a row label or cell in a row</td>
<td>Ignores the right-click mouse button</td>
</tr>
</tbody>
</table>

**Note:** For more information on Level 1 and 2 highlighting and the Show Flights checkbox, see the topic Show/Hide Examined Flights.

The right-click menu provides the following options.
- **Time in Sector** - Opens the Time in Sector chart for that particular sector.
- **Show/Hide Baseline** - Allows you to add or hide rows to the display that show the baseline counts for that selected sector and any sectors that have been added to the sector. Baseline counts are displayed in gray.
- **Bar Chart** - Opens a NAS Monitor Bar Chart for an examined sector.
- **Alerts Report** - Creates a flight list for an examined sector.
- **Turn Green** - (Disabled (grayed out) if the pointer is not over an alerted or turned-green cell.) Allows you to indicate that you are resolving an alert for a selected time period for a sector within your Traffic Management Unit (TMU) airspace.
- **Remove Row** - (Disabled (grayed out) if the row is not in the Select Monitored Elements list or is a baseline sector.) Removes a selected row from the NAS Monitor.
- **Move Row Up** - (Disabled (grayed out) if the sort order is not Manual, the row is a baseline sector, or if the row is the first row.) Allows you to move a selected row up a row.
- **Move Row Down** - (Disabled (grayed out) if the sort order is not Manual, the row is a baseline sector, or if the row is the last row.) Allows you to move a selected row down a row.

**Note:** The parent sector that contains all or a portion of a child sector that is listed in the Monitored Elements list will be shown in the NAS Monitor even if the parent sector is not in the Monitored Elements list.
RVSM

In any current sectorization row in the NAS Monitor, the TSD displays the peak one-minute counts of flights predicted to be RVSM non-conformant at any time when they are in the sector, based on current sectorization.

**Note:** RVSM counts display on the NAS Monitor if the RVSM Counts Display option is checked in the Select RVSM Display Options dialog box. See page 4-19.

The TSD shows the total number of RVSM non-conformant flights as a white number over a square black background to the right of the count as shown below.

In any baseline sectorization row in the NAS Monitor, the TSD displays the peak one-minute count of flights predicted to be RVSM non-conformant at any time when they are in the sector, based on baseline sectorization.
Display Range
You can change the amount of alert data displayed on the NAS Monitor by using the Display Range option. The current display range is shown in blue. To change the display range click on the number of hours you would like to display or click anywhere on the blue shaded segment and drag it to the number of hours you would like to display.

Select Monitored Elements
The Select Monitored Elements command lets you select NAS elements for display on the NAS Monitor. You can access the Select Monitored Elements dialog box using either method below.

- Pull down the Customize menu in the NAS Monitor dialog box by clicking Customize or pressing <Alt> C. Click Select Elements or press E.
  OR
- Click the Select Elements button on the NAS Monitor dialog box.

Note: Upon opening the Select Monitored Elements dialog box, the Monitored Elements section will reflect any changes that were made manually to the sort order of the NAS Monitor.
If you select the Manual sort option, you can use the Monitored Elements section of the Select Monitored Elements dialog box to reorder the list.
Using the Select Monitored Elements Dialog Box

The Select Monitored Elements dialog box provides Select sections for selecting NAS elements and a Monitored Elements section that lists the selected elements.
Select Sectors

The Select Sectors section displays a pick list from which you can select sectors and TRACONS and provides an options menu for sorting the list. Select a **Group By** option to indicate how you want to sort the list. The Area sort option is the default sort.

### Sorting Sectors

<table>
<thead>
<tr>
<th>Sort Mode</th>
<th>Sort Order</th>
</tr>
</thead>
<tbody>
<tr>
<td>Area</td>
<td>Alphabetically by center, area of specialization and sector number within each area, then by TRACON.</td>
</tr>
<tr>
<td>Type</td>
<td>Alphabetically by center, sector type (low, high, superhigh, and TRACON), then sector number.</td>
</tr>
<tr>
<td>Alphanumerically</td>
<td>Alphabetically by center, then sector number, then by TRACON.</td>
</tr>
</tbody>
</table>

To open the pick list and select sectors or TRACONS, do the following:

- Click the plus (+) symbol for a center to expand the pick list for that center.
- Click the plus (+) symbol for a folder to expand the pick list and display a list of sectors or TRACONS.

Select sectors or TRACONS using one of the following methods:

- To select an element, left-click the element label.
- To select an element without deselecting any other selected elements, simultaneously press the `<Ctrl>` key while left-clicking the element label.
- To select a range of elements, left-click the first item in the range. Simultaneously press the shift key while left-clicking the last item in the range.
- To select all elements under a higher-level item in the list, left-click the item. You can select all sectors in a Center by selecting the center or all sectors in an area by selecting the area.

**Note:** Click the minus (-) symbol for a center or folder to collapse the pick list.
Select Airports

The Select Airports section provides a text field in which you can enter the airport you want to display or click an arrow button to display a pull-down list of choices. The list of airports is sorted alphabetically. If you type in an entry or a partial entry and click the arrow button, the list automatically scrolls to the first entry that begins with the characters you typed.

This section also displays checkboxes labeled arrivals and departures. By default, all checkboxes are selected. To specify whether you want arrival and/or departure airports to display, select or deselect the appropriate checkboxes.

Note: The Airports and Fixes picklists contain only elements that are monitored by the TFMS Traffic Database (TDB) process.

Select Fixes

The Select Fixes section provides a text field in which you can enter the name of a fix you want to display or click an arrow button to display a pull-down list of choices. The list of fixes is sorted alphabetically. If you type in an entry or a partial entry and click the arrow button, the list automatically scrolls to the first entry that begins with the characters you typed.

This section also displays checkboxes labeled low, high, and superhigh. By default, all checkboxes are selected. To specify whether you want the low, high, and/or superhigh strata of the fix to display, select or deselect the appropriate checkboxes.

Adding/Removing Elements

After selecting the NAS element(s) you want to display, click the Add>> button to move the items to the Monitored Elements section. To remove an element from the Monitored Elements list, select the element and click the <<Remove button.

Monitored Elements

The Monitored Elements section of the Select Monitored Elements dialog box displays the elements you select for display on the NAS Monitor. After adding an element or elements, the element(s) displays at the bottom of the Monitored Elements list. The vertical scroll bar allows you to see all entries.

There are certain instances in which the NAS Monitor will not reflect the exact list of NAS elements chosen through Select Monitored Elements. For example, if a selected sector is partially or fully combined with another sector or sectors, the NAS Monitor will display a row for the "parent" sector into which it is combined even if the parent sector is not specified in Select Monitored Elements.
Reordering Elements
To reorder a NAS element in the Monitored Elements list, use the Move Up or Move Down buttons or drag and drop the element. The order in which elements display in the Monitor section is the order, from top to bottom, in which they display on the NAS Monitor when the NAS Monitor sort order is Manual. To move an element up or down and reorder the list, do the following:

- Select the element and then click the Move Up or Move Down button as many times as necessary to move the element to the desired location.

OR

- Select the element and use the drag-and-drop method (middle mouse button) to move the element to the desired location.
  - Click OK to close the Select Monitored Elements dialog box and display the selected NAS elements on the NAS Monitor.
  - Click Apply to display the selected NAS elements on the NAS Monitor without closing the Select Monitored Elements dialog box.
  - Click Cancel to close the dialog box without saving any changes.

Show/Hide All Baselines
The NAS Monitor identifies a sector into which one or more other sectors have been combined by displaying a + sign in its row label and displays alert data for the sector in its current configuration. To show a row of data for the sector, and each sector combined into the sector, in its baseline configuration, click the Show All Baselines toggle button. Rows of alert data displayed in gray with their element labels in parentheses indicate baseline data. The counts in these rows represent the peak 1-minute counts predicted for the sectors in their baseline configuration. When Hide All Baselines is selected, the additional rows are removed and a single row of alert data for the sector in its current configuration displays.

   Note: Selecting the Show All Baselines toggle button displays baseline data for the entire monitor. To show or hide baseline data for an individual sector, right-click on the element label and select the Show/Hide Baseline menu option.

Show Only if Alerted in Next...
This option determines whether a NAS Monitor time limit applies to the display of alert data for the NAS Elements being monitored. If you select this checkbox, the NAS Monitor displays a row of alert data for each NAS element that attains alert status within the time limit set in the Set NAS Monitor Time Limit option.

If you leave this checkbox unselected, no NAS Monitor time limit applies to the display of alert data.
Changing the time limit in the Set NAS Monitor Time Limit option will dynamically update the NAS Monitor checkbox text to display the new time limit. The default time limit is 2.25 hours. If you change the Time Limit to 4.00 hours, the label in the NAS Monitor will change to "Show only if alerted in next 4.00 hours."

Sort By

The Sort By section of the NAS Monitor lets you sort alert data by area, alphanumerically, or manually. Click the down-arrow button to select a sort option.

Area

Select Area sort mode to display rows of alert data sorted in the following order:

<table>
<thead>
<tr>
<th>Sort</th>
<th>Sort Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First</td>
<td>Sectors/TRACONs in the primary center (if any), sorted alphanumerically by area name and then sector name, with any TRACONs at the end.</td>
</tr>
<tr>
<td>Second</td>
<td>Sectors/TRACONs in other centers sorted alphanumerically by center, then area name, and then sector label.</td>
</tr>
<tr>
<td>Third</td>
<td>Airports sorted alphabetically by airport name, with the arrival row for an airport appearing above the departure row if both are displayed.</td>
</tr>
<tr>
<td>Fourth</td>
<td>Fixes sorted alphabetically by fix name, and within each fix by type (low first, high next, super-high next).</td>
</tr>
</tbody>
</table>

The NAS Monitor displays a thick, black, horizontal line separating each area in the sector section of the display and separating the sector section, the airport section, and the fix section.

Alphanumeric

Select Alphanumeric sort mode to display rows of alert data sorted alphanumerically regardless of the element.
Manual

Select Manual sort mode to manually reorder rows of alert data on the NAS Monitor. To move a row and change the sort order, click on any cell in the row and select the **Move Row Up** or **Move Row Down** option on the Customize or Right-Click menu. The example below displays a selected cell and the Right-Click menu.

Any changes you make manually to the sort order are reflected in the Select Monitored Elements dialog box when that dialog box is opened.

**Note:** You can toggle back and forth between the sort order you set manually and another sort option without recreating your sort order.

### Selecting Cells and Rows

Some alert data, such as the Alerts Report, is specific to the time interval or intervals you select on the NAS Monitor.

- To select a specific time interval on the monitor, click the cell.
- To select a range of time intervals use the click-and-drag method. When you select a cell or a range of cells in a row, the row label becomes highlighted.
- To select an entire row, click on the row label. If you select an entire row or a range of cells within a row, the range of selected cells is highlighted by a thick, line border around each cell in the range.
NAS Monitor Functions and Customize Pull-Down Menus

The **Functions** pull-down menu on the NAS Monitor contains the following menu items:

- Show System Summary
- Time in Sector
- Bar Chart
- Alerts Report
- Show/Hide Examined Flights
- Turn Green
- Close

The **Customize** pull-down menu on the NAS Monitor contains the following menu items:

- Select Elements
- Show All Baselines
- Move Row Up
- Move Row Down
- Remove Row
- Relative/ Absolute Time Range
- Sort By
- Show/Hide Options Panel

These functions are discussed on the pages that follow.
NAS Monitor Functions Menu

Show System Summary

The **Show System Summary** option lets you view in one display the alert status of all sectors within selected Centers.

1. Pull down the Functions menu on the NAS Monitor dialog box by clicking Functions or pressing `<Alt F>`.
2. Click **Show System Summary** or press **S**.

**Note:** You can access the System Summary by the following alternate methods:

1. Pull down the **Alerts** menu by clicking **Alerts** on the main menu or pressing `<Alt> A`.
2. Click **Show NAS Monitor** or press **N**.
3. Click **System Summary** on the Show NAS Monitor sub-menu or press **S**.

**OR**

1. Pull down the Functions menu in the NAS Monitor Control Panel by clicking Functions or pressing `<Alt>-F`.
2. Click **Show NAS Monitor** or press **N**
3. Click **Show System Summary** or press `<Alt>-S`

For detailed information on using the System Summary dialog box, see Page 4-86
**Time In Sector**

To open a Time in Sector chart from the NAS Monitor, choose one of the following methods:

- Right-click on a cell that represents the sector and time interval. This will display a right-click menu. Select the **Time in Sector** option from the right-click menu.

- Select a row in the NAS Monitor, pull down the **Functions** menu on the NAS Monitor dialog box (or press `<Alt>-F`), and click the **Time in Sector** option (or press **T**).

- Right-click on an alerted sector on the TSD display. Select the **Time in Sector** option from the right-click menu. The right-click menu displays a menu title containing a description of the current configuration of the selected sector.

If you right-click on two or more overlapping alerted sectors on the display, a right-click menu displays with an entry for each sector. Each entry contains a description of the current configuration for the sector. Click on one of the sector menu entries to display a sub-menu containing the Time in Sector option.
Reading the Time in Sector Chart

The Time in Sector chart graphically depicts the flights that cross the sector during a 15-minute interval. Each flight is represented as a horizontal bar from its entry into the sector to its exit out of the sector. By default, the flights are sorted by entry time, then by exit time. The Sector name is displayed in the title bar. When you place the cursor over a bar in the chart, a tool tip displays the flight’s full route. The following is a sample Time in Sector chart with a tool tip displayed for ACID SWA1103.

Notice that the horizontal line near the bottom of the chart shows one-minute intervals. Above the time intervals are the counts of flights expected to be in the sector during that one-minute interval. The Time in Sector chart displays 15-minute segments of data. To see other 15-minute segments, use the back and forward arrow buttons at the bottom of the chart.

Note: When alert data goes out of date on the NAS Monitor, the last update time in the upper right corner displays in red and flashes for one minute.
The Time in Sector chart columns are explained in the following table.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RVSM</td>
<td>Indicates the within-sector RVSM conformance status of each flight in the list. &quot;NC&quot; is displayed if the flight is non-conformant or a dash &quot;-&quot; is displayed otherwise.</td>
</tr>
<tr>
<td>ACID</td>
<td>Displays a flight's unique alphanumeric aircraft identifier. The Aircraft IDs in the ACID column are dark or light. The dark items represent active flights; the light represents inactive flights. Sort order: Alphabetically by the first three characters of the ACID and then numerically by the remaining characters.</td>
</tr>
<tr>
<td>ORIG</td>
<td>If the Sort by Origin option is chosen, then the origin airport is displayed in the third column with an &quot;ORIG&quot; column heading. Sort order: Origin airport, entry time, then exit time.</td>
</tr>
<tr>
<td>DEST</td>
<td>If the Sort by Destination option is chosen, then the destination airport is displayed in the third column with an &quot;DEST&quot; column heading. Sort order: Destination airport, entry time, then exit time.</td>
</tr>
<tr>
<td>Center</td>
<td>Displays the ARTCC where the flight is currently located (or the Departure ARTCC for inactive flights). Sort order: Center in which the flight is currently located (or the departure Center for inactive flights), Entry Time, then Exit time.</td>
</tr>
</tbody>
</table>

**Note:** The Center column is displayed unless either the "Sort by Origin" or Sort by Destination option is chosen.

Above the chart are the following data:
- Upper and lower MAP threshold values.
- Peak one-minute flight counts.
- Total number of flights occupying the sector at any time during the 15-minute interval.
- Time the chart was last updated.
Aircraft Identifiers

The Aircraft IDs in the ACID column are dark or light. The dark items represent active flights; the light represents inactive flights.

Interval Colors

Time intervals in the Time in Sector chart are in one of the following colors.

<table>
<thead>
<tr>
<th>Time Interval Colors</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color</td>
</tr>
<tr>
<td>Red</td>
</tr>
<tr>
<td>Yellow</td>
</tr>
<tr>
<td>Green</td>
</tr>
</tbody>
</table>

Functions Menu

The Functions menu on the Time in Sector chart has three options:

1. **Sort**
   Submenu options allow you to sort by Entry Time, Active/Inactive, ACID, Origin, Destination, Center and RVSM.

2. **Display**
   Submenu options let you display the ACID, Truncated Route, or Full Route.

3. **Close**
   
   **Note:** Regardless of the Display option you choose, the TSD displays a tool tip with the flight's full route when you place the cursor over a bar in the chart.
Scrolling

There are four buttons at the bottom of the chart that let you move within the time intervals.

### Time in Sector Chart Scroll Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;&lt;&lt;&lt;</td>
<td>Clicking this button goes back to the previous 15-minute time interval.</td>
</tr>
<tr>
<td>&lt;</td>
<td>Clicking this button goes back one minute.</td>
</tr>
<tr>
<td>&gt;&gt;&gt;&gt;</td>
<td>Clicking this button goes forward to the next 15-minute time interval.</td>
</tr>
<tr>
<td>&gt;</td>
<td>Clicking this button goes forward one minute.</td>
</tr>
</tbody>
</table>

When the chart is sorted by Entry Time, moving forward or backward on the Time in Sector chart will cause the vertical scroll bar to auto-scroll if no bars are displayed for any flights. The chart will automatically scroll vertically to show the flights that are predicted to be in the sector during the 15-minute time period.

**Note:** When the chart is sorted by Entry Time, the Time in Sector chart displays arrows on the left and right sides of the chart. These arrows indicate that there is flight data beyond that point in the chart, either before or after the current time period.
NAS Monitor Bar Chart

The Bar Chart option lets you generate a bar chart comparing the traffic demands for a NAS element with its traffic thresholds. The illustrations that follow display a bar chart for an examined airport, sector, and fix.

1. Pull down the Functions menu on the NAS Monitor dialog box by clicking **Functions** or pressing <Alt F>.

2. Click **Bar Chart** or press C.

**Note:** You can open a bar chart for any element in the NAS Monitor by selecting the row and selecting the **Bar Chart** option from the Functions menu.

You can also open a bar chart by selecting a row and the **Bar Chart** option from the right-click menu. After issuing the Bar Chart command, the NAS Monitor Bar Chart dialog box opens.

Using the "C" Quick Key

When you use the "C" quick key to display the NAS Monitor Bar Chart, the location of the mouse pointer when you press the quick key and the state of the Show Flights checkbox determine how the NAS Monitor responds.

<table>
<thead>
<tr>
<th>If the Pointer is located</th>
<th>The TSD does the following</th>
</tr>
</thead>
<tbody>
<tr>
<td>In a selected row over a cell that is within the selected cell range or on the row label of the selected row that has the Show Flights checkbox unchecked</td>
<td>Preserves the selection and displays the Bar Chart for the selected element and time range</td>
</tr>
<tr>
<td>In a selected row over a cell that is outside the selected cell range of the row that has the Show Flights checkbox unchecked</td>
<td>Preserves the row selection, changes the cell selection to the cell being pointed to, and requests a Bar Chart for the selected element and time interval</td>
</tr>
<tr>
<td>On a row label of an unselected row that has the Show Flights checkbox unchecked</td>
<td>Selects the row by highlighting the row label, highlights all the visible cells in the row, and displays the Bar Chart for the selected element and time range</td>
</tr>
<tr>
<td>On a row label in an unselected row that has the Show Flights checkbox checked</td>
<td>Selects the row by highlighting the row label, preserves the Level 1 cell selection but changes the cell highlighting to Level 2, and displays the Bar Chart for the selected element and time range.</td>
</tr>
<tr>
<td>On a cell in an unselected row that has the Show Flights checkbox unchecked</td>
<td>Selects the row by highlighting the row label, sets the cell highlighting to Level 2, and displays the Bar Chart for the selected element and time interval.</td>
</tr>
</tbody>
</table>
### If the Pointer is located | The TSD does the following
---|---
On a cell within a Level 1 selected cell range of a row that has the Show Flights checkbox checked | Selects the row by highlighting the row label, preserves the Level 1 cell selection but changes the cell highlighting to Level 2, and displays the Bar Chart for the selected element and time range.

On a cell outside the Level 1 selected cell range of a row that has the Show Flights checkbox checked. | Selects the row by highlighting the row label, sets the cell highlighting to Level 2, and displays the Bar Chart for the selected element and time interval.

Somewhere other than a row label or cell in a row | Ignores the quick key

**Note:** For more information on Level 1 and 2 highlighting and the Show Flights checkbox, see the topics NAS Monitor and Show/Hide Examined Flights

### Reading the NAS Monitor Bar Chart

The NAS Monitor Bar Chart dialog box displays a bar chart showing the relationship between alert (MAP) thresholds and projected traffic demand.

**Note:** This section describes using the NAS Monitor Bar Chart in Normal mode. For information on using the NAS Monitor Bar Chart in Model mode, see page 4-422 in Chapter 4, Reroute Impact Assessment.
The bar chart shows the active, proposed, and total flights projected for each 15 minute time interval. A two-color bar indicates the portion of the projected demand that is based on proposed flights. The dialog box provides a legend showing the colors used for active and projected flights and the symbols used to represent alert thresholds.

![Bar Chart Image]

**Airport Bar Chart Colors**

<table>
<thead>
<tr>
<th>Color</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>Number of active flights projected to arrive at or depart from the airport in that interval</td>
</tr>
<tr>
<td>Yellow</td>
<td>Number of proposed flights projected to arrive at or depart from the airport in that interval</td>
</tr>
</tbody>
</table>

**Note:** You can use the Chart Background button in the Change Colors and Fonts option (Display Menu, Adapt commands) to change the background color of the Bar Chart.

**Display Range**

The Display Range option at the top of the dialog box determines the time range represented by the NAS Monitor bar chart. The current display range is shown in blue. When the NAS Monitor Bar Chart dialog box is first opened, the Display Range option is set to the display range specified for the NAS Monitor. To change the display range, click on the number of hours you would like to display or click anywhere on the blue shaded segment and drag it to the number of hours you would like to display. You can set the display range for up to 6 hours.
Bar Chart for an Examined Airport

In the following example the NAS Monitor Bar Chart dialog box opens showing the bar chart for an examined airport. The MAP value is represented by a thick, black line with red dots. In this example Arrivals was selected for the specified airport. To view a bar chart for departures from this airport, select Departures for the airport and open a second bar chart.
Bar Chart for an Examined Sector

In the following example, the NAS Monitor Bar Chart dialog box opens showing the bar chart for an examined sector. The MAP On value is represented by a thick, black line with red dots and the MAP Off value is represented by a thin, red line with green diamonds. The Map On and Map Off values are the same.

Note: A plus sign (+) or minus sign (-) is appended to the sector name in the title bar of the Bar Chart if that sector is not in its baseline configuration.
Bar Chart for an Examined Fix

In the next example, the NAS Monitor Bar Chart dialog box opens showing the bar chart for an examined fix. The MAP value is represented by a thick, black line with red dots.

![Bar Chart for an Examined Fix](image)

**Functions and Customize Menus**

The **Functions** pull-down menu provides an option to close the NAS Monitor Bar Chart dialog box and return to the NAS Monitor.

The **Customize** pull-down menu provides the menu item, Show/Hide Options Panel. The NAS Monitor Bar Chart with the Options Panel hidden looks like the sample below.

![Functions and Customize Menus](image)
Alerts Report

The Alerts Report command lets you create a flight list report for any selected NAS element on the NAS Monitor. The report includes all flights projected to arrive at, depart from, or traverse an alerted element for each 15-minute interval during the selected time range. You can open an Alerts Report for any row in the NAS Monitor by highlighting the row and selecting the Alerts Report option as described below:

1. Pull down the Functions menu in the NAS Monitor dialog box by clicking Functions or pressing <Alt F>.
2. Click Alerts Report or press R.

You can also right-click on the row label or on a cell that represents the NAS element and time interval and select the Alerts Report option from the right-click menu, or use the Quick Key method, pressing R.

Using the "R" Quick Key

When you invoke the "R" quick key to display the Alerts Report, the location of the mouse pointer when you press the quick key and the state of the Show Flights checkbox determine how the NAS Monitor responds.

<table>
<thead>
<tr>
<th>If the Pointer is located</th>
<th>The NAS Monitor process</th>
</tr>
</thead>
<tbody>
<tr>
<td>In a selected row over a cell that is within the selected cell range or on the row label of the selected row that has the Show Flights checkbox unchecked</td>
<td>Preserves the selection and requests an Alert Report for the selected element and time range.</td>
</tr>
<tr>
<td>In a selected row over a cell that is outside the selected cell range of the row that has the Show Flights checkbox unchecked</td>
<td>Preserves the row selection, changes the cell selection to the cell being pointed to, and requests an Alert Report for the selected element and the selected time interval.</td>
</tr>
<tr>
<td>On a row label of an unselected row that has the Show Flights checkbox unchecked</td>
<td>Selects the row by highlighting the row label, displays all the visible cells in the row with Level 2 highlighting, and requests an Alert Report for the selected element and time range.</td>
</tr>
<tr>
<td>On a row label in an unselected row that has the Show Flights checkbox checked</td>
<td>Selects the row by highlighting the row label, preserves the Level 1 cell selection but changes the cell highlighting to Level 2, and requests an Alerts Report for the selected element and time range.</td>
</tr>
<tr>
<td>On a cell in an unselected row that has the Show Flights checkbox unchecked</td>
<td>Selects the row by highlighting the row label, sets the cell highlighting to Level 2, and requests an Alerts Report for the selected element and time interval.</td>
</tr>
<tr>
<td>On a cell within a Level 1 selected cell range of a row that has the Show Flights checkbox checked</td>
<td>Selects the row by highlighting the row label, preserves the Level 1 cell selection but changes the cell highlighting to Level 2, and requests an Alerts Report for the selected element and time range.</td>
</tr>
</tbody>
</table>
Displaying an Alerts Report

After issuing the Alerts Report command, a message stating that the request has been sent displays and the Alerts Report opens.

The Alerts Report provides the following buttons at the bottom of the report:

- **Print**
  Opens the Print dialog box. The Print dialog box displays the pathname of the standard print script and allows you to specify the number of copies you want to print.

- **Close**
  Closes the NAS Monitor Alerts Report and returns you to the NAS Monitor dialog box.
Show/Hide Examined Flights

The Show/Hide Examined Flights option lets you display or hide the current location of flights predicted to arrive at, depart from, or traverse any element(s) you are examining during a selected time interval in the NAS Monitor.

1. Pull down the Functions menu on the NAS Monitor dialog box by clicking **Functions** or pressing `<Alt F>`.

2. Select **Show Examined Flights** or **Hide Examined Flights** from the pull-down menu or press F.

OR

Click the **Show/Hide Examined Flights** icon button on the NAS Monitor dialog box.

**Note:** You can only show Examined Flights for one monitor at a time. Showing Examined Flights in one monitor will turn off the display of Examined Flights in another monitor.

After you issue the command, the Show/Hide Examined Flights button indicates that the Show Examined Flights display is toggled "on" by displaying a blue airplane icon on a white background.

If the Show Flights display is turned "off" and flights are hidden, the icon has a red "x" through it.
Using the Show Flights Command

To show Examined Flights for a specific NAS element during a selected time interval, use the checkbox to the left of the row to select the element. Do the following.

1. After toggling the Show Flights command on, select the NAS element for which you want flights drawn by clicking the **Show Flights** checkbox to the left of the row. You can draw flights for up to nine NAS elements at time.

2. The time intervals you select determine the flights displayed. When you click the **Show Flights** checkbox for a row, all time intervals are selected by default and the row is highlighted with a "Level 1" line border. Level 1 highlighting is illustrated in the following example. However, if the Show Flights checkbox had been previously checked for that row, TFMS remembers the cell selection that existed when the checkbox was checked and restores that cell selection when the checkbox is again checked. This allows you to toggle the flights display for that element without resetting the cell selection.

3. Click the icon button to select the icon type you want to use for drawn flights. Three icon types are available.

4. Click the color button to display a color palette and select the color you want to use for drawn flights.

You can also select a single time interval or a range of intervals in a row. To select an individual time interval, hold the pointer over the cell and left-click. To select more than one cell, use the `<Shift>` and `<Ctrl>` keys or the click-and-drag method. When you select an individual time interval or a range of intervals in a row, the row label becomes highlighted.

You can also select an entire row by clicking on the row label. When you select a cell, a range of cells, or an entire row by clicking on the row label, the range of selected cells is displayed with "Level 2" highlighting. Level 2 highlighting displays as a thick line border around each selected cell and is illustrated in the following example.

3. Click the icon button to select the icon type you want to use for drawn flights. Three icon types are available.

4. Click the color button to display a color palette and select the color you want to use for drawn flights.
Note: The color and icon type for flights in more than one drawn flight set are determined by row order. The color you select will take precedence over colors specified for flights in Select Flights, Create/Edit FEA/FCA flights, and Monitor All Reroutes.

5. To hide flights, click the **Hide Flights** toggle button or menu option. If you subsequently click the **Show Flights** button, the same time intervals previously selected display highlighted.

Note: Clicking the **Show/Hide Flights** toggle button or menu option does not deselect any selected NAS elements.

Flights That Have Not Departed

Flights that have not yet departed are indicated by flight counts at each airport, including a count of all flights still on the ground, controlled flights on the ground past the original departure time, flights on the ground past their Estimated Time of Departure (ETD), and flights on the ground that are RVSM non-conformant. Those flights that meet these selection criteria are represented by small, empty circles at the airports where they are originating. Beside each circle icon are the airport identifier and a set of four numbers, as shown and explained below:

- **Total flights on ground**
  This is the total number of flights represented by this icon, that is, the number waiting to depart from this airport that will depart from, arrive at, or traverse the examined element within the indicated time limit.

- **Controlled flights**
  Of the total number of flights represented by this icon, this is the number of flights that are currently controlled by a ground delay program and whose original departure time is already past.

- **Flights on ground past ETD**
  Of the total number of flights represented by this icon, this is the number of flights whose ETD is already past but which have not departed.

- **RVSM Non-Conformant Flights**
  This is the total number of RVSM non-conformant flights on the ground.

Note: This number is displayed if the “RVSM Non-Conformant Indicators for Drawn Flights” option is on and flights are drawn for an
examined sector, fix, airport and/or FEA/FCAs, and some of the examined flights are inactive.

You can display data blocks for flights that have not departed by selecting the circle icons. Note that a data block for a circle icon may describe multiple flights. The data block lists the Estimated Time of Departure for each flight and, if controlled, the original (proposed) departure time.

**Note:** If the “RVSM Non-Conformant Indicators for Drawn Flights” option is on and a data block is shown for examined flights on the ground, the TSD inserts the string “NC” before each flight that is RVSM non-conformant in at least one of the sectors or FEA/FCAs for which flights are currently being drawn, or that is predicted to be non-conformant at any future time if the flight is a member of an examined fix or airport flight set.

As with any other data blocks, data blocks for circle icons may also show the origin and destination or route of each flight, and routes may be drawn, depending on whether those items had been selected when you issued the Select Flights command.

**Other Flights**

Issuing the Hide Examined Flights command does not turn off other flights that are already displayed. Issue Hide Flights on the TSD Flights Menu to turn off other flights before issuing Show Examined Flights.
Turn Green
The Turn Green option lets you indicate that you are resolving an alert for a selected time period for any open sector, airport, or fix within your Traffic Management Unit (TMU) airspace. This command acts as a toggle. Toggle it on to change the color of an alerted cell on the NAS Monitor and to let other TSD users know that the situation causing the interval alert is being addressed.

1. Pull down the Functions menu on the NAS Monitor dialog box by clicking **Functions** or pressing `<Alt F>`.
2. Select **Turn Green** from the pull-down menu or press **G**.

To use the Turn Green command, you can also right-click on an alerted cell that represents the NAS element and time interval. This will display a right-click menu. Select the **Turn Green** option from the right-click menu.
### Using the "G" Quick Key

When you use the "G" quick key to toggle the Turn green option, the location of the mouse pointer when you press the quick key and the state of the Show Flights checkbox determine how the NAS Monitor responds.

<table>
<thead>
<tr>
<th>If the Pointer is located</th>
<th>The NAS Monitor process</th>
</tr>
</thead>
<tbody>
<tr>
<td>In a selected row over an alerted cell that is within the selected cell range of the row that has the Show Flights checkbox unchecked</td>
<td>Preserves the selection and invokes the Turn Green option for the cell being pointed to</td>
</tr>
<tr>
<td>In a selected row over an alerted cell that is outside the selected cell range of the row that has the Show Flights checkbox unchecked</td>
<td>Preserves the row selection, changes the cell selection to the cell being pointed to, and invokes the Turn Green option for that cell</td>
</tr>
<tr>
<td>On an alerted cell in an unselected row that has the Show Flights checkbox unchecked</td>
<td>Selects the row by highlighting the row label, displays Level 2 highlighting around the cell being pointed to, and invokes the Turn Green option for that cell.</td>
</tr>
<tr>
<td>On an alerted cell within the &quot;Level 1&quot; selected cell range of a row that has the Show Flights checkbox checked</td>
<td>Selects the row by highlighting the row label, preserves the &quot;Level 1&quot; cell selection but changes the highlighting around the cell to Level 2, and invokes the Turn Green option for that cell</td>
</tr>
<tr>
<td>On an alerted cell outside the &quot;Level 1&quot; selected cell range of a row that has the Show Flights checkbox checked</td>
<td>Selects the row by highlighting the row label, displays Level 2 highlighting around the cell being pointed to (deselecting other cells in the row if any), and invokes the Turn Green option for that cell</td>
</tr>
<tr>
<td>Somewhere other than a cell in any row</td>
<td>Ignores the G quick key</td>
</tr>
</tbody>
</table>

**Note:** For more information on Level 1 and 2 highlighting and the Show Flights checkbox, Show/Hide Examined Flights.
Red and Yellow Segments

When you issue Turn Green on a red or yellow cell, the color of the cell displays as red or yellow with a green stripe drawn across it. The background color of the cell represents the alert status prior to issuing the command. While the TSD waits for the acknowledgment from TFMS, you are prevented from issuing another Turn Green command.

Note: The black ovals appear in the image above to indicate the cells affected by the Turn Green command and do not appear in the TSD display.

Command Result

After you toggle on Turn Green, the result is transmitted to all TSDs at all sites at the next alert update. Your screen shows the change immediately after the command has been confirmed by the TFMS, while other TSDs show the change when their alert data is updated (within five minutes). This assumes that other TSDs are displaying live alerts and are examining the particular element for which you issued the command.

Turn Green status remains on the display as long as the time cell remains on the NAS Monitor or until you turn it off or until the status changes to a higher status. This means that if the cell was yellow when you issued the Turn Green command and the segment subsequently becomes red, the Turn Green status is cancelled and the status is changed to red.
Undoing the Result

To turn the command off, toggle off Turn Green on the cell with Turn Green status. The cell changes back to the previous color. If the traffic situation for the interval changes, then the color of the segment changes accordingly at the next update.

Command Restriction

You are allowed to use this command only for those elements within your TMU controlled space. If you are at an Air Route Traffic Control Center (ARTCC), you can use Turn Green for airports, sectors, and fixes within your ARTCC. If you are at the Air Traffic Control System Command Center (ATCSCC), you can use the command for any element. If you are not authorized to use this command for an element, you will receive an error message from TFMS, and the status of the segment will not change.

Close

The Close option allows you to close the NAS Monitor and tier Centers.
NAS Monitor Customize Menu

Select Elements

The Select Elements option lets you add NAS elements to or remove NAS elements from the NAS Monitor. Click Select Elements (or press E) on the NAS Monitor Customize menu to open the Select Monitored Elements dialog box. If you select the Manual sort option, you can use the Monitored Elements section of the Select Monitored Elements dialog box to reorder the list. For more information on using the Select Monitored Elements dialog box, see page 4-103.

Show/Hide All Baselines

This option allows you to add or hide rows to the display that show the baseline counts for a selected sector and any sectors that have been added to the sector. The NAS Monitor identifies a sector into which one or more other sectors have been combined by displaying a + sign in its row label and displays alert data for the sector in its current configuration. Click Show All Baselines or Hide All Baselines (or press B) on the NAS Monitor Customize menu. Rows of alert data displayed in gray with their element labels in parentheses indicate baseline data. The counts in these rows represent the peak 1-minute counts predicted for the sectors in their baseline configuration. When Hide All Baselines is selected, the additional rows are removed and a single row of alert data for the sector in its current configuration displays.

Note: Selecting the Show All Baselines menu option displays baseline data for the entire monitor. To show or hide baseline data for an individual sector, right-click on the element label and select the Show/Hide Baseline menu option from the right-click menu.

Reordering Rows

You can access the Move Row Up, Move Row Down, and Remove Row commands on the Customize and Right-Click Menus of the NAS Monitor. You can click the menu selection or use the mnemonic keys:

- For Move Row Up, press U.
- For Move Row Down, press D.
- For Remove Row, press R.

To move rows up or down and thereby change the sort order, you must set the Sort By option to Manual Sort. You can remove rows from the NAS Monitor regardless of the sort mode. To use any of these commands, you must first select the row. The changes you make to the NAS Monitor using these commands are reflected in the Select Monitored Elements dialog box.
Relative/ Absolute Time Range

The Relative/Absolute Time Range command determines the time range mode with which selected time intervals in a timeline or a range of time intervals display. Selected time intervals can display in Relative or Absolute time. To toggle the NAS Monitor between Relative and Absolute Time Range, use the Relative/Absolute Time Range command on the Customize pull-down menu of the NAS Monitor dialog box. Click **Relative Time Range** or **Absolute Time Range** or press T.

- **Relative Time Range**
  With Relative Time Range mode, a selected time range displays relative to the current time and shifts forward as current time advances. When the beginning of the first time interval in a timeline or range of time intervals increments by 15 minutes, the start and end times of the selected time range are also incremented by 15 minutes so that the same intervals, by their position in the timeline, remain selected.

- **Absolute Time Range**
  With Absolute Time Range mode, a selected time range remains the same as current time advances. As current time is updated and the left most time bucket drops off the timeline, the selected time range eventually diminishes until the last time bucket selected is the current time. As time advances and the last selected time bucket drops off the timeline, the TSD displays the new current time interval as selected, even if it was not selected before.

Sort By

The Sort By option of the NAS Monitor customize menu lets you sort alert data by Area, Alphanumerically, or Manually. Each sort option is accessed by clicking its name on the Sort By submenu or by pressing its mnemonic letter. For Area, press R, for Alphanumeric, press L and for Manual, press M. This option can also be accessed by clicking the **Sort By** button on the NAS Monitor. For more information on the Sort By function, see page 4-107.

Show/Hide Options Panel

This option allows you to show or hide the NAS Monitor Options Panel. To toggle between showing or hiding the Options Panel on the NAS Monitor, use the Show/Hide Options Panel command on the Customize pull-down menu of the NAS Monitor dialog box. Click **Show Options Panel** or **Hide Options Panel** or press T.
### Preferences Command

The NAS Monitor Preferences command enables you to define your preferences for displaying alerts.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
</table>
| 1. Pull down the Alert menu by clicking **Alerts** on the main menu or pressing <Alt> A.  
2. Click **Preferences** or press P. | None |

#### Semicolon Method

None

### NAS Monitor Preferences Dialog Box

After you click **Preferences**, the NAS Monitor Preferences dialog box opens.

![NAS Monitor Preferences Dialog Box]

The following table explains the fields in the NAS Monitor Preferences dialog box.
### NAS Monitor Preferences

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What You Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Range</td>
<td>Allows you to set the default range of hours displayed in the NAS Monitor.</td>
<td>Click the up or down arrow or use the keyboard arrow keys to change the default time range in quarter hours from .25 hour to 6 hours. The default display range is 2.25 hours.</td>
</tr>
<tr>
<td>Cell Range Selection</td>
<td>Allows you to select the default cell range selection in the NAS Monitor.</td>
<td>Click the Relative or Absolute radio button. The default is Relative.</td>
</tr>
<tr>
<td>Show Flights Icon</td>
<td>Allows you to select the default icon type with which you want NAS Monitor flights to be drawn.</td>
<td>Click on the icon button to select an icon type. You can select from three options - Automatic, Airplane, or Dot. The default is Automatic.</td>
</tr>
<tr>
<td>Show Flights Color</td>
<td>Allows you to select the default color with which you want NAS Monitor flights to be drawn. The color you select displays in the box in each NAS Monitor row.</td>
<td>Click the button to display a color palette. Click on your choice of color for alerts. The default color is red.</td>
</tr>
<tr>
<td>NAS Monitor for Examined Elements</td>
<td>Allows you to select the default NAS Monitor where elements examined with the Examine function are displayed.</td>
<td>Click on the down arrow to open a pick list. The default is Custom.</td>
</tr>
</tbody>
</table>

When you finish using the NAS Monitor Preferences dialog box and click **OK**, your preferences for displaying alerts are saved.

### File Menu

You can use the File pull-down menu to save NAS Monitor preferences to a file, recall a file, or delete a file. Clicking on the appropriate menu item opens a dialog box. For more information, refer to the section on File Pull-Down Menu, on page 2-3 in Chapter 2, TSD Basics.
Weather Menu

Overview

In this section, you will learn how to use the commands available on the Weather pull-down menu. The section discusses hiding and showing weather on the TSD, selecting weather from either CIWS or legacy overlays, obtaining a weather report, and a runway visual range report. Each of the following topics corresponds to an item on the Weather menu.

- **Show/Hide Weather Command**
  Toggles weather on or off.

- **Select Weather Command**
  Lets you select various weather overlays for display.

- **WX Report Command**
  Displays and prints weather information.

- **RVR Report Command**
  Displays and prints runway visual range information.
### Show/Hide Weather Command

The **Show Weather/Hide Weather** command lets you toggle off and on the graphic overlays that are made with other weather commands. To remove all the weather overlays as if each one was turned off separately, use the Clear Weather semicolon command.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Weather menu by formatting <strong>Weather</strong> on the main menu or pressing <code>&lt;Alt&gt; W</code>.</td>
<td><strong>W</strong></td>
</tr>
<tr>
<td>2. Click <strong>Show Weather</strong> or <strong>Hide Weather</strong> or press <strong>W</strong>.</td>
<td><strong>Semicolon Method</strong></td>
</tr>
<tr>
<td></td>
<td>None</td>
</tr>
</tbody>
</table>

**Note:** The **Show Weather** command takes effect only if weather overlays have been selected in the Select Weather dialog box. For information about this dialog box, see the **Select Weather** command in the next section.

When Show Weather is selected, the Weather menu option displays Hide Weather; When Hide Weather is selected, the Weather menu option displays Show Weather.
The **Select Weather** command lets you select the Select Weather dialog box. There are two sets of Weather products available for display: Corridor Integrated Weather System (CIWS) and Legacy. The Legacy version of the Select Weather dialog box allows you to select display colors for NCWF and TOPS, and other options for Lightning and Jet Stream. The CIWS version of the Select Weather dialog box allows you to specify a variety of weather products and legends, described in this section.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
</table>
| 1. Pull down the Weather menu by clicking **Weather** on the main menu or pressing `<Alt>` W.  
2. Click **Select Weather** or press S. | None |

| Semicolon Method | None |
Select Weather Dialog Box

After you click Select Weather or press the mnemonic key from the Weather menu, the Select Weather dialog box opens with options for the Corridor Integrated Weather System (CIWS) weather overlays displayed. The radio buttons at the top of the Select Weather dialog box allow you to choose the CIWS or Legacy set of weather products. You can select and display weather overlays from either set but cannot display both at the same time. The Weather Services International (WSI) Lightning, WSI Jet Stream, and CCFP overlay capabilities are available on both the CIWS and Legacy dialog boxes.

The Select Weather dialog box has two radio buttons that allows you to select either the CIWS version or the Legacy version. The options in the CIWS version of the dialog box are separate and distinct from any similar options in the Legacy version of the Select Weather dialog box. The CIWS version allows you to specify the CIWS weather products and legends that are to be displayed when the weather is shown and the CIWS option is selected.

The following section discusses how to use the CIWS version of the Select Weather dialog box. For information on using the Legacy version of the Select Weather dialog box, see page 4-181.
Select Weather Dialog Box - CIWS Version

After you click Select Weather or press the mnemonic key from the Weather menu, the Select Weather dialog box opens with options for the Corridor Integrated Weather System (CIWS) weather overlays displayed. If the Legacy version of the Select Weather dialog box is open, click the CIWS radio button on the Select Weather Dialog box to open the CIWS version of Select Weather dialog box.
Using the CIWS Version of the Select Weather Dialog Box

The CIWS version of the Select Weather dialog box provides radio buttons for selecting the four basic CIWS products:

- Precipitation Vertically Integrated Liquid (VIL*) Mosaic
- Precipitation (VIL*) Forecast
- Echo Tops Mosaic
- Echo Tops Forecast

* Stands for Vertically Integrated Liquid

Only one of these mosaics can be displayed at a time. You can also choose to display no CIWS mosaics by clicking the NONE radio button.

The Select Weather dialog box provides check boxes for toggling the display state of additional weather overlays. These overlays can be displayed simultaneously with any of the CIWS mosaics with one exception. The CCFP Overlay cannot be displayed if you are running the Precipitation or Echo Tops Forecast mosaic. A check mark in a check box indicates that the "Show" state for the overlay is selected. An empty check box indicates that the "Show" state is deselected and that overlay will be hidden on the map. Options or Filters buttons allow you to customize the display of an overlay. To enable selected overlays, click OK or Apply.

The following table lists and briefly describes the weather overlays and capabilities that are available in the CIWS version of the Select Weather dialog box.

### CIWS Select Weather Dialog Box

<table>
<thead>
<tr>
<th>Weather Overlay</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CIWS Mosaic</td>
<td></td>
</tr>
<tr>
<td>PRECIP</td>
<td>Precipitation (VIL) Mosaic. Shows current precipitation intensity measured as vertically integrated liquid water (VIL). You can display the PRECIP mosaic in standard or winter mode.</td>
</tr>
<tr>
<td>San Juan NOWRAD</td>
<td>Weather Services International (WSI) San Juan NOWRAD 2km Mosaic. Shows current precipitation intensity for San Juan using a 2 km grid.</td>
</tr>
<tr>
<td>PRECIP FORECAST</td>
<td>Precipitation (VIL) Forecast. Shows forecasts of precipitation intensity. You can display the PRECIP Forecast mosaic in standard or winter mode as a static forecast mosaic for a fixed time interval in the future or as an animated loop of forecast images for a selected time period.</td>
</tr>
</tbody>
</table>
### CIWS Select Weather Dialog Box (Continued)

<table>
<thead>
<tr>
<th>Weather Overlay</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ECHO TOPS</td>
<td>Echo Tops (ETOP) Mosaic. Shows the heights of the echo tops (estimates of the altitude of the radar 18 dBZ echo top height) in 5,000 foot increments. You can choose to show topped areas with the Echo Tops mosaic. The topped areas indicate where the highest elevation of the NEXRAD radar beam may be below the top of the corresponding storm.</td>
</tr>
<tr>
<td>ECHO TOPS FORECAST</td>
<td>Echo Tops (ETOP) Forecast. Shows forecasts of echo tops. You can display a static forecast mosaic for a fixed time interval in the future or an animated loop of forecast images for a selected time period.</td>
</tr>
<tr>
<td>NONE</td>
<td>Shows no precipitation or echo tops mosaics on the map.</td>
</tr>
</tbody>
</table>

#### Legend

| Legend | Shows a CWIS legend for the selected CIWS weather product. |

#### Forecast Accuracy Scores

| Show Scores, Regions, Data Blocks | Provides a measure of how well the past 30, 60, and/or 120 minute Precipitation or Echo Tops forecasts performed at selected airports. You can display all of the scores for the selected airports in a table and individually in data blocks on the map. |
| Home Airport | Provides a scrollable list of CONUS and Canadian airport names and three-letter airport codes in alphabetical order. The Selected Airport(s) will have their Forecast Accuracy Scores displayed when the Show check boxes for Scores or Data Blocks are selected. |

#### Other Weather Overlays

| Radar Coverage Map | Shows the areas covered by the NEXRAD radars. This overlay cannot be displayed with the Satellite mosaic. |
| Satellite Mosaic  | Shows visual and infrared satellite data from the GOES satellites. This overlay cannot be displayed with the Radar Coverage Map. |
| Forecast Contours | If you are displaying the Precipitation mosaic this overlay shows forecasts of level 3+ (standard mode) or level 1c+ (winter mode) precipitation for the next 30, 60, and/or 120 minutes. If you are displaying the Echo Tops mosaic, this overlay shows forecasts of 30,000 ft + echo tops for the next 30, 60, and/or 120 minutes. This overlay cannot be displayed with the Verification Contours. |
### CIWS Select Weather Dialog Box (Continued)

<table>
<thead>
<tr>
<th>Weather Overlay</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Verification Contours</strong></td>
<td>Shows Precipitation or Echo Tops forecast contours that were generated 30, 60, and/or 120 minutes prior to the currently displayed weather image. This overlay cannot be displayed with the Forecast Contours.</td>
</tr>
<tr>
<td><strong>Growth and Decay Trends</strong></td>
<td>Shows areas where storm growth or decay has been detected over the past 15-18 minutes.</td>
</tr>
<tr>
<td><strong>Storm Motion</strong></td>
<td>Shows the motion (speed and direction) of storms and the extrapolated positions of storms 10 and 20 minutes in the future (contours).</td>
</tr>
<tr>
<td><strong>Echo Top Tags</strong></td>
<td>Shows the measurements of cloud heights at 20,000 ft or higher and displays the values in flight level format as hundreds of feet in 1,000 ft increments.</td>
</tr>
<tr>
<td><strong>Lightning</strong></td>
<td>Weather Services International (WSI) Lightning. Shows the most recent lightning strikes for CONUS. This product is available for display with both the CIWS and Legacy products.</td>
</tr>
<tr>
<td><strong>Jet Stream</strong></td>
<td>Weather Services International (WSI) Jet Stream. Shows wind speed, altitude, and direction. This product is available for display with both the CIWS and Legacy products.</td>
</tr>
<tr>
<td><strong>CCFP Forecast</strong></td>
<td>Collaborative Convective Forecast Product (CCFP) Forecast. Shows forecast areas where convective weather might occur.</td>
</tr>
</tbody>
</table>

**Note:** The CCFP Overlay cannot be displayed if you are running the Precipitation or Echo Tops Forecasts. To display the CCFP overlay, select the CIWS Precipitation or Echo Tops mosaic or the NONE option.

The following sections describe the functionality of the CIWS Select Weather dialog box.
CIWS Mosaic

The CIWS Mosaic section of the Select Weather dialog box is shown below.

CIWS PRECIP Standard Mode

The Precipitation (VIL) mosaic in Standard mode shows the current precipitation intensity measured as vertically integrated liquid water. One data point in the mosaic represents the precipitation intensity over a 1 km square area. The mosaic displays up to six levels of precipitation intensity in shades of green, yellow, orange, and red. To display the Precipitation Mosaic in Standard mode, click the PRECIP radio button and OK or Apply.

CIWS Standard Mode Precipitation Legend

Click the Legend check box to show the CIWS legend with the PRECIP mosaic. The CIWS PRECIP Legend shows the colors for six levels of standard mode precipitation from the lightest, level 1, to the heaviest, level 6, as follows.

Click the Legend check box to show the CIWS legend with the PRECIP mosaic. The legend initially displays with six levels of precipitation intensity selected and allows you to specify the minimum level of intensity to be displayed. If you click on a selected level (a level that has a check mark), lower levels of precipitation are deselected (unchecked) for display. For example, clicking on level 3 deselects levels 1 and 2. If you click on a deselected level, you select that level and all levels representing higher levels of precipitation. After you click on the levels you want selected or deselected and submit the changes, the TSD updates the mosaic display.
The following samples illustrate the Precipitation standard mode display: the top sample shows all six precipitation levels and the bottom sample shows display of levels 3 through 6 on the right, for the same precipitation situation.
**CIWS PRECIP Winter Mode**

The Winter Mode option of the Precipitation mosaic provides greater detail for light intensity precipitation (Level 1) and shows snow and rain/snow mix precipitation phases. In Winter mode, the Standard Level 1 color for liquid precipitation is broadened and separated into three distinct levels: 1a, 1b, and 1c. With the broadened Level 1 color band, the mosaic now displays up to eight levels of liquid precipitation intensity. Additionally, the Precipitation mosaic in Winter mode shows three levels of intensity for snow and rain/snow mix. To display the Precipitation (VIL) mosaic in Winter Mode, click the PRECIP radio button, click the Winter Mode check box, and click OK or Apply.

**CIWS Winter Mode Precipitation Legend**

Click the Legend check box to show the CIWS legend with the PRECIP mosaic in Winter mode. The CIWS Winter Mode PRECIP Legend appears as follows.

The CIWS Winter Mode PRECIP Legend shows the eight levels of liquid precipitation intensity and three levels of intensity for snow and rain/snow mix. The horizontal blue and pink lines represent snow (blue) and rain/snow mix (pink) phases. Level 1a represents the lightest level of snow (pale blue) and rain/snow mix (pale pink). Levels 1b and 1c represent increasing levels of intensity. Levels 1c and above represent the highest level of intensity for snow and rain/snow mix.

Both standard mode and winter mode legends allow you to select the minimum precipitation level to be displayed. If you click on a level that is selected (with a checkmark), the TSD deselects (unchecks) all levels in the legend that represent lower levels of intensity and updates the mosaic to reflect the legend's selections. The TSD displays only the selected levels whether you display a static image of the forecast or an animated loop of forecast images.
In the example that follows, the Precipitation mosaic is displayed in Winter Mode with the CIWS legend. This image of the mosaic shows shades of green representing several levels of liquid precipitation intensity and some blue and pink representing snow and rain/snow mix phases.

San Juan NOWRAD

The San Juan NOWRAD overlay, displayed simultaneously with the CIWS Precipitation mosaic, shows areas of precipitation intensity for the San Juan geographic area using a 2 km grid. This overlay shows 6 levels of precipitation intensity in colors that are the same as those used for the Legacy NOWRAD products. To specify the minimum level of precipitation intensity to be displayed for the San Juan NOWRAD overlay, use the CIWS PRECIP legend (Standard mode). The CIWS PRECIP legend shows precipitation intensity in colors that are equivalent to the colors used in the NOWRAD legend.

To display the San Juan NOWRAD overlay, click the PRECIP radio button, the San Juan NOWRAD check box, and OK or Apply. San Juan NOWRAD data updates every fifteen minutes.
CIWS PRECIP Forecast

The Precipitation (VIL) Forecast mosaic in Standard mode shows a forecast of precipitation intensity. You can display the precipitation forecast mosaic as an animated loop of forecast images for a selected time period or as a static image for a fixed time interval relative to current time.

To select the Precipitation Forecast mosaic in Standard mode, click the PRECIP FORECAST radio button. To specify the parameters for the animated looping of the forecast, click the Options button to open the CIWS PRECIP Forecast Options dialog box, shown below.

CIWS PRECIP Forecast Options dialog box

The CIWS PRECIP Forecast Options dialog box allows you to specify the time frame at which past images should start and forecast images should end and the time increment between images. The time frame can be from up to two hours in the past to two hours in the future.
The table below explains the items on the CIWS PRECIP Forecast Options dialog box.

## CIWS PRECIP Forecast Options Loop Parameters

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What You Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Past Images Start At</td>
<td>Allows you to specify the time at which the animated loop of past images should begin. You can start the loop with images from 120 minutes to 10 minutes into the past.</td>
<td>Click the up or down arrow to select the number of minutes into the past at which the loop should begin. The available times display as negative values representing numbers of minutes in the past in 10 increments.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The down arrow is disabled at first, because you cannot set the start for more than 120 minutes in the past. The down arrow is enabled if the Start time is less than 120 minutes in the past.</td>
<td></td>
</tr>
<tr>
<td>Increment</td>
<td>Allows you to set the time increment between images in the animated loop.</td>
<td>Click the up or down arrow to select the time increment between images. You can set the increment to be 10, 20, or 30 minutes between images.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>CIWS forecast files currently contain forecasts at 10 minute intervals but may be changed to contain forecasts at 15 minute intervals. If the forecasts are changed to 15 minute intervals, you will be able to set the increment to 15 or 30 minutes between images.</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>The down arrow is disabled at first, because you cannot set the start an interval increment of less than 10 minutes. The down arrow is enabled if the Start time is set at 20 or 30 minutes.</td>
<td></td>
</tr>
</tbody>
</table>
CIWS PRECIP Forecast Options Loop Parameters

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What You Do</th>
</tr>
</thead>
</table>
| Forecast Images End At    | Allows you to specify the time at which the animated loop of forecast images should end. You can end the animated loop with forecast images that are 10 minutes to 2 hours into the future. | Click the up or down arrow to select the number of minutes into the future at which the loop should end. The available times display as positive values representing numbers of minutes into the future in 10 minute increments.  
  **Note:** The up arrow is disabled at first, because you cannot set the start for more than 120 minutes in the future. The up arrow is enabled if the end time is less than 120 minutes in the future. |

To save any changes you make to the Loop parameters and close the CIWS PRECIP Forecast Options dialog box, click **OK**. To close the CIWS PRECIP Forecast Options dialog box without saving changes, click **Cancel**.

**CIWS Forecast Loop Control**

After you select the overlay, define the parameters, and click **OK** or **Apply** on the Select Weather dialog box, the Precipitation Forecast mosaic and the CIWS Forecast Loop Control dialog box display, as follows.

The CIWS Forecast Loop Control dialog box allows you to control the animated looping of forecast images. Using this dialog box you can also stop looping and display a static image.
Using the CIWS Forecast Loop Control Dialog Box

The table below explains the items in the CIWS Forecast Loop Control dialog box.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What You Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Image</td>
<td>Allows you to display the image associated with the start time of the animated looping.</td>
<td>To display the image associated with the start time of the animated looping, click this button.</td>
</tr>
<tr>
<td>Single Step Back</td>
<td>Allows you to display the image prior to the one currently displayed in the sequence of images. If you display the prior image, the TSD resets the current loop time to the time associated with the selected image.</td>
<td>To display the image prior to the one currently displayed, click this button.</td>
</tr>
<tr>
<td><strong>Note:</strong> If the current loop time is the start time of the looping and you click this button, the TSD sets the current loop time to the end time of the looping.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pause/Resume</td>
<td>Allows you to stop (pause) or start (resume) the animated looping. The symbol on this button depends on the current state of the animated looping. If the looping is paused, a resume symbol (›) displays. If the animated looping is active, a pause symbol (II) displays.</td>
<td>To start animated looping, click the resume symbol (›). To stop animated looping, click the pause symbol (II).</td>
</tr>
<tr>
<td>Single Step Forward</td>
<td>Allows you to display the image after the one currently displayed in the sequence of images. The TSD resets the current loop time to the time associated with the selected image.</td>
<td>To display the image after the one currently displayed, click this button.</td>
</tr>
<tr>
<td><strong>Note:</strong> If the current loop time is the end time of the looping and you click this button, the TSD sets the current loop time to the start time of the looping.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### CIWS Forecast Loop Control Dialog Box (Continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What You Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Image</td>
<td>Allows you to display the image associated with the end time of the looping.</td>
<td>To display the image associated with the end time of the animated looping, click this button.</td>
</tr>
<tr>
<td>Speed Control</td>
<td>Allows you to control the speed of the animated looping.</td>
<td>To slow down the animated looping, click the slider bar and drag to the left. To speed up the animated looping, click the slider bar and drag to the right.</td>
</tr>
<tr>
<td>Offset From Current Time</td>
<td>Displays the offset from current time, in minutes, of the time associated with the currently displayed image.</td>
<td>Display only.</td>
</tr>
<tr>
<td>Time of the Displayed Image</td>
<td>Displays the time associated with the currently displayed image in <strong>HHMM</strong> format.</td>
<td>Display only.</td>
</tr>
<tr>
<td>Jump to Selected Time</td>
<td>These eleven buttons allow you to &quot;jump&quot; the display to the image closest to the time interval selected. The TSD resets the current loop time to the &quot;jump to&quot; time. For example, the Time 0 button represents the current-time image. The button labeled -60 allows you to jump to an image that is 60 minutes prior to the current time.</td>
<td>To display the image associated with a specific &quot;jump to&quot; button, click the button</td>
</tr>
</tbody>
</table>

### Animated Looping of Forecast Images

To start the animated looping of forecast images, click the **Resume** button (▷) on the CIWS Forecast Loop Control dialog box. If you set a time frame in the loop parameters to display both past and forecast images, the TSD displays saved mosaic images from the past time period and then displays the forecasted images that most closely match the animated loop times. As looping continues, the Offset from Current Time value and the Time of the Displayed Image are updated. When looping through images for the past time period, the offset time displays as negative and decreases with each image in the sequence. As looping continues and the mosaic transitions to forecast colors, the offset time displays as positive and increases with each forecasted image. The slider bar allows you to control the speed at which the looping of images occurs.
System Performance During Animated Looping

When you start animated looping of forecast images or when the TSD updates weather data, the initial cycling through of weather images is slower than after it gets going. This is due to the processing of the raw data for each image. However, once the data has been processed, much of the data is kept in memory and the raw data for an image does not need to be processed again. Therefore the TSD draws the weather image much faster when looping through images the second time around.

Also, if you are simultaneously running multiple TSDs in a forecast loop, the overall workstation performance will be degraded. This is because the TSD uses a lot more memory when it is running a forecast loop. If you have a number of other TSDs running a forecast loop in other workspaces and you select the Forecast option and click OK or Apply on the Select Weather dialog box, a warning message displays informing you of those other TSDs with forecast loops running.

Static Forecast Images

The CIWS Forecast Loop Control dialog box allows you to display a static weather image for a fixed time interval, either past or present, relative to the current time. To display a static image from the Forecast Loop, click a "Jump To" button along the bottom of the dialog box. Clicking the blue "Time 0" button displays the weather image for the current time. The buttons labeled -60 and -30 allow you to jump to images that are 60 or 30 minutes prior to the current time. The eight green buttons to the right of the Time 0 button allow you to jump to images forecasted for future time periods relative to current time. When you select a Jump To button and display a static image, the TSD continues to update the mosaic with the most recently received data, as time progresses, relative to current time.
The following samples illustrate the Precipitation forecast display. When you run the Precipitation Forecast loop play, you will notice the change in precipitation display colors on the TSD when the loop advances through the selected time offsets. As the loop advances from the past (negative numbers) to future forecast (positive numbers), the display switches colors from the standard six-level precipitation colors to the four-level forecast precipitation colors.

The sample static shots shown below are taken from a single forecast loop display. The sample on the top shows the display taken during the past time portion of the loop and the sample on the bottom shows as the display taken during the future time portion of the loop. The top sample shows all six precipitation levels and the bottom sample shows display of levels 3 through 6 on the right, for the same precipitation situation.
**CIWS Precipitation Mosaic Colors**

The following table shows all of the possible colors for display of the Precipitation mosaic in standard mode and winter mode. For each type of precipitation in standard and winter modes, the table shows the standard colors and the slightly grayed colors that are used in the degraded radar coverage regions.

![Precipitation Mosaic Colors Table]

In both standard and winter Precipitation modes, the CIWS Legend allows you to select the minimum precipitation level to be displayed. Initially, the legend and mosaic display all six Standard mode (or eight Winter mode) levels of precipitation. If you click on a higher level check box, the TSD deselects (unchecks) all the check boxes for levels below the selected level in the legend and updates the mosaic to reflect the legend's selections. The TSD displays only the selected levels whether you display a static image of the forecast or an animated loop of forecast images.
If you selected to show the CIWS legend with the Precipitation Forecast mosaic, the legend shows four levels of forecasted intensity.

The following table shows all of the possible colors for display of the Precipitation Forecast mosaic.

<table>
<thead>
<tr>
<th>Precipitation Forecast Colors</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Past/Current Forecast</strong></td>
</tr>
<tr>
<td><strong>Liquid</strong></td>
</tr>
<tr>
<td>Level 1</td>
</tr>
<tr>
<td>Level 1a</td>
</tr>
<tr>
<td>Level 1b</td>
</tr>
<tr>
<td>Level 1c</td>
</tr>
<tr>
<td>Level 2</td>
</tr>
<tr>
<td>Level 2</td>
</tr>
<tr>
<td>Level 3</td>
</tr>
<tr>
<td>Level 3</td>
</tr>
<tr>
<td>Level 4</td>
</tr>
<tr>
<td>Level 4</td>
</tr>
<tr>
<td>Level 5</td>
</tr>
<tr>
<td>Level 5</td>
</tr>
<tr>
<td>Level 6</td>
</tr>
<tr>
<td><strong>Mixed</strong></td>
</tr>
<tr>
<td>Level 1a</td>
</tr>
<tr>
<td>Level 1b</td>
</tr>
<tr>
<td>Level 1c</td>
</tr>
<tr>
<td>Level 1e</td>
</tr>
<tr>
<td>Level 1e</td>
</tr>
<tr>
<td><strong>Snow</strong></td>
</tr>
<tr>
<td>Level 1a</td>
</tr>
<tr>
<td>Level 1b</td>
</tr>
<tr>
<td>Level 1c</td>
</tr>
<tr>
<td>Level 1e</td>
</tr>
</tbody>
</table>

All the legends allow you to select the minimum precipitation level to be displayed. On any CIWS Legend, if you click on a level that is selected, the TSD deselects all levels in the legend that represent lower levels of intensity and updates the mosaic to reflect the legend's selections. The TSD displays only the selected levels whether you display a static image of the forecast or an animated loop of forecast images.
CIWS ECHO TOPS Mosaic

Echo Tops are the maximum heights of precipitation echos from the NEXRAD radars. The Echo Tops Mosaic shows the heights of the echo tops in 5,000 foot increments up to 50,000 feet. To display the Echo Tops mosaic, click the ECHO TOPS radio button and click OK or Apply. Echo Tops data is updated every 2.5 minutes.

The Echo Tops legend shows ten Echo Tops altitudes and allows you to specify the minimum altitude to be displayed. In the example that follows, the Echo Tops mosaic is displayed with the legend below it. All ten altitudes are selected for display.

You can limit the display to a minimum Echo Top level, in the same manner as with the PRECIP mosaic, by clicking checkbox for the level you select in the CIWS Echo Tops Legend. Initially, the legend and mosaic display all tops levels. If you click on a higher level check box, the TSD deselects all the check boxes for levels below the selected level in the legend and updates the mosaic to reflect the legend's selections. The TSD displays only the selected levels whether you display a static image of the forecast or an animated loop of forecast images.
CIWS ECHO TOPS Show Topped

The ECHO TOPS Show Topped check box provides the capability to show regions where the highest elevation of the NEXRAD radar beam may be below the top of the corresponding storm. The maximum height in these cases cannot be estimated. To display the Echo Tops mosaic with "topped" areas, click the **Show Topped** check box and click **OK** or **Apply**. The TSD shows "topped" areas in the color black. The following samples illustrate the Echo Tops display without tops on the top and with tops, indicated by the red circles (included here for illustration purposes), shown on the bottom.
Note: Typically the Echo Tops mosaic is drawn over a gray Radar Coverage Map and the black "topped" areas are visible. If the background color is black, the "topped" areas are not visible except when surrounded by other echo top regions.

CIWS ECHO TOPS Legend

Click the Legend check box to show the CIWS legend with the Echo Tops mosaic. The CIWS Echo Tops Legend is shown below:

The CIWS Echo Tops Legend initially displays the colors for 10 altitude levels in thousands from the lowest of 5 (representing 5,000 feet), to the highest of 50+ (representing 50,000 feet and above). The legend allows you to specify the minimum altitude to be displayed. If you click on a selected altitude (a level that has a check mark), lower altitude levels are deselected (unchecked) for display. For example, clicking on level 15 deselects levels 5 and 10. If you click on a deselected level, you select that level and all levels representing higher altitudes. After you click on the levels you want selected or deselected and submit the changes, the TSD updates the mosaic display.

CIWS ECHO TOPS FORECAST Show Topped

The Echo Tops Forecast Show Topped check box provides the capability to show regions in the animated loop where the highest elevation of the NEXRAD radar beam may be below the top of the corresponding storm. The maximum height in these cases cannot be estimated. To display the Echo Tops Forecast mosaic with "topped" areas, click the Show Topped check box and click OK or Apply. The TSD shows "topped" areas in the color black. Topped areas are not shown with images for future time periods.

CIWS ECHO TOPS FORECAST

The Echo Tops Forecast mosaic shows the forecast of echo tops. To select the Echo Tops Forecast mosaic, click the ECHO TOPS FORECAST radio button on the Select Weather dialog box. To specify the parameters for the animated looping of the forecast, click the Options button to open the CIWS Echo Tops Forecast Options dialog box, shown below.
The CIWS Echo Tops Forecast Options dialog box allows you to specify the time frame at which past images should start and forecast images should end and the display increment between images, in the same manner as the CIWS PRECIP Forecast Options dialog box. The CIWS Echo Tops Forecast Options dialog box allows you to specify the time frame at which past images should start and forecast images should end and the display increment between images. The time frame can be from up to two hours in the past to up to two hours in the future. For more information, see page 4-148.

After you select the overlay, define the parameters, and click **OK** or **Apply**, the Echo Tops Forecast mosaic and the CIWS Forecast Loop Control dialog box display. The CIWS Forecast Loop Control dialog box allows you to control the animated looping of forecast images in the same manner as the described in the section on CIWS PRECIP Forecast. Using this dialog box you can also stop looping and display a static image. Echo Tops forecast data is updated every 5 minutes.

- For more information on using the CIWS Forecast Loop Control dialog box, see the page 4-150.
- For more information on Animating Looping of Forecast Images, see page 4-152.
- For more information on System Performance during Animated Looping, see page 4-153.
- For more information on Static Forecast Images, see page 4-153.

### CIWS Echo Tops Forecast Legend

Click the **Legend** check box to show the CIWS legend with the Echo Tops Forecast mosaic. The CIWS Echo Tops Forecast Legend is shown below:

![CIWS Echo Tops Forecast Legend](image)

The CIWS Echo Tops Forecast legend shows the standard 10 altitude levels below which it shows four levels of echo tops in shades of purple. The horizontal purple line on the legend represents these four forecasted levels. The lowest forecasted level, shown in the palest purple on the horizontal line, is for Echo Tops below 30,000 feet; the higher levels are 30,000 feet, 35,000 feet and above 40,000 feet.

The legend allows you to select the minimum echo tops level to be displayed. If you click on a level that is selected, the TSD deselects all levels in the legend that represent lower heights of echo tops and updates the mosaic to reflect the legend's selections. The TSD displays only the selected levels whether you display a static image of the forecast or an animated loop of forecast images.
The following table shows all of the possible colors for display of the Echo Tops Forecast mosaic, as shown in the CIWS Echo Tops Forecast Legend.

<table>
<thead>
<tr>
<th>Altitude Level K ft</th>
<th>Echo Tops Mosaic</th>
<th>Echo Tops Forecast</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td></td>
<td></td>
</tr>
<tr>
<td>35</td>
<td></td>
<td></td>
</tr>
<tr>
<td>40</td>
<td></td>
<td></td>
</tr>
<tr>
<td>45</td>
<td></td>
<td></td>
</tr>
<tr>
<td>50+</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

When you run the Echo Tops Forecast loop play, you will notice the change in display of echo tops colors on the TSD when the loop advances through the selected time offsets. As the loop advances from the past (negative numbers) to future forecast (positive numbers), the display switches colors from the standard ten-level echo tops colors to the four-level forecast echo tops colors.
The sample static shots shown below are taken from a single forecast loop display. The sample on the top shows the display taken during the past time portion of the loop and the sample on the bottom shows as the display taken during the future time portion of the loop.
Forecast Accuracy Scores

CIWS calculates, in real time, the accuracy of its past 30, 60, and 120 minute Precipitation and Echo Tops forecasts for the region surrounding major airports. The Forecast Accuracy Scores section of the CIWS Select Weather dialog box, shown below, allows you to display the calculated accuracy scores associated with the CIWS mosaic you are currently displaying.

- When the standard mode precipitation forecast is displayed, the forecast scores represent measurements of the accuracy of the past 30, 60, and 120 minute forecasts of level 3 and above precipitation intensity.
- When the winter mode precipitation forecast is displayed, the forecast scores represent measurements of the accuracy of the past forecasts of level 1c and above precipitation intensity.
- When the echo tops forecast is displayed, the forecast scores represent measurements of the accuracy of the forecast of echo tops that are greater than 30,000 feet.

To display the Forecast Accuracy Scores, you select the name of one or more of the major airports in the Home Airports section. The 30, 60, and 120 minute forecast scores are then shown listed in the Accuracy Scores dialog box, as in the following sample. You also have the option to display the scoring region around the airport and data blocks showing the scores for each airport selected.

The Home Airports section of the CIWS Select Weather dialog box has a scrollable list of CONUS and Canadian airport names and three-letter airport codes in alphabetical order. Select an airport by scrolling to the code in the list by clicking the name to highlight the code and clicking the right arrow to add the code to the Selected Airports list. You can remove names from the selected airports list by highlighting the name in the Selected Airports list and clicking the left arrow. To highlight more than one airport, you can use the "click and drag", Shift-click, or Ctrl-click method. To move an airport from the Selected list back to the Home Airports list, highlight the airport(s) and click the left arrow button.
In the Show section, click the **Scores** check box to display an Accuracy Scores dialog box showing scores in table format for selected airports or you can display scores in data blocks on the map. The Accuracy Scores dialog box is shown below.

![Accuracy Scores dialog box](image)

Click the **Regions** check box to display a scoring "region" for each selected airport. A scoring region displays as a square that is centered on an airport. The squares are drawn using the TSD highlight color black, if the background color is light, and white, if the background color is dark.

Click the **Data Blocks** check box to display a data block above and to the right for each selected home airport. To display the Accuracy Scores for the selected airports, click the **OK** or **Apply** button on the Select Weather dialog box after you have made your selections.
The following example shows the TSD displaying Accuracy Scores, Regions and Data blocks for Atlanta (ATL), Boston (BOS), and Charlotte (CLT).

On the TSD display, you can click and drag accuracy scores data blocks to different locations as needed. Both the Accuracy Scores dialog box and the data blocks show the colors used to draw Forecast Contours for the three time periods. If accuracy scores data is not available for a specified airport or for one of the forecast time periods, N/A is displayed to indicate that the data values are not available. If there is not enough precipitation to generate a score, "<MIN" is displayed for the airport and time period.

If you are showing accuracy scores with the Precipitation or Echo Tops forecast in an animated loop, the TSD displays accuracy scores that were current at the time of each past Precipitation or Echo Tops image that displays. Accuracy scores display for the current time frame when the animated loop displays current and forecast images.
Other Weather Overlays

Radar or Satellite Overlay

The Radar Coverage Map shows the areas covered by the NEXRAD radars. The TSD displays the standard coverage areas as a medium gray overlay and the degraded (extended) coverage areas as a dark gray overlay. Only the standard radar coverage areas display if you are showing the Radar Coverage Map with an Echo Tops mosaic.

**Note:** If you display the Radar Coverage Map with a Precipitation mosaic and the mosaic overlaps with degraded radar coverage areas, the overlapping areas of the mosaic display in subdued colors. For more information, see CIWS Precipitation Mosaic Colors on page 4-155.

To display the Radar Coverage Map overlay, click the **Radar Coverage Map** check box and click **OK** or **Apply**. Radar Coverage data is updated every 2.5 minutes.

If you are showing the Radar Coverage Map with the Precipitation or Echo Tops forecast in an animated loop, a radar image displays that is current with the time of each past Precipitation or Echo Tops image that displays. A radar image displays for the current time frame when the animated loop displays current and forecast images.

In the following example the Radar Coverage Map is displayed with the Precipitation mosaic.
Satellite Mosaic
The Satellite mosaic shows both the visible and infrared images from the GOES satellites in a single mosaic. Because the Satellite mosaic displays in varying shades of gray, a black background is recommended. Satellite mosaic data is updated every 15 minutes. To display the Satellite Mosaic overlay, click the Satellite Mosaic check box and click OK or Apply.

If you are showing the Satellite mosaic with the Precipitation or Echo Tops forecast in an animated loop, a satellite image displays that is current with the time of each past Precipitation or Echo Tops image that displays. When the animated loop displays forecast images, a satellite image will not be displayed. In the following example, the Satellite mosaic is displayed with the Precipitation mosaic.

Forecast or Verification Contours Overlay
The Forecast Contours overlay shows the areas where CWIS predicts an existing storm will be 30, 60, and/or 120 minutes into the future. Forecast contours can be displayed over current Precipitation or Echo Tops images. To select the contours you want to display, click the Options button to open the Forecast Contours Options dialog box.

After clicking the Options button for Forecast Contours on the CIWS version of the Select Weather dialog box, the Forecast Contours Options dialog box opens. This dialog
box allows you to select a 30, 60, and/or 120 minute forecast contour for display on the TSD. A legend on the dialog box shows the colors the TSD uses to represent each contour.

![Forecast Contours Options dialog box]

To show a particular contour, click the check box for the time period, 30 minutes, 60 minutes or 120 minutes and click OK. You can select any combination of these time periods. To close the Forecast Contours Options dialog box without saving any changes, click Cancel. The TSD draws forecast contours on the map using single pixel lines and updates contours data every 5 minutes.

If you are displaying the Precipitation mosaic in Standard mode, the contours show the predicted location of Level 3 + precipitation intensity for the selected time period(s). In Winter mode, the contours show the predicted location of Level 1c + precipitation intensity. If you are displaying the Echo Tops mosaic, the contours show the predicted location of 30,000 foot echo tops for the selected time period(s).

If you are showing Forecast Contours with the Precipitation or Echo Tops forecast during an animated loop, the TSD displays the Forecast Contours only when the Precipitation or Echo Tops image for the current time frame is displayed.
In the following example, the Precipitation mosaic displays with forecast contours for 30, 60, and 120 minutes.

When the Forecast Contours are being displayed, the TSD shows the forecast contours that are consistent with the Precipitation or Echo Tops mosaic currently being displayed, including standard mode Precipitation, winter mode Precipitation, and Echo Tops.

**Verification Contours**

The Verification Contours overlay shows the areas where CWIS predicted a storm would be currently located in the forecasts that were generated 30, 60, and/or 120 minutes prior to the currently displayed image. Verification contours can be displayed over past and current Precipitation or Echo Tops images and provide a way of visually verifying the accuracy of prior forecasts.
To select the contour types you want to display, click the **Options** button to open the Verification Contours Options dialog box. The Verification Contours Options dialog box, shown below, allows you to specify whether you want to show verification contours for forecasts generated 30, 60, or 120 minutes ago.

![Verification Contours Options dialog box](image)

This dialog box also shows a legend of colors that represent the time periods for the forecast: blue - 30 minutes, magenta - 60 minutes, and white - 120 minutes. To show a particular contour, click the check box for the time period and click **OK**. To close the Verification Contours Options dialog box without saving any changes, click **Cancel**. After you select the overlay and define the contour types you want to display, click **OK** or **Apply** on the Select Weather dialog box.

When you display the Verification Contours overlay, the TSD displays the data from saved Forecast Contour overlays that are consistent with the mosaic currently being displayed. For example, if you select the 30 minute Verification contour option while displaying the current Precipitation forecast, the TSD displays the precipitation forecast data from the Forecast Contour data set for the time period 30 minutes prior to the current time. The TSD draws verification forecast contours on the map using single pixel lines and updates contours data every 5 minutes.

If you are displaying the Precipitation mosaic in Standard mode, the Verification contours show the previously forecasted location of Level 3 + precipitation intensity for the selected time period(s). In Winter Mode, the contours show the previously forecasted location of Level 1c + precipitation intensity. If you are displaying the Echo Tops mosaic, the contours show the previously forecasted location of 30,000 foot Echo Tops for the selected time period(s).
In the example below, the contours are shown over the Echo Tops mosaic showing tops of 30,000 feet and above.

If you are showing Verification Contours with the Precipitation or Echo Tops forecast during an animated loop, the TSD displays only the Verification Contours for past and current images.
Other Weather Options

The Other Weather Options section of the Select Weather dialog box provides the following additional weather overlays:

- **Growth and Decay Trends**
  - The Growth and Decay Trends overlay shows areas where storms have grown or decayed in the past 15 to 18 minutes. As indicated on the Growth and Decay legend in the Other Weather Options section of the Select Weather dialog box, shown above, areas of growth display as orange cross hatching. Areas of decay display as solid navy blue regions. Growth and Decay Trends data is updated every 2.5 minutes. To display the Growth and Decay Trends overlay, click the **Growth and Decay Trends** check box and click **OK** or **Apply**.

  If you are showing Growth and Decay Trends with the Precipitation or Echo Tops forecast during an animated loop, the TSD displays only the Growth and Decay Trends overlays for past and current images in the loop. In the following example the Growth and Decay Trends is displayed over the Precipitation mosaic.
Storm Motion

The Storm Motion overlay displays the movement of Level 3+ intensity precipitation or echo tops at an altitude of 30,000 ft and above. This overlay uses arrows to show the direction of cell movement and indicates the speed of storm cells, in knots, by displaying numeric values at the tips of the arrows. The arrows originate from the center of the current storm cells. The leading edge of the current storm "envelope" is represented by a solid line and the extrapolated positions of that leading edge 10 and 20 minutes into the future are shown as dashed lines. Storm motion data is updated every 2.5 minutes.

To select the colors for the direction and speed arrows and the leading edge and extrapolated position lines of a storm cell, click the Options button to open the Storm Motion Options dialog box, shown below.

![Storm Motion Options Dialog Box]

This dialog box allows you to select the color for the arrows used to show the direction of storm cell movement and the numeric values that indicate the speed of storm cells. This dialog box also allows you to select the color for the lines that represent the leading edge of the current storm "envelope" and the extrapolated positions of that leading edge. Clicking one of the color buttons opens the color palette allowing you to change the color.

To save your selections and close the Storm Motion Options dialog box, click OK. To close the Storm Motion Options dialog box without saving any changes, click Cancel.

After you select the Storm Motion overlay and define the colors, click OK or Apply in the Select Weather dialog box.

If you are showing the Storm Motion overlay with the Precipitation or Echo Tops forecast during an animated loop, the TSD displays only the storm motion for past and current images in the loop.
The following example shows a close up of the Storm Motion overlay with the Precipitation mosaic.
**Echo Top Tags**

The Echo Top Tags overlay shows the measurements of cloud heights at 20,000 feet or higher and displays the values in flight level format as hundreds of feet in 1,000 foot increments (for example, 200, 210, 320). The tags are shown as solid colored text boxes with a leader line that extends from the text box to the echo tops location. The tags display with either a white or black background color depending on the TSD background color. Echo Top Tags data is updated every 2.5 minutes.

A Filters button allows you to open the Echo Tops Tags Options dialog box, shown below, and specify the position of the tags relative to the echo tops and the minimum flight level to display the tags.

**Note:** The Filters button next to the Echo Top Tags check box displays with a green background if there no filter has been specified for a minimum flight level. If you submit a minimum flight level at which to display the tags, the button displays with a yellow background. After you select the overlay and define any filters, click **OK** or **Apply** on the Select Weather dialog box.

This dialog box allows you to specify the position for displaying the tags relative to the echo tops. The Select Tag Position section provides three radio buttons options for positioning display of the tags:

- Surround to display tags surrounding the location
- Left Only to display tags always on the left
- Right Only to display tags always on the right.

To select a tag position, click the radio button for that option. If you select the Surround option, the TSD assigns the tag positions left, right, above, or below the echo tops in order to eliminate overlapping tags. In the event that tags overlap, TSD only displays the tag with the higher flight level.
In the Filter Option section, you can set a minimum flight level at which to display the tags. To select this option, click the **Minimum flight level to display** check box. To set the minimum flight level to display tags, click the up or down arrows to the right of the flight level value field to increment or decrement the values. You can specify the minimum value in 5,000 foot increments from 20,000 feet (200) to 75,000 feet (750).

To save your selections and close the Echo Tops Tags Options dialog box, click **OK**. To close the Echo Tops Tags Options dialog box without saving any changes, click **Cancel**.

If you are showing the Echo Tops Tags overlay with the Precipitation or Echo Tops forecast during an animated loop, the TSD displays only the echo tops tags for the current images in the loop. Echo Tops Tags are not shown for past or future time frames. In the following example the Echo Tops Tags overlay is displayed with the Echo Tops mosaic. The tags have been filtered to display to the left of those echo tops that are 20,000 feet and higher.
Lightning

The Lightning overlay displays the most recent lightning strikes for CONUS. The Lightning overlay displays each lightning strike as a cross icon (+) in the color specified on the Select Weather dialog box. Clicking the color button opens the color palette and allows you to change the overlay color. After you click the Lightning check box and specify the color, click **OK** or **Apply**. The TSD updates lightning data every 5 minutes.

If you are showing the Lightning overlay with the Precipitation or Echo Tops forecast during an animated loop, the TSD displays only the lightning for the past and current images in the loop. Lightning is not shown for future time frames.

In the example below the Lightning overlay displays in blue with the Precipitation mosaic.

![Image of Lightning overlay with Precipitation mosaic]

**Note:** The WSI Lightning Weather overlay is also available on the Legacy version of the Select Weather dialog box. Lightning History dialog is available only in the Legacy version of the Select Weather dialog box.
Jet Stream

The Jet Stream overlay shows areas where winds are strongest or greater than 70 knots and indicates wind speed, altitude, and direction. Jet stream data is updated every 3 hours. An Options button allows you to open the CIWS Jet Stream Options dialog box, shown below, and specify the colors for the overlay.

The components of the Jet Stream overlay are explained in the following table.

### CIWS Jet Stream Options dialog box

<table>
<thead>
<tr>
<th>Overlay</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Altitude</td>
<td>These labels identify the altitude at which the strongest winds were measured, in hundreds of feet. For example, the number 338 represents an altitude of 33,800 feet.</td>
</tr>
<tr>
<td>Speed</td>
<td>Contour lines and numbers identify wind speed in knots. The outermost lines define areas within which winds aloft have been measured at 70 knots or more. Within these areas, contour lines define areas of even higher winds, placed at intervals of 20 knots.</td>
</tr>
<tr>
<td>Streamlines</td>
<td>Arrows on the streamline indicate the direction of the wind.</td>
</tr>
</tbody>
</table>

This dialog box allows you to specify the colors the TSD uses when displaying altitude, wind speed, and/or streamlines. Clicking a color button opens the color palette allowing you to change the color for the selected overlay.

**Note:** At least one Jet Stream option must be selected in the Jet Streams Options dialog box. You will see an error message if you try to deselect all of the options. The WSI Jet Stream overlay is also available on the Legacy version of the Select Weather dialog box.

To save your selections and close the CIWS Jet Stream Options dialog box, click **OK**. To close the CIWS Jet Stream Options dialog box without saving any changes, click **Cancel**.
After you select the Jet Stream overlay, specify jet stream colors, and click **OK** or **Apply** on the Select Weather dialog box, the Jet Stream overlay appears on the TSD, as shown below.
CCFP Forecast

The Collaborative Convective Forecast Product (CCFP) overlay shows forecast areas where convective weather might occur. The CCFP forecast season typically runs from March 1 through November 30. During the CCFP forecast season, meteorologists at the Aviation Weather Center (AWC) produce CCFP forecasts every two hours, taking into account information provided by FAA and airline weather specialists. The TSD receives CCFP data updates every two hours and displays only the most recently issued data.

Note: The Canadian CCFP forecast season runs from April 1 through September. During March, October, and November, when Canadian CCFP forecasting is not operational, the CCFP section of the Select Weather dialog box displays the message "Canadian CCFP is NOT AVAILABLE."

The CCFP section of the Select Weather dialog box allows you to display a CCFP overlay and associated information for a 2, 4, or 6 hour forecast by clicking on the button for the desired forecast. You can also show CCFP data blocks and the CCFP Legend on the TSD display. To show the data blocks and/or the legend, click the check box for the option and click OK or Apply.

Note: The CCFP Overlay cannot be displayed if you are running the Precipitation or Echo Tops Forecasts. To display the CCFP overlay, select the CIWS Precipitation or Echo Tops mosaics or the NONE option.

If you display a CCFP overlay along with the Times dialog box, the Times box shows the time that the CCFP was issued and the time for which it is valid. The TSD indicates on the Times dialog box that CCFP data has expired if a time interval of 2.5 hours passes after the last data update.

The CCFP overlay is fully described in the section on the Select Weather Dialog Box-Legacy Version. For more information, see page 4-183.
Select Weather Dialog Box - Legacy Version

If you click the Legacy radio button, you will see the Legacy version of Select Weather dialog box.

Note: When you save The TSD will save the currently selected state of all of the options in both the CIWS and Legacy versions of the Select Weather dialog box. These saved values will be recalled when the dialog is reopened and they will be saved in adaptation and pref set files when those files are saved.
The Legacy Select Weather dialog box lets you select an overlay and change that overlay to meet your specifications. The following weather overlays are available in the Legacy version of the Select Weather dialog box:

- **NOWRAD**
  National Operational Weather Radar (NOWRAD) shows precipitation areas and levels of intensity for CONUS, Canada, and San Juan.

- **NOWRAD Legend**
  A numbered color-coded dialog box that controls the six precipitation level for NOWRAD overlays that appear on the TSD.

- **CCFP (Collaborative Convective Forecast Product)**
  Identifies areas for predicted thunderstorms.

- **CCFP Legend**
  Contains colors and codes for thunderstorm coverage, growth, and confidence.

- **NCWF (National Convective Weather Forecast)**
  NCWF provides one-hour extrapolation forecasts of thunderstorm locations.

- **Lightning**
  Weather Services International (WSI) Lightning. Shows current and historical lightning strikes for CONUS and Canada. This product is available for display with both the CIWS and Legacy products.

- **TOPS**
  Altitude of cloud echo tops in precipitation areas.

- **Jet Stream**
  Weather Services International (WSI) Jet Stream. Shows wind speed, altitude, and direction. This product is available for display with both the CIWS and Legacy products.

**NOWRAD Overlay and Legend**

The NOWRAD overlay shows areas of precipitation and precipitation intensity using a 2 km grid. The overlay shows levels of precipitation intensity in six colors. You can display NOWRAD data for the CONUS, Canada, and San Juan individually or at the same time. The TSD updates NOWRAD data for the CONUS every five minutes. To select a NOWRAD Overlay, click the check box for **CONUS Nowrad**, **CANADIAN Nowrad** and/or **SAN JUAN Nowrad**. Data for Canada and San Juan is updated every 15 minutes.

The Legacy version of the Select Weather dialog box allows you to display a legend with the NOWRAD overlay. To display the NOWRAD legend, click the **Show NOWRAD Legend** check box and click **OK** or **Apply**. The legend displays with six levels of precipitation selected. The levels of precipitation on the NOWRAD legend represent the lightest, Level 1, to the heaviest, Level 6.
The following sample shows the CONUS NOWRAD overlay with the NOWRAD Legend. The legend indicates that all six levels of precipitation are selected for display and the overlay shows all levels of precipitation intensity.

The NOWRAD legend appears with six levels of precipitation selected. The levels of precipitation represent a range from the lightest, level 1 to the heaviest, level 6. You can deselect lower levels of precipitation by clicking a level that is selected which deselects all levels that represent lower levels of precipitation. For example, clicking level 3 deselects levels 1 and 2. If you click a deselected level, you select that level and all levels representing higher levels of precipitation. After you click the levels you want selected or deselected, the TSD redraws your changes. To remove the legend, click the Legend check box to deselect it or click the close corner on the legend dialog box; otherwise, the legend remains displayed after you close the Select Weather dialog box.

**CCFP Display**

The Collaborative Convective Forecast Product (CCFP) overlay shows forecast areas where convective weather might occur. The CCFP forecast season typically runs from March 1 through November 30. During the CCFP forecast season, meteorologists at the Aviation Weather Center (AWC) produce a set of three CCFP forecasts every two hours, taking into account information provided by FAA and airline weather specialists.
The CCFP Weather product is available on the CIWS and the Legacy versions of the Select Weather dialog box. For information on using the CCFP overlay in the CIWS version of the Select Weather dialog box, see page 4-180.

The CCFP section of the Legacy Select Weather dialog box allows you to display a CCFP overlay and associated information for a 2, 4, or 6 hour forecast by clicking on the button for the desired forecast. You can also choose to hide or show CCFP data blocks and the CCFP Legend on the TSD display.

**Note:** The Canadian CCFP forecast season runs from April 1 through September. During March, October and November, when Canadian CCFP forecasting is not operational, the CCFP section of the Select Weather dialog box displays the message "Canadian CCFP is NOT AVAILABLE."

The TSD receives CCFP data updates every two hours and displays only the most recently issued data. If you display a CCFP overlay along with the Times dialog box, the Times box shows the time that the CCFP was issued and the time for which it is valid. The TSD indicates on the Times dialog box that CCFP data has expired if a time interval of 2.5 hours passes after the last data update.

**CCFP Forecast Polygons**

Each CCFP forecast area displays as a two-dimensional area or polygon and has associated with it the following attributes: coverage, confidence, speed and direction of movement, echo tops, and growth.

**Convective Coverage and Confidence**

For each CCFP polygon, the TSD depicts convective coverage using the following fill patterns:

- Solid fill: high forecast coverage
- Medium fill: medium forecast coverage
- Sparse fill: low forecast coverage

Forecast confidence is depicted in each polygon in the following colors:

- Slate blue: high confidence
- Gray: low confidence
The following image shows five forecast areas. Sparse fill indicating mostly low convective coverage dominates. One small polygon shows medium fill indicating medium coverage for that area. A slate blue color shows those areas assigned a high confidence forecast.
Direction and Speed of Movement

The direction of a forecast area is indicated by a green arrow that points from the polygon in the direction that the forecast is moving. The speed of movement in knots is indicated by a value near the tip of the direction-of-movement arrow. In the image below two polygons indicating low coverage and low confidence are moving at 10 knots per hour in a westerly and north westerly direction. A third polygon indicating low coverage and high confidence is moving at 20 knots per hour in a south easterly direction.

Echo Tops and Growth Rate

Echo tops information displays in the data block for a forecast area as a three digit number with possible values of 290, 340, 390, or 400. These numbers represent the maximum value of the forecast tops for the area with the exception of 400. A value of 400 represents tops forecast at or above 40,000 feet.

Growth rate information displays to the right of the echo tops value in the data block for a forecast area as an up arrow representing positive growth or a down arrow representing negative growth. A data block that displays no arrow represents no change in growth rate. For more information, see CCFP Data Blocks and CCFP Legend on page 4-183.
CCFP Data Blocks

CCFP data blocks contain echo tops and growth rate information for a CCFP forecast area. To prevent confusion about which data block applies to a particular forecast area, the TSD displays a leader line connecting the polygon with its data block. If a data block is positioned within a forecast area, no leader line displays.

In the following image, a low coverage/low confidence forecast area contains two areas assigned a low coverage/high confidence forecast. The low coverage/low confidence forecast polygon (in gray) shows a data block indicating forecast tops with a maximum value of 390 (39,000 feet) and a negative growth rate. Data blocks for the two areas assigned a low coverage/high confidence forecast (the polygons in slate blue) show tops that are forecast at or above 40,000 feet. One of these data blocks shows a negative growth rate and the other shows no change in growth rate.
You can show or hide all CCFP data blocks or any individual data block. To display all CCFP data blocks on the TSD, click the **Data Blocks** check box in the CCFP section of the Select Weather Legacy dialog box. Click to uncheck the Data Blocks check box to turn off the display of CCFP Data Blocks.

To show or hide an individual data block, right-click on the CCFP polygon and select **Toggle Label** from the right-click menu. If desired, drag-and-drop the data block to a new location on the TSD.
CCFP Forecast Lines of Convection

A CCFP forecast can also contain forecast lines of convection. The TSD displays CCFP forecast lines of convection in the color purple. High coverage lines appear as solid lines and medium coverage lines appear as dashed lines.

The example below shows several CCFP polygons and illustrates medium and high forecast lines of convection; low, medium, and high forecast coverage; low and high confidence forecasts; speed and direction of movement; and echo tops and growth rate information.
CCFP Legend

Clicking on the CCFP Legend check box in the Select Weather Legacy dialog box displays a legend for the CCFP forecast.

Note: If you close the legend, the Legend check box in the Select Weather dialog box toggles off automatically and is deselected.

The CCFP legend shows the convective coverage fill patterns and the colors used to indicate confidence in the CCFP forecast polygons. Note that the fill patterns on the legend display as they would look using black for the TSD background color.
The table below explains the convective coverage areas and the confidence levels determined by the weather specialists in their forecasts of convective activity.

**CCFP Convective Coverage and Confidence Chart**

<table>
<thead>
<tr>
<th>Polygon Fill / Polygon Color</th>
<th>Coverage</th>
<th>Confidence</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solid Fill / Slate Blue</td>
<td>High 75 - 100%</td>
<td>High 50 - 100%</td>
</tr>
<tr>
<td>Solid Fill / Gray</td>
<td>High 75 - 100%</td>
<td>Low 25 - 49%</td>
</tr>
<tr>
<td>Medium Fill / Slate Blue</td>
<td>Medium 40 - 74%</td>
<td>High 50 - 100%</td>
</tr>
<tr>
<td>Medium Fill / Gray</td>
<td>Medium 40 - 74%</td>
<td>Low 25 - 49%</td>
</tr>
<tr>
<td>Sparse Fill / Slate Blue</td>
<td>Low 25 - 39%</td>
<td>High 50 - 100%</td>
</tr>
<tr>
<td>Sparse Fill / Gray</td>
<td>Low 25 - 39%</td>
<td>Low 25 - 49%</td>
</tr>
</tbody>
</table>

The CCFP Legend also shows the following:

- The color and thickness of the forecast lines of convective coverage as well as how high and medium coverage forecast lines are drawn.
- What the echo tops value in a data block represents.
- How the positive and negative growth rate of a forecast area is represented.
- How the direction of movement of a forecast area, as well as the speed in knots, is indicated.
Other Weather Overlays

NCWF – National Convective Weather Forecast

To display the NCWF option, click the NCWF check box on the Select Weather dialog box and click OK or Apply. NCWF data updates every 5 minutes.

The National Convective Weather Forecast (NCWF) uses polygons to depict a one-hour forecast of the location of currently existing thunderstorms. NCWF does not forecast the initiation of new storms or the growth or decay of existing storms. Each forecast polygon is simply an extrapolation of the storm's current shape, direction, and speed. As the storm's shape, direction, or speed changes, its polygon, arrow, and number will change, too, every five minutes.

Each polygon represents the size and shape of the core of the storm, roughly speaking, the level 3 and higher precipitation. It is not intended to encompass the lower-intensity, outer boundaries of the storm. Each polygon is accompanied by an arrow and a number that indicate the storm's current direction of motion and speed, in knots. The length of each storm's arrow corresponds to the speed of that storm. A storm moving 50 nautical miles per hour has an arrow that is 50 nautical miles long. The base of the arrow is located at the center of the currently existing storm. The tip of the arrow is located at the center of its forecasted location. The number near the base of the arrow is the storm's current speed.
**NCWF Polygons, Arrows, and Numbers**

Each polygon represents the size and shape of the core of the storm, roughly speaking, the level 3 and higher precipitation. It is not intended to encompass the lower-intensity, outer boundaries of the storm.

The length of each storm's arrow corresponds to the speed of that storm. A storm moving 50 nautical miles per hour has an arrow that is 50 nautical miles long. The base of the arrow is located at the center of the currently existing storm. The tip of the arrow is located at the center of its forecasted location. The number near the base of the arrow is the storm's current speed. Arrows appear only for storms with forecast polygons.

**Which Storms Have Forecast Polygons?**

NCWF will not issue forecast polygons for every storm. In order to have a forecast polygon, a storm must:

- Have echo tops of at least 15,000 feet and be at least 500 square miles in area, and
- Be convective with significant vertical development rather than stratiform, and
  - Have a stable track vector in the NCWF algorithm
  Or
  - Have a significant cloud-to-ground lightning flashrate
- Have a stable track vector in the NCWF algorithm

Most storms will not have forecast polygons early in their lifetimes because it can take 20 minutes or more for the algorithm to develop a stable track vector once the storm fulfills the other criteria. When the storm no longer meets the criteria listed above, the NCWF stops issuing forecast polygons for that storm.

The presence of an NCWF polygon does not guarantee that the storm will persist for one hour. The absence of an NCWF polygon does not mean that the storm will not persist for one hour. The presence and absence of polygons is based simply upon whether the storms meet the criteria listed above.

**NCWF Performance**

Analysis of all of the NCWF polygons from 2002 shows that the forecasts were correct about 30% of the time (i.e., storms did occur inside the forecast polygons at the forecast valid time) and the forecasts were incorrect about 70% of the time (i.e., storms did not occur in the forecast polygon at the valid time or the storms that did occur were not strong enough to meet the forecast validation criteria). Indeed, most individual thunderstorms do not last for more than an hour so a one-hour forecast of their location should be evaluated carefully.

Thunderstorms of the air-mass or ‘popcorn’ variety usually do not persist long enough to reach their one-hour forecast locations. Nevertheless, the NCWF storm motion information for those storms may be valuable to TFMS users for tactical purposes. Storms that persist for more than one hour may be described as ‘organized’ convection associated...
with a cold front or a dry line or some other long-lived causal factor. NCWF polygons are more accurate for organized storms than for air-mass storms.

**The Times Box**

The Times Box indicates the time for which the NCWF forecast is valid. (e.g., NCWF Valid: 2012) The valid time is one hour in the future with respect to the time that the weather radar data were collected. It takes several minutes to collect the data and several more minutes to process it, so the valid time will usually be 45-55 minutes in the future with respect to the current time.

When weather data goes out of date, the time values change. The TSD indicates time expirations by displaying them in red. Item labels and times flash in red and black for one minute when they expire and remain red after the lapse of one minute. If current weather data is unavailable, the Times box shows that weather item’s time as 0000, N/A for Not Available, or blank spaces. The TSD will not display that overlay or a Jet Stream overlay more than 12 hours old. If any weather file including CCFP is received more than 30 minutes early, the TSD will display the time in red in the Times Dialog box.
Lightning

The Lightning overlay displays the most recent lightning strikes for CONUS. With this overlay you can also display lightning strikes that occurred at an earlier time. To select the latest strikes or the strikes that occurred earlier, click the **Lightning** check box on the Select Weather dialog box and click the **Options** button to open the Lightning History dialog box. The Lightning History dialog box, shown below, also allows you to open the color palette and change the overlay color.

The Lightning History dialog box lets you select the latest lightning strikes, or strikes from an earlier time, and allows you to specify the color in which a lightning overlay is displayed on the TSD. The Show checkboxes represent the overlays for lightning strikes during the past hour. Click a check box to select the overlay for a specific time. You can select more than one lightning overlay. For example, you can show how the lightning has changed over the past hour by selecting several overlay times.

To change the color of the lightning icons, click the Color button for an overlay, select a color from the color palette that displays, and click **OK**.

After you select the Lightning option on the Select Weather dialog box, make your selections on the Lightning History dialog box, and click **OK** or **Apply**, the overlay appears on the TSD. The Lightning overlay displays each lightning strike as a cross icon (+) in the color specified. The TSD updates lightning data every 5 minutes.
**Tops**

To display the Tops overlay, click the **TOPS** check box on the Select Weather dialog box and click **OK** or **Apply**. The radar Tops overlay updates every 10 minutes.

The radar **Tops** overlay displays the altitude of cloud tops within precipitation areas. Labels indicate the altitude of cloud tops in hundreds of feet. For example, the number **300** indicates 30,000 feet. The three digit values show the flight level associated with the maximum height of the tops.

You can change the color of the altitude labels. In the Select Weather dialog box, click the **Tops** check box and click the color button to display a color palette. Click the color you want the tops to appear. The button changes to reflect the new color. Click **OK** or **Apply**. The TSD redraws with radar tops appearing in the color of your choice.

You can also use the TOPS Quick Key, by pressing **T** to toggle on and off the display of Legacy Radar Tops. Note that this Quick Key is disabled if the CIWS version of the Select Weather dialog box is selected.

![Map with Tops overlay](image)

**Note:** When displaying radar tops, it is useful to issue the **NOWRAD** command, which displays areas and levels of precipitation.
Jet Stream

The Jet Stream overlay, updated every three hours, shows areas where winds are strongest or greater than 70 knots. Within these areas, the overlay displays wind speed, altitude, and direction. After you click the Jet Stream check box and click OK or Apply in the Select Weather dialog box. An Options button allows you to open the Legacy Jet Stream Options dialog box, shown below, select which elements of the jet stream overlay to show and specify the colors for the overlay.

Note: At least one Jet Stream option must be selected in the Jet Streams Options dialog box. You will see an error message if you try to deselect all of the options.

The components of the Legacy Jet Stream overlay function in the same manner as the CIWS Jet Stream Overlay. For more information, see page 4-178.
The **WX Report** command lets you display and print weather information. You can generate a weather report for any airport you specify.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Weather menu by clicking <strong>Weather</strong> on the main menu or pressing <code>&lt;Alt&gt;W</code>.&lt;br&gt;2. Click <strong>WX Report</strong> or press <strong>X</strong>.</td>
<td>None</td>
</tr>
</tbody>
</table>

**Semicolon Method**

Input Request:
**WX airport**

**Weather Report Prompts Dialog Box**

After you click **WX Report** or press the mnemonic key from the Weather menu, the Weather Report Prompts dialog box opens.

![Weather Report Prompts Dialog Box](image)
Enter a 3- or 4-character location identifier. For example, to specify a weather report for MCI airport, enter **MCI** or **KMCI**. After you click **OK** or **Apply**, the report opens.
About the Display

The TSD displays reports in two sections. The first part contains Aviation Routine Weather Report (METAR) data and the second part contains International Aerodrome Forecast (TAF) weather data.

The following table describes METAR and TAF weather data.

<table>
<thead>
<tr>
<th>Report data</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>METAR</td>
<td>Weather report.</td>
</tr>
<tr>
<td>TAF</td>
<td>Aerodrome forecast.</td>
</tr>
<tr>
<td>KJFK</td>
<td>Location identifier. Both LID and KLID are accepted.</td>
</tr>
<tr>
<td>091451Z</td>
<td>Two-digit day of month and four-digit time. Z=UTC time.</td>
</tr>
<tr>
<td>105M or P65M</td>
<td>Visibility (in miles and fractions). P=prevailing.</td>
</tr>
<tr>
<td>FEW036</td>
<td>Cloud height and type. Three-digit height in hundreds of feet. SCT=scattered; BKN=broken; OVC=overcast; TCU or CB=towering cumulus; CLR=clear below 12,000 feet.</td>
</tr>
<tr>
<td>10/02</td>
<td>Temperature/dew point.</td>
</tr>
<tr>
<td>A3030</td>
<td>Altimeter in inches of mercury.</td>
</tr>
<tr>
<td>RMK A02 SLP261</td>
<td>Remark data. Remarks can include information such as lightning behavior, tornadoes, and funnel clouds.</td>
</tr>
</tbody>
</table>

You can print a copy of these reports before closing the windows and returning to the TSD screen.

**Note:** Use the scrolling arrows to scroll through the weather report if it contains more information than the window can display at one time.
The **RVR Report** command lets you display and print Runway Visual Range information. You can generate an RVR report for any airport you specify.

### Menu Method

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Pull down the Weather menu by clicking <strong>Weather</strong> on the main menu or pressing <code>&lt;Alt&gt;W</code>.</td>
</tr>
<tr>
<td>2.</td>
<td>Click <strong>RVR Report</strong> or press <code>V</code>.</td>
</tr>
</tbody>
</table>

### Quick Key Method

None

### Semicolon Method

Input Request:

**RVR airport**

---

**RVR Prompts Dialog Box**

After you click **RVR Report** or press the mnemonic key from the Weather menu, the RVR Prompts dialog box opens.
Enter a three or four character location identifier, such as BOS or KBOS to specify a report. After you click OK or Apply, the report opens.

![RVR Report](image)

**About the Display**

The TSD displays the RVR report, which looks like the following sample.

**RVR Data Report**

<table>
<thead>
<tr>
<th>Column Header</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RWY</td>
<td>Runway identifier. Numeric values from 01 through 36. A sub-runway value might be appended to the RWY. The sub-runways are defined as L (left), R (right), or C (center). A blank in this field indicates there is no sub-identifier.</td>
</tr>
<tr>
<td>TD MP RO</td>
<td>Runway Visual Range at the <strong>touchdown</strong>, <strong>middle</strong> and <strong>rollout</strong> points. Values range from 0000 to 6000, representing feet. A trend indicator is displayed directly to the right of each displayed RVR value to indicate the trend of the RVR value over the previous five-minute window. A <strong>plus sign</strong> [+] indicates an increasing trend, a <strong>minus sign</strong> [-] indicates a decreasing trend and a steady trend is indicated by the absence of an indicator. A <strong>blank</strong> value indicates that no RVR system visibility sensor is needed for that precision point on the runway based on the instrumentation and landing category of that runway. A value of <strong>FFF</strong> indicates that a corresponding RVR sensor is off-line or data is invalid.</td>
</tr>
<tr>
<td>E</td>
<td>Runway <strong>Edge</strong> Light Setting. Values range from 0 (off) to 5 (maximum intensity), or F (sensor is off-line or data is invalid).</td>
</tr>
<tr>
<td>C</td>
<td>Runway <strong>Centerline</strong> Light Setting. Values range from 0 (off) to 5 (maximum intensity), <strong>blank</strong> (no centerlines are configured for the runway), or F (sensor is off-line or data is invalid).</td>
</tr>
</tbody>
</table>

**Note:** If data is not currently being received for an airport, the message, “Data Not Available” is displayed.
Reroute Menu: Normal Mode

Overview

This section describes the functionality of the TSD Reroute commands in Normal mode. Features of the Reroute commands let you produce one or more graphic overlays showing areas where flight reroutes have been suggested due to severe weather conditions or traffic congestion. Normal mode refers to the way the TSD behaves using normal commands without using preview or modeling functionality. Specific to reroutes, Normal mode refers to the normal issuing of reroutes based on currently operational functions.

Reroutes commands include:

- Reroute Impact Assessment (RRIA) which allow you to view reroutes in Preview and Model modes. Preview functions provide a quick way to see how many flights (and optionally which flights) would be affected by a proposed reroute, and to see how those numbers would change if you modify the reroute. In reroute modeling mode, the TSD will display the projected state of the NAS taking into account the projected impact of a proposed reroute, leaving operational data unaffected until the reroute is issued.

- Execution of Flow Strategies (XFS) function enables the amending of a flight’s route to make it conformant with a reroute. The XFS function lets traffic managers use the TSD to submit route amendments for non-conformant flights to En Route Automation Modernization (ERAM) and provides other features related to monitoring and executing reroutes.
This section includes commands and functions that may be used in Normal mode as well as in Preview or Model modes. Functions used primarily for reroute modeling are discussed in the next chapter.

See see “Reroute Menu: Reroute Impact Assessment” on page 4-333 for information on using the TSD in Preview mode and Model mode.

Weather specialists coordinate alternate route sets and provide data to key personnel at the ARTCC located in the areas that the reroute set affects. This section is divided into the following topics, each of which corresponds to an item on the Reroute pull-down menu.

- **Show/Hide Reroutes Command**  
  Shows or hides all reroute sets that have their Show checkboxes checked in the Select Reroute dialog box.

- **Select Reroutes Command**  
  Defines reroute sets that are to be shown on the TSD display, and reroutes that are available for editing.

- **Monitor All Reroutes Command**  
  Monitors the flights involved in public reroutes and also lets you obtain periodic updates.

- **Create Reroute Command**  
  Defines a new reroute set.

- **Preferences Command**  
  Lets you specify your preferences for the default display options.
Show/Hide Reroutes Command

Show Reroutes/Hide Reroutes command lets you turn on or off the display of reroute sets that have been selected for display in the Select Reroutes dialog box. You must have selected a reroute set before reroutes will appear on your display. See Select Reroutes Command on page 4-209 in the next section. Either Show Reroutes or Hide Reroutes appears on the Reroute menu.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Reroute menu by clicking Reroute on the TSD Main Menu or pressing &lt;Alt&gt; R.</td>
<td>None</td>
</tr>
<tr>
<td>2. Click Hide Reroutes or Show Reroutes or press R.</td>
<td>Semicolon Method</td>
</tr>
<tr>
<td></td>
<td>None</td>
</tr>
</tbody>
</table>
When you select Show Reroutes, if a reroute set has been selected, a display similar to the following is displayed.

![Traffic Situation Display (Dynamic Projection)](image)

**Reroute Line Styles**

The reroutes graphic shows the four distinct appearances of reroute sets as they appear on the TSD.

- **Public Reroutes**: 
- **Shared Reroutes**: 
- **Local Reroutes**: 
- **Private Reroutes**:

- Public reroute sets are created by specialists at the ATCSCC and are shared with all TFMS users.
- Shared reroute sets can be created by any TFMS user and can be viewed by users at sites specified in the reroute definition.
Local reroutes are created by users at TFMS field sites and are shared with other TFMS users within their facility.

Any TSD user may create private reroutes for viewing on their workstation only.

**Viewing Protected Segments**

You can view protected segments that have been defined for a reroute by browsing the displayed reroute. When you browse the reroute, the TSD draws the protected portion of the route in a slate blue color using the same 2 pixel line style as the non-protected portion. The example below shows a browsed Public reroute. The protected portions display in a slate blue color.

Note: To set a reroute to display its protected segments when drawn, the Protected Segments checkbox in the Display Reroute section of the Create or Edit dialog box must be checked. See Display Reroute on page 4-307.
Dragging and Dropping Reroute Names

Reroute set names are sometimes difficult to see when several other map items are displayed on the TSD. You can drag the labels to a location where you can see them more easily. When the pointer moves over any segment of the reroute or the reroute label name, the TSD highlights both the segment and the label name. With the reroute highlighted, click and hold the middle mouse button, drag the reroute name to the new location, and release the button. The reroute name separates from the reroute and appears in the new location with a lead line connecting the label to the reroute. The reroute itself does not move.

Save and Recall Reroutes Parameters

The Adapt→Save and Adapt→Recall commands were covered in the Display Menu section. Using these commands you can save such items as map overlays and flight sets. You can also save and recall your preferences for creating and displaying reroute sets.
Select Reroutes Command

The Select Reroutes command enables you to choose the reroute sets you want to display on the TSD map. You can specify whether the label, navaids, and/or fixes for a reroute set display and the color in which the TSD draws each reroute. The Select Reroutes list is sorted first by Domain in the following order: Public, Shared, Local, and Private. You can choose “Name” or reroute “End” time as a secondary sort. This command also allows you to edit, copy, view, or delete a selected reroute, monitor reroutes, view model results, and model a reroute cancellation.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Reroute menu by clicking Reroute on the TSD Main Menu or pressing &lt;Alt&gt; R.</td>
<td>None</td>
</tr>
<tr>
<td>2. Click Select Reroutes or press S.</td>
<td>Semicolon Method</td>
</tr>
</tbody>
</table>

Select Reroutes Dialog Box

After you click Select Reroutes or press S, the Select Reroutes dialog box, which contains a list of all reroutes in the database, opens. A sample dialog box is shown below, with the reroutes sorted by Domain - Public, Shared, Local and Private - and next sorted in alphabetical order by Name. Public reroutes are always listed first.

You may also sort the Reroute list within each Domain by End/Date time, with earliest end time. Click the End column label button to change the sort from Name to End/Date time.
To change back, click the Name column label button. Sort order can also be changed using the Sort By option on the Function menu.

**Note:** The sort order is maintained in the state you select when you close the Select Reroute dialog box. Also, the sort order is saved with the adaptation file when you select Display ⇨ Adapt ⇨ Save.

The following table explains how to use the Select Reroutes dialog box checkboxes and fields. The Functions menu and Info button are discussed later in this section. Press <Tab> to move forward and <Shift> <Tab> to move backward between fields.

### Select Reroutes

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What you do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Reroute</td>
<td>Toggles the display of the reroute on the TSD map after you have selected</td>
<td>To toggle a check mark and display the reroute on the TSD map after the Show Reroutes command is issued, click the checkbox. The reroute line segments are drawn using a dashed line of 2 pixel width.</td>
</tr>
<tr>
<td></td>
<td>the Show Reroutes command. For information on viewing protected segments, see</td>
<td></td>
</tr>
<tr>
<td></td>
<td>the section on Viewing a Reroute's Protected Segments.</td>
<td></td>
</tr>
<tr>
<td>Show Label</td>
<td>Toggles a display of the label for the reroute set.</td>
<td>Click the checkbox to toggle a check mark. *</td>
</tr>
<tr>
<td>Show Navaids</td>
<td>Toggles a display of the navaids for the reroute set.</td>
<td>Click the checkbox to toggle a check mark. *</td>
</tr>
<tr>
<td>Show Fixes</td>
<td>Toggles a display of the fixes for the reroute set.</td>
<td>Click the checkbox to toggle a check mark. *</td>
</tr>
<tr>
<td>Domain</td>
<td>Defines reroute set domains: Public, Shared, Local, or Private. Only users</td>
<td>You cannot edit the Domain field in this dialog box. You must use the Functions Menu/Edit Reroute option on the Select Reroutes dialog box to make a change. The Functions menu is discussed later in this section.</td>
</tr>
<tr>
<td></td>
<td>at designated sites, ATCSCC for example, can create Public reroute sets.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Reroute set domains are sorted by Domain in the following order:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Public, Shared, Local, and Private.</td>
<td></td>
</tr>
<tr>
<td>Status</td>
<td>Displays the status of the reroute: Active or Expired.</td>
<td>You cannot edit the Status field.</td>
</tr>
<tr>
<td></td>
<td>• If the reroute is not monitored,</td>
<td></td>
</tr>
<tr>
<td></td>
<td>the Status is Expired if the End Time is in the past; otherwise the</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Status is Active.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• If the reroute is monitored, the</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Status is Expired if the End Time is in the past and RMP has stopped</td>
<td></td>
</tr>
<tr>
<td></td>
<td>monitoring the reroute as indicated by the lack of a dynamic list for</td>
<td></td>
</tr>
<tr>
<td></td>
<td>the reroute. Otherwise the Status is Active.</td>
<td></td>
</tr>
</tbody>
</table>
## Select Reroutes (Continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What you do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color</td>
<td>Lets you determine the color for each reroute set.</td>
<td>Click the button to display a color palette. Click your choice of reroute color. Your selection of color will not affect display of reroutes for other users. *</td>
</tr>
<tr>
<td>Name</td>
<td>User-specified name for the reroute set. By default, the name of the reroute set appears as a label.</td>
<td>The reroute name cannot be changed in this dialog box. You must use the Functions Menu/Edit Reroute option on the Select Reroutes dialog box to make a change. The Functions menu is discussed later in this section.</td>
</tr>
<tr>
<td>End</td>
<td>Four-character end time in UTC, depending upon your Preference setting.</td>
<td>The end time cannot be changed in this dialog box. You must use the Functions Menu/Edit Reroute option on the Select Reroutes dialog box to make a change. The Functions menu is discussed later in this section.</td>
</tr>
<tr>
<td>ADZ</td>
<td>Lets you view the text of a public reroute advisory. Also available on the Reroute Monitor.</td>
<td>This column displays the advisory number button associated with a public reroute. Click the ADZ number button to display the Reroute Advisory dialog box, showing the text of the advisory. If there is no advisory associated with the reroute, the button displays dashes (“---”).</td>
</tr>
<tr>
<td>View Model</td>
<td>Switches the TSD into reroute modeling mode and displays the View Reroute dialog box with model results for the selected reroute.</td>
<td>If model data is available for the reroute, the button displays “View”; otherwise the button displays dashes (“---”). After you click a reroute row’s View button, you will see an information dialog with the message: “Please wait while the TSD requests model results.” For information on viewing Reroutes in Model Mode, see “Reroute Menu: Reroute Impact Assessment” on page 4-333.</td>
</tr>
<tr>
<td>Info</td>
<td>Allows you to see additional information about the reroute.</td>
<td>Click the Info button to display the Reroute Information dialog box which shows additional information about the selected reroute. See page 4-214. for more information.</td>
</tr>
</tbody>
</table>

**Note:** * You can change the display attributes for each reroute using the Show Label, Show Navaids, Show Fixes and Color options, but the change in display will not change the reroute database when these attributes are changed in the Select Reroutes dialog box.  

You can toggle all of the checkboxes in a column on or off by clicking the column label.
Viewing a Reroute's Protected Segments

You can view the protected segments for a reroute if the Show Reroute checkbox on the Select Reroute dialog box is checked and the Show Reroutes command has been issued. To view the protected segments for the reroute, browse the shown reroute on the map. When you browse the protected portion or portions, the TSD highlights the segment by coloring it a slate blue color and displays the protected portion using the same 2 pixel line style as the non-protected portion.

The example below shows a browsed Public reroute with its protected segments highlighted in slate blue.

**Note:** You define the protected segments for a reroute on the Reroute Definition tab of the Create or Edit Reroute dialog box. To enable drawing of protected segments, the Protected Segments checkbox in the Display Reroute section of the Reroute Definition tab must be checked. See Display Reroute on page 4-307 and Protected Segments on page 4-309.
Advisory (ADZ) Button

The ADZ column shows the advisory number associated with each public reroute. Click the Advisory number button associated with a public reroute to view Reroute Advisory text.

When you create and save a reroute, the TSD automatically constructs and saves a Traffic Management Initiative (TMI) ID with the reroute definition. The TMI ID is included in the reroute advisory and informs en route controllers that a flight is in a reroute and which reroute the flight is in. The TMI ID for a reroute consists of the following three elements: the letters "RR", a three character facility ID of the facility where the reroute was created, and the advisory number if an advisory was issued for the reroute; otherwise a unique 3-digit sequence number. For example, RRZZZ025.
Reroute Information (Info) Button

All of the information about a specific reroute is not shown on the Select Reroutes dialog box. If you want additional information, click the **Info** button for that reroute set. After you click the **Info** button, a dialog box is displayed with information for that reroute. This dialog box displays additional information about the reroute including the reroute name (in the title bar), the site and workstation that updated the reroute, the date and time the reroute was last updated, and the date and time model results, if available, were generated. The dialog box also displays Start and End times for the reroute. If the reroute was defined to identify flights based on a public FEA/FCA flight list, Entry From and To times display. The reroute start time displays a prefix of ETD or ETA depending on how the reroute set was defined.

![Reroute Information Dialog Box](image)

Click **OK** to close the dialog box and return to the Select Reroutes dialog box.
Select Reroute Dialog Box Functions Menu

Use the Functions menu, located on the upper left side of the Select Reroutes dialog box, to perform the following reroute functions options. Select a reroute by clicking the row number button to the left of the reroute row, then select one of the options from the Functions menu.

The following options are available on the Functions menu:

- Edit Reroute page 4-215
- Copy Reroute page 4-218
- View Reroute page 4-220
- Delete Reroute page 4-223
- Cancel Reroute page 4-224
- Monitor Reroute(s)... page 4-226
- View Model page 4-220
- Model Reroute Cancellation page 4-227
- Sort by page 4-227

Note: If no reroute is selected on the Select Reroute dialog box, or if the Create/Edit Reroute dialog box is already open, only Sort by is enabled and all other options are disabled (grayed out). The availability of each option depends on row selection(s) made in the Select Reroute dialog box and whether you are authorized to make changes to a selected reroute. For details on whether a particular function is available or disabled, refer to the function option sections, as listed above.

Edit Reroute

The Edit Reroute option lets you edit a reroute definition.

The Edit Reroute option is disabled if:

- You have selected multiple reroute rows in the Select Reroute dialog box.
- You have selected a public reroute row (or rows) and you are not authorized to create or edit public reroutes. Typically, authorization to edit public reroutes is reserved to Command Center users.
- You have selected a row with a Shared reroute that was created at a TFMS site other than where you are using the TSD.
In the Select Reroutes dialog box, click the number of the reroute you want to edit and select **Edit Reroute** from the Functions menu. The following dialog box opens.

Procedures for using the Edit Reroute dialog box are the same as those for using the Create Reroute dialog box. See the Create Reroute Command section on page 4-282 for detailed information.
Sending Cancellation Messages Due to Dropped Flights

Upon saving edits to a reroute definition, a Cancellation Messages section displays on the Issue Reroute dialog box if pre-departure or active flights exist that no longer match the reroute definition and an amendment message was sent to ERAM and accepted for at least one of the dropped flights.

The radio buttons in the Cancellation Messages section allows you to choose whether you want to send a cancellation message to ERAM for all dropped flights or only those flights that are not airborne. Cancellation messages notify ERAM that the reroute protected segment and TMI ID for the flights are no longer needed.
**Copy Reroute**

The Copy Reroute option lets you create a new reroute by copying and editing an existing reroute definition.

The Copy Reroute option is disabled if you have selected multiple reroute rows in the Select Reroute dialog box.

In the Select Reroutes dialog box, click the number of the reroute you want to copy and select **Copy Reroute** from the Functions menu. The Create Reroute dialog box opens, populated with the copied reroute information, as shown in the following example.

The Copy Reroute option is also available on the Functions menu of the Create Reroute, Edit Reroute, and View Reroute dialog boxes. See the Create Reroute Command section on page 4-282 for detailed information on how to use the Create Reroute dialog box.
Using the Copy Reroute Option

When you select a reroute and then select the Copy Reroute option, the Create Reroute dialog box opens displaying the information defined for the reroute selected for copying with the following exceptions:

- The Name field on the Reroute Definition and Advisory tabs displays the text “COPY_OF” before the reroute name as a reminder that it is a copy of another reroute. If you want to save the copied reroute, you must edit or remove the prefix “COPY.” The system will not let you save a reroute that begins with the word “Copy.”
- The Domain field displays a domain of Private regardless of the domain of the reroute being copied. You can edit the domain.
- The reroute color is set to the color defined on the Select Reroutes dialog box instead of the color defined for the reroute being copied.

Modeling Changes to an Existing Reroute

The Copy Reroute option can be used if you want to edit and model an existing reroute and share those model results before you issue the edited reroute as a replacement for the original Public reroute.

You can copy the original reroute, modify it, model it and share the results with other sites, if desired. When you are ready to issue the edited reroute as a replacement for the original, you must change the Domain to Public and edit the reroute name so that it does not begin with the word “COPY”. After you click Send on the Create Reroute dialog box the TSD displays a message in the Issue Reroute dialog box to remind you that the original public reroute will be replaced by the edited copy.

Note: Only Command Center traffic managers have the ability to make a reroute public.
Click **Send** on the Issue Reroute dialog box to replace the original reroute with the copy. The Select Reroute dialog box reflects the replacement. There is no longer a reroute named BUM CAN.

If you want to retain the name of the original reroute, you must modify the reroute name on the Reroute definition tab before sending the reroute.

Click **Cancel** to close the Issue Reroute dialog box without making the reroute replacement.

**View Reroute**

The View Reroute option lets you view a reroute definition without allowing you to edit the definition. You can access the View Reroute dialog box by clicking on the number of the reroute you want to view and selecting View Reroute from the Functions menu of the Select Reroute dialog box. The View Reroute dialog box opens.

The View Reroute option is disabled if you have selected multiple reroute rows in the Select Reroute dialog box.

**Note:** The View Reroute dialog box opens in Model mode when you select the View Model option from the Functions menu of the Select Reroute dialog box and model results are available.

For information on using Model Mode, see see “Reroute Menu: Reroute Impact Assessment” on page 4-333.
The following is an example of the View Reroute dialog box:

![View Reroute Dialog Box](image)

**Using the View Reroute Dialog Box**

Most of the fields and buttons that are active in Create/Edit Reroute are disabled on the View Reroute dialog box. The View Reroute dialog box allows you to view the reroute definition and do the following.

- Draw the reroute and any associated Miles in Trail (MIT) restrictions on the TSD display. (See Miles In Trail (MIT) Restrictions on page 4-391 in the Reroute Impact Assessment section of Chapter 4, for more information.)
- Draw the protected segments of a reroute on the TSD display.
- View the Flight List tab, sort and/or customize the flight list columns, and print the flight list if one was saved with the reroute.
- View the Shared Sites Tab if the reroute is a Shared reroute.
- View the Restrictions Tab and any saved MIT restrictions.
- View the Advisory Tab.
- If authorized, model the reroute and view the Analysis tab and model results.
Note: If the entire text for a route is not visible in the route grid of the Reroute Definition tab, you can browse over the row to display a tooltip with the full route text.

Miles in Trail (MIT) Restrictions are discussed in the Reroute Impact Assessment section of Chapter 4 beginning on page 4-333.

File Menu
The File Menu on the View Reroute dialog box provides two options: Save My Routes and Manage My Routes.

Functions Menu
The Functions Menu on the View Reroute dialog box provides the options.

• View Replace Reroute(s)
  
The View Replace Reroute(s) option opens the Replace Selected Reroutes dialog box allowing you to view the name and advisory number of the active, required reroutes that have been selected to be replaced. The Replace Selected Reroute dialog box is discussed on page 4-378 in the Reroute Impact Assessment section of Chapter 4.

• Copy Reroute
  
If you select the Copy Reroute option, the Create Reroute dialog box opens allowing you to create a new reroute based on the reroute you are viewing. After selecting this option, the name field on the Reroute Definition tab displays the text “COPY_OF-” before the reroute name. For more information on the Copy Reroute option, see Copying a Reroute in this chapter on page 4-218.

• Edit Reroute
  
If you select the Edit Reroute option and the reroute has modeling data available, the Edit Reroute dialog box opens in Model mode. The Edit option is not available if the reroute you are viewing is a public reroute and you are not authorized to edit the reroute.

View Menu
The View Menu provides the following options

• Show POI Counts...
  
  - Total
  
  - Hour
  
  - 15 Minutes

• Hide POI Counts
  
Use the Show POI Counts option to set how you want POI counts to display when
you are in model mode. For more information on POI counts, see the POI Timeline on page 4-389 in the Reroute Impact Assessment section of Chapter 4.

- **View Model**
  If model results are available for a reroute, the View Model option is active. After selecting View Model, the View Reroute dialog box opens in Model mode displaying the previously calculated model results. For more information on Model mode, see page 4-369 in the Reroute Impact Assessment section of Chapter 4.

### Delete Reroute

The **Delete Reroute** option on the Select Reroutes Functions menu lets you delete one or more Local, Shared or Private reroutes. Public reroute with Expired status can be deleted by authorized users.

If you select public reroute with Active status, and select the **Delete Reroute** menu option, an error dialog box will display with the message “You have selected an active public reroute. You must use the Cancel Reroute option for this reroute, not the Delete Reroute option.” Click **OK** button to close Error dialog box.

The Delete Reroute option is disabled if:

- You have selected a Public reroute row (or rows) and you are not authorized to create or edit Public reroutes.
- You have selected a row with a Shared reroute that was created at a TFMS site other than where you are using the TSD.

To select the reroute row, click the number of the reroute you want to delete and select **Delete Reroute** from the Functions menu. If you are deleting multiple reroutes, click the number of a reroute, use the <Ctrl> and <Shift> keys to select other reroutes, and select **Delete Reroute**. You can also drag the pointer over the row numbers to select them for deletion.

Selecting this menu item opens the Delete Confirmation dialog box.

- Click **Yes** to delete the reroute(s). For each reroute you have selected for deletion, you will see a confirmation message informing you that the reroute has been deleted.
- Click **No** to close the Delete Confirmation dialog box without deleting the reroute.
Cancel Reroute

The Cancel Reroute function allows you to cancel a public reroute and specify that all flights in the reroute, or only pre-departure flights, be cancelled.

The Cancel Reroute function is disabled unless exactly one Public reroute is selected and you are authorized to create and edit Public reroutes.

If you are authorized to create and edit Public reroutes, you access the Cancel Reroute option on the Functions menu of the Select Reroutes dialog box. Selecting this menu option after selecting a public reroute brings up the Cancel Reroute Advisory dialog box shown below.

**Note:** If you select any reroute with a domain of local, private, or shared, use the Delete Reroute option to delete the reroute. The option to cancel pre-departure flights only is available for public reroutes only.

Using the Cancel Reroute Advisory Dialog Box

The Cancel Reroute Advisory dialog box includes a Cancellation Criteria panel, an Advisory/Message Text window, and an Email Options panel.

The Cancellation Criteria panel allows you to specify whether you want to cancel all flights or only those that are not airborne. This panel also provides a View Cancellation List button. Clicking the **View Cancellation List** button opens the Cancellation Flight List dialog box. This box lists either all flights or only the pre-departure flights that are in the Reroute Dynamic Flight List for the reroute.
The Cancellation Flight List displays the ACID, Origin, and Destination for each flight.

![Cancellation Flight List](image)

The Advisory/Message Text panel on the Cancel Reroute Advisory dialog box displays the Advisory number, the site cancelling the reroute, the date on which it was cancelled, and the reroute's name. The current date/time and the end date/time for the reroute display in the format DDHHMM below the Associated Restrictions.

The following table explains the remaining items on the Cancel Reroute Advisory dialog box.

### Cancel Reroute Advisory

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What You Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancellation Criteria</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cancel Reroute for:</td>
<td>Allows you to specify whether you want to cancel all flights or only pre-departure flights in the selected public reroute.</td>
<td>To cancel all flights for the selected public reroute, click the <strong>All Flights</strong> radio button. To cancel only pre-departure flights, click the <strong>Not Airborne Flights</strong> radio button. If you select the Not Airborne Flights radio button the following text automatically displays in the Remarks text box, &quot;Reroute is cancelled only for flights that are not airborne as of &lt;current time HHMMZ&gt;&quot;.</td>
</tr>
<tr>
<td>View Cancellation List</td>
<td>Allows you to open a read-only list of the flights that will be cancelled based on your selection of All flights or Not Airborne Flights and the contents of the Reroute Dynamic Flight List.</td>
<td>To open the View Cancellation List window and view a read-only list of flights, click this button.</td>
</tr>
</tbody>
</table>
Cancel Reroute Advisory

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What You Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advisory/Message Text</td>
<td>Allows you to enter Remarks regarding the reroute cancellation. If you specify that you want to cancel the reroute for predeparture flights by selecting the Not Airborne Flights radio button in the Cancellation Criteria section, the TSD pre-fills the Remarks text box with an appropriate cancellation message. The pre-filled remarks text is editable.</td>
<td>Click in the Remarks text box to enter or edit remarks information.</td>
</tr>
<tr>
<td>Remarks</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Associated Restrictions</td>
<td>Allows you to enter information on any associated Restrictions</td>
<td>Click in the Associated Restrictions text box to enter or edit information on Restrictions associated with the advisory.</td>
</tr>
<tr>
<td>Message Type</td>
<td>Allows you to specify the message type as Advisory or General.</td>
<td>Click the appropriate radio button.</td>
</tr>
<tr>
<td>Address</td>
<td>Allows you to specify an address for the advisory</td>
<td>Click the arrow button to open a drop-down list of address options.</td>
</tr>
</tbody>
</table>

Sending the Advisory Cancellation

To send an advisory or message notifying recipients of the canceled reroute, click Send. Otherwise, click Cancel. If you selected the All Flights radio button in the Cancellation Criteria section, the TSD deletes the reroute and sends the Cancellation Advisory to the selected recipients. If you selected the Not Airborne Flights button, the TSD modifies the reroute so that it applies only to pre-departure flights and sends the Cancellation Advisory to the selected recipients.

Monitor Reroute(s)

The Monitor Reroute(s) option lets you view the Reroute Monitor for one or more active Public reroute sets. The Monitor Reroute(s) function is disabled if you have not selected a Public reroute row in the Select Reroute dialog box.

For more information on how to use the Reroute Monitor, see page 4-228 in this chapter.
**View Model**

The View Model option allows you to view model results, if available, for a selected reroute. This menu option opens the View Reroute dialog box in Model mode. If the model results for a reroute are updated or the reroute is modified or deleted by another user while you are viewing the reroute, the TSD displays a notification message informing you of the change. The View Model option is disabled if you have opened the Create/Edit Reroute dialog box.

For more information, see Modeling a Reroute on page 4-369 in the Reroute Impact Assessment section of Chapter 4.

**Model Reroute Cancellation**

The Model Reroute Cancellation option allows you to view, in Model mode, the impact on the NAS of cancelling a selected reroute. This option is used with Reroute Modeling and is available if the selected reroute is a single, active (not expired), required public reroute and you are authorized to create or edit public reroutes. Also, the selected reroute must have explicit reroute segments. That is, if the reroute has only non-explicit reroute segments, such as UPT, you cannot model the impact of cancelling it. The Model Reroute Cancellation option is disabled if you have opened the Create/Edit Reroute dialog box.

For detailed information on Model Reroute Cancellation, see Model Reroute Cancellation on page 4-381 in the Reroute Impact Assessment section of Chapter 4.

**Sort By**

The Sort by function lets you sort the list of reroutes by Name or End time.

Reroutes are sorted in the list first by Domain in this order: Public, Shared, Local, and Private. The Sort by menu item lets you sort by Name or End Time. You can change the sort order in two ways:

1. Pulling down the Functions menu and select **Sort by, Name**, or **End Time**.
   
   or

2. Clicking **Name** or **End** column headings on the Select Reroutes dialog box.
Monitor All Reroutes Command

The **Monitor All Reroutes** command lets you monitor the flights involved in public, shared and local reroutes and get periodic updates. You will be able to see which flights are affected by a reroute, which flights have filed flight plans that comply with the reroute, and which flights have not filed flight plans that comply with the reroute. Authorized users can also grant exceptions to an individual flight’s planned deviations from the specified reroute.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Reroute menu by clicking <strong>Reroute</strong> on the TSD Main Menu or pressing <code>&lt;Alt&gt;</code> R.</td>
<td>None</td>
</tr>
<tr>
<td>2. Click <strong>Monitor All Reroutes</strong> or press M.</td>
<td><strong>Semicolon Method</strong></td>
</tr>
<tr>
<td></td>
<td>None</td>
</tr>
</tbody>
</table>

**Note:** You can also access the Monitor All Reroutes command from the generic right-click menu. Without pre-selecting or selecting a flight or map item, right-click on the TSD display to open the generic right-click menu.
Reroute Monitor Dialog Box

After you click **Monitor All Reroutes** or press **M**, the Reroute Monitor dialog box opens. The title bar in the following Reroute Monitor dialog box contains the text “Relative Time Range.” Relative and Absolute Time Range are discussed in the Timeline section, beginning on page 4-234.

![Reroute Monitor Dialog Box](image)

### Reroute Monitor Functions

You can perform several functions using the Reroute Monitor.

- You can monitor one or more public, local or shared reroutes.

  **Note:** To monitor a local or shared reroute the Monitor Reroute option in the Characteristics panel of the Create/Edit Reroute dialog box must have been selected when the reroute was last saved. See Characteristics on page 4-311.

- You can hide or show the Timeline and Flight List. You can also shrink the dialog box to show only the Counts Panel and Time Panel.

- You can highlight an individual flight and view its assigned route.

- You can control which flights appear in the Flight List and on the TSD display by using the Filter option and/or the Timeline.

  - You can filter the flights by various criteria such as reroute status, domain, or advisory action. Click the **Select Filter** button to access the Reroute Flight Filters dialog box and define the criteria.

- You can set the timeline to Relative or Absolute Time Range selection. You can also choose which time is to be represented by the Timeline: Departure Time, Arrival Time, Entry Time for a specified Center, or FEA/FCA Entry Time. You select time intervals on the timeline using standard selection methods.
• You can control which columns are shown in the Reroute Monitor Flight List and define how the columns are sorted.
• You can show or hide reroute flights on the TSD display.
• You can highlight an individual flight and view its assigned route.
• You can approve or disapprove an exception by selecting a row and then using the right-click menu.
• You can submit route amendments for non-conforming flights.

Note: Filters will be turned ON if you select Filters and click OK or Apply in the Reroute Flight Filters dialog box. You can also use the Select Filters option on the Functions menu.

Many of the Reroute Monitor functions can be performed in more than one way. You can use a menu command as well as a push button command to do the same thing. For example, clicking on Select Filters on the Functions menu or clicking the Select Filters button in the Control Panel has the same effect of opening the Reroute Flight Filters dialog box.

**Reroute Monitor Dialog Box**

The Reroute Monitor dialog box contains three major sections.

1. **Control Panel**
   - Located near the top of the dialog box, the Control Panel has three subsections:
     - Counts Panel
     - Selection Panel
     - Time Panel

2. **Timeline**
   - This section of the Reroute Monitor is located under the Control Panel. You can use the Timeline to select a time range of flights shown in the Flight List and drawn on the TSD. The time range selection can be Relative or Absolute.

3. **Flight List**
   - The Flight List, located on the lower part of the dialog box, lists the flights involved with the reroute.
Control Panel
The three major sections of the Control Panel are discussed below.

Counts Panel
The Counts Panel, located on the left side of the Control Panel, displays the number of flights by conformance status. For explicit routes (routes for which no route type has been selected in the Create/Edit Reroute dialog box), TFMS determines a flight’s conformance status by checking the protected segment of its assigned route. The Counts panel appears as follows:

```
Non-Conformant:  0  Conformant:  24
Unknown:  43  OK:  1
Excluded:  0
```

The Counts Panel displays the following data:

- **Conformant:**
  Number of flights that meet either of the following conditions:
  - A reroute advisory requires the flight to follow the protected segment of an explicit route and the flight's current route from a flight plan or early intent message matches one of the assigned routes shown for the flight in the reroute advisory.
  - A reroute advisory requires the flight to avoid an FCA and provides no explicit route assignment and the flight's current route from a flight plan or early intent message bypasses the FCA.

- **Non-Conformant:**
  Number of flights that meet either of the following conditions:
  - A reroute advisory requires the flight to follow the protected segment of an explicit route and the flight's current route from a flight plan or early intent message does not match one of the assigned routes shown for the flight in the reroute advisory.
  - A reroute advisory requires the flight to avoid an FCA and provides no explicit route assignment and the flight's current route from a flight plan or early intent message intersects the FCA.

- **Unknown:**
  Number of flights with no flight plan filed or early intent message submitted. This count may include flights with an assigned route that has no protected segment defined or flights in a reroute that was issued using the option not to include protected segments.

- **OK:**
  Number of flights that were manually approved for an exception to remain on their current route after a reroute was issued.
• **Excluded:**
  Number of flights that were excluded from the reroute when it was issued.

**Note:** If a flight is in one or more monitored reroutes, the TSD counts the flight as non-conformant with at least one of its monitored reroutes. The TSD counts it as conformant if it is conformant with all of its monitored reroutes.

**Selection Panel**

The buttons located in the Selection Panel let you select the reroutes you want to display on the Reroute Monitor and to view and edit flight filters.

To display all monitorable reroutes, click the **All** radio button in the Monitor field of the Selection Panel. To open the Select Monitored Reroutes dialog box and select specific reroutes you want to display and monitor, click the **Select Reroutes** button. After you select individual reroutes and close the Select Monitored Reroutes dialog box, the Monitor field in the Selection Panel is toggled to **Selected**.

If you define filters in the Reroute Flight Filters dialog box, the Filters field of the Selection Panel is toggled **On**.

**Note:** If you hover over the Select Reroutes button, a tool tip displays containing a list of the reroutes selected for monitoring. If the All radio button is selected, all monitorable reroutes display in the tool tip.

If the Reroute flights are hidden, the Show/Hide Reroute Flights icon in the Selection Panel has a red X through it, as shown above. The Show New Flights checkbox lets you specify whether the TSD displays a check mark in the Show checkbox for new flights that are added to the Flight List after the Reroute Monitor is refreshed. The Show New Flights option is checked by default.

Click the **Protected Segments** checkbox to display the protected portion of any assigned route that is drawn using the Reroute Monitor Show function. The TSD highlights protected segments on the display in a slate blue color. The Protected Segments checkbox is unchecked by default.

Click the **Show Navaids** and Show Reroute checkboxes to display the navaids and reroutes for selected flights. The color button lets you select the color of the flight icons, reroutes, and navaids.

**Note:** To toggle the display of flights on and off, you can use the “=” quick key.
Time Panel

The Time Panel segment of the Control Panel displays the current time. It also indicates whether updates to the Reroute Monitor are being held or whether the window is being updated. The example below shows that updates are being updated. Click **Hold Updates** to hold the Reroute Monitor updates.

![Current Time: 1723, Last Update: 1721, Hold Updates]

The Time Panel below shows that updates are being held. Click **Resume Updates** to resume the Reroute Monitor updates.

![Current Time: 1723, Held At: 1721, Resume Updates]

**Note:** This function is also available through the Hold/Resume Updates command on the Functions menu.

Reroute Monitor Timeline

The Timeline section of the Reroute Monitor displays flight counts in quarter-hour time periods. You can use the Timeline to display a time range of flights shown in the Flight List and drawn on the TSD. The summary counts reflect the counts within the selected intervals in the Reroute Monitor timeline, rather than the entire time period of the reroute.

The Timeline is in quarter-hour intervals. In each time interval the Timeline displays a count of the number of flights in the interval whose reroute status is either non-conformant or unknown. This count is followed by a slash (/) and a count of the number of flights whose reroute status is conformant, OK, or Excluded. In other words, the counts on the left of the / represent Non-Conformant or Unknown status; the counts on the right of the / represent Conformant, OK, or Excluded status.

If the time range is Relative, as in the example above, a left carat (<) is displayed at the beginning of the segment. This segment contains a count of flights that are in one of the monitored reroutes that would not otherwise be counted in one of the other time intervals. Relative and Absolute time ranges are explained in the following pages.
Relative and Absolute Time Range

An option on the Reroute Monitor View menu lets you select Relative or Absolute Time Range.

Relative Time Range

If you select Relative Time Range from the View menu, the TSD keeps the same block of cells highlighted, even though the times associated with those cells have shifted to the next 15-minute time segment. In other words, the Relative option lets you highlight/examine a range of time relative to the current time. When the Relative Time Range is selected, there is a prior to current time segment on the left end of the timeline, identified by the < sign.

In the example above, the current time is 1415, and the 1415, 1430, 1445, and 1500 time segments are selected. When the current time becomes 1430, the 1430, 1445, 1500, and 1515 segments become selected. In both cases, the relative time range is the current time plus 45 minutes.
If Arrival Time is selected in the “Assign to Time Segments” section of the Reroute Monitor, the prior to current time segment is not available since it would apply to flights that had already landed.

**Absolute Time Range**

If you select Absolute Time Range on the View menu of the Reroute Monitor, the TSD shifts all cell highlighting one cell to the left as the current time advances. If, for example, you choose to highlight/examine fixed clock times such as 1600 to 1700, when the current time becomes 1615, the 1615, 1630, and 1645 segments remain highlighted and the 1600 segment is dropped from the Timeline. In other words, the time range is now 45 minutes rather than the original 60 minutes. At 1645, only the 1645 segment remains highlighted. At 1700, the 1700 segment becomes selected, ensuring that there is always at least one time segment selected.

If the Timeline is in the Absolute Time Range mode the prior to current time segment is not shown for any of the “Assign to Time Segments” options.

**Assign to Time Segments**

The Assign to Time Segments section allows you to select the time that is represented by the Timeline: Departure Time, Arrival Time, FEA/FCA Entry, or Center Entry. The default setting is Departure Time. Click the radio button for the time you want to represent in the timeline. If you select Center Entry, click the Center arrow button to specify the Center. For information on how this setting affects the Reroute Monitor Flight List, see the Reroute Monitor Flight List on page 4-236.

**Note:** The Assign to Time Segments by FEA/FCA Entry option is not available in Monitor All mode if any of the monitored reroutes are not based on an FEA/FCA.
Reroute Monitor Flight List

The Flight List section of the Reroute Monitor displays data for each flight that is included in at least one of the monitored reroutes, that satisfies any filter conditions that may have been specified, and that has been assigned to a time segment in the timeline.

For a given monitored reroute, a flight might have more than one assigned route. The airline may review the options and choose which route to fly. If the Flight List has been set to display assigned routes through the Customize Columns function, the Flight List will display more than one assigned reroute for such flights.

To indicate that a flight is in more than one reroute, the Flight List displays the ACID for that flight in blue. Each of the flight's monitored reroutes displays on a separate line. The conformance status of the flight for each of its monitored reroutes displays on its respective line if the Flight List has been set to display reroute status (RRSTAT) through the Customize Columns function. If the Flight List is filtered to show Non-Conformant (NC) flights only, the Reroute Monitor displays the flight and all of its monitored reroutes if it is NC in at least one of them. A flight is considered conformant only if it is conformant in all of its monitored reroutes.

In the following example, the Reroute Monitor Flight List indicates that flight AAL133 is in two monitored reroutes and that it has a conformance status of Unknown in one and Conformant in the other. In this instance, the flight is not considered conformant because it is conformant in only one reroute.

After you specify how you want flight counts to be displayed in the Timeline, the columns in the Flight List are updated to reflect your selection. With Departure Time as the default selection, the Flight List automatically displays the ETD column. You can also add Arrival Time (ETA), Center Entry (C Entry), and FEA/FCA Entry by selecting those buttons. These columns are added only if they are not already displayed. To remove columns, use the Customize Columns function.

Note: The first three columns of the Flight List - Show, ADZ, and ACID - are fixed in the positions shown and cannot be removed.
The columns available for display in the Reroute Monitor Flight List are described in Customize Columns (Reroute Monitor) on page 4-251.

When you add the columns, they are displayed to the right of the ACID column. The added columns are not removed if you subsequently choose another option. As you can see in the sample above, adding the C Entry column does not cause the Departure Time and Arrival Time columns to be removed from the Flight List.

To add the FCA ENTRY column, select the **FEA/FCA Entry** button in the **Assign to Time Segments by** panel. The FEA/FCA Entry time option is not available if any of the monitored reroutes are not based on an FEA/FCA.

**Note:** To view a pop up tool tip displaying the Advisory number (or three dashes if there is no number) and the names of a flight's monitored reroutes, browse over the ACID of the flight.

### Route Prefixes

The route prefix that displays on the Reroute Monitor Flight List for an assigned route depends on the reroute's advisory action and segment type. The Assigned Route column displays route prefixes as follows:

<table>
<thead>
<tr>
<th>Route Segment Type</th>
<th>RQD</th>
<th>RMD</th>
<th>PLN</th>
<th>FYI</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Type</td>
<td>Required</td>
<td>Recommended</td>
<td>Planned</td>
<td>Information</td>
</tr>
<tr>
<td></td>
<td>RQD:</td>
<td>RMD:</td>
<td>PLN</td>
<td>FYI</td>
</tr>
<tr>
<td>UPT RTE</td>
<td>RQD UPT RTE</td>
<td>RMD UPT RTE</td>
<td>PLN UPT RTE</td>
<td>FYI UPT RTE</td>
</tr>
<tr>
<td>CDR RTE</td>
<td>RQD CDR RTE</td>
<td>RMD CDR RTE</td>
<td>PLN CDR RTE</td>
<td>FYI CDR RTE</td>
</tr>
<tr>
<td>RERTE</td>
<td>RQD RERTE</td>
<td>RMD RERTE</td>
<td>PLN RERTE</td>
<td>FYI RERTE</td>
</tr>
<tr>
<td>UNKN RTE</td>
<td>RQD UNKN RTE</td>
<td>RMD UNKN RTE</td>
<td>PLN UNKN RTE</td>
<td>FYI UNKN RTE</td>
</tr>
</tbody>
</table>
Viewing Assigned Routes for Individual Flights

You can view assigned routes for individual flights on the TSD map. If the reroute is being shown, the TSD highlights the assigned route for individual flights when those flights are browsed (highlighted). The flight icons and their assigned route(s) are both highlighted.

To see an individual flight, click on the **Show** column header to deselect the Show checkboxes for all flights. Click **Show** to the left of the flight you want to monitor.

**Note:** Both the Show airplane icon and the Show Reroutes checkbox need to be selected.

The entire reroute is displayed on the map. Browsing the flight icon for AAL160, which was the selected flight in this case, highlights the assigned route for the specified flight.

If you select Hide Reroutes on the Reroute menu, the highlighted reroute segment for the specified flight remains displayed while the rest of the reroute is hidden.

Highlighting a Single Flight

You can highlight a single flight while continuing to draw other flights. To do this,

1. Select the flight’s row in the Reroute Monitor flight list.
   You can do this by clicking on the **ACID** field for the flight.

2. If needed, click the **Show Flights** (airplane) icon to show the flight.
   You can also select Show Flights on the Reroute Monitor View menu to show the flight.
The sample TSD window below shows a highlighted single flight. Both the current route and the selected assigned route(s) are shown for the flight, even if these features are not toggled on for other drawn flights.

Note: The selected flight, active or inactive, is drawn on the TSD even if the Show button on the Reroute Monitor Flight list has not been checked for that flight.
Monitoring a Single Reroute in Reroute Monitor

When you monitor a single reroute in the Reroute Monitor, the name of the reroute is shown on the title bar. To display the flight icon, click the flight icon to the left of the New Flights checkbox, in the Showselections panel of the Reroute Monitor.

Click the Select Reroutes button on the Selection panel to display the Select Monitored Reroutes dialog box. Click in the checkbox corresponding to the reroute and click OK. The name of the reroute is displayed on the title bar of the Reroute Monitor, and only that reroute is displayed in the Flight List. Select a route segment with its flight from that list to be displayed on the TSD. On the Selection Panel, change the color to delineate this reroute segment from the rest of the reroute.

**Note:** You can match the ADZ number of the route listed in the Select Reroutes dialog box with the ADZ number in the Reroute Monitor dialog box to display the appropriate reroute.

**Viewing Protected Segments for Assigned Routes**

You can view the protected portion of an assigned route on the TSD display if the assigned route for the flight is drawn using the Reroute Monitor Show function and the Protected Segments checkbox in the Selection Panel is checked. The system highlights the protected portion of each assigned route by coloring it a slate blue color. The protected portion is drawn using the same line style as the non-protected portion. The following example shows the protected portion of a flight's assigned route highlighted in blue. The flight is currently flying along the non-protected portion of the route.

**Note:** You define the protected segments for a reroute on the Reroute Definition tab of the Create or Edit Reroute dialog box. To enable drawing of protected segments, the Protected Segments checkbox in the Display Reroute section of the Reroute Definition tab must be checked.
Reroute Monitor Menus

Three menus are available in the top section of the dialog box: File, Functions, and View.

File Menu

The File menu lets you print a Reroute Monitor Flight List; adapt (save, recall, or delete) a Reroute Monitor adaptation file; or close the Reroute Monitor dialog box.

Print

The Print command lets you print a Reroute Monitor Flight List. After you click Print, the Print Reroute Monitor Flight List dialog box opens.

Adapt

The Adapt command lets you recall a previously saved reroute monitor adaptation file, save a reroute monitor adaptation file, or delete a previously saved reroute monitor adaptation file. This command also lets you save the states of the Show New Flights command and the Absolute/Relative Time Range selection. When you save or recall an adaptation file you can change the defaults to the settings defined in this file. The Save, Recall, and Delete options work exactly the same way as they do on the Adapt menu option on the TSD Display menu.

The Recall As Defaults command allows you to recall the settings that you had previously saved to an adaptation file and change the default settings for subsequent Reroute Monitors to the recalled settings.

The Save As Defaults command saves the current settings to an adaptation file. Additionally this option makes the current settings the default settings for the Reroute Monitors that you subsequently invoke in your current TSD session. Each time you open the Reroute Monitor during your TSD session, the current settings will be the default settings for these Reroute Monitors.
Save and Recall Reroute Monitor Settings

When you save an adaptation file for the Reroute Monitor, the following settings will be saved.

- State of the Show/Hide Timeline toggle
- State of the Show/Hide Flight List toggle
- State of the Draw/Hide Flights toggle
- Range of selected cells in the Timeline
- State of the Assign to Time Segments setting
- Center name for the Center Entry Time option (if selected)
- Names of the Data Columns displayed in the Flight List
- Order in which the data columns are displayed from left to right
- Width of each displayed data column
- State of the Show Current/Assigned/Both Route radio buttons
- State of the Full/Truncate Route radio buttons
- State of the Filters On/Off radio button
- All filter settings
- Primary, secondary, and tertiary sort specification, including whether each sort is in ascending or descending order
- Color for drawn flights
- State of the Show Reroute checkbox
- State of the Navaids checkbox
- State of the Show New Flights checkbox
- State of the Absolute/Relative Timeline toggle
- State of the Protected Segments checkbox

Close

Clicking **Close** on the File Menu closes the Reroute Monitor dialog box.
Functions Menu
The Functions menu on the Reroute Monitor dialog box contains the following options:

- Select Reroutes
- Select Filters
- Customize Columns
- Advanced Sort
- Hold/Resume Updates
- Approve Exception
- Revoke Exception.
- General Amendment

*Note:* By right-clicking a flight's ACID in the Reroute Monitor Flight List, you can access a right-click menu containing the options Approve Exception, Revoke Exception, and Generate Amendment.

Select Reroutes
The Select Reroutes option on the Functions menu of the Reroute Monitor opens the Select Monitored Reroutes dialog box. The dialog box displays a list of reroutes that can be monitored, as shown below. To display a list of selected reroutes, in the Select Monitored Reroutes dialog box, click in the checkbox to the left of the Advisory number. The Reroute Monitor lists only the reroutes you selected.

![Select Monitored Reroutes](image)

*Note:* You can also open this dialog box by clicking the Select Reroutes button on the Control Panel.

If a new monitorable reroute is created while a Reroute Monitor window is open, the default state for that reroute is unselected.
Select Filters

Selecting **Select Filters** on the Functions menu opens the Reroute Flight Filters dialog box, shown below.

**Note:** Clicking the **Select Filters** button on the Control Panel also opens the Reroute Flight Filters dialog box.

The Reroute Flight Filters dialog box is similar to the Create FEA/FCA Primary Filter tab and the Secondary Filter dialog box except for the Advanced Filters button, which provides additional filter options. The abbreviated version of the Reroute Flight Filters dialog box has the options that are most often used. However, if you want to specify one of the Advanced Filters options, click the **Advanced Filters** button to expand the Reroute Flight Filters dialog box.

**Note:** If you define filters in the Reroute Flight Filters dialog box, the Filters field in the Selection Panel on the Reroute Monitor is toggled On.
Filtering on Non-Conformant

You can filter on Non-Conformant in a specified Center.

To do so,

1. Leave Non-Conformant checked and uncheck all other Reroute Status options.
2. Click the arrow to the right of the Non-Conformant checkbox and select the appropriate Center from the drop-down list.

The following sample shows a flight list filtered by Non-Conformant flights.
Advanced Filters

The expanded dialog box has all available filter options, including the ones on the abbreviated version of the Reroute flight Filters dialog box. Clicking the **Advanced Filters** button on the Reroute Flight Filters dialog box displays additional filter fields, as shown below.

![Reroute Flight Filters Dialog Box](image)

**Note:** If you specify advanced filter options, this expanded version of the Reroute Flight Filters dialog box will open when you issue the Select Filters command.
The following table describes the fields in the expanded Reroute Flight Filters dialog box.

**Reroute Flight Filters**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reroute Status</td>
<td>Limits the selection to reroute conformance status - Conformant, Non-Conformant, OK, Unknown, or Excluded.</td>
</tr>
<tr>
<td>Note:</td>
<td>If the Reroute Monitor Flight List is filtered to show Non-Conformant (NC) flights only and a flight is in more than one monitored reroute, the Reroute Monitor displays the flight and all of its reroutes if it is NC in at least one of them. A flight is considered conformant only if it is conformant in all of its monitored reroutes.</td>
</tr>
<tr>
<td>Domain</td>
<td>Limits the selection to flights in monitored reroutes that are available to the TFMS site and that meet the domain criteria of Public, Shared, or Local. All Domain checkboxes are checked by default. Note that if Public is selected, all Advisory Action checkboxes are automatically checked. If Public is deselected, all Advisory Action checkboxes are automatically unchecked. If Shared or Local are selected, the Reroute Monitor includes any Shared or Local reroutes that are available at the site if a reroute dynamic list was generated for the reroute. The TSD generates a reroute dynamic list for a local or shared reroute only if the Monitor Reroute checkbox on the Create or Edit dialog box was checked when the reroute was last saved.</td>
</tr>
<tr>
<td>Advisory Action</td>
<td>Limits the selection to flights that have an advisory action of RQD, RMD, PLN, or FYI.</td>
</tr>
<tr>
<td>Assigned Route Type</td>
<td>Limits the selection to assigned route type - Explicit, UPT (User-Preferred Trajectory), CDR (Code Departure Route), RERTE, UNKN. Note: An Explicit route is one for which no route type has been selected in the Create Reroute dialog box.</td>
</tr>
<tr>
<td>Departs from any of/Departs from none of/</td>
<td>Limits the selection to flights that depart from any or none of the listed airports or an airport in the listed ARTCC(s). The &quot;City Pairs any of&quot; option lets you specify up to 20 city pairs. This option is discussed more fully on the following page.</td>
</tr>
<tr>
<td>City Pairs any of</td>
<td></td>
</tr>
<tr>
<td>Arrives at any of/Arrives at none of/</td>
<td>Limits the selection to flights that arrive at any of or none of the listed airports or an airport within the listed ARTCC(s). City Pairs any of&quot; lets you specify up to 20 city pairs. This option is discussed more fully on the following page.</td>
</tr>
<tr>
<td>City Pairs any of</td>
<td></td>
</tr>
<tr>
<td>Traverses any of/Traverses none of/Traverses all of</td>
<td>Limits the selection to flights that traverse any, all, or none of the listed sectors, fixes, or ARTCCs.</td>
</tr>
<tr>
<td>Uses any of these airways/Uses none of these airways/Uses all of these airways</td>
<td>Limits the selection to flights that use any, all, or none of the listed airways.</td>
</tr>
</tbody>
</table>
### Reroute Flight Filters (Continued)

<table>
<thead>
<tr>
<th>Filter Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Located in any of/ Located in none of</td>
<td>Limits the selection to flights that are, or are not, currently located in the specified sectors or ARTCCs.</td>
</tr>
<tr>
<td>Aircraft type any of/ Aircraft type none of</td>
<td>Limits the selection to flights that are, or are not, of specific aircraft types.</td>
</tr>
<tr>
<td>Any of these remarks/ None of these remarks/ All of these remarks</td>
<td>Limits the selection to flights with any, all, or none of the specified remarks keywords.</td>
</tr>
<tr>
<td>ACID begins with any of/ ACID begins with none of/ ACID is any of/ ACID is none of</td>
<td>For the first two options, limits the flight list to flights with aircraft IDs (Stripped ACID) that begin, or do not begin with, the characters specified by each entry. For the last two options, limits the flights with aircraft IDs (Unstripped ACID with leading zeros) that exactly match, or do not match, the characters specified by each entry.</td>
</tr>
<tr>
<td>Aircraft category any of</td>
<td>Limits the selection to flights that have an aircraft category that matches one of the selected categories. The default is all categories selected, indicating that no filtering is required.</td>
</tr>
<tr>
<td>Weight class any of</td>
<td>Limits the selection to flights that have a weight class that matches one of the listed categories. The default is all categories selected, indicating that no filtering is required.</td>
</tr>
<tr>
<td>User category any of</td>
<td>Limits the selection to flights that have a user category that matches one of the listed categories. The default is all categories selected, indicating that no filtering is required.</td>
</tr>
<tr>
<td>RVSM status</td>
<td>Limits the selection to all flights, flights that are RVSM conformant, or flights that are RVSM non-conformant.</td>
</tr>
</tbody>
</table>
| Flight Status | Clicking on the arrow displays three choices: All, Active, or Proposed.  
- If **Proposed** is selected, limits the selections to flights that are not yet airborne, which includes those that have a status of Scheduled, Filed, Airline Created, or Controlled.  
- If **Active** is selected, limits the selection to airborne flights.  
- **All** indicates that no filtering is required. **All** is the default. |
| Reset | Resets the filter fields to their defaults. |
| Filter Summary | Displays a read-only version of the filter as it is constructed. |
City Pair Option

Both the abbreviated and advanced filters versions of the Reroute Flight Filters dialog box include a City Pair option for the Departure and Arrival filter fields. The sample below shows the options for the Departure filter fields. To return to the default dialog box, click on the City Pairs arrow and select **Departs/Arrives** filters.
When you select the City Pairs any of option from either the Departure or Arrival filter fields, the Reroute Flight Filters dialog box changes to display origin and destination fields. The origin and destination fields let you specify up to 20 city pairs as shown below. You can view additional fields by moving the horizontal scroll bar to the right. The Reroute Monitor displays only those flights that depart from and arrive at the city pairs shown in the Reroute Flight Filters dialog box.
Customize Columns (Reroute Monitor)

The Customize Columns option on the Functions menu of the Reroute Monitor dialog box lets you add and remove columns from the Reroute Monitor Flight List. After you select Customize Columns on the Functions menu, the Customize Columns for Reroute Monitor dialog box opens.

The Selected Columns field shows the columns that are currently displayed on the Reroute Monitor Flight List. The Available Columns field shows the columns that can be added to the Reroute Monitor Flight List.

To Customize Columns:

1. To move a column name out of the Selected Columns, click on the column name and then click the << Remove button. The column name appears in the Available Columns list.

2. Click OK. You are returned to the Reroute Monitor. Notice that the column is no longer displayed in the Reroute Monitor Flight List.

3. To return the column to the Reroute Monitor Flight List, select Customize Columns again and select the name in the Available List column, click the Add >> button and then OK. You are returned to the Reroute Monitor, and the column is re-displayed.
4. To move the selected column names up and down within the list of Selected Columns, select the name and then click **Move Up** or **Move Down**. The order in which they appear in Selected Columns is the order, from left to right, in which they appear on the Reroute Monitor Flight List.

5. Click **OK** to move the column header to the left if you selected Move Up, or to the right if you selected Move Down.

**Note:** The columns Show, ADZ, and ACID are fixed columns and cannot be added, moved, or removed from the Reroute Monitor Flight List.
The following table includes the column names available in the Customize Columns option, the column headers that display on the Reroute Monitor Flight List, and a description of each column.

### Customize Columns for Reroute Monitor

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Flight List Header</th>
<th>Column Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADCUS Remark</td>
<td>ADC</td>
<td>Advise Customs about this flight. Displays a Y if the remark exists for a flight, or “-” if there is none.</td>
</tr>
<tr>
<td>ALTRV Remark</td>
<td>ATV</td>
<td>Altitude Reservation. Displays a Y if the remark exists for a flight, or “-” if there is none.</td>
</tr>
<tr>
<td>Advisory Action</td>
<td>ACTION</td>
<td>Action associated with the advisory that applies to the flight. This can be any of the action values assigned when the advisory is issued, such as RQD, RMD, or FYI.</td>
</tr>
<tr>
<td>Aircraft Category</td>
<td>CAT</td>
<td>Aircraft Category code. Possible values are J, P, and T.</td>
</tr>
<tr>
<td>Aircraft Type and Equipment</td>
<td>TYPE</td>
<td>Aircraft Type and Equipment.</td>
</tr>
<tr>
<td>Amendment Status</td>
<td>AMDT STATUS</td>
<td>The status of a flight's submitted route amendment. Possible values are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>SENT</strong> - A route amendment was submitted to ERAM but no response has been received. This status is displayed as soon as the amendment has been sent.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>SENT</strong> (with strikethrough) - Timeout: a configurable period has elapsed since a route amendment was submitted to ERAM but no response has been received.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>ACPT</strong> - A route amendment was submitted to ERAM and accepted.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>RJCT</strong> - A route amendment was submitted to ERAM and rejected.</td>
</tr>
<tr>
<td>Note:</td>
<td></td>
<td>A dashed line (“---”) displays if no amendment message was submitted for a flight or if an amendment cancellation message was sent and successfully processed and no new amendment has been submitted.</td>
</tr>
<tr>
<td>Arrival Center</td>
<td>ACENTR</td>
<td>Arrival Center.</td>
</tr>
<tr>
<td>Arrival Fix</td>
<td>AFIX</td>
<td>Arrival Fix.</td>
</tr>
<tr>
<td>Arrival Time</td>
<td>ETA</td>
<td>TFMS estimate of wheels-down time.</td>
</tr>
</tbody>
</table>
## Customize Columns for Reroute Monitor (Continued)

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Flight List Header</th>
<th>Column Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CATIII Remark</td>
<td>III</td>
<td>Flight has CATIII landing equipment. Displays a Y if the remark exists for a flight, or “-” if there is none.</td>
</tr>
<tr>
<td>Center Entry Time</td>
<td>C ENTRY</td>
<td>If Center Entry Time option is selected on timeline, then this is the time when the flight enters the specified center.</td>
</tr>
<tr>
<td>Centers Traversed</td>
<td>CENTRS</td>
<td>Space separated list of centers that the flight traverses.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The Center name displays in red if the center can move the flight onto its assigned route.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The name displays in black if the center will be traversed by the flight but will not be able to or will not need to move the flight onto its assigned route.</td>
</tr>
<tr>
<td>Control Element</td>
<td>CTL ELEM</td>
<td>Name of the airport or FCA that is controlling the flight or a “-” if the flight is not controlled.</td>
</tr>
<tr>
<td>Controlled Time of Departure</td>
<td>CTD</td>
<td>Controlled Departure Time, or “-” if none.</td>
</tr>
<tr>
<td>Current Altitude</td>
<td>CALT</td>
<td>Current altitude in hundreds of feet.</td>
</tr>
<tr>
<td>Current ARTCC</td>
<td>ARTCC</td>
<td>ARTCC where flight is currently located or departure ARTCC for inactive flights.</td>
</tr>
<tr>
<td>DVRSN Remark</td>
<td>DVT</td>
<td>Diversion recovery leg. Displays a Y if the remark exists for a flight, or “-” if there is none.</td>
</tr>
<tr>
<td>Departure Center</td>
<td>DCENTR</td>
<td>Departure Center.</td>
</tr>
<tr>
<td>Departure Fix</td>
<td>DFIX</td>
<td>Departure Fix.</td>
</tr>
</tbody>
</table>
Departure Time  | ETD  | TFMS estimate of wheels-up time. The ETD prefix indicates both the status of a flight and the source of data for a flight as follows:

- **A** - Actual departure time, usually based on a NAS departure message.
- **E** - Estimated Actual departure time. No departure message was received, but the flight is known to be airborne because NAS messages indicating this have been received.
- **T** - Flight is off the gate and may be taxiing. A gate departure time has been received.
- **P** - P-time from the NAS flight plan message.
- **N** - P-time from the airline-provided early intent message.
- **S** - Departure time estimated from the Official Airline Guide scheduled time.
- **R** - The historical route has been replaced by the assigned route.

**Note:** If you place the pointer over a cell in the ETD column of the flight list, a tool tip displays that defines the ETD value in the cell.

<table>
<thead>
<tr>
<th>Destination</th>
<th>DEST</th>
<th>Arrival Airport.</th>
</tr>
</thead>
<tbody>
<tr>
<td>FCA Remark</td>
<td>FCA</td>
<td>Flight has been rerouted around a Flow Constrained Area. Displays a <strong>Y</strong> if the remark exists for a flight, or “-” if there is none.</td>
</tr>
<tr>
<td>FEA/FCA Entry Time</td>
<td>FCA ENTRY</td>
<td>Time when the flight is predicted to first intersect the FEA/FCA, if the reroute that applies to the flight is an FEA/FCA-based reroute. Otherwise “-.”</td>
</tr>
<tr>
<td>FEA/FCA Exit Time</td>
<td>FCA EXIT</td>
<td>Time when the flight is predicted to exit the FEA/FCA for the last time if the reroute that applies to the flight is an FEA/FCA-based reroute. Otherwise “-.”</td>
</tr>
<tr>
<td>FEA/FCA Name</td>
<td>FEA/FCA Name</td>
<td>FEA/FCA name, if the reroute that applies to the flight is an FEA/FCA-based reroute. Otherwise “-.” The FCA name is displayed in parentheses if the flight was originally in the FCA but has since dropped out.</td>
</tr>
<tr>
<td>Filed Speed</td>
<td>SPD</td>
<td>Filed speed.</td>
</tr>
</tbody>
</table>

**Customize Columns for Reroute Monitor (Continued)**

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Flight List Header</th>
<th>Column Description</th>
</tr>
</thead>
</table>
| Departure Time    | ETD                | TFMS estimate of wheels-up time. The ETD prefix indicates both the status of a flight and the source of data for a flight as follows:
|                   |                    | - **A** - Actual departure time, usually based on a NAS departure message. |
|                   |                    | - **E** - Estimated Actual departure time. No departure message was received, but the flight is known to be airborne because NAS messages indicating this have been received. |
|                   |                    | - **T** - Flight is off the gate and may be taxiing. A gate departure time has been received. |
|                   |                    | - **P** - P-time from the NAS flight plan message. |
|                   |                    | - **N** - P-time from the airline-provided early intent message. |
|                   |                    | - **S** - Departure time estimated from the Official Airline Guide scheduled time. |
|                   |                    | - **R** - The historical route has been replaced by the assigned route. |
|                   |                    | **Note:** If you place the pointer over a cell in the ETD column of the flight list, a tool tip displays that defines the ETD value in the cell. |
| Destination       | DEST               | Arrival Airport. |
| FCA Remark        | FCA                | Flight has been rerouted around a Flow Constrained Area. Displays a **Y** if the remark exists for a flight, or “-” if there is none. |
| FEA/FCA Entry Time| FCA ENTRY          | Time when the flight is predicted to first intersect the FEA/FCA, if the reroute that applies to the flight is an FEA/FCA-based reroute. Otherwise “-.” |
| FEA/FCA Exit Time | FCA EXIT           | Time when the flight is predicted to exit the FEA/FCA for the last time if the reroute that applies to the flight is an FEA/FCA-based reroute. Otherwise “-.” |
| FEA/FCA Name      | FEA/FCA Name       | FEA/FCA name, if the reroute that applies to the flight is an FEA/FCA-based reroute. Otherwise “-.” The FCA name is displayed in parentheses if the flight was originally in the FCA but has since dropped out. |
| Filed Speed       | SPD                | Filed speed. |
### Customize Columns for Reroute Monitor (Continued)

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Flight List Header</th>
<th>Column Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flight Status</td>
<td>FSTAT</td>
<td>Both the status of a flight and the source of data for a flight as follows:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>S - Scheduled.</strong> TFMS has received no flight plan. Data is based on the OAG and/or user-provided schedule updates. The route is based on historical data.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>N - Early Intent.</strong> TFMS has received a user-provided early intent route.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>P - Proposed.</strong> TFMS has received a NAS flight plan.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>T - Taxi.</strong> TFMS has received a message indicating the flight has pushed off the gate and may be taxiing.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>A - Active.</strong> TFMS has received a NAS or user-provided departure message.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>E - Estimated.</strong> TFMS has received a message indicating the flight was active, but no departure message was received.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>R - Replaced</strong> The historical route has been replaced by the assigned route.</td>
</tr>
<tr>
<td>GUFI</td>
<td>GUFI</td>
<td>Global Unique Flight Plan Indentifier</td>
</tr>
<tr>
<td>HAR Remark</td>
<td>HAR</td>
<td>High-Altitude Airspace Redesign. Displays a <strong>Y</strong> if the remark exists for a flight, or “-” if there is none.</td>
</tr>
<tr>
<td>ICR Remark</td>
<td>ICR</td>
<td>Integrated Collaborative Rerouting. Displays a <strong>Y</strong> if the remark exists for a flight, or “-” if there is none.</td>
</tr>
<tr>
<td>LIFEGUARD Remark</td>
<td>LFG</td>
<td>Lifeguard or MEDEVAC. Displays a <strong>Y</strong> if the remark exists for a flight, or “-” if there is none.</td>
</tr>
<tr>
<td>NRP Remark</td>
<td>NRP</td>
<td>National Route Program flight. Displays a <strong>Y</strong> if the remark exists for a flight, or “-” if there is none.</td>
</tr>
<tr>
<td>Origin</td>
<td>ORIG</td>
<td>Departure Airport.</td>
</tr>
<tr>
<td>Proposed Gate</td>
<td>P-Time</td>
<td>Flight plan P-Time.</td>
</tr>
<tr>
<td>Time of Departure</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PTP Remark</td>
<td>PTP</td>
<td>Point to Point. Displays a <strong>Y</strong> if the remark exists for a flight, or “-” if there is none.</td>
</tr>
<tr>
<td>RR Remark</td>
<td>RR</td>
<td>Reroute. Displays a <strong>Y</strong> if the remark exists for a flight, or “-” if there is none.</td>
</tr>
</tbody>
</table>
### Customize Columns for Reroute Monitor (Continued)

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Flight List Header</th>
<th>Column Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requested Altitude</td>
<td>ALT</td>
<td>Requested altitude in hundreds of feet.</td>
</tr>
<tr>
<td>Reroute Name</td>
<td>REROUTE</td>
<td>Name of the reroute that applies to the flight.</td>
</tr>
<tr>
<td>Reroute Status</td>
<td>RRSTAT</td>
<td>Reroute conformance status</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• C = Conformant</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• NC = Non-Conformant,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• NC/OK = Non-Conformant but previously OK</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• UNKN = Unknown,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• OK = Exception Granted</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• EXC = Excluded</td>
</tr>
<tr>
<td>Routes</td>
<td>CURRENT ROUTE / REROUTE(S)</td>
<td>Current and assigned routes. If several route options have been assigned, they will all be listed. The route prefix that displays for an assigned route is based on the reroute's advisory action and segment type.</td>
</tr>
<tr>
<td>RVSM Status</td>
<td>RVSM</td>
<td>RVSM conformance status.</td>
</tr>
<tr>
<td>SWAP Remark</td>
<td>SWP</td>
<td>Swapping flight from a standard to a nonstandard route. Displays a Y if the remark exists for a flight, or “-” if there is none.</td>
</tr>
<tr>
<td>Time to Intersect</td>
<td>TIME TO</td>
<td>Time to intersect the FCA, if the reroute that applies to the flight is an FCA-based reroute. Otherwise “-”. The value shall be '00:00' if the flight has already intersected the FCA.</td>
</tr>
<tr>
<td>TMI ID</td>
<td>TMI ID</td>
<td>Trafic Management Initiative ID. The TSD determines the TMI ID associated with each assigned route from the reroute definition. The TMI ID for a reroute consists of the following three elements: the letters &quot;RR&quot;, a three character facility ID of the facility where the reroute was created, and the advisory number if an advisory was issued for the reroute; otherwise a unique 3-digit sequence number. For example, RRDCC345.</td>
</tr>
<tr>
<td>WXRTE Remark</td>
<td>WXR</td>
<td>Severe weather reroute. Displays a Y if the remark exists for a flight, or “-” if there is none.</td>
</tr>
</tbody>
</table>
Customize Route Column

The Show buttons in the Customize Route Column section of the Customize Columns for Reroute Monitor dialog box, lets you show the current route, the assigned route(s), or both in the Current Route/Reroute(s) column on the Reroute Monitor window. You also have the option of showing the full route or the truncated* route in the Current Route/Reroute(s) column.

*The word “truncated” in this case means not word-wrapped.

**Note:** When Truncated Route is selected, you can see the Full Route by moving the mouse pointer over the current route. A tool tip shows the full route without word wrapping. If you select Full Route on the Customize Columns dialog box, moving the pointer over the route has no effect.

Centers Traversed Column

The Centers Traversed column in the Reroute Monitor Flight List shows the Center name in red if the flight will be non-conformant while it is in the Center and if the Center can move the flight onto its assigned route. Center names that are listed in black are Centers that will be traversed by the flight, but the flight will either be conformant in those Centers or those Centers will not be able to or need to move the flight onto its assigned route. This condition will exist if the flight has already traversed the Center or if the flight will be on the assigned route when it is within control of the Center.

In the sample below, the CENTRS column displays several reroutes showing centers displayed in red, indicating that those centers can move the corresponding flights onto their assigned routes.
Show Buttons

The **Show** buttons in the Customize Route Column section of the Customize Columns for Reroute Monitor dialog box, shown on the preceding page, let you show the current route, the assigned route(s), or both in the Current Route/Reroute(s) column on the Reroute Monitor window. You also have the option of showing the full route or the truncated* route in the Current Route/Reroute(s) column.

*The word “truncated” in this case means not word wrapped.

**Note:** When Truncated Route is selected, you can see the Full Route by moving the mouse pointer over the current route. A tool tip shows the full route without word wrapping. If you select Full Route on the Customize Columns dialog box, moving the pointer over the route has no effect.

Advanced Sort

The **Advanced Sort** option on the Functions menu of the Reroute Monitor dialog box lets you sort the Reroute Monitor Flight List by specifying Primary, Secondary, and Tertiary sort criteria.

1. Click on the arrow next to the criteria field to select from a pick list of sort options.
2. Click in the radio buttons to select either ascending or descending order.
3. Click **OK**.
Clicking on the column header also lets you sort the list in ascending or descending order alphabetically by the value in that column. When you select a column header to sort, an arrow is displayed showing whether the sort is ascending or descending. For example, the window below shows DEST is sorted in descending order.

### Hold/Resume Updates

When a Reroute Monitor is displaying several reroutes, it is refreshed several times during each update, once for each reroute. Selecting **Hold Updates** on the Functions menu stops the Reroute Monitor from updating. Clicking the **Hold Updates** button on the Time Panel also stops the Reroute Monitor from updating. When you use either method to hold the updates, a **Held At:** label is displayed in red in the Time Panel section of the Control Panel. The Hold Updates option on the Functions menu changes to Resume Updates. The Hold Updates button becomes Resume Updates. The Reroute Monitor window below shows the Time Panel when data is being held.

To resume updating, select **Resume Updates** on the Functions menu or click the **Resume Updates** button on the Time Panel.
**Missing or Out-of-Date Data**

Flight List data is updated independently for each reroute, so the data may be up to date for some reroutes but missing or out-of-date for others. The Last Update time field in the Time Panel is displayed in red with a value of N/A if flight list data is unavailable for all of the reroutes being monitored.

![Sample Image 1](image1)

If one or more of the monitored reroutes is out of date, the Last Update Time field is shown in red like the following sample. Moving the pointer over the Last Update field displays a list of reroutes being monitored. You can check the list to see which reroute(s) are out of date.

![Sample Image 2](image2)

If the data is available and up to date for a single monitored reroute or multiple reroutes, the Last Update time would look like the following.

![Sample Image 3](image3)
Approve Exception

The **Approve Exception** command lets you approve the fact that the flight is not conforming to the assigned reroute. The Approve Exception command is disabled (grayed out) unless you are authorized to create public reroutes and you select one non-conformant flight in the Reroute Monitor Flight List.

Revoke Exception

The **Revoke Exception** command lets you remove your approval for the flight’s planned deviation from the assigned reroute. The Revoke Exception option is disabled (grayed out) unless you are authorized to create public reroutes and you select one flight whose reroute status is OK or NC/OK.

Generate Amendment

The **Generate Amendment** option lets you submit a route amendment for one or more pre-departure flights for which flight plans have been processed. You can select a flight with any conformance status, with any type of assigned route, and in any type of reroute for which a flight list can be generated. After you select at least one flight in the Reroute Monitor Flight List, the Generate Amendment option becomes active. After you select this option, the system validates that the selected flights are in pre-departure status, are in the same monitored reroutes, and have the same set of assigned routes in those monitored reroutes. The system also validates that flight plans have been received for all flights. If all of the selected flights pass the validation checks, the TSD opens the Route Amendment dialog box.

**Note:** If the workstation you are using is not authorized to submit route amendments, this option remains grayed out.
**Route Amendment Dialog Box**

The Route Amendment dialog box lets you submit or edit a route amendment for one or more pre-departure flights listed on the Reroute Monitor. After selecting the flights, you access this dialog box by selecting the Generate Amendment option on the Functions menu or on the Reroute Monitor's right-click menu. If you are reviewing an existing amendment for a flight, the Route Amendment dialog box opens after you click the **Edit Amendment** button on the Amendment Status Report.

**Note:** To customize the Reroute Monitor Flight List and display the Amendment Status button, see Customize Columns (Reroute Monitor) on page 4-251.

The Route Amendment dialog box opens in two different versions:

- If the flights you are amending are between the same city pair, the Route Amendment (Same Amendment for All Flights) version opens allowing you to create a single route amendment for all selected flights. See Creating a Route Amendment When Flights Have the Same City Pair on page 4-275.

- If the flights you are amending are not between the same city pair, the Route Amendment (Unique Amendment for Each Flight) version opens allowing you to create an amendment for each selected flight. Creating a Route Amendment When Flights Do Not Have the Same City Pair on page 4-276.

The Route Amendment dialog box opens with the count of the flights for which an amendment is being submitted displayed at the top. A View/Edit List button lets you open a window containing a Route Amendment Flight List. You can edit the list by removing flights if needed.

**Amendment Flight List**

The Amendment Flight List dialog box displays a list of the flights selected to be amended. You access the Amendment Flight List by clicking the **View/Edit List** button on the Route Amendment dialog box. The Amendment Flight List dialog box displays as shown in the example below.

![Amendment Flight List](image)

The Amendment Flight List allows you to edit the list of selected flights by removing flights from the list. The list includes a row for each flight and displays columns for ACID and Origin and Destination airports. The list is sorted by ACID. If there are more than 15
flights in the list, a vertical scroll bar displays and allows you to view the additional flights.

A column of checkboxes labeled “Remove” displays to the left of the ACID column. The checkboxes are unchecked by default. To remove flights from the Flight List, click the checkbox for the flight or flights you want to remove and click the Remove button at the bottom of the dialog box. The Remove button becomes active after at least one flight is checked. To close the Flight List without removing flights, click the Close button. After you remove flights from the Amendment Flight List, the Route Amendment dialog box is updated to reflect the change.

The Route Amendment dialog box displays two panels. The top panel of the Route Amendment dialog box displays the current routes for the flights being amended, provides the capability to retrieve and display retrieved routes, and displays the assigned route(s). The top panel also provides “Show” buttons for drawing routes on the map and Merge checkboxes for selecting routes to merge. The bottom panel provides the capability to merge selected routes, validate any route text you edit, and undo edits. You can also draw merged routes on the map.

The Route Amendment dialog box in the image below shows a route amendment being submitted for two flights that are between the same city pair.
Route Amendment Top Panel

The Route Amendment dialog box is shown below:

![Route Amendment dialog box](image)

The top panel of the Route Amendment dialog box includes three sections described below.

- **Current Routes for Flights to be Amended**
  This section displays a non-editable row for each flight you selected on the Reroute Monitor, displaying up to five flight rows. If you selected more than five flights, use the vertical scroll bar to view the additional rows. The current routes and the ACIDs display for each of the flights. The rows are sorted by ACID and cannot be edited. An active "Show" toggle button and a "Merge" checkbox display to the left of each row. By default, the first row only has its Merge checkbox checked.

- **Retrieved Routes**
  When you first open the Route Amendment dialog box, the Retrieved Routes section displays a single blank row. The Retrieve Routes, Search DB (Database), Get CDR, and Add Route buttons and the Route Code text box located above the Current Routes section provide the capability for retrieving routes for merging. As you retrieve routes using these functions, the Retrieved Routes section displays up to three rows of routes. If you retrieve more than three routes, you can use the vertical scroll bar to view the additional routes. For each row, a route string and a route ID display. All rows in the Retrieved Routes section are editable. To manually edit route text for a row, click in the row. To remove a row, browse the row and select the **Delete Route** option from the right-click menu.

  A "Show" toggle button and a "Merge" checkbox display to the left of each row in the Retrieved Routes panel. The "Show" toggle button initially displays as inactive. Clicking the **Show** button or **Merge** checkbox for a retrieved route triggers the validation (parsing) of the route. If the validation is successful, the
Show button becomes active or the Merge checkbox displays as checked. If the validation fails, an error dialog displays showing the validation error.

- **Assigned Routes**
  This section displays a non-editable row for each assigned route that applies to the flights you are trying to amend. If the flights are involved in more than one monitored reroute, the assigned routes for all of the monitored reroutes display. Additionally, if there are several applicable assigned routes for a reroute, all of those assigned routes also display. The Assigned Routes panel displays up to three rows. If there are more than 3 rows of routes to display, use the vertical scroll bar to view the additional rows. For each row, the text of the assigned route with protected segment indicators, if any, and the TMI ID for the route display. The sort order for reroutes in the Assigned Routes panel is Public, Shared, and then Local. An active "Show" toggle button and a "Merge" checkbox display to the left of each row.

The rows in each section in the top panel are initially sized to show two lines of text. You can resize the height of a row by clicking and dragging the bottom of the row. Note that when you click on the bottom of the row, a dashed line appears to indicate the new row height.

**Note:** If an assigned route was given a type of CDR RTE, RERTE, UNKN RTE, or UPT RTE, a Merge checkbox does not display to the left of the row.
The items in the route amendment top panel are explained in the table below.

**Route Amendment Top Panel**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What You Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show</td>
<td>These toggle buttons allow you to draw the route on the TSD map. The default setting for Show toggle buttons is &quot;On&quot; in the Current Routes and Assigned Routes sections. <strong>Note:</strong> The Assigned Routes panel does not display a Show toggle button if the assigned route was given a type of CDR RTE, RERTE, UNKN RTE, UPT RTE.</td>
<td>To draw the route on the TSD map, click the <strong>Show</strong> button.</td>
</tr>
<tr>
<td>Merge</td>
<td><strong>Route Amendment (Same Amendment for all Flights) Dialog Box:</strong> Lets you select the routes you want to merge. <strong>Route Amendment (Unique Amendment for Each Flight) Dialog Box:</strong> Lets you to select the routes you want to merge. The Merge checkboxes in the Current Routes for Flights to be Amended panel display as selected and disabled. <strong>Note:</strong> The Assigned Routes panel does not display a Merge checkbox if the assigned route was given a type of CDR RTE, RERTE, UNKN RTE, UPT RTE.</td>
<td>To select a route you want to merge, click the checkbox for the route.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• You can check one Merge checkbox within each of the three top panels: Current Routes for Flights to be Amended, Retrieved Routes, or Assigned Route(s)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• You can check one Merge checkbox within the Retrieved Routes and Assigned Routes panels</td>
</tr>
<tr>
<td>Current Routes for Flights to be Amended</td>
<td>Route</td>
<td>Displays the current routes for the selected flights.</td>
</tr>
<tr>
<td></td>
<td>ID</td>
<td>Displays the ACID for the flight.</td>
</tr>
</tbody>
</table>

**Retrieved Routes**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What You Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Route</td>
<td>Text box for manually entering routes or for retrieving a route from the database. Routes retrieved from the database using the Retrieved Routes buttons at the top of the panel display in this text box and can be edited.</td>
<td>Upon opening the Route Amendment dialog box, this text box displays blank. • To manually type in a route or edit a retrieved route, click in the text box. • To retrieve a route from the database, use the Retrieve buttons at the top of the panel.</td>
</tr>
</tbody>
</table>
### Route Amendment Top Panel (Continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What You Do</th>
</tr>
</thead>
</table>
| ID   | The ID field displays the text "Manual" for manually entered routes. As routes are retrieved from the database, this field is automatically populated. If you retrieve a route using the Recently Sent button, this field displays the text "RECENT". If you retrieve a route using the Route Search dialog box, the ID field displays as follows:  
  - From the CDR database - the CDR code displays.  
  - From the Playbook, the first 10 characters of the playbook name displays. If the playbook name is longer than 10 characters, you can browse over the ID to view the entire name.  
  - From the Pref routes database, the text, "Pref" displays.  
If you retrieve a route by entering a Route code and clicking the Get CDR button, this field displays the CDR code for the route.  
If you append a row to the Retrieved Routes panel by clicking the Add Route button, the text "MANUAL" displays.  
**Note:** If you edit route text for any row other than one that you manually enter, the system displays the ID field for that row as grayed out. This is to indicate that the originally retrieved route text has been modified. | Display-only. |

### Retrieve Routes Buttons

| Recently Sent | Allows you to retrieve the route text for an amendment you submitted. This button is active if both of the following conditions are true:  
  - At least one amendment has been submitted to ERAM and accepted by ERAM for the reroute(s) associated with the selected flights.  
  - The submitted amendment was for the same city pair as the flights for which you are currently generating an amendment.  
**Note:** The amendment must have been submitted at the same workstation and during the same TSD session. | To retrieve the route text for recently submitted amendments, click this button.  
Each appended row displays the route text for a recently submitted amendment. The text, RECENT, displays in the ID column. Retrieved amendments display in descending order of the most recent send time. |
**Route Amendment Top Panel (Continued)**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What You Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search DB</td>
<td>Allows you to open the Route Search dialog box (see “Route Search” on page 4-300) and retrieve a route by searching the CDR, Playbook, or Pref routes database.</td>
<td>To open the Route Search dialog box and retrieve a route, click this button.</td>
</tr>
<tr>
<td>Route Code</td>
<td>Allows you to enter a CDR code for retrieving a single CDR route. As soon as you enter a CDR code, the Get CDR button becomes active.</td>
<td>Enter the CDR code of the route you want to retrieve.</td>
</tr>
<tr>
<td>Get CDR</td>
<td>Allows you to search the CDR database if you enter a CDR code in the Route Code text box.</td>
<td>To search the CDR database for a CDR matching the code entered in the Route Code text box, click this button.</td>
</tr>
<tr>
<td></td>
<td>• If no CDR code is entered in the Route Code text box, this button is grayed out.</td>
<td>• If no CDR code is entered in the Route Code text box, this button is grayed out.</td>
</tr>
<tr>
<td></td>
<td>• If a matching CDR is found, the route is appended to the Retrieved Routes panel and the CDR code displays in the ID column for the route.</td>
<td>• If a matching CDR is found, the route is appended to the Retrieved Routes panel and the CDR code displays in the ID column for the route.</td>
</tr>
<tr>
<td>Add Route</td>
<td>Allows you to append a single, blank row to the Retrieved Routes panel and manually enter a route.</td>
<td>To append a single, blank row to the Retrieved Routes panel for the purpose of manually entering route text, click this button.</td>
</tr>
</tbody>
</table>

**Assigned Route(s)**

| Assigned Route(s)     | Displays the assigned routes for the selected flights.                                                                                                                                                     | Display-only.                                                                                                                                                                                             |
|                       | • If a flight is involved in more than one monitored reroute, the assigned routes for all of the monitored reroutes are displayed.                                                                     |                                                                                                                                                                                                          |
|                       | • If there are several applicable assigned routes from the same reroute, all of the assigned routes are also displayed.                                                                                     |                                                                                                                                                                                                          |
|                       | Note that assigned routes with a domain of public are listed first, shared reroutes next, and local reroutes last. Reroutes within a domain are sorted by TMI ID.                                               |                                                                                                                                                                                                          |
| ID                    | Displays the Traffic Management Initiative ID for the reroute.                                                                                                                                            | Display-only.                                                                                                                                                                                             |
Route Amendment Bottom Panel

The bottom panel, labeled Create Route Amendment, allows you to generate route text by merging routes. You can edit merged route text, validate edited text, show an edited route on the map, and undo edits.

If you select flights to amend that have the same city pair, this panel displays a single row for route text. One amendment will be generated for all selected flights.

If you select flights to amend that do not have the same city pair, this panel displays a row for each flight. If you select more than 5 flights to amend, use the vertical scroll bar to view the additional rows. A unique amendment will be generated for each of the selected flights.

After you generate route text, the Create Route Amendment panel displays the conformance status for the generated route and the TMI ID for the reroute advisory.

The items in the Route Amendment bottom panel are explained in the table below.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What You Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show</td>
<td>Allows you to draw the route on the TSD map as long as the Route Amendment dialog box remains open.</td>
<td>To draw the route on the TSD map, click this button.</td>
</tr>
</tbody>
</table>
| Merge                 | **Route Amendment (Same Amendment for all Flights) Dialog Box:** Allows you to create a route amendment by merging the two selected routes. If you browse over the Merge Routes button the following tool tip displays: "Construct an amendment for all flights by merging two selected routes."

**Note:** This button is active after exactly two routes are checked in the top panel. | To merge the selected routes and create a route amendment for all flights, click this button. |
### Route Amendment Bottom Panel (Continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What You Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Merge Routes</td>
<td><strong>Route Amendment (Unique Amendment for Each Flight) Dialog Box:</strong></td>
<td>To merge the selected routes and create a unique amendment for each flight, click this button.</td>
</tr>
<tr>
<td></td>
<td>Allows you to create a route amendment for each selected flight by merging the selected assigned or retrieved route with each current route. If you browse over the Merge Routes button the following tool tip displays: &quot;Construct amendments by merging each current route with the selected route.&quot; Note: This button is active only if a single route is checked in either the retrieved routes panel or the assigned routes panel but not both.</td>
<td></td>
</tr>
<tr>
<td>Use Last Sent</td>
<td>Inserts the text of the last successfully sent amendment for the reroute and city pair into the route amendment text box. Note: This button is active if a route amendment was sent and accepted for the reroute and for the same city pair as the flights currently being amended. This button is not active if you are creating unique route amendments for flights that are not between the same city pair.</td>
<td>To insert the text of the last successfully sent amendment, click this button.</td>
</tr>
<tr>
<td>Merge with CDR/Pref</td>
<td>Searches the RMT database, retrieves all CDRs and Pref routes for the selected flight's city pair, merges the assigned route with each retrieved route and determines the merged route with the shortest end to end distance. After determining the merged route with the shortest end to end distance, enters the route text for the merged route into the route amendment text box. Note: This button is active if a route is selected in the Assigned Routes panel. This button is not active if you are creating unique route amendments for flights that are not between the same city pair.</td>
<td>To search the RMT database and determine the merged route with the shortest end to end distance, click this button.</td>
</tr>
</tbody>
</table>
## Route Amendment Bottom Panel (Continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What You Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>TMI ID</td>
<td>Displays the Traffic Management Initiative ID that will be submitted with the route amendment.</td>
<td>If there are multiple reroutes displayed, click the arrow button to view a pick list of available TMI IDs.</td>
</tr>
<tr>
<td></td>
<td>• If there is only one reroute displayed in the Assigned Routes panel, the TMI ID for that reroute displays.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• If there are multiple reroutes displayed, a pick list of TMI IDs is available. The TMI ID selected in the pick list defaults to the TMI ID associated with the assigned route that is checked in the Assigned Routes panel or to the TMI ID that is associated with the first assigned route, if no assigned route is checked. You can change the default selection. <strong>Note:</strong> The TSD determines the TMI ID associated with each assigned route from the reroute definition. The TMI ID for a reroute consists of the following three elements: the letters &quot;RR&quot;, a three character facility ID of the facility where the reroute was created, and the advisory number if an advisory was issued for the reroute; otherwise a unique 3-digit sequence number. For example, RRDCC345.</td>
<td></td>
</tr>
<tr>
<td>Route Amendment</td>
<td>After you click the <strong>Merge Routes</strong> button, this text box displays the route text, including any protected segments, for the merged routes. You can edit the route text. If you are creating unique route amendments for flights that are not between the same city pair, the ACID for a flight displays at the beginning of the row.</td>
<td>To edit route text, click in the text box. You can copy and paste route text from one of the other panels using the standard methods (&lt;Ctrl&gt;&lt;C&gt; and &lt;Ctrl&gt;&lt;V&gt;).</td>
</tr>
<tr>
<td>RRSTAT</td>
<td>Displays the conformance status of the reroute. If more than one reroute displays, the conformance status of the reroute selected in the TMI pick list displays. <strong>Note:</strong> If you edit the route amendment text, you must click the <strong>Preview</strong> button to update the conformance status of the route.</td>
<td>Display-only.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
<td>What You Do</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Preview</td>
<td>This button is grayed out unless you edit merged route text or route text from a recently sent amendment. Clicking this button validates the edited route. If the route is validated and the Show button is toggled on, the TSD draws the route on the map and updates the conformance status for the flight.</td>
<td>To validate the route, click this button.</td>
</tr>
<tr>
<td>Undo</td>
<td>This button is grayed out unless you edit merged route text or route text from a recently sent amendment. Clicking this button reverts the route text to the prior text, entered before the last set of edits. <strong>Note:</strong> If you need to undo route text, use the Undo function before leaving the route amendment text box. If you leave the text box and return, you cannot undo prior edits.</td>
<td>To undo edits made to the route text, click this button.</td>
</tr>
</tbody>
</table>
Displaying Routes on the Map

As long as the Route Amendment dialog box remains open, you can display on the map any current, retrieved, assigned, or merged route by toggling its "Show" button On. The system draws current routes using the standard line style for current routes. Retrieved and assigned routes are drawn on the map using the 2 pixel line style that is used when drawing routes through the Reroute Monitor. The system draws merged routes using the 4 pixel line style that is used when a reroute is drawn through the Create Reroute dialog box.

For assigned routes, the system uses the line color that is associated with the reroute. The system draws all other routes and route segments using the color associated with the reroute whose TMI ID is displayed in the TMI ID field.

The following example shows the top panel of the Route Amendment dialog box. The current route is drawn with a standard 2 pixel solid green line. Due to protected segment indicators the assigned route displays in a slate blue color. The selected retrieved route is drawn in purple using a dashed 2 pixel line.
Creating a Route Amendment When Flights Have the Same City Pair

If the flights for which you want to submit a route amendment are between the same city pair and have passed all validation checks, the Route Amendment dialog box opens as shown below. In this example, the title bar specifies that the created amendment will be the same for the two selected flights.

On this version of the Route Amendment dialog box you select two routes to merge. You select the two routes from three different panels; Current Routes, Retrieved Routes, or Assigned Routes. If you select the Merge checkbox for a retrieved or manually added route, the TSD validates the route text and displays error messages if the route string does not meet the validation checks. The Merge Routes button in the Create Amendment panel displays as active after exactly two routes are checked in the top panel.

In this example the checkboxes for a current route and an assigned route have been checked. The Create Route Amendment panel shows that one route amendment will be created for the two selected flights. The TMI ID and the conformance status (RRSTAT) for the created route amendment display on the right.

After you click the Merge Routes button to merge your selected routes, the system merges the routes and formats route text inserting dots and double dots as appropriate between each route element. If a selected route is an assigned route and the assigned route is from a public reroute that includes a protected segment, the system will display protected segment indicators in the merged route text.
Creating a Route Amendment When Flights Do Not Have the Same City Pair

If the flights for which you want to submit a route amendment are not between the same city pair and have passed all validation checks, the Route Amendment dialog box opens as shown below. The title bar specifies that a unique amendment is being created for each flight.

On this version of the Route Amendment dialog box the Merge checkboxes for the selected flights' current routes are checked and grayed out. The selected flights' current routes will be merged with a retrieved or assigned route to create a unique amendment for each flight. If you select the Merge checkbox for a retrieved or manually added route, the TSD validates the route text and displays error messages if the route string does not meet the validation checks.

The Merge Routes button in the Create Route Amendment panel will display as active only if a single route is checked in either the Retrieved Routes panel or the Assigned Routes panel but not both. This version of the Create Route Amendment panel provides a row for each flight being amended. If there are more than five flights being amended, use the vertical scroll bar to view the rows for all flights.

In this example, the checkbox for an assigned route has been checked and the Create Route Amendment panel shows that two route amendments have been created, one for each of the two selected flights. The ACID for each selected flight displays at the beginning of the row. The conformance status of each reroute displays and a picklist of TMI IDs is available on the right.
**Sending the Route Amendment**

After you merge routes and construct valid route text, the Send button at the bottom of the Route Amendment dialog box becomes active. To save and send the route amendment to ERAM, click the **Send** button. Otherwise, click **Cancel**.

After you click the **Send** button, the TSD may display a Confirm Send dialog box for any flights with a Proposed Gate Time of Departure (P-Time) that is within a configurable parameter time of current time. This dialog box indicates that the flights may require verbal coordination and lists their ACIDs and P-times.

![Confirm Send dialog box](image)

You can choose to send amendments for these flights or not. The Confirm Send dialog box also provides a button allowing you to return to the Route Amendment dialog box and edit the Amendment Flight List.

If you click **Yes** to send route amendment data to ERAM, the TSD sends the full end-to-end route, the protected portion, and the TMI ID. ERAM validates the data received from TFMS and makes it available to departure and en route controllers.

**Amendment Status Report**

The Amendment Status Report dialog box lets you view information on the status of a submitted amendment. You access the Amendment Status Report by clicking the **Amendment Status** button for a flight in the Reroute Monitor Flight List when the amendment status is Sent (SENT), Accepted (ACPT), or Rejected (RJCT). If your workstation is authorized to submit amendment messages, you can access the Route Amendment dialog box from the Amendment Status Report and edit an amendment.
The Amendment Status Report dialog box displays the ACID for the selected flight in the title bar.

The following table describes the items displayed on the Amendment Status Report.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACID</td>
<td>Aircraft ID</td>
</tr>
<tr>
<td>Report Time</td>
<td>Time at which the Amendment Status Report window was opened.</td>
</tr>
<tr>
<td>TMI ID</td>
<td>Traffic Management Initiative (TMI) ID that was sent with the amendment. The TMI ID consists of the following three elements: (&lt;\text{the letters &quot;RR&quot;}&gt;) (&lt;\text{a three character facility ID of the facility where the reroute was created}&gt;) (&lt;\text{the advisory number if an advisory was issued for the reroute, otherwise a unique 3-digit sequence number}&gt;.) For example, RRDC345.</td>
</tr>
<tr>
<td>Amended Route</td>
<td>Amended route text, including protected segment indicators (if any)</td>
</tr>
<tr>
<td>Time Sent</td>
<td>Time the amendment was sent (HHMM)</td>
</tr>
<tr>
<td>Current Status</td>
<td>Current amendment status: Sent, Timed Out, Accepted, or Rejected. If the status is Accepted or Rejected, the status text displays as red.</td>
</tr>
<tr>
<td>Reason</td>
<td>Reason an amendment was rejected.</td>
</tr>
<tr>
<td>Edit Amendment</td>
<td>Allows you to open the Route Amendment dialog box and edit the amendment.</td>
</tr>
<tr>
<td>Close</td>
<td>Allows you to close the Amendment Status Report window.</td>
</tr>
</tbody>
</table>
View Menu

The View Menu contains the following options:

- **Show/Hide Flights**
  This option lets you toggle the reroute flights on and off the TSD window.
  The flight icon on the Control Panel also lets you toggle reroute flights on and off
  the TSD window.

- **Show/Hide Timeline**
  This option lets you show or hide the Timeline portion of the dialog box.

- **Absolute/Relative Time Range**
  This option lets you identify the time range in the timeline as Relative or Absolute.
  Relative and Absolute time ranges are discussed in detail in the Timeline section
  on page 4-234.

- **Show/Hide Flight List**
  This option lets you show or hide the flight list portion of the dialog box.

- **Shrink/Expand**
  This option lets you reduce the Reroute Monitor window or expand it to the state it
  was in before it was reduced.

  A left-facing and right-facing arrow on the Control Panel also let you shrink or
  expand the Reroute Monitor window.

**Show/Hide Flights**

The **Show Flights** command allows the flights for all reroute that are being monitored to
be displayed on the TSD. The **Hide Flights** command removes the flights from the TSD
display.

- Pull down the **View** menu in the Reroute Monitor dialog box by clicking **View** or
  pressing <Alt>-V. Click **Show/Hide Flights** or press **F**.

  OR

- Click the **Show/Hide Flights** icon in the Selection Panel on the Reroute Monitor
dialog box.
The sample below shows the TSD as it would appear if you selected **Show Flights** on the View Menu or if you clicked the **Show/Hide Flights** icon. Reroute non-conformant flights are shown with a solid circle drawn around the flight icon. The Reroute Flight Filters and selected time range control the flights that are displayed on the TSD.

**Show/Hide Flight Icon**

If the Reroute Flights are hidden, the Show/Hide Flights icon in the Selection Panel has a red “×” through it, as shown below. Use the New Flights checkbox to specify whether the TSD displays a check mark in the Show checkbox for new flights that are added to the Flight List after the Reroute Monitor is refreshed. If their Show checkboxes are selected, the TSD automatically draws the new flights on the display. Use the Reroute and Navaids checkboxes to display the reroutes and navaids for selected flights.

You can change the color of the flight icons on the TSD by clicking the color button on the Control Panel and selecting a color from the resulting Color Selector palette.

**Show/Hide Timeline**

If the Timeline is visible on the Reroute Monitor, the View Menu contains the Hide Timeline option. When you select Hide Timeline, the Timeline section of the Reroute Monitor window is hidden.
Show/Hide Flight List

The Show/Hide Flight List command allows you to show or hide the Flight List section of the Reroute Monitor dialog box. The Flight List section of the Reroute Monitor displays data about the flights that are included in any of the monitored reroutes. Flights that are involved in multiple reroutes will be included in the list multiple times, once for every monitored reroute. Flight IDs shown in blue indicate that the flight is in more than one reroute whether monitored or not. If you browse over the flight ID, a tool tip will list all reroutes for that flight.

If the Flight List is displayed on the Reroute Monitor, the View Menu contains the Hide Flight List option. When you click Hide Flight List on the View Menu, the Flight List section of the Reroute Monitor window is hidden. When the Flight List is hidden, the Hide Flight List button changes to Show Flight List.

Shrink/Expand

When you click Shrink on the View Menu, the Reroute Monitor is reduced in size.

You can also reduce the size of the Reroute Monitor by clicking the arrow to the right of the Counts Panel. When the Reroute Monitor is full size, the arrow points to the left. clicking this arrow reduces the Reroute Monitor to the size show above.

To expand the Reroute Monitor, click the right arrow.

The window expands to the state it was in before it was reduced. For example, if you had previously hidden the Timeline, when you expand the window, the Reroute Monitor opens with the Timeline hidden.

Note: Passing the cursor over the arrow displays a tool tip: Expand when the window is reduced and Shrink when the window is expanded.
Create Reroute Command

The **Create Reroute** command lets you create new reroutes and designate them as Public, Local, Shared or Private. Only authorized users, such as those at ATCSCC, can create a public reroute set. You define the reroute set by specifying its name, domain, display parameters, and the reroute specification.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
</table>
| 1. Pull down the Reroute menu by clicking **Reroute** on the TSD Main Menu or pressing `<Alt>` *R*.  
2. Click **Create Reroutes** or press **C**. | **N** |

<table>
<thead>
<tr>
<th>Semicolon Method</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>None</strong></td>
</tr>
</tbody>
</table>
Create Reroute Dialog Box

After you click **Create Reroute**, press **C** with the Reroutes menu open, or press **N** with the pointer on the TSD, the Create Reroute dialog box opens. The dialog box shows the default preferences that have been specified for the Identify Flights Based On and Characteristics section.

You can change the color in the Reroute Preferences dialog box. The other default values cannot be changed.
Create Reroute Dialog Box Buttons

There are five buttons at the bottom of all the tabs of the Create Reroute dialog box. The function of the left-most button is determined by the domain you select for the reroute definition: Private, Local, Shared, or Public.

- Save/Share/Send
  - Private or Local domain: Save
  - Shared domain: Share
  - Public domain: Send
- Model
- Clear
- Cancel
- Help

Send/Share/Save Button

After you finish entering the reroute definition, click the Send/Share/Save button as it appears:

- For a Private or Local reroute, click the Save button to save the reroute.
- For a Shared reroute, click the Share button to save the reroute and make it available to the shared sites.
- For a Public reroute, click the Send button to save the reroute, make it available to all sites, and issue an advisory.

In all cases, the TSD performs several checks for errors and validates the data you entered before saving the reroute. If all of the data passes the validation checks, the TSD opens the dialog box shown below. The title bar displays Issue, Share or Save Reroute, depending on the domain of the reroute.
If you are saving changes you made to an existing reroute, pre-departure or active flights exist that do not match the reroute definition of the modified reroute, and an amendment message was sent and accepted for at least one of the dropped flights, a section titled Cancellation Messages also displays.

The following table explains the checkboxes and buttons on the Issue/Share/Save Reroute dialog box.

### Issue/Share/Save Reroute Dialog box

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navaids</td>
<td>Allows you to choose whether navaids display with the reroute.</td>
</tr>
<tr>
<td>Fixes</td>
<td>Allows you to choose whether fixes display with the reroute.</td>
</tr>
<tr>
<td>Color</td>
<td>Allows you to choose the color with which the reroute displays after you save the reroute.</td>
</tr>
<tr>
<td>Send Advisory/ Send General Message</td>
<td>This checkbox is active if you are creating a Public reroute. If you selected the Advisory radio button on the Advisory tab, a Send Advisory checkbox displays; otherwise a Send General Message checkbox displays. Allows you to send an Advisory or General message.</td>
</tr>
<tr>
<td>Attach Flight List</td>
<td>This checkbox is active if you are creating a Public reroute. Allows you to attach a flight list to the Advisory or General message.</td>
</tr>
</tbody>
</table>
To confirm that you want to save the reroute, click the **Save**, **Share**, or **Send** button. The TSD displays a Status dialog box, that displays the name of the reroute you have requested in the title bar.

- If the request is successful, the Issue/Share/Save Reroute dialog box closes. For a public reroute, the Create Reroute dialog box also closes. For a private, local or shared reroute, the Create dialog box remains open.
- If the request is unsuccessful, this box will display an error message. Click **Retry** to resend the request or click **Do Not Retry** to return to the Create Reroute dialog box.
- If the TSD detected errors in the data entered, it displays the Create Reroute dialog box with the fields in error highlighted in red.
- If no flights are found to match the reroute definition, an error dialog box summarizing data errors is displayed.

### Issue/Share/Save Reroute Dialog box

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| Print Flight List After Send | This checkbox is active if you are creating a Public reroute. Allows you to print a flight list after sending an Advisory or General message.  
**Note:** The printed flight list includes a flight only if the Include checkbox for the flight's reroute segment on the Flight List tab is checked. |
| Print Flight List Now | This button is active if you are creating a Public reroute. Allows you to print a flight list before sending an Advisory or General message.  
**Note:** The printed flight list includes a flight only if the Include checkbox for the flight's reroute segment on the Flight List tab is checked. |
| Include Protected Segments | This checkbox is active if you are creating a Local or Shared reroute. Allows you to show or hide the display of protected segment indicators in the assigned route text displayed on the Reroute Monitor and the Generate Amendment dialog boxes. If you are creating a Public reroute, this checkbox is automatically checked and grayed out. |

### Cancellation Messages section

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send Cancellation Messages for</td>
<td>Allows you to choose whether you want to send a cancellation message to ERAM for All Flights or only those flights that are Not Airborne. The cancellation message notifies ERAM that the reroute protected segment and TMI ID for the flights are no longer needed.</td>
</tr>
</tbody>
</table>
Model
Click Model to switch the TSD to Model mode and view model results for the reroute. For more information on Model mode, see page 4-333 in the Reroute Impact Assessment section of Chapter 4.

Clear
Click Clear to clear all entries and restore all fields to their default state. After you click Clear, a confirmation dialog box displays. If you are modeling a reroute, clicking the Clear button clears model data from the Create/Edit Reroute dialog box and returns the TSD to Normal mode.

Cancel
Click Cancel to close the Create/Edit Reroute dialog box without saving your latest changes. After you click Cancel, a confirmation dialog box displays.

Help
Click Help on any Create Reroute dialog box to open context-sensitive Help for that dialog box.
Create/Edit Reroutes Menu Bar

The Create/Edit Reroutes dialog box has a menu bar with the following pull-down menu and button options:

- File Menu
- Functions Menu
- View Menu
- Full View Button

**Note:** An additional button, the MIT (Miles In Trail) Status button appears on the Create/Edit Reroute dialog box menu bar when you are working in Model Mode. See Using the MIT Status Button on page 4-382 in the Reroute Impact Assessment section of Chapter 4, for more information.

Create/Edit Reroutes File Menu

The File menu provides options that allow you to save reroute sets, organize saved folders and reroute sets, and revert to a previously saved or edited version of a reroute definition.

**Save My Routes**

Click **Save My Routes** on the Create/Edit Reroute dialog box File menu to open the Save My Routes dialog box.

The Save My Routes dialog box allows you to save route sets that can only be seen within your facility. To save a route, click on an existing folder name in the Saved Routes field or click the **New Folder** button to create a new folder. Type the name of the route in the Save As field and click **OK** to save the route.
**Note:** The Save My Routes menu option is grayed out if the route section of the Create Reroute dialog is blank.

**Manage My Routes**

Click **Manage My Routes** on the Create Reroute dialog box File menu to open the Manage My Routes dialog box.

The Manage My Routes Dialog allows you to organize saved folders and route sets. You can create new folders and rename, delete, and copy existing folders and route sets.

- **New Folder Button**

  Both the Save My Routes and Manage My Routes dialog boxes allow you to create a new folder for your saved route sets. Click **New Folder** to open the New Folder dialog box.
Revert to Earlier Reroute Definition

The Revert to Earlier Reroute Definition option on the File menu of the Create/Edit Reroute dialog box allows you to undo changes made to a reroute definition since the Create/Edit Reroute dialog box was opened and return to a previously saved version. This option is available in all modes.

To access the Undo/Revert Reroute Definition dialog box while editing a reroute, select Revert to Earlier Reroute Definition from the File menu of the Create/Edit Reroute Definition dialog box.

In the Date/Time of Saved Reroutes section of the dialog box, the date/time for the initial version of the definition automatically displays in the format \texttt{dd:hhmmss}. Each time you edit and save a reroute definition with the Create/Edit Reroute dialog box open, the TSD temporarily saves a copy of the reroute definition as a separate file.

In the Undo/Revert Reroute Definition dialog box example above, three versions of a reroute definition have been saved, showing the date/time stamp for each saved file in chronological order.

Click on the date/time of a saved definition to select it. Note that you are able to select only one row in the dialog box. The date/time of the selected definition displays in the Selection field.

- To undo any changes you made to the reroute definition and return to the earlier, saved definition, click \textbf{OK}.
- To close the Undo/Revert Reroute Definition dialog box without undoing any changes to the reroute definition, click \textbf{Cancel}.

You can retrieve any saved version of the reroute definition as long as the Create/Edit Reroute dialog box remains open. After you close the Create/Edit Reroute dialog box, the TSD discards all temporarily saved versions displayed in the Undo/Revert Reroute Definition dialog box.
Create/Edit Reroutes Functions Menu

The Functions menu on the Create/Edit Reroute dialog box provides the following options.

- **Edit/Replace Route Text**
  The Edit/Replace Route Text option enables you to edit or replace route string text for selected route segments or all route segments containing a specified route string.

- **Replace Reroute(s)**
  The Replace Route(s) option is a modeling function.
  For more information, see Replace Reroute(s) on page 4-378 in the Reroute Impact Assessment section of Chapter 4.

- **Copy Reroute**
  The Copy Reroute option lets you create a new reroute by copying and editing an existing reroute definition. If you are authorized to create public reroutes, you can use this option to copy and edit a public reroute and share the edited version before issuing the edited version as a replacement for the original public reroute. If you copy a reroute with Private, Local or Shared domain, the copied reroute does not replace the original reroute. You can also access the Copy Reroute option from the View Reroute and the Select Reroute dialog boxes.
  For detailed information on using the Copy Reroute option, see page 4-218 in this chapter.

Edit/Replace Route Text

You can open the Edit/Replace Route Text dialog box in four ways:

- Click on **Edit/Replace Route Text** on the Create/Edit Reroute Functions menu to open an empty Edit/Replace Route Text dialog box.

- Within the Edit or Create Reroute dialog box, select one or more route grid rows, right click, and select **Edit/Replace** from the right-click menu to open the Edit/Replace Route Text dialog box. The “Change” and “To” fields are initialized with the text that is common to all the selected reroute segments. If you select both Origin and Destination split route segments, the TSD displays all route text that is common in the full route segments.

- Click on the drawn reroute on the TSD map to select one or more reroute segments and select **Edit/Replace Route Text** from the right-click menu to open the Edit/Replace Route Text dialog box. This works the same as the grid row method, with the “Change” and “To” fields initialized with the text that is common to all the selected reroute segments.

- With the Create/Edit Reroute dialog box open, browse or select a reroute segment and select **Edit/Replace** from the right-click menu.
**Note:** When the Edit/Replace Route Text dialog box opens, the Change and To fields are initialized with the text that is common to all the selected reroute segments. If the TSD finds that there is no route text that is common to all selected segments OR if no segments were selected, no text displays in the Change and To fields.

You can manually edit text in the “Change:” and “To:” fields or copy and paste text. To copy and paste route string text, use the Copy <CTRL-C>, Cut <CTRL-X>, and Paste <CTRL-V> functions.

- To change the text string in the Change field with the text string you specify in the To field in selected segments only, select the **Change Only Selected Segments radio** button and click **OK**. If the text in split route segments is being replaced, the TSD will split the text between origin and destination segments at the last fix in the replacement text string.

- To change all occurrences in the route grid of the text string in the Change field with the text string you specify in the To field, select the **Change all Occurrences radio** button and click **OK**.

In the sample below, **ABR CESNA JUVAJ VIXIS PENDO SIBKI TULEG** is changed to **ABR CESNA AGOMA ACATI VIXIS PENDO SIBKI TULEG** and Change Only Selected Segments is selected in the Edit/Replace Route Text dialog box. The first three route segments are checked in the Create Reroute dialog box, shown above. The changes will not apply to the other, unselected segments.
After invoking the Edit/Replace Route Text command, the TSD checks all route segments in the grid to determine if any segments need to be parsed and validated. If no route segments need to be parsed, the Edit/Replace Route Text dialog box displays. Otherwise, the TSD displays a message indicating that some route segments have not been validated and must be parsed before the Edit/Replace function can be used.

- If you click Yes, the TSD sends the unparsed route segments for parsing.
- If a parsing error is encountered in the route segment data, the TSD displays route segments in red in the route grid. If you hover over these route segments a tool tip describing the parsing errors displays. The TSD displays parsing errors in red on the route grid until you edit them.
- If you click No, the TSD cancels the Edit/Replace Route Text function.

After you click Yes and no errors are found, the TSD displays a confirmation dialog box that indicates the number of occurrences of the route string found and the number changed and asks whether you want to keep the changes.

**Note:** You can view the drawn routes on the TSD map at the same time the confirmation dialog box is open. This enables you to view the route drawing to determine if you want to confirm the change.

Click Yes to accept the changes or No to close the confirmation box without keeping the changes.
Create/Edit Reroutes View Menu
The View menu provides options that allow you to show or hide POI counts and view model results.

Show POI Counts/Hide POI Counts
Use the Show POI Counts option to set how you want POI counts to display in Preview or Model mode. Use Hide POI Count to remove POI counts from the display.

For more information on POI Counts, see POI Timeline: TSD Display on page 4-389 in the Reroute Impact Assessment section of Chapter 4.

View Model
The View Model option is disabled on the View menu of the Create and Edit Reroute dialog boxes. In View Reroute, this menu option opens the View Reroute dialog box in Model mode.

For more information on reroute modeling, see Modeling a Reroute on page 4-369 in the Reroute Impact Assessment section of Chapter 4.

Full View Button
You can resize the Create/Edit Reroute dialog box by clicking and dragging the lower corners. The Full View button located to the right of the View Menu allows you to restore the size of the Create, Edit, and View dialog boxes to the default size needed to fully display the selected tab. Hovering the pointer over the Full View button displays the following tooltip.

Full View
Click to resize this dialog to full view
Create Reroute Dialog Box Tabs

The Create Reroute dialog box contains six tabs:

- Reroute Definition Tab page 4-295
- Reroute Analysis Tab page 4-320
- Flight List Tab page 4-320
- Shared Sites Tab page 4-322
- Restrictions Tab page 4-323
- Advisory Tab page 4-324

Reroute Definition Tab

By default, the Reroute Definition tab has focus when the Create Reroute dialog box is opened. Fields and functions available on the Reroute Definition Tab are described in this section. The Reroute Definition tab allows you to define the routes that will make up the reroute.
You can define the reroute using any combination of the following methods.

- Select one or more plays from the Playbook Database.
- Select individual route segments from one or more playbook plays.
- Import Coded Departure Routes (CDRs).
- Import a set of routes that have been saved previously in My Routes.
- Import reroute definitions from a file that was saved using the Route Management Tool (RMT).
- Manually type in the routes.

**Import Routes From**

The Import Routes From field contains buttons that allow you to import routes from three import sources: Playbook, Route Search, My Routes, and RMT File.

**Playbook**

The Playbook dialog box allows you to import routes from the Playbook.

Click **Playbook** in the Import Routes From section to open the Playbook dialog box. The Available Plays section shows the play categories.

Plays are predefined sets of routes. You can create a reroute set automatically by selecting these plays and using them as they are or by modifying them to match your requirements.

To expand a Playbook category and view a list of plays, click the plus sign (+) icon to its left or double-click the folder name. When the category is expanded the plus sign changes
to a minus sign (-) icon. In the preceding example, the Airports category was expanded to display the available plays.

**Previewing Available Plays on the Map**

The Playbook dialog box allows you to select one or more plays from the Available Plays and view them on the map before adding the plays to the Selected Plays column.

- To select an individual play in the Available Plays list, click on the play to highlight it.
- To select more than one play as a continuous section of the whole list either click and drag from the first to the last play you want, or press `<Shift>`, click the first play you want, and then click the last play of the continuous list you want; the plays from the first to the last will be selected.
- To select more than one non-adjacent plays, and press `<Ctrl>` to select the plays.

The TSD highlights selected plays in system-generated colors as in the example below.

You can view plays on the TSD map before adding them to the Selected Plays list. You can resize the Playbook dialog box and move it aside on your screen so that while clicking on one or more Available Plays, you can view them on the TSD map. Another way to view the map is to double click the title bar of the Playbook dialog box so it will “roll-up.” Double click again to restore the Playbook dialog box.

When you select a play in the Available Plays list, the TSD immediately draws the play on the map. If several plays are selected, the TSD draws them all, using its system-assigned color (the same color used to highlight it in the Available Plays list) to differentiate each of the selected plays.
In the image below the routes are drawn for the plays highlighted in the above image of the Playbook dialog box:

**CVG CINCE 1, CVG CINCE 2, CVG EAST, and CVG JAVIT 1.**

If needed, you can click and drag the lower corners to resize the map to view the plays list more fully.

When viewing a play, the TSD draws a solid circle and labels at the location of all airports that are origins or destinations for the play. Solid squares and labels are drawn at the geographic center of all ARTCC's that are specified as an origin or destination. A dashed line is drawn from each airport icon to the end of the associated reroute segment.

If you decide to add one or more of the plays to the Selected Plays list, the selected plays will appear on the TSD map in the color selected in the Characteristics section of the Create/Edit Reroute Definition dialog box.

In the Playbook dialog box, click **Collapse All Nodes** to close all expanded Playbook folders and return to a list of available play folders. Double clicking an individual play category name or clicking the minus sign to its left will collapse the play category.

**Adding Available Plays to the Selected Plays Column**

To add a play to the Selected Plays column, double-click the play or select the play by clicking once and clicking **Add**. When a single play is added, it displays at the bottom of the Selected Plays list. To select multiple plays and move them to the Selected Plays column, click on a play in the Available Plays column, drag the pointer down over the list.
of plays, or use the <Shift> or <Ctrl> keys as described on the previous page, and click the **Add** button.

If multiple plays are added as a group, the group is added to the bottom of the list. The plays within the group are sorted in alphabetical order. If a reroute is edited, the list of plays in Selected Plays will reflect the order of plays in the route grids. If needed, a vertical scroll bar allows you to view all plays in the list. You can also remove plays from the Selected Plays column by selecting the play(s) and clicking **Remove** or **Remove All**.

After you add one or more plays to the Selected Plays column, the TSD draws the route(s) on the map in the color selected in the Characteristics section of the Create/Edit Reroute dialog box.

**Note:** Once a play is added to Selected Plays that play will be disabled (grayed out) in the Available Plays column.

Once you have selected plays, click the **Retrieve Selected Play(s)** button to auto-fill the Reroute Definition tab with the selected play(s) and close the Playbook dialog box.

Route segments for plays are added to the route grids of the Create Reroute dialog box in the order that the plays appear in the Selected Plays column of the Playbook dialog box. When route segments for plays are added to the route grids, they are added to the bottom of the route grids below any existing route segments. If you select a single play from Playbook, the name of the play displays in the Name field on the Reroute Definition and Advisory tabs. Otherwise, the Name field displays blank.
Route Search

Click **Route Search** in the Import Routes From field to open the Route Search dialog box. The Route Search dialog box allows you to search the CDR database or the Playbook database.

You can access the Route Search dialog box by clicking the **Route Search** button on the Create or Edit Reroute dialog boxes or the **Search DB** button on the Route Amendment dialog box. This dialog box allows you to search the Coded Departure Routes (CDR), Playbook, or the Preferred Routes databases for routes to import when creating or editing a reroute or when generating a route amendment.

The CDR button is selected by default.
The Route Search dialog box provides three radio buttons for specifying the database in which you want to search. The following table explains the fields and buttons on this dialog box.

### Route Search

<table>
<thead>
<tr>
<th>Item</th>
<th>What You Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>CDR</td>
<td>If you want to search the CDR database for routes to import, click this radio button.</td>
</tr>
<tr>
<td>Playbook</td>
<td>If you want to search the Playbook database for routes to import, click this radio button.</td>
</tr>
<tr>
<td>Pref Routes</td>
<td>If you want to search the Preferred Routes database for routes to import, click this radio button.</td>
</tr>
<tr>
<td>Playbook Play</td>
<td>This text field becomes active if you select the Playbook radio button. You can enter a play or select a play.</td>
</tr>
<tr>
<td></td>
<td>• To open a pick list of available plays, click the down-arrow to the right of the text field. To select a play in the list, click the play.</td>
</tr>
<tr>
<td></td>
<td>• If you type a playbook name, the list scrolls to the play name that most closely matches the text you enter.</td>
</tr>
<tr>
<td></td>
<td>• If you leave the Playbook Play field blank, all plays in the Playbook database will be searched for routes that match the search criteria.</td>
</tr>
<tr>
<td>Origin(s)</td>
<td>Enter a single 3 or 4-character departure airport designator or multiple designators in this field. To enter multiple designators, separate the designators with a space. For example, JFK or BOS JFK.</td>
</tr>
<tr>
<td>Dest(s)</td>
<td>Stands for Destination. Enter a single 3 or 4-character destination airport designator or multiple designators in this field. To enter multiple designators, separate the designators with a space. For example: LAX or LAX SFO.</td>
</tr>
<tr>
<td>Dept. ARTCCs</td>
<td>Stands for Departure ARTCC. Enter a single 3 or 4-character Center code for the ARTCC or multiple Center codes. To enter multiple Center codes, separate the codes with a space.</td>
</tr>
<tr>
<td>Arrive ARTCCs</td>
<td>Stands for Arrival ARTCC. Enter a single 3 or 4-character Center code for the ARTCC or multiple Center codes. To enter multiple Center codes, separate the codes with a space.</td>
</tr>
</tbody>
</table>
The Route Search dialog box remains open so you can copy additional routes if desired. Click **Close** to close the dialog box.
Note: Once a route is copied it will be disabled (grayed out) in the Search Results fields of the Route Search dialog box.

When route segments for plays are added to the Create Reroute Definition route grids, they are added to the bottom of the route grids below any existing route segments. CDR routes are added to the bottom of the Origin Segments grid below any existing route segments. When multiple CDR routes are copied from the Route Search dialog, they are copied in the same order that they appear in the Search Result grid.

**My Routes**

Click the **My Routes** button in the Import Routes From section on the Reroute Definition tab to open the My Routes dialog box.

![My Routes dialog box](image)

The My Routes dialog box provides you with a list of categories and route sets that have been saved for your facility in the Playbook Database, with categories depicted as folders and the route sets depicted as files within each category folder.

Double-click a folder to open it. Click a route name to select it and click **Retrieve Routes** to open the selected route set in the reroute grids of the Create Reroute dialog box and close the My Routes dialog box.

**Note:** Click **Collapse All Nodes** to close all open folders.

When you have saved routes, you can organize saved folders and route sets using the Manage My Routes option on the Create/Edit/View Reroute File menu. See Manage My Routes on page 4-289.

**RMT File**

Click the **RMT File** button in the Import Routes From section to import route definitions that were previously defined and saved to a file using the Route Management Tool (RMT). When the you click the **RMT File** button, the content of the RMT file that was saved using RMT is imported into the Origin Grid.
**Note:** Before pressing this button, the specialist should have used RMT to define the routes that they wish to include in the specification of the reroute.

**Manually Entering Reroute Data**

Entering data in the Create Reroute dialog box is discussed in this section.

The tables on the following pages explain the fields in the three main sections of the **Create Reroute** dialog box.

**Create Public FEA and FCA Reroutes**

You can use the Reroute Definition tab of the Create Reroute dialog box to create a reroute based on a Public FEA or FCA.

1. Select the Public FEA/FCA Flight List radio button on the Create Reroute dialog box.

2. Click on the down arrow in the field below the Public FEA/FCA Flight List button to open a list of available Public FEAs and FCAs as shown in the example below.

3. Click on the appropriate FEA or FCA name to select that FEA or FCA. The Name field auto-fills with the name of the FEA/FCA and the Entry Time fields auto-fill with the From and To time and dates of the FEA/FCA.

4. In the Characteristics section you can change the name of the FEA/FCA based reroute by appending a character string to the FEA/FCA name. This allows you to create multiple reroutes based on the same FEA/FCA.

5. Enter a least one route set manually using the playbook or a saved route.

Fill in the required fields of the Advisory tab. The Name field on the Advisory tab also allows you to change the name of the FEA/FCA-based reroute by appending a character string to the FEA/FCA name. If the name is changed on the Reroute
Definition tab, that name will show on the Advisory tab. If the name is changed on the Advisory tab, that name will show on the Reroute Definition tab.

When a reroute is created that is based on an FCA, the Category field in the Advisory tab is set to FCA and the Action field is set to RQD (Required). You will not be able to edit these fields.

**Identify Flights based on:**

The table below explains the items in the “**Identify Flights based on**” section of the Create Reroute dialog box.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What you do</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ETD/ETA/Public FEA/FCA Flight List</strong></td>
<td>Lets you identify flights based on ETD, ETA, or an active public FEA or FCA.</td>
<td>Click the appropriate radio button to select <strong>ETD, ETA, or Public FCA Flight List</strong>. When you select the <strong>Public FEA/FCA Flight List</strong> radio button on the dialog box and click on the arrow in the text field below the flight list button, a list of Public FEAs and FCAs is displayed. Click on the appropriate Public FEA or FCA name to select it.</td>
</tr>
</tbody>
</table>
| **Start Time** | Required field. Lets you set the Reroute start date/time.  
- If ETD is selected, the Start date defaults to the current date and the Start Time is blank.  
- If ETA is selected, the Start date and time fields are blank,  
- If Public FEA/FCA Flight List is selected, the Start Time date and time fields are disabled (grayed out) | The Start Time field accepts two numeric characters to specify the date and four numeric characters to specify the start time in UTC. You can click in the date and hours/minutes fields to enter the date and time you want. |
Create Reroute: Identify Flights based on (Continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What you do</th>
</tr>
</thead>
</table>
| End Time       | Required field. Designates a time at which you want the route definition to expire.  
• If ETD is selected, the End date defaults to the current date and the End Time is blank.  
• If ETA is selected, the End date and time fields are blank,  
• If Public FEA/FCA Flight List is selected, the End Time date and time fields are disabled (grayed out). | The End Time field accepts two numeric characters to specify the date and four numeric characters to specify the end time in UTC. You can click in the date and hours/minutes fields to enter the date and time you want. |
| Primary Filters | Indicates whether the Primary Filter conditions for the selected FEA/FCA are different from the default filter conditions. If the filter conditions differ, this field displays a checkmark. Otherwise, it displays an X. | This field cannot be edited.                                                                                                                  |
| Entry Time: From| When you select an FEA/FCA from the dropdown list, this field indicates day and time from the Start Time for the selected FEA/FCA. | This field cannot be edited.                                                                                                                  |
| Entry Time: To  | When you select an FEA/FCA from the dropdown list, this field indicates the day and time from the Void Time for the selected FEA/FCA. | This field cannot be edited.                                                                                                                  |
| Flight Status  | Allows you to select all flights or to filter your request by selecting Airborne or Not Airborne. | Click All, Airborne, or Not Airborne to filter the flight list.                                                                                 |
Display Reroute

The Display Reroute section of the Create Reroute dialog box provides the capability to draw a reroute on the TSD map with fixes, navaids, and/or protected segments, and to draw and preview flight counts. If fixes and/or navaids are selected to be drawn, the TSD draws their labels using the color of the reroute at the same location where they are drawn using the Show Reroute function. Where the reroute overlaps with an existing reroute that is being shown, the labels for the reroute being created, edited, or viewed will be drawn on top of the shown reroute labels.

The Display Reroute section also shows the total count of flights being previewed.

Create Reroute: Display Reroute

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What You Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show: Fixes</td>
<td>Displays the fixes along the drawn reroute.</td>
<td>To display fixes, click in the <strong>Show Fixes</strong> checkbox.</td>
</tr>
<tr>
<td>Show: Navaids</td>
<td>Displays the navaids along the drawn reroute.</td>
<td>To display navaids, click in the <strong>Show Navaids</strong> checkbox.</td>
</tr>
<tr>
<td>Show: Protected</td>
<td>Displays protected segments for the drawn, previewed, or modeled reroute.</td>
<td>To display protected segments, click the <strong>Protected Segments</strong> checkbox.</td>
</tr>
<tr>
<td>Segments</td>
<td></td>
<td>If you click this checkbox, the TSD draws the protected portion of a reroute segment using a slate blue color. The protected portion of the reroute is drawn with the same line style as the non-protected portion. The line segments are drawn using a solid line of 4 pixel width.</td>
</tr>
</tbody>
</table>

Note: This checkbox applies only to the display of protected segments on the TSD map. Note that if a reroute segment is unchecked in the route grid and therefore not included in the reroute definition, the TSD draws both protected and non-protected segments in gray.

For information on defining protected segments, see Protected Segments on page 4-309.
### Create Reroute: Display Reroute (Continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What You Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draw</td>
<td>This button becomes active after you define a reroute set. Lets you draw the reroute on the map. When you use the Draw function, no flight counts display. Note that the Draw button is disabled in Modeling Mode.</td>
<td>After you have defined a reroute set, click <strong>Draw</strong>. If the reroute set is validated, the TSD draws the reroute and the button label changes to Erase. Click <strong>Erase</strong> to remove the reroute from the map. If you edit the reroute definition, the Draw button color turns red and the label displays as Redraw. To update the TSD map with the revised reroute set, click <strong>Redraw</strong>. For more information on the drawn reroute, see Previewing the Reroute on page 4-339 in the Reroute Impact Assessment section of Chapter 4.</td>
</tr>
<tr>
<td>Preview</td>
<td>This button becomes active after you define a reroute set. Lets you draw the reroute on the map and preview flight counts. Note that the Preview button is disabled in Modeling Mode.</td>
<td>After you have defined a reroute set, click <strong>Preview</strong>. If the reroute set is validated, the TSD draws the reroute and allows you to preview flight counts. After you select Preview, the label on the Draw button changes to Erase. To remove the reroute and flight counts from the map, click <strong>Erase</strong>. If you edit the reroute definition, the Preview button color turns red and the label on the Draw button turns to Redraw. To update the TSD map with the revised reroute set, click <strong>Preview</strong> again. For more information on the Preview mode, see Previewing the Reroute on page 4-339 in the Reroute Impact Assessment section of Chapter 4.</td>
</tr>
<tr>
<td>Flight Count</td>
<td>Displays the total number of flights affected by the reroute. A flight count displays when the reroute is previewed or modeled.</td>
<td>This field cannot be edited.</td>
</tr>
</tbody>
</table>
Protected Segments

When creating a reroute, you may define a segment of an assigned route as "protected" in order to prevent enroute controllers from making casual changes to the segment and prevent changes to the segment from being made automatically by ERAM. You define protected segments for explicit route segments only, that is, segments that consist of specific fixes and routes.

You can view the protected portions of a reroute when you draw, preview, or model the reroute if you check the Protected Segments checkbox in the Display Reroute section of the Reroute Definition tab. The Protected Segments check box is used only for display purposes on the TSD.

The TSD uses the same 4 pixel line style as it does when drawing the non-protected portion. In the following example, the reroute and its protected segments are displayed in Draw mode.

Protected segment "indicators" specify the portion that should be followed carefully in order to achieve the reroute TMI goal and are defined in the route grid using the greater-than symbol, ">" and the less-than symbol, "<". The beginning of a protected segment in a route segment is indicated by a ">" symbol placed immediately to the left of a fix or airport and the end of the protected segment is indicated by a "<" symbol placed immediately to the right of a fix or airport. You can define only one continuous portion of a reroute segment as a protected segment.

If protected segment indicators were previously defined for a route segment you retrieve, the system displays the protected segment indicators in the grid as defined. If you manually type in a route segment and do not indicate any protected segments, the system displays protected segment indicators at the beginning and end of the entire route segment as soon as you move focus out of the route grid cell.
If you import a route segment from a database such as Playbook or Coded Departure Route (CDR) and no protected segments have been defined, the system automatically displays the protected segment indicators at the beginning and end of the entire route segment after the segment is retrieved. You can manually delete existing indicators and reposition them in the route string as needed. The following example shows full routes with protected segment indicators at the beginning and end.

<table>
<thead>
<tr>
<th>#</th>
<th>Origin(s)</th>
<th>Filter</th>
<th>Type</th>
<th>Route</th>
<th>Full Destination(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ZBL</td>
<td></td>
<td></td>
<td>JFK J77 SPA J6 COL MS J54 BHM J39 F11 J8 GOP J96 BAC J223</td>
<td>JFK</td>
</tr>
<tr>
<td>2</td>
<td>ZBL</td>
<td></td>
<td></td>
<td>JFK J77 SPA J6 COL MS J54 BHM J39 F11 J8 GOP J96 BAC J223</td>
<td>JFK</td>
</tr>
<tr>
<td>3</td>
<td>ZNY</td>
<td></td>
<td></td>
<td>JFK J6 COL MS J54 BHM J110 RSK J64 PPS TYS M2 &lt;</td>
<td>JFK</td>
</tr>
<tr>
<td>4</td>
<td>ZNY</td>
<td></td>
<td></td>
<td>JFK J6 COL MS J54 BHM J110 RSK J64 PPS TYS M2 &lt;</td>
<td>JFK</td>
</tr>
<tr>
<td>5</td>
<td>PHL</td>
<td></td>
<td></td>
<td>JFK J6 COL MS J54 BHM J110 RSK J64 PPS TYS M2 &lt;</td>
<td>JFK</td>
</tr>
<tr>
<td>6</td>
<td>ZBC</td>
<td></td>
<td></td>
<td>JFK J6 COL MS J54 BHM J110 RSK J64 PPS TYS M2 &lt;</td>
<td>JFK</td>
</tr>
<tr>
<td>7</td>
<td>ZBC</td>
<td></td>
<td></td>
<td>JFK J6 COL MS J54 BHM J110 RSK J64 PPS TYS M2 &lt;</td>
<td>JFK</td>
</tr>
</tbody>
</table>

When parsing and validating route segments, the system displays validation errors for protected segments in the standard way. Error messages indicate the total number of all types of validation errors and the text of each error. Cells in the route grid that contain a route segment with protected segment errors display with a red background.
## Characteristics

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What you do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Required field. User-specified name for the reroute. By default, the name of the route appears as a label on the display. Maximum of 64 characters. <strong>Note:</strong> Reroute Names are restricted to alphanumeric, dash, and underscore characters. Spaces and other special characters are not allowed.</td>
<td>Click in the Name field and enter a route name, preferably one that relates to the reroute definition.</td>
</tr>
<tr>
<td>Domain</td>
<td>Defines the domain: Private, Local, Shared, Public. All users can create local and private domains. Only users at designated sites, ATCSCC for example, can create public reroutes.</td>
<td>Click the appropriate button to designate the reroute domain.</td>
</tr>
</tbody>
</table>
| Monitor Reroute checkbox | If checked, the system generates a Reroute Dynamic list for the Local or Shared reroute you are creating and allows you to select that reroute for viewing on the Reroute Monitor.  
- If you are creating a Public reroute, this checkbox is automatically checked and disabled (grayed out).  
- If you are creating a reroute with a domain of Private, this checkbox is unchecked and disabled. | To generate a reroute Dynamic List for a Local or Shared reroute, click this checkbox. |
Route Grids

The lower section of the Create Reroute dialog box is occupied by two grids, one for the Origin segment and one for the Destination segment of the route. When you first open the Create Reroute dialog box, each grid has 20 empty rows by default. Whether you import or manually define your routes, the reroute detail appears in these grids.

When routes are added to the route grids by any method, the TSD vertically scrolls the route grids so that the bottom-most portion of the list is displayed. There is always at least one empty row at the bottom of the route grids. If needed, you can manually add a route segment below existing route segments.

**Note:** The Edit Reroute dialog box is similar to the Create Reroute dialog box but when you open it (from Select Reroutes) the route grid is filled with the information from the selected reroute.

- You can change the relative height of the origin and destination sections of the route grid using the window pane feature. To use this feature, position the pointer on the line between the origin and destination segments. The pointer changes to a cross. Press the left mouse button to change the height of the two window panes.
- You can resize any column in the grids except for the row number column and the columns that contain checkboxes. To resize a column position the cursor on the right border of the column to be resized and drag the resize handle to the right or left.
- If you click in a column that is not completely visible, the grid will scroll horizontally to make the selected column visible.
- You can copy and paste all or a portion of a route segment from one row to another row in the route grid.

To copy and paste:

1. Highlight the portion of the route that you want to copy.

   Press `<Ctrl><Insert>` or `<Ctrl> C`. 
2. Click on the row that you wish to paste into and position the cursor at the location where the route is to be pasted.

Press <Shift><Insert> or <Ctrl> V.

The following table describes the fields of the upper Origins grid. An asterisk (*) appears next to fields in the Items column that are common to the lower part of the grid, Destination Segments for Split Routes, which is described on page 4-319.

**Create Reroute: Route Grids**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What you do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Row Label *</td>
<td>A system-generated numeric row label.</td>
<td>Click on a row label to select the row.</td>
</tr>
<tr>
<td>Include/Exclude*</td>
<td>This checkbox is automatically checked when you import a route into a row or manually enter a route in a blank row. If a check displays in this checkbox, the segment is included in the reroute definition.</td>
<td>Click the checkbox to include or exclude the segment from the reroute definition. If you hover the cursor over the check mark symbol heading the column, a tool tip displays: “Check button to include route in the reroute definition.”</td>
</tr>
<tr>
<td># *</td>
<td>Displays a count of the flights associated with the route segment.</td>
<td>Display-only. You can hover the pointer over the column header field for a tool tip displays: “Total number of affected flights.”.</td>
</tr>
<tr>
<td>Origin(s)</td>
<td>Departure airport or center.</td>
<td>Enter one or multiple three- or four-character departure airport designator(s), up to 128 characters. Example: JFK or KJFK. You can hover the pointer over the columns header field for a tool tip displays: “Airports and/or Centers, or keyword UNKN”.</td>
</tr>
<tr>
<td>Filter</td>
<td>Each row in the Filter field includes a blank button to its left that displays a Flight Filters dialog box.</td>
<td>Click the button to the left of the Filter field row to open the Flight Filters dialog box for that field. See Flight Filters on page 4-316 for more information. You can hover the pointer over the column header field for a tool tip displays: “Press button to bring up a Flight Filters dialog.”</td>
</tr>
<tr>
<td>Type</td>
<td>Lets you select the type of route from: CDR RTE, RERTE, UNKN RTE, UPT RTE or NONE (indicated by a blank entry). NONE is the default type.</td>
<td>Click the Type dropdown list and click the route type from the list.</td>
</tr>
</tbody>
</table>
Create Reroute: Route Grids (Continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What you do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Route *</td>
<td>Lets you enter the route information. If a type other than None is selected, you can enter any text in the Route field. The text will not be validated.</td>
<td>Enter route elements in this field, with a space between each element up to 256 characters. You can enter multiple route elements in this field. Select the search criteria to be associated with the route elements. See Destination Segments for Split Routes on page 4-319 for additional information.</td>
</tr>
<tr>
<td>Full</td>
<td>Indicates whether the route is complete or split. Lets you change a split route to a route that is complete from origin to destination.</td>
<td>Click in the Full column to display a check. The column is enabled only if Destination field is empty. See Full Column on page 4-318 for more information.</td>
</tr>
<tr>
<td>Destinations (Origin [upper] Route Grid)</td>
<td>Arrival airport or center.</td>
<td>Enter a three-or four-character destination airport designator. Examples: LAX or KLAX.</td>
</tr>
</tbody>
</table>

Route Grid Right-Click Menu

To access the right-click menu on the route grid, select a row by left-clicking while the pointer is over a row label and then right-click. You can also access the right-click menu by right-clicking anywhere on a row that has already been selected. The right-click menu provides the following options:

- **Insert**
  The Insert option allows you to insert one or more blank rows into the reroute grid. To insert rows, select the same number of rows that you want to insert and select the Insert option from the right-click menu. The rows you select should be adjacent to one another. The TSD inserts row(s) above the row(s) that you have selected.

- **Delete**
  The Delete option allows you to delete a selected row or rows from the grid.

- **Ungroup**
  The Ungroup option allows you to display multiple rows for a single reroute segment with multiple origins or destinations. If you select a reroute segment with more than one origin or destination and select the Ungroup option, the TSD displays a separate row for each origin or destination of the segment. For example, if a row has two origins, the TSD will insert an additional row into the grid for that segment's second origin. After ungrouping a row, you can take different actions on each of the separated origins and destinations.
• **Edit/Replace**
  The Edit/Replace option opens the Edit/Replace Route Text dialog box and allows you to edit or replace route string text for selected route segments or all route segments containing a specified route string. For more information, see page 4-291.

**Include/Exclude Column**

The Include/Exclude column in the reroute grids consists of checkboxes that you can toggle to include or exclude a route segment from the reroute definition. Toggling the Include/Exclude checkboxes automatically updates the total flight count displayed on the Reroute Definition and Flight List tabs.

If you are in Model mode, toggling the Include/Exclude checkboxes causes the TSD to display indicators that model results are out of date.

For more information on Model Mode, see Modeling a Reroute on page 4-369 in the Reroute Impact Assessment section of Chapter 4.

**Sorting the Grid**

You can sort information in the route grid by Origin, Route, or Destination. When the route grid is sorted by one of these methods, the TSD displays an upward pointing arrow in the column label to indicate the primary sort column. However, if a row is added by any method, for example, if a row is manually inserted or if a row is inserted through the Ungroup function, the TSD removes the sort order indicator. To re-sort the grid, click the column header.

• When the origin segments are sorted by the origin, the segments are sorted by the departure center then by the origin airport.

• When the segments are sorted by destination, they are sorted by the arrival center then by the arrival airport.

**Note:** The sort order in the route grid is always ascending; there is no descending sort option.
Flight Filters

The Filter field in the Create Reroute route grid defines the criteria to be used to filter flights in a particular route. Click the checkbox next to the Filter field on a route row of the Create Reroute route grid to open the Flight Filters dialog box.

**Note:** If a Center is displayed in the Origin field on the Create Reroute dialog box it will appear on the Flight Filter dialog box title bar.
If you change any of the filters in the dialog box, the TSD summarizes the defined filter(s) in the Filter text field in the Create Reroute dialog box. The purpose of the Filter text field is to provide a visual indication that a filter is defined for the route and to provide a summary of the filter that is defined.

The following table describes the fields in the Flight Filters dialog box.

**Flight Filters**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>do not depart from</td>
<td>Limits the selection to flights that do not depart from the specified airports. You can enter one or more airport designators, up to 64 characters. Default is blank.</td>
</tr>
<tr>
<td>do not arrive at</td>
<td>Limits the selection to flights that do not arrive at the specified airports. You can enter one or more airport designators, up to 64 characters. Default is blank.</td>
</tr>
<tr>
<td>are through</td>
<td>Limits the selection to flights that fly through the specified ARTCC. You can enter one ARTCC designator.</td>
</tr>
<tr>
<td>do use airway</td>
<td>Limits the selection to flights that use any of the specified airways. Enter one or more airway designators (Jet, Victor, Oceanic, or other type of route), up to 64 characters. Default is blank.</td>
</tr>
<tr>
<td>do use fix</td>
<td>Limits the selection to flights that use any of the specified fixes. You can enter one or more fix designators, up to 64 characters. Default is blank.</td>
</tr>
<tr>
<td>are aircraft type</td>
<td>Limits the selection to flights of specified aircraft types. You can enter one or more aircraft type designators, up to 64 characters. The default is blank.</td>
</tr>
<tr>
<td>Flight Level</td>
<td>Limits the selection to flights whose filed altitude is between the lowest and highest flight levels inclusive. Enter a flight altitude specified in hundreds of feet. You can enter only one entry in each field. The maximum entry in this field is 600. The minimum entry is 000.</td>
</tr>
<tr>
<td>Lowest/Highest</td>
<td></td>
</tr>
<tr>
<td>Aircraft Category</td>
<td>Limits the selection to flights that have an aircraft category that matches one of the specified categories. Default is Jet.</td>
</tr>
<tr>
<td>Weight Class</td>
<td>Limits the selection to flights that have a weight class that matches one of the selected categories. Default is all categories selected.</td>
</tr>
<tr>
<td>User Category</td>
<td>Limits the selection to flights that have a user category that matches one of the selected categories. Default is all categories except for Military selected.</td>
</tr>
<tr>
<td>RVSM Status</td>
<td>Limits the selection to All Flights, flights that are RVSM conformant, or flights that are RVSM non-conformant.</td>
</tr>
</tbody>
</table>
**Flight Filters (Continued)**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Type</td>
<td>Contains three options: No Filter, Departure, and Arrival. No Filter is the default and indicates that no filtering is required for this field. Departure and Arrival Time fields limit the selection to flights that depart or arrive within the specified time period.</td>
</tr>
<tr>
<td>Start/End</td>
<td>Enter two numeric characters to specify the day and four numeric characters to specify the start time in UTC.</td>
</tr>
<tr>
<td>Segment Remarks</td>
<td>Lets the specialist associate remarks with each origin segment. A free-form text field allowing up to 128 characters.</td>
</tr>
</tbody>
</table>

Pictured below is route grid that contains flight filters in the Filter column for a reroute segment.

![Route Grid](image)

**Full Column**

The **Full** column indicates the status of the destination segment of the route. If the route has an airport listed in the Destination field, the Full checkbox is checked and disabled (grayed out). The Full checkbox is enabled when the destination information has been deleted or is left empty in manually entered routes, allowing you to create a split route. When you import or enter a split route the destination segment of the route appears in the lower grid. See Destination Segments for Split Routes (page 4-319).
Destination Segments for Split Routes

Route definitions can consist of routes that have been split into origin and destination segments, with the routes split at a point that is common to each route. In the following example, the route is split at the common point, in this case MGM.

Origin: **ZME MEI J4 MGM**

Destination: **MGM MGM048138 GRD J209 RDU J207 FKN J79 JFK ORW2 BOS**

The following is an example of how a split reroute set appears on the route grids.
Reroute Analysis Tab

The Reroute Analysis tab provides a summary of the impact of the reroute on flights and sector alerts and is only available in Reroute Modeling.

For more information, see Reroute Analysis Tab on page 4-374 in the Reroute Impact Assessment section of Chapter 4.

Flight List Tab

Using Flight List Tab in Normal Mode

The Flight List tab displays a list of the flights and assigned routes associated with the reroute segments specified on the Reroute Definition tab. The Flight List Tab, as it appears before you request a flight list, is shown below.
To populate the flight list grid with flight data, click Create Flight List. The populated flight list is shown below. Note that the Create Flight List button now displays Update Flight List.

For more information on using the Flight List Tab in Preview and Model modes, see Using the Flight List Tab in Model Mode on page 4-358 in the Reroute Impact Assessment section of Chapter 4.
**Shared Sites Tab**

If you are defining a reroute set with a domain of Shared, the Shared Sites tab becomes active. If any other domain is selected, the Shared Sites tab is disabled (grayed out). Click the **Shared Sites** tab to enter the TFMS sites with which you want to share a reroute definition and model results.

This is an example of the Shared Sites tab.

![Shared Sites Tab Example](image)

For more information, see Shared Sites Tab on page 4-427 in the Reroute Impact Assessment section of Chapter 4.
Restrictions Tab

The Restrictions tab allows you to enter, edit, and/or view Miles-in-Trail (MIT) restrictions for a reroute, and, if available, displays model data on the MIT and impacted flights. Clicking the **Create/Edit Reroute Restrictions** tab, displays the following dialog box:

![Create Reroute Restrictions Dialog Box](image)

**Note:** MIT Restrictions are a modeling function.

For more information, see Miles In Trail (MIT) Restrictions on page 4-391 of the Reroute Impact Assessment section of Chapter 4.
Advisory Tab

Authorized users who are creating a Public reroute and sending an advisory or general message must fill in the required fields on the Advisory tab of the Create Reroute dialog box, shown below. Required fields are indicated with an asterisk.

**Note:** The Advisory tab can also be filled in for a private, local or shared reroute, if you want to begin constructing the advisory text before making the reroute public. However, an advisory will be sent only if the reroute is public.

Using the Create Reroute Advisory Tab

After you select a Play from one of the Playbook categories on the Reroute Definition tab some fields on the Advisory tab automatically fill in and some need input. You can edit the Include Traffic and Facilities Included fields manually or you can edit the fields automatically by clicking **Auto Fill**. The Auto Fill feature for the Facilities Included field will fill in the field with a string constructed by concatenating the center codes for all centers that are traversed by reroute segments included in the reroute definition. The fields that have arrows open a drop-down list from which you can select the appropriate entry.

When you create a reroute based on an FCA, the Category field in the Advisory tab is forced to FCA, and the Action field is forced to RQD (Required). These fields cannot be edited. When you create a reroute based on a Public FEA, the Category field in the
Advisory tab defaults to FEA, and the Action field defaults to RMD (Recommended). You can edit these fields with one exception: you cannot change the Action field to RQD.

**Auto Fill**

After you select a Play from one of the Playbook categories on the Reroute Definition tab some fields on the Advisory tab automatically fill in and some need input. You can respond to the Include Traffic and Facilities Included fields manually or you can respond to the fields automatically by clicking **Auto Fill**. The Auto Fill feature for the Facilities Included field will fill in the field with a string constructed by concatenating the center codes for all centers that are traversed by reroute segments included in the reroute definition. The fields that have arrows open a drop-down list from which you can select the appropriate entry.

**Email Options**

After you create the reroute set and fill out the required fields in the Advisory section, you can use the email function to send the reroute set as an advisory or general message.

**Note:** The Address is a required field if the advisory is to be sent when the reroute is created.
**Preview Advisory**

Use the Preview Advisory button to preview the reroute advisory in email format. Clicking the **Preview Advisory** button opens the Preview Advisory information box.

*Note:* The Preview Advisory function does not assign a number to the reroute advisory.

---

### Preview Advisory

<table>
<thead>
<tr>
<th>ORG</th>
<th>DEST</th>
<th>ROUTE</th>
</tr>
</thead>
<tbody>
<tr>
<td>KB05</td>
<td>KLAX</td>
<td>KB05 GLYDE BAF J77 SAK XJ77</td>
</tr>
<tr>
<td>KB05</td>
<td>KLAX</td>
<td>KB05 GLYDE BAF J77 SAK XJ77</td>
</tr>
<tr>
<td>KB05</td>
<td>KLAX</td>
<td>KB05 GLYDE BAF J77 SAK XJ77</td>
</tr>
<tr>
<td>KB05</td>
<td>KLAX</td>
<td>KB05 GLYDE BAF J77 SAK XJ77</td>
</tr>
<tr>
<td>KB05</td>
<td>KLAX</td>
<td>KB05 GLYDE BAF J77 SAK XJ77</td>
</tr>
<tr>
<td>KB05</td>
<td>KLAX</td>
<td>KB05 GLYDE BAF J77 SAK XJ77</td>
</tr>
<tr>
<td>KB05</td>
<td>KLAX</td>
<td>KB05 GLYDE BAF J77 SAK XJ77</td>
</tr>
<tr>
<td>KB05</td>
<td>KLAX</td>
<td>KB05 GLYDE BAF J77 SAK XJ77</td>
</tr>
<tr>
<td>KB05</td>
<td>KLAX</td>
<td>KB05 GLYDE BAF J77 SAK XJ77</td>
</tr>
<tr>
<td>KB05</td>
<td>KLAX</td>
<td>KB05 GLYDE BAF J77 SAK XJ77</td>
</tr>
<tr>
<td>KB05</td>
<td>KLAX</td>
<td>KB05 GLYDE BAF J77 SAK XJ77</td>
</tr>
</tbody>
</table>

---

![Close button](image)
### Preferences Command

The **Preferences** command enables you to define your preferences for creating and displaying reroutes.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Reroute menu by clicking <strong>Reroute</strong> on the TSD Main Menu or pressing <strong>&lt;Alt&gt; R</strong>.</td>
<td></td>
</tr>
<tr>
<td>2. Click <strong>Preferences</strong> or Press <strong>P</strong>.</td>
<td>None</td>
</tr>
</tbody>
</table>

#### Semicolon Method

None
Reroute Preferences Dialog Box

After you select Preferences from the Reroute menu, the Reroute Preferences dialog box opens. The Reroute Preferences dialog box has two tab options: Columns and Sort. The following graphic shows the Reroute Preferences dialog box with the Columns tab selected:
The following graphic shows the Reroute Preferences dialog box with the Sort tab selected:
The following table explains the fields and buttons within the Reroute Preferences dialog box.

### Reroute Preferences dialog box

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What You Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Sort Order in Select Reroutes: Name End Time</td>
<td>Allows you to select either <strong>Name</strong> or <strong>End Time</strong> as the default sort order in the Select Reroute dialog box.</td>
<td>Click either the <strong>Name</strong> or the <strong>End Time</strong> radio button to select the default sort order for the Select Reroutes dialog box.</td>
</tr>
<tr>
<td>Color</td>
<td>Lets you determine the color for each reroute. Opens a color palette with 36 available colors.</td>
<td>Click the button to display a color palette. Click your choice or color for the reroute.</td>
</tr>
</tbody>
</table>

#### Flight Lists

<table>
<thead>
<tr>
<th>Reroute Flight List Tab</th>
<th>Allows you to define default columns and sort options for the Reroute Flight List in the Create Reroute, Edit Reroute and View Reroute dialog boxes.</th>
<th>Click the radio button to display columns and sort options for Reroute Flight List.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point of Interest</td>
<td>In the Columns and Sort tabs, displays a list of options in Available Columns list, and Sort By list, including Point of Interest Time, specific to Point of Interest flight lists.</td>
<td>Click the radio button to display columns and sort options for Point of Interest Flight List.</td>
</tr>
<tr>
<td>MIT (Miles-in-Trail)</td>
<td>In the Columns and Sort tabs, displays a list of options that are available in Available Columns list, and Sort By list, including Crossing Time with MIT and Estimated MIT Delay, specific to MIT flight lists.</td>
<td>Click the radio button to display columns and sort options for MIT Flight List.</td>
</tr>
</tbody>
</table>
### Reroute Preferences dialog box (Continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What You Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column Tab</td>
<td>Lets you select default columns for the Flight List tab of the Create Reroute command, depending on the Flight Lists radio button selected.</td>
<td>Click <strong>Columns</strong> if the tab is not already open. To move a column name to the Selected Columns list, click on the column name in Available Columns list and then click <strong>Add</strong>. To move a column name out of the Selected Columns list, click on the column name and then click <strong>Remove</strong>. To move the selected column names up and down within the list of Selected Columns, select the name and then click <strong>Move Up</strong> or <strong>Move Down</strong>.</td>
</tr>
<tr>
<td></td>
<td>• If <strong>Reroute Flight List Tab</strong> is selected, the functionality of this tab is similar to the Customize Columns dialog box accessed through the Flight List tab of Create Reroute.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• If <strong>Point of Interest</strong> is selected, the list of columns includes <strong>Point of Interest Time</strong>.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• If <strong>MIT</strong> is selected, the list of columns includes <strong>Crossing Time with MIT</strong> and <strong>Estimated MIT Delay</strong>.</td>
<td></td>
</tr>
<tr>
<td>Sort Tab</td>
<td>Lets you select default sort options for primary, secondary, and tertiary sorts. The functionality of this tab is similar to the Advanced Sort dialog box accessed through the Flight List tab of Create Reroute. The sort options are determined by the selection made in the Flight Lists section: Reroute Flight List Tab, Point of Interest, or MIT.</td>
<td>Click <strong>Sort</strong> to open the Sort tab. Select a column header from the drop-down list and then click the <strong>Ascending</strong> or <strong>Descending</strong> radio button.</td>
</tr>
<tr>
<td>Show Current Route</td>
<td>Lets you specify whether you want both the current and assigned reroute(s) or the assigned route(s) only to display on the flight list.</td>
<td>Check this option to display both the current and assigned route text. If you leave this option unchecked, the TSD displays only the assigned route text.</td>
</tr>
</tbody>
</table>
### Reroute Preferences dialog box (Continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What You Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Assigned Route:</td>
<td>Lets you specify whether the assigned or modeled route text displays on the Flight List.</td>
<td>Click the <strong>Segments</strong> radio button to display assigned route text.</td>
</tr>
<tr>
<td>* Segments</td>
<td></td>
<td>Click the <strong>End-to-End Route</strong> radio button to display modeled reroute text.</td>
</tr>
<tr>
<td>* End-to-End Route</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:** For more information on the columns available for the Reroute Flight List, POI Flight List and MIT Flight List, see Customize Columns for Reroute Flight Lists on page 4-362.

For more information on the sort options for the Reroute Flight List, POI Flight List, and MIT Flight List, see Advanced Sort for Reroute Flight Lists on page 4-359 in the Reroute Impact Assessment section of Chapter 4.

When you finish using the Reroutes Preferences dialog box and click **OK**, your preferences are saved and will be the new defaults on the Create Reroute dialog box the next time you select it.

**File Menu**

You can use the File menu options to recall, save, and delete adaptation files that define your default preferences.
Reroute Menu: Reroute Impact Assessment

Overview

The Reroute Impact Assessment (RRIA) features of the TSD provide tools to support traffic flow management decision making when the current NAS state presents the need for the coordinated rerouting of flights. Using data on current NAS conditions, the TSD simulates the state of the NAS with the proposed reroute. RRIA features allow you to create, share, model and assess the impact of a proposed reroute; create and evaluate the impact of Miles-in-Trail Restrictions; and modify the reroute, if needed, before issuing.

The use of Reroute commands in Normal mode are discussed in Chapter 4, Reroute Menu, beginning on page 4-203.

This section is divided into the following topics.

- **Introduction**
  
  This section provides a general description of the topics covered in Reroute Impact Assessment.
• **Previewing a Reroute**  
  This section discusses how to use Draw and Preview mode to preview the proposed reroute on the TSD. It introduces the function of the Flight List Tab and other TSD enhancements.

• **Modeling a Reroute**  
  This section discusses all aspects of using the TSD in Model mode, including the functionality of the Reroute Definition, Reroute Analysis, Flight List Shared Sites, Restrictions and Advisory tabs of the Create/Edit/View dialog box. Also, this section discusses using the Select Reroutes, NAS Monitor, and Examine FEA/FCA functions in Model mode.

  - **NAS Monitor in Model Mode**  
    This section discusses the effect of Model mode on using the NAS Monitor and the NAS Monitor Bar Chart while in Model Mode.

  - **Examine FEA/FCA in Model Mode**  
    This section discusses the effect of Model mode on using the Examine FEA/FCA command, including the FEA/FCA Timeline and the FEA/FCA Bar Chart, while in Model Mode.

• **Sharing a Reroute**  
  This section discusses how to use the Shared Sites tab of the Create/Edit Reroute dialog box.

• **Select Reroutes**  
  This section reviews the Select Reroutes dialog box functionality that involves Reroute Modeling.
Introduction To RRIA

The previous section, Reroute Menu, covers how to use Reroute functions in Normal Mode. This section covers Reroute Impact Assessment (RRIA) which allows you to view reroutes and their impact on the NAS in Preview mode and Model mode. Many of the functions and options detailed in the previous section can be used in Normal, Preview, and Model modes. Some functions and options are more likely to be used in Preview and Model modes so they are briefly described in the previous section and fully described in this chapter.

In Reroute Preview mode, you can see how many flights would be affected by a proposed reroute and how those flight counts would be affected by modifications to the proposed reroute.

In Reroute Model mode, the TSD displays the projected state of the NAS, taking into account the impact of a proposed reroute. The model data displays the projected state of the NAS based on its state at the time the model results were generated. With the exception of weather data and the current time, the TSD displays static flight data as of the time modeling was generated and does not dynamically update when it is in Model mode. The Model button at the bottom of the Create, Edit, or View Reroute dialog boxes enables you to request modeling and see the projection of the newly defined or edited reroute on the TSD map.

**Note:** When the TSD is switched from Normal mode to Model mode, the TSD saves the current adaptation state of the TSD. This action is the equivalent of issuing the Display/Adapt/Save command on the TSD. The original state is restored when the TSD is switched back into Normal mode.

Reroute Definition

The first step is to define a draft reroute on which to base the model. After the need for a reroute has been established, use the Create Reroute command, the Edit Reroute function or the Copy Reroute function to define a proposed reroute. Chapter 4, Reroute Menu provides detailed information on how to use the Reroute commands to define a reroute in Normal mode. Some functions touched on in Reroute Menu are used more in Preview and Model modes, and are discussed in detail in this chapter.

The Create/Edit Reroute dialog box tabs provide flexible, user-friendly functions that streamline the process. These features allow you to define and adjust the reroute, experiment with a variety of reroute options, and get a quick idea of how many flights will be affected before modeling the draft reroute and studying model results.
You can define a reroute using the Select Reroute dialog box to copy or edit an existing reroute or you can create a reroute “from scratch” using the Create Reroute command. Look in Chapter 4, Reroute Menu for the following topics:

- For information on using the Select Reroute command, see page 4-209.
- For information on using the Create Reroute command, see page 4-282.
- For information on using the Edit Reroute function, see page 4-215.
- For information on using the Copy Reroute command, see page 4-218.

The following Create/Edit Reroute dialog box functions are commonly used to define a reroute that will be previewed or modeled.

- **Using Playbook to View Prospective Plays**
  
  To assist you in deciding which play or plays are most appropriate for a particular traffic situation, the Playbook function of the Create Reroute dialog box allows you to view the route(s) of prospective plays in system-generated colors on the map before importing them.

  For information on using the Playbook Function, see page 4-296 in the Reroute Menu section of Chapter 4.

- **Edit/Replace Route Text**

  After establishing a draft set of plays in the route grid of the Reroute Definition Tab, the Edit/Replace Reroute Text function allows you to edit or replace route string text and tailor the routes as needed.

  For information on accessing and using the Edit/Replace Route Text function, see page 4-291 in the Reroute Menu section of Chapter 4.

- **Revert to Earlier Reroute Definition**

  The Revert to Earlier Reroute Definition option allows you to undo changes made to a reroute definition and return to a previously saved version.

  For information on accessing and using the Revert to Earlier Reroute function, see page 4-290 in the Reroute Menu section of Chapter 4.
Draw and Preview Functions
After defining a draft reroute, you can use the Draw function to display the proposed route segments on the TSD map or you can use the Preview function to preview the reroute by drawing it with flight counts.

For more information on using the Draw function, see Draw a Reroute on page 4-339.

For more information on Preview mode, see Preview a Reroute on page 4-342.

Reroute Modeling
The next step is to model the reroute. After you request modeling, the TSD provides clear indicators to remind you that you are operating in Model mode. As you revise the draft reroute trying different variations, the TSD reminds you to remodel and update model results with each change.

The modeling results viewed on the Reroute Analysis tab, based on a snapshot taken of the NAS when modeling was requested, show information such as the average increased flying time and distance of flights and the effect of the reroute on each Center. The Flight List tab allows you to view the effect of the reroute on flying time and distance of individual flights. While modeling the reroute you can open the NAS Monitor in Model mode and view how the reroute will impact the demand on a particular sector. To view the effects on any FEAs or FCAs that were created, you can open the FEA/FCA Timeline in Model mode. You can also model the impact of replacing one or more required public reroutes with the reroute you are creating.

The following Create/Edit Reroute dialog box functions are commonly used when you are working in Model mode.

- **Miles-in-Trail (MIT)**
  To further support traffic flow management decision making and the management of flights in an airspace, the RRIA features include the capability to create Miles-in-Trail (MIT) restrictions for a reroute when the need arises. After a restriction is created and the reroute is modeled or remodeled, you can view the drawn restriction and its model results. A right-click menu accessed while browsing a restriction includes the option to open an MIT Flight List. When viewing model data for a proposed reroute you can choose to include or exclude the impact of any MIT Restrictions.

  For more information on MIT Restrictions, see page 4-391.

- **Point Of Interest (POI) Flight List**
  The Point of Interest (POI) Flight List option lets you view the flights that are predicted to pass over a POI on a selected route segment. You can access this option from the right-click menu while browsing a reroute in Preview or Model mode.

  For more information on using the POI Flight List, see page 4-384
• Shared Sites Tab

To enable collaboration between the Command Center and the Centers involved with a reroute, the Shared Sites tab of the Create Reroute dialog box allows you to specify the sites with which you want to share a reroute definition. After the reroute has been shared, the Select Reroutes command allows designated sites to access a reroute, select the Edit and View Reroute functions, and study model data, if available, for the reroute.

For more information on using the Shared Sites Tab, see page 4-427.

A reroute is revised, remodeled, and redistributed as necessary until a decision is reached on the version of the reroute that will be issued. A copy of the reroute that has been generated by the Command Center may also be created, modified, and modeled, as part of this process. The Copy Reroute option allows you to issue a copy of a public reroute as a replacement for the original.

After collaboration is finished and/or final revisions are made, you send, share, or save a reroute depending on the selected domain. The Create Reroute dialog box provides a Save button for reroutes with a domain of Private or Local. A Share button shows for Shared reroutes. If you want to issue a Public reroute after collaborating with selected sites, change the domain of the reroute from Shared to Public, fill out the Advisory tab, and click the Send button to issue the reroute.

If, after monitoring a reroute, you find that the reroute is not meeting its objective, you can repeat the process of drafting, modifying, modeling, redistributing, and collaborating before issuing a revised reroute.

The RRIA features that support traffic management decision making also include the capability to model the impact of cancelling a reroute.
Previewing a Reroute

The Preview function lets you see how many flights would be affected by a proposed reroute in Preview mode and how those flight counts would be affected by modifications to the proposed reroute.

Note: Some of the functions and options available in Preview mode are also available in Model mode, so, in this section, the shared functions and options sometimes mention Model mode. Model mode has functionality beyond that available in Preview mode and is discussed in the section following, on page 4-369.

Note: While modeling a reroute provides a variety of useful data and functions that are not available in Preview mode, the main advantage of using the preview function is that it will typically provide results faster than the model function. You may want to use the preview function to get an initial idea of the flights that would be impacted and then use the model function to do a more detailed analysis.

Draw a Reroute

To draw a reroute,

1. Using Create, Edit, or Copy Reroute, enter a reroute set. Note that you can draw a reroute before entering Start Time, End Time or a Name.
2. Click the Draw button in Display Reroute section of the Reroute Definition tab.
   The TSD validates the reroute set and draws the reroute on the map in the color selected in the Characteristics section. The reroute line segments are drawn using a solid 4 pixel line. The locations of airports that are specified as an origin or destination in the reroute definition are drawn as solid circles. The geographic centers of ARTCCS that are specified as an origin or destination are drawn as solid squares. When you select the Draw function, the TSD does not provide any flight counts.
3. After the TSD draws the reroute, the Draw button label changes to Erase. Click Erase to remove the reroute from the map. If you change the reroute definition by changing any of the route segments, the button color turns red and the label displays as Redraw. To update the TSD map with the revised reroute set, click Redraw.

Note: Using the Draw function alone is typically very fast, but does not provide any flight data.
The image below is an example of a drawn reroute.

Create Flight List

After you draw the reroute, you can create the flight list for the reroute.

1. Make valid entries for the Start Time and End Time fields. An error message will display if any of these fields is invalid or missing when you try to create a flight list.

2. Click on the Flight List tab.

3. On the Flight List Tab, click Create Flight List.
The Create Flight List button changes to Update Flight List, as shown below.

![Flight List Table]

<table>
<thead>
<tr>
<th>ACID</th>
<th>ORIG</th>
<th>DEST</th>
<th>ETD</th>
<th>Delta Time</th>
<th>Delta Dist</th>
<th>Assigned Route</th>
</tr>
</thead>
<tbody>
<tr>
<td>OP1701</td>
<td>JNY</td>
<td>MUN</td>
<td>BC</td>
<td>13184</td>
<td>15</td>
<td>100</td>
</tr>
<tr>
<td>JBI588</td>
<td>ZMN</td>
<td>FLL</td>
<td>MIP</td>
<td>12114</td>
<td>3</td>
<td>32</td>
</tr>
<tr>
<td>BIVL15</td>
<td>ZMN</td>
<td>JFK</td>
<td>MIP</td>
<td>12114</td>
<td>15</td>
<td>16</td>
</tr>
<tr>
<td>COKS92</td>
<td>ZMN</td>
<td>LAX</td>
<td>MIP</td>
<td>12107</td>
<td>7</td>
<td>57</td>
</tr>
<tr>
<td>JBI586</td>
<td>ZMN</td>
<td>MOS</td>
<td>MIP</td>
<td>12013</td>
<td>11</td>
<td>80</td>
</tr>
<tr>
<td>JBI18</td>
<td>ZMN</td>
<td>JFK</td>
<td>MIP</td>
<td>12052</td>
<td>13</td>
<td>100</td>
</tr>
<tr>
<td>COKS45</td>
<td>ZMN</td>
<td>LAX</td>
<td>MIP</td>
<td>12052</td>
<td>15</td>
<td>54</td>
</tr>
<tr>
<td>JBI139</td>
<td>ZMN</td>
<td>JFK</td>
<td>MIP</td>
<td>12050</td>
<td>16</td>
<td>22</td>
</tr>
</tbody>
</table>
Preview a Reroute

This section describes functions and options you use when in Preview mode. Some of the functions described are also used when you model a reroute. Reroute modeling is discussed in later sections, but Model mode is mentioned in this section wherever a function or option may be used for both Preview and Model modes.

To preview a reroute in Preview mode,

1. Using Create, Edit, or Copy Reroute, enter a reroute set. The Preview button is disabled on the View Reroute dialog box.

2. Click the **Preview** button in the Display Reroute section of the Reroute Definition tab.

**Note:** The Preview button is a shortcut that allows you to combine the effects of the Draw button and the Create Flight List button in a single step.

After you enter a reroute set and click the **Preview** button in the Display Reroute section of the Reroute Definition tab, the TSD draws the reroute on the map and generates flight counts and a flight list. This is Preview mode. The flight count associated with each airport or ARTCC is displayed on the map in parentheses after the airport or ARTCC label.

The following image is an example of a reroute displayed in Preview mode. The flight count associated with each airport or ARTCC is displayed on the map in parentheses after the airport or ARTCC label.
### Flight Count Column

The flight count associated with each reroute segment is displayed in the # column in the route grid; the total flight count for the reroute set is displayed in the Display Reroute section; and a list of the flights and assigned routes associated with the specified reroute segments is displayed when you click on the **Flight List** tab.

**Note:** You can hover the pointer over each flight count in the route grid on the Reroute Definition tab and display a tooltip that shows the flight count and the distance and time added for the selected segment.

The image below shows the Reroute Definition tab after you click **Preview**. Red ellipses have been drawn on the image to indicate the total flight count for the reroute and the flight counts for each segment in the grid. As you hover the mouse over the flight count, a tool tip showing the flight count with added distance and added time information displays for the row in the grid, as shown below.

![Reroute Definition Tab](image)

After clicking the **Preview** button, the Draw button label changes to Erase. If you edit the reroute definition while previewing the reroute, the TSD changes the Draw button label to Redraw and displays the Redraw and Preview buttons in red, as shown below, to remind you that the map and flight counts now need updating. Editing the reroute definition while

---

<table>
<thead>
<tr>
<th>#</th>
<th>Origin(s)</th>
<th>Filter</th>
<th>Type</th>
<th>Route</th>
<th>Full Destination(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>JFK</td>
<td></td>
<td></td>
<td>HNL JBI JRE YVR</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>JFK</td>
<td></td>
<td></td>
<td>HNL JBI JRE YVR</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>JFK</td>
<td></td>
<td></td>
<td>HNL JBI JRE YVR</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>JFK</td>
<td></td>
<td></td>
<td>HNL JBI JRE YVR</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>JFK</td>
<td></td>
<td></td>
<td>HNL JBI JRE YVR</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>JFK</td>
<td></td>
<td></td>
<td>HNL JBI JRE YVR</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>JFK</td>
<td></td>
<td></td>
<td>HNL JBI JRE YVR</td>
<td></td>
</tr>
</tbody>
</table>

**Destination Segments for Split Routes:**

<table>
<thead>
<tr>
<th>#</th>
<th>Destination</th>
<th>Route</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>JFK</td>
<td>HNL JBI JRE YVR</td>
</tr>
<tr>
<td>2</td>
<td>JFK</td>
<td>HNL JBI JRE YVR</td>
</tr>
<tr>
<td>3</td>
<td>JFK</td>
<td>HNL JBI JRE YVR</td>
</tr>
</tbody>
</table>
in Preview mode includes editing the reroute start or end times, any of the reroute segments, or updating the Action field on the Advisory tab.

TSD In Preview Mode

This section covers the changes in appearance and functionality when the TSD is in the Preview mode (and, where indicated, in Model mode.)

Displaying Protected Segments for a Reroute

You can display protected segments for a reroute on the map through Create, Edit, and View Reroute; Select Reroutes; and the Reroute Monitor. When displaying protected segments, the TSD draws the protected portion of a route in a slate blue color using the same line style as the non-protected portion.

If you are creating, editing, or viewing a reroute, you can draw the protected portions that have been defined for the reroute if you check the Protected Segments checkbox in the Display Reroute section of the Reroute Definition tab. The TSD uses the same 4 pixel line style as it does when drawing the non-protected portion. In the following example, the reroute and its protected segments are displayed in Draw mode.
After saving the reroute, you can draw the reroute and its protected segments through Select Reroutes if the Show Reroutes command has been issued. To draw the reroute and its protected segments, click the reroute's **Show** checkbox on the Select Reroutes dialog box and browse the reroute on the map. When you browse the reroute, the TSD displays the protected portion using the same 2 pixel line style as the non-protected portion. The example below shows a browsed reroute with it's protected segments highlighted in slate blue.
You can display the protected portion of an assigned route through the Reroute Monitor if a flight's assigned route is drawn using the Reroute Monitor Show function and the Protected Segments checkbox in the Selection Panel is checked. The TSD displays the protected portion using the same 2 pixel line style as the non-protected portion. The following example shows the protected portion of a flight's assigned route highlighted in blue. The flight is currently flying along the non-protected portion of the route.

For information on defining protected segments, see Protected Segments on page 4-309 in the Create Reroute Command section of the chapter on Reroute Menu.
Browsing Over a Reroute Segment in Preview/Model Mode

If you browse the pointer over one or more reroute segments while in Preview (or Model) mode, the TSD highlights the segment(s), shows the associated nav aids and their labels, and temporarily displays a tool tip. The tool tip displays the number of flights that are included in the reroute at the location of the pointer. (Note that this count does not include any flights that cross the location but are not part of the reroute.) The location is referred to as the Point of Interest (POI). The tool tip disappears when you are no longer browsing the segment or segments.

While in Preview (or Model) mode, you can select to Show (or Hide) POI Counts using the View menu of the Create/Edit Reroutes dialog box. Show POI Counts is also an option on the right click menu when you browse the TSD map with a segment selected on the TSD or on the route grid. The POI count displays a total count of the flights in the reroute that would traverse the POI, or an hourly, or quarter hourly flight count over the POI. In the image below, hourly counts are shown. (See page 4-351 for information on using the Show POI Counts option.)
To fix the display of the POI count on the map, press the middle mouse button while browsing over the segment. You can also select the Show POI Count option from the right-click menu while browsing the segment. A leader line from the tool tip (shown in red in the image below) to the location of the point of interest displays. The fixed display of the POI count is called the POI Timeline.
Browsing over an ARTCC in Preview/Model Mode

If you place the pointer over an ARTCC for a previewed or modeled reroute, the TSD highlights the segment and the segment's airport and ARTCC icons in black; temporarily shows an icon, label, and flight count for all origin or destination airports for any of the rerouted flights in the ARTCC; and draws a dashed line from those airports to the ends of the associated route segments. In the example below the pointer was placed over the ARTCC ZID.
Selecting a Reroute Segment

If you left or right-click while browsing over a reroute segment that is not selected (highlighted) in the reroute grid, the TSD selects the segment by drawing “selection” circles at the location of each navaid on the segment AND highlights the row for the segment in the grid. If you select the row for the reroute segment in the grid, the TSD automatically draws “selection” circles at the location of the navaids on the segment.

To deselect a selected reroute segment on the map,

• You can use the Deselect option on the right-click menu.
• You can deselect the row for the segment (remove highlighting) in the route grid.
• You can click on the selected segment on the TSD to deselect it.
Using the Right-Click Menus in Preview/Model Mode

If you select a reroute segment while in Preview (or Model) mode and right-click anywhere on the map (except when browsing over a flight icon, FEA/FCA icon, or the POI Timeline), a right-click menu displays providing the following options:

- **Turn On**
  Use the Turn On menu option to display a segment as active in the drawn route and included in the grid (a check displays in the Include checkbox). Turning on a reroute segment includes the segment in the reroute definition and affects flight counts.

- **Turn Off**
  Use the Turn Off menu option to display a segment as excluded (grayed out) in the drawn route and in the grid (no check displays in the Include checkbox). Turning off a reroute segment excludes the segment from the reroute definition and affects flight counts.

- **Show Flight List**
  Use the Flight List option to display the POI Flight List dialog box showing the flights predicted to pass over the POI. A POI symbol (a black diamond shape) displays at the location on the route of the POI.

- **Show POI Count**
  Use the Show POI Count menu option to show POI Flight counts on the map where a segment is browsed. The View menu lets you show the flight counts as Total, Hour or 15 Minutes.

The following sample shows the TSD in Preview mode showing POI count in hourly intervals.
When the POI is displaying the hourly counts, the TSD shows one line for each hour, with the reroute flight count for that hour. The total flight count for all of the hours is displayed at the bottom of the timeline. Remember that only the flights that are in the reroute are counted; any flight that crosses the POI but is not part of the reroute is not counted. Also, if a flight has several assigned route options in the reroute, it is counted only on the assigned route that TFMS has used to model the flight. In most cases this is the assigned route option with the shortest flying time.

**Note:** When more than one POI timeline is displayed, all visible timelines are affected by the selections in the View menu. For example, if you select Hide POI Counts, the TSD removes all POI timelines from the display. Your choice of Total, Hour, or 15 minutes on the POI Timeline takes effect on all of the POI timelines on the TSD.

- **Hide POI Counts**
  Use the Hide POI Counts option to remove POI flight counts from the map.

- **Ungroup**
  Use the Ungroup option to display multiple rows in the route grid for a single reroute segment with multiple origins or destinations. Ungrouping a row allows you to take separate actions on each of the origins or destinations that are grouped together in the original row. If you select a reroute segment with more than one origin or destination and select the Ungroup option, the TSD displays a separate row for each origin or destination of the segment. For example, if a row has two origins, the TSD will insert an additional row into the grid for that segment's second origin. For more information, see Ungroup on page 4-354.

- **Edit/Replace Route Text**
  Use the Edit/Replace Route Text option to open the Edit/Replace Route Text dialog box and update route string text for segments in the route grid. For more information, see Edit/Replace Route Text on page 4-291 in the Reroute Menu section of Chapter 4.

- **Show Filter**
  Displays the Flight Filters dialog box for a segment that was selected in the Create/Edit dialog box. The Flight Filter dialog box lets you view the filter definitions for the segment and change them if desired. For more information see Flight Filters on page 4-316 in the Reroute Menu section of Chapter 4.

- **Deselect**
  Use the Deselect option to deselect all selected route segments. See Selecting a Reroute Segment on page 4-350 in the section, for more information.
If you do not select a reroute segment while in Preview mode and right-click anywhere on the map except when browsing a flight or FEA/FCA icon, a right-click menu displays providing the following options.

- **Hide POI Counts**
  Use the Hide POI Counts option to remove POI flight counts from the map.

- **Edit/Replace Route Text**
  Clicking this option opens the Edit/Replace Route Text dialog box and update route string text for a segments in the route grid. For more information, see Edit/Replace Route Text on page 4-291 in the Reroute Menu section of Chapter 4.

- **Create MIT**
  Use the Create MIT option to create an MIT restriction for a reroute while in Preview (or Model) mode. When you select this option the Create MIT Restrictions dialog box opens. When you browse and right-click a drawn MIT on the map, the right-click menu displays an Edit MIT option.

  **Note:** You can also access the Create/Edit MIT Restriction dialog box by clicking the Create (or Edit) button on the Restrictions Tab of the Create/Edit Reroute dialog box.

To further support traffic flow management decision making and the management of flights in an airspace, the RRIA features include the capability to create Miles-in-Trail (MIT) restrictions for a reroute when the need arises. After a restriction is created and the reroute is modeled or remodeled, you can view the drawn restriction and its model results. A right-click menu accessed while browsing a restriction includes the option to open an MIT Flight List. When viewing model data for a proposed reroute you can choose to include or exclude the impact of any MIT Restrictions.

The MIT Restrictions function can be used in Preview mode, but it is most useful in Model mode and, therefore, discussed in detail in the Modeling a Reroute section. See Using the Create/Edit MIT Restrictions Dialog Box on page 4-332.

  **Note:** When you browse and right-click a drawn MIT on the map, the right-click menu includes an Edit MIT option.

- **MoveZoom**
  Clicking this option opens the Move/Zoom dialog box. For more information, see the Move/Zoom command on page 4-25 in Chapter 4, Maps Menu section.

- **Undo MoveZoom**
  This option is enabled after you have changed the MoveZoom parameters by using the MoveZoom option or by using the Maps> MoveZoom command. Click **Undo**
MoveZoom to undo the MoveZoom changes. For more information, see the Move/Zoom command on page 4-25 in Chapter 4, Maps Menu section.

- **Create FEA/FCA**
  Clicking this option opens the Create FEA/FCA dialog box. For more information, see the Create FEA/FCA Command on page 4-442 in Chapter 4, FEA/FCA Menu section.

**Ungroup**

Route segments with multiple origins can be ungrouped using the right-click menu option on the TSD map in Preview (or Model) mode, as described in the previous section, or by using the right-click menu option in the route grid of the Reroute Definition Tab in the Create/Edit Reroute dialog box.

To ungroup route segments in the route grid,

1. In the Create/Edit Reroute Definition dialog box, select a row or rows in the route grid with multiple origins by clicking the row number. In the following example, the routes shown on row 3 will be ungrouped.

2. Click the right mouse button to open the right-click menu and select **Ungroup**.
3. In the image below, the multiple origins in row 3 of the previous example have been ungrouped into three separate rows. You can now specify actions that can be taken on only one of the origins (or destinations).

![Image of route segments ungrouped into multiple rows]

**Note:** When you ungroup route segments using the right-click menu on the TSD map, the route grid will appear ungrouped in the same manner as shown above.
Flight List Tab in Preview/Model Mode

After previewing a reroute, the Flight List tab of the Create/Edit Reroute dialog box allows you to create, update, or view a flight list for the reroute set you defined on the Reroute Definition tab. The Flight List Tab shows a list of the flights and routes that are associated with the segments currently included in the reroute.

On the TSD map you can turn off any segment that you would like to remove from the reroute. This causes the segment to be grayed out on the map and in the route grid. After turning a segment on or off, the TSD adjusts the flight counts on the map and in the route grid and adjusts the total flight count on the Reroute Definition and Flight List tabs to reflect the change.

To generate a list of the flights and routes that are associated with segments currently included in the reroute, click the Create Flight List button on the Flight List tab. After clicking this button, a message appears that the TSD is generating the flight list and the button label changes to Update Flight List. The total flight count and the date and time Flight List data was last updated displays to the right of the Update Flight List button. If you are in Model mode, the time that modeling was started displays. The flight list is also generated when you click the Preview button on the Reroute Definition tab and display a reroute in Preview mode.

For information on using the Flight List Tab in Normal mode, see page 4-320 in the Reroute Menu section of Chapter 4.

For more information on Preview mode, see Previewing a Reroute on page 4-339 in this section.
This is a sample of the Flight List tab of the Create/Edit Reroute dialog box.
Using the Flight List Tab in Model Mode

The Flight List tab displays the list of flights and assigned routes associated with the segments in the reroute and the following fields and buttons.

### Flight List Tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create/Update Flight List</td>
<td>Use this button to create the reroute flight list or update the existing flight list.</td>
</tr>
<tr>
<td>Flight Count</td>
<td>This count represents the total count of flights in the reroute set during the selected time range. Flights with multiple assigned routes are counted only once in the flight count.</td>
</tr>
</tbody>
</table>
| Last Update/Model Time      | If you are in Preview mode, the time that displays is the last time that flight data was updated.  
If you are in Model mode, the time that displays is the time at which modeling was requested.  
If the current time exceeds the Last Update or Model time by at least 15 minutes, the Last Update or Model time displays in red. |
| Advanced Sort               | Use this button to open the Advanced Sort dialog box and set sort options for the Flight List. [See Advanced Sort Dialog Box (Flight List) on page 4-359] |
| Customize Columns           | Use this button to open the Customize Columns dialog box and add, remove, or reorder the columns in the Flight List. [See Customize Columns Dialog Box (Flight List) on page 4-362] |
| Print Flight List Now       | Use this button to print a hardcopy of the Flight List. Clicking this button opens the Print Flights dialog box. On the Print Flights dialog box a pathway and temporary file name for the flight list display as the default Print Command. After specifying the number of copies to print, click OK.  
**Note:** The Print Flight List Now button is active if there is at least one flight checked as included in the flight list. The button is inactive in Modeling mode. |

When you first display the Reroute Flight List, the rows are sorted based on the settings in the Reroute Preferences (see page 4-327 in the Reroute Menu section of Chapter 4). You can change the sort order and sort by any field except the Route field. To change the sort order, click a column header. The sort toggles between ascending and descending order. An upward pointing arrow indicates that a column is sorted in ascending order. Clicking on the column header sorts the column in descending order and the arrow points downward.

To adjust the width of a column, position the pointer over the right edge of a column header, left-click, and “drag” the edge left or right.
If you click the **Create/Update Flight List** button and there are no flights in the flight list, the TSD opens an Error dialog box that reads, “ERROR: No matching flights found.”

**Note:** If you are sorting by ACID, the TSD sorts the Flight List alphabetically by airline code and then numerically by flight number. If you are sorting by a time-related column that contains values with an alpha prefix such as ETD, the TSD sorts the list based on the time value and ignores the prefix.

**Advanced Sort Dialog Box (Flight List)**

The Advanced Sort option is accessible through the Flight List tab of the Create/Edit/View Reroute dialog boxes, the MIT Flight List, and the POI Flight List. The Advanced Sort option allows you to sort any of these flight lists by specifying primary, secondary, and tertiary sort criteria.

To open the Advanced Sort dialog box, click the **Advanced Sort** button on the Flight List tab of the Create/Edit/View Reroute dialog box, the MIT Flight List dialog box, or the POI Flight List dialog box. The Advanced Sort dialog box displays.

![Advanced Sort for Reroute Flight List](image)

**Using the Advanced Sort Dialog Box**

You can sort a flight list by defining up to three levels for sort fields in either ascending or descending order. To select from a pick list of sort options, click on the arrow next to the Sort By (primary sort) and Then By (secondary and tertiary sort) fields. To select either ascending or descending order, click in the radio buttons.
Sort Options Available for the Reroute Flight Lists

The sort fields on the Advanced Sort dialog box list the following sort options.

### Advanced Sort Options

<table>
<thead>
<tr>
<th>Sort Option</th>
<th>Flight List Header</th>
<th>Column Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Airborne/Ground Delay</td>
<td>A/G</td>
<td><strong>MIT Flight List Only.</strong> Indicates whether the MIT delay for this MIT is an airborne (A) or ground (G) delay. See page 4-413 for more information on MIT Flight List.</td>
</tr>
<tr>
<td>Aircraft ID</td>
<td>ACID</td>
<td>Aircraft identifier (the default sort for the flight list)</td>
</tr>
<tr>
<td>Aircraft Type and Equipment</td>
<td>TYPE</td>
<td>Aircraft Type and Equipment</td>
</tr>
<tr>
<td>Arrival Center</td>
<td>ACTR</td>
<td>Arrival Center.</td>
</tr>
<tr>
<td>Arrival Time</td>
<td>ETA</td>
<td>TFMS estimate of wheels-down time.</td>
</tr>
<tr>
<td>Control Element</td>
<td>CTL ELEM</td>
<td>Control element for GDP, GS, or AFP.</td>
</tr>
<tr>
<td>Crossing Time with MIT</td>
<td>Delayed Time</td>
<td><strong>MIT Flight List Only.</strong> The time at which the flight crosses the MIT after it has been delayed by the MIT and by any other MIT restriction previously encountered along the reroute. If more than one MIT restriction exists, the Delayed Time reflects the accumulative delay from all restrictions. See page 4-413 for more information on MIT Flight List.</td>
</tr>
<tr>
<td>Delta Distance</td>
<td>Delta Dist</td>
<td>Difference between the length of the assigned route and the current route.</td>
</tr>
<tr>
<td>Delta Time Enroute</td>
<td>Delta Time</td>
<td>Difference between the ETE for the assigned route and the ETE for the current route.</td>
</tr>
<tr>
<td>Departure Center</td>
<td>DCTR</td>
<td>Departure Center.</td>
</tr>
<tr>
<td>Departure Time</td>
<td>ETD</td>
<td>TFMS estimate of wheels-up time with the flight status prefix.</td>
</tr>
<tr>
<td>Destination</td>
<td>DEST</td>
<td>Arrival Airport.</td>
</tr>
<tr>
<td>Distance</td>
<td>DIST</td>
<td>Length of the end-to-end route in nautical miles.</td>
</tr>
</tbody>
</table>
### Advanced Sort Options (Continued)

<table>
<thead>
<tr>
<th>Sort Option</th>
<th>Flight List Header</th>
<th>Column Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Estimated MIT Delay</td>
<td>MIT Delay</td>
<td><strong>MIT Flight List Only.</strong> MIT delay computed for this flight at this MIT point. Note that this is not cumulative delay. That is, it does not include any delay that has been assigned to the flight at earlier MIT points. If displayed in red, it means the flight has been assigned airborne delay that exceeds a parameterized threshold limit, indicating that this MIT is likely not feasible unless additional passback MIT is applied. See page 4-413 for more information on MIT Flight List.</td>
</tr>
<tr>
<td>Estimated Time En route</td>
<td>ETE</td>
<td>Estimated time en route in minutes for each route.</td>
</tr>
<tr>
<td>Filed Speed</td>
<td>SPD</td>
<td>Filed speed.</td>
</tr>
<tr>
<td>Flight Status</td>
<td>FSTAT</td>
<td>ETD prefix. See ETD.</td>
</tr>
<tr>
<td>In Reroute</td>
<td>In RR</td>
<td><strong>MIT Flight List Only.</strong> Indicates whether or not the flight is impacted by the reroute. Y or N.</td>
</tr>
<tr>
<td>Origin</td>
<td>ORIG</td>
<td>Departure Airport.</td>
</tr>
<tr>
<td>Original Crossing Time</td>
<td>Original Time</td>
<td><strong>MIT Flight List Only.</strong> The crossing time without any MIT restrictions.</td>
</tr>
<tr>
<td>Point of Interest Time</td>
<td>POI Time</td>
<td><strong>POI Flight List Only.</strong> Estimated crossing time at the POI if the proposed reroute is issued. See page 4-384 for more information on POI Flight List.</td>
</tr>
<tr>
<td>Proposed Gate Time of Departure</td>
<td>PGTD</td>
<td>Flight plan Ptime.</td>
</tr>
<tr>
<td>Requested Altitude</td>
<td>ALT</td>
<td>Requested altitude in hundreds of feet.</td>
</tr>
<tr>
<td>RVSM Status</td>
<td>RVSM</td>
<td>Create/Edit/View Reroute Flight list only. RVSM conformance status.</td>
</tr>
</tbody>
</table>

Clicking on a column header of a flight list will also allow you to sort the list in ascending or descending order alphabetically by the values in that column. The TSD displays a blue arrow in a column header to indicate whether the sort order in the column is ascending or descending.
Reset Preferences checkbox

Use the Reset preferences to this sort order checkbox to specify whether you want the TSD to reset the default sort selections for the Flight List in the Reroute Preferences dialog box. See Preferences Command on page 4-327 in the Reroute Menu section of Chapter 4.

Customize Columns Dialog Box (Flight List)

The Customize Columns option is accessible through the Flight List tab of the Create/Edit/View Reroute dialog boxes, the MIT Flight List, and the POI Flight List. The Customize Columns option allows you to add, remove, and reorder columns in the selected flight list. To set the default column selections for all Reroute Flight lists, use the Reroute Preferences command. See Preferences Command on page 4-327 in the Reroute Menu section of Chapter 4.

To open the Customize Columns dialog box, click the Customize Columns button on the flight list. The Customize Columns dialog box in the image below displays with column names for the Flight List tab of the Create/Edit/View Reroute dialog boxes.

![Customize Columns dialog box](image)

The Selected Columns field shows the columns that are currently displayed in the Flight List. The Available Columns field shows the columns that can be added to the Flight List.
To Customize Columns:

1. To move a column name to the Selected Columns list click on one column name (or move more by using the <<Shift>> and <<Ctrl>> keys) in the Available columns list and then click the Add >> button. Column names you add to the Selected Columns list no longer appear in the Available Columns list.

2. To move a column name out of the Selected Columns, click on the column name (or move more by using the <<Shift>> and <<Ctrl>> keys) and then click the <<Remove button. Column names are removed from the Selected Columns list and appear in the Available Columns list.

3. To move the selected column names up and down within the list of Selected Columns, select the column name and then click the Move Up button or the Move Down button. If no column name is selected in the Selected Columns list, the Move Up and Move Down buttons are disabled (grayed out).

The order in which columns names appear in Selected Columns is the order, from left to right in which they appear on the Flight List between the ACID column to the left and the Assigned Route column to the right.

4. Click OK to close the Customize Columns dialog box and display the selected columns and return to the Flight List.

Click Apply to display the selected columns on the Flight List without closing the Customize Column dialog box.

Click Cancel to close the Customize Column dialog box without saving any changes.

Note: The columns ACID and Assigned Route are fixed columns and cannot be added, moved, or removed from the Flight List.
The following table includes the column names available in the Customize Columns option, the column headers that display on the Flight List, and a description of each column. Note that some of the column names display only for MIT Flight lists or POI Flight lists and do not appear in the sample shown above.

### Customize Columns for Reroute Flight List

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Flight List Header</th>
<th>Column Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Airborne/Ground Delay</td>
<td>A/G</td>
<td>MIT Flight List Only. Indicates whether the MIT delay for this MIT is an airborne (A) or ground (G) delay. See page 4-413 for more information on MIT Flight List.</td>
</tr>
<tr>
<td>Aircraft Type and Equipment</td>
<td>TYPE</td>
<td>Aircraft Type and Equipment.</td>
</tr>
<tr>
<td>Arrival Center</td>
<td>ACTR</td>
<td>Arrival Center.</td>
</tr>
<tr>
<td>Arrival Time</td>
<td>ETA</td>
<td>TFMS estimate of wheels-down time.</td>
</tr>
<tr>
<td>Control Element</td>
<td>CTL ELEM</td>
<td>Control element for GDP, GS, or AFP.</td>
</tr>
<tr>
<td>Crossing Time with MIT</td>
<td>Delayed Time</td>
<td>MIT Flight List Only. The time at which the flight crosses the MIT after it has been delayed by the MIT and by any other MIT restriction previously encountered along the reroute. If more than one MIT restriction exists, the Delayed Time reflects the accumulative delay from all restrictions. See page 4-413 for more information on MIT Flight List.</td>
</tr>
<tr>
<td>Delta Distance</td>
<td>Delta Dist</td>
<td>Difference between the length of the assigned route and the current route. This column does not display on the Create Reroute Flight List unless you are previewing or modeling a reroute.</td>
</tr>
<tr>
<td>Delta Time Enroute</td>
<td>Delta Time</td>
<td>Difference between the ETE for the assigned route and the ETE for the current route. A negative number indicates that the proposed reroute would be shorter that the flight’s current route. This column does not display on the Create Reroute Flight List unless you are previewing or modeling a reroute.</td>
</tr>
<tr>
<td>Departure Center</td>
<td>DCTR</td>
<td>Departure Center.</td>
</tr>
</tbody>
</table>
## Customize Columns for Reroute Flight List (Continued)

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Flight List Header</th>
<th>Column Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Departure Time</td>
<td>ETD</td>
<td>TFMS estimate of wheels-up time. The ETD prefix indicates both the status of a flight and the source of data for a flight as follows:</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>A</strong> - Actual departure time, usually based on a NAS departure message.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>E</strong> - Estimated departure time. No departure message was received, but the flight is known to be airborne because NAS messages indicating this have been received.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>T</strong> - Flight is off the gate and may be taxiing. A gate departure time has been received.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>P</strong> - P-time from the NAS flight plan message.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>N</strong> - P-time from the airline-provided flight plan message.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>S</strong> - Departure time estimated from the Official Airline Guide scheduled time.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>R</strong> - The historical route has been replaced by the assigned route.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> You can hover the pointer over a cell in the ETD column of the Flight List and view a tooltip that defines the ETD prefix in the cell.</td>
</tr>
<tr>
<td>Destination</td>
<td>DEST</td>
<td>Arrival Airport.</td>
</tr>
<tr>
<td>Estimated MIT Delay</td>
<td>MIT Delay</td>
<td><strong>MIT Flight List Only.</strong> MIT delay computed for this flight at this MIT point. Note that this is not cumulative delay. That is, it does not include any delay that has been assigned to the flight at earlier MIT points. If displayed in red, it means the flight has been assigned airborne delay that exceeds a parameterized threshold limit, indicating that this MIT is likely not feasible unless additional passback MIT is applied. See page 4-413 for more information on MIT Flight List.</td>
</tr>
<tr>
<td>Estimated Time En Route</td>
<td>ETE</td>
<td>Estimated time en route in minutes for each flight.</td>
</tr>
<tr>
<td>Filed Speed</td>
<td>SPD</td>
<td>Filed speed.</td>
</tr>
<tr>
<td>Flight Status</td>
<td>FSTAT</td>
<td>ETD prefix. See ETD.</td>
</tr>
<tr>
<td>In Reroute</td>
<td>In RR</td>
<td><strong>MIT Flight List Only.</strong> Indicates whether or not the flight is impacted by the route. Y or N.</td>
</tr>
</tbody>
</table>
Previewing a Reroute

The first column of the flight list consists of Include/Exclude checkboxes. You can toggle these checkboxes to include or exclude a flight and its associated route segment from the reroute definition. Toggling the Include/Exclude checkboxes automatically updates the total flight count displayed on the Flight List and Reroute Definition tabs and any flight counts, if drawn, on the map. (Note that if a flight has several associated route segments, you must uncheck them all if you want to entirely exclude the flight from the reroute.) If you are in Model mode, toggling the Include/Exclude checkboxes causes the TSD to display indicators that model results are out of date. After toggling the Include/Exclude checkboxes for flights on the Reroute Flight List and remodeling, flight list data on any open POI or MIT Flight Lists is also updated.

For more information on Model mode, see the Modeling a Reroute in this section on page 4-369.

Flight List ACID Column

The ACID column is a fixed column and always displays as the first column in the Flight list after the Include/Exclude column. The Flight List displays the ACID for the flight in blue to indicate when a flight is part of one or more public required reroutes already issued. To display a tool tip listing the Advisory number (or 3 dashes if no number) and
reroute name (or N/A if not available) of all other public required reroutes that contain a specific flight, place the pointer over the flight's blue ACID value. In the example below, the tool tip indicates that the flight with an ACID of JBU635 is also in the reroute with an advisory number and name of 537 TUM.

**Assigned Route Column**

The Assigned Route column is a fixed column and displays as the last column in the Flight list. The Assigned Route string displays an asterisk indicating the route used for modeling. The Customize Route Column section of the Customize Columns dialog box determines whether the current and assigned routes or the assigned route only displays on the Flight list.

The Show Current Route checkbox lets you specify whether you want both the current and assigned route OR the assigned route only to display on the Flight List. If you check this box, both the current and assigned route text display with the current route displaying in the first line of the cell and the assigned route displaying in the second line. If you leave this box unchecked, only the assigned route text displays.

**Note:** A reroute segment and its assigned route text displays only if the segment is currently included in the reroute definition.

The Assigned Route Option radio buttons let you specify whether the route text that displays for each assigned route is the segment text specified in the reroute definition or the end-to-end route text that was computed by the system during modeling. To display the segment text, click **Specified Segment**. To display the end-to-end route text, click **End-to-End Route**.
**Note:** For modeling purposes, the system determines an end-to-end route by merging a flight's current route with its assigned reroute in a way that avoids any excessive turn angles.

**Note:** If the assigned route was used for modeling a flight, an asterisk appears before the assigned route string on the Flight List. If there is no modeled reroute text for an assigned route, a blank line displays.

**Route Prefixes**

The route prefix that displays on the Flight List for an assigned route depends on the reroute's advisory action and segment type. The Assigned Route column displays route prefixes as follows:

### Route Prefix Depending on Advisory Action

<table>
<thead>
<tr>
<th>Route Segment Type</th>
<th>RQD</th>
<th>RMD</th>
<th>PLN</th>
<th>FYI</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Type</td>
<td>Required</td>
<td>Recommended</td>
<td>Planned</td>
<td>Information</td>
</tr>
<tr>
<td></td>
<td>RQD:</td>
<td>RMD:</td>
<td>PLN</td>
<td>FYI</td>
</tr>
<tr>
<td>UPT RTE</td>
<td>RQD UPT RTE</td>
<td>RMD UPT RTE</td>
<td>PLN UPT RTE</td>
<td>FYI UPT RTE</td>
</tr>
<tr>
<td>CDR RTE</td>
<td>RQD CDR RTE</td>
<td>RMD CDR RTE</td>
<td>PLN CDR RTE</td>
<td>FYI CDR RTE</td>
</tr>
<tr>
<td>RERTE</td>
<td>RQD RERTE</td>
<td>RMD RERTE</td>
<td>PLN RERTE</td>
<td>FYI RERTE</td>
</tr>
<tr>
<td>UNKN RTE</td>
<td>RQD UNKN RTE</td>
<td>RMD UNKN RTE</td>
<td>PLN UNKN RTE</td>
<td>FYI UNKN RTE</td>
</tr>
</tbody>
</table>
Modeling a Reroute

The modeling function of the TSD provides the capability of displaying the projected state of the NAS with a proposed reroute. The TSD models a reroute and its impact using a “snapshot” of data on the current NAS state. While you are modeling a reroute, the TSD updates weather data and the current time only. To view the time that model results were last updated, refer to the Times dialog box.

You model or remodel a newly created or existing reroute by clicking the Model button on the Create, Edit, or View Reroute dialog box. You can also view the modeled results for a shared, public, or local reroute created by another user through the Select Reroutes command.

Using Model Mode on the TSD

When you click Model on a Create/Edit dialog box, the TSD displays a dialog box indicating that TFMS is generating model results for this reroute. It may take 30 seconds or more in some cases to generate the model results; you won’t be able to take other actions on your TSD until the model results are ready. If you find that it is taking too long to generate the results, you can click the Cancel button on the message window at any time to cancel the model request and return to the Create/Edit dialog box in Normal mode.

Disabled TSD Functions in Model Mode

In Model mode, the TSD disables the following functions associated with the TSD menu items.

- Display menu: Adapt commands
  RVSM
- Flights menu: Show/Hide Flights
  Select Flights
  Show/Hide Flight Counts
  Find Flight
- Alerts menu: Show/Hide Alerts
  Select Alerts, Examine Alerts
  Alarms
  Show NAS Monitor/Custom and System Summary options,
  Preferences
- Reroute menu: Monitor All Reroutes
- Tools menu: Replay
  Database Commands
  EDCT Commands
  Report Manager
  Scripts
Model Mode Indicators

When the model results are ready, the TSD switches to the model mode version of the Create/Edit Reroute dialog box, shown below. Like the shown in the example below, all TSD dialog boxes in Model mode are displayed in an intense yellow.

The TSD provides several indicators to remind you that you are operating in Model mode. These indicators, as shown in the example above, include the display of the text “MODEL MODE” in the dialog box title, a background color of bright yellow, and an MIT status button in the menu bar.
The TSD map displays with a slate blue border and the legend “MODEL MODE” in large text with the name of the site that created the reroute and the model update time.

If the Times dialog box is showing it displays the time the modeled reroute was generated and the current time. If you have selected NAS Monitor, the Times dialog box also displays the NAS Monitor time along with the Modeled Time and the Current Time, as in the following sample.

Note that the Times box will continue to refresh the Current time in the normal way, but the Model time and NAS Monitor time remain constant and continue to display the time when you last requested the model and displayed the NAS Monitor. If the model results are more than 15 minutes old, the times are displayed in red as shown in the figure above. This is not meant to indicate an error condition. It is just a reminder that the model results
are not automatically refreshed, and as the results get older, you might want to click the **Model** button again to update the results using the latest flight data.

### Updating the Reroute Definition in Model Mode

If you modify a reroute definition while the TSD is in Model mode and do not remodel the reroute, the following changes occur to let you know that the modeled data has not been updated to reflect the latest change.

- Frames the TSD map with a red border and displays the text “REMODEL” in red
- Changes the background color of the Model button to red and changes the text on the button to “Remodel”
- Displays “Model Time” labels in red such as on the Times dialog box and the Reroute Analysis tab

![TSD Map with Red Border](image)

**Note:** Changing the sort order in the reroute grid is not considered a change in the reroute definition.

To update model results, click the red **Remodel** button at the bottom of the Create/Edit Reroute dialog box.

If you have already shared a reroute with other sites, and you make changes to the reroute and click **Remodel**, a message dialog box will open which reads:

> Updated reroute definition and model results will be made available to other users. Do you want to continue?

Click **Yes** to save the changes and update the model results or click **No** to close the message box without updating the reroute definition or generating a model.
**Note:** This is to ensure that all users are viewing the same model data for the same reroute.

**Notification of TMLs in Model Mode**

If a Traffic Management Initiative (TMI) is issued, modified, or deleted while you are modeling a reroute, the TSD notifies you that a TMI event has occurred by displaying a warning icon in the menu bar of the TSD and the following dialog boxes:

- Create/Edit/View Reroute
- NAS Monitor (accessed from the Reroute Analysis tab)
- NAS Monitor Bar Chart
- FEA/FCA Timeline
- FEA/FCA Bar Chart

The warning icon displays as an orange triangle, shown circled in red in the detail of the TSD menu below. The warning icon will also be displayed if you are examining an FEA/FCA while in model mode, and the FEA/FCA definition has been modified since the model was generated.

You can use this warning icon and the information it provides to determine if the reroute you are modeling needs to be remodeled.

When you browse over the warning icon, a tool tip displays informing you of the type of change that occurred (GDP, GS, AFP, RR, FEA, or FCA); the name of the airport, AFP, FEA/FCA, or reroute involved; whether the change is new, a modification, or a cancellation; and the time of the change. The following example shows the warning icon on the menu bar of the NAS Monitor and its tool tip. In this example, a reroute with the name of PHX_BUNTR_TVC was modified at 1631.

For more information on using the NAS Monitor in Model mode, see page 4-418.

For more information on Examining FEA/FCAs in Model mode, see page 4-424.
**Reroute Analysis Tab**

The Reroute Analysis tab of the Create Reroute dialog box is available only in Model mode. This tab provides a summary of the impact of the reroute on flights and sector alerts. If you make changes to the reroute definition, the TSD updates flight and sector information on this tab only after you remodel. Clicking on the **Reroute Analysis** tab displays the following dialog box.

![Reroute Analysis Tab Diagram]

- **Flight Counts**:
  - In Proposed Reroute: 55
  - In Another RQD Reroute: 0
  - No Assigned Reroute: N/A
  - Have Multiple Options: 22
  - In a GDP/GB: 6
  - In an AFP: 0
  - Flights with MIT: N/A
  - Flights Delayed by MIT: N/A

- **Alerted Sector Peaks** (increased/decreased):

<table>
<thead>
<tr>
<th>Flight Count</th>
<th>Alerted Sector Peaks</th>
</tr>
</thead>
<tbody>
<tr>
<td>+2</td>
<td>CY +1/0</td>
</tr>
<tr>
<td>+5</td>
<td>WB +1/0</td>
</tr>
<tr>
<td>-26</td>
<td>WU 0/-3</td>
</tr>
<tr>
<td>-11</td>
<td>WC 0/-2</td>
</tr>
<tr>
<td>-3</td>
<td>WY +3/0</td>
</tr>
<tr>
<td>+17</td>
<td>ZB +5/0</td>
</tr>
<tr>
<td>+30</td>
<td>ZC +3/0</td>
</tr>
<tr>
<td>0</td>
<td>ZN 0/-1</td>
</tr>
<tr>
<td>-7</td>
<td>ZC 0/-1</td>
</tr>
<tr>
<td>-27</td>
<td>ZP +1/0</td>
</tr>
<tr>
<td>+1</td>
<td>ZY +2/1</td>
</tr>
<tr>
<td></td>
<td>2145 2345 0045 0945 0245 0345 0445 0545</td>
</tr>
</tbody>
</table>

- **Added Distance/Time**:
  - Avg Added Distance: 73
  - Max Added Distance: 278
  - Avg Added Time: 14
  - Max Added Time: 43

- **Delay**:
  - Avg MIT Delay: N/A
  - Max MIT Delay: N/A
  - Avg Total Delay: 14
  - Max Total Delay: 43

**Note**: The TSD updates flight and sector information on this tab only after you remodel.
Using the Reroute Analysis Tab

The top portion of the Reroute Analysis tab displays a summary of the impact of the modeled reroute on flights, and the bottom portion displays an hourly summary of the impact of the reroute on the centers in the NAS. The site that created the reroute and the time at which modeling data was last updated display above the grid. If you change the reroute definition after you model a reroute or if a parameter set time period has passed since the model was last updated, the Model Updated time displays in red. The following table explains the items in the top portion of the Reroute Analysis tab.

<table>
<thead>
<tr>
<th>Flight Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item</td>
</tr>
<tr>
<td>In Proposed Reroute</td>
</tr>
<tr>
<td>No Assigned Reroute</td>
</tr>
<tr>
<td>In a GDP/GS</td>
</tr>
<tr>
<td>Flights with MIT</td>
</tr>
<tr>
<td>In Another RQD Reroute</td>
</tr>
<tr>
<td>Have Multiple Options</td>
</tr>
<tr>
<td>In an AFP</td>
</tr>
<tr>
<td>Flights Delayed by MIT</td>
</tr>
</tbody>
</table>
Reroute Analysis Tab (Continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avg Added Distance</td>
<td>The average number of miles added to flights in the proposed reroute</td>
</tr>
<tr>
<td>Avg Added Time</td>
<td>The average number of minutes of additional flying time due to the proposed reroute (not including any MIT delay.)</td>
</tr>
<tr>
<td>Avg MIT Delay</td>
<td>The average number of minutes that flights in the proposed reroute are delayed due to MIT restrictions. You can browse over this count to display a tool tip that shows the average number of minutes that flights are ground delayed and the average number of minutes that flights are airborne delayed.</td>
</tr>
<tr>
<td>Avg Total Delay</td>
<td>The average total number of minutes per flight that flights in the proposed reroute are delayed, including both additional flying time and MIT delay.</td>
</tr>
<tr>
<td>Max Added Distance</td>
<td>The maximum number of miles added to flights in the proposed reroute.</td>
</tr>
<tr>
<td>Max Added Time</td>
<td>The maximum number of minutes of additional flight time due to the proposed reroute.</td>
</tr>
<tr>
<td>Max MIT Delay</td>
<td>The maximum number of minutes that flights in the proposed reroute are delayed due to MIT restrictions. You can browse over this count to display a tool tip that shows the average number of minutes that flights are ground delayed and the average number of minutes that flights are airborne delayed.</td>
</tr>
<tr>
<td>Max Total Delay</td>
<td>The maximum total number of minutes per-flight that flights in the proposed reroute are delayed.</td>
</tr>
</tbody>
</table>

Alerted Sector Peaks Table

The bottom portion of the Reroute Analysis tab displays, in table format, the total count of flights added or removed from a Center and an hourly summary of the number of sectors within each center that are made better or worse due to the reroute. The table displays up to twelve rows at a time, a row for each center affected by the reroute. A vertical scroll bar allows you to view more than 12 rows.

The first column in the table labeled Flight Count displays the total number of flights that are added or removed from a particular center over the entire time period of the proposed reroute. The total count displays as a plus (+) or minus (-) value. The center name displays in the column to the right of the flight count. The remaining columns represent 1 hour time intervals and are labeled along the bottom of the grid.
**Note:** Turning a reroute segment on or off does not update the values in the Flight Count column. You must remodel the reroute to update the model results.

The cells in the table display as blanks if there is no impact on an alerted sector. If there is an impact, two numbers separated by a slash display. The first number represents a count of the number of sectors that are alerted with the reroute and that have a peak count that is greater with the reroute than without the reroute during at least one 15 minute period in an hour; these are the sectors that are considered to be “worse” with the reroute. A plus sign displays as a prefix unless the number is zero. The second number represents a count of the number of sectors that are alerted without the reroute and that have a peak count that is less with the reroute than without the reroute during at least one 15 minute period in an hour; these are the sectors that are considered to be “better” with the reroute. A minus sign displays as a prefix unless the number is zero.

To display a tool tip, as shown below, that shows a breakdown, by quarter hour, of the number of sectors within each center that are improved or worse due to the reroute, hover the pointer over a cell in the grid.
MIT Status Button

If MIT restrictions exist, you can toggle the MIT Status button On to show sector counts that include the impact of the restrictions or Off to show sector counts that exclude the impact of the restrictions.

For more information on the MIT Status button, see page 4-382, in this chapter.

Note: Toggling the MIT Status button does not affect the values in the Flight Count column in the grid.

Accessing the NAS Monitor from the Reroute Analysis Tab

Clicking on the Reroute Analysis Tab lets you display the NAS Monitor in Model mode. To display the NAS Monitor in Model mode for a center, click on the center name in the Alerted Sector Peaks table on the Reroute Analysis tab. You can also select the Show NAS Monitor option from the Alerts menu.

For more information on the using the NAS Monitor in Model mode, see page 4-418, in this chapter.

Functions Menu-Replace Reroute(s) Option

The Functions menu on the Create/Edit dialog box is discussed in the Create Reroutes section on page 4-291 in the Reroute Menu section of Chapter 4. The Replace Reroute(s) option is discussed here because it is used in Model mode when showing modeling results.

Replace Reroute(s)

The Replace Reroute(s) option on the Functions menu of the Create/Edit Reroute dialog box allows you to select one or more active, required public reroutes and model the impact of replacing the reroutes.

Note: The Replace Reroute(s) function is for modeling purposes only. If you actually want to cancel the public reroute(s) you have selected, you must delete the reroute(s) through the Delete Reroute option accessed through Select Reroutes Functions menu.
After selecting the Replace Reroute(s) option, the Replace Selected Reroutes dialog box opens if non-expired, required reroutes are available. Otherwise, a message displays indicating that none exist.

![Replace Selected Reroutes dialog box](image)

The Replace Selected Reroutes dialog box displays a three column grid that includes a Replace column with checkboxes, a Name column, and an Advisory column. Select the public reroute or reroutes you want replaced by the reroute you are creating or editing by clicking on the Replace checkbox to the left of the reroute name.
After selecting one or more active, required public reroutes and clicking OK or Apply, the TSD appends the text “_REPLACES” to the reroute name on the Reroute Definition and Advisory tabs and inserts text into the Remarks field on the Advisory tab to indicate that the reroute you are currently creating or editing is replacing the selected public reroute(s).

This reroute would replace one or more existing reroutes; you can modify the name and remove the suffix if you want.

To view the impact of replacing one or more active, required public reroutes on flights and sector alerts, select the Reroute Analysis tab. From the Reroute Analysis tab you can open the NAS Monitor in Model mode. All the model results will display the combined impact of adding the proposed reroute and cancelling the selected reroutes.

For more information on the using the NAS Monitor in Model mode, see page 4-418, in this chapter.
Model Reroute Cancellation

The Model Reroute Cancellation option on the Functions menu of the Select Reroutes dialog box allows you to view, in Model mode, the impact on the NAS of cancelling a public reroute. This option is enabled on the Functions menu if the selected reroute is a single, active (not expired), required public reroute and you are authorized to create or edit public reroutes. Also, the selected reroute must have explicit reroute segments. That is, if the reroute has only non-explicit reroute segments, such as UPT, you cannot model the impact of cancelling it.

When you select this menu option, the TSD will request the model results that will indicate the impact of cancelling the selected reroute. When the model results are received, the View Reroute Cancellation dialog box opens in Model mode.

To view the impact of cancelling the reroute on sector alerts, select the Reroute Analysis tab. When you open the NAS Monitor or examine an FEA/FCA, all flight counts and alerts will display the impact of cancelling the reroute.

Note: Modeling the cancellation of a reroute does not actually cancel it. To cancel a reroute, go to the Select Reroutes dialog box and select the Delete Reroute option, the same way as you currently do.
Using the MIT Status Button

When you are modeling a reroute, the MIT Status button displays in any window where model results are shown: the menu bar of the TSD and the following dialog boxes: Create/Edit/View Reroute, NAS Monitor (accessed from the Reroute Analysis tab), NAS Monitor Bar Chart, Examine FEA/FCA, and FEA/FCA Bar Chart. The button acts as a toggle allowing you to include or exclude modeled MIT delay data in model results. When you toggle the button, the TSD displays model results that either include or exclude the effects of the MIT restrictions on the following:

- Point of Interest (POI) timelines and flight lists
- Sector counts displayed on the Reroute Analysis tab
- Alerts and peak counts displayed in the NAS Monitor
- FEA/FCA counts on the FEA/FCA timeline and bar chart.

**Note:** When toggling the MIT Status button the MIT Flight List is not updated. The MIT Flight List continues to show all flights affected by an MIT even when the MIT Status button is toggled off. Also note that if you toggle the MIT status button in one window, the TSD will automatically toggle the state of the button in all other windows on your TSD. This ensures that you are always looking at consistent model results everywhere; either all of the model results include MIT impacts, or none of them do.

If you have not defined an MIT restriction for a reroute you are modeling, the MIT status button displays with an X over the label as follows:

![MIT](image)

The tool tip shown below is displayed when you have not defined an MIT restriction and you hover the cursor over the button.

**MIT have not been modeled for this reroute.**

If you create and model an MIT Restriction for the reroute, the MIT Status button displays as follows indicating that modeled MIT delays exist and are included in the model results.

![MIT](image)
The tool tip shown below displays after you create and model an MIT Restriction and you hover the cursor over the MIT status button.

**Reroute model results include modeled MIT delays.**
*Click to change.*

To toggle data for modeled MIT delays off and show model results, click the **MIT** status button. If MIT model results exist for a reroute but the model results are turned off, the button displays with a single slash over the label.

The tool tip shown below displays when model results exist but are turned off and you hover the cursor over the MIT Status button. To show model results that include MIT delays, click the button.

**Reroute model results do not include modeled MIT delays.**
*Click to change.*
POI Flight List Dialog Box

The View menu of the Create/Edit Reroute dialog box has a Point of Interest (POI) Flight List option that lets you view the flights that are predicted to pass over a POI on a selected route segment. If you browse the pointer over one or more reroute segments while in Preview or Model mode, the TSD highlights the segment(s), shows the associated navaids and their labels, and temporarily displays a tool tip that displays the number of flights that are included in the reroute at the location of the pointer.

After you right-click to establish a POI on the reroute, right-click to open the menu and select **Show Flight List**. A POI symbol (diamond shape) displays at the POI location and the POI Flight List dialog box opens.

The POI Flight List dialog box is shown below.

![POI Flight List Dialog Box](image)

**Note:** You can display a flight list for only one POI along the route. The POI that is associated with the flight list is indicated with a diamond on the route segment. If you select the flight list option for a different POI, the flight list dialog box will be updated to show the flights for the new POI. You can draw rerouted flights on the TSD when you are in the Model mode. In Preview mode, the Draw Flights icon, in the upper left corner of the dialog box, is disabled (grayed out).
### Using the POI Flight List Dialog Box

The POI Flight List dialog box displays the list of flights predicted to pass over the POI, a timeline, and the following fields and buttons.

#### POI Flight List Dialog Box

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Menu</td>
<td>The File menu provides a Close option for closing the POI Flight List dialog box.</td>
</tr>
<tr>
<td>Functions Menu</td>
<td>The Functions Menu provides Advanced Sort and Customize Columns options.</td>
</tr>
<tr>
<td>Draw Flights</td>
<td><strong>This button is enabled in Model mode only.</strong> Use this button to show or hide the rerouted flights listed in the Flight list. A flight is shown on the map if the Draw Flights button has been set to show flights, the flight's checkbox is checked, and the flight crosses the POI during the time range selected in the timeline. The button indicates that flights are hidden by displaying a red “x” through the flight icon. For more information, see the POI Draw Flights Function section on page 4-388.</td>
</tr>
<tr>
<td>Flight count</td>
<td>This count represents the total count of flights predicted to pass over the POI during the selected time range.</td>
</tr>
<tr>
<td>Last update/Model time</td>
<td>If you are in Preview mode the time that displays is the last time that flight data was updated. If you are in Model mode the time that displays is the time at which modeling was requested.</td>
</tr>
<tr>
<td>Advanced Sort</td>
<td>Use this button to open the Advanced Sort dialog box (see page 4-359) and set sort options for the Flight List. You can click on any of the column headers on the POI Flight List dialog box to toggle the sort order of the columns in ascending or descending order.</td>
</tr>
<tr>
<td>Customize Columns</td>
<td>Use this button to open the Customize Columns dialog box (see page 4-362) and add, remove, or reorder the columns in the Flight List.</td>
</tr>
<tr>
<td>POI Time</td>
<td>The Timeline section of the POI Flight List displays the number of flights that cross over the POI during quarter-hour time intervals. The first time interval represents the quarter hour during which the first rerouted flight crosses the POI. The last time interval represents the quarter hour during which the last rerouted flight crosses the POI. By selecting time intervals in the timeline, you can determine the time range of flights that are shown in the Flight List.</td>
</tr>
</tbody>
</table>
POI Flight List Dialog Box (Continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>POI Flight List</td>
<td>Displays a row for every flight in the reroute that is predicted to cross the POI during the time range you select in the Timeline. Displays columns as selected in Customize Columns Option. For more information on the POI Flight List, see page 4-387</td>
</tr>
<tr>
<td>Print Flight List</td>
<td>Use this button to print a hardcopy of the POI Flight List. Clicking this button opens the Print Flights dialog box. On the Print Flights dialog box, the default Print Command is displayed. After specifying the number of copies to print, click OK.</td>
</tr>
</tbody>
</table>

Selecting Time Intervals on the POI Flight List Timeline

When the POI Flight List dialog box is first opened, all time intervals in the timeline during which flights cross the POI are selected. With all time intervals selected, all flights for the entire timeline display in the Flight List. To change the time range of flights shown, do one of the following:

- Click on a single time interval. You can click on either the count or the quarter-hour time cell. Both cells become selected for that interval.

- With one interval selected, press and hold the \(<\text{Shift}\>\) key and click on another interval. All time intervals, the first and last selected as well as those in between, are highlighted.

- With the pointer on either the count or the time cell, press and hold the left mouse button while dragging the pointer to another interval. All time intervals from the first to the last are selected. If you drag the pointer to the right of the last visible interval, the timeline scrolls to the right.
POI Flight List

The POI Flight List displays a row for every flight in the reroute that is predicted to cross the POI during the time range you select in the Timeline. When you first open the POI Flight List, the rows are sorted based on the settings in the Reroute Preferences. To change the sort order, click a column header. The sort toggles between ascending and descending order. An upward pointing arrow indicates that a column is sorted in ascending order. Clicking on the column header sorts the column in descending order and the arrow points downward. You can also select the Advanced Sort button to open the Advanced Sort dialog box and set sort options.

**Note:** If you are sorting by ACID, the TSD sorts the Flight List alphabetically by airline code and then numerically by flight number. If you are sorting by a time-related column that contains values with an alpha prefix such as ETD, the TSD sorts the list based on the time value and ignores the prefix.

To add a column, remove a column, or reorder the columns in the Flight List, use the Customize Columns button to open the Customize Columns dialog box. The default column selections are defined through the Reroute Preferences command. You can adjust the width of a column by positioning the pointer over the right edge of a column header, left-clicking, and “dragging” the edge left or right. If you subsequently open the POI Flight List dialog box during the same TSD session, the column widths display as they were when you last closed the dialog box. You can also resize the entire POI Flight List dialog box both horizontally and vertically. To resize vertically, hover the pointer over the bottom edge of the dialog box and drag up or down. To resize horizontally, hover the pointer over the left or right edge of the dialog box and drag left or right.

**Note:** The TSD refreshes the POI Flight List when it receives updated model results and when you turn a reroute segment on or off or toggle the global MIT status setting on or off.
POI Flight List ACID Column

The ACID column is a fixed column and cannot be moved to another column location or removed from the Flight List. To indicate that a flight is part of one or more public required reroutes already issued, the Flight List displays the ACID for the flight in blue. To display a tool tip listing the Advisory number (or 3 dashes if no number) and reroute name (or N/A if not available) of all other public required reroutes that contain the flight, place the pointer over the flight's blue ACID value. In the example below, the tool tip indicates that the flight with an ACID of AAL16 is also in the reroute with an advisory number and name of 714 YQT.

The menu bar provides a File menu and a Functions menu. The File menu provides a Close option for closing the POI Flight List dialog box. The Functions Menu provides Advanced Sort and Customize Columns options.

POI Draw Flights Function

When the TSD is operating in Model mode, the POI Flight List provides the capability to draw rerouted flights on the TSD map. To select the flights you want drawn, use the checkbox in the first column of each row. Click on the column header to select or deselect all checkboxes for the flights currently in the list. The TSD draws a flight if the flight's checkbox is checked, the Draw Flights button is set to show flights, and the flight crosses the POI during the time range selected in the timeline.

Note: In Preview mode, the Draw Flights icon, in the upper left corner of the dialog box, is grayed out. The drawing of rerouted flights is disabled in Preview mode because of a conflict with the drawing of active flights, which is constantly being updated, and the drawing of rerouted flight data that is based on a snapshot in time.

The TSD draws active, rerouted flights using the standard flight icon and inactive flights using the standard circle icon. When a rerouted flight is drawn, the TSD displays the flight's current route and the flight's modeled route on the reroute. The current route is drawn as a dashed 1-pixel line and the modeled reroute is drawn as a solid 2-pixel line.
**Note:** For modeling purposes, the system determines an end-to-end route by merging a flight’s current route with its assigned reroute in a way that avoids any excessive turn angles.

If you browse over the drawn flight icon, current route, or modeled route, the TSD highlights all three items for the flight. Flight icons and routes for rerouted flights are drawn in the same color as the reroute. The image below shows the highlighted flight icon for flight N84PJ, its data block, and its current and modeled routes, all of which are being browsed and shaded black.

In Model mode the flight display is static, showing flight positions as they were when the model was generated. The display does not automatically update the flight positions the way it does in Normal mode. If you want to update the flight positions, you must remodel the reroute.

**Note:** You can use the Customize Flight Display dialog box, accessed from the Flights menu, to control the display of flight data blocks.

**POI Timeline: TSD Display**

When you browse the pointer over a reroute segment in Preview or Model mode, the TSD displays a tooltip with a Point of Interest (POI) timeline at the location of the pointer. The POI timeline displays as a single number representing the total number of flights in the reroute that would cross the POI or as a timeline showing the hourly or quarter-hourly flight count over the POI.

You can access the Show POI Counts By options and set how you want POI counts to display by selecting the View menu on the Create Reroute dialog box or by right-clicking when browsing a fixed POI timeline.

**Note:** To fix the display of the POI timeline on the map, press the middle mouse button. A leader line runs from the timeline to the POI location. To remove the display of the POI Timeline use the right-click menu option Hide POI Counts. The POI Timeline right-click menu is discussed on the next page.
If you choose to display the timeline showing hourly or quarter-hourly flight counts, the total flight count for all hours displays at the bottom of the timeline.

Remember that only the flights that are in the reroute are counted; any flight that crosses the POI but is not part of the reroute is not counted. Also, if a flight has several assigned route options in the reroute, it is counted only on the assigned route that TFMS has used to model the flight. In most cases this is the assigned option with the shortest flying time.

The image below displays the POI timeline showing flight counts on a quarter-hourly basis and the POI right-click menu.

![POI Timeline Right-Click Menu Diagram](image)

The right click menu options accessed when browsing a fixed POI timeline are explained in the following table.

### POI Timeline Right-Click Menu

<table>
<thead>
<tr>
<th>Data Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show POI Counts by Total</td>
<td>Displays the total number of flights to cross a POI on a reroute segment</td>
</tr>
<tr>
<td>Show POI Counts by Hour</td>
<td>This is the default setting. Displays a line for each hour that shows the beginning time of the hour and the count of flights for that hour.</td>
</tr>
<tr>
<td>Show POI Counts by 15 Min</td>
<td>Displays a line for each hour that shows the beginning time of the hour followed by four counts, one for each quarter-hour.</td>
</tr>
<tr>
<td>Hide POI Counts</td>
<td>Removes POI counts from the map.</td>
</tr>
<tr>
<td>Show POI Flight List</td>
<td>Displays the POI Flight List dialog box and a POI symbol at the POI location on the reroute segment</td>
</tr>
</tbody>
</table>
Note: The TSD updates all POI timelines displayed on the map when you remodel, turn a reroute segment on or off, or toggle the global MIT status setting on or off.

Miles In Trail (MIT) Restrictions

An MIT restriction is defined by the set of flights to be considered, the amount of separation required between those flights, and the place at which the separation is required. You can specify MIT restrictions by two methods

1. A basic approach in which you can graphically indicate each location on a proposed reroute where a MIT restriction is be applied. The basic approach can be used when you only want to apply the MIT restriction to flights that are involved in the reroute.

2. A more advanced approach based on FEA/FCAs. You would use the FEA/FCA approach if you want to apply the MIT restriction to both rerouted and non-rerouted flights, or you want to specify filter conditions to limit the flights to which the MIT restriction is applied.

The Restrictions Tab displays model data and the impacted flights for any MIT restriction(s) that have been created for a reroute. The drawn restriction for a modeled reroute also displays model data in its data block on the TSD map.

For more information on viewing drawn MIT restrictions and their data blocks, see page 4-409.
Restrictions Tab in Model Mode

The Restrictions Tab of the Create/Edit Reroute dialog box provides access to the Create/Edit dialog box Restrictions tab, displays a list of existing restrictions currently associated with the reroute, and, if available, displays model data on the MIT and impacted flights. Clicking on the Restrictions tab displays the following dialog box.
Using the Restrictions Tab

The following table discusses the information displayed in the Restrictions tab grid.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Column Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name entered on the Create MIT Restriction dialog box. The MIT Restrictions List is sorted by name.</td>
</tr>
<tr>
<td>MIT</td>
<td>The spacing defined for the MIT Restriction. Note: You can edit this value directly in the grid. To edit the value, double-click the cell.</td>
</tr>
<tr>
<td>Start</td>
<td>Start time for the MIT (ddhhmm).</td>
</tr>
<tr>
<td></td>
<td>• If the MIT Auto Time option was selected and the reroute is not modeled, this cell displays blank.</td>
</tr>
<tr>
<td></td>
<td>• If the MIT Auto Time option was selected and the reroute has been modeled since the MIT was created or updated, the date and time that the first flight that required a delay crossed the restriction is displayed.</td>
</tr>
<tr>
<td></td>
<td>• If the Manual Time option was selected, the start date and time that was manually entered in the Reroute Definition tab displays.</td>
</tr>
<tr>
<td></td>
<td>• If the FEA/FCA Time option was selected, the start date and time of the FEA/FCA selected for the MIT displays.</td>
</tr>
<tr>
<td>Stop</td>
<td>Stop time for the MIT (ddhhmm)</td>
</tr>
<tr>
<td></td>
<td>• If the MIT Auto Time option was selected and the reroute is not modeled, this cell displays blank.</td>
</tr>
<tr>
<td></td>
<td>• If the MIT Auto Time option was selected and the reroute has been modeled since the MIT was created or updated, the date and time that the last flight that required a delay crossed the restriction is displayed.</td>
</tr>
<tr>
<td></td>
<td>• If the Manual Time option was selected, the stop date and time that was manually entered displays.</td>
</tr>
<tr>
<td></td>
<td>• If the FEA/FCA Time option was selected, the stop date and time of the FEA/FCA selected for the MIT displays.</td>
</tr>
<tr>
<td># Flights</td>
<td>The number of flights that intersect with the MIT.</td>
</tr>
<tr>
<td># Delayed Flights</td>
<td>The number of flights that are delayed due to the MIT.</td>
</tr>
<tr>
<td>Average Delay</td>
<td>The time in minutes of the average delay at this restriction.</td>
</tr>
<tr>
<td>Maximum Delay</td>
<td>The time in minutes of the maximum delay at this restriction.</td>
</tr>
</tbody>
</table>
A Create button displays to the left of the name field in each row allowing you to open the Create/Edit MIT Restriction dialog box and define an MIT restriction. If there are existing MIT restrictions, an Edit button displays.

After clicking the Create or Edit button, the Create/Edit MIT Restriction dialog box opens.

The Create/Edit MIT Restriction dialog box lets you enter or edit an MIT restriction for a reroute. You can also access this dialog box by:

- Right-clicking the TSD map and selecting the Create MIT option from the right-click menu. Note that routes on the TSD and in the Reroute Definition route grid must be deselected.
- Browsing a drawn MIT, right-clicking, and selecting the Edit MIT option.
Using the Create/Edit MIT Restrictions Dialog Box

The following table explains the items available in the basic version of the Create MIT Restrictions dialog box. The procedures for using the Edit version of this dialog box are the same.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What You Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>MIT Name</td>
<td>The name of the restriction.</td>
<td>Enter up to 34 characters. This field accepts only alphanumeric characters, underscores, and dashes.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If you define an MIT based on a Navaid, the TSD automatically sets the MIT name to MIT_'name of Navaid'.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If you define an MIT based on an FEA/FCA, the TSD automatically sets the MIT name to MIT_'name of FEA/FCA'.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• You can edit the default name.</td>
</tr>
<tr>
<td>As One Spacing</td>
<td>Use this field to specify a value for “As One” spacing. TFMS applies the</td>
<td>Enter an integer from 1 to 100 or click the down-arrow for a picklist of entries.</td>
</tr>
<tr>
<td></td>
<td>spacing value you enter in this field to any flights assigned “As One”</td>
<td></td>
</tr>
<tr>
<td></td>
<td>spacing. You can assign As One spacing to an MIT with secondary or destination filters.</td>
<td></td>
</tr>
<tr>
<td>Define MIT based on</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Crossing Segment</td>
<td>Allows you to base the MIT on a crossing segment.</td>
<td>To base the MIT on a crossing segment, click this button and click two points on either side of the reroute on the map to define a crossing segment.</td>
</tr>
<tr>
<td>Erase Segment</td>
<td>This button becomes active if you define a crossing segment.</td>
<td>To remove the crossing segment from the TSD map, click this button.</td>
</tr>
</tbody>
</table>
## Create MIT Restriction - Basic Version (Continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What You Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navaid</td>
<td>Allows you to base the MIT on a Navaid. The Navaid picklist becomes active when you click the NAVAID radio button.</td>
<td>To base the MIT on a Navaid, click this button. Click the down-arrow button for a picklist of Navaids on any segment in the reroute. If you begin to type a string of characters in this field, the TSD automatically completes your entry.</td>
</tr>
<tr>
<td>FEA/FCA</td>
<td>Allows you to base the MIT on a line FEA/FCA. The FEA/FCA picklist becomes active when you click the FEA/FCA radio button.</td>
<td>To base the MIT on a line FEA/FCA, click this button. Click the down-arrow for a picklist of all active, non-moving line FEA/FCAs available on the workstation. Note: FEA/FCAs created with the polygon option in Create/FEA/FCA will not appear in the list. After you select an FEA/FCA from the picklist, the FEA/FCA Secondary Filter section opens AND the start and stop times for the FEA/FCA display (grayed out) to the right of the FEA/FCA radio button in the MIT Start/Stop Time section.</td>
</tr>
<tr>
<td>Specify MIT by Destination</td>
<td>This button is active if you selected the Crossing Segment radio button and drew a crossing segment OR if you selected the Navaid radio button and entered a Navaid in the picklist field.</td>
<td>If active, click the button to specify the MIT by destination and opens the Destination Filter section. Note: If a flight list for the reroute has not been generated, the TSD displays a message that a flight list must first be generated. After you click OK, the TSD generates a flight list and the Destination Filter section opens. The Destination Filter section is discussed on page 4-398.</td>
</tr>
</tbody>
</table>
## Create MIT Restriction - Basic Version (Continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What You Do</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>MIT Start/Stop Time</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Auto</td>
<td>Allows you to base the MIT Start and Stop date/times on the crossing times of the first flight and last flights affected by the restriction. This is the default selection.</td>
<td>To specify the Auto setting, click this radio button.</td>
</tr>
<tr>
<td>Manual</td>
<td>Allows you to manually enter MIT Start and Stop date/times or to change the default Start and Stop times of the Reroute.</td>
<td>To manually enter Start and Stop date/times, click this radio button.</td>
</tr>
<tr>
<td>Start</td>
<td>Allows you to manually enter an MIT Start date and time.</td>
<td>The start date and time of the reroute automatically displays as the default. You can edit the default entry.</td>
</tr>
<tr>
<td>Stop</td>
<td>Allows you to manually enter an MIT Stop date and time.</td>
<td>The stop date and time of the reroute automatically displays as the default. You can edit the default entry.</td>
</tr>
<tr>
<td>FEA/FCA</td>
<td>Allows you to set the MIT Start and Stop date/times as the start and stop date/times of the selected FEA/FCA.</td>
<td>To set the MIT Start and Stop date/times as the start and stop date/times of the FEA/FCA, click this radio button. After clicking this button, the FEA/FCA start and stop times to the right of the button display as active. These values cannot be changed here; you must edit the FEA/FCA if you want to change them.</td>
</tr>
</tbody>
</table>
Specify MIT By Destination

You have the option to specify different MIT spacing for each traffic flow affected by the MIT. This function depends on whether the MIT has been defined based on a crossing segment, a navaid, or an FEA/FCA.

Destination Filter Panel

If you are defining an MIT Restriction based on a crossing segment or navaid and want to define a destination filter, do the following:

1. Select the Crossing Segment radio button OR select the Navaid radio button.
2. Draw the crossing segment on the map OR select a navaid from the picklist field.
3. Click the Specify MIT by Destination button.

After you click the Specify MIT by Destination button, an expanded version of the Create MIT dialog box displays. However, if you are not currently in either Preview or Model mode, the TSD must first generate a list of flights that are affected by the reroute so it can determine all the destination airports to which flights crossing the MIT are going. Therefore, if the TSD is not currently in Preview or Model mode, the TSD will display the following dialog box and will open the destination filter panel only if you click Yes to generate a flight list first.
After the TSD generates a flight list, Create MIT Restriction dialog box with the destination filter panel displays.

The Specify MIT by Destination Panel displays up to 10 rows of filters. If there are more than 10 rows, use the scroll bar to view all destination filters.
The following table explains the items available in the Specify MIT by destination panel in the expanded version of the Create MIT Restrictions dialog box. The procedures for using the Edit version of this panel are the same.

**Create MIT Restrictions - Specify MIT by Destination Panel**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What You Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space All by Dest</td>
<td>Allows you to set separate spacing for all destination filters in the list. The default spacing value for each filter is set to the As One Spacing value to the right of the MIT name.</td>
<td>To set separate spacing for all destination filters, click this button. After clicking this button you can edit any individual spacing value for any of the filters.</td>
</tr>
<tr>
<td>Space All As One</td>
<td>Allows you to automatically apply As One spacing to all destination filters. If you select this button, the TSD displays the text “As One” in the Spacing column for all destination filters.</td>
<td>To specify that “As One” spacing is to be applied to all destinations, click this button. The spacing value entered in the As One Spacing field above will be applied to all filters as a group. After clicking this button you can edit any individual spacing value for any of the filters.</td>
</tr>
<tr>
<td>#</td>
<td>This column shows the count of the number of flights in the reroute impacted by the MIT with the destination airport displayed to the right.</td>
<td>This field cannot be edited.</td>
</tr>
<tr>
<td>Destination Airport Name</td>
<td>The name of the destination airport of the flights impacted by the MIT. This list is sorted in ascending alphabetical order by destination airport name.</td>
<td>This field cannot be edited.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
<td>What You Do</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Destination Spacing</td>
<td>A data entry field that allows you to enter the MIT spacing that will be applied to the flight going to each destination.</td>
<td>Enter an integer from 1 to 100 or click the down-arrow for a picklist of entries. The list includes the entries, “As One” and “Exclude”.</td>
</tr>
</tbody>
</table>
|                      | • **A numeric value** – If a destination has a numeric value, then that spacing will be applied independently to the flights going to that destination, without affecting the delay applied to flights going to any other destination.  
|                      | • **As One** – Flights with the “As One” designation will be grouped together, and the “As One Spacing” value entered in the top right corner of the dialog box will be applied to these flights as a group.  
|                      | • **Exclude** – Any flight going to a destination with the “Exclude” designation will not be part of this MIT. These flights will not receive any MIT delay at this MIT point, and their crossing time at the MIT point will not affect the delay that is applied to any other flight. |                                                                            |
| Clear Destination Filters | Allows you to clear all destination filters.                                  | To clear all destination filters, click this button. A confirmation dialog box displays. |
FEA/FCA Secondary Filter Panel

If you are defining an MIT Restriction based on a line FEA/FCA, select the FEA/FCA radio button and click the down arrow button in the FEA/FCA picklist field. An expanded version of the Create MIT dialog box displays.

**Note:** In the following example, a secondary filter exists for the selected FEA/FCA. If no secondary filter exists for an FEA/FCA, the dialog box indicates that none exist and the two buttons, Space All By Filter and Space All As One, do not display.

![Create MIT Restriction for BUM_CAN](image)

The FEA/FCA Secondary Filter Panel displays up to 10 rows of filters. If there are more than 10 rows, use the scroll bar to view all filters. The last row represents all flights that do not meet any of the secondary filter conditions and is labeled “RESIDUALS”.

![MIT Create MIT Restriction for BUM_CAN](image)
The following table explains the items available in the FEA/FCA panel in the expanded version of the Create MIT Restrictions dialog box. The procedures for using the Edit version of this panel are the same.

### Create MIT Restriction Dialog Box - FEA/FCA Panel

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What You Do</th>
</tr>
</thead>
</table>
| Apply MIT To          | Allows you to specify to which flights the MIT restriction applies. | Click the **All**, **In Reroute**, or **Not In Reroute** radio button.  
  • **All** – The MIT is applied to all flights that intersect the selected FEA/FCA, even those that are not part of the reroute.  
  • **In Reroute** – The MIT is applied only to those flights that are included in the reroute and that intersect the FEA/FCA when modeling on their assigned reroute.  
  • **Not in Reroute** – The MIT is applied only to those flights that intersect the FEA/FCA and are not included in the reroute. |
| Space All By Filter   | Allows you to set separate spacing for all secondary filters in the list. The default spacing value for each filter is set to the As One Spacing value to the right of the MIT name. | To set separate spacing for all secondary filters, click this button. After clicking this button you can edit any individual spacing value for any of the filters. |
| Space All As One      | Allows you to automatically apply As One spacing to all secondary filters. If you select this button, the TSD displays the text “As One” in the Spacing column for all secondary filters. | To specify that “As One” spacing is to be applied to all secondary filter sets, click this button. The spacing value entered in the As One Spacing field above will be applied to all filters as a group. After clicking this button you can edit any individual spacing value for any of the filters. |
| Secondary Filter Name | Name of the secondary filters available on the workstation for the selected FEA/FCA. Secondary filter names are sorted alphabetically. The last row in the list displays as “Residual”. | This field cannot be edited. See Secondary Filters, below. |
### Create MIT Restriction Dialog Box - FEA/FCA Panel (Continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What You Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secondary Filter</td>
<td>A data entry field for entering Miles-in-Trail spacing.</td>
<td>Enter an integer from 1 to 100 or click the down-arrow for a picklist of entries. The list includes the entries, “As One” and “Exclude”.</td>
</tr>
<tr>
<td>Spacing</td>
<td></td>
<td>• <strong>A numeric value</strong> – If a secondary filter has a numeric value, then that spacing will be applied independently to the flights that match that filter, without affecting the delay applied to flights that match any other filter.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>As One</strong> – Flights with the “As One” designation will be grouped together, and the “As One Spacing” value entered in the top right corner of the dialog box will be applied to these flights as a group.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Exclude</strong> – Any flight that matches a filter with the “Exclude” designation will not be part of this MIT. These flights will not receive any MIT delay at this MIT point, and their crossing time at the MIT point will not affect the delay that is applied to any other flight.</td>
</tr>
</tbody>
</table>
Secondary Filters

If secondary filters have been defined for the selected FEA/FCA, the panel will list each secondary filter and allow you to specify the spacing that is to be applied to each secondary filter flow. That is, you can choose the value “As One,” “Exclude,” or a numerical value between 1 and 100 for each flow. Or, you can use the Space All by Filter and Space All As One buttons as a shortcut to set the all the spacings to the same value.

If no secondary filters have been defined for the selected FEA/FCA, the text “No Secondary Filters” will be displayed in place of the filter list and the Space All by Filter and Space All As One buttons will not be displayed. You can still choose whether the MIT will be applied to all, rerouted, or non-rerouted flights, but the same spacing will be applied to all of the indicated flights.

Saving the MIT Restriction

To create or save changes to the MIT Restriction and close the Create/Edit MIT Restriction dialog box, click OK. The TSD updates the Restrictions Tab to show the newly created/edited restriction. The TSD also draws or redraws the restriction on the map.

For information on the drawn restriction, before and after model results are generated, see page 4-409 Viewing the Drawn MIT Restriction.
MITs with Secondary or Destination Filters

If you create an MIT Restriction with a secondary or destination filter and specify a numerical spacing value for the filter, a separate row for the filter displays on the Restriction tab after the restriction is saved. In the following example, the Create MIT Restriction dialog box shows a restriction being created for the navaid BUM called MIT_BUM. The destinations LAX and SFO have numerical spacing values of 10 and 15 entered respectively. All other destinations show "As One" spacing selected. The image displayed to the right shows the Restrictions Tab after the restriction was saved and before model results are available. Separate rows show for the LAX and SFO filters with their spacing values. All other destinations are included in the group with an "As One" spacing of 20.
In the example below, the Create/Edit MIT Restriction dialog box shows an MIT restriction based on an FEA called MIT_FEA033. A secondary filter for the FEA exists named JFK_ORD with a spacing value of 20. Residual flights have “As One” spacing selected. The image displayed to the right shows the Restrictions Tab after the restriction was saved and before model results are available. The JFK_ORD filter shows a separate row with its specified spacing of 20. The residual flights are included in the group with an “As One” spacing of 10. These are the flights that match the MIT definition but do not match the specified filter.
MIT Model Results Displayed on the Restrictions Tab

The following image shows the Restrictions tab with model results for a reroute with MIT restrictions. Model results include the number of flights that intersect with the MIT, the number of flights that are delayed due to the MIT, the time in minutes of the average delay, and the time in minutes of the maximum delay.

For information on the display of MIT restrictions on the map, see Viewing Drawn MIT Restrictions on page 4-409.

Note that the MIT Status button in the image below indicates that modeled MIT delays exist and that model results for the reroute reflect the delays.

Note: You can hover over the cells, # Delayed Flights, Average Delay, and Maximum Delay, and display a tool tip showing airborne and ground delay data for each cell.

Disabling an MIT Restriction

On the Restrictions tab, each row has a checkbox to the left of the Create/Edit button. When you create an MIT restriction, this checkbox is checked by default, meaning that the MIT you have created will be included in the model results. You can click the checkbox to toggle the checkbox to enable (checked) or disable (unchecked) the MIT restriction.

When you disable an MIT restriction, any model results displayed in that row will be grayed out. When you remodel the reroute, any disabled MIT will be ignored in the modeling.
Delete Selected MIT(s) Button

Use this button to delete selected (highlighted) MIT restrictions listed on the Restrictions tab. To select a row, left click the row number. To select more than one row, use the <Shift>-left-click or <Ctrl>-left-click method. After selecting a row or rows and clicking the Delete Selected MIT(s) button, a confirmation dialog box displays asking if you are sure you want to delete the selected MIT(s).

Viewing Drawn MIT Restrictions

After you save an MIT Restriction and close the Create/Edit MIT Restriction dialog box, the TSD updates the Restriction Tab with information on the newly created/edited restriction.

Viewing the Drawn Restriction Before Modeling/Remodeling

The TSD draws the saved MIT restriction on the map in the color defined for the reroute. An MIT restriction based on a crossing segment or on a line FEA/FCA displays as a line segment on the map. If the MIT restriction is based on a navaid, the TSD draws the restriction as a solid circle at the location of the navaid if navaids are not already set to display on the Reroute Definition tab. The saved MIT Restriction also displays with a data block.

Prior to modeling, the data block for an MIT restriction displays two lines of information. The first line displays the MIT name. The second line displays a text string that indicates which flights are included in the MIT and the spacing value that was specified for the restriction. If destination filters for a crossing segment or navaid restriction or secondary filters for an FEA/FCA restriction were specified, the text “Filtered” displays instead of a spacing value. The second line of the data block indicates which flights are included in an MIT by the following text.

<table>
<thead>
<tr>
<th>Text</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RR</td>
<td>MIT restriction is either non-FEA/FCA based OR the MIT is FEA/FCA based and applies to those flights passing through the FEA/FCA that are in the reroute.</td>
</tr>
<tr>
<td>ALL</td>
<td>MIT restriction is FEA/FCA based and applies to all flights that pass through the FEA/FCA.</td>
</tr>
<tr>
<td>NoRR</td>
<td>MIT restriction is FEA/FCA based and applies to those flights passing through the FEA/FCA that are not in the reroute.</td>
</tr>
</tbody>
</table>
The following example shows an FEA/FCA MIT restriction for a reroute. The data block for the restriction indicates that the name is MIT_FEA132. The second line of text in the data block indicates that the restriction applies to ALL flights in the reroute and has a spacing value of 5.

\[\text{Note: Use the middle-click button to drag and relocate the MIT restriction's data block.}\]
Viewing the Drawn Restriction After Modeling/Remodeling

After modeling the reroute, the data block for an MIT restriction displays three lines of information. The first two lines are explained in the prior section, Viewing the Drawn Restriction Before Modeling/Remodeling. The third line of text displays after modeling results have been generated and indicates the number of flights subject to the MIT, the average per-flight delay for the MIT, and the maximum delay for the MIT.

The following example shows the MIT restriction after modeling results have been generated. The third line in the data block for the restriction indicates that 80 flights are subject to the restriction, the average per-flight delay is 13 minutes, and the maximum delay is 31 minutes.
Browsing the MIT Restriction

You can browse the MIT restriction independent of the reroute. Browsing the restriction highlights the restriction in black. Right-clicking while browsing highlights the restriction and displays the following right-click menu:

- **Toggle Data Block**
  Clicking the **Toggle Data Block** option turns the display of the MIT data block on or off.

- **Show MIT Flight List**
  See Miles-In-Trail (MIT) Flight List Option on page 4-413.

- **Edit MIT**
  See Using the Create/Edit MIT Restrictions Dialog Box on page 4-395

- **Delete MIT**
  Clicking the **Delete MIT** option displays a confirmation box asking you to confirm that you want to delete the MIT restriction.

The image below shows a browsed MIT Restriction and the right-click menu.

![MIT Restriction and Right-Click Menu](image)

**Note:** When you browse an MIT restriction, the data block for the restriction displays even if the data block has been toggled off.
Miles-In-Trail (MIT) Flight List Option

When modeling a reroute, you can access the Miles-in-Trail (MIT) Flight List option from the MIT right-click menu while browsing a drawn MIT. The MIT Flight List lets you view the flights that are included in the MIT and that are predicted to cross the MIT during a selected time range.

This is a sample of the MIT Flight List dialog box.

![MIT Flight List dialog box](image)
Using the MIT Flight List Dialog Box
The MIT Flight List dialog box displays the list of flights predicted to pass over the MIT, a timeline, and the following fields and buttons.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flight Count</td>
<td>This count represents the total count of flights predicted to pass over the MIT during the selected time range.</td>
</tr>
<tr>
<td>Model Time</td>
<td>The time that displays is the time at which modeling was requested.</td>
</tr>
<tr>
<td>Advanced Sort</td>
<td>Use this button to open the Advanced Sort dialog box and set sort settings for the MIT Flight List. See Advanced Sort Dialog Box (Flight List) on page 4-359.</td>
</tr>
<tr>
<td>Customize Columns</td>
<td>Use this button to open the Customize Columns dialog box and add, remove, or reorder the columns in the Flight List. See Customize Columns Dialog Box (Flight List) on page 4-362</td>
</tr>
<tr>
<td>Print Flight List Now</td>
<td>Use this button to print a hardcopy of the MIT Flight List. Clicking this button opens the Print Flights dialog box. On the Print Flights dialog box, the default Print Command is displayed. After specifying the number of copies to print, click <strong>OK</strong>.</td>
</tr>
</tbody>
</table>

MIT Flight List Timeline
The Timeline section of the MIT Flight List displays the number of flights that cross the MIT during each quarter-hour time interval after the MIT restriction is applied. The first time interval represents the quarter hour during which the first flight in the MIT Flight List crosses the MIT. The last interval represents the quarter hour during which the last flight in the MIT Flight List crosses the MIT. By selecting time intervals in the timeline, you can determine the time range of flights that are shown in the Flight List.
Selecting Time Intervals on the MIT Flight List Timeline

When the MIT Flight List dialog box is first opened, all time intervals during which a flight crosses over the MIT are selected in the timeline. With all time intervals selected, all flights for the entire timeline display in the Flight List. To change the time range of flights shown, do one of the following:

- Click on a single time interval. You can click on either the count or the quarter-hour time cell. Both cells become selected for that interval.
- With one interval selected, press and hold the <Shift> key and click on another interval. All time intervals, the first and last selected as well as those in between are highlighted.
- With the pointer on either the count or the time cell, press and hold the left mouse button while dragging the pointer to another interval. All time intervals from the first to the last are selected. If you drag the pointer to the right of the last visible interval the timeline scrolls to the right.

Using the MIT Flight List

The MIT Flight List displays a row for every flight in the reroute that is predicted to cross the MIT during the time range you select in the Timeline. When you first open the MIT Flight List, the rows are sorted based on the settings in the Reroute Preferences. To change the sort order, click a column header. The sort toggles between ascending and descending order. An upward pointing arrow indicates that a column is sorted in ascending order. Clicking on the column header sorts the column in descending order and the arrow points downward. You can also click the Advanced Sort button to open the Advanced Sort dialog box.

Note: If you are sorting by ACID, the TSD sorts the Flight List alphabetically by airline code and then numerically by flight number. If you are sorting by a time-related column that contains values with an alpha prefix such as ETD, the TSD sorts the list based on the time value and ignores the prefix.

You can adjust the width of a column by positioning the pointer over the right edge of a column header, left-clicking, and “dragging” the edge left or right. If you subsequently open the MIT Flight List dialog box during the same TSD session, the column widths display as they were when you last closed the dialog box. You can also resize the entire MIT Flight List dialog box. Hover the pointer over an edge of the dialog box and drag up or down to resize vertically or left or right to resize horizontally.

Note: The TSD refreshes the MIT Flight List when it receives updated model results or when you turn a reroute segment on or off. When toggling the MIT Status button the MIT Flight List is not updated. The MIT Flight List continues to show all flights affected by an MIT even when the MIT Status button is toggled off.
MIT Flight List ACID Column

The ACID column is a fixed column and cannot be moved to another column location or removed from the Flight List. To indicate that a flight is part of one or more public required reroutes already issued, the Flight List displays the ACID for the flight in blue. To display a tool tip listing the Advisory number (or 3 dashes if no number) and reroute name (or N/A if not available) of all other public required reroutes that contain the flight, place the pointer over the flight's blue ACID value. In the example below, the tool tip indicates that the flight with an ACID of AAL16 is also in the reroute with an advisory number and name of 518 CAN_1_EAST.

Note: If the ETD field is displayed in the Flight List and you hover the pointer over a cell in the ETD column, a tool tip displays that defines the prefix of the ETD value in the cell.
Flight List MIT Delay Column

If selected for display on the MIT Flight List, the MIT Delay column shows the estimated delay time of the MIT. If the airborne delay at an MIT is considered to be excessive, the delay will be displayed in red. This can be interpreted as an indication that a pass-back MIT might be needed in order to make this MIT feasible.

File Menu

The File menu provides a Close option for closing the MIT Flight List dialog box.

Functions Menu

The Functions Menu provides an Advanced Sort and Customize Columns option.

See Advanced Sort Dialog Box (Flight List) on page 4-359 and Customize Columns Dialog Box (Flight List) on page 4-362.

Returning to Normal Mode Functioning

The TSD returns to normal functioning when you click the **Clear** button, the **Cancel** button or close the Create/Edit or View Reroute dialog box. If you click the **Clear** button the Create/Edit Reroute dialog box remains open with all fields set to default states. If you close the dialog box or click **Cancel**, Create/Edit Reroute dialog box closes. In either case unsaved changes will be lost.
NAS Monitor in Model Mode

When modeling a reroute you can access the NAS Monitor from the Reroute Analysis Tab of the Create Reroute dialog box by clicking a center name in the Alerted Sector Peaks table or by selecting the Show NAS Monitor option from the Alerts menu of the TSD. If you click on a center name in the Alerted Sectors table, a NAS Monitor opens tabbed to the selected center.

Much of the functionality of the NAS Monitor in Model mode is the same as in Normal mode. This section discusses some of the differences.

For information on using the NAS Monitor in Normal mode, see Show NAS Monitor Command on page 4-82 in Chapter 4, Alerts Menu section.

NAS Monitor Control Panel in Model Mode

After clicking on a row label on the Reroute Analysis tab or selecting the Show NAS Monitor option on the Alerts menu, the NAS Monitor Control Panel and NAS Monitor open. The following image shows the NAS Monitor Control Panel in Model mode. The NAS Monitor Control Panel dialog box provides a “Model” button that allows you to bring the NAS Monitor dialog box to the front if hidden from view.
Using the NAS Monitor Dialog Box in Model Mode

The NAS Monitor in Model mode displays a tab for each center that is impacted by the proposed reroute. In the example below the tab ZDC is selected and displays on top. You can click on any tab to view the data for that center.

The tabs display in alphabetical order from left to right with US centers displayed first followed by Canadian centers. A horizontal scroll bar allows you to view all columns. The first column in the table displays the name of the sector, airport, or fix for the data in the row. As in Normal mode, if you browse over the name for a sector that is not in its baseline state, a tool tip displays that lists the sectors that are combined into that sector. However, note that this is based on the sectorization that was in place when the model was generated, which may be different from the current sectorization.

Each cell in the NAS Monitor shows the predicted sector peak flight count and the colored alert status for each time interval if the proposed reroute were to be issued. In some of the intervals the flight counts are followed by another number prefixed by a plus or minus sign. This number refers to the change in the peak flight count from the baseline, without the proposed reroute. If there is no change in the peak count due to the reroute, there is no second number displayed.

The NAS Monitor in Model mode has different cell resizing properties than the normal NAS monitor. Instead of shrinking the width of each column so that all columns can be displayed at the same time (as the NAS Monitor in Normal mode does), the NAS Monitor...
in Model mode keeps the cell widths constant and provides a horizontal scroll bar, if needed, to see all the columns.

**NAS Monitor Menu Bar**

The NAS Monitor menu bar has the following options and features:

**Functions Menu**

The Functions menu on the NAS Monitor dialog box in Model mode provides the NAS Monitor Bar Chart option and the Close command. For more information on using the NAS Monitor Bar Chart in Model mode, see page 4-418.

*Note:* You can also access the NAS Monitor Bar Chart option by right-clicking a row label or any cell in a row and selecting the option from the right-click menu.

**Customize Menu**

The Customize menu on the NAS Monitor dialog box in Model mode provides the following menu options. The functionality of these options is the same as in Normal mode. The Select Elements and Show All Baselines options and the Sort By settings can also be accessed through buttons located to the right of the Options Panel on the NAS Monitor dialog box in Model mode.

- Select Elements
- Show/Hide All Baselines
- Move Row Up
- Move Row Down
- Remove Row
- Sort By
- Show/Hide Options Panel

The Move Row Up, Move Row Down, and Remove Row options require that you select a row before issuing each command and are therefore grayed out if no row is selected or if the selected row is a baseline sector. The Move Row Up and Move Row Down options are also grayed out if the Sort By option is not set to Manual.

*Note:* You can also access the Show/Hide Baseline, Move Row Up, Move Row Down, and Remove Row options from the right-click menu.

**MIT Status Button**

If MIT restrictions exist, you can toggle the MIT Status button to show the impact of the reroute with and without the restrictions on flight counts and alert information. For more information on the MIT Status button, see Using the MIT Status Button on page 4-382 in this chapter.
TMI Warning Triangle Icon

If a Traffic Management Initiative (TMI) is issued, modified or deleted while you are viewing the NAS Monitor for a modeled reroute, the TMI warning triangle icon displays in the menu bar. For more information on the TMI warning triangle icon, see page 4-373.

NAS Monitor Show Options Panel

The NAS Monitor in Model mode provides an options panel that includes a “Show” group of radio buttons that control the selection of rows that are shown. The time that model results were last updated displays on the far right. The following table explains the Show radio buttons.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Impacted</td>
<td>Displays a row for any monitored element that has had at least one flight added, removed or time-shifted due to the reroute.</td>
</tr>
<tr>
<td>Alerted</td>
<td>Displays a row for any monitored element that is alerted in at least one time segment with or without the reroute.</td>
</tr>
<tr>
<td>Alerted and Count Up</td>
<td>Displays a row for any monitored element that has at least one time segment alerted with the reroute and the flight count is higher due to the proposed reroute.</td>
</tr>
<tr>
<td>All</td>
<td>Displays a row for all elements that meet the Select Elements criteria.</td>
</tr>
</tbody>
</table>
NAS Monitor Bar Chart in Model Mode

The Bar Chart command in model mode lets you generate a bar chart comparing the projected traffic demands for a NAS element with and without the proposed reroute. When viewing the NAS Monitor, you can access the NAS Monitor Bar Chart option by right-clicking a row label, or any cell in a row, and selecting the Bar Chart option from the right-click menu. You can also select the Bar Chart option from the NAS Monitor Functions menu or use the “C” quick key when the monitor has focus and the pointer is over a row. The NAS Monitor Bar Chart option opens in Model mode as shown below.

![Bar Chart in Model Mode](image)

The NAS Monitor Bar Chart menu bar has the following options and features:

- Functions menu allows you to close the bar chart and return to the NAS Monitor.
- Customize menu allows you to Show or Hide the options panel at the top of the Bar Chart.
- MIT Status button functions in the same manner as for the NAS Monitor. See page 4-420.
- TMI Warning Triangle Icon functions in the same manner as for the NAS Monitor. See page 4-421.
NAS Monitor Bar Chart Options Panel

The options panel on the NAS Monitor Bar Chart in Model mode provides checkboxes allowing you to display flight count data with and without the reroute, a legend showing how Monitor Alert Parameters (MAP) are shown in the chart, and a time field showing when model results were last updated. A Hide Options Panel option is available on the Customize menu.

If needed, the bar chart provides a horizontal scroll bar allowing you to view all time intervals for the reroute. If you locate the pointer over a bar in the chart, a tool tip displays with the element name, model time, flight count with the reroute, and flight count without the reroute.
Examine FEA/FCA in Model Mode

FEA/FCA Timeline in Model Mode

When the TSD is in Model mode, you can access a Model mode version of the FEA/FCA Timeline for any FEA/FCA that was in place when the reroute model was generated. You can open the FEA/FCA Timeline using any of the existing methods for examining an FEA/FCA. For information on using the Examine FEA/FCA command, see page 4-480 in Chapter 4, FEA/FCA Menu section.

**Note:** If the FEA/FCA Timeline dialog box is already open when you request modeling, the TSD will switch the open FEA/FCA Timeline to Model mode.

Using the FEA/FCA Timeline in Model Mode

The functionality of the FEA/FCA Timeline in Model mode is similar to the FEA/FCA Timeline in Normal mode except the following are disabled:

- Show FEA/FCA Flights
- FCA Report
- Dynamic List
- Absolute Time Range

The FEA/FCA timeline in Model mode also displays modeled flight count data.

The numbers in the upper row of the FEA/FCA Timeline in Model mode are modeled flight counts for each quarter-hour time interval. The numbers in the bottom row represent the 15-minute intervals. For each time interval, one or two numbers display. The first number is the predicted FEA/FCA flight count with the proposed reroute in place. A second number displays separated from the first number by a slash if the flight count changed after modeling the reroute. The second number represents the change in the flight count from the baseline. A positive number indicates that the flight count has increased due to the reroute. A negative number indicates that the flight count has decreased. If you want to show the impact of delays caused by MIT restrictions in the modeled flight count data, toggle the MIT Status button.

The toolbar portion of the dialog box provides buttons that allow you to show or hide the FEA/FCA Bar Chart or open the FEA/FCA Filters dialog box. A Flight Counts toggle button also displays allowing you to toggle between the display of total occupancy counts for the time intervals (T), peak occupancy counts (P), and counts by entry time (E). The
time that model results were generated displays to the right of the Filters button as well as a field indicating whether Total, Peak, or Entry counts are shown. The total number of discrete flights predicted to traverse or enter the FEA/FCA during the selected time intervals also displays.

For information on the FEA/FCA Timeline dialog box in Normal mode, see page 4-480, Examine FEA/FCA.

**Functions Menu**

The Functions menu provides the following options.

- Show/Hide Bar Chart
- Filters
- Flight Counts >by Entry Time, Peak Occupancy, or Total Flights
- Close

As with the standard FEA/FCA Timeline, you can use the Flight Counts menu option to display the total occupancy counts (T), peak occupancy counts (P), or counts by entry time (E) for the time intervals. The Filters function also works the same in Model mode as in Normal mode but any secondary filter that you want to apply must have been defined prior to the time when the model results were generated. If you create a new secondary filter, you must remodel the reroute before you can apply the secondary filter to the counts.
FEA/FCA Bar Chart in Model Mode

When modeling a reroute you can access the FEA/FCA Bar Chart in Model mode by clicking on the **Show/Hide Bar Chart** option on the Function menu or the Show/Hide Bar Chart toolbar button on the Examine FEA/FCA dialog box in Model mode.

In Model mode, the FEA/FCA Bar Chart dialog box displays the following:

- **With Reroute/Without Reroute checkboxes**
  - If you leave the Without Reroute checkbox unchecked, the bar chart displays only flight count data with the proposed reroute. If you hover the cursor over the any bar, a tooltip will display showing the name of the FEA/FCA, the time slot of the bar and the flight count with the proposed reroute.
  - If you check the Without Reroute checkbox, the bar chart will show flight count data displayed in a pair of bars, one without the proposed reroute and the other with the proposed reroute. If you hover the cursor over the any pair of bars, a tooltip will display showing the name of the FEA/FCA, the time slot of the bars and the flight counts with and without the proposed reroute.

- **The bar chart shows the number of secondary filters applied, whether residual flights are check on or off on the Filters dialog box, and the time at which model results were updated.**

- **MIT Status button**
  - You can toggle the MIT Status button to display model results that either include or exclude all MIT impacts.

- **Notification of TMI’s warning icon (triangle)**
  - This icon is displayed if a Traffic Management Initiative (TMI) is issued, modified, or deleted while you are modeling a reroute (see page 4-373.)
Shared Sites Tab

The Shared Sites tab of the Create Reroute dialog box allows you to select the TFMS sites with which you want to share a reroute definition and model results. To access the Shared Sites tab, a reroute's Domain must be set to Shared on the Reroute Definition tab. This tab is also available when editing or viewing a shared reroute. Clicking on the Shared Sites tab displays the following dialog box, shown in its default state.
Using the Shared Site Tab

The following table explains the items on the Shared Sites tab of the Create Reroute dialog box:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What You Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Center</td>
<td>Checkboxes representing U.S. and Canadian centers.</td>
<td>Click on the checkboxes for the centers with which you want to share the reroute definition and model results.</td>
</tr>
<tr>
<td>Select Impacted</td>
<td>Allows you to automatically select all of the checkboxes for the centers traversed by flights in the route segments that are included in the reroute definition.</td>
<td>Click on the <strong>Select Impacted</strong> button.</td>
</tr>
<tr>
<td>Select All</td>
<td>Allows you to automatically select all U.S. and Canadian center checkboxes.</td>
<td>Click on the <strong>Select All</strong> button.</td>
</tr>
<tr>
<td>Deselect All</td>
<td>Allows you to automatically deselect all selected U.S. and Canadian center checkboxes.</td>
<td>Click on the <strong>Deselect All</strong> button.</td>
</tr>
<tr>
<td>Additional Facilities</td>
<td>Displays additional facilities with which you can share the reroute definition and model results.</td>
<td>Click on the facility or facilities with which you want to share the reroute definition and model results and click <strong>Add</strong>. To select more than one facility, press <code>&lt;Shift&gt;</code> or <code>&lt;Ctrl&gt;</code> and click to select the facilities. You can also click and drag the pointer down over the list to select facilities.</td>
</tr>
<tr>
<td>Additional Shared Sites</td>
<td>Displays the selected sites with which you want to share the reroute definition and model results.</td>
<td>Nothing unless you intend to remove facilities from the Additional Shared Sites column. To remove facilities, select the facility or facilities you want to remove and click <strong>Remove</strong>. To select more than one facility, press <code>&lt;Shift&gt;</code> or <code>&lt;Ctrl&gt;</code> and click to select the facilities. You can also click and drag the pointer down over the list to select facilities.</td>
</tr>
</tbody>
</table>
### Shared Sites Tab (Continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What You Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Adds the facility selected in the Additional Facilities column, or entered in the Other Site field, to the Additional Shared Sites column.</td>
<td>To add the selected facility or facilities, or the entered facility, click on the <strong>Add</strong> button.</td>
</tr>
<tr>
<td>Remove</td>
<td>Deletes the selected facility or facilities from the Additional Shared Sites column.</td>
<td>To delete the selected facility or facilities, click on the <strong>Remove</strong> button.</td>
</tr>
<tr>
<td>Remove All</td>
<td>Deletes all facilities from the Additional Shared Sites column.</td>
<td>To delete all facilities, click on the <strong>Remove All</strong> button.</td>
</tr>
<tr>
<td>Other Site</td>
<td>Allows you to type in a facility to add to the Additional Shared Sites column.</td>
<td>Click in the field and type a facility name.</td>
</tr>
</tbody>
</table>
Select Reroutes Command

Viewing Model Results Through Select Reroutes

Using the Select Reroutes command you can view the modeled results of a reroute created by another user. Among the options available on the Functions menu of the Select Reroutes dialog box, the following options provide access to the Reroute Model mode.

- **Edit Reroute**
  You can define a reroute on the Edit Reroute dialog box and click the **Model** button to view the defined reroute in Model mode.

  For information on the Edit Reroute option, see page 4-215 in the Reroute Menu section of Chapter 4.

- **Copy Reroute**
  You can define a reroute by using the Copy Reroute option on the Functions Menu and in the Create Reroute dialog box and click the **Model** button to view the defined reroute in Model mode.

  For information on the Copy Reroute option, see page 4-218 in the Reroute Menu section of Chapter 4.

- **View Reroute**
  The View Reroute dialog box opens in Model mode when you select the View Model option from the Functions menu of the Select Reroute dialog box and model results are available.

  For information on the View Reroute option, see page 4-220 in the Reroute Menu section of Chapter 4.

- **View Model/ View button**
  To view modeled results through Select Reroutes, highlight the reroute and select the View Model option from the Functions menu or click the **View** button on the Select Reroutes dialog box. Selecting the View Model option or clicking the **View** button opens the View Reroute dialog box in Model mode. If you are viewing a reroute in Model mode and the model results are updated or the reroute is modified or deleted by another user, the TSD will display a notification message informing you of the change.

  For information on the View Model option, see page 4-227 in the Reroute Menu section of Chapter 4.

- **Model Reroute Cancellation**
  The Model Reroute Cancellation option allows you to view, in Model mode, the impact on the NAS of cancelling a selected reroute.

  For information on the Model Reroute Cancellation option, see page 4-381 in this section.
FEA/FCA Menu

Overview

This section describes the functionality of the Flow Evaluation Areas (FEA) and Flow Constrained Areas (FCA) commands. FCAs are produced at the ATCSCC (Command Center) only; FEAs are created at the TFMS sites. Features of the commands let you produce one or more graphic overlays showing areas where the Traffic Management Specialist wishes to evaluate the traffic flow or where flight rerouting has been suggested due to severe weather conditions. The FEA/FCA function defines the flight filter and includes the ability to combine filter criteria using AND/OR logic and to define multiple filters.

This section is divided into the following topics, each of which corresponds to an item on the FEA/FCA pull-down menu.

- **Show/Hide FEA/FCAs Command**  
  Lets you show or hide all FEA/FCAs defined in the Select FEA/FCA dialog box

- **Select FEA/FCA Command**  
  Lets you define the FEA/FCAs for display on the TSD
• **Create FEA/FCA Command**  page 4-442
  Lets you create a new FEA or FCA and designate whether it is Private, Shared, Local or Public

• **Recall FEA/FCA File Command**  Page 4-477
  Lets you recall an FEA/FCA that you previously saved

• **Examine FEA/FCA Command**  Page 4-480
  Lets you display details about traffic demands for an FEA/FCA

• **Preferences Command**  Page 4-500
  Lets you set the defaults for the Create FEA/FCA dialog box

In addition to the FEA/FCA menu commands, the FEA/FCA Request Count and Request List are included at the conclusion of this chapter.
The **Show/Hide FEA/FCAs** command lets you turn on or off the display of FEA/FCAs. You must have created an FEA/FCA before you can show it.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the FEA/FCA menu by clicking <strong>FEA/FCA</strong> on the TSD Main Menu or by pressing <code>&lt;Alt&gt;</code> C.</td>
<td>None</td>
</tr>
<tr>
<td>2. Click <strong>Hide FEA/FCAs</strong> or <strong>Show FEA/FCAs</strong> or press F.</td>
<td>Semicolon Method</td>
</tr>
<tr>
<td></td>
<td>None</td>
</tr>
</tbody>
</table>

**Note:** If no FEA/FCAs have been created, this menu item will not be available.
When you issue Show FEA/FCAs, all FEA/FCAs with the Show buttons checked in the Select FEA/FCA dialog box appear on the TSD display and look like the sample below. Note that one of the FEAs is a drawn polygon and one is entered as a NAS element.

When you select **Hide FEA/FCA**, all FEA/FCAs are removed from the display.
Select FEA/FCA Command

The Select FEA/FCA command enables you to define which FEA/FCAs you want to display on the TSD. This function also lets you edit, copy, delete, or choose colors for an FEA/FCA. The Functions menu lets you view or edit FEA/FCA filters.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the FEA/FCA menu by clicking FEA/FCA on the TSD Main Menu or by pressing &lt;Alt&gt; C.</td>
<td>None</td>
</tr>
<tr>
<td>2. Click Select FEA/FCA or press S.</td>
<td>None</td>
</tr>
</tbody>
</table>

Note: If no FEA/FCAs have been created, this menu item will not be available.

Select FEA/FCA Dialog Box

After you click Select FEA/FCA or press S, the Select FEA/FCA dialog box, which contains a list of all FEA/FCAs in the database that are available to you, opens.
The following table explains the Select FEA/FCA dialog box. Only the Show, Color, and Info fields can be edited in this dialog box.

### Select FEA/FCA Dialog Box

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What you do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show</td>
<td>Displays and removes FEA/FCAs from the TSD.</td>
<td>Click the checkbox to toggle a check mark on or off. Click the Show column header to toggle on or off all Show checkboxes.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> When the TSD starts up, all Show checkboxes are turned off if the Auto-Show Status is set to OFF in the FEA/FCA Preferences dialog box. If set to ON, when the TSD starts up, the Show checkbox displays a check mark for any existing FEA/FCAs that match the categories selected in the Preferences dialog box.</td>
</tr>
<tr>
<td>Domain</td>
<td>Displays the following domains: Public, Shared, Local or Private.</td>
<td>You cannot edit this field.</td>
</tr>
<tr>
<td>AFP Status</td>
<td>Indicates whether FEA/FCA is FSM-Eligible or has an active AFP (Airspace Flow Program)</td>
<td>You cannot edit this field.</td>
</tr>
<tr>
<td>Type</td>
<td>This field displays the types, FEA, FCA, and Expired. Users at the Command Center create the FCAs.</td>
<td>You cannot edit this field.</td>
</tr>
<tr>
<td>Color</td>
<td>Changes the color of the FEA/FCA boundary. Also, the flight icon color will be changed to the same color as the FEA/FCA.</td>
<td>Click the button to display a color palette. Click your color choice.</td>
</tr>
<tr>
<td>FEA/FCA Name</td>
<td>User-specified name for the FEA/FCA. Maximum of 30 characters.</td>
<td>You cannot edit this field.</td>
</tr>
<tr>
<td>Facility</td>
<td>TFMS site where the FEA/FCA was created.</td>
<td>You cannot edit this field.</td>
</tr>
<tr>
<td>Info</td>
<td>Displays the Information dialog box for the selected FEA/FCA name.</td>
<td>Click the <strong>Info</strong> button for the specific FEA/FCA.</td>
</tr>
</tbody>
</table>
**FEA/FCA Information Dialog box**

Clicking the **Info** button located on the Select FEA/FCA dialog box displays the Information dialog box for the selected FEA/FCA. The following sample shows the parameters for the FEA/FCA, a summary of the Primary Filter criteria, and the name and site of Secondary filters that were added.

![Information dialog box](image)

**Note:** The FEA/FCA Info dialog box will have “FSM” or “AFP” appended to the FEA/FCA name if it is FSM-Eligible or has an active AFP.

There are two pull-down menus on the Select FEA/FCA Dialog Box: File and Functions.

**File Menu**

The File menu on the Select FEA/FCA dialog box lets you

- Save your FEA/FCA definition to a file
- Recall the file
- Delete the file

These functions are described in detail in Chapter 2, TSD Basics.
Functions Menu
The Functions Menu on the Select FEA/FCA dialog box lets you perform the following functions:

- Edit: Edit FEA/FCA definitions
- Filters: View or edit FEA/FCA filters
- Delete: Delete FEA/FCAs that are no longer relevant
- Copy: Copy a selected FEA/FCA
- Examine: Examine an FEA/FCA
- Sort By Domain, AFP Status, Type, Name, or Facility

Note: Only ATCSCC users can edit or delete FCAs.

Edit
The Edit function lets you edit the selected FEA/FCA definition and update the database with the edited definition. If the selected FEA or FCA is Public and if you are not authorized to edit a Public FCA, you will not be able to edit or delete it.

Note: If an FEA/FCA is edited while you are examining it, a warning dialog box opens to inform you that it has been edited. Clicking Info opens the Information dialog box for the FEA/FCA.

1. On the Select FEA/FCA dialog box, click the number of the FEA/FCA you want to edit. You can select only one row at a time to be edited. Otherwise, the Edit options will be disabled.
2. Click Functions.
3. Click Edit. The Edit FEA/FCA dialog box opens.
4. Enter data in the Edit FEA/FCA dialog box in the same way you would in the Create FEA/FCA dialog box. For instructions on using this dialog box, see the Create FEA/FCA Command section on page 4-442.

Note: You do not have to edit the Start Date/Time fields when editing an FEA/FCA. TFMS ignores Start Date/Time values that are before the beginning of the current 15-minute interval.
Filters
The Filters dialog box lets you view or edit the FEA/FCA filters.

1. Click **Functions** and **Filters**.
2. The Filters dialog box opens showing any Primary and Secondary filters you created using the Create FEA/FCA function.

A single primary filter can be set up as part of the FEA/FCA definition. It is used to narrow down the list of FEA/FCA flights to only those that match the primary filter conditions.

Any TSD user can create and save secondary filters for an FEA/FCA. Each user can select which secondary filters will be applied to their view of FEA/FCA flights. A secondary filter can be private and viewable on the creator’s workstation only, or it can be shared with the same set of users with whom its parent FEA/FCA is shared. However, only specialists at the ATCSCC can create Public secondary filters.

Other methods of opening the Filters dialog box include
- Clicking **Filters** on the FEA/FCA Timeline.
- Clicking **Filters** on the Functions menu on the Timeline.
- Clicking **Filters** on the FEA/FCA Dynamic List.

All of these methods are discussed in the Examine FEA/FCA section later in this document.
Delete

The Delete function lets you remove current FEA/FCAs from the database.

1. On the Select FEA/FCA dialog box, click the number of the FEA/FCA you want to delete.
   
   If you want to delete multiple FEA/FCAs, click the number of the first one you want to delete. Use the `<Ctrl>` and `<Shift>` keys to select others.

2. Click Functions and Delete.

3. The Delete Confirmation dialog box opens, asking you to confirm your delete request.

4. Click Yes to delete.
   
   A message is briefly displayed telling you that your request has been sent to the server. If the deletion request is rejected, an Error dialog box is displayed. If the request is confirmed, the TSD applies the deletion to the Select FEA/FCA dialog box as though you had clicked Apply.

   **Note:** FEA/FCAs that have expired by more than 60 minutes will be automatically deleted.

Copy

The Copy option on the Functions menu lets you create a new FEA/FCA definition by copying an existing one and modifying it to your specifications.

1. On the Select FEA/FCA dialog box, click the number of the FEA/FCA you want to copy.

2. Click Functions and Copy. The Copy FEA/FCA dialog box opens.
   
   There are four versions of the dialog box. Three are for custom FEA/FCAs and are accessed when you copy an FEA/FCA that was created as a Polygon, Line or Circle. The fourth is accessed when you copy an FEA/FCA that was created by selecting a NAS element.

3. Enter data in the Copy FEA/FCA dialog box in the same way you would in the Create FEA/FCA dialog box. For instructions on using this dialog box, see the Create FEA/FCA Command section on page 4-442.
Examine

The Examine option on the Functions menu works in the same way as the Examine FEA/FCA command, which is described in the Examine FEA/FCA command section.

Sort By

The Sort By option on the Functions menu lets you sort the items in the Select FEA/FCA dialog box by Domain, AFP Status, Type, Name, or Facility.

- Sorting by Domain sorts the items in the dialog box in the following order: Public, Shared, Local and Private, next in alphabetical order by name.
- Sorting by AFP Status sorts the items in the dialog box in the following order:
  - AFP FCAs
  - FSM FCAs
  - FSM FEAs
  - Other FCAs
  - Other FEAs
  - Any FEA/FCAs whose Type has expired
- Sorting by Type sorts the items in the dialog box in the following order: FCA, FEA, and Expired, next by AFP Status in the following order: AFP, FSM, None, and next in alphabetical order by name.
- Sorting by Name sorts the items in the dialog box in alphabetical order by the names that have been entered.
- Sorting by Facility sorts the items in the dialog box in alphabetical order by the facility that created the FEA/FCA and next in alphabetical order by name.

Note: Clicking the column header of the Domain, Type, AFP Status, Name, or Facility column sorts the items in the dialog box in the manner described above.
The **Create FEA/FCA** command lets you create new FEAs or FCAs and designate them as Public, Shared, Local, or Private.

- Public FCAs and FEAs are created by specialists at the ATCSCC and are shared with all TFMS users.
- Shared and Local FEAs are created by users at TFMS field sites and are shared with TFMS users within their facility. Shared FEAs are shared automatically within the ATCSCC and other designated TFMS sites.
- Private FEAs can be created by all TSD users for viewing on their workstations or connected Exceed PC workstations.

### Menu Method

1. Pull down the FEA/FCA menu by clicking **FEA/FCA** on the TSD Main Menu or by pressing `<Alt> C`.
2. Click **Create FEA/FCA** or press **C**.

### Quick Key Method

None

### Semicolon Method

None
Create FEA/FCA Dialog Box

After you click Create FEA/FCA or press C from the FEA/FCA menu, the Create FEA/FCA dialog box opens, like the following samples for a custom Polygon FEA and custom Line FEA with the Parameters tab selected. The default selection for the Create FEA/FCA dialog box is Polygon FEA.
The next two samples show the Create FEA/FCA dialog boxes for Circle and NAS selections.
FEA/FCA Tabs

The Create FEA/FCA dialog box has six tabs:

- **Parameters**
  Lets you enter the parameters for the FEA/FCA definition.

- **Primary Filter**
  Lets you define a primary filter.

- **Secondary Filters**
  Displays summary information about all the filters that have been defined for an FEA/FCA. Also, allows you to open the Create Secondary Filter and Edit Secondary Filter dialog boxes to create or edit secondary filters.

- **Shared Sites**
  Lets you enter the names of sites that will share the FEA/FCA definition.

- **Lat/Lon Edit**
  Lets you enter the latitude and longitude of the points of a custom polygon or line. This tab is only available for the polygon and line options.

- **Preferences**
  Lets you set preferences that are saved with the FEA/FCA definition.

Parameters Tab

The following table explains how to use the Parameters Tab in the Create FEA/FCA dialog box. The table includes dialog box sections for Polygon, Line, Circle, and NAS FEA/FCAs. Click in each field to make an entry and press <Tab> to move from one field to another.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What you do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Polygon</td>
<td>This selection lets you draw a custom FEA/FCA polygon on the TSD.</td>
<td>Click the Polygon button to select this option.</td>
</tr>
<tr>
<td>Line</td>
<td>This selection lets you draw a custom multi-segment FEA/FCA line on the TSD.</td>
<td>Click the Line button to select this option.</td>
</tr>
<tr>
<td>Circle</td>
<td>This selection lets you draw a custom FEA/FCA circle, specifying the center point and radius.</td>
<td>Click the Circle button to select this option.</td>
</tr>
<tr>
<td>NAS</td>
<td>This selection lets you designate a NAS element as an FEA/FCA.</td>
<td>Click the NAS button. This button is discussed further in “NAS Element FEA” section.</td>
</tr>
</tbody>
</table>
### Create FEA/FCA Dialog Box: Parameters Tab (Continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What you do</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>User-specified name for the FEA/FCA. Maximum of 30 characters. FEA/FCA Names are restricted to alphanumeric, dash, and underscore characters. Spaces and other special characters are not allowed. <strong>Note:</strong> The name of an FSM-Eligible FEA/FCA cannot match the name of an airport.</td>
<td>Click in the text entry field and enter a name. Private, Local or Shared FEAs cannot start with FCA. Public FCAs are automatically designated using a sequence of names starting with FCA001. The system resets the sequence number at 0900Z. Scroll horizontally if you need to enter more than 14 characters.</td>
</tr>
<tr>
<td><strong>Time Range</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Start Time</strong></td>
<td>Initially filled in with the date and time of the current 15-minute time interval. The start date is formatted mm/dd/yy. The start time is formatted as hh:mm.</td>
<td>Place the pointer in the year, month, day, hours, or minutes value. Type in the date or time values, click the arrow to the right of the <strong>Start Time</strong> field to increment or decrement the values, or use the keyboard arrow keys.</td>
</tr>
<tr>
<td><strong>End Time</strong></td>
<td>Initially filled in with the start time plus the duration specified in the FEA/FCA Preferences dialog box. The end date is formatted mm/dd/yy. The end time is formatted as hh:mm.</td>
<td>Place the pointer in the year, month, day, hours, or minutes value and type in the date or time values, click the arrow to the right of the <strong>End Time</strong> field to increment or decrement the values, or use the keyboard arrow keys.</td>
</tr>
<tr>
<td><strong>Extended</strong></td>
<td>This checkbox lets you extend the FEA/FCA up to 7 days from the current day. If left unchecked, the FEA/FCA can exist up to 24 hours.</td>
<td>Click the <strong>Extended</strong> checkbox. <strong>Note:</strong> This option is not available for Moving FEAs.</td>
</tr>
<tr>
<td><strong>Look Ahead Time Range</strong></td>
<td>This checkbox lets you extend 24 hours in the future from the current time. The time parameter set by the <strong>Look Ahead Time Range</strong> determines the maximum future time range for which flight data will be available for display on the TSD in the Timeline or in the Dynamic List.</td>
<td>Click the arrow to the right of the <strong>Look Ahead Time Range</strong> field to increment or decrement the values from one to 24 hours or use the keyboard arrow keys.</td>
</tr>
</tbody>
</table>
### Create FEA/FCA Dialog Box: Parameters Tab (Continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What you do</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Altitude Range</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ceiling</td>
<td>This field is initially filled in with the default value for Ceiling, as defined in the FEA/FCA Preferences dialog box. You can enter one to three digits for the ceiling, from 000 to 600, which represents hundreds of feet.</td>
<td>Click in the <strong>Ceiling</strong> box and enter a one to three digit number. This field is available only when the Polygon, Line, or Circle button is selected.</td>
</tr>
<tr>
<td>Floor</td>
<td>This field is initially filled in with the default value for Floor, as defined in the FEA/FCA Preferences dialog box. You can enter one to three digits for the ceiling, from 000 to 600, which represents hundreds of feet.</td>
<td>Click in the <strong>Floor</strong> box and enter a one to three-digit number. This field is available only when the Polygon, Line or Circle button is selected. <strong>Note</strong>: If the Floor value is higher than that of the Ceiling, an error message is displayed.</td>
</tr>
<tr>
<td><strong>Moving Parameter</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Heading</td>
<td>This field is initially set to zero. You can enter one to three digit values from 000 to 359 degrees. Note that 000 = north.</td>
<td>Click in the <strong>Heading</strong> box and enter a one to three digit number. This field is available only when the Polygon or Line button is selected.</td>
</tr>
<tr>
<td>Speed</td>
<td>This field is initially set to zero. You can enter one to two digit values from 00 to 99 knots. You need to enter data in this field if you want to see a moving FEA/FCA.</td>
<td>Click in the <strong>Speed</strong> box and enter a one to three digit number. This field is available only when the Polygon or Line button is selected.</td>
</tr>
<tr>
<td><strong>Circle Parameters</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Center</td>
<td>The Center field lets you enter the latitude and longitude of the center of the circle. The format for this data is: ( \text{dd}^\circ\text{mm}^N/\text{dd}^\circ\text{mm}^W ). <em>(Note: This format is also used in the Move/Zoom dialog box.)</em></td>
<td>The format for the Center values is ( \text{dd}^\circ\text{mm}^N/\text{dd}^\circ\text{mm}^W ). This field is available only when the Circle button is selected. <strong>Note</strong>: This format is also used in the Move/Zoom dialog box.</td>
</tr>
<tr>
<td>Radius</td>
<td>The Radius field lets you enter the radius of the circle in nautical miles.</td>
<td>Enter values from one to 999. This field is available only when the Circle button is selected.</td>
</tr>
</tbody>
</table>
Create FEA/FCA Dialog Box: Parameters Tab (Continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What you do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td>This is the category of NAS elements: Airport, Center, Sector, Base Sector, Fix, TRACON, Base TRACON, and Special Use Area (SUA).</td>
<td>Click the arrow to the right of the Type field. Click one of the NAS elements on the resulting pick list. This field is available only when the NAS button is selected.</td>
</tr>
<tr>
<td>Name</td>
<td>This is the name of the NAS element you selected in the Type field.</td>
<td>Click on the arrow to the right of the Name field. In the resulting pull-down list, click on the NAS element Type you selected. There is an automatic fill-in feature in the Name field. If you type in the Name field rather than selecting from the pick list, the TSD fills in the field with the first match that is found in the list for the Type you selected. This field is available only when the NAS button is selected. Note: If the Sector or TRACON type is selected, Sectors or TRACONs that are closed will not appear in the list. Sectors that are not in their baseline state will have a +/- symbol after their name in the pull-down list.</td>
</tr>
</tbody>
</table>
Create FEA/FCA Dialog Box: Parameters Tab (Continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What you do</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Characteristics</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Domain</strong></td>
<td>This field lets you define the FEA/FCA type: Public, Private, Local, Shared.</td>
<td>Click in the appropriate radio button to select the domain you want.</td>
</tr>
<tr>
<td></td>
<td>- Only users at ATCSCC can create Public FCAs or Public FEAs, which are shared with all TFMS users.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Users at TFMS field sites can create Shared FEAs, which are shared with users at that facility, at the ATCSCC, and at other designated sites.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Users at TFMS field sites can create Local FEAs, which are shared with users at that facility but not shared with the ATCSCC.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- All users can create Private FEAs, which are viewed only at the specific workstation where they were created.</td>
<td></td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>Lets you create an FEA or FCA. <strong>Note:</strong> If you are not authorized to create an FCA, the FCA option will not be available.</td>
<td>Click in the appropriate radio button to create an FEA or FCA.</td>
</tr>
<tr>
<td><strong>Reason</strong></td>
<td>The reason that the FEA/FCA was created.</td>
<td>Click the arrow for a pull-down list of pre-defined reasons and select the appropriate reason.</td>
</tr>
</tbody>
</table>
Create FEA/FCA Dialog Box: Parameters Tab (Continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What you do</th>
</tr>
</thead>
<tbody>
<tr>
<td>FSM Eligible</td>
<td>This checkbox lets you designate the FEA/FCA as FSM Eligible and it will be available to be monitored using FSM. Authorized users can create an AFP based on Public FCAs that have been designated FSM-Eligible. The name of an FEA that is to be designated as FSM-eligible cannot exceed six characters. <strong>Note:</strong> If you are not an authorized user, the FSM-Eligible option will not be available.</td>
<td>Click the <strong>FSM Eligible</strong> checkbox to select this option.</td>
</tr>
</tbody>
</table>

**Drawing Control**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What you do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drawn at start time position</td>
<td>This checkbox lets you specify whether you have drawn the FEA/FCA at the position associated with the current time or the position associated with the start time you entered in the Create FEA/FCA dialog box.</td>
<td>This checkbox only applies to moving FEA/FCAs. Leave unchecked if you have drawn the FEA/FCA at its current position. Check if you have drawn the FEA/FCA where you project it will be located at the FEA/FCA start time. <strong>Note:</strong> When NAS Element is selected, this field is disabled (grayed out).</td>
</tr>
<tr>
<td>Color</td>
<td>Lets you determine the color of each FEA/FCA.</td>
<td>Click the button to display a color palette. Click a color that you want for the FEA/FCA.</td>
</tr>
<tr>
<td>Erase</td>
<td>Lets you delete the FEA/FCA polygon or line you just created.</td>
<td>Click <strong>Erase</strong> to delete the FEA/FCA polygon or line you just created. This field is available only in custom Polygon, Line, or Circle FEA/FCAs.</td>
</tr>
</tbody>
</table>
Create FEA/FCA Dialog Box: Parameters Tab (Continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What you do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Lets you delete the last point of the polygon or line you are drawing.</td>
<td>Click <strong>Undo</strong> to delete the last point of the polygon or line. Continue clicking <strong>Undo</strong> to delete previously defined points of the polygon or line. You can continue clicking <strong>Undo</strong> until all the previously defined points are deleted. This field is available only when Polygon or Line is selected. <strong>Note:</strong> Clicking the right mouse button while the pointer is on the TSD has the same effect as clicking <strong>Undo</strong>.</td>
</tr>
<tr>
<td>Draw</td>
<td>Lets you draw the circle When you select Draw in the Circle Parameters section, the TSD approximates the circle by defining up to 60 polygon points and redraws the circle on the TSD display using these polygon points.</td>
<td>Enter the center and radius parameters into the fields in the Circle Parameters fields and click <strong>Draw</strong>.</td>
</tr>
</tbody>
</table>

**Custom FEA/FCAs**

The Polygon, Line, and Circle options let you draw custom FEA/FCAs. The Polygon and Line dialog boxes share the same features. The basic difference between the Polygon and Line options and the Circle option is that the Polygon and Line options contain the Moving Parameters section and the Circle option contains the Circle Parameters section. Each of these sections is discussed in the following pages.
Moving Parameters Section

The Moving Parameters fields (Heading and Speed) must be filled in on the Create FEA/FCA dialog box if you want to create a moving FEA/FCA, which is discussed on the following page. The default values are set to 0. You may also fill in the Altitude Range (Ceiling and Floor) fields. The value for the Floor field must be less than the value for the Ceiling field; otherwise, you will get an error message.
Moving FEA/FCAs

When you create or edit a custom FEA/FCA polygon or line segment (see next section), you can make it move to show where the FEA/FCA started and how it is moving during the course of the time limits you have specified. For example, the graphic below shows several FEA polygons and one Moving FEA polygon. The Moving FEA has shadows of the original FEA, the shadows appearing as dotted lines. These shadows represent past and future locations of the FEAs. The shadows are drawn at the starting location and at the one-quarter, one-half, three-quarter and ending locations. The solid line indicates the current location of the FEA.

Note: FEA/FCAs using NAS elements cannot move.
Drawing an FEA/FCA Polygon

You can draw a custom FEA/FCA polygon on the TSD using the following procedure. You can also draw the polygon by clicking and holding the left button. As you drag the pointer, additional points are defined. To draw a polygon,

1. Make sure you have entered a name for the FEA/FCA in the Create FEA/FCA dialog box.

2. In the Drawing Control section of the Create FEA/FCA dialog box, check the **Drawn at start time position** checkbox if you are creating a moving FEA/FCA. This checkbox only applies to moving FEA/FCAs. Leave unchecked if you have drawn the FEA/FCA at its current position. Check if you have drawn the FEA/FCA where you project it will be located at the start time.

3. Click the left mouse button to begin the polygon.

4. Click the left mouse button again to establish the next point. Continue this process until you have established all the points you want.

5. Click **OK** to close the dialog box. The polygon remains on the TSD and a line is drawn from the last point you defined to the first point.

Drawing an FEA/FCA Line Segment

You can draw a custom FEA/FCA line on the TSD by defining two or more points.

1. Make sure you have entered a name for the FEA/FCA in the Create FEA/FCA dialog box.

2. In the Drawing Control section of the Create FEA/FCA dialog box check the **Drawn at start time position** checkbox if you are creating a moving FEA/FCA. This checkbox only applies to moving FEA/FCAs. Leave unchecked if you have drawn the FEA/FCA at its current position. Check if you have drawn the FEA/FCA where you project it will be located at the start time.

3. Click the left mouse button to begin the line segment.

4. Click the left mouse button again to establish the next point. Continue this process until you have established all the points you want for a single- or multi-segment line.

5. Click **OK** to close the dialog box.
After you create a multi-segment line FEA/FCA, the typical TSD window would be similar to the following.

![TSD Display](image)

**Circle Parameters**

After you select Circle, the Circle option lets you specify the center point and the radius of the circle in the methods described below:

1. Make sure you have entered a name for the FEA/FCA in the Create FEA/FCA dialog box.
2. Enter the parameters in the Circle Parameters section of the dialog box by clicking in the field and changing the values. Click **Draw**.
   
   **OR**
   
3. Place the pointer on the TSD display.
   
   The latitude and longitude of the pointer is displayed as you move the pointer.
4. Click and hold the left mouse button to specify the center point and radius.
5. While holding the left mouse button, drag the pointer to specify the radius.

**Note:** The circle is continuously being redrawn to assist you in specifying the desired radius and the value of the radius, in nautical miles, is shown on the display and in the Circle Parameters fields on the Create FEA/FCA dialog box.
After you create a circle FEA/FCA, the typical TSD window would be similar to the following, showing custom FEA/FCAs created with both polygons and circles.
NAS Button

Selecting NAS Element on the Create FEA/FCA dialog box changes the dialog box to display the NAS ELEMENT portion of the dialog box. The dialog box no longer shows the Altitude Range and Moving Parameters sections.
Clicking the **Category** arrow in the NAS ELEMENT section of the dialog box Opens a pick list of NAS Element types:

### NAS Elements

<table>
<thead>
<tr>
<th>NAS Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Airport</td>
<td>When this option is selected, TFMS will identify all flights that depart from or arrive at the specified airport. <strong>Note</strong>: You can specify filters to restrict the flights to only arrival or departure.</td>
</tr>
<tr>
<td>Center</td>
<td>When this option is selected, TFMS will identify all flights that depart from, arrive at, or traverse the specified center.</td>
</tr>
<tr>
<td>Sector</td>
<td>When this option is selected, TFMS will identify all flights that intersect the specified sector.</td>
</tr>
<tr>
<td>Base Sector</td>
<td>When this option is selected, TFMS will identify all flights that intersect the specified sector in its baseline state, regardless of whether it is currently open, closed, or combined.</td>
</tr>
<tr>
<td>Fix</td>
<td>When this option is selected, TFMS will identify all flights that traverse the specified Fix.</td>
</tr>
<tr>
<td>TRACON</td>
<td>When this option is selected, TFMS will identify all flights that intersect the specified TRACON.</td>
</tr>
<tr>
<td>SUA</td>
<td>When this option is selected, TFMS will identify all flights that traverse the specified SUA.</td>
</tr>
</tbody>
</table>

**Note**: If an FEA/FCA is created by specifying the name of a sector using the NAS element Sector option, the FEA/FCA's volume of airspace is always the same as the current sector boundaries, even when those boundaries change. The FEA/FCA, therefore, changes boundaries and flight loading dynamically. However, if the FEA/FCA is created using the Base Sector, the volume of airspace will not change dynamically.
Create Primary Filter

Selecting the Primary Filter tab opens the following dialog box.
The Primary Filter tab allows you to define the Primary filter parameters for the flights that intersect the FEA/FCA. The first nine conditional fields of the Create Primary Filter dialog box let you choose between flights matching all of the filter conditions or flights that match at least one of the conditions. By default, the “And all of these conditions” radio button is selected. The Flight Color button is the color of the FEA/FCA. If you change the color in this dialog box, you will change the color of the FEA/FCA.

**Note:** If you do not want to filter the flights by any of the fields shown in the dialog box, leave the field empty.

Each conditional field also provides a pick list of possible states. Click the down arrow in each field to view the pick list. The text entry fields accept multiple entries with a space separating each entry. If your entries surpass the visible area of the entry field, a scroll bar becomes available. The following table explains the buttons and fields in the Create Primary Filter dialog box.

### Create Primary Filter Dialog Box

<table>
<thead>
<tr>
<th>Filter Selections</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color of Residual Flights</td>
<td>Allows you to specify a color for Residual Flights. Displays the color assigned to the FEA/FCA. Any change you make to the flight color is reflected in the Color field on the Parameters tab. Flights that match this Primary filter, but do not match any secondary filters, are drawn using this color.</td>
</tr>
<tr>
<td>Departs from any of / Departs from none of</td>
<td>Limits the selection to flights that depart from any or none of the listed airports or an airport in the listed ARTCC(s).</td>
</tr>
<tr>
<td>Arrives at any of / Arrives at none of</td>
<td>Limits the selection to flights that arrive at any of or none of the listed airports or an airport within the listed ARTCC(s).</td>
</tr>
<tr>
<td>Traverses any of / Traverses all of / Traverses none of</td>
<td>Limits the selection to flights that traverse any (or all or none) of the listed sectors, fixes, or ARTCCs.</td>
</tr>
<tr>
<td>Uses any of these airways / Uses all of these airways / Uses none of these airways</td>
<td>Limits the selection to flights that use any (or all, or none) of the listed airways while traversing the FCA.</td>
</tr>
<tr>
<td>Located in any of / Located in none of</td>
<td>Limits the selection to flights that are, or are not, currently located in the specified sectors or ARTCCs.</td>
</tr>
<tr>
<td>Aircraft type any of / Aircraft type none of</td>
<td>Limits the selection to flights that are, or are not, of specific aircraft types.</td>
</tr>
<tr>
<td>Any of these remarks/ All of these remarks/ None of these remarks</td>
<td>Limits the selection to flights with any, (or all or none) of the specified remarks keywords.</td>
</tr>
</tbody>
</table>
Create Primary Filter Dialog Box

<table>
<thead>
<tr>
<th>Filter Selections</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heading is within / Heading is not within</td>
<td>Limits the selection to flights whose heading upon entry into the FEA/FCA is, or is not, within the specified heading ± the range. The Heading field accepts values from 000 to 359. The Range field accepts values from 000 to 180.</td>
</tr>
<tr>
<td>ACID begins with any of / ACID begins with none of</td>
<td>Limits the selection to flights with aircraft IDs that begin, or do not begin, with the characters specified by each entry.</td>
</tr>
<tr>
<td>Flight level</td>
<td>Limits the selection to flights whose altitude anywhere within the FEA/FCA is predicted to be between the lowest and highest flight levels. The maximum entry for both fields is 600, and the minimum entry for both fields is 000 inclusive. These levels are expressed in hundreds of feet. One entry in each field only.</td>
</tr>
<tr>
<td>Aircraft category any of</td>
<td>Limits the selection to flights that have an aircraft category that matches one of the selected categories. The default is all categories selected, indicating that no filtering is required.</td>
</tr>
<tr>
<td>Weight class any of</td>
<td>Limits the selection to flights that have a weight class that matches one of the selected categories. The default is all categories selected, indicating that no filtering is required.</td>
</tr>
<tr>
<td>User category any of</td>
<td>Limits the selection to flights that have a user category that matches one of the selected categories. The default is all categories selected, indicating that no filtering is required.</td>
</tr>
<tr>
<td>Flight status</td>
<td>Clicking on the arrow displays three choices: All, Active, or Proposed. If Proposed is selected, limits the selections to flights that have a status of Scheduled, Filed, Airline Created, or Controlled. If Active is selected, limits the selection to airborne flights. All indicates that no filtering is required. All is the default.</td>
</tr>
<tr>
<td>RVSM status</td>
<td>Limits the selection to All flights, flights that are RVSM conformant, or flights that are not RVSM conformant.</td>
</tr>
<tr>
<td>Departure/Arrival Time Range</td>
<td>Limits the selection to flights that depart or arrive within the specified time period. The Option menu provides three choices: No Filter, Departure, or Arrival. You can enter start and end time. Time values 00:00 to 23:59 are accepted. The default is No Filter.</td>
</tr>
<tr>
<td>Primary Filter Summary</td>
<td>Displays a read-only version of the filter as it is constructed.</td>
</tr>
</tbody>
</table>
### Edit a Primary Filter

You can use the Edit FEA/FCA dialog box to edit a primary filter. You can only edit a primary filter if you have editing rights for the FEA/FCA. Other users can add or manipulate secondary filters using a separate Filters dialog box, explained on the following page. The Edit Primary Filter function works in the same way as the Create Primary Filter function.

### Create Secondary Filters

All TSD users can create secondary filters and apply them to their view of FEA/FCA flights. A secondary filter can be private and viewable on the user's workstation only, or it can be shared with the same set of users with whom its parent FEA/FCA is shared. Only authorized users, such as Command Center users, are allowed to add public secondary filters to a public FEA or FCA. When a primary filter is defined, the filter criteria is summarized in the Primary Filter field at the top of the secondary Filters tab.

Clicking the **Secondary Filters** tab on the Create FEA/FCA dialog box, opens the following window.

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Filters</th>
<th>Sites</th>
<th>Lon</th>
<th>Pref</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRIMARY FILTER</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Secondary Filters</th>
<th>Show</th>
<th>Filter Name</th>
<th>Color</th>
<th>Domain</th>
<th>Facility</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Create</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2 Create</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 Create</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4 Create</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5 Create</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Residual Flights**

![Create FEA/FCA dialog box](Image)

**OK**  **Apply**  **Cancel**  **Help**
The following table describes the fields in the Secondary Filters dialog box section of the Create FEA/FCA dialog box.

**Secondary Filters Dialog Box**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What You Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create/Edit/View</td>
<td>Allows you to create or edit a secondary filter.</td>
<td>Click <strong>Create</strong> to open the Create Secondary Filter dialog box. If a secondary filter is already defined, click <strong>Edit</strong> to open the Edit Secondary Filter dialog box, discussed later in this section.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The Create, Edit/View button(s) are disabled (grayed out) if a filter definition dialog box is open. You are only allowed to open one filter definition dialog box at a time.</td>
<td><strong>Note:</strong> If the filter is editable at your workstation, an Edit button is displayed; otherwise a View button is displayed.</td>
</tr>
<tr>
<td>Show</td>
<td>Lets you include flights that match the secondary filter criteria in the flight shown on the display.</td>
<td>Click in the checkbox to toggle a check mark on or off.</td>
</tr>
<tr>
<td>Filter Name</td>
<td>Name of the filter</td>
<td>You cannot edit this field. To edit the Secondary Filter name, click <strong>Edit</strong> and change the name in the resulting Edit Secondary Filter dialog box.</td>
</tr>
<tr>
<td>Color</td>
<td>Lets you determine the color of the flight icons for each filter.</td>
<td>Click the <strong>Color</strong> button to open the Color Selector dialog box. Select a color.</td>
</tr>
<tr>
<td>Domain</td>
<td>Displays the following domains: Public, Local, Shared, Private.</td>
<td>You cannot edit this field. To edit the Secondary Filter domain, click <strong>Edit</strong> and change the domain in the Edit Secondary Filter dialog box.</td>
</tr>
<tr>
<td>Facility</td>
<td>TFMS site where the filter was created.</td>
<td>You cannot edit this field.</td>
</tr>
<tr>
<td>Residual Flights</td>
<td>Lets you include flights that do not match any of the “shown” secondary filters.</td>
<td>Click in the checkbox to toggle a check mark on or off.</td>
</tr>
</tbody>
</table>
The following buttons are found in the Secondary Filter section of the Create FEA/FCA dialog box.

### Secondary Filter section

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up</td>
<td>Moves a selected row up one position in the Secondary Filters list.</td>
</tr>
<tr>
<td>Down</td>
<td>Moves a selected row down one position in the Secondary Filters list.</td>
</tr>
<tr>
<td>Top</td>
<td>Moves a selected row to the top of the Secondary Filters list.</td>
</tr>
<tr>
<td>Copy</td>
<td>Opens the Copy Secondary Filter dialog box to create a new secondary filter that is a copy of the selected secondary filter.</td>
</tr>
<tr>
<td>Delete</td>
<td>Marks the secondary filters for deletion. They will be deleted from the database when you click <strong>OK</strong>.</td>
</tr>
</tbody>
</table>

### Create Secondary Filter Dialog Box

The Create Secondary Filter dialog box enables you to define a subset of flights within the set of flights that match the Primary Filter. The first nine conditional fields of the Create Secondary Filter dialog box let you choose between flights that match all of the filter conditions or flights that match at least one of the conditions. By default, the “And all of these conditions” radio button is selected.

Each conditional field also provides a pick list of possible states. Click the down arrow in each field to view the pick list. The text entry fields accept multiple entries with a space separating each entry. If your entries surpass the visible area of the entry field, a scroll bar becomes available.
After clicking **Create** on the Create FEA/FCA dialog box, the Create Secondary Filters dialog box opens.

![Create Secondary Filter dialog box](image)

**Note:** If you do not want to filter the flights by any of the fields shown in the dialog box, leave the field empty.
The following table describes the fields in the Create Secondary Filter dialog box.

### Create Secondary Filter

<table>
<thead>
<tr>
<th>Filter Selections</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Allows you to provide a name for the secondary filter.</td>
</tr>
<tr>
<td>Color</td>
<td>Allows you to specify a color for the secondary filter flights. The TSD chooses a unique color to assign to the filter by default. The default color is different from the FEA/FCA color or any other existing secondary filter colors.</td>
</tr>
<tr>
<td>Domain</td>
<td>Allows you to create a Private, Local, Shared, or Public secondary filter. Private is always a domain option and is the default. Local is an option if the FEA domain is local; otherwise it is disabled (grayed out). Shared is an option if the FEA domain is shared; otherwise, it is disabled (grayed out). Public is an option if the FEA/FCA domain is public and the user is authorized to create public FEA/FCAs and filters.</td>
</tr>
<tr>
<td>Departs from any of/Departs from none of</td>
<td>Limits selection to flights that depart from any or none of the listed airports or an airport in the listed ARTCC(s).</td>
</tr>
<tr>
<td>Arrives at any of/Arrives at none of</td>
<td>Limits the selection to flights that arrive at any of or none of the listed airports or an airport in the listed ARTCC(s).</td>
</tr>
<tr>
<td>Traverses any of/Traverses all of/Traverses none of</td>
<td>Limits the selection to flights that traverse any, (or all or none) of the listed sectors, fixes, or ARTCCs.</td>
</tr>
<tr>
<td>Uses any of these airway/Uses all of these airways/Uses none of these airways</td>
<td>Limits the selection to flights that use any, (or all or none) of the listed airways within the FEA/FCA.</td>
</tr>
<tr>
<td>Located in any of/Located in none of</td>
<td>Limits the selection to flights that are, or are not, currently located in the specified sectors or ARTCCs.</td>
</tr>
<tr>
<td>Aircraft type any of/Aircraft type none of</td>
<td>Limits the selection to flights that are, or are not, of specific aircraft types.</td>
</tr>
<tr>
<td>Any of these remarks/All of these remarks/None of these remarks</td>
<td>Limits the selection to flights with any, (or all or none) of the specified remarks keywords.</td>
</tr>
<tr>
<td>Heading is within/Heading is not within</td>
<td>Limits the selection to flights whose heading upon entry into the FEA/FCA is, or is not, within the specified heading ± the range. The Heading field accepts values from 000 to 359. The Range field accepts values from 000 to 180.</td>
</tr>
<tr>
<td>ACID begins with any of/ACID begins with none of</td>
<td>Limits the selection to flights with aircraft IDs that begin, or do not begin, with the characters specified by each entry.</td>
</tr>
</tbody>
</table>
Create Secondary Filter (Continued)

<table>
<thead>
<tr>
<th>Filter Selections</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flight Level</td>
<td>Limits the selection to flights whose altitude anywhere within the FEA/FCA is predicted to be between the lowest and highest flight levels inclusive. The maximum entry for both fields is 600, and the minimum entry for both fields is 000. These levels are expressed in hundreds of feet. <strong>Note:</strong> Only one entry is accepted in each field.</td>
</tr>
<tr>
<td>Aircraft category any of</td>
<td>Limits the selection to flights that have an aircraft category that matches one of the selected categories. The default is all categories selected, indicating that no filtering is required.</td>
</tr>
<tr>
<td>Weight class any of</td>
<td>Limits the selection to flights that have a weight class that matches one of the selected categories. The default is all categories selected, indicating that no filtering is required.</td>
</tr>
<tr>
<td>User category any of</td>
<td>Limits the selection to flights that have a user category that matches one of the selected categories. The default is all categories selected, indicating that no filtering is required.</td>
</tr>
<tr>
<td>Flight Status</td>
<td>Clicking the arrow displays three choices: All, Active, or Proposed. If Proposed is selected, limits the selections to flights that have a status of Scheduled, Filed, Airline Created, or Controlled. If Active is selected, limits the selection to airborne flights. All indicates that no filtering is required. All is the default.</td>
</tr>
<tr>
<td>RVSM Status</td>
<td>Limits the selection to All flights, flights that are RVSM conformant, or flights that are RVSM non-conformant.</td>
</tr>
<tr>
<td>Departure/Arrival Time Range</td>
<td>Limits the selection to flights that depart or arrive within the specified time period. The Option menu provides three choices: No Filter, Departure, or Arrival. You can enter start and end time. Time values 00:00 to 23:59 are accepted. The default is No Filter.</td>
</tr>
<tr>
<td>Primary Filter Summary</td>
<td>Displays a read-only version of the primary filter.</td>
</tr>
<tr>
<td>Secondary Filter summary</td>
<td>Displays a read-only version of the secondary filter as it is constructed.</td>
</tr>
</tbody>
</table>

When you have selected filter criteria, click **OK** to create the secondary filter and close the Create Secondary Filter dialog box. The secondary filter is summarized in the Secondary Filters section of the Create FEA/FCA dialog box.
**Edit Secondary Filters**

Clicking **Edit** on the row of the secondary filter you want to edit opens the Edit Secondary Filter dialog box. The secondary filter fields and buttons function in the same way as they do on the Create Secondary Filter dialog box.

**Copy a Secondary Filter**

You can copy a secondary filter by opening the Second Filters tab on the Create FEA/FCA dialog box, selecting the number of the secondary filter you want to copy, and clicking **Copy**. The Copy Secondary filter dialog box opens. The secondary filter fields and buttons function in the same way as they do on the Create Secondary Filter dialog box.

**Shared Sites Tab**

If you are creating a Private FEA/FCA, you do not need to use the Shared Sites tab. If you are creating a Shared FEA/FCA that you want to share with users at other TFMS sites, you will need to list the sites you want to share the FEA with. The Shared Sites tab lets you specify the TFMS sites that will share the FEA definition.
Clicking **Shared Sites** opens a dialog box like the following.

Note: If no sites are specified, the FEA will be shared with all TSD users at your site. You do not need to specify your site name.

**Entering Shared Sites**

Each row of the Shared Sites dialog box lets you enter a site name. You can enter the site name directly in the text entry field or click the arrow to display a pick list of site names and click your choice. There is an automatic fill-in feature in the rows of the dialog box. When you type the first character of the site name in the text entry field, the TSD fills in the field with the first match in the list for that character. Clicking the arrow displays a pick list of all operational TFMS sites, sorted alphabetically.

You can click **Reset** to restore the list to the previously saved values.
**Lat/Lon Tab**

This tab is available only on polygons and lines. Clicking **Lat/Lon Edit** on the Create FEA/FCA dialog box opens the following dialog box. You can enter the latitude and longitude in the text boxes.
The Lat/Lon tab displays 60 rows at all times. The vertical scroll bar on the right lets you see all 60 rows. Enter latitude and longitude in the numbered rows of text boxes, as in the following example.

Latitude may be followed by N or S. Longitude may be followed by E or W. If these letters are missing, the program assumes N and W. If latitude is following by N or S, longitude must be followed by E or W or W or E. For example, 3911/09343W is not valid.

Valid entries include: 3911N/09343W and 3911/09343
Window Buttons

The following window buttons are found on the Shared Sites and Lat/Lon Edit dialog boxes.

- **Insert**  
  **Lat/Lon only.** With a row selected, clicking this button inserts a row above the selected row, and subsequent Lat/Lon entries are moved down one row. If 60 rows are already specified, the Insert button is not available.

- **Add**  
  **Shared Sites only.** Clicking this button adds a row to the 24 rows shown in the sample Shared Sites window.

- **Delete**  
  Clicking the row number and clicking **Delete** removes the row from the window. The TSD displays a fixed number of rows on this window, however, so there cannot be fewer than 14 rows for Shared Sites and 60 rows for Lat/Lon.

- **Reset**  
  Clicking this button changes the shared sites list to the list of sites specified in the FEA/FCA Preferences dialog box. This button is found only on the Shared Sites tab.

- **Draw**  
  Clicking this button draws the polygon on the TSD. This button is found only on the Lat/Lon Edit tab.
Pref (Preferences) Tab

Clicking Pref on the Create FEA/FCA dialog box lets you define the preferences for the display of the FEA/FCA Timeline and the Dynamic List for the FEA/FCA you are creating. The preferences are saved with the FEA/FCA definition. The TSD will use these preferences as the default values for displaying the Timeline and Dynamic List for the FEA/FCA. In the example below, Auto-Examine is not checked, so a Timeline would not automatically be displayed for this FEA/FCA.

**Note:** When an FEA/FCA is examined, these preferences will take precedence over the default preferences defined for each TSD. This change also applies to the Edit FEA/FCA and Copy FEA/FCA dialog boxes.
The following table describes the fields of the Preferences tab.

### Preferences Tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What you do</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Timeline</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Visible Time Range</td>
<td>Allows you to specify the visible time range between 60 and 330 minutes (inclusive) of the FEA/FCA Timeline.</td>
<td>Click the up or down arrow to the right of the field to increment or decrement the values, or use the keyboard arrow keys.</td>
</tr>
<tr>
<td>Selected Time Range</td>
<td>Allows you to specify the time range of the selected intervals.</td>
<td>Click the up or down arrow to the right of the field to increment or decrement the values, or use the keyboard arrow keys.</td>
</tr>
<tr>
<td>Flight Counts</td>
<td>Lets you specify whether you want to see peak flight counts, total flight counts, or flight counts by entry time on the Timeline.</td>
<td>Click <strong>Entry</strong>, <strong>Peak</strong>, or <strong>Total</strong>.</td>
</tr>
<tr>
<td><strong>Dynamic List</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Columns tab</td>
<td>Lets you add and remove columns from the Dynamic List.</td>
<td>Procedures for using the Columns tab are the same as those for using the Customize Columns dialog box.</td>
</tr>
<tr>
<td>Sort tab</td>
<td>Lets you sort the Dynamic List by specifying primary, secondary, and tertiary sort criteria.</td>
<td>Procedures for using the Sort tab are the same as those for using the Sort dialog box.</td>
</tr>
</tbody>
</table>

### Saving an FEA/FCA

You can save an FEA/FCA in two ways.

1. Clicking **Apply** on the Create FEA/FCA dialog box saves the FEA/FCA to the database and leaves the dialog box open.
2. Clicking **OK** saves the FEA/FCA to the database and closes the Create FEA/FCA dialog box.

### Browsing the FEA/FCA

As with map items and flights on the TSD, you can browse an FEA/FCA.

To browse an FEA/FCA place the pointer on the FEA/FCA to highlight it. The data block displays. If the FEA/FCA is stationary, the data block is abbreviated and does not show the speed and heading.
FEA/FCA Right-Click Menu

Highlighting an FEA/FCA and right-clicking it opens a right-click menu with the following menu options.

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toggle Data Block</td>
<td>Toggles the FEA/FCA's data block on and off.</td>
</tr>
<tr>
<td>Toggle Data Block Size</td>
<td>Toggles the FEA/FCA's data block between the short form and the long form.</td>
</tr>
<tr>
<td>Hide</td>
<td>Hides the FEA/FCA and deselects the “show” option in the Select FEA/FCA dialog for the FEA/FCA.</td>
</tr>
<tr>
<td>Examine</td>
<td>Displays the FEA/FCA Timeline for the FEA/FCA.</td>
</tr>
<tr>
<td>Examine Flights</td>
<td>Displays the FEA/FCA Timeline for the FEA/FCA and turns on the flights display using the default Selected Time Range setting defined in the FEA/FCA’s preferences.</td>
</tr>
<tr>
<td>Dynamic List</td>
<td>Displays the FEA/FCA Timeline and displays the Dynamic List using the default Selected Time Range setting defined in the FEA/FCA’s preferences.</td>
</tr>
<tr>
<td>Copy</td>
<td>Opens the Copy FEA/FCA dialog box for the FEA/FCA.</td>
</tr>
</tbody>
</table>

**Note:** The FEA/FCA data block and right-click menu will have “FSM” or “AFP” appended to the FEA/FCA name if it is FSM-Eligible or has an active AFP.
## FEA/FCA Right-Click Menu (Continued)

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit</td>
<td>Opens the Edit FEA/FCA dialog box for the FEA/FCA.</td>
</tr>
<tr>
<td></td>
<td>Note: The Edit menu option is disabled (grayed out) if you are</td>
</tr>
<tr>
<td></td>
<td>not allowed to edit the FEA/FCA.</td>
</tr>
<tr>
<td>Delete</td>
<td>Displays the Delete Confirmation dialog for the FEA/FCA.</td>
</tr>
<tr>
<td>Filters</td>
<td>Opens the Filters dialog box for the FEA/FCA.</td>
</tr>
<tr>
<td>Save FEA/FCA File</td>
<td>Opens the Save FEA/FCA File dialog for the FEA/FCA with the name of the</td>
</tr>
<tr>
<td></td>
<td>FEA/FCA displayed in the Save As field.</td>
</tr>
<tr>
<td>Information</td>
<td>Opens the FEA/FCA Information Dialog for the FEA/FCA.</td>
</tr>
</tbody>
</table>
You may have FEA/FCAs that you use over and over again. However, because those that have expired will be deleted from the database once a day, you need to be able to save the definition that you want to re-use. You can recall that saved FEA/FCA as needed. You can also delete an FEA/FCA when you no longer need it.

<table>
<thead>
<tr>
<th>Recall FEA/FCA File Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>The <strong>Recall FEA/FCA File</strong> command lets you recall a previously saved file. It works in the same way it does on the File pull-down menus on the Select FEA/FCA and FEA/FCA Preferences dialog boxes.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the FEA/FCA menu by clicking <strong>FEA/FCA</strong> on the TSD Main Menu or by pressing &lt;Alt&gt; C.</td>
<td>None</td>
</tr>
<tr>
<td>2. Click <strong>Recall FEA/FCA File</strong> or press R.</td>
<td><strong>Semicolon Method</strong></td>
</tr>
<tr>
<td></td>
<td>None</td>
</tr>
</tbody>
</table>
Recalling an FEA/FCA File

After you click **Recall FEA/FCA File** or press **R** from the FEA/FCA menu, the Recall FEA/FCA File dialog box opens.

![Recall FEA/FCA File dialog box](image)

Clicking a file name in the dialog box or entering the name in the Selection text entry field recalls the saved FEA/FCA definition. The files are recalled from the workstation that is specified in the FEA/FCA Preferences dialog box. The default location for the files on the workstation is `/ETMS/tsd/adapt/fca_files`.

There are two options near the bottom of the dialog box:

1. **Retain Saved Start Time**
2. **Reset Start Time to Current Time**.

**Retain Saved Start Time**

The Retain radio button is selected by default. If you choose this option, the start time and end time of the original saved FEA/FCA is retained. The start date of the original FEA/FCA will be reset to the current date if the start time is after the current time.

The start date of the original FEA/FCA will be reset to the following day if the start time is before the current time.
The example below shows a recalled FEA file with a start time of 23:30. If the current time is earlier than 23:30 (for example, 10:30), the start date is the current date (in this example, 01/10/07), and the end date in this case is the following day. If the current time is later than 23:30, the start date is the following day, and the end date is set to preserve the original duration.

Reset Start Time to Current Time

If you select this option, the start date and time will be set to the current date, and the start time will be set to the beginning of the current 15-minute interval. The end date and time will be set to preserve the original duration.
Examine FEA/FCA Command

The Examine FEA/FCA command lets you request reports and view the flights that are predicted to intersect the FEA/FCA. You can examine multiple FEA/FCAs and display their timelines on the TSD. If you are examining multiple FEA/FCAs, the color of the flight icon that is associated with the multiple FEA/FCAs is determined by the FEA/FCA that is highest in the Select FEA/FCA dialog box when the FEA/FCAs are sorted according to the default sort order. The default sort order sorts first by Domain (Public, Shared, Local, Private) and next alphabetically by name.

You will not be able to examine an FEA/FCA that is based on a sector that is currently closed. If you are examining such an FEA/FCA and the sector upon which it is based is combined into another sector, the TSD will close the timeline and display an error message.

If no FEA/FCAs have been created, this menu item will not be available.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the FEA/FCA menu by clicking FEA/FCA on the TSD Main Menu or by pressing &lt;Alt&gt; C.</td>
<td>With the FEA/FCA selected, press E</td>
</tr>
<tr>
<td>2. Click Examine FEA/FCA or press E.</td>
<td>Semicolon Method</td>
</tr>
<tr>
<td></td>
<td>None</td>
</tr>
</tbody>
</table>

Note: This section describes using the Examine FEA/FCA command in Normal mode. For information on using the Examine FEA/FCA command in Model mode, see page 4-424 in Chapter 4, Reroute Impact Assessment section.

FEA/FCA Alert

If an FEA/FCA is edited while being examined, a warning dialog box opens to inform you that it has been edited. Clicking Info opens the Information dialog box for the FEA/FCA.
Examine FEA/FCA Dialog Box

After you click Examine FEA/FCA or press E from the FEA/FCA menu, the Examine FEA/FCA dialog box opens, requesting the name of the FEA/FCA you want to examine.

![Examine FEA/FCA Dialog Box](image)

After you enter the FEA/FCA Name and click OK, the FEA/FCA Timeline dialog box opens, looking like the sample below. The numbers in the upper row indicate the maximum number of flights expected to occupy the FEA/FCA during any 1-minute interval within the 15-minute interval. These numbers do not appear immediately, but take a short period to be displayed on the dialog box. The numbers on the bottom row indicate the 15-minute intervals.

![FEA/FCA Timeline](image)

**Note:** The FEA/FCA Timeline will have "FSM" or "AFP" appended to the FEA/FCA name if it is FSM-Eligible or has an active AFP.

The timeline also displays the number of Secondary filters that are turned on, as shown in the example above.

**Note:** You can also access the FEA/FCA Timeline dialog box from the Select FEA/FCAs dialog box. Click the row number of the FEA/FCA you want to examine. Click the **Functions** pull-down menu and select Examine.
RVSM

If the RVSM Counts option is selected in the Select RVSM Display Options dialog box, the RVSM counts are displayed on the FEA/FCA Timeline. The TSD displays the peak one-minute counts (or total counts) of flights that are predicted to be RVSM non-conformant at any time when they are in the examined FEA/FCA. The TSD displays this counts as a white number over a square black background in the Timeline cell.

The example below shows an FEA/FCA Timeline with total RVSM counts displayed.

Selecting Time Intervals on the FEA/FCA Timeline

You can select the time intervals in several ways:

- Click a single time interval.
  You can click either the flight data field or the time interval field. Both fields become selected for that interval.

- With one interval selected, press and hold the <Shift> key and click another interval. All time intervals, the beginning and end as well as those in between, are selected.

- With the pointer on either the flight data field or the time interval, press and hold the left mouse button, moving it over to another interval. All time intervals from the first to the last are selected. If the pointer is on the flight data field row, the timeline will scroll when the pointer is moved to the right of the last visible interval.

**Note:** To return to a single interval, click that interval again. Only that one is selected.
FEA/FCA Timeline Functions

You can use the FEA/FCA Timeline dialog box to perform the following functions:

- Show or Hide an FEA/FCA Bar Chart
- Generate the Dynamic List
- Toggle between Relative and Absolute Time Range selections
- Show or Hide FEA/FCA Flights
- Generate an FEA/FCA Report
- Toggle among Total Counts, Entry Counts, and Peak Counts
- View or edit FEA/FCA Flight Filters

You can use one of three methods to perform these functions: the icons on the dialog box, the Functions pull-down menu, and FEA/FCA quick keys. Each of these methods are shown on the following pages.

Timeline Toolbar Icons

Clicking one of the toolbar icons shown below generates a Dynamic List, shows or hides FEA/FCA flights, shows or hides a bar chart, or opens the FEA/FCA flight filters.

**Note:** When the cursor is positioned over the Filters button, the TSD pops up a tool tip with a list of the currently selected secondary filters.

There is another icon on the Timeline, which lets you toggle between the display of peak occupancy counts for each minute within the 15-minute time interval or total flights that traverse the FEA/FCA within the 15-minute time interval. The figure below shows the Timeline with the Total Counts icon toggled on.
Clicking the **Flight Counts** button toggles the Total Counts, Entry Counts, and Peak Counts display. The sample below shows the Timeline with the Peak Counts icon toggled on.

### FEA/FCA Quick Keys

When focus is on the FEA/FCA Timeline, you can use the following quick keys to perform the Examine FEA/FCA functions:

<table>
<thead>
<tr>
<th>Quick Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>=</td>
<td>Toggles the display of FEA/FCA flights</td>
</tr>
<tr>
<td>R</td>
<td>Requests an FEA/FCA report</td>
</tr>
<tr>
<td>C</td>
<td>Displays the FEA/FCA Bar Chart</td>
</tr>
</tbody>
</table>

### Timeline Functions Menu

The Functions pull-down menu lets you perform the same functions as the tool bar icons: Show/Hide Bar Chart, Show/Hide Flights, generate a report, or toggle peak and total counts. In addition, you can display the Dynamic List and open the Filters dialog box.
Functions Menu: Show/Hide Bar Chart

The Show/Hide Bar Chart option on the FEA/FCA Timeline Functions menu lets you generate a bar chart displaying the number of flights expected to traverse an element during 15-minute intervals and indicates the number of secondary filters applied and also whether residual flights are On or Off.

After you issue the Show Bar Chart command using the Functions menu, quick key, or icon, the FEA/FCA Chart dialog box for the examined FEA/FCA opens. The bar chart indicates whether peak counts or total counts were selected on the FEA/FCA Timeline dialog box. The screen below show a bar chart with Total Counts.
The screen below shows a bar chart with Peak Counts.

![Bar Chart Image]

Fixes and airports are best represented by Total counts, which is consistent with the Total counts of Monitor Alert.

**Note:** The FEA/FCA Bar Chart will have “FSM” or “AFP” appended to the FEA/FCA name if it is FSM-Eligible or has an active AFP.

**Using the Bar Chart**

You can display information for each interval by clicking and holding the left mouse button in a time interval bar on the chart. Each bar provides the following information:

- **Time Interval**
  Displays the selected 15-minute time interval in hhmm format. For example: 1915

- **Total Flights**
  Displays the total number of flights, active and proposed, expected to be in the FEA/FCA during the peak one-minute traffic count within the specific time interval or the total number of flights expected in the FEA/FCA during the interval.

- **Active Flights**
  Displays the number of flights currently in the air expected to be in the FEA/FCA during the peak 1-minute traffic count within the specific time interval or the total number of flights expected in the FEA/FCA during the interval.
• **Proposed Flights**
  Displays the number of flights that have not yet left the ground and that are expected to be in the FEA/FCA during the peak one-minute traffic count within the selected time interval or the total number of flights expected in the FEA/FCA during the interval.

**Filters**

The filter information is displayed below the bars on the graph. The FEA/FCA Chart indicates the number of secondary filters applied, and whether residual flights are On or Off.

**Bar Chart Colors**

The FEA/FCA Chart uses a 2-color bar to indicate what portion of the flights in each interval is proposed and what portion is active, as follows:

- **Red** -- Number of active flights projected to be in the FEA/FCA during the peak one-minute count or the total number of active flights projected to be in the FEA/FCA for the 15-minute intervals.

- **Yellow** -- Number of proposed flights projected to be in the FEA/FCA during the peak one-minute traffic count or the total number of proposed flights projected to be in the FEA/FCA for the 15-minute intervals.

There are three buttons at the bottom of the FEA/FCA Chart:

1. **Toggle Size**
   Clicking this button lets you resize the Chart. Clicking it again returns it to its original size.

2. **Close**
   Clicking this button closes the Chart.

3. **Help**
   Clicking this button displays help text for this dialog box.
Functions Menu: Show Flights

The Show FEA/FCA Flights options on the Functions menu lets you show the flights that are predicted to intersect the FEA/FCA during the time intervals that are selected in the FEA/FCA Timeline, and that match at least one of the selected secondary filters. If Residuals are selected in the Filters dialog box, all FEA/FCA flights will be shown.

Active Flights

After you issue Show Flights, the flights that are currently active appear as regular flight icons in the color of the FEA/FCA. You can display data blocks for these flights through the Customize Flight Display dialog box. The color of the flight icons is determined by the color that is associated with the highest secondary filter in the Filters dialog box that matches the flight's characteristics.

If you are examining multiple FEA/FCAs, the color of the flight icon that is associated with the multiple FEA/FCAs is determined by the FEA/FCA that is highest in the Select FEA/FCA dialog box when the FEA/FCAs are sorted according to the default sort order. The default sort order is first by Domain (Public, Shared, Local, Private) next by name.
Flights on the Ground

Flights that have not yet departed are indicated by flight counts at each airport, including a count of all flights still on the ground, controlled flights on the ground past the original departure time, and flights on the ground past their Estimated Time of Departure (ETD). Small, empty circles at the airports where they are originating represent those flights that meet these criteria. Beside each circle icon are the airport identifier and a set of three numbers, as shown and explained here:

- **Total flights on ground**
  This is the total number of flights represented by this icon, that is, the number waiting to depart from this airport that will traverse the examined FEA/FCA within the indicated time limit and that match at least one of the secondary filters that has been turned on.

- **Controlled flights**
  Of the total number of flights represented by this icon, this is the number of flights that are currently controlled by a ground delay program and whose original departure time is already past.

- **Flights on ground past ETD**
  Of the total number of flights represented by this icon, this is the number of flights whose ETD is already past, but have not departed.

- **RVSM Non-Conformant Flights**
  This is the total number of RVSM non-conformant flights on the ground.

**Note:** This number is displayed if the “RVSM Non-Conformant Indicators for Drawn Flights” option is on and flights are drawn for an examined sector, fix, airport and/or FEA/FCAs, and some of the examined flights are inactive.
You can display data blocks for flights that have not departed by selecting the circle icons. Note that a data block for a circle icon may describe multiple flights. The data block lists the Estimated Time of Departure for each flight and, if controlled, the original (proposed) departure time, as follows:

![Data Block Example]

As with any other data blocks, data blocks for circle icons may also show the origin and destination or route of each flight, and routes may be drawn, depending on whether those items had been selected when you selected Customize on the Flights menu.

**Functions Menu: Report**

The FEA/FCA Report option on the Functions menu lets you generate a report that lists the flights predicted to intersect with the selected FEA/FCA during the selected time intervals. Using the Functions menu, the quick key, or the icon method opens a report like the following example.

![Report Example]
Functions Menu: Dynamic List

When you select **Dynamic List** from the Functions menu, a dialog box that looks like a spreadsheet is displayed. The Dynamic List includes only flights that are predicted to intersect the FEA/FCA during the selected time intervals and, if residuals are off in the Filters dialog box, that match at least one of the secondary filters that are turned on.

The sample Dynamic List shows only those columns selected in the Customized Columns dialog box, which is explained later in this section. Active flights are shown in black text on a white background. Inactive flights are shown in gray text, and the aircraft ID column also has a gray background.

The FEA/FCA title bar displays the flight count option selected in the timeline.

![Dynamic List](image)

**Note:** The FEA/FCA Dynamic List will have “FSM” or “AFP” appended to the FEA/FCA name if it is FSM-Eligible or has an active AFP.
The following table describes all the columns of information in the Dynamic list.

### Dynamic List Columns

<table>
<thead>
<tr>
<th>Data Item</th>
<th>Header</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abbreviated Route</td>
<td>ABBR ROUTE</td>
<td>Route that has been abbreviated using the CRCT algorithm, up to 15 characters. Abbreviated Route is a default column in the Dynamic List.</td>
</tr>
<tr>
<td>Aircraft ID</td>
<td>ACID</td>
<td>Alphanumeric aircraft identifier. Aircraft ID is a default column in the Dynamic List.</td>
</tr>
<tr>
<td>Aircraft Type</td>
<td>TYPE</td>
<td>Flight's aircraft type. Example: DC10 or B727</td>
</tr>
<tr>
<td>Airline</td>
<td>AIRLINE</td>
<td>Airline Identifier (leading alphabetic characters of the ACID).</td>
</tr>
<tr>
<td>Arrival Center</td>
<td>ACENTR</td>
<td>Arrival Center.</td>
</tr>
<tr>
<td>Arrival Time</td>
<td>ETA</td>
<td>TFMS estimate of wheels down time.</td>
</tr>
<tr>
<td>Centers Traversed</td>
<td>CENTERS</td>
<td>Space separated list of centers that the flight traverses.</td>
</tr>
<tr>
<td>Control Element</td>
<td>CTL ELEM</td>
<td>FCA or Airport for the AFP or GDP or “-” if none.</td>
</tr>
<tr>
<td>Controlled Arrival Time</td>
<td>CTA</td>
<td>Controlled Arrival Time or “-” if none.</td>
</tr>
<tr>
<td>Controlled Departure Time</td>
<td>CTD</td>
<td>Controlled Departure Time or “-” if none</td>
</tr>
<tr>
<td>Current ARTCC</td>
<td>ARTCC</td>
<td>ARTCC where flight is currently located or departure ARTCC for inactive flights.</td>
</tr>
<tr>
<td>Current Altitude</td>
<td>CALT</td>
<td>TFMS reported altitude in hundreds of feet.</td>
</tr>
<tr>
<td>Departure Center</td>
<td>DCENTR</td>
<td>Departure Center.</td>
</tr>
</tbody>
</table>
### Dynamic List Columns (Continued)

<table>
<thead>
<tr>
<th>Data Item</th>
<th>Header</th>
<th>Description</th>
</tr>
</thead>
</table>
| Departure Time          | ETD    | Estimated time of departure, based on the best available time data.  
A - Actual departure time, usually based on a NAS departure message.  
E - Estimated actual departure time. No departure message was received, but the flight is known to be airborne because NAS messages indicating this have been received.  
N - P-time from the airline-provided early intent message.  
P - P-time from the NAS flight plan message.  
R - The historical route has been replaced by the assigned route.  
S - Departure time estimated from the Official Airline Guide scheduled time.  
T - Flight is off the gate and may be taxiing. A gate departure time has been received.  
Departure Time is a default column in the Dynamic List.  
  
**Note:** If you place the pointer over a cell in the ETD column of the flight list, a tool tip displays that defines the ETD value in the cell. |
| Destination             | DEST   | FAA designator showing the destination airport. If you are reviewing the arrival portion of the report, this column should be the original airport name. |
| Entry Time              | ENTRY  | Time when the flight is predicted to first intersect the FEA/FCA.  
Entry Time is a default column in the Dynamic List. |
| Exit Time               | EXIT   | Time when the flight is predicted to exit the FEA/FCA for the last time.  
| FCA Indicator           | RMK    | Indicator if this is a flight that has FCA in Remarks  
| Filed Speed             | SPD    | Filed speed.  
| Flight Status           | FSTAT  | Value of the flight status field. Same as the ETD prefix.  
| Full Route              | FULL ROUTE | Complete field 10 route, up to 30 characters.  
| Initial Gate Time of Departure | IGTD | Value of the Gate Departure Time when the flight is first entered into TFMS.  
| NRP Indicator           | NRP    | Indicates whether the flight is a National Route Program flight.  
| Origin                  | ORIG   | FAA designator showing the departure airport.  
| RVSM                    | RVSM   | Indicates the within-sector RVSM compliance status of each flight in the list. "NC" is displayed if the flight is non-conformant or a dash "." is displayed otherwise. |
Dynamic List Columns (Continued)

<table>
<thead>
<tr>
<th>Data Item</th>
<th>Header</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requested Altitude</td>
<td>ALT</td>
<td>Requested Altitude. TFMS Filed Altitude in hundreds of feet.</td>
</tr>
<tr>
<td>Secondary Filter</td>
<td>FILTER</td>
<td>Displays the name of the highest priority matching secondary filter, or residual if no secondary filters match and the residuals option was selected.</td>
</tr>
<tr>
<td>Time to Intersect</td>
<td>TIME TO</td>
<td>Time to intersect the FEA/FCA. The value shall be 00:00 if the flight has already intersected the FEA/FCA.</td>
</tr>
</tbody>
</table>
Hold Button
You can stop the Dynamic List from updating by clicking Hold. The list stops updating and the Hold button changes to Resume. To update the list, click Resume.

Note: When the Dynamic List is updated, the previous scroll position stays the same. The same rows are displayed before and after the update.

Sort the Dynamic List
You can sort the list by specifying primary, secondary, and tertiary sort criteria. Clicking the column header will continue to sort the list in ascending or descending order alphabetically.

File Menu: Dynamic List
The File Menu on the Dynamic List lets you save the Dynamic List to the Reports directory. You can view the report in the Report Manager on the Tools menu. You can also Print it to your designated printer or Close the report and return to the Alerts Timeline dialog box.
Tool Bar Icons: Dynamic List

The icons near the top of the Dynamic List perform the Print and Save functions in the same way that the File menu items do.

Note: The Dynamic List includes all flights that are predicted to intersect the FEA/FCA during the entire life time of the FEA/FCA, not just the intervals selected.

Functions Menu: Customize Columns

The Customize Columns option on the Functions menu lets you add and remove columns from the Dynamic List. Clicking Functions on the Dynamic List Window and on Customize Columns opens the following dialog box.
To customize columns

1. To move a column name out of the Selected Columns, click the column name and click **Remove**. The column name now appears in the Available Columns list.

2. Click **OK**. You are returned to the Dynamic List. Notice that the column is no longer displayed.

3. To return the column to the Dynamic List, select **Customize Columns** again and select the name in the Available List column, click **Add** and click **OK**. You are returned to the Dynamic List, and the column is redisplayed.

4. To move the selected column names up and down within the list of Selected Columns, select the name and click **Move Up** or **Move Down**. The order in which they appear in Selected Columns is the order, from left to right, in which they appear on the Dynamic List.

5. Click **OK** to move the column header to the left if you selected **Move Up**, or to the right if you selected **Move Down**.

**Functions Menu: Filters**

Selecting Filters on the Functions menu or pressing the Filters button opens the Filters dialog box. The sample Filters dialog box below shows the Primary filter and two Secondary filters for the FEA/FCA.

This dialog box can also be opened by other methods.

- Click **Filters** on the Functions menu of the Select FEA/FCA dialog box.
- Click **Filters** on the FEA/FCA Timeline Functions menu.
- Click the **Filters** button on the FEA/FCA Timeline dialog box.
- Click the **Filters** button on the FEA/FCA Dynamic List.
The sample Filters dialog box below shows the primary filter and two secondary filters for the FEA/FCA.

![Filters dialog box]

Only authorized users can edit the Primary Filter. That process is discussed in the Select FEA/FCA section. You can edit the secondary filters by clicking the Edit button next to the appropriate secondary filter. The secondary filter fields and buttons function the same as they do on the Secondary Filters tab of the Create FEA/FCA dialog box. This function is discussed in the Create FEA/FCA section.

**Note:** You can deselect a selected row by pressing and holding the `<Ctrl>` key and clicking on the row number.
Functions Menu: Flight Counts
Clicking **Flight Counts** on the Functions menu opens a sub-menu that lets you choose between Entry Time, Peak Occupancy, and Total Flights.

Functions Menu: Close
Clicking **Close** on the Functions menu closes the Timeline dialog box.
The **Preferences** command lets you define the defaults you want for the Create FEA/FCA dialog box.

### Preferences Command

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the FEA/FCA menu by clicking <strong>FEA/FCA</strong> on the TSD Main Menu or pressing <code>&lt;Alt&gt;</code> <strong>C</strong>.</td>
<td><strong>None</strong></td>
</tr>
<tr>
<td>2. Click <strong>Preferences</strong> or press <strong>P</strong>.</td>
<td><strong>None</strong></td>
</tr>
</tbody>
</table>

**Note:** If you entered preferences values in the Create FEA/FCA Preferences tab for a defined FEA/FCA, those values take precedence over your entries in the Preferences dialog box shown on the following page.
FEA/FCA Preferences Dialog Box

After you select Preferences from the FEA/FCA menu, the FEA/FCA Preferences dialog box opens, looking like the sample below.
Using the FEA/FCA Preferences Dialog Box

Using the Preferences dialog box, you can disable the automatic showing of newly defined shared or public FEA/FCAs. When you disable this feature by clicking OFF in the Auto-Show Settings Status section, the TSD does not display newly defined FEA/FCAs that are created by another user.

The FEA/FCA Preferences dialog box contains three tabs: Create/Systems, Timeline/Dynamic List, and Shared Sites. The Create/System tab provides the fields for specifying the default FEA/FCA parameters. The Timeline/Dynamic List tab provides the fields for specifying the default Timeline and Dynamic List parameters. The Shared Sites tab provides fields for specifying the default sites for sharing a Shared FEA/FCA.

Create/System Tab

The following table describes the fields on the Create / System tab.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What you do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Polygon</td>
<td>Selecting this button lets you define a custom FEA/FCA as a polygon.</td>
<td>Polygon is selected by default. Either leave it selected, or click Line, Circle, or NAS to change the default.</td>
</tr>
<tr>
<td>Line</td>
<td>Selecting this button lets you define a custom FEA/FCA as a line.</td>
<td>Click the Line radio button to select this option.</td>
</tr>
<tr>
<td>Circle</td>
<td>Selecting this button lets you define a custom FEA/FCA as a circle.</td>
<td>Click Circle radio button to select this option.</td>
</tr>
<tr>
<td>NAS</td>
<td>Selecting this button means that when you create a new FEA/FCA, the NAS Element button will be selected. You will be able to select an element from a pick list. See the Create FEA/FCA section (page 4-442) for more details.</td>
<td>Click NAS radio button to select this option.</td>
</tr>
</tbody>
</table>

Characteristics

Domain

This field lets you define the FEA/FCA domain: Private, Local, Shared, or Public. All users can create Private FEAs, which are viewed only at the specific workstation where they were created. Local FEAs are shared with all workstations at the creator's site. Users at TFMS field sites can create Shared FEAs. Only users at ATCSCC can create Public FEAs or FCAs, which are shared with all TFMS users. Click the Private, Local, Shared, or Public radio button.
# FEA/FCA Preferences

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What you do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Select Either FEA (Flow Evaluation Area) or FCA (Flow Constrained Area). Only users at ATCSCC can select the FCA option and only if the Public domain was also selected.</td>
<td>Click the FEA or FCA radio button.</td>
</tr>
<tr>
<td>Color</td>
<td>Lets you determine the default color of the FEA/FCA and flight icon.</td>
<td>Click on the button to display a color palette. Click a color that you want for the FEA/FCA.</td>
</tr>
<tr>
<td>Look Ahead Time Range</td>
<td>Allows you to determine the maximum future time range for which flight data will be available for display on the TSD in the Timeline or Dynamic List. You can choose values from one to 24 hours.</td>
<td>Click the up or down arrow to the right of the field to increment or decrement the values, or use the keyboard arrow keys.</td>
</tr>
<tr>
<td>Ceiling</td>
<td>This field is initially filled in with the default value for Ceiling. You can enter one to three digits for the ceiling, from 000 to 600, which represents hundreds of feet.</td>
<td>To change the default value, click in the Ceiling box and enter a one to three digit number.</td>
</tr>
<tr>
<td>Floor</td>
<td>This field is initially filled in with the default value for Floor. You can enter one to three digits for the floor, from 000 to 600, which represents hundreds of feet.</td>
<td>To change the default value, click in the Floor box and enter a one to three digit number.</td>
</tr>
<tr>
<td>Duration (min)</td>
<td>This field specifies the amount of time that the FEA/FCA is valid.</td>
<td>Click in the Duration box and enter a one to four digit number.</td>
</tr>
<tr>
<td>System Settings</td>
<td></td>
<td></td>
</tr>
<tr>
<td>End Time Warning</td>
<td>This checkbox lets you specify whether the FEA/FCA End Time warning is to be displayed for FEAs and FCAs. Enabling the End Time Warning for FEA/FCAs causes the TSD to send out a warning message 30 minutes before the end time is up. This warning message is displayed in the FEA/FCA End Time Warning dialog box.</td>
<td>Click in the End Time Warning checkbox if you want the warning displayed. To disable the 30-minute warning, remove the check in the End Time Warning checkbox.</td>
</tr>
<tr>
<td>Auto-Show Settings</td>
<td>See page 4-504.</td>
<td>Click in the ON or OFF button.</td>
</tr>
<tr>
<td>Fileserver / workstation</td>
<td>Fileserver or workstation where the FEA/FCA files are stored.</td>
<td>Click in the text box and enter the name of the workstation. The default workstation is <strong>wkstn01</strong>.</td>
</tr>
</tbody>
</table>
Auto-Show Feature

The Auto-Show feature on the Create/System tab on the FEA/FCA Preferences dialog box has been modified to let you automatically show all FEA/FCAs that match the criteria shown in the Auto-Show Settings section of the FEA/FCA Preferences dialog box.

The default options are Auto-Show Status ON and Public FCA, Public FEA, and Shared categories checked, unless you have defined other settings in your TSD Adaptation file. If the TSD is started with the Auto-Show Status ON, the TSD places a check in the Show checkbox in the Select FEA/FCA dialog box for all existing FEA/FCAs that match the Auto-Show criteria.

Note: If Hide FEA/FCAs is selected on the FEA/FCA menu, the FEA/FCAs are not drawn on the TSD, even though the Show buttons are checked in the Select FEA/FCA dialog box.
You can select Auto-Show criteria other than the default options mentioned on the previous page. In the example below, the Auto-Show status is on for Private FEAs only. Therefore, any private FEAs you create or edit will have the Show button selected in the Select FEA/FCAs dialog box. However, the FEA will not be displayed on the TSD if Hide FEA/FCAs has been selected.

If you select the OFF Auto-Show setting, FEA/FCAs created or edited from that point on will not have their Show buttons automatically checked in the Select FEA/FCA dialog box.

**Note:** Any FEA/FCA that you create will always have its Show button checked in the Select FEA/FCA dialog box in the TSD used to create the FEA/FCA regardless of the Auto-Show status or settings.
Timeline/Dynamic List Tab

The Timeline / Dynamic List tab allows you to specify the default Timeline and Dynamic List parameters when creating an FEA/FCA. Clicking Timeline / Dynamic List opens a dialog box like the following.
Auto-Examine Function

Clicking in the **Auto-Examine** checkbox in the Timeline section of the FEA/FCA dialog box lets you establish the default setting for the Auto-Examine option on the Pref tab of the Create/Edit FEA/FCA dialog box. In the example below, the Auto-Examine checkbox is unchecked. Therefore, the Pref tab on the Create/Edit FEA/FCA dialog box would have its Auto-Examine checkbox unchecked and any FEA/FCA you create or edit would not automatically open a Timeline.

Checking the Auto-Examine checkbox in the FEA/FCA Preferences dialog box causes the Auto-Examine checkbox on the Pref tab on the Create/Edit dialog box to be checked. In that case, unless you change it, the FEA/FCAs you create or edit during the current TSD session will automatically open a Timeline.
FEA/FCA Relative and Absolute Time Range

The Time Range on the FEA/FCA Timeline can be Relative or Absolute. The FEA/FCA Time Range selection determines the Time Range mode the FEA/FCA Timeline displays. The Timeline initially opens with the Time Range Selection set to the mode specified in the FEA/FCA Preferences dialog box. The default setting is Relative unless Absolute is specified in an Adaptation file. The Functions menu on the Preferences dialog box below specifies Absolute Time Range, indicating that the Time Range is in Relative mode.

The FEA/FCA Timeline title bar displays the Time Range mode.

Relative Time Range

As was mentioned above, Relative Time Range is the default time range mode unless otherwise specified in an adaptation file or a Preference Set file used to start the TSD. When the Timeline is set to Relative Time Range mode, the selected time range displays relative to the current time and shifts forward as the current time advances. When the beginning of the first time interval on the Timeline increments by 15 minutes, the start and end times of the selected time range are also incremented by 15 minutes so that the same intervals, by position in the Timeline, remain selected.
Absolute Time Range

When the FEA/FCA Timeline is set to Absolute Time Range mode, the selected time range remains the same as the current time advances. When the beginning of the first time interval increments by 15 minutes, the start and end times of the selected time range are retained unless the start time is now in the past. If the start time is in the past, the TSD sets the start time to be equal to the beginning of the current 15 minute interval. As time continues to advance, the TSD sets an end time that is now in the past to be equal to the start time plus 15 minutes.

If, for example, you select fixed clock times such as 1600 to 1700, when the current time becomes 1615, the 1615, 1630, and 1645 segments remain highlighted and the 1600 interval is no longer displayed. In other words, the time range is now 45 minutes rather than the original 60 minutes. At 1645, only the 1645 segment remains highlighted. At 1700, the 1700 segment becomes selected, ensuring that there is always at least one time segment selected.

As time continues to advance, the TSD sets an end time that is now in the past to be equal to the start time plus 15 minutes.

Selecting a Time Range for Individual FEA/FCAs

The Relative/Absolute Time Range command on the Functions menu on the FEA/FCA Timeline enables you to toggle the time range selection for an FEA/FCA you are examining.

If the Timeline is then closed and later redisplayed, that Timeline will be restored as it had been for the FEA/FCA when it was closed.
Dynamic List

The Dynamic List icon on the Timeline displays the Dynamic List report for the FEA/FCA.

Clicking the Dynamic List icon opens a report like the following.

If Total Flight Counts was selected on the Timeline, the title bar on the Dynamic List would show Total Counts, as it does in the example above. If E (Entry Counts) or P (Peak Counts) is selected, the title bar would show one of those flight count types.
Changing Flight Count Types

To change the type of flight counts from Total Flights to Peak Occupancy, or Entry Time, click **Flight Counts** on the Functions menu and move the cursor to the right to select one of the three types.

You can also click the **Flight Counts** button on the Timeline toolbar. For example, clicking the T icon changes the flight counts to E (Entry) or P (Peak).

Shared Sites Tab

The Shared Sites tab lets you specify the TFMS sites that will share the FEA/FCA definition. The sites you enter will be default sites and will be listed in the Create FEA/FCA dialog box the next time you open it. Clicking on **Shared Sites** opens a dialog box like the following.
Each row of the Shared Sites tab lets you enter a site name. You can enter the site name directly in the text entry field or click the arrow to display a pick list of site names and click your choice. There is an automatic fill-in feature in the rows of the dialog box. When you type the first character of the site name in the text entry field, the TSD fills in the field with the first match in the list for that character. Clicking the arrow displays a pick list of all operational TFMS sites, sorted in alphabetical order.

There are two buttons near the bottom of the Shared Sites dialog box:

- **Add**
  Clicking this button adds a row to the 15 rows shown above in the sample Shared Sites dialog box.

- **Delete**
  Clicking the row number and clicking Delete removes the row from the dialog box. The TSD displays a fixed number of rows on this window, however, so there cannot be fewer than 15 rows.

- **Reset**
  Clicking Reset in the FEA/FCA Preferences dialog box resets the list of sites to the previously saved list.

**File Menu**

The File menu on the FEA/FCA Preferences dialog box lets you:

- Recall an adaptation file
- Save your defaults to a file
- Delete the file

These functions are discussed in Chapter 2, TSD Basics.
Requesting Reports

You can request FEA/FCA flight count and list reports using the semicolon command method by requesting FCATA as a data source.

The following examples show the command line format and the resulting report for each of these request reports.

Request Count

Request FCATA fea_fca_name

Example: **REQ FCATA FCA005**
Request List
Request FCATA fea_fca_name
Example: **REQ FCATA FCA005 LIST**

**FCATA Reports with Secondary Filters**
Specifying the FCATA data source in the Request command line lets you obtain a list and count report of the flights predicted to traverse the FEA/FCA that match one or more of the secondary filters. The command uses the following formats.

**Request List:**
REQ FCATA fea_fca_name date start_time end_time filters SECONDARY secondary_filter_name(s) LIST

Example: **REQ FCATA FCA005 08/10 1200 1400 AIRL AAL SECONDARY SLC_DEP LIST**

**Request Count:**
REQ FCATA fea_fca_name date start_time end_time SECONDARY secondary_filter_name(s)

Example: **REQ FCATA FCA005 08/10 1200 1400 SECONDARY SLC_DEP**
Tools Menu

Overview

This section describes commands available on the Tools pull-down menu and sub-menus. The section is organized by the following topics, each of which corresponds to an item on the Tools menu.

- **Snapshot Commands**  
  Saves the TSD screen image to an xwd formatted file  
  Page 4-517

- **Network Utilities Command**  
  Enables you to view the site and hubsite data, switch TSD sites, and re-establish communication with the TFMS as necessary  
  Page 4-522

- **Replay Command**  
  Enables you to display past flight, weather, and alert data  
  Page 4-525

- **Database Commands**  
  Enables you to issue database commands to the TFMS  
  Page 4-532
• **EDCT Commands**  
  Enables you to view departure times of flights controlled by EDCT programs  

• **Command Line Command**  
  Enables you to issue commands through a command line interface dialog box  

• **Report Manager Command**  
  Enables you to manage reports in the Reports directory  

• **Script Command**  
  Enables you to run a script file  

• **Version Command**  
  Displays the current TSD version number and date of compilation
Snapshot Commands

The Snapshot commands let you save the TSD screen to an xwd file. You can choose one of three options from the pull-down sub-menu to capture, view and print an image of the TSD display.

### Capture Command

The Capture command lets you take a screen capture of the TSD display.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1. Pull down the Tools menu by clicking Tools on the main menu or pressing <Alt>T.
2. Click Snapshot or press P.
3. Click Capture or press C.

### Semicolon Method

None

### Snapshot Options Dialog Box

To capture a TSD screen image to a file, click the Snapshot Capture command. The Snapshot Options dialog box opens, as shown below.

![Snapshot Options Dialog Box](image-url)
The Snapshot Options dialog box contains three main sections:

- The top portion of the dialog box is the Capture Option, which by default is set to capture the entire screen. You click TSD Window to change the option and capture only the TSD window.

- In the middle of the dialog box is the Save/Print Option section, which by default is set to print and save the snapshot. You can change that to save without printing by clicking the \textit{Save to File} button.

- The bottom section contains a text field where you enter the name of the snapshot file to be saved.

\textbf{Note:} If you do not specify a filename before you click \textbf{OK}, you get an error message telling you to do so.

When you click \textbf{OK} on the Snapshot Options dialog box, the TSD starts a screen capture routine. You know the routine is running because you hear one beep when it starts. This process may take several seconds. When the screen capture routine has completed, you hear two beeps, and a dialog box opens telling you that the screen was successfully captured and saved to file \textit{<filename>}. Click \textbf{OK}, or wait for the dialog box to time out and disappear (approximately five seconds). You can now view or print the captured file.

When the captured screen appears, it will now have a default file name of \textit{snapshot.mmdhhmmss}, which you may change if you desire.
The **View** command lets you view an image of the TSD display.

### Menu Method

1. Pull down the Tools menu by clicking **Tools** on the main menu or pressing <Alt>T.
2. Click **Snapshot** or press P.
3. Click **View** or press V.

### Quick Key Method

- None

### Semicolon Method

- None

#### View Snapshot Dialog Box

To view your captured TSD snapshot, click **View** from the Snapshot sub-menu. The View Snapshot File dialog box opens:

![View Snapshot File Dialog Box](image)

Click the file you wish to view; this selects the file. Click **OK**. The file you selected appears. You may close the snapshot display window using the Window Menu button or by pressing Q or <Ctrl>C.
### Print Command

The **Print** command lets you print a hard copy of the TSD screen captured.

<table>
<thead>
<tr>
<th><strong>Menu Method</strong></th>
<th><strong>Quick Key Method</strong></th>
</tr>
</thead>
</table>
| 1. Pull down the Tools menu by clicking **Tools** on the main menu or pressing `<Alt> T`.  
2. Click **Snapshot** or press **P**.  
3. Click **Print** or press **P**. | None |

<table>
<thead>
<tr>
<th><strong>Semicolon Method</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td></td>
</tr>
</tbody>
</table>

### Print Snapshot Dialog Box

You can print a hard copy of any captured file by clicking **Print** on the Snapshot submenu. When you do, the Print Snapshot File dialog box opens.
Click on the file name you want to print and click **OK**. Another dialog box opens.

![Print Snapshot dialog box](image)

After you enter the path name in the text field, the file is sent to the printer.
Network Utilities Command

The Network Utilities command lets you change aspects of the TSD by accessing a submenu with two command options. You can see which site and hubsite provides flight data to the TSD, switch to a different site for flight data, and cause the TSD to reconnect with TFMS.

<table>
<thead>
<tr>
<th>Site Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>The <strong>Site</strong> command displays a dialog box that shows the local site name and hubsite name, and lets you switch all TSDs to another site.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Tools menu by clicking <strong>Tools</strong> on the main menu or pressing <code>&lt;Alt&gt;T</code>.</td>
<td></td>
</tr>
<tr>
<td>2. Click <strong>Network Utilities</strong> or press <strong>N</strong>.</td>
<td></td>
</tr>
<tr>
<td>3. Click <strong>Site</strong> or press <strong>S</strong></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Semicolon Method</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Input Request:</strong></td>
</tr>
<tr>
<td><strong>SITE</strong></td>
</tr>
</tbody>
</table>

Site Information Dialog Box

After you click **Site** or press the mnemonic key from the Tools menu, the Site Information dialog box opens, looking like the following sample.

The dialog box displays local and hubsite data. The Local Site field displays your local site name. The Hubsite field displays the hubsite where the flight data originated.

**Note:** You can't edit these fields.
Clicking the **Switch This TSD to Specified Site** button lets you switch a single TSD currently running on your node to another FTM site. Clicking the **Switch All TSDs on This Node** button lets you switch all TSDs currently running on your node to another FTM site. Clicking the **Switch All TSDs on This Site** button lets you switch all TSDs for all nodes that are connected to the same site as your node to a different site at your location. Clicking the **Switch To Site** button displays all sites at your location that are available for you to switch to.

**Note:** Switch options that are not available to you are disabled (grayed out).

A notification dialog box opens when the TSD switches to a new FTM site.
Reconnect Command

The **Reconnect** command disconnects from all TFMS servers and connects with the servers. You can use this function to reestablish communication with TFMS services in case a connection is lost and the automatic reconnection is not successful.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
</table>
| 1. Pull down the Tools menu by clicking **Tools** on the main menu or pressing `<Alt>` T.  
2. Click **Network Utilities** or press N.  
3. Click **Reconnect** or press R | Press “ |

**Semicolon Method**

None

**Information message**

After issuing the Reconnect command, you see a message saying that the deregistration message has been sent.
The **Replay** command lets you replay historical flight, weather, and alert data on one TSD at a time. This feature lets you review a scenario at a certain time and place and lets you compare current activities with those of the past. During the replay you can issue other TSD commands as usual. Requests for data from TFMS databases return current rather than historical data.

### Menu Method

1. Pull down the Tools menu by clicking **Tools** on the main menu or pressing `<Alt> T`.
2. Click **Replay** or press **R**.

### Quick Key Method

- **None**

### Semicolon Method

- **Input Request:**
  - REPLAY

The Replay function lets you display overlays for either the Current or Baseline sector boundaries that were in existence at the time that is being replayed. For example, if alerts are being replayed, alert icons are displayed using the sector boundaries that existed at the time being replayed.

**Note:** It is recommended that Current Sector Boundaries data be replayed if Alerts are being replayed. This data is needed to draw the correct boundaries for the Alert icons. Note also that the Time in Sector chart is unavailable when the TSD is running in Replay mode. If a Time in Sector chart is open when the Replay option is selected, a confirmation dialog box displays allowing you to close the Time in Sector chart or cancel Replay.
Replay Specification Dialog Box

After you click **Replay**, the Replay Specification dialog box opens. Also, the Times window changes to reflect that the data is historic, rather than current.
Show Data File Locations

When you click the **Show Data File Locations** button, the Replay Specification dialog box expands to show the pathnames to where the data items are stored. The example below shows a partial view of data and its corresponding pathnames.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>CIWS Precipitation Mosaic</td>
<td>/wx_maps/ciws_VIL_1km</td>
<td></td>
</tr>
<tr>
<td>CIWS Echo Tops Mosaic</td>
<td>/wx_maps/ciws_echotop_1km</td>
<td></td>
</tr>
<tr>
<td>Echo Top Tags</td>
<td>/wx_maps/ciws_echotop_tags</td>
<td></td>
</tr>
<tr>
<td>Growth &amp; Decay Contours</td>
<td>/wx_maps/ciws_growthdecay_co</td>
<td></td>
</tr>
<tr>
<td>Storm Motion Leading Edges</td>
<td>/wx_maps/ciws_leading_edges</td>
<td></td>
</tr>
<tr>
<td>Storm Motion Vectors</td>
<td>/wx_maps/ciws_motion_vectors</td>
<td></td>
</tr>
<tr>
<td>VIL Standard Forecast Contours</td>
<td>/wx_maps/ciws_VIL_contour_std</td>
<td></td>
</tr>
</tbody>
</table>

When you click the **Hide Data File Locations** button, you are returned to the default Replay Specification dialog box.

The following table describes items in the Replay Specification dialog box and provides examples of entries. Click the check box to the right of the text entry field and click **OK** to replay that data.

**Note:** Flights must be selected to run a replay and is automatically selected in the dialog box. You cannot deselect it. Other items are optional.

### Replay Specification

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Date</td>
<td>Date on which data to be replayed begins. (UTC format: mmdd)</td>
<td>Current date</td>
</tr>
<tr>
<td>From Time</td>
<td>Time when data to be replayed begins. (UTC format: hhmm)</td>
<td>One hour prior to the current time</td>
</tr>
<tr>
<td>To Date</td>
<td>Date on which data to be replayed ends. (UTC format: mmdd)</td>
<td>Current date</td>
</tr>
<tr>
<td>To Time</td>
<td>Time when data to be replayed ends. (UTC format: hhmm)</td>
<td>Current time</td>
</tr>
<tr>
<td>Replay Time Increment</td>
<td>The number of minutes that the replay time advances at each update.</td>
<td>1</td>
</tr>
<tr>
<td>Time Between Updates</td>
<td>Time frequency in seconds with which the Replay time updates.</td>
<td>10</td>
</tr>
</tbody>
</table>
### Replay Specification (Continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flights</td>
<td>Pathname where flights data is stored.</td>
<td>/nfs/lxstn01/traffic</td>
</tr>
<tr>
<td>Alerts</td>
<td>Pathname where alerts data is stored.</td>
<td>/nfs/lxstn01/sio_files</td>
</tr>
<tr>
<td>Current Sector Boundaries</td>
<td>Pathname where current sector boundaries data is stored.</td>
<td>/nfs/lxstn01/ETMS/rrsvr/dynamic_data/archive</td>
</tr>
<tr>
<td>CONUS 2 km Radar</td>
<td>Pathname where CONUS NOWRAD 2km data is stored.</td>
<td>/nfs/lxstn01/wx_maps/nowrad_2km</td>
</tr>
<tr>
<td>Canada 2 km Radar</td>
<td>Pathname where Canadian NOWRAD 2km data is stored.</td>
<td>/nfs/lxstn01/wx_maps/nowrad_2km_can</td>
</tr>
<tr>
<td>San Juan 2 km Radar</td>
<td>Pathname where San Juan NOWRAD 2km data is stored.</td>
<td>/nfs/lxstn01/wx_maps/nowrad_2km_sj</td>
</tr>
<tr>
<td>CCFP</td>
<td>Pathname where CCFP is stored.</td>
<td>/nfs/lxstn01/wx_maps/ccfp_files</td>
</tr>
<tr>
<td>NCWF</td>
<td>Pathname where NCWF is stored.</td>
<td>/nfs/lxstn01/wx_maps/ncwf_files</td>
</tr>
<tr>
<td>Legacy TOPS</td>
<td>Pathname where Legacy Tops data is stored.</td>
<td>/nfs/lxstn01/wx_maps/echo_top</td>
</tr>
<tr>
<td>Jetstream</td>
<td>Pathname where jet stream data is stored.</td>
<td>/nfs/lxstn01/wx_maps/jet_stream</td>
</tr>
<tr>
<td>Lightning</td>
<td>Pathname where lightning data is stored.</td>
<td>/nfs/lxstn01/wx_maps/lightning</td>
</tr>
<tr>
<td>Satellite Image</td>
<td>Pathname where CIWS satellite data is stored.</td>
<td>/nfs/lxstn01/wx_maps/ciws_satellite</td>
</tr>
<tr>
<td>CIWS Precipitation Mosaic</td>
<td>Pathname where CIWS precipitation data is stored.</td>
<td>/nfs/lxstn01/wx_maps/ciws_VIL1km</td>
</tr>
<tr>
<td>CIWS Echo Tops Mosaic</td>
<td>Pathname where CIWS echo tops data is stored.</td>
<td>/nfs/lxstn01/wx_maps/ciws_echotop_1km</td>
</tr>
<tr>
<td>Echo Tops Tags</td>
<td>Pathname where CIWS echo tops tags data is stored.</td>
<td>/nfs/lxstn01/wx_maps/ciws_echotop_tags</td>
</tr>
<tr>
<td>Growth&amp; Decay Contours</td>
<td>Pathname where CIWS growth and decay trends data is stored.</td>
<td>/nfs/lxstn01/wx_maps/ciws_growthdecay_contour</td>
</tr>
<tr>
<td>Storm Motion Leading Edges</td>
<td>Pathname where CIWS storm motion leading edges data is stored.</td>
<td>/nfs/lxstn01/wx_maps/ciws_leading_edges</td>
</tr>
<tr>
<td>Storm Motion Vectors</td>
<td>Pathname where CIWS storm motion vectors data is stored.</td>
<td>/nfs/lxstn01/wx_maps/ciws_motion_vectors</td>
</tr>
<tr>
<td>VIL Standard Forecast Contour</td>
<td>Pathname where CIWS standard precipitation forecast data is stored.</td>
<td>/nfs/lxstn01/wx_maps/ciws_VIL_contour_std</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
<td>Examples</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>VIL Winter Forecast Contour</td>
<td>Pathname where CIWS echo tops forecast data is stored.</td>
<td>/nfs/lxstn01/wx_maps/ciws_echotop_contour</td>
</tr>
<tr>
<td>Echo Tops Forecast Contour</td>
<td>Pathname where CIWS standard precipitation forecast data is stored.</td>
<td>/nfs/lxstn01/wx_maps/ciws_VIL_contour_std</td>
</tr>
<tr>
<td>VIL Standard Accuracy Scores</td>
<td>Pathname where CIWS standard precipitation accuracy scores data is stored.</td>
<td>/nfs/lxstn01/wx_maps/ciws_stdprecip_accuracy</td>
</tr>
<tr>
<td>VIL Winter Accuracy Scores</td>
<td>Pathname where CIWS winter precipitation accuracy scores data is stored.</td>
<td>/nfs/lxstn01/wx_maps/ciws_winterprecip_accuracy</td>
</tr>
<tr>
<td>Echo Tops Accuracy Scores</td>
<td>Pathname where CIWS echo tops accuracy scores data is stored.</td>
<td>/nfs/lxstn01/wx_maps/ciws_echotop_fcst_accuracy</td>
</tr>
</tbody>
</table>
Replay Control Panel

After you click OK in the Replay Specification dialog box, the Replay Control Panel dialog box opens, displaying the current date and time.

Using the Replay Control Panel

The replay date and time shown at the top of the control panel update continuously and automatically. You can also change these fields by clicking Pause and entering new values in the date and time field. When you click Pause, the button changes to Resume. Click Resume to continue running the replay with the new date and time values.

Like a DVD player, you can move the replay forward or backward. Notice that the arrows to the left and right of the Resume button are highlighted when the replay has been paused. Each arrow has a specific function.

- The arrow to the immediate left of the Resume button moves the time back one increment.
- The arrow to the immediate right of the Resume button moves the time forward one increment.
- The second arrow from the left of Resume runs the replay backwards.
- The second arrow from the right of Resume runs the replay forward.
- The arrow to the far left of the row returns the time value to its original start time.

When the replay date and time reach the end of the specified time period, the replay process returns to its original start date and time.

Clicking Cancel returns you to the Replay Specification dialog box.

Clicking Cancel on the Replay Specification dialog box cancels the Replay mode and returns the TSD to displaying live data.
**File Menu**

The File menu contains the same menu items as it does in several TSD dialog boxes: Recall, Save, and Delete. This menu is explained in Chapter 2.

**Minimap Menu**

The Minimap function is not available at TFMS field sites.
Database Commands

Database Commands let you display and revise airport, fix, and sector capacity settings, display and revise airport General Aviation estimates, and maintain the airline schedule database.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Tools menu by clicking <strong>Tools</strong> on the main menu or pressing <code>&lt;Alt&gt;</code> T.</td>
<td>None</td>
</tr>
<tr>
<td>2. Click <strong>Database Commands</strong> or press D.</td>
<td></td>
</tr>
<tr>
<td>3. Click a command from the sub-menu or press its mnemonic key.</td>
<td></td>
</tr>
</tbody>
</table>

Semicolon Method

Input Request:
- **CAPL** or **CAPS**
- **GAEL** or **GAES**
- **FPSD**
- **CXSD**
- **INHB**
- **ACTV**

Command Line Dialog Box

After you click **Database Commands** or press the mnemonic key from the Tools menu, a Command Line dialog box opens for the individual command that you select from the Database Commands sub-menu, as in the following example.
The following table lists commands currently available on the sub-menu. For detailed information about each command, see Chapter 5, Semicolon Commands.

## Database Commands

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Chapter 5 Page No.</th>
<th>Mnemonic Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAPL</td>
<td>Lists alert thresholds for an airport, fix, or sector. Thresholds refer to the number of flights an airport, fix, or sector can receive or handle during a 15–minute time interval before an alert is generated.</td>
<td>See page 5-18.</td>
<td>C</td>
</tr>
<tr>
<td>CAPS</td>
<td>Allows traffic managers to set the alert thresholds of an airport, fix, or sector for a specified time period. You can set two parameters for sectors: MAP On and MAP Off.</td>
<td>See page 5-20.</td>
<td>P</td>
</tr>
<tr>
<td>GAEL</td>
<td>Lists the estimated number of general aviation flights arriving at, departing from, or traversing a specified airport, fix, or sector within 15–minute intervals.</td>
<td>See page 5-84.</td>
<td>G</td>
</tr>
<tr>
<td>GAES</td>
<td>Allows traffic managers to set the general aviation estimates for a specified airport, fix, or sector.</td>
<td>See page 5-86.</td>
<td>E</td>
</tr>
<tr>
<td>FPSD</td>
<td>Adds flights to the TFMS airline schedule database, or edits a flight that already exists in the database. The added flight data can be seen in TFMS reports generated through the Request and Alert commands.</td>
<td>See page 5-80.</td>
<td>F</td>
</tr>
<tr>
<td>CXSD</td>
<td>Cancels the current day’s flight plan for a specified flight number in the TFMS flight schedule database.</td>
<td>See page 5-25.</td>
<td>X</td>
</tr>
<tr>
<td>INHB</td>
<td>Inhibits a specific flight or all flights for a specific airline in the TFMS flight schedule database.</td>
<td>See page 5-95.</td>
<td>I</td>
</tr>
<tr>
<td>ACTV</td>
<td>Activates a flight or airline in the TFMS airline database, thus removing a restriction that was previously set with the INHB command.</td>
<td>See page 5-6.</td>
<td>A</td>
</tr>
</tbody>
</table>
The **EDCT Commands** (Estimated Departure Clearance Time) allow you to view controlled departure times of flights.

<table>
<thead>
<tr>
<th><strong>Menu Method</strong></th>
<th><strong>Quick Key Method</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Tools menu by clicking <strong>Tools</strong> on the main menu or pressing <strong>&lt;Alt&gt; T</strong>.</td>
<td>None</td>
</tr>
<tr>
<td>2. Click <strong>EDCT Commands</strong> or press <strong>E</strong>.</td>
<td></td>
</tr>
<tr>
<td>3. Click a command from the submenu or press its mnemonic key.</td>
<td></td>
</tr>
</tbody>
</table>

### Semicolon Method

**Input Request:**

- EDCT AC OFF
- EDCT AC ON
- EDCT CHECK
- EDCT CNX
- EDCT CTALIST
- EDCT HOLD
- EDCT LIST
- EDCT LOG
- EDCT PURGE
- EDCT RELEASE
- EDCT SCS OFF
- EDCT SCS ON
- EDCT SHOW
- EDCT SLIST
- EDCT SLOTS
- EDCT SUB OFF
- EDCT SUB ON
- EDCT SUB PRINT
- EDCT SUB SHOW
- EDCT UNASSIGNED SLOTS
- EDCT UPDATE
Command Line Dialog Box

After you click **EDCT Commands** or press the mnemonic key from the Tools menu, a Command Line dialog box opens for the individual command that you select from the EDCT Commands sub-menu, as in the following example.

![Command Line Dialog Box](image)

The following table lists commands currently available on the sub-menu. For detailed information, each command is listed alphabetically in Chapter 5, Semicolon commands.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Mnemonic Key</th>
<th>Chapter 5 Page no.</th>
</tr>
</thead>
<tbody>
<tr>
<td>EDCT AC OFF</td>
<td>Turns off the Adaptive Compression for a Ground Delay Program (GDP) or an Airspace Flow Program (AFP) associated with the specified airport, FCA, or all airports and FCAs. This command is similar to EDCT SCS OFF, which turns Slot Credit Substitution off. Only users at authorized sites can use this command.</td>
<td>(none)</td>
<td>page 5-28</td>
</tr>
<tr>
<td>EDCT AC ON</td>
<td>Turns on the Adaptive Compression for a GDP or an AFP associated with the specified airport, FCA, or all airports and FCAs. This command is similar to EDCT SCS ON, which turns Slot Credit Substitution on. Only users at authorized sites can use this command.</td>
<td>(none)</td>
<td>page 5-30</td>
</tr>
<tr>
<td>EDCT CHECK</td>
<td>Displays the current status of a single flight controlled by an EDCT program.</td>
<td>K</td>
<td>page 5-32</td>
</tr>
<tr>
<td>EDCT CNX</td>
<td>Creates a report listing all flights cancelled in EDCT programs for a selected airport or FCA. If you specify an airline, the list will include only those cancelled flights for an airport or FCA for that selected airline.</td>
<td>X</td>
<td>page 5-35</td>
</tr>
<tr>
<td>EDCT CTALIST</td>
<td>Creates a report listing all controlled and cancelled flights for an airport or FCA, as well as open slots. If you specify an airline, the list will include only those controlled and cancelled flights for an airport or FCA for that selected airline.</td>
<td>A</td>
<td>page 5-38</td>
</tr>
</tbody>
</table>
### EDCT Commands (Continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Mnemonic</th>
<th>Chapter 5 Page no.</th>
</tr>
</thead>
<tbody>
<tr>
<td>EDCT HOLD</td>
<td>Holds the slots of all flights in a GDP or an AFP, or only the slots of flights belonging to a specified airline and its sub-carriers. Only users at authorized sites can use this command.</td>
<td>D</td>
<td>page 5-41</td>
</tr>
<tr>
<td>EDCT LIST</td>
<td>Creates a report containing a list of all airports currently controlled by EDCT programs.</td>
<td>L</td>
<td>page 5-43</td>
</tr>
<tr>
<td>EDCT LOG</td>
<td>Creates a report listing all EDCT flights, cancellation messages, and Substitution processing (SI) messages processed by the system in the order they were received. Only users at authorized sites can use this command.</td>
<td>G</td>
<td>page 5-46</td>
</tr>
<tr>
<td>EDCT PURGE</td>
<td>Purges EDCT flight controls for a specified airport or FCA or for all airports and FCAs. You can restrict the purge to include only controls before or after a specified time. Only users at authorized sites can use this command.</td>
<td>P</td>
<td>page 5-49</td>
</tr>
<tr>
<td>EDCT RELEASE</td>
<td>Releases the slots of all flights in a GDP or AFP, or only the slots of flights belonging to a specified airline and its sub-carriers. Only users at authorized sites can use this command.</td>
<td>R</td>
<td>page 5-51</td>
</tr>
<tr>
<td>EDCT SCS OFF</td>
<td>Suspends Slot Credit Substitution (SCS) for flights controlled by EDCT programs at a specified airport or FCA, or all airports and FCAs. To allow slot credit processing after using this command, you must activate processing with the EDCT SCS ON command. Only users at authorized sites can use this command.</td>
<td>F</td>
<td>page 5-53</td>
</tr>
<tr>
<td>EDCT SCS ON</td>
<td>Allows Slot Credit Substitution (SCS) processing to be turned on at an airport or for an FCA. SCS processing can be turned off using the EDCT SCS OFF command. Only users at authorized sites can use this command.</td>
<td>C</td>
<td>page 5-55</td>
</tr>
<tr>
<td>EDCT SHOW</td>
<td>Creates a report containing detailed information on all flights controlled by EDCT programs for a specified airport, for all airports or for an FCA.</td>
<td>H</td>
<td>page 5-56</td>
</tr>
</tbody>
</table>
## EDCT Commands (Continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Mnemonic</th>
<th>Chapter 5 Page no.</th>
</tr>
</thead>
<tbody>
<tr>
<td>EDCT SLIST</td>
<td>Provides a slot list for a specified airport or an FCA. If you specify an airline, the list will include only those slots for the airline and its sub-carriers at the specified airport or FCA in the exact format that goes to the airlines.</td>
<td>S</td>
<td>page 5-60</td>
</tr>
<tr>
<td>EDCT SLOTS</td>
<td>Creates a report listing all open slots for airlines at specified airports or within FCAs.</td>
<td>T</td>
<td>page 5-63</td>
</tr>
<tr>
<td>EDCT SUB OFF</td>
<td>Suspends Substitution message processing at a specified airport, for a specified FCA, or for all airports and FCAs. Only users at authorized sites can use this command.</td>
<td>U</td>
<td>page 5-65</td>
</tr>
<tr>
<td>EDCT SUB ON</td>
<td>Allows Substitution message processing at a specified airport, for a specified FCA, or for all airports and FCAs where Substitution processing was previously suspended. Only users at authorized sites can use this command.</td>
<td>N</td>
<td>page 5-67</td>
</tr>
<tr>
<td>EDCT SUB PRINT</td>
<td>Allows the selection of a printer at the Air Traffic Control System Command Center (ATCSCC) to print ATCSCC’s copy of replies to Substitution processing (SI) messages. Only users at authorized sites can use this command.</td>
<td>B</td>
<td>page 5-69</td>
</tr>
<tr>
<td>EDCT SUB SHOW</td>
<td>Creates a report showing the status of Substitution processing for all airports/FCAs. Only users at authorized sites can use this command.</td>
<td>W</td>
<td>page 5-70</td>
</tr>
<tr>
<td>EDCT UNASSIGNED SLOTS</td>
<td>Creates a report listing all unassigned slots at a specified airport or FCA.</td>
<td>O</td>
<td>page 5-72</td>
</tr>
<tr>
<td>EDCT UPDATE</td>
<td>Updates a controlled flight with new departure and arrival times. Only users at authorized sites can use this command.</td>
<td>E</td>
<td>page 5-74</td>
</tr>
</tbody>
</table>
Command Line Command

The Command Line command lets you issue TSD commands, display previously issued commands, and display a list of reports that have been received during the current TSD session.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Tools menu by clicking Tools on the main menu or pressing &lt;Alt&gt; T.</td>
<td>None</td>
</tr>
<tr>
<td>2. Click Command Line or press C.</td>
<td></td>
</tr>
</tbody>
</table>

Command Line Dialog Box

After you click Command Line or press the mnemonic key from the Tools menu, the Command Line dialog box opens, looking like the sample below.

The sample Command Line dialog box has nothing entered in the Input Request field. If a semicolon command has been entered during the current TSD work session, that command name is displayed and highlighted in the field. You can enter the new command by typing in the command name over the highlighted current command.
**Command History Button**

Click the **Command History** button to display a list of previously entered commands. Any command that you select from this list appears in the Input Request field.

**Note:** You can also type the command name in the Input Request field.

A sample dialog box with Command History selected follows.

When focus is on the Input Request field and the **Return** key is pressed, the command is issued.

If the command you issued is a request command, a report is generated. If the command is not a request command, the TSD is redrawn with the results of the command displayed on the screen. For example, if you issued the **Move** command, as in the sample dialog box above, the TSD changes its display to the center point you have selected.
Reports Button

The Reports button lets you display a list of reports that have been received during the current TSD session. Click Reports to display a current list of reports, which are shown below along with a list of previously issued commands.

To view a specific report in the list, you may click the report name and click Display. You may also double-click the report name. After viewing the report you can print it to your specified printer or close the report and return to the Command Line dialog box.

File Menu

The File menu lets you save the contents of the Command History list to a file and to recall a previously saved list to replace the current Command History list. You may also delete a previously saved file using the Delete option in the File menu. The Command Line dialog box may be closed using the Exit option on the File menu.

Requests Menu

The Requests pull-down menu, shown on the following page, makes other menu options available.

- **Send Secondary**
  Uses information requested in an original report to generate subsequent Flight List, Flight Count, or Flight Plan reports for the same location. See page 4-162 for specific details on using this procedure.

- **Remove**
  To remove a previously issued command from the displayed list of commands, click the command and click Remove.

- **Clear**
  To clear a command from the Input Request field, click Clear. You may also highlight the command in the Input Request field by triple-clicking the command and pressing <Delete>. 
Secondary Reports
You use the Requests pull-down menu to generate a secondary report.

<table>
<thead>
<tr>
<th>What To Do</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Make a secondary request</strong></td>
</tr>
<tr>
<td>1. Click a report name in the Reports window; For example: <em>dfw_.cnts.16174023,02</em></td>
</tr>
<tr>
<td>2. Type the name of the secondary command for the same location in the Input Request field. For example: <em>REQ DFW</em></td>
</tr>
<tr>
<td>3. Click <strong>Requests</strong> and click <strong>Send Secondary</strong>.</td>
</tr>
<tr>
<td>4. Wait until the secondary report is displayed in the Reports window.</td>
</tr>
<tr>
<td>5. Click the report name and click <strong>Display</strong>.</td>
</tr>
<tr>
<td>6. Click <strong>Print</strong> to send a copy of the report to your printer or <strong>Close</strong> to exit the display window.</td>
</tr>
</tbody>
</table>
The Report Manager command lets you find and view reports in the Reports directory.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
</table>
| 1. Pull down the Tools menu by clicking Tools on the main menu or pressing <Alt> T.  
2. Click Report Manager or press M. | <Ctrl> ; |

### Semicolon Method
None

#### Report Manager Dialog Box
After you click Report Manager or press the mnemonic key from the Tools menu, the Report Manager dialog box opens.

You can use the dialog box to display, remove, search, or filter reports in the Reports directory. The lower section of the Report Manager dialog box looks like the Reports window in the Command Line dialog box. In the Report Manager dialog box, however, all reports in the Reports directory appear in the Reports window, not just those reports generated during the current TSD session.
## Report Manager

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What you do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>Filters reports by location identifier.</td>
<td>Enter the location identifier for an airport, ARTCC, a sector, or fix in the text field to the left of the <strong>Location</strong> button. Note that the Location checkbox is selected when an entry is made in the Location field.</td>
</tr>
<tr>
<td>Report Type and List</td>
<td>Filter reports by type.</td>
<td>Enter a report type, or select one from the list of report types that is displayed when the <strong>Report Type List</strong> button is clicked. Click the appropriate report type, which is displayed in the text field to the left of the Report Types button.</td>
</tr>
<tr>
<td>Date/Time</td>
<td>Filter by date and time.</td>
<td>Click the <strong>Date/Time</strong> button and enter your specified timeframe. Your entry must use the following format: dd hh mm ss (day/hour/minute/seconds); however, you only need to enter as much of the Date/Time value as is appropriate. That is, enter only the day value to find all reports for a day.</td>
</tr>
<tr>
<td>Filter</td>
<td>Searches for all reports or a list of reports filtered to your specifications. If you filter without specifications, all reports in the Reports directory are listed.</td>
<td>Select the filter options that you wish to be used in filtering the list of reports and click the <strong>Filter</strong> button. To display all reports in the Reports directory, click <strong>Filter</strong> without selecting any of the three filter options.</td>
</tr>
<tr>
<td>Clear Filter</td>
<td>Removes entries from the filter fields, which are described above.</td>
<td>Click the <strong>Clear Filter</strong> button.</td>
</tr>
<tr>
<td>Display</td>
<td>Displays an individual report from the Reports directory.</td>
<td>Click the name of the desired report and click <strong>Display</strong>. After reading the report, you can close it or print it.</td>
</tr>
<tr>
<td>Print</td>
<td>Prints an individual report from the Reports directory.</td>
<td>Click the name of the desired report and click <strong>Print</strong>. Another dialog box opens with the default print path displayed. You can edit the path to meet your own specifications. Enter the number of copies you want in the Copies field. The default number is 1. Click <strong>OK</strong> to print.</td>
</tr>
</tbody>
</table>
The **Script** command lets you automate the execution of a series of semicolon and quick key commands by placing them in a script file which the system can execute. Issuing the Script command causes the TSD to sequentially execute the commands contained in the script file you specify. Once the Script function begins executing the commands, it may be stopped by pressing `<Ctrl><End>`.

### Menu Method

1. Pull down the Tools menu by clicking **Tools** on the main menu or pressing `<Alt> T`.
2. Click **Script** or press `S`.

### Quick Key Method

None

### Semicolon Method

Input Request:

| SCRIPT or SRC or S |

### Script Prompts Dialog Box

After you click **Script** or press the mnemonic key from the Tools menu, the Script Prompts dialog box opens.

If your script file is not located in the `/ETMS/tsd/data/scripts` directory, you must enter the full pathname of the script file you wish to execute in the Pathname field. For example, if you wish to run the script file `myscript`, located in the `/ETMS/mydir directory, type `/ETMS/mydir/myscript`. Click **OK** or press `<Enter>` to execute the script file.

If your script file is located in the `/ETMS/tsd/data/scripts` directory, you may enter only the filename.
Script File Format

Script files are ASCII files that you develop yourself to execute functions you wish to perform automatically. Each item in the file must use the following format:

### Script File Format Descriptions

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comment</td>
<td>Enclosed in curly {} brackets; the TSD ignores all information enclosed in the brackets. May be continued on a separate line or may be within a line that contains valid script commands.</td>
</tr>
<tr>
<td>Line</td>
<td>Blank lines are ignored (except as noted in Semicolon Commands, below). Each line is limited to 256 characters (including spaces).</td>
</tr>
<tr>
<td>Quick Key</td>
<td>Multiple quick key commands may be entered on the same line, but one or more space(s) must separate each command.</td>
</tr>
<tr>
<td>Semicolon</td>
<td>Each semicolon command must start on a new line, with a semicolon (;) as the first non–blank character. Arguments normally accepted by the semicolon command may be entered on the same line with the command. Each argument must be separated by one or more spaces. If the semicolon command would normally accept interactive entries in a prompt dialog box, the script file may contain those entries on separate lines after the semicolon command. A blank line here denotes a blank entry in the corresponding field in the prompt dialog box. The TSD executes the command after it reads the line corresponding to the last prompt field in the dialog box, or, if the TSD encounters a line reading ”&lt;enter&gt;”, it executes the semicolon command assuming blank entries for all remaining prompt fields.</td>
</tr>
<tr>
<td>Script Utility</td>
<td>Each script utility command must begin a new line. The TSD ignores any extraneous words on the same line as the script utility command.</td>
</tr>
<tr>
<td>Case</td>
<td>The TSD is case-insensitive; however, it converts filenames contained in script files to lowercase to be compatible with other TSD functions.</td>
</tr>
</tbody>
</table>
# TSD Quick Key Commands

The table below lists the quick key commands supported by the script command.

## TSD Script Quick Key Commands

<table>
<thead>
<tr>
<th>Key</th>
<th>TSD Command</th>
<th>Key</th>
<th>TSD Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>%</td>
<td>Turn on Alerts display</td>
<td>-%</td>
<td>Turn off Alerts display</td>
</tr>
<tr>
<td>f</td>
<td>Turn on Flights</td>
<td>-f</td>
<td>Turn off Flights</td>
</tr>
<tr>
<td>*</td>
<td>Turn on Show Last TZ</td>
<td>-*</td>
<td>Turn off Show Last TZ</td>
</tr>
<tr>
<td>/</td>
<td>Turn on Lead Lines</td>
<td>-/</td>
<td>Turn off Lead Lines</td>
</tr>
<tr>
<td>-</td>
<td>Turn on Draw Routes</td>
<td>- -</td>
<td>Turn off Draw Routes</td>
</tr>
<tr>
<td>&amp;</td>
<td>Turn on Route Text in data blocks</td>
<td>-&amp;</td>
<td>Turn off Route Text in data blocks</td>
</tr>
<tr>
<td>+</td>
<td>Turn on Org-Dest text in data blocks</td>
<td>-+</td>
<td>Turn off Org-Dest text in data blocks</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Turn on all Data Blocks</td>
<td>-</td>
</tr>
<tr>
<td>~</td>
<td>Turn on Map Labels of shown map overlays</td>
<td>--</td>
<td>Turn off Map Labels</td>
</tr>
<tr>
<td>&lt;</td>
<td>Turn on Range Ring Labels of shown rings</td>
<td>--&lt;</td>
<td>Turn off Range Ring labels</td>
</tr>
<tr>
<td>#xxx</td>
<td>Display a specific Jet or Victor Route Number; add the route to the Show Map Item list</td>
<td>#&lt;xxx</td>
<td>Remove a specific Jet or Victor Route Number from the Show Map Item list.</td>
</tr>
<tr>
<td>^</td>
<td>Turn on TRACONs</td>
<td>^-</td>
<td>Turn off TRACONs</td>
</tr>
<tr>
<td>a</td>
<td>Turn on ARTCCs</td>
<td>-a</td>
<td>Turn off ARTCCs</td>
</tr>
<tr>
<td>b</td>
<td>Turn on Boundaries</td>
<td>-b</td>
<td>Turn off Boundaries</td>
</tr>
<tr>
<td>h</td>
<td>Turn on High Sectors</td>
<td>-h</td>
<td>Turn off High Sectors</td>
</tr>
<tr>
<td>j</td>
<td>Turn on Jet Routes</td>
<td>-j</td>
<td>Turn off Jet Routes</td>
</tr>
<tr>
<td>l</td>
<td>Turn on Low Sectors</td>
<td>-l</td>
<td>Turn off Low Sectors</td>
</tr>
<tr>
<td>n</td>
<td>Turn on All NAVAIDs</td>
<td>-n</td>
<td>Turn off All NAVAIDs</td>
</tr>
<tr>
<td>o</td>
<td>Turn on Oceanic Sectors</td>
<td>-o</td>
<td>Turn off Oceanic Sectors</td>
</tr>
<tr>
<td>p</td>
<td>Turn on Pacing Airports</td>
<td>-p</td>
<td>Turn off Pacing Airports</td>
</tr>
<tr>
<td>s</td>
<td>Turn on Superhigh Sectors</td>
<td>-s</td>
<td>Turn off Superhigh Sectors</td>
</tr>
<tr>
<td>t</td>
<td>Turn on All Airports</td>
<td>-t</td>
<td>Turn off All Airports</td>
</tr>
<tr>
<td>v</td>
<td>Turn on Victor Routes</td>
<td>-v</td>
<td>Turn off Victor Routes</td>
</tr>
<tr>
<td>y</td>
<td>Ignored by TSD</td>
<td>-y</td>
<td>Ignored by TSD</td>
</tr>
<tr>
<td>[a</td>
<td>Turn on Alert Areas</td>
<td>-[a</td>
<td>Turn off Alert Areas</td>
</tr>
<tr>
<td>[m</td>
<td>Turn on MOAs</td>
<td>-[m</td>
<td>Turn off MOAs</td>
</tr>
<tr>
<td>[p</td>
<td>Turn on Prohibited Areas</td>
<td>-[p</td>
<td>Turn off Prohibited Areas</td>
</tr>
<tr>
<td>[r</td>
<td>Turn on Restricted Areas</td>
<td>-[r</td>
<td>Turn off Restricted Areas</td>
</tr>
<tr>
<td>[w</td>
<td>Turn on Warning Areas</td>
<td>-[w</td>
<td>Turn off Warning Areas</td>
</tr>
<tr>
<td>[+</td>
<td>Turn on all SUAs</td>
<td>-[+</td>
<td>Turn off all SUAs</td>
</tr>
<tr>
<td>[l</td>
<td>Turn on Lat/Lon Grid</td>
<td>-[l</td>
<td>Turn off Lat/Lon Grid</td>
</tr>
<tr>
<td>arr</td>
<td>Turn on Arrival Fixes</td>
<td>-arr</td>
<td>Turn off Arrival Fixes</td>
</tr>
<tr>
<td>dep</td>
<td>Turn on Departure Fixes</td>
<td>-dep</td>
<td>Turn off Departure Fixes</td>
</tr>
<tr>
<td>pop</td>
<td>Maximize Window Size</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Example Script File

Your script file to modify the TSD display might look something like this:

{Sample file}
{Turn on boundaries and pacing airports}
  b p
{Set the projection to London}
  ;proj london
{turn off lat/lon grid and arrival fixes}
  -l -arr
{end}

Script Utility Commands

The TSD will recognize all of the following script utility commands, which are the following:

- ; WAIT n
- ; CONFIGWAIT n
- ; PAUSE text
- <LOCK>
- <UNLOCK>

The ; WAIT and ; CONFIGWAIT commands cause the TSD to wait n seconds before executing the next command in the script file.

The TSD ignores the <LOCK> and <UNLOCK> commands.

When a ; PAUSE command is encountered, the TSD displays the text of the ; PAUSE command in a dialog box. When the user clicks OK in the dialog box, the TSD continues executing the script file.
Version Command

The Version command lets you display a dialog box showing what version of the TSD you are currently running and the process Id for the version. The process Id is helpful when troubleshooting the TSD.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Tools menu by clicking Tools on the main menu or pressing &lt;Alt&gt; T. 2. Click Version or press V.</td>
<td>None</td>
</tr>
</tbody>
</table>

**Semicolon Method**

Input Request:

VER

Version Dialog Box

After you click the Version command or press the mnemonic key from the Tools menu, the Version dialog box opens. Click OK to close the box. The Version command is also available on the Help menu.
5. TSD Semicolon Commands

This chapter covers all TSD commands that have a Command Line Interface. These commands are listed here in alphabetical order. Each of these commands is explained in detail following this list.

<table>
<thead>
<tr>
<th>ACTV</th>
<th>GAEL</th>
<th>Request FIXL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adapt</td>
<td>GAES</td>
<td>Request LIFP</td>
</tr>
<tr>
<td>Aircraft Color</td>
<td>GTP ACID</td>
<td>Request List</td>
</tr>
<tr>
<td>Alarm</td>
<td>GTP AIRP</td>
<td>Request Listo</td>
</tr>
<tr>
<td>Background Color</td>
<td>Help</td>
<td>Request VT</td>
</tr>
<tr>
<td>CAPL</td>
<td>INHB</td>
<td>Restore</td>
</tr>
<tr>
<td>CAPS</td>
<td>Jet Stream</td>
<td>Restore Colors</td>
</tr>
<tr>
<td>Clear Weather</td>
<td>Lead Lines</td>
<td>Runway Layout</td>
</tr>
<tr>
<td>CXSD</td>
<td>Legend</td>
<td>RVR Report</td>
</tr>
<tr>
<td>EDCT AC Off</td>
<td>Lightning</td>
<td></td>
</tr>
<tr>
<td>EDCT AC On</td>
<td>Move</td>
<td></td>
</tr>
<tr>
<td>EDCT Check</td>
<td>NOWRAD (2km)</td>
<td></td>
</tr>
<tr>
<td>EDCT CNX</td>
<td>Projection</td>
<td></td>
</tr>
<tr>
<td>EDCT CTALIST</td>
<td>Radar Tops</td>
<td></td>
</tr>
<tr>
<td>EDCT Hold</td>
<td>Range Rings</td>
<td></td>
</tr>
<tr>
<td>EDCT List</td>
<td>Range Rings Defaults</td>
<td></td>
</tr>
<tr>
<td>EDCT Log</td>
<td>Remove</td>
<td></td>
</tr>
<tr>
<td>EDCT Purge</td>
<td>Replay</td>
<td></td>
</tr>
<tr>
<td>EDCT Release</td>
<td>Request Area</td>
<td></td>
</tr>
<tr>
<td>EDCT SCS Off</td>
<td>Request ARRD</td>
<td></td>
</tr>
<tr>
<td>EDCT SCS On</td>
<td>Request Count</td>
<td></td>
</tr>
<tr>
<td>EDCT Show</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EDCT Slist</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EDCT Slots</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EDCT Sub Off</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EDCT Sub On</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EDCT Sub Print</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EDCT Sub Show</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EDCT Unassigned Slots</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EDCT Update</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Examine</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FPSD</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

VNTSC-TFM-RM-010
TFMS Reference Manual, TSD Version 8.9
Document Version 24
Command Finder

- Alerts Commands
  - Alarm
  - Examine
  - Select Alerts
  - Time Limits

- Basic Commands
  - Adapt
  - Help
  - Legend
  - Script
  - Site
  - Version

- Color Commands
  - Aircraft Color
  - Background Color
  - Restore Colors
  - Save Colors
  - Select Flight Group Color
  - Select Flights and Color
Database Commands

ACTV
CAPL
CAPS
CXSD
FPSD
GAEL
GAES
INHB
REMOVE
RESTORE

EDCT Commands

EDCT AC OFF
EDCT AC ON
EDCT Check
EDCT CNX
EDCT CTALIST
EDCT Hold
EDCT List
EDCT Log
EDCT Purge
EDCT Release
EDCT SCS Off
EDCT SCS On
EDCT Show
EDCT Slist
EDCT Slots
EDCT Sub Off
EDCT Sub On
EDCT Sub Print
EDCT Sub Show
EDCT UNASSIGNED Slots
EDCT Update
Flight Commands

- Lead Lines
- GTP ACID
- GTP AIRP
- Replay
- Select Arrivals
- Select Arrivals and Departures
- Select Data Blocks
- Select Departures
- Select Flights

Map Commands

- Lat/Lon Points
- Move
- Projection
- Range Rings
- Range Rings Defaults
- Runway Layout
- Show Map Item
- Zoom

Weather Commands

- Clear Weather
- Jet Stream
- Lightning
- NOWRAD (2km)
- NOWRAD (6km)
- NOWRAD (8km)
- Radar Tops
- RVR Report
- WX Report
Request Commands

- Request Area
- Request ARRD
- Request Count
- Request FIXL
- Request LIFP
- Request List
- Request Listo
- Request VT
Semicolon Commands: A-D

**ACTV**

The **ACTV** (Activate) command activates a flight or airline in the TFMS airline schedule database, thus removing a restriction that was previously set with the INHB command.

**Command Line Interface**

Press `;` and enter your command using the following syntax:

For example: **ACTV UAL123 0104 0106**

Press `<Enter>`.

**Menu Method**

1. Pull down the Tools menu by clicking **Tools** on the main menu or pressing `<Alt>` T.
2. Click **Database Commands** or press D.
3. Click **ACTV** on the sub-menu or press A.

**Quick Key Method**

None

**ACTV Prompts Dialog Box**

If you enter the command with no parameters, the ACTV Prompts dialog box opens.

You may also enter the complete command on one line. Be sure to include a space between items. For each item in the dialog box, enter a value as described in table on the next page.
Confirmation Messages

When a flight or airline is successfully activated in the database, you get a confirmation message. This message includes the aircraft or airline activated, and information about the time affected. You may see different message formats.

If you activate a flight without using the start or stop date options, for example, the confirmation message dialog box would appear.

```
Flight UAL 123 activated: Old inhibit period: 0104-0104 New inhibit period: (CR)
```

The flight identifier appears first, next the old and new inhibit periods. If the flight was no longer inhibited, the message would show no dates for the new inhibit period. This example shows a flight that was inhibited for the current date (0104) only.

In this example, the period specified with the ACTV command covers only a portion of the old inhibit period. The flight is still inhibited for the part of the time period not covered by the ACTV command. If you do not receive a confirmation message, you may see one or more diagnostic messages.

Related Commands

Use the FPSD command to add a new flight or edit an existing flight in the schedule database, and use CXSD to cancel a flight.
Adapt

The **Adapt** command allows you to restore the current TSD display to a previously customized configuration, which is specified in the adaptation file. This command is similar to the Recall sub-menu command, accessed from the Adapt sub-menu on the Display menu.

## Command Line Interface

Press `;` and enter your command using the following syntax:

![Command Line Interface](image)

(*Indicates optional entry)

For example:

**ADAPT /ETMS/TSD/ADAPT/ADAPTATIONS/BLACK_BACKGROUND**

Press `<Enter>`.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
</table>
| 1. Pull down the Display menu by clicking **Display** on the main menu or pressing `<Alt>` **D**.  
2. Click **Adapt** or press **A**.  
3. Click **Recall** or press **R**. | None |
Adapt Prompts Dialog Box

If you enter the command with no pathname, the Adapt dialog box opens.

If you do not use a full pathname, the system looks for the file you specify in the directory /ETMS/tsd/adapt/primary. If you do not answer this prompt, the system uses the adaptation file invoked at TSD startup.

Note: The other Adapt sub-menu items, Save, Delete, and Change Colors and Fonts, cannot be issued through the Command Line Interface.

About Adaptation Files

An adaptation file is a special file created by the TSD using the Adapt > Save menu option. It is invoked each time the TSD is started, and changed each time you save an adaptation using the Adapt > Save option. This allows the TSD to be customized with a particular geographic location, set of overlays, and flight display. Issuing the Adapt command during a TSD session restores the TSD to this configuration or allows you to choose another.
The **Aircraft Color** command changes the default color of all the flight icons that appear on the TSD.

### Aircraft Color

#### Command Line Interface

Press `;` and enter your command using the following syntax:

```
DEFAULT AIRCRAFT COLOR
```

**Note:** You can also enter the command **DAC**

For example: **DAC BLUE**

Press `<Enter>`.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Flights menu by clicking <strong>Flights</strong> on the main menu or pressing <code>&lt;Alt&gt; F</code>.&lt;br&gt;2. Click <strong>Select Flights</strong> or press <strong>S</strong> to open the Select Flights dialog box.</td>
<td>None</td>
</tr>
</tbody>
</table>

### Resulting

If you enter the command with no parameters, the Default Aircraft Color dialog box opens.
Clicking the **Color** button displays a color palette.

![Color Selector](image)

You may also enter the complete command on one line. Be sure to include a space between the command name and the color.

**Related Commands**

You can save and recall your specified aircraft colors to a file by selecting the File pull-down menu on the Select Flights dialog box. See the Flights menu in Chapter 4.
The **Alarm** command allows you to set or see the status of audible and/or visual alarms for Monitor Alert. When the Alarm command is set to ON and alerts are displayed, the systems beeps and/or flashes for any alerted element identified in the Alarm Specifications dialog box. While elements remain alerted, the alarm is produced at each update. This command turns the alarm on or off and allows you to see the current status or to modify the current alarm settings.

### Command Line Interface

Press ; and enter your command using the following syntax:

1. Pull down the Alert menu by clicking **Alerts** on the main menu or pressing <Alt> A.
2. Click **Alarms** or press L.

### Menu Method

<table>
<thead>
<tr>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
</tr>
</tbody>
</table>

Press <Enter>.
Alarm Commands

The element type parameters are optional.

- **Alarm On element type** - Turns alarms on and adds the specified element to the list of elements in the Alarm Specifications dialog box.

- **Alarm Off element type** - Turns alarms off and removes the specified elements from the list of elements under the Alarm Specifications dialog box.

- **Alarm Read filename** - Reads the specified alarm file. Without a specified filename, this command displays the Recall Alarms File dialog box.

Alarms occur only if live alerts are on. When alarms are on, the alarm icon is shown in the Times box.
Alarms Specifications Dialog Box

When you issue the Alarm Status semicolon command, the Alarm Specifications dialog box opens.

![Alarms Specifications Dialog Box](image-url)
Using the Dialog Box

The Alarm Specifications dialog box has four parts:

- **Alarm Status**
  
  Turns the alarms on or off
  
  Click **ON** or **OFF**.

- **Elements for Which Alarms are to be Issued.**
  
  Enter single or multiple names of the appropriate airport, fix, or sector. Use a space between multiple entries.

- **Alarm Parameters**
  
  Specifies alarms for active and proposed flights.
  
  For active flights, click the button to issue alarms for red alerts. For proposed flights, click the button to issue alarms for yellow alerts. Click a button to specify the alarm as a beep and/or flash. Note that at least one checkbox must be selected. However, both may be selected.

- **Beep Parameters**
  
  Specifies parameters for beeping and flashing.
  
  Enter a number for the length of tone, number of tones per ring, and the number of rings.

After you enter these fields, click **OK** to set the alarms.

**File Menu**

You can use the File pull-down menu to save the alarm specifications to be recalled at a later date. For more information about the File pull-down menu, refer to Chapter 2.

**Related Commands**

The Show Alerts command is used with Alarm to notify the user of alerted elements.
Background Color

The **Background Color** command changes the color of the TSD’s background for the duration of your TSD session, or until you issue the Adapt command. Be sure that the background color you choose is not the same as the color for flights of other elements.

Command Line Interface

Press `;` and enter your command using the following syntax:

For example: **SBC BLUE**

Press `<Enter>`.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Display menu by clicking <strong>Display</strong> on the main menu or pressing <code>&lt;Alt&gt; D</code>.</td>
<td>None</td>
</tr>
<tr>
<td>2. Click <strong>Adapt</strong> or press A.</td>
<td></td>
</tr>
<tr>
<td>3. Click <strong>Change Colors and Fonts</strong> or press C.</td>
<td></td>
</tr>
</tbody>
</table>
Resulting

If you enter the command with no parameters, the Select Background Color dialog box opens.

Clicking the Color button displays a color palette, as shown below.

Background Colors

For the background color, you can specify one of the color names listed below. This table lists the color names associated with each cell in the

<table>
<thead>
<tr>
<th>black</th>
<th>dark gray</th>
<th>gray</th>
<th>light gray</th>
<th>white</th>
<th>antique white</th>
<th>light tan</th>
</tr>
</thead>
<tbody>
<tr>
<td>dark brown</td>
<td>brick red</td>
<td>red</td>
<td>reddish tan</td>
<td>light pink</td>
<td>light cyan</td>
<td>turquoise</td>
</tr>
<tr>
<td>purple</td>
<td>plum</td>
<td>magenta</td>
<td>violet red</td>
<td>pink</td>
<td>light green</td>
<td>bright green</td>
</tr>
<tr>
<td>navy blue</td>
<td>blue</td>
<td>slate</td>
<td>light blue</td>
<td>cyan</td>
<td>sea green</td>
<td>goldenrod</td>
</tr>
</tbody>
</table>
The **CAPL (Capabilities List)** command lists the current Monitor Alert Parameter (MAP) settings for an airport, fix, or sector. The MAP values displayed by the CAPL command are either values set previously with the CAPS command, or default values. These values are the number of flights allowed to arrive at, depart from, or traverse a selected element during each 15-minute interval, before that element changes to alert status.

### Command Line Interface

Press `;` and enter your command using the following syntax:

For example:

```
CAPL SFO A A
```

```
CAPL RADDY F H
```

*If you issue the command using an Airport (A) or Fix (F) type, you must specify subtype data. If you issue the command using a Sector (S) type, you cannot specify subtype data. See the note on the following page for additional information. See the Table under the CAPS command for definitions of place, type, and subtype. Press `<Enter>`.

### Menu Method

1. Pull down the Tools menu by clicking **Tools** on the main menu or pressing `<Alt> T`.
2. Click **Database Commands** or press **D**.
3. Click **CAPL** on the sub-menu or press **C**.

### Quick Key Method

None
**Request Capacity Data Dialog Box**

If you enter the command with no parameters, the Request Capacity Data dialog box opens.

![Request Capacity Data dialog box](image)

Enter the **Place** name. Click the **Type** arrow type to display the three types of locations. If the type is Fix, enter the subtype. You may also enter the complete command on one line, making sure to include a space between each item. For an explanation of the fields in the dialog box, see the CAPS command.

**About the Display**

The top half of the screen displays a table that contains a listing of the current capacity thresholds for the element you have identified. Separate capacity listings appear for airport arrivals and departures and for low, high, and superhigh fixes.

The illustration below shows what the screen might look like if you requested capacities for an airport. The time period (shown under the times column) covers a 24-hour period starting from the quarter-hour preceding the current TSD update time.

![15 minute capacity values for airport DFW](image)

Capacities labeled nom are the nominal values that the system uses as default for the element. Capacities labeled tod are today's values, which may have been set with the CAPS command.

**Related Commands**

The CAPS command is used to temporarily set the capacities for up to 24 hours from current time. The GAEL and GAES commands allow you to list and set General Aviation Estimates for air traffic.
CAPS

The CAPS (Capacities Set) command allows traffic management specialists to temporarily set the arrival or departure MAP value of an airport, fix, or sector for specific time periods up to 24 hours from the MAP value time. For sectors, you can enter MAP On and MAP Off values. Traffic management specialists at the Air Traffic Control System Command Center (ATCSCC) can use CAPS to change settings for any element. All other users can change the settings for airports fixes, or sectors only within their own Air Route Traffic Control Center (ARTCC) boundaries. Changes made with this command do not affect alert thresholds beyond 24 hours in the future.

Command Line Interface

Press ; and enter your command using the following syntax:

```
CAPS NAME START END ON OFF
```

For example: MAP On and MAP Off parameters:
```
CAPS ZLC17 S 1900 2100 ON 15 OFF 13
```

MAP On parameter only:
```
CAPS ZLC17 S 1900 2100 ON 15
```

MAP Off parameter only:
```
CAPS ZLC17 S 1900 2100 OFF 13
```

Press <Enter>.

Note: As shown in the examples above, relative time periods may be used. See the Relative Time Periods section in Appendix A for additional information. Although the start time and end time values can be repeated, multiple times should not be put in the same command.

Menu Method | Quick Key Method
---|---
1. Pull down the Tools menu by clicking Tools on the main menu or pressing <Alt>T. 2. Click Database Commands or press D. 3. Click CAPS on the sub-menu or press P. | None

Note: When you set only one parameter, TFMS will change only the parameter that you specified unless the MAP Off value would become greater than the MAP On value. In that case both parameters will be set to the same value that you specified.
**Note:** If you issue the command using an Airport (A) or Fix (F) type, you must specify subtype data. If you issue the command using a Sector (S) type, you cannot specify subtype data. See the note on the following page for additional information.

### Set Capacity Dialog Box

If you enter the CAPS command with no parameters, the Set Capacity dialog box opens. If you are using the CAPS command for sectors, you can enter MAP On and MAP Off values. For airports and fixes you can enter only one MAP value. The sample dialog box below shows a sector with different MAP On and MAP Off parameters.

![Set Capacity Dialog Box](image)

You may also enter the complete command on one line. Be sure to include a space between items.
For each item in the dialog box or entered on the command line, enter a value as described in the following table:

<table>
<thead>
<tr>
<th>Item</th>
<th>Purpose</th>
<th>What you do</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Place</td>
<td>Specifies the element for which you wish to change capacity or capacities.</td>
<td>Enter the FAA designator for the airport, fix, or sector.</td>
<td>BOS</td>
</tr>
<tr>
<td>Type</td>
<td>Further specifies which element you want.</td>
<td>Click Airport to specify airport, Fix to specify fix, or Sector to specify sector.</td>
<td>Airport</td>
</tr>
<tr>
<td>Subtype (Arrival/Departure)</td>
<td>Specifies whether you want to set the capacity for arrivals or departures at the specified airport.</td>
<td>Click Arrival for arrivals or Departure for departures.</td>
<td>Arrival</td>
</tr>
<tr>
<td>Subtype</td>
<td>Specifies the altitude range for which you want to set the capacity.</td>
<td>Click Low for low fix. High for high fix. Superhigh for superhigh fix.</td>
<td>Superhigh</td>
</tr>
<tr>
<td></td>
<td>There are no Sector subtypes.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Start time</td>
<td>Specifies the time at which you want the capacity setting to take effect.</td>
<td>Enter four-digit UTC or relative time. (See next page for details.)</td>
<td>2000+2+2~</td>
</tr>
<tr>
<td>End time</td>
<td>Specifies the time at which you want the capacity setting to expire.</td>
<td>Enter the four-digit UTC or relative time (See next page for details)</td>
<td>2300+6</td>
</tr>
<tr>
<td>MAP On</td>
<td>A sector becomes alerted when the peak traffic count for a 15-minute interval exceeds the MAP On value.</td>
<td>Enter the number of flights.</td>
<td>17</td>
</tr>
<tr>
<td>MAP Off</td>
<td>A sector becomes unalerted when the peak traffic count for the 15-minute interval becomes equal to or less than the MAP Off value.</td>
<td>Enter the number of flights.</td>
<td>15</td>
</tr>
</tbody>
</table>
When you have specified the place, type, and subtype parameters and moved the focus to the Start Time field, the TSD issues a CAPL command to request the current capacity data. You may wait for the report to be returned, or you may proceed to enter the time and capacity parameters and issue the command without waiting for the report. However, note that the report, when it is received, will reflect the capacity settings in effect before the CAPS command was issued.

**Confirmation**

After issuing the command, the system notifies you that the command has been sent. At this point you can issue the CAPL command to verify the revised capacity settings. You may have to wait a few minutes before seeing the results of the command.

**Relative Time Periods**

You can specify times relative to the current time by entering a plus sign (+) followed by the number of hours after the current hour. (Unlike relative times with Request commands, times in the past are not valid; a value of +0 refers to the next quarter-hour interval.) You can use relative times in combination with absolute times. For example, assuming that the current time is 0925 UTC, the following command sets the arrival capacity at 20 starting at 1000 (one hour after 0925, rounded down to the nearest whole hour) and ending at 1200:

```
CAPS ORD A A +1 1200 20
```

You can also use a relative time for the end time, or for both start and end times. Using the same current time of 0925, the next example has the same effect as the previous example:

```
CAPS ORD A A +1 +3 20
```

You can use the tilde character (~) to set the start time and end time to the beginning of the current quarter hour. Assuming the current time is 0935, the next example makes the command effective starting at 1030 and ending at 1230:

```
CAPS ORD +1~ +3~ 20
```

**Changing Default Values**

To change default capacity values, see your System Administrator.

**Related Commands**

The CAPL command allows you to see the capacities set with this command. The GAEL and GAES commands allow you to list and set General Aviation Estimates for air traffic.

**Note:** The range of relative times is limited to 23 hours. This means relative values must fall between +0 (the next quarter hour) and +23 (the beginning of the 23rd hour).
Clear Weather

The `Clear Weather` command clears all weather overlays, just as if you had turned each one off separately. To remove the weather overlays temporarily, you can use the `Hide Weather` command on the Weather menu.

Command Line Interface

Press `;` and enter your command using the following syntax:

```plaintext
WX_MAPS CLEAR
```

Press `<Enter>`.

Menu Method

1. Pull down the Weather menu by clicking `Weather` on the main menu or pressing `<Alt> W`.
2. Click `Hide Weather` or press `W`.

Quick Key Method

None

Related Commands

The following commands also display weather overlays: NOWRAD2, Radar Tops, Lightning, and Jet Stream. The `Show Times` command displays the types of weather overlays currently on the TSD. `Show Weather` enables your selected overlays to be displayed and `Hide Weather` temporarily hides the weather overlays. `Weather Report` displays a weather report for an airport you specify.
The **CXSD** (Cancel Schedule Database) command cancels the current day’s flight plan for a specified flight number in the TFMS flight schedule database. In this context, current day is the period beginning 15 hours before the current time and ending 15 hours afterward. Also, the flight plan must be for a scheduled (that is, not active) flight. A flight canceled with the CXSD command does not appear in TFMS alerts or reports generated through the Request and Alerts Report commands. Use the FPSD command to put a canceled flight back in the database.

### Command Line Interface

Press `;` and enter your command using the following syntax:

```
* Indicates optional entries
For example:  CXSD AAL83 ORD 2218 LAX
Press <Enter>.
```

### Menu Method | Quick Key Method

| 1. Pull down the Tools menu by clicking **Tools** on the main menu or pressing <Alt> **T**. | None |
| 2. Click **Database Commands** or press **D**. | |
| 3. Click **CXSD** on the sub-menu or press **X**. | |
CXSD Prompts Dialog Box

If you enter the command with no parameters, the CXSD Prompts dialog box opens.

![CXSD Prompts Dialog Box](image)

You may also enter the complete command on one line. Be sure to include a space between items. For each item in the dialog box or entered on the command line, enter a value as described in the table below.

### CXSD

<table>
<thead>
<tr>
<th>Item</th>
<th>Purpose</th>
<th>What you do</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flight ID</td>
<td>Specifies the flight you want to cancel.</td>
<td>Enter the airline identifier, followed by the flight number.</td>
<td>AAL83</td>
</tr>
<tr>
<td>Origin Airport</td>
<td>Specifies the airport where the flight is to originate.</td>
<td>Enter the three–character designator for the origin airport.</td>
<td>ORD</td>
</tr>
<tr>
<td>Departure time</td>
<td>Specifies the departure time.</td>
<td>Enter the four–digit UTC when the flight is scheduled to depart.</td>
<td>2218</td>
</tr>
<tr>
<td>Destination</td>
<td>Specifies the destination airport.</td>
<td>Enter the three–character designator for the destination airport.</td>
<td>LAX</td>
</tr>
</tbody>
</table>

**Confirmation Message**

When the flight plan has been successfully canceled from the schedule database, you get a confirmation message. The message gives the flight identifier first, followed by the effective start date.

The flight is canceled for the current day only. The current day is defined as 15 hours before and after the time you issue the command. If the flight you specify has taken off less than 15 hours before the time you issue the command, the change will be effective for the next day.
No Confirmation Message

If you do not receive a confirmation message, you may see one or more diagnostic messages. For an explanation, see Appendix B.

Related Commands

You can use the INHB command to inhibit a flight on the database for an indefinite period, and use the ACTV command to reactivate it.
Semicolon Commands: E-G

EDCT AC OFF

The **EDCT AC OFF** semicolon command turns Adaptive Compression off for a Ground Delay Program (GDP) or Airspace Flow Program (AFP) associated with the specified airport or FCA, or all airports and FCAs. Adaptive Compression can be turned on using the **EDCT AC ON** command. This command is similar to **EDCT SCS OFF**, which turns Slot Credit Substitution off. Only users at authorized sites can use this command.

Command Line Interface

Press `;` and enter your command using the following syntax:

```
EDCT AC OFF DFW
```

**Note:** You can also enter the name of an FCA or **ALL**.

For example: **EDCT AC OFF FCA022**

or **EDCT AC OFF ALL**

Press `<Enter>`.

### Menu Method

1. Pull down the Tools menu by clicking **Tools** on the main menu or pressing `<Alt> T`.
2. Click **EDCT Commands** or press **E**.
3. Click **EDCT AC OFF**.

### Quick Key Method

None
Adaptive Compression

Adaptive Compression is intended to avoid slots being wasted by moving flights up to fill those slots. Its purpose is to increase the efficiency of an EDCT program and to eliminate needless delay. When a ground delay program is issued, each arrival slot is assigned to a flight. Sometimes, however, it will turn out that no flight uses a slot, which is thus wasted. This might happen if a flight is cancelled and another flight is not substituted for it. It might also happen if a flight has a mechanical delay and misses its slot. The Adaptive Compression feature will watch for slots that are in danger of being wasted and will move flights up to fill those slots.

In the Command Line dialog box, if you enter the EDCT AC OFF command with no parameters, the EDCT AC OFF Prompts dialog box opens.

Enter a three- or four-character airport designator, an FCA name, or ALL.
The **EDCT AC ON** semicolon command turns Adaptive Compression on for a Ground Delay Program (GDP) or Airspace Flow Program (AFP) associated with the specified airport or FCA, or all airports and FCAs. Adaptive Compression can be turned off using the **EDCT AC OFF** command. This command is similar to **EDCT SCS ON**, which turns Slot Credit Substitution on. Only users at authorized sites can use this command.

### Command Line Interface

Press `;` and enter your command using the following syntax:

![Command Line Interface](image)

**Note:** You can also enter the name of an airport or **ALL**.

For example:  
- **EDCT AC ON JFK**  
- **EDCT AC ON ALL**

Press `<Enter>`.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
</table>
| 1. Pull down the Tools menu by clicking **Tools** on the main menu or pressing `<Alt>` **T**.  
2. Click **EDCT Commands** or press **E**.  
3. Click **EDCT AC ON**. | None |
Adaptive Compression

Adaptive Compression is intended to avoid slots being wasted by moving flights up to fill vacant slots. Its purpose is to increase the efficiency of an EDCT program and to eliminate needless delay. When a ground delay program is issued, each arrival slot is assigned to a flight. Sometimes, however, it will turn out that no flight uses a slot, which is thus wasted. This might happen if a flight is cancelled and another flight is not substituted for it. It might also happen if a flight has a mechanical delay and misses its slot. The Adaptive Compression feature will watch for slots that are in danger of being wasted and will move flights up to fill those slots.

In the Command Line dialog box, if you enter the EDCT AC ON command with no parameters, the EDCT AC ON Prompts dialog box opens.

Enter a three- or four-character airport designator, an FCA name, or ALL.
EDCT Check

The **EDCT Check** command displays the current status of a single flight controlled by an EDCT program. When you issue this command, you get a one-line response showing the controlled departure time and whether the TFMS has issued a Controlled Time (CT) message to implement the control for this flight.

Command Line Interface

Press `;` and enter your command using the following syntax:

Note: You can also enter the command as **EDC CHE**.

For example: **EDC CHE UAL335 BOS ORD**
Press `<Enter>`.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
</table>
| 1. Pull down the Tools menu by clicking **Tools** on the main menu or pressing `<Alt> T`.  
2. Click **EDCT Commands** or press **E**.  
3. Click **EDCT Check** on the sub-menu or press **K**. | None |

EDCT Prompts Dialog Box

If you enter the command with no parameters, the EDCT Check Prompts dialog box opens.
You may also enter the complete command on one line. Be sure to include a space between items. For each item in the dialog box or entered on the command line, enter a value as described in the following table.

### EDCT Check

<table>
<thead>
<tr>
<th>Item</th>
<th>What you do</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aircraft ID</td>
<td>Enter the alphanumeric designator specifying the identification number of the desired flight.</td>
<td>UAL457</td>
</tr>
<tr>
<td>Origin Airport</td>
<td>Enter the three– or four–letter designator specifying the origination point of the flight.</td>
<td>ORD</td>
</tr>
<tr>
<td>Destination Airport</td>
<td>Enter the three– or four–letter designator specifying the airport where the flight is to land.</td>
<td>JFK</td>
</tr>
</tbody>
</table>

### Reading the Reply

After you enter the information in the EDCT Check Prompts dialog box, a reply like the following is displayed.

- **Aircraft ID** Aircraft identifier for each flight.
- **ASLOT** Arrival slot currently assigned to the flight. Includes the arrival airport and slot time in six-digit format.
- **DEP** Departure airport
- **CTD** Controlled Time of Departure. In six-digit format.
- **CTA** Controlled Time of Arrival. In six-digit format.
- **TYPE** Type of control last applied to this flight. Types include GDP, GS, SUB, UPD, FA, COMP, BLKT.
- **EX** Exempt flag. Indicates whether the flight was considered exempt when the last controls were computed by FSM. Values are Y or N.
- **CX** Cancel flag. Values are Y or N.
- **SH** Slot Hold flag. For cancelled flights it indicates whether the airline will hold that slot in the next compression or revision. Values are Y or N.
- **ERTA** Earliest Runway Time of Arrival. This is the earliest CTA that the airline would accept for the flight. In six-digit format.
- **IGTD** Initial Gate Time of Departure. This is the departure time when the flight was first created. It is used to positively identify a flight leg. In six-digit format.
• **CT sent**  Indicates whether a CT message has been sent to the departure center in order to implement the controlled departure time for this flight.

• **CT time sent/pending**  Indicates CT time that has been sent and shows if another CT time is pending. If no CT has been sent and no CT is pending, the field will show None Sent/None Pending. If CT time has been sent, the first field will show a time rather than None (for example, 0130Sent). If a CT time is pending, it will show a time rather than None (for example, 0215Pending).

### Related Commands
The following commands provide additional information about controlled flights and airports: **EDCT CNX, EDCT CTALIST, EDCT LIST, EDCT LOG, EDCT SHOW, EDCT SLIST, and EDCT SLOTS.** The **EDCT SUB SHOW** command displays the status of Substitution processing. The **EDCT SCS OFF** command suspends slot credit substituting and **EDCT SCS ON** command allows slot credit substituting. In addition, traffic management specialists can hold or release slots with **EDCT HOLD** or **EDCT RELEASE**, suspend or activate SI messages with **EDCT SUB OFF** or **EDCT SUB ON**, select a printer with **EDCT SUB PRINT**, update controlled departure and arrival times for a single controlled flight with **EDCT UPDATE**, or purge controlled flights with **EDCT PURGE**. Some of these commands are available on a restricted basis. See the command summary for restrictions.
EDCT CNX

The EDCT CNX command creates a report listing all flights cancelled in EDCT programs for a selected airport or FCA. If you specify an airline, the list will include only those cancelled flights for an airport or FCA for that selected airline. If you select an airline, the list will include only those cancelled flights for an airport or FCA for that selected airline.

Command Line Interface

Press ; and enter your command using the following syntax:

```
EDCT CNX airport OR FCA name and Optional airline
```

Note: You can also enter the command as EDC CNX.

For example:

- EDCT CNX SFO
- EDCT CNX SFO UAL
- EDCT CNX FCA002

Press <Enter>.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
</table>
| 1. Pull down the Tools menu by clicking Tools on the main menu or pressing <Alt> T.  
2. Click EDCT Commands or press E.  
3. Click EDCT CNX on the sub-menu or press X. | None |
EDCT CNX Prompts Dialog Box

If you enter the command with no parameters, the EDCT CNX Prompts dialog box opens.

![EDCT CNX Prompts Dialog Box]

Enter a three- or four-character airport designator or an FCA name. Optionally, you can enter the airport designator or FCA name and an airline. Be sure to include a space between each item.

Displaying the Report

Immediately after you issue the command, you receive a confirmation message indicating your request has been sent. At this time you may continue to use other TSD functions.

Confirmation Message

After a short time, the program emits a beep and shows a dialog box.
Click **Display** in the dialog box to see the report.

![EDCT CNX report dialog box]

**Reading the Report**

The EDCT CNX report displays the report name at the top. The body of the report lists all cancelled flights for a specified airport or FCA or cancelled flights for one airline for the airport or FCA.

After you have read the report, you can send it to your printer by clicking **Print**. A dialog box opens asking you to confirm or enter the print command and number of copies desired.

**Related Commands**

For a list of related commands see the EDCT Check command. See the command summary for restrictions.
The **EDCT CTALIST** command creates a report listing all controlled and cancelled flights for an airport or an FCA, as well as open slots. If you specify an airline, the list will include only those controlled and cancelled flights for an airport or FCA for that selected airline.

### Command Line Interface

Press `;` and enter your command using the following syntax:

![Command Line Interface](image)

**Note:** You can also enter the command as **EDC CTA**.

For example:

- **EDCT CTALIST SFO**
- **EDC CTA SFO UAL**
- **EDC CTA FCA002**

Press `<Enter>`.  

### Menu Method  |  Quick Key Method

| 1. Pull down the Tools menu by clicking **Tools** on the main menu or pressing `<Alt> T`. |
| 2. Click **EDCT Commands** or press **E**. |
| 3. Click **EDCT CTALIST** command on the sub-menu or press **A**. |

| None |

---

**EDCT CTALIST**

**VNTSC-TFM-RM-010 TSD Semicolon Commands**

**TFMS Reference Manual, TSD Version 8.9**

**Document Version 24**

**5-38**
EDCT CTALIST Prompts Dialog Box

If you enter the command with no parameters, the EDCT CTALIST Prompts dialog box opens.

![EDCT CTALIST Prompts Dialog Box]

Enter a three- or four-character airport designator or an FCA name. Optionally, you can enter the airport designator or FCA name and an airline. Be sure to include a space between each item.

Displaying the Report

Immediately after you issue the command, you receive a confirmation message indicating your request has been sent. At this time you may continue to use other TSD functions.

Confirmation Message

After a short time, the program emits a beep and shows a dialog box.

![Confirmation Message Dialog Box]
Click **Display** to see the report.

![EDCT CTALIST report](image)

**Reading the Report**

The EDCT CTALIST report displays the report name at the top. The body of the report lists all controlled and cancelled flights for a specified airport or FCA or for a specified airline for the airport or FCA.

After you have read the report, you can send it to your printer by clicking **Print**. A dialog box opens asking you to confirm or enter the print command and number of copies desired.

**Related Commands**

For a list of related commands see the **EDCT Check** command. See the command summary for restrictions.
EDCT Hold

The EDCT Hold command holds the slots of all flights in a GDP or an AFP, or only the slots of flights belonging to a specified airline and its sub-carriers. Only users at authorized sites can use this command.

Command Line Interface

Press ; and enter your command using the following syntax:

Note: You can also issue the command by entering EDC HOL.

For example:

- EDCT HOLD ALL SLOTS FOR SFO
- EDCT HOLD ALL SLOTS FOR SFO UAL
- EDCT HOLD ALL SLOTS FOR FCA002 UAL

Press <Enter>.

Menu Method

1. Pull down the Tools menu by clicking Tools on the main menu or pressing <Alt> T.
2. Click EDCT Commands or press E.
3. Click EDCT HOLD command on the sub-menu or press D.

Quick Key Method

None

EDCT Hold Prompts Dialog Box

If you enter the command with no parameters, the EDCT Hold Prompts dialog box opens.
Enter a three- or four-character airport designator or an FCA name. Optionally, you can enter the airport designator or FCA name and an airline. Be sure to include a space between items.

**Confirmation Message**

After a short period, you will get a message displaying the number of slots released for the specified airport or FCA or airport or FCA and airline.

**Related Commands**

For a list of related commands see the EDCT Check command. See the command summary for restrictions.
EDCT List

The **EDCT List** command creates a report containing a list of all airports currently controlled by EDCT programs. This command now shows the data from the EDCT Show command.

**Command Line Interface**

Press `;` and enter your command using the following syntax:

```
Command Line
Input Request:
EDCT LIST
```

**Note:** You can also enter the command as **EDC LIS**.

Press `<Enter>`.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
</table>
| 1. Pull down the Tools menu by clicking **Tools** on the main menu or pressing `<Alt>` T.  
2. Click **EDCT Commands** or press E.  
3. Click **EDCT List** from the sub-menu or press L. | None |

**Resulting Dialog Box**

Immediately after you issue the command, you receive a confirmation message indicating your request has been sent. At this time you may continue to use other TSD functions. After a short time, the program emits a beep and shows a dialog box.
Click **Display** to see a report similar to the following.

![Report Example](image)

**Reading the Report**

The EDCT List report displays the report name at the top. The body of the report lists airports that are currently controlled by a ground delay program, and associated data.

The following list describes each column in the report.

- **DEST** Airport for which each EDCT has been issued. An airport may be listed more than once, if more than one EDCT has been issued for that location.

- **TIMES** Time span (in shorthand UTC) that has been affected by delayed arrivals, as determined by the EDCT.

- **CONTROL** Type of control that has been issued. EDCT indicates flights controlled by the EDCT; FA (Fuel Advisory) indicates flights that were issued controls after the EDCT was issued.

- **FLIGHTS** Total number of flights controlled by the EDCT (and FA, if applicable)

- **SUBS** Data from the EDCT Sub Show command, showing you the status of Substitution processing (SI) for all airports.

- **SCS** Allows or does not allow slot credit substituting for flights controlled by EDCT programs at a specified airport or all airports. Only traffic management specialists at the ATCSCC may use this command.
Note:  The EDCT Sub Show command continues working as it currently does.

After you have read the report, you can send it to your printer by clicking Print.

Related Commands

For a list of related commands see the EDCT Check command. See the command summary for restrictions.
EDCT Log

The EDCT Log command creates a report listing all EDCT files, cancellation messages, and SI messages processed by the system in the order they were received. Only users at authorized sites can use this command.

Command Line Interface

Press ; and enter your command using the following syntax:

(* Indicates optional entry)

Note: You can also enter the command as EDC LOG

For example: EDCT LOG 12/16
Press <Enter>.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Tools menu by clicking Tools on the main menu or pressing &lt;Alt&gt; T.</td>
<td>None</td>
</tr>
<tr>
<td>2. Click EDCT Commands or press E.</td>
<td></td>
</tr>
<tr>
<td>3. Click EDCT LOG command on the sub-menu or press G.</td>
<td></td>
</tr>
</tbody>
</table>

EDCT Log Prompts Dialog Box

If you enter the command with no parameters, the EDCT Log Prompts dialog box opens. Enter the date in the format provided in the Date field.

You may also enter the complete command on one line. Be sure to include a space between each item.
Displaying the Report
Immediately after you issue the command, you receive a confirmation message indicating your request has been sent. At this time you may continue to use other TSD functions.

Confirmation Message
After a short time, the program emits a beep and shows a dialog box.

Click **Display** in the dialog box to see the report.

Reading the Report
The report displays a log of all EDCT files, cancellation messages, and SI messages processed by the system. For each EDCT file processed by the system, the report includes a one-line entry with the time and date the file was received, followed by the filename. For each batch of cancellation and/or substitution messages received by the system, the report includes an entry with the date and time the messages were received, followed by a separate entry for each message. Entries are arranged chronologically, and messages shown do not necessarily correspond to the EDCT file immediately preceding them.
Each entry for a cancellation or substitution message includes the following columns of information, displayed from left to right on the report that identifies the following:

- **STATUS**  Flight is canceled, exchanged, or substituted.
- **ACID**  Aircraft identifier of each flight.
- **ORIG**  Origin airport for this flight.
- **CDT**  Controlled departure time for this flight.
- **CTA**  Controlled time of arrival of this flight.
- **DEST**  Destination airport for this flight.

After you have read the report, you can send it to your printer by clicking **Print**. A dialog box opens asking you to confirm or enter the print command and number of copies desired.

**Note:** The report also includes purge control messages, if applicable to any time period for the date specified. This message indicates the time the purge was issued, the airport(s) affected, and the number of flights affected.

**Related Commands**

For a list of related commands see the EDCT Check command. See the command summary for restrictions.
EDCT Purge

The **EDCT Purge** command purges EDCT flight controls for a specified airport or FCA or for all airports and FCAs. You can restrict the purge to include only controls before or after a specified time. After using this command, the controls you purge are no longer in effect, and do not show up in EDCT List or EDCT Show reports (EDCT Summary reports include a record of any purged controls). Only users at authorized sites can use this command.

### Command Line Interface

Press ; and enter your command using the following syntax:

![Command Line Interface](image)

**Note:** You can also enter the command as **EDC PUR**.

For example:
- **EDCT PURGE MEM B0800**
- Or **EDC PUR FCA002**
- Or **EDCT PURGE ALL PROGRAMS 1400 B**

Press <Enter>.

### Menu Method

1. Pull down the Tools menu by clicking **Tools** on the main menu or pressing <Alt> T.
2. Click **EDCT Commands** or press E.
3. Click **EDCT PURGE** command on the sub-menu or press P.

### Quick Key Method

None
EDCT Purge Prompts Dialog Box

If you enter the command with no parameters, the EDCT Purge Prompts dialog box opens.

![EDCT Purge Prompts Dialog Box]

For each item in the dialog box or entered on the command line, enter a value as described in the table below. Be sure to include a space between items.

<table>
<thead>
<tr>
<th>Item</th>
<th>What you do</th>
<th>Example</th>
</tr>
</thead>
</table>
| Enter airport name, FCA name, or ALL PROGRAMS | Enter the FAA airport designator, FCA name, or enter the words ALL PROGRAMS. | BOS
FCA001
ALL PROGRAMS |
| Time | Enter the four-digit UTC. | 1300 |
| Purge controls (B) or (A) specified time. | Enter B for Before, or A for After. | B |

Confirmation Message

Immediately after you issue the command, you receive a confirmation message indicating your request has been sent.

When the TSD receives a response from the EDCT, you see a message like the one shown below:

![Confirmation Message]

Related Commands

For a list of related commands see the EDCT Check command. See the command summary for restrictions.
The **EDCT Release** command releases all slots in a GDP or AFP or only the slots of flights belonging to a specified airline and its sub-carriers. Only users at authorized sites can use this command.

### Command Line Interface

Press `;` and enter your command using the following syntax:

```
Note: You can also enter the command as EDC REL.
```

For example:

```
EDCT RELEASE ALL SLOTS FOR SFO
Or EDC REL ALL SLOTS FOR SFO UAL
Or EDC REL ALL SLOTS FOR FCA002
```

Press `<Enter>`.

### Menu Method

1. Pull down the Tools menu by clicking **Tools** on the main menu or pressing `<Alt> T`.
2. Click **EDCT Commands** or press **E**.
3. Click **EDCT RELEASE** command on the sub-menu or press **R**.

### Quick Key Method

None

### EDCT Release Prompts Dialog Box

If you enter the command with no parameters, the EDCT Release Prompts dialog box opens.
Enter the three- or four-character airport designator alone or the airport designator or FCA name and an airline. Be sure to include a space between each item.

**Confirmation Message**

After a short period, you will get a message displaying the number of slots released for the specified airport or FCA or airport or FCA and airline.

**Related Commands**

For a list of related commands see the EDCT Check command. See the command summary for restrictions.
EDCT SCS OFF

The **EDCT SCS OFF** command suspends SCS for flights controlled by EDCT programs at a specified airport or FCA, or for all airports and FCAs. To allow slot credit processing after using this command, you must activate processing with the **EDCT SCS ON** command. Only users at authorized sites can use this command.

### Command Line Interface

Press `;` and enter your command using the following syntax:

For example:

- EDCT SCS OFF ORD
- EDCT SCS OFF FCA002
- EDCT SCS OFF ALL

Press `<Enter>`.

### Menu Method

1. Pull down the Tools menu by clicking **Tools** on the main menu or pressing `<Alt> T`.
2. Click **EDCT Commands** or press **E**.
3. Click **EDCT SCS OFF** command on the sub-menu or press **F**.

### Quick Key Method

None

### EDCT SCS Off Prompts Dialog Box

Selecting **EDCT SCS OFF** from the EDCT sub-menu or entering the semicolon command with no parameters opens the following dialog box.
When you enter the airport name, FCA name, or **ALL** and click **OK** or **Apply**, the following message is returned. Click **Yes** to confirm.
EDCT SCS ON

The **EDCT SCS ON** command allows SCS for flights controlled by EDCT programs at a specified airport or FCA, or all airports and FCAs. SCS processing can be turned off using the **EDCT SCS OFF** command. Only users at authorized sites can use this command.

Command Line Interface

Press `;` and enter your command using the following syntax:

![Command Line Interface](image)

For example:

- **EDCT SCS ON ALL**
- Or **EDCT SCS ON ORD**
- Or **EDCT SCS ON FCA002**

Press `<Enter>`.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
</table>
| 1. Pull down the Tools menu by clicking **Tools** on the main menu or pressing `<Alt> T`.  
2. Click **EDCT Commands** or press **E**.  
3. Click **EDCT SCS ON** command on the sub-menu or press **C**. | None |

EDCT SCS On Prompts Dialog Box

Selecting **EDCT SCS ON** from the EDCT sub-menu or entering the semicolon command with no parameters opens the following dialog box.

![EDCT SCS On Prompts Dialog Box](image)

Enter an airport name, FCA name or ALL. Click **OK** or **Apply**.
EDCT Show

The **EDCT Show** command creates a report containing detailed information on all flights controlled by EDCT programs for a specified airport, for an FCA or for all airports and FCAs.

Command Line Interface

Press `;` and enter your command using the following syntax:

![Command Line Interface](image)

**Note:** You can also enter the command as **EDC SHO**.

For example:

- **EDCT SHOW JFK**
- **EDT SHO FCA002**
- **EDT SHO ALL**

Press `<Enter>`.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Tools menu by clicking <strong>Tools</strong> on the main menu or pressing <code>&lt;Alt&gt; T</code>.</td>
<td></td>
</tr>
<tr>
<td>2. Click <strong>EDCT Commands</strong> or press <strong>E</strong>.</td>
<td></td>
</tr>
<tr>
<td>3. Click <strong>EDCT SHOW</strong> command on the sub-menu or press <strong>H</strong>.</td>
<td>None</td>
</tr>
</tbody>
</table>

EDCT Show Prompts Dialog Box

If you enter the command with no parameters, the EDCT Show Prompts dialog box opens.

![EDCT SHOW PROMPTS](image)

Enter an airport name, FCA name or ALL. Click **OK** or **Apply**. Be sure to include a space between each item.
Displaying the Report

Immediately after you issue the command, you receive a confirmation message indicating your request has been sent. At this time you may continue to use other TSD functions. After a short time, the program emits a beep and shows a dialog box similar to the following one.

Click **Display** to see the report. You may enlarge the display window with the window handles if desired.

Reading the Report

The EDCT Show report displays a list of all flights controlled by a ground delay program at the airport you specified or a list of all flights controlled by an airspace flow program on the FCA specified. The report reflects the current status of these flights (after any substitutions have been made).
The header identifies the specified airport and the time that the latest ground delay program was generated or received by the TFMS. The information is arranged in three sections, reading from top to bottom: currently controlled flights, previously controlled flights that were cancelled (if applicable) and previously controlled flights whose controls were purged (if applicable). The following is a description of the data columns:

- **ACID** Aircraft identifier
- **DEP** Departure airport for this flight.
- **CDT** Controlled departure time for this flight. Displayed in six-digit format.
- **CTA** Controlled time of arrival of this flight. Displayed in six-digit format.
- **CT SENT?** Indicates whether a CT message has been sent to the departure center in order to implement the controlled departure time for this flight. Values are Y or N.
- **CTR** Departure center (ARTCC) for this flight.
- **CTL_TYPE** Type of control last applied to this flight. Types include GDP, GS, SUB, UPD, FA, COMP, BLKT.
- **SRC** Indicates whether the flight is FA-controlled. Values are Y (FA controlled) or N (Not FA controlled).
- **EXEMPT?** Exempt flag. Indicates whether the flight was considered exempt when the last controls were computed by FSM. Values are Y or N.
- **CNX** Cancel flag. Values are Y or N.
- **SL_HELD** Slot Hold flag. For cancelled flights it indicates whether the airline will hold that slot in the next compression or revision. Values are Y or N.
- **ORIG_CDT** For CDTs received from SI messages, identifies the original controlled departure time for this flight. Displayed in six-digit format.
- **ORIG_CTA** Indicates the original Controlled Time of Arrival. Displayed in six-digit format.

After you have read the report, you can send it to your printer by clicking **Print**. A dialog box opens asking you to confirm or enter the filename and number of copies desired.
ALL Option

To see a report on all controlled flights for the current day, enter the word ALL on the command line instead of a single airport name. The report reflects the current status of flights that were controlled that day. The report generated by EDCT Show All has two additional columns of information:

- **GOT DZ?**
  Identifies which flights became active and which TFMS received a departure message.

- **CANCEL**
  Identifies flights that have received a cancellation message.

Related Commands

For a list of related commands see the EDCT Check command. See the command summary for restrictions.
The **EDCT Slist** command provides a slot list for a specified airport or an FCA. If you specify an airline, the list will include only those slots for the airline and its sub-carriers at a specified airport or FCA in the exact format that goes to the airlines.

### Command Line Interface

Press `;` and enter your command using the following syntax:

![Command Line Interface](image)

**Note:** You can also enter the command as **EDC SLI**.

For example:  
**EDCT SLIST SFO UAL**  
Or  
**EDC SLI FCA002**  
Press `<Enter>`.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
</table>
| 1. Pull down the Tools menu by clicking **Tools** on the main menu or pressing `<Alt>` T.  
2. Click **EDCT Commands** or press E.  
3. Click **EDCT SLIST** command on the sub-menu or press S. | None |

**EDCT SLList Prompts Dialog Box**

If you enter the command with no parameters, the EDCT Slist Prompts dialog box opens.
Enter the three- or four-character airport designator or an FCA name. Optionally, you can enter the airport designator or FCA name and the airline. Be sure to include a space between each item.

**Displaying the Report**

Immediately after you issue the command, you receive a confirmation message indicating your request has been sent. At this time you may continue to use other TSD functions.

**Confirmation Message**

After a short time, the program emits a beep and shows a dialog box.

Click **Display** in the dialog box to see the report.

![Image of report dialog box]
Reading the Report

The EDCT Slist report displays the report name at the top. The body of the report lists the slots for the specified airport or FCA or for the airport or FCA and airline.

- **ACID** Aircraft identifier for each flight.
- **ASLOT** Arrival slot currently assigned to the flight.
- **DEP** Departure airport.
- **CTD** Controlled Time of Departure.
- **CTA** Controlled Time of Arrival.
- **TYPE** Type of control last applied to this flight (GDP, GS, SUB, UPD, FA, COMP, BLKT).
- **EX** Exempt flag. Indicates whether the flight was considered exempt when the last controls were computed by FSM.
- **CX** Cancel flag.
- **SH** Slot Hold flag. For cancelled flights it indicates whether the airline will hold that slot in the next compression or revision.
- **ERTA** Earliest Runway Time of Arrival. This is the earliest CTA that the airline would accept for the flight.
- **IGTD** Initial Gate Time of Departure. This is the departure time when the flight was first created. It is used to positively identify a flight leg.

**Note:** The Time fields in the CTD, CTA, ERTA, and IGTD columns are expressed as six digits: *ddhhmm* (day, hour, minute.)

After you have read the report, you can send it to your printer by clicking **Print**. A dialog box opens asking you to confirm or enter the print command and number of copies desired.

**Related Commands**

For a list of related commands see the **EDCT Check** command. See the command summary for restrictions.
EDCT Slots

The **EDCT Slots** command creates a report listing all open slots for airlines at specified airports or within FCAs.

### Command Line Interface

Press `;` and enter your command using the following syntax:

![Command Line Interface Image]

**Note:** You can also enter the command as **EDC SLO**.

For example:

- **EDCT SLOTS EWR UAL**
- Or **EDC SLO FCA002**

Press `<Enter>`.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
</table>
| 1. Pull down the Tools menu by clicking **Tools** on the main menu or pressing `<Alt> T`.  
2. Click **EDCT Commands** or press E.  
3. Click **EDCT SLOTS** command on the sub-menu or press T. | None |

### EDCT SLOTS Prompts Dialog Box

If you enter the command with no parameters, the EDCT Slots Prompts dialog box opens.

![EDCT Slots Prompts Dialog Box Image]
Enter the three- or four-character airport designator or an FCA name. Optionally, you can enter the airport designator or FCA name and the airline. Be sure to include a space between each item.

**Displaying the Report**

Immediately after you issue the command, you receive a confirmation message indicating your request has been sent. At this time you may continue to use other TSD functions. After a short time, a dialog box opens that allows you to Display or Print the report. You can also click **Close** to close the dialog box.

Click **Display** to see the report.

**Reading the Report**

The EDCT Slots report displays the report name at the top. The body of the report lists all open slots for a specified airport and/or airline.

After you have read the report, you can send it to your printer by clicking **Print**. A dialog box opens asking you to confirm or enter the filename and number of copies desired.

**Related Commands**

For a list of related commands see the **EDCT Check** command. See the command summary for restrictions.
EDCT SUB OFF

The **EDCT Sub Off** command suspends SI at a specified airport, for a specified FCA or for all airports and FCAs. Only users at authorized sites can use this command.

**Command Line Interface**

Press `` and enter your command using the following syntax:

```
EDCT SUB OFF [airport OR FCA name OR ALL]
```

**Note:** You can also enter the command as **EDC SUB OFF**.

For example:

- **EDCT SUB OFF DFW**
- **Or EDC SUB OFF ALL**
- **Or EDC SUB OFF FCA002**

Press `<Enter>`.

**Menu Method**

1. Pull down the Tools menu by clicking **Tools** on the main menu or pressing `<Alt> T`.
2. Click **EDCT Commands** or press **E**.
3. Click **EDCT SUB OFF** command on the sub-menu or press **U**.

**Quick Key Method**

None

**EDCT Sub Off Prompts Dialog Box**

If you enter the command with no parameters, the EDCT Sub Off Prompts dialog box opens.

Enter an airport name, FCA name or **ALL**. Click **OK** or **Apply**.
Confirmation Message

Immediately after you issue the command, you receive a confirmation message indicating your request has been sent.

If Substitution processing has already been suspended for the airport or FCA you specify (or all airports), the EDCT Sub Off command has no effect, and you get a message indicating that Substitution processing has already been suspended for your selection. This message disappears after a few seconds.

Related Commands

For a list of related commands see the EDCT Check command. See the command summary for restrictions.
EDCT SUB ON

The **EDCT Sub On** command allows SI at a specified airport, for an FCA, or for all airports and FCAs where Substitution processing was previously suspended. Only users at authorized sites can use this command.

**Command Line Interface**

Press `;` and enter your command using the following syntax:

```
EDCT SUB ON airport OR FCA name OR ALL
```

**Note:** You can also enter the command as **EDC SUB ON**.

For example:  
- **EDCT SUB ON DFW**  
- **EDC SUB ON FCA002**  
- **EDC SUB ON ALL**

Press `<Enter>`.

**Menu Method**

1. Pull down the Tools menu by clicking **Tools** on the main menu or pressing `<Alt> T`.
2. Click **EDCT Commands** or press **E**.
3. Click **EDCT SUB ON** command on the sub-menu or press **N**.

**Quick Key Method**

None

**EDCT Sub On Prompts Dialog Box**

If you enter the command with no parameters, the EDCT Sub On Prompts dialog box opens.

Enter an airport name, FCA name, or **ALL**. Click **OK** or **Apply**.
Confirmation Message
Immediately after you issue the command, you receive a confirmation message indicating that your request has been sent.

Related Commands
For a list of related commands see the EDCT Check command. See the command summary for restrictions.

Note: If Substitution processing is already on for the airport or FCA you specify (or all airports), the EDCT Sub On command has no effect, and you get a message indicating that Substitution processing is already on for your selection.
The **EDCT Sub Print** command allows the selection of a printer at the ATCSCC to print ATCSCC’s copy of replies to SI messages. Only users at authorized sites can use this command.

### Command Line Interface

Press `;` and enter your command using the following syntax:

```
Note: You can also enter the command as EDC SUB PRI.

For example:  
EDC SUB PRI $tsd./wstn15  
Or EDC SUB PRI OFF (To turn off the printer)
```

Press `<Enter>`.

### Menu Method

1. Pull down the Tools menu by clicking **Tools** on the main menu or pressing `<Alt> T`.
2. Click **EDCT Commands** or press **E**.
3. Click **EDCT SUB PRINT** command on the sub-menu or press **B**.

### Quick Key Method

None

### Confirmation Message

Immediately after you issue the command, you receive a confirmation message indicating your request has been sent.

### Related Commands

For a list of related commands see the **EDCT Check** command. See the command summary for restrictions.
EDCT Sub Show

The **EDCT Sub Show** command generates a report showing you the status of SI messages for all airports. Only users at authorized sites can use this command.

Command Line Interface

Press `;` and enter your command using the following syntax:

![Command Line Interface](image)

**Note:** You can also enter the command as **EDC SUB SHO**.

Press `<Enter>`.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Tools menu by clicking <strong>Tools</strong> on the main menu or pressing <code>&lt;Alt&gt;T</code>.</td>
<td></td>
</tr>
<tr>
<td>2. Click <strong>EDCT Commands</strong> or press <strong>E</strong>.</td>
<td></td>
</tr>
<tr>
<td>3. Click <strong>EDCT SUB SHOW</strong> command on the sub-menu or press <strong>W</strong>.</td>
<td>None</td>
</tr>
</tbody>
</table>

**Displaying the Report**

Immediately after you issue the command, you receive a confirmation message indicating your request has been sent. At this time you may continue to use other TSD functions.
Click **Display** to see the report.

![Report Display](image)

**Reading the Report**

The report name appears at the top of the display. A header indicates if processing is available for all airports, suspended for all airports, or suspended for some airports. If all airports are affected, you see only the header. If processing is suspended for some airports, the airports are listed below in the body of the report. The last line of the report identifies the address of the printer at the ATCSCC to which a copy of the SI message replies are sent.

After you have read the report, you can send it to your printer by clicking **Print**. A dialog box opens asking you to confirm or enter the filename and number of copies desired.

**Related Commands**

For a list of related commands see the **EDCT Check** command. See the command summary for restrictions.
EDCT Unassigned Slots

The **EDCT Unassigned Slots** command creates a report listing all unassigned slots for a specified airport or FCA.

### Command Line Interface

Press `;` and enter your command using the following syntax:

```
EDCT UNASSIGNED SLOTS airport OR FCA name
```

For example:

- **EDCT UNASSIGNED SLOTS DEN**
- **EDCT UNASSIGNED SLOTS FCA002**

Press `<Enter>`.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
</table>
| 1. Pull down the Tools menu by clicking **Tools** on the main menu or pressing `<Alt> T`.
  2. Click **EDCT Commands** or press **E**.
  3. Click **EDCT UNASSIGNED SLOTS** command on the sub-menu or press **O**. | None |

### EDCT Unassigned Slots Prompts Dialog Box

If you enter the command with no parameters, the EDCT Unassigned Slots Prompts dialog box opens.

Enter the airport or FCA name at the prompt and click **OK** or **Apply**.
Unassigned Slots List Report
A sample Unassigned Slots List report is shown below.

![Unassigned Slots List Report](image)

**Reading the Report**

The EDCT UNASSIGNED SLOTS report displays the report name at the top. The body of the report lists all unassigned slots for a specified airport or FCA.

After you have read the report, you can send it to your printer by clicking Print. A dialog box opens asking you to confirm or enter the print command and number of copies desired.
The **EDCT Update** command updates a controlled flight with new departure and arrival times. Only users at authorized sites can use this command.

### Command Line Interface

Press ; and enter your command using the following syntax:

```
Note: You can also enter the command as EDC UPD.
* Indicates optional entries.
For example:
EDC UPD LOF343 MWA STL 101405 CTD:101430 CTA: 101625 CX: Y SH: N ERTA: 101610
Press <Enter>.
```

### Menu Method

1. Pull down the Tools menu by clicking **Tools** on the main menu or pressing <Alt> T.
2. Click **EDCT Commands** or press E.
3. Click **EDCT UPDATE** command on the sub-menu or press E.

### Quick Key Method

None
EDCT UPDATE Dialog Box

If you enter the command with no parameters, the EDCT Updates dialog box opens.

You may also enter the complete command on one line. Be sure to include a space between each item. For each item in the dialog box or entered on the command line, enter a value as described in the following table.

<table>
<thead>
<tr>
<th>Item</th>
<th>What you do</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aircraft ID</td>
<td>Enter the alphanumeric designator specifying the identification number of the desired flight.</td>
<td>LOF343</td>
</tr>
<tr>
<td>Departure Airport</td>
<td>Enter the three or four-letter designator specifying the origination point of the flight.</td>
<td>MWA</td>
</tr>
<tr>
<td>Arrival Airport</td>
<td>Enter the three or four-letter designator specifying the airport where the flight is to land.</td>
<td>STL</td>
</tr>
<tr>
<td>IGTD</td>
<td>Enter the six-number time value for the Initial Gate Time of Departure. The format is ddhhmm. This is the departure time when the flight was first created. It is used to positively identify a flight leg.</td>
<td>101405</td>
</tr>
<tr>
<td>CTD</td>
<td>Enter the item name, followed by a colon and the six-digit time value for the Controlled Time of Departure. The format is ddhhmm. Optional entry.</td>
<td>CTD:101430</td>
</tr>
<tr>
<td>CTA</td>
<td>Enter the item name, followed by a colon and the six-digit time value for the Controlled Time of Arrival. The format is ddhhmm. Optional entry.</td>
<td>CTA:101625</td>
</tr>
</tbody>
</table>
Immediately after you issue the command, you receive a confirmation message indicating your request has been sent. If the system cannot find the flight or if it is not controlled, you will see a diagnostic message. Check the flight information and reissue the command.

**Related Commands**

For a list of related commands see the **EDCT Check** command. See the command summary for restrictions.
The **Examine** command displays a Timeline dialog box, which provides specific information about traffic demands on a particular airport, fix, or sector. Within the dialog box, 15-minute intervals appear in various colors that represent the alert status of the interval.

### Command Line Interface

Press `;` and enter your command using the following syntax:

```
EXAMINE or E element type subtype
```

For example:

- `EXAMINE BOS A`
- `E LOGEN L`
- `E ZDV31`

Press `<Enter>`.

### Menu Method

1. Pull down the Alerts Menu by clicking **Alerts** on the main menu or pressing `<Alt> A`.
2. Click **Examine Alerts** or press **E**.

### Quick Key Method

None

### Examine Alert Dialog Box

If you enter the command with no parameters, the Examine Alert dialog box opens.

You may also enter the complete command on one line. Be sure to include a space between each item. Enter the Place field with the name of an airport, fix, or sector to be
examine and click the appropriate Type button. If the location is a fix, also click its Subtype designator. Fix subtypes are (L)ow, (H)igh, and (S)uperhigh. A or D limits the airport traffic demand information to Arrivals only or Departures only.

About the Time Bar

The display below shows a sample NAS Monitor dialog box that opens after issuing the Examine command for sector ZDC72. For more information, see the Examine Alerts command in Chapter 4.

Changes to the time bar

The time bar is color-coded, as indicated in the table that follows. These colors cannot be changed.

<table>
<thead>
<tr>
<th>Color of time bar segment</th>
<th>What it represents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>No alerts</td>
</tr>
<tr>
<td>Yellow</td>
<td>Alert for proposed flights</td>
</tr>
<tr>
<td>Red</td>
<td>Alert for active flights</td>
</tr>
<tr>
<td>Green with yellow stripe</td>
<td>Previous alert for proposed flights - alert resolved by a Traffic Management Unit (TMU)*</td>
</tr>
<tr>
<td>Green with red stripe</td>
<td>Previous alert for active flights - alert resolved by a TMU*</td>
</tr>
<tr>
<td>Uncolored</td>
<td>No data available, or data is being requested</td>
</tr>
</tbody>
</table>

*See the Turn Green command in Chapter 4 for additional information.
Examine

Examining Non–Alerted Elements
When you examine a non-alerted element, that element appears in magenta. It remains magenta until it is no longer being examined, or it becomes alerted as a result of a Monitor Alert update. All segments on the time bar appear green, because no alerts are on for this element.

Related Commands
You can receive three other types of supplementary information after examining an element. First, you can use the Show Bar Chart command to display a bar chart illustrating the element's traffic demands for each interval in the timeline. You can use the Show Examined Flights command to display the projected flight data for that element during the time intervals you have chosen. Additionally, you can use the Alerts Report command to request a report that lists the projected flight data for that element during the time intervals you have chosen.
The **FPSD (Flight Plan Schedule Database)** command is used to add a flight to the TFMS airline schedule database, or to edit a flight plan that already exists in the database. The added flight data can be seen in TFMS reports generated through the Request commands. To undo the effects of this command, use either the CXSD command to cancel the flight or the INHB command to inhibit the flight.

### Command Line Interface

Press `;` and enter your command using the following syntax:

```
[*Indicates optional entry. However, these are highly recommended, if you are adding a flight for one day only.]
```

For example:  

```
FPSD AAL320 ATL 0825 JFK B727 OXXXXXO 0525 0601
```

Press `<Enter>`.

### Menu Method

1. Pull down the Tools menu by clicking **Tools** on the main menu or pressing `<Alt>` **T**.
2. Click **Database Commands** or press **D**.
3. Click **FPSD** on the sub-menu or press **F**.

### Quick Key Method

None
FPSD Prompts Dialog Box

If you enter the command with no parameters, the FPSD Prompts dialog box opens.

You may also enter the complete command on one line. Be sure to include a space between items. For each item in the dialog box or entered on the command line, enter a value as described in the table below.

<table>
<thead>
<tr>
<th>Item</th>
<th>Purpose</th>
<th>What you do</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flight ID</td>
<td>Specifies the flight you want to add or edit.</td>
<td>Enter the airline identifier, followed by the flight number.</td>
<td>AAL320</td>
</tr>
<tr>
<td>Origin</td>
<td>Specifies the airport where the flight is to originate.</td>
<td>Enter the three- or four-character designator for the origin airport.</td>
<td>ATL</td>
</tr>
<tr>
<td>Departure time</td>
<td>Specifies the departure time.</td>
<td>Enter the three- or four-digit UTC when the flight is scheduled to depart.</td>
<td>0825</td>
</tr>
<tr>
<td>Destination</td>
<td>Specifies the destination airport.</td>
<td>Enter the three-character designator for the destination airport.</td>
<td>JFK</td>
</tr>
<tr>
<td>ETE</td>
<td>Specifies the estimated time en route for this flight.</td>
<td>Enter the time in minutes.</td>
<td>125</td>
</tr>
<tr>
<td>Aircraft type</td>
<td>Specifies the aircraft type to be used for this flight.</td>
<td>Enter the three- or four-character identifier for the aircraft type.</td>
<td>B727</td>
</tr>
</tbody>
</table>
**Result of Adding a Flight**

When a flight has been successfully added to the schedule database, you get a confirmation message.

The record for the added flight remains in the database until the entire database is updated with OAG data. The database is updated every week. Flight records can also be added to the database through the batch FPSD (BFPSD) process, which is described in the System Administration Manual.

**Note:** If you did not include any of the optional fields, the flight is scheduled for one day only. If the current time (when you issue the command) is at least one hour before the scheduled departure time, the flight is added for today only. Otherwise it is added for tomorrow only.

**Using the Optional Fields**

If you specified days of operation and a start date, but did not specify a stop date, the flight will remain active in the database until one of four things happens:

- You use FPSD to edit the flight plan and add a stop date.
- You use CXSD to cancel the flight (for one day only).
- You use INHB to inhibit the flight.
- The database is updated.

<table>
<thead>
<tr>
<th>Item</th>
<th>Purpose</th>
<th>What you do</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Days of operation</td>
<td>Specifies the days of the week this flight is to be in operation.</td>
<td>Enter seven characters, each specifying a day of the week, beginning with Sunday. Enter X for each day the flight is to be scheduled; Enter O for each day the flight is not to be scheduled.</td>
<td></td>
</tr>
<tr>
<td>Start date</td>
<td>Specifies the date you want this command to take effect (the date on which this flight is to become scheduled).</td>
<td>Enter the four–digit date code in the format mmdd.</td>
<td>0525</td>
</tr>
<tr>
<td>Stop date</td>
<td>Specifies the date on which you want to end the effect of this command (the last date on which this flight is to be scheduled).</td>
<td>Enter the four–digit date code in the format mmdd.</td>
<td>0601</td>
</tr>
</tbody>
</table>
Unless one of the other conditions described above takes place first, if you specify days of operation, start date, and stop date, the flight remains active until the stop date or until the weekly database update.

Regardless of start date and stop date, all flights in the database, including those added with the FPSD command, are replaced the next time the database is updated with OAG data.

**Editing Current Flight Plans**

To edit an existing flight plan currently in the database, issue the command the same way you would if you were adding the flight. The following rules apply to editing flights:

- You can edit only the departure time, ETE, aircraft type, days of operation, and start and stop dates. Editing any of the other fields (flight number, origin, or destination), creates a new flight instead of editing an existing one.
- In general, you cannot edit more than one field per command. (See exceptions to this rule below.) If you try to do so, the command fails and you get a diagnostic message. For example, if you wanted to edit both the ETE and the aircraft type, you would have to issue the FPSD command twice.
- Along with the field you edit, you must repeat all of the entries in the original command.

Two exceptions to editing one field per command are pairing the departure time and ETE fields, or the start date and stop date fields. Either of these pairs can be edited together in a single command. Any changes you make are reflected in the confirmation message when you issue the command.

**No Confirmation Message**

If you do not receive a confirmation message after issuing the command, you may see one or more diagnostic messages. For more information about diagnostic messages, see Appendix B.

**Verifying the Results**

You can check on the results of FPSD commands by examining a flight list report. You can generate this report with the Request List command.

**Related Commands**

You can use the INHB command to remove a flight from the database for an indefinite period, and use the ACTV command to reactivate it.
The **GAEL** (General Aviation Estimates List) command displays the estimated number of General Aviation (GA) flights arriving at, departing from, or traversing a specified airport, fix, or sector within 15-minute intervals. These numbers can be changed by using the GAES command.

### Command Line Interface

Press `;` and enter your command using the following syntax:

```
GAEL place type subtype
```

For example: **GAEL MIA A**

*If you issue the command using an Airport (A) or Fix (F) type, you must specify subtype data. If you issue the command using a Sector (S) type, you cannot specify subtype data. See the Table under the CAPS command for definitions of place, type, and subtype.

Press `<Enter>`.

### Menu Method

1. Pull down the Tools menu by clicking `Tools` on the main menu or pressing `<Alt> T`.
2. Click `Database Commands` or press `D`.
3. Click `GAEL` on the sub-menu or press `G`.

### Quick Key Method

None
Request GA Dialog Box

If you enter the command with no parameters, the Request GA Estimate dialog box opens.

Enter the **Place** name. Click the **Type** arrow and select **Airport**, **Fix**, or **Sector**. You can also enter all the information on one line.

**Confirmation Message**

Immediately after you issue the command, you receive a confirmation message indicating your request has been sent. After a short time the GA estimates for the requested map item is displayed, looking like the sample below.

**Related Commands**

The **GAES** command allows you to set General Aviation Estimates for traffic. The **CAPL** and **CAPS** commands are used to see and set the capacities for up to 24 hours from the current time.
The **GAES** (General Aviation Estimates Set) command allows a specialist to temporarily change the estimated number of GA flights that arrive and depart during each 15-minute interval from an airport for up to 24 hours from the current time. Although you can also alter the GA estimates for fixes and sectors, only changes to airport estimates have an effect on the flight counts or ARRD reports. Traffic management specialists at the ATCSCC can use GAES to change settings for any location. Other users are limited to elements within their own ARTCC boundaries. Changes made with this command do not affect GA estimates beyond 24 hours in the future.

### Command Line Interface

Press ; and enter your command using the following syntax:

For example:  

```
GAES BOS A D 1200 1500 + 4
```

Or

```
GAES ZBW38 S 1200 1500 + 4
```

*If you issue the command using an Airport (A) or Fix (F) type, you must specify subtype data. If you issue the command using a Sector (S) type, you cannot specify subtype data. See the Table under the CAPS command for definitions of place, type, and subtype.*

Press <Enter>.

### Menu Method

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Pull down the Tools menu by clicking Tools on the main menu or pressing &lt;Alt&gt; T.</td>
</tr>
<tr>
<td>2.</td>
<td>Click Database Commands or press D.</td>
</tr>
<tr>
<td>3.</td>
<td>Click GAES on the sub-menu or press E.</td>
</tr>
</tbody>
</table>

### Quick Key Method

None
Set GA Estimate Dialog Box

If you enter the command with no parameters, the Set GA Estimate dialog box opens.

![Set GA Estimate Dialog Box](image)

You may also enter the complete command on one line. Be sure to include a space between items. For each item in the dialog box or entered on the command line, enter a value as described in the following table.

<table>
<thead>
<tr>
<th>Item</th>
<th>Purpose</th>
<th>What you do</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Place</td>
<td>Specifies the element for which you wish to change capacity or capacities.</td>
<td>Enter the FAA designator for the airport, fix, or sector.</td>
<td>BOS</td>
</tr>
<tr>
<td>Type</td>
<td>Further specifies which element you want.</td>
<td>Click Airport, Fix, or Sector.</td>
<td>A</td>
</tr>
<tr>
<td>Subtype: Airport (Arrivals/Departures)</td>
<td>Specifies whether you want to set the capacity for arrivals or departures at the specified airport.</td>
<td>Click Arrivals or Departures.</td>
<td>A</td>
</tr>
<tr>
<td>Subtype: Fix (Low/High/Superhigh)</td>
<td>Note: Subtype is grayed out for Sector types.</td>
<td>Click Low, High, or Superhigh.</td>
<td>S</td>
</tr>
<tr>
<td>Start time</td>
<td>Specifies the time at which you want the capacity setting to take effect.</td>
<td>Enter four-digit UTC or relative time. (See next page for details.)</td>
<td>2000+2+2~</td>
</tr>
</tbody>
</table>
When you have specified the place, type, and subtype parameters and moved the focus to the Start Time field, the TSD issues a GAEL command to request the current estimates. You may wait for the report to be returned or you may proceed to enter the time and estimate parameters and issue the command without waiting for the report. However, note that the report, when it is received, will reflect the GA estimates in effect before the GAES command was issued.

**Confirmation Message**

Immediately after you issue the command, you receive a confirmation message indicating your request has been sent. At this point you can issue the GAEL command to verify the revised estimate listing. You may have to wait a few minutes before seeing the results of the GAES command.

**Relative Time Periods**

Relative time periods may also be used when issuing this command. See the CAPS command for information.

**Changing Values**

To make permanent changes to the GA estimates, see your System Administrator.

**Related Commands**

The GAEL command allows you to see the General Aviation Estimates you have set with GAES. The CAPL and CAPS commands are used to see and set capacities for up to 24 hours from the current time.
GTP ACID

The GTP ACID command lets you display information about as many as 14 of the most recent departures for a specified flight from a specified airport. An TFMS tool called Delay Advisor provides access to the Ground Time Predictor (GTP), a system that predicts flight departures based on historical data.

Command Line Interface

Press ; and enter your command using the following syntax:

For example:  GTP ACID USA1147 ATL

Press <Enter>.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>None</td>
</tr>
</tbody>
</table>

Confirmation Message

Immediately after you issue the command, you receive a confirmation message indicating your request has been sent. At this time you may continue to use other TSD functions.
Displaying the Report

After a short time, the program emits a beep and displays a dialog box. Click **Display** in the dialog box to see a report similar to the sample.

![GTP ACID Report Example](image)

After you have read the report, you can send it to your printer by clicking **Print**. A dialog box opens asking you to confirm or enter the filename and number of copies desired.

Reading the Report

The GTP ACID command displays an aircraft identifier (ACID) report of the history of the flight. The header echoes the request you entered. The first dashed line (-----) represents the next flight, which has not yet occurred. Subsequent dashed lines indicate a gap in flight dates. If necessary, scroll down to view all of the data.

**Note:** All time values in this report are in Greenwich Mean Time (GMT).

The columns of data for each flight/departing airport pair are as follows:

- **Date**  
  Date on which the flight departed. Entered in the format mmdd.

- **Day**  
  Day of the week on which the flight departed.

- **PGTD**  
  Proposed gate time of departure, the time the aircraft is expected to leave the gate. Expressed in hours and minutes (hhmm).

- **AGTD**  
  The time that the aircraft actually leaves the ground, not to be confused with the actual gate time of departure, as it is defined in the Request List command. Over time, this acronym, which stands for actual gate time of departure, has come to be defined as given here.
• **AGT**  Actual ground time, the difference between the AGTD and the PGTD. Expressed in minutes. Negative AGT values are never displayed, so a 000 value may represent either a true zero or a negative value.

• **EGT**  Estimated Ground Time, predicted by GTP. Expressed in minutes.

• **GTM**  Ground Time Method. The method used for making predictions. This column displays one of the following methods:

  Cat: Category-based prediction. Based on ground time history of a specific airport, time of day, flight duration (enroute time) and day of week combination.

  Ac: Aircraft-based prediction. Based on a weighted average of the historical ground times of the specific flight.

  Ctl: Controlled-flight based. EGT value defaults to 0.

  Def: Default-based prediction, used when Cat, Ac, or Ctl are not appropriate or available.

**Related Commands**

Issue the GTP AIRP (Airport) command to display a summary overview of ground times experienced by flights at specified airports.
The **GTP AIRP** command lets you display a summary overview of ground times experienced by flights at specified airports over a 24-hour period. You can request information for up to 34 airports. An TFMS tool called Delay Advisor provides access to the Ground Time Predictor (GTP), a system that predicts flight departures based on historical data.

### Command Line Interface

Press `;` and enter your command using the following syntax:

For example:  
**GTP AIRP JFK**  
Press `<Enter>`.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>None</td>
</tr>
</tbody>
</table>
Displaying the Report
Immediately after you issue the command, you receive a confirmation message indicating your request has been sent. At this time you may continue to use other TSD functions. After a short time, the program emits a beep and displays a dialog box. Click Display in the dialog box to see a report similar to the sample.

After you have read the report, you can send it to your printer by clicking Print. A dialog box opens asking you to confirm or enter the filename—and number of copies desired.

Reading the Report
The header echoes the request you typed. In the sample AIRP report some estimated ground time values are equal to zero. These values indicate missing data rather than actual values. The AIRP report displays the following information:

- Specified airport: airport from which the flights are departing.
- Departure time periods: departure periods, in hours, totaling a 24-hour day. GTP specifies the range and number of time periods based on the user-selected airport.
- Estimated time enroute: periods of ground time, in minutes. GTP specifies the range and number of ground time periods based on the user-specified airport.
- Estimated ground times: calculated time, in minutes, of ground times experienced by flights within the category formed by the combination of airport, departure times, enroute time, and day of the week. Used as a prediction for ground times of subsequent flights of the same category.

Related Commands
Issue the GTP ACID (Aircraft Identifier) command to display information about departures for a specified flight from a specified airport.
Semicolon Commands: H-P

Help

The Help command displays TSD help.

Command Line Interface

Press ; and enter your command using the following syntax:

Press <Enter>.

Menu Method | Quick Key Method
---|---
Click Help on the main menu bar, or Press <Alt> H or select Help in dialog boxes. | None
INHB

The **INHB** (Inhibit) command inhibits either a specific flight or all flights for a specific airline in the TFMS flight schedule database. In this case, inhibit means to prevent information about the flights from affecting the TFMS alerts or flight reports generated through the Request commands and Alerts command. To undo the effects of the command, use the ACTV command. Users at any site may issue this command.

## Command Line Interface

Press `;` and enter your command using the following syntax:

For example: **INHB UAL123 0608 0615**  
Press `<Enter>`.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
</table>
| 1. Pull down the Tools menu by clicking **Tools** on the main menu or pressing `<Alt>` T.  
2. Click **Database Commands** or press **D**.  
3. Click **INHB** on the sub-menu or press **I**. | None |

## INHB Prompts Dialog Box

When you issue the INHB command with no parameters, or when you issue the INHB command from the menu, a dialog box similar to this one appears.
For each item entered on the command line, enter a value as described in the following table.

**INHB**

<table>
<thead>
<tr>
<th>Item</th>
<th>Purpose</th>
<th>What you do</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flight or airline ID</td>
<td>Specifies either the flight number or the airline that you want to inhibit.</td>
<td>Enter the FAA designator for the flight or airline.</td>
<td>UAL123 or UAL</td>
</tr>
<tr>
<td>Start date (mmdd)</td>
<td>Optional: The date on which you want the command to take effect.</td>
<td>Enter the date in mmdd format.</td>
<td>0104 (January 4)</td>
</tr>
<tr>
<td>Stop date (mmdd)</td>
<td>Optional: The date on which you want the effect of the command to be removed.</td>
<td>Enter the date in mmdd format.</td>
<td>0111 (January 11)</td>
</tr>
</tbody>
</table>

**Confirmation Message**

After issuing the INHB command, you receive a confirmation message that the command has been sent. After a short time, a response message will be received. The message includes the aircraft or airline activated and information about the time or times affected.

**No Confirmation Message**

If you do not receive a confirmation message, you may see one or more diagnostic messages. For a list of diagnostic messages, see Appendix B.

**Related Commands**

Use the FPSD command to add a new flight or edit an existing flight in the schedule database, and use CXSD to cancel a flight.
Jet Stream

The Jet Stream command shows you winds aloft that are moving at a speed of 70 knots or more. This command shows a graphic overlay with three features: wind speed, altitude, and streamlines. By seeing where aircraft may desire to reroute to take advantage of or avoid the jet stream winds, you can anticipate potential traffic problem at a particular element.

Command Line Interface

Press ; and enter your command using the following syntax:

```
Input Request:
WX_MAPS JEST_STREAM ON
```

Turn ON or OFF and press <Enter>

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Weather menu by clicking Weather on the main menu or pressing &lt;Alt&gt; W.</td>
<td>None</td>
</tr>
<tr>
<td>2. Click Select Weather or press S to open the Select Weather dialog box.</td>
<td></td>
</tr>
<tr>
<td>3. In the Other Weather Options section, next to Jet Stream, click On or Off to toggle display of the Jet stream</td>
<td></td>
</tr>
</tbody>
</table>

**Note**: If none of the Jet Stream display options is selected, the Jet Stream On radio button will be disabled (grayed out).

About the Display

After you enter this command, an overlay similar to the following overlay showing the three color-coded jet stream options representing altitude, wind speed, and streamlines appears. This overlay updates each time the TFMS receives a new Jet Stream overlay, about once every three hours. You can turn any or all of the jet stream options off and on and change their colors in the Select Weather dialog box. For details, see the Jet Stream section in Chapter 4.
Jet Stream Options

The Jet Stream options are discussed below.

Altitude

Numbers identify the altitude at which the strongest winds were measured, in hundreds of feet. For example, the number 348 represents an altitude of 34,800 feet.

Speed

Contour lines and numbers identify wind speed in knots. The outermost contour lines define the areas within which winds aloft have been measured at 70 knots or more. Within these areas contour lines define areas of even higher winds, placed at intervals of 20 knots.

Streamlines

The streamlines indicate the direction of the high winds. A general direction of west to east is assumed.

Related Commands

The following commands also display weather overlays: NOWRAD2, Radar Tops, and Lightning. The Show Times command displays the types of weather overlays currently on the TSD. Show Weather enables your selected overlays to be displayed and Hide Weather temporarily hides the weather overlays. Weather Report displays a weather report for an airport you specify.
## Lat/Lon Point

The **Lat/Lon Point** command displays the latitude and longitude coordinates of the geographical location at which the cursor currently points. The values remain until the quick key is pressed to turn them off and the display is refreshed.

### Command Line Interface

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
</table>
| None        | 1. Move the cursor to the point whose coordinates you wish to find.  
2. Press . (period)  
To turn the coordinates off:  
Press D  
This will permanently remove the coordinates from the display. |

None
Lead Lines

The **Lead Lines** command displays dotted lines leading from the noses of the airplane icons to forecast the position of flights over a period of time or a distance that you specify. Even though real flights do not travel in straight lines, the program assures that the flights continue heading in the same direction and at the same speed as when they were last observed.

### Command Line Interface

Press `;` and enter your command using the following syntax:

```
LEAD LINES or LL
```

Press `<Enter>`.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
</table>
| 1. Pull down the Flights menu by clicking **Flights** on the main menu or pressing `<Alt> F`.  
2. Click **Customize** or press **M** to open the Customize Flight Display dialog box. | None |
Customize Flight Display Dialog Box

Once you have issued the Lead Lines command, the Customize Flight Display dialog box opens. The dialog box is divided into three areas: Show, Draw, and History.

![Customize Flight Display Dialog Box]

The following table explains how to use the Customize Flight Display dialog box.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What You Do</th>
<th>Example and Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Blocks</td>
<td>Identifies the flight, the flight’s altitude, the aircraft type, the ground speed, and the time (in minutes) until arrival. This time is based on the TFMS Estimated Time of Arrival.</td>
<td>Click the Data Blocks checkbox. Click OK to display data blocks for all flights on display. To remove the data blocks, click the button to remove and check and click OK.</td>
<td>Leader lines connect each data block with the flight to which it refers.</td>
</tr>
<tr>
<td>Beacon Code</td>
<td>Controls whether the beacon code is shown in the data block.</td>
<td>Click the Beacon Code checkbox to display the beacon code in the third line of the flight data block.</td>
<td>One or more data blocks must be displayed to see the effect of this command.</td>
</tr>
</tbody>
</table>
## Customize Flight Display (Continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What You Do</th>
<th>Example and Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Org/Dest</td>
<td>Displays an additional line of data block information identifying the flight’s origin and destination. When the command is issued, any data blocks currently displayed are appended with an additional line showing the airports of origin and destination for the flight. The Org/Dest and Route options cannot be selected simultaneously.</td>
<td>Click the Org/Dest button, and click <strong>OK</strong> to append the origin/destination information to all data blocks that are currently displayed. To remove the appended lines, click the <strong>Off</strong> button and click <strong>OK</strong>.</td>
<td>One or more data blocks must be displayed to see the effect of this command.</td>
</tr>
<tr>
<td>Route</td>
<td>Adds the textual flight route as part of a standard data block. When the command is issued, any data blocks currently displayed are appended with an additional line showing the flight route.</td>
<td>Click the Route button, and click <strong>OK</strong> to add the flight route text information to the data blocks. To remove the appended line, click the <strong>Off</strong> button and click <strong>OK</strong>.</td>
<td>One or more data blocks must be displayed to see the effect of this command.</td>
</tr>
<tr>
<td><strong>Draw</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Route</td>
<td>Draws the route of every flight that is currently displayed.</td>
<td>Click in the field to display a check. Click <strong>OK</strong> to draw the routes on the display.</td>
<td>Each route looks like a solid line and appears in the same color as the airplane icon and its data block.</td>
</tr>
<tr>
<td>Last TZ</td>
<td>Geographically identified the last reported position of each flight and draws a dotted line from that point to the appropriate flight icon.</td>
<td>Click the button and click <strong>OK</strong>. To remove the dotted line from the display, click Last TZ again. Make sure Show Flights is on.</td>
<td>If no TZ has been received for a flight, the TSD draws nothing for that flight.</td>
</tr>
<tr>
<td>Lead Lines</td>
<td>Displays dotted lines leading from the noses of the airplane icons.</td>
<td>Click <strong>Lead Lines</strong> to expand the dialog box to include the Lead Line Specifications section.</td>
<td>See Lead Line Specifications below.</td>
</tr>
<tr>
<td><strong>History</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Collect History Every</td>
<td>Tells the TSD to begin collecting historical data.</td>
<td>Click to display a check. Click the up or down arrow to set the minutes. To stop collecting history, click <strong>Collect History Every</strong> again.</td>
<td>The default frequency in minutes that the TSD should collect the history is 5. You can increase or decrease this number of minutes.</td>
</tr>
</tbody>
</table>
If you turn on Data Blocks using the Customize command, the Org/Dest or Route selections override those selected in the Select Flights dialog box. However, if you do not turn Data Blocks on using the Customize command, the Select Flights dialog box takes preference.

**Using the Lead Lines Specification Section**

The Lead Lines Specification section of the dialog box lets you specify the lead time in minutes and the lead distance in nautical miles. The default value for Lead Time is five minutes; the default value for Lead Distance is 40 miles. The following procedure illustrates how to change the values in either the lead time in minutes field or the lead distance in nautical miles field.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What You Do</th>
<th>Example and Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draw</td>
<td>Shows the successive positions of a flight at each of the flight’s updates that you established in the Collect History Every field.</td>
<td>Click to display a check. If necessary, issue Show Flights. To remove the drawing from the TSD, click <strong>Draw</strong> again.</td>
<td>The TSD draws a dashed line connecting the flight’s previous locations. The history appears in the same color as the flight icon.</td>
</tr>
</tbody>
</table>

### What To Do

**Change the values**

1. In the Customize Flight Display dialog box, select Lead Lines to activate the Lead Lines Specification portion of the dialog box.

![Lead Lines Specification](image_url)

2. Enter the values for either Lead Time or Lead Distance.
   - To change the Lead Time value, click on the down arrow and on one of the values that appear on the display.
     You can also type the value in the text field to the right of the Lead Time radio button.
   - To change the Lead Distance value, click on the down arrow and on one of the values that appear on the display.
     You can also type the value into the text field.

3. Click **OK** to implement your changes and to close the Customize Flight Display dialog box.
Legend

The **Legend** command allows you to display text at the bottom of a TSD window. This command is typically used to display a legend of colors selected for map elements or flight groups. You may enter up to 256 characters. At the bottom of the TSD window, the legend text is left justified and wraps according to the size of the display. The legend text remains on the display until you reissue the command or quit the TSD. Reissuing the command with no text deletes any previous legend text.

### Command Line Interface

Press `;` and enter your command using the following syntax:

![Command Line Interface](image)

**Note:** To remove the legend from the screen, issue the command again without text and click **OK** in the Legend dialog box.

For example:   
**LEGEND MAGENTA = ARRIVALS CYAN = DEPARTURES**  
Press `<Enter>`.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
</table>
| 1. Pull down the Display menu by clicking **Display** on the main menu or pressing `<Alt> D`.  
2. Click **Legend** or press **L**. | None             |

### Legend Dialog Box

If you enter the command with no text, the Legend dialog box opens.

![Legend Dialog Box](image)

You can enter your text in the Legend Text text box and click **OK**.
Lightning

The Lightning command produces a graphic overlay that provides information on areas where lightning strikes have occurred during a given five-minute period. This information shows lightning that may affect air traffic in CONUS and Canada. To remove the overlay temporarily, issue the Hide Weather command.

Command Line Interface

Press ; and enter your command using the following syntax:

![Command Line Interface]

Turn ON or OFF and press <Enter>

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Weather menu by clicking Weather on the main menu or pressing &lt;Alt&gt; W.</td>
<td>None</td>
</tr>
<tr>
<td>2. Click Select Weather or press S to open the Select Weather dialog box.</td>
<td></td>
</tr>
<tr>
<td>3. In the Other Weather Options section, next to Lightning, click On or Off to toggle display of the latest lightning strikes.</td>
<td></td>
</tr>
</tbody>
</table>

About the Display

After issuing the Lightning command, you see an overlay that depicts the most recent lightning strikes, as shown in the following illustration. This overlay updates every five minutes, when the TFMS receives a new lightning overlay. By using the Lightning History dialog box, you can display how lightning strikes have changed over a period of time, up to one hour. For details, see the Lightning section in the Weather Menu on page 4-195.

Note: If you want to change the default lightning color, use the Lightning History dialog box, which is available from the Select Weather dialog box.
Multiple lightning strikes occurring closer than one mile apart are represented by the same icon. A four-digit number showing the time when the most recent information was gathered appears in the Times box.

**Related Commands**

The following commands also display weather overlays: NOWRAD2, Radar Tops, and Jet Stream. The Show Times command displays the types of weather overlays currently on the TSD. Show Weather enables your selected overlays to be displayed and Hide Weather temporarily hides the weather overlays. Weather Report displays a weather report for an airport you specify.
Move

Using the **Move** command, you can change the center point of your display to any Air Route Traffic Control Center (ARTCC), TRACON, sector, airport, navaid, fix, Special Use Airspace (SUA), lat/lon point, fix-radial point, or specific flight ID you want.

### Command Line Interface

Press `;` and enter your command using the following syntax:

For example:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>M ORD</td>
<td>(airport)</td>
</tr>
<tr>
<td>M LAKES</td>
<td>(fix)</td>
</tr>
<tr>
<td>M @UAL123</td>
<td>(flight id)</td>
</tr>
<tr>
<td>M DOME</td>
<td>(TRACON)</td>
</tr>
<tr>
<td>M 3545/14059 or M 3545N/14059W</td>
<td>(lat/lon point)*</td>
</tr>
<tr>
<td>M JOT</td>
<td>(fixes and navaids)</td>
</tr>
<tr>
<td>M LOGEN360010</td>
<td>(fix-radial distance)**</td>
</tr>
</tbody>
</table>

*You specify a lat/lon point by entering the point in NAS format: N coordinate/W coordinate, with the latitude required to be four digits and the longitude required to be five digits. For example, to move to point 35’ 45”N and 140’ 59”W, enter 3545N/14059W.

You specify a radial point and distance in relation to a designated fix or airport. This is sometimes called a RHO-THETA point. Use the format: Fix-radial-distance with no spaces or markers (`aaaaarrrddd`), where:

- `aaaaa` is a three- to five-character designator for a fix,
- `rrr` is the radial direction in degrees, and
- `ddd` is the distance in nautical miles.

Press: `<Enter>`

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
</table>
| 1. Pull down the Maps menu by clicking **Maps** on the main menu or pressing `<Alt> M`.  
2. Click **Move/Zoom** or press **M**. | **M** |
Move Prompts Dialog Box
If you enter the command with no parameters, the Move Prompt dialog box opens.

Enter the location in the Place field. You may also enter the complete command on one line, making sure to leave a space between the command and the location or flight ID.

About the Display
After you specify the center point, the display is redrawn with the location you specified as its center.

Dynamic Sectorization
The TSD centers the display at the center point of the sector as defined by dynamic sectorization if the sector exists. If the sector has been combined into another sector, the TSD centers the display at the center point of the baseline sector.

When the sector is combined, the TSD re-centers the display as specified above and displays a warning dialog box with the appropriate message.

Related Commands
The Zoom command works like the Move command except that you can change the scale as well as the center point of the display.
NOWRAD2

The NOWRAD2 command creates a graphic overlay of high-density precipitation amounts that can help aircraft avoid areas of precipitation and anticipate potential traffic problems at a specific element. These displays show up to six precipitation levels, ranging from very light to very heavy. To remove the overlay temporarily, issue the Hide Weather command.

Command Line Interface

Press ; and enter your command using the following syntax:

```
WX_Maps NOWRAD2 ON
```

Turn ON or OFF and press <Enter>.

Menu Method

1. Pull down the Weather menu by clicking Weather on the main menu or pressing <Alt> W.
2. Click Select Weather or press S to open the Select Weather dialog box.
3. In the Nowrad section, click 2KM to display of precipitation for CONUS, Canada and/or San Juan. Click Off to suppress display of Nowrad2 information.

Quick Key Method

None

About the Display

After issuing the NOWRAD2 command, an overlay similar to the following appears. By default, the NOWRAD2 command displays six levels of precipitation. You can deselect lower levels of precipitation through the weather legend button in the Select Weather dialog box, which is available through the Weather menu. When the WX_Maps NOWRAD2 ON command is issued, the NOWRAD (2km) overlay appears for CONUS, Canada, and San Juan.

Note: This command is not supported if you are displaying CIWS Weather overlays.
Related Commands

The following commands also display weather overlays: Radar Tops, Jet Stream, and Lightning. The Show Times command displays the types of weather overlays currently on the TSD. Show Weather enables your selected overlays to be displayed and Hide Weather temporarily hides the weather overlays. Weather Report displays a weather report for an airport you specify.
Projection

The **Projection** command allows you to choose the geographic region—Continental United States (CONUS), London, Canada, Atlantic, Alaskan, or Chile—around which you would like your display to be oriented or allows the TSD to dynamically change the projection as needed. After you issue the command, the TSD redraws the display so that the geographical boundaries are most accurately represented around the selected region. For most TSD sites the CONUS is the default region.

**Command Line Interface**

Press `;` and enter your command using the following syntax:

![Command Line Interface](image)

**Note:** You can also enter the command as **PROJ**

For example:  
**PROJECTION CONUS**  
**PROJ AL**  
**PROJ AT**  
**PROJ DYNAMIC**

Press `<Enter>`.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Maps menu by clicking <strong>Maps</strong></td>
<td></td>
</tr>
<tr>
<td>on the main menu or pressing <code>&lt;Alt&gt; M</code>.</td>
<td>None</td>
</tr>
<tr>
<td>2. Click <strong>Projection</strong> or press <strong>P</strong>.</td>
<td></td>
</tr>
</tbody>
</table>

**Projection Command Dialog Box**

If you enter the command with no region, the Projection Command dialog box opens. Click the button to the right of CONUS and enter the projection you want from the resulting pull-down menu.
Dynamic Projection

Dynamic projection is selected by default in the Projection command dialog box. The Projection field is disabled (grayed out).

![Projection Command Dialog Box]

The TSD title bar displays (Dynamic Projection), when Dynamic projection is selected with no named projection.

When the Dynamic Projection is selected, the projection center point automatically changes to be equal to the display center point. As you move the display center point, the projection center point also changes.

Fixed Projection Option

Clicking Fixed on the Projection Command dialog box and clicking on the down arrow in the Projection field lets you choose from a pick list of projection center points. The list of projection points is shown below.

![List of Projection Points]

Click OK to change the projection. The center point of the display changes and the TSD title bar displays the projection you choose. For example, if CONUS is the selected projection the title bar displays CONUS in parentheses.

Error Message

If you enter the command incorrectly, or ask for a region that is not available in the dialog box, you get an Error message.

Check the command spelling, verify that the region exists (CONUS, LONDON, CANADA, ATLANTIC, ALASKAN, or CHILE) and reissue the command.
Semicolon Commands: R

Radar Tops

The Radar Tops command lets you toggle the display of the altitude of cloud tops within precipitation areas. Labels indicate the altitude of cloud tops in hundreds of feet. The altitude numbers are represented in hundreds of feet. For example, 300 indicates 30,000 feet.

Command Line Interface

Press ; and enter your command using the following syntax:

```
WX_MAPS RADAR_TOPS ON
```

Turn ON or OFF and press <Enter>

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Weather menu by clicking Weather on the main menu or pressing &lt;Alt&gt; W.</td>
<td>None</td>
</tr>
<tr>
<td>2. Click Select Weather or press S to open the Select Weather dialog box.</td>
<td></td>
</tr>
<tr>
<td>3. In the Other Weather Options section, next to Tops, click On or Off to toggle display of Radar tops</td>
<td></td>
</tr>
</tbody>
</table>

Note: This command is not supported if you are displaying CIWS Weather overlays. When displaying radar tops, it is useful to issue the NOWRAD2 command, which displays areas and levels of precipitation.

Related Commands

The following commands also display weather overlays: NOWRAD2, Jet Stream, and Lightning. The Show Times command displays the types of weather overlays currently on the TSD. Show Weather enables your selected overlays to be displayed and Hide Weather temporarily hides the weather overlays. Weather Report displays a weather report for an airport you specify.
The **Range Rings** command displays one or more sets of range rings around specified locations on the TSD. The locations may be airports, fixes, navaids, lat/lon points, or fix-radial-distances. You may specify the number of rings you want displayed (up to 200) and the distance (up to 3,000 nautical miles) between the rings. You may display up to ten sets of rings.

### Command Line Interface

Press `;` and enter your command using the following syntax:

![Command Line Interface](image)

**Note:** You can also enter the command as **RR**.

For example: **RR SEA 5 200**

Press `<Enter>`

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
</table>
| 1. Pull down the Maps menu by clicking **Maps** on the main menu or pressing `<Alt> M`.  
2. Click **Range Rings** or press **R**. |  
| `<Insert>` (create)  
`<Delete>` (hide)  
`<Ctrl> <Insert>` (toggle labels) |

### Range Rings Dialog Box

If you enter the command with no parameters, the Range Rings dialog box opens.
You may also enter the complete command on one line. Be sure to include a space between items. For each item in the dialog box or entered on the command line, enter a value as described in the table.

### Range Rings

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
<th>What you do</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color</td>
<td>Allows you to choose a color for the range rings.</td>
<td>Click the button and select the desired color from the color palette.</td>
<td>CYAN</td>
</tr>
<tr>
<td>Airport/Fix/ Navaid/Lat-Lon/ Fix-Radial-Distance</td>
<td>Displays the identifier of the location around which you want to center the rings.</td>
<td>Click in the field and enter an airport, fix, navaid, lat–lon, or fix–radial–distance.</td>
<td>ORD MALTA JOT</td>
</tr>
<tr>
<td>Number of Rings:</td>
<td>Displays the number of rings you want displayed.</td>
<td>Enter a number of rings for display. The default value is 5.</td>
<td>5</td>
</tr>
<tr>
<td>Distance between rings (nm)</td>
<td>Displays the distance in nautical miles that you want to separate each ring from the next.</td>
<td>Enter the number of miles. The default is 20.</td>
<td>20</td>
</tr>
</tbody>
</table>

#### Range Rings Quick Keys

You can create a range rings set by pointing to any airport, fix or navaid on the TSD and pressing `<Insert>`. If no other range rings set exists for the location that you point to, a new range rings set is displayed using the defaults parameters and added to the list of sets defined in the Select Range Rings dialog box.

If a range rings set has already been defined for the location, the TSD will display that set. If more than one set has been created for the same location and you press `<Insert>` to create another set at that location, only the first set appears on the TSD. The Create Range Rings dialog box opens with a list of all the sets for that location, from which you may select.
You may remove all range rings from the display by pressing `<Delete>` when the TSD window has focus. All range rings are hidden, although they remain listed in the dialog box. Individual sets of range rings may be removed using the Select Range Rings dialog box.

To toggle range rings set labels, press `<Ctrl> <Insert>`. This action hides the labels of any range rings that appear on the TSD. Because multiple range rings sets can appear simultaneously with labels on or off, pressing `<Ctrl> <Insert>` shows labels for those range rings displayed with labels deselected. The label checkbox in the dialog box changes appropriately.

**Range Rings Defaults**

You can change the current default values for the number of rings and the distance between rings used by the Range Rings command. The system displays four rings with a 50-mile distance between rings.
Range Rings Defaults

The Range Rings Defaults command allows you to change the default values for the number of rings and distance between rings used by the Range Rings command. At the start of each TSD session, range rings defaults are determined by the adaptation file that is recalled at startup.

Command Line Interface

Press ; and enter your command using the following syntax:

For example: RRD 4 25 RED
Press <Enter>.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Maps menu by clicking Maps on the main menu or pressing &lt;Alt&gt; M.</td>
<td>None</td>
</tr>
<tr>
<td>2. Click Range Rings or press R.</td>
<td></td>
</tr>
<tr>
<td>3. In the Select Range Rings dialog box, select Defaults from the Functions menu</td>
<td></td>
</tr>
</tbody>
</table>

Range Rings Defaults Dialog Box

If you enter the command with no parameters, the Range Rings Defaults dialog box opens.
You may also enter the complete command on one line. Be sure to include a space between items. For each item in the dialog box or entered on the command line, enter a value as described in the table below.

### Range Rings Defaults

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
<th>What you do</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Rings</td>
<td>Displays the number of rings you want displayed.</td>
<td>Enter a number of rings for display. The default value is 5.</td>
<td>4</td>
</tr>
<tr>
<td>Distance between Rings</td>
<td>Displays the distance in nautical miles that you want to separate each ring from the next.</td>
<td>Enter the number of miles. The default value is 20.</td>
<td>10</td>
</tr>
<tr>
<td>Color</td>
<td>Allows you to choose a color for the range rings.</td>
<td>Click the button with the left button and select the desired color from the color palette.</td>
<td>RED</td>
</tr>
<tr>
<td>Show Label</td>
<td>Toggles labels for the center point and distance of each range rings set.</td>
<td>Click the checkbox to select or deselect it.</td>
<td></td>
</tr>
</tbody>
</table>

If you enter the command with one, two, or all three parameters, the default values change for only those specified parameters.
The **Remove** command lets you remove flights from the TFMS database, as though they had never existed. Using this command you can remove an airline that goes on strike, eliminate duplicate flight numbers, or remove a specific incorrect flight. Only traffic management specialists at the Air Traffic Control Systems Command Center (ATCSCC) may use this command.

### Command Line Interface

Press `;` and enter your command using the following syntax:

```
REM AIRL:COM DAT:0703 ORI:BOS
```

Multiple entries must be enclosed in brackets.

For example:

```
REM FLI:[AAL123 AAL214] DAT:0705
```

Press `<Enter>`.

* Represents optional entries. Either Airline or Flight is required, but not both. Date is a required entry.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>None</td>
</tr>
</tbody>
</table>

### Preview the Remove Command

You can preview the removal of flights without deleting any actual flights. When you enter the **Remove Preview** command, a list is displayed showing the flights that would be removed if you issued a real Remove command. You issue a Preview Remove command in the same way that you would enter any Remove commands using the keywords explained on the following pages. The difference is that you enter the word Preview after the word Remove, for example:

```
REM PREVIEW AIRL:COM DAT: 0703 ORI: BOS
```
Remove Command Keywords

The following table explains the keywords used when issuing the Remove command.

**Note:** Each keyword must be followed by a semicolon (;). Date is required and must be entered in every Remove command.

### Remove Keywords

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIRLINE</td>
<td>Three-letter airline code. Either Airline or Flight is required, but not both. Airline can be abbreviated ARL.</td>
<td>Remove all flights for an airline: REM AIRL:COM DATE:0705</td>
</tr>
<tr>
<td>FLIGHT</td>
<td>A full flight call sign. Either Airline or Flight is required. Can be abbreviated as FLI. Can have a single value, a range of values, or a list of values. Items within a list of values must be separated by a space.</td>
<td>Remove single flight: REM FLI:AAL123 DAT:0705 Remove all flights in a range of flights: REM FLI:[ARN 8000-ARN8999] DAT:0705 Remove a list of flights REM FLI:[AAL123 AAL214] DAT:0705</td>
</tr>
<tr>
<td>DATE</td>
<td>A four-digit month/day in mmdd format. This is a required value. Date can be abbreviated DAT. Can have a single value, a range of values, or a list of values. Items within a list of values must be separated by a space. You can also enter ALL in this field to indicate all dates.</td>
<td>Remove flight on a single date: REM FLI:AAL123 DAT:0705 Remove flight for a range of dates: REM FLI:AAL123 DAT:[0705-0708] Remove flight for a list of dates: REM FLI:AAL123 DAT:[0905 0908 0909] Remove flight for all dates: REM FLI:AAL123 DAT:ALL</td>
</tr>
<tr>
<td>AIRPORT</td>
<td>A three or four-character airport code. Optional entry. The absence of an airport entry indicates all airports. Abbreviated AIRP.</td>
<td>Remove flight operating in or out of multiple airports: REM FLI:BLR999 DAT:0705 AIRP: [BOS JFK DCA] Remove flight operating in or out of a specific airport: REM FLI:BLR999 DAT:0705 AIRP: BOS</td>
</tr>
</tbody>
</table>
### Remove Keywords (Continued)

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>ORIG</td>
<td>A three or four -character airport code. Optional. Abbreviated ORI. Can have a single value or a list of values. Items within a list of values must be separated by a space. Cannot be specified with AIRPORT</td>
<td>Remove a single leg of a flight from a single origin: REM FLI:COM1379 DAT:0705 ORI:BOS</td>
</tr>
<tr>
<td>DEST</td>
<td>A three or four -character airport code. Optional. Abbreviated DES. Can have a single value or a list of values. Items within a list of values must be separated by a space. Cannot be specified with AIRPORT</td>
<td>Remove a single leg of a flight from a single destination: REM FLT:COM1379 DAT:0705 DES:JFK</td>
</tr>
<tr>
<td>STATUS</td>
<td>Flights that have only OAG or CDM messages.</td>
<td>Remove a flight by status: STATUS:OAG STATUS:CDM</td>
</tr>
</tbody>
</table>

You can enter up to **20 values** in a list of values.

### Confirmation Message

After you issue the Remove command, the system checks the command format and if the format is correct and the site from which you issued the command is authorized to perform a removal, you will see a message showing you what flights have been removed. Otherwise, you will receive an error message.
Replay

The **Replay** command lets you replay historical flight, weather, and alert data on one TSD at a time. This feature lets you review a scenario at a certain time and place and lets you compare current activities with those of the past. During the replay you can issue other TSD commands as usual. Requests for data from TFMS databases return current rather than historical data.

Command Line Interface

Press `;` and enter your command using the following syntax:

```plaintext
Input Request:
REPLAY
```

Press `<Enter>`.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
</table>
| 1. Pull down the Tools menu by clicking **Tools** on the main menu or pressing `<Alt> T`.  
2. Click **Replay** or press **R**. | None |

The Replay function lets you display overlays for either the Current or Baseline sectors that were in existence at the time that is being replayed. For example, if alerts are being replayed, alert icons are displayed using the current sector boundaries that existed at the time being replayed.

**Note:** It is recommended that Current Sector Boundaries data be replayed if Alerts are being replayed. This data is needed to draw the correct boundaries for the Alert Icons. Also, the Time in Sector chart is unavailable when the TSD is running in Replay mode. If a Time in Sector chart is open when the Replay option is selected, a confirmation dialog box displays allowing you to close the Time in Sector chart or cancel Replay.
Resulting Display

After you click **Replay**, the Replay Specification dialog box opens. If **Show Times** is selected on the Display menu, the Times box on the TSD display now contains the word Replay, reflecting that the data shown is historic rather than current.

![Replay Specification Dialog Box]

If Show Times is selected on the Display menu, the Times box on the TSD display now contains the word Replay, reflecting that the data shown is historic rather than current.

![Times Display]

Replay: 1646
Flights: 1646
Tops: 1645
Lightning: 0000
Jet Stream: 1500
NOWRAD2_us: 1640
NOWRAD2_cn: 1645
NOWRAD2_sj: 1645
CCFP Issued: N/A
CCFP Valid: N/A
Alerts: 0000
Time Limit: 2.25
Show Data File Locations

When you click the **Show Data File Locations** button, the Replay Specification dialog box expands to show the pathnames to where the data items are stored. The example below shows a partial view of data and its corresponding pathname.

![Pathname Table]

When you click the **Hide Data File Locations** button, you are returned to the default Replay Specification dialog box.

Using the Dialog Box

The following table describes items in the Replay Specification dialog box and provides examples of entries. Click the checkbox to the right of the text entry field to replay that data.

Clicking **Cancel** in the Replay Specification dialog box cancels the Replay mode, and returns the TSD to its live data display.

**Note:** Flights must be selected to run a replay and is automatically selected in the dialog box. You cannot deselect Flights. Other items are optional.

### Replay Specification

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>From Date</td>
<td>Date on which the data to be replayed begins. (UTC format: <em>mmdd</em>)</td>
<td>Current date</td>
</tr>
<tr>
<td>From Time</td>
<td>Time when the data to be replayed begins. (UTC format: <em>hhmm</em>)</td>
<td>One hour prior to the current time</td>
</tr>
<tr>
<td>To Date</td>
<td>Date on which the data to be replayed ends. (UTC format: <em>mmdd</em>)</td>
<td>Current date</td>
</tr>
<tr>
<td>To Time</td>
<td>Time when the data to be replayed ends. (UTC format: <em>hhmm</em>)</td>
<td>Current time</td>
</tr>
</tbody>
</table>
## Replay Specification (Continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replay Time Increment</td>
<td>The number of minutes that the replay time advances at each update.</td>
<td>1</td>
</tr>
<tr>
<td>Time Between Updates</td>
<td>Time frequency in seconds with which the Replay time updates.</td>
<td>10</td>
</tr>
<tr>
<td>Flights</td>
<td>The pathname where the flights data is stored.</td>
<td>/nfs/wkstn01/traffic</td>
</tr>
<tr>
<td>Alerts</td>
<td>Pathname where the alerts data is stored.</td>
<td>/nfs/wkstn01/sio_files</td>
</tr>
<tr>
<td>CONUS 2 km Radar</td>
<td>Pathname where the CONUS NOWRAD 2km data is stored.</td>
<td>/nfs/wkstn01/wx_maps/nowrad_2km</td>
</tr>
<tr>
<td>Canada 2 km Radar</td>
<td>Pathname where the Canadian NOWRAD 2km data is stored.</td>
<td>/nfs/wkstn01/wx_maps/nowrad_2km_can</td>
</tr>
<tr>
<td>San Juan 2 km Radar</td>
<td>Pathname where the San Juan NOWRAD 2km data is stored.</td>
<td>/nfs/wkstn01/wx_maps/nowrad_2km_sj</td>
</tr>
<tr>
<td>CCFP</td>
<td>Pathname where CCFP is stored.</td>
<td>/nfs/wkstn01/wx_maps/ccfp_files</td>
</tr>
<tr>
<td>NCWF</td>
<td>Pathname where NCWF is stored.</td>
<td>/nfs/wkstn01/wx_maps/ncwf_files</td>
</tr>
<tr>
<td>Lightning</td>
<td>Pathname where the lightning data is stored.</td>
<td>/nfs/wkstn01/wx_maps/lightning</td>
</tr>
<tr>
<td>Echo Tops</td>
<td>Pathname where the tops data is stored</td>
<td>/nfs/wkstn01/wx_maps/echo_tops</td>
</tr>
<tr>
<td>Jet Stream</td>
<td>Pathname where the jet stream data is stored.</td>
<td>/nfs/wkstn01/wx_maps/jet_stream</td>
</tr>
<tr>
<td>Current Sector Boundaries</td>
<td>Pathname where the current sector boundaries data is stored.</td>
<td>/nfs/wkstn01/ETMS/rrsvr/dynamic_data/archive</td>
</tr>
</tbody>
</table>
Using the Control Panel

The replay date and time shown at the top of the control panel update continuously and automatically. You can also change these fields by clicking **Pause** and entering new values in the date and time field. When you click **Pause**, the button changes to **Resume**, as shown below. Click **Resume** to continue running the replay with the new date and time values.

![Replay Control Panel Diagram]

Like a VCR, you can move the replay forward or backward. Notice that the arrows to the left and right of the **Resume** button are highlighted when replay has been paused. Each arrow has a specific function.

- The arrow to the immediate left of the Resume button moves the time back one increment.
- The arrow to the immediate right of the Resume button moves the time forward one increment.
- The second arrow from the left of Resume runs the replay backwards
- The second arrow from the right of Resume runs the replay forward.
- The arrow to the far left of the row returns the time value to its original start time.

When the replay date and time reach the end of the specified time period, the replay process returns to its original start date and time. Clicking **Cancel** returns you to the Replay Specification dialog box.
File Menu
The File menu contains the same menu items as it does in several TSD dialog boxes: Recall, Save, and Delete. This menu was explained in Chapter 2.

Minimap Menu
The Minimap function is not available at TFMS field sites.
The **Request Area** command allows you to request a report that displays the number of flights traversing a specified sector or multiple sectors. In addition, you may specify a time period, time intervals, and count options for the report.

### Command Line Interface

Press `;` and enter your command using the following syntax:

```
REQ sector time period "EVERY count"
```

If you enter a request for multiple sectors, issue the command using the following syntax. Enclose multiple sectors in brackets.

```
REQ [sector1 sector2] time period "EVERY count"
```

(* Indicates optional entry)

For example:

```
REQ AREA ZDC16 4/12 2030 0130 EVERY 30
Or  
REQ AREA [ZBW52 ZBW02] 2030 0130 EVERY 30
```

**Note:** When using count options in a **Request Area** command, such as `AC_CAT`, do not include the word `count` in the command line.

Press `<Enter>`

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>None</td>
</tr>
</tbody>
</table>
Specifying Sectors

The Request Area command must include at least one sector name and may include multiple sectors. When you request only one sector, the resulting Area report contains flight counts over that sector in 15-minute intervals in a default period of five hours or another period of time you specified. When you request multiple sectors, the resulting Area report contains flight counts for all the sectors, also in 15-minute intervals.

Note: When you request an Area report for multiple sectors, flights appearing in more than one sector (e.g., adjacent sectors easily passed through within the same 15-minute time interval) are counted only once in order not to misrepresent the total counts for that interval. To see multiple flight entries in multiple sectors, issue the Request List command and specify ENTRY, EXIT, and SECTOR sort options.

If you wish your reports to come from Hubsite data rather than your own local server, specify HUBSITE or HUB in your requests.

Request Area Options

There are several options available with the Request Area command:

- Time period
- Every
- Count.

Time Period

The time period option allows you to change the date and the time span for the report data. By default, the report covers a time period of five hours beginning at the current time on the current day. If you use this option with other command options, you must place it first in the command line. For more information about using dates and times, see Appendix A, page A-8.

Every

The default Area report displays flight data in 15-minute intervals. However, you can use the every option (also known as the time interval option) to specify a different time interval format. For more information, see Appendix A, page A-24.

Count

The count option allows you to designate a category of columns for an Area report that differs from the default report format. For example, you can specify the AIRL count option to request a report with columns headed by airline designators, displayed in alphabetical order from left to right. Although the word count is used when specifying a count option in the Request Count command, using it in a Request Area command results in an error message. For a list of count options, see Appendix A, page A-15.
Displaying the Report

By issuing the following command, you can display an Area report for flights over a single sector as shown in this sample:

```
REQ AREA ZDC18
```

Immediately after you issue the command, you receive a confirmation message indicating your request has been sent. At this time you may continue to use other TSD functions. After a short time, the program emits a beep and shows a dialog box similar to the following one.

Click **Display** to see the report and **Print** to print it to your local printer.

Reading the Report

Each report has a header that echoes the request you typed in, followed by the day of the month, and the beginning and ending times of the report. In the body of the report, each
row represents one time interval, identified in the left-hand column. By default, the report spans a five-hour time period, divided into 15-minute intervals. For each time interval, the report shows the number of flights that are within each sector at any time during that time interval, followed by a total for that time period. The last line of the report shows a total for each sector, followed by a grand total for the report. All totals in the Area report are simple totals of the individual sector counts. (They may not represent the total number of unique flights.)

Secondary Requests

Secondary requests allow you to use the report name to quickly request additional reports with different specifications for the same location specified in the original report. This feature is very useful when you need detailed information for a specific airport.

You may not use the Request Area command to make a secondary request. However, you can generate a secondary request report from an original Area report by using the Request Count, Request List, or Request Listo command. For information about using secondary requests, see Appendix A, page A-25.

Related Commands

The following is a list of other flight report commands available through the TSD.

- **Request ARRD**
  Predicts arrival delays for specified airports.

- **Request Count**
  Lists flight counts for an airport, fix, sector, or ARTCC.

- **Request FIXL**
  Lists flight counts for an arrival fix or for all arrival fixes for an airport.

- **Request LIFP**
  Lists flight plans for specified flights.

- **Request List(o)**
  Lists flight info for an airport, fix, sector, or ARTCC.

- **Request VT**
  Compares actual arrival/departure times with a specified time type.
The **Request ARRD** (Arrival Delays) command creates a report that helps you assess potential traffic congestion by predicting arrival delays. After specifying an airport, you can use the command options to set the number of stacked flights, capacity levels, and General Aviation estimates in order to analyze various traffic scenarios.

### Command Line Interface

Press ; and enter your command using the following syntax:

![Command Line Interface](image)

(* indicates optional entry)

For example:  

```
REQ ARRD DFW 4/12 2000 0000 CAPS 2100 2200 25 EVERY 30
```

Press <Enter>

### Menu Method

<table>
<thead>
<tr>
<th>None</th>
</tr>
</thead>
</table>

### Quick Key Method

<table>
<thead>
<tr>
<th>None</th>
</tr>
</thead>
</table>

### Specifying the Data Source

The default data source for request commands is the Traffic Database (TDB). Because the TDB is the default, you cannot specify the TDB as the data source in a request command. If you want a different source of data, you can specify one. The OAG data source lets you specify that the report use only schedule data. See Appendix A, page A-2, for more information.

If you wish your reports to come from Hubsite data rather than your own local server, specify HUBSITE or HUB in your requests.
Using the ARRD Options

The ARRD options are summarized in the table below. There is more information about each option following the table.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>What you do</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Period</td>
<td>Changes the time span for the report.</td>
<td>Enter the time span in UTC format.</td>
<td>REQ ARRD BOS 2000 0000</td>
</tr>
<tr>
<td>Stak</td>
<td>Sets a specified number of arrivals held over the airport.</td>
<td>Enter STAK, the number of stacked flights, and the time, in UTC format.</td>
<td>REQ ARRD DFW STAK 5 2000</td>
</tr>
<tr>
<td>CAPS</td>
<td>Changes the specified rate of arrivals (capacity) allowed per report time interval.</td>
<td>Enter CAPS, the time interval for the new capacity, and the capacity number.</td>
<td>REQ ARRD JFK CAPS 2100 2200 3</td>
</tr>
<tr>
<td>GA</td>
<td>Changes the number of General Aviation flights allowed per report time interval.</td>
<td>Enter GA, the time interval for the new estimate, and the estimate number.</td>
<td>REQ ARRD ORD GA 0300 0800 10</td>
</tr>
<tr>
<td>Every</td>
<td>Sets the time interval for the report format.</td>
<td>Enter EVERY, and the time value in minutes.</td>
<td>REQ ARRD LAX EVERY 30</td>
</tr>
</tbody>
</table>

**Time Period**

The time period option allows you to change the time span for the report data. By default, the report covers a time period of five hours beginning at the current time. If you use this option with other command options, you must place it first (immediately after the airport) in the command line. You may specify any hourly period between current time and 24 hours in the future. You can also use relative time periods. For more information about using dates and times and about relative time periods, see Appendix A, page A-8.

**Stak**

The stak option sets up an initial condition involving a specified number of arrivals held over the airport. To use this option, you must also specify the number of stacked flights and the time.

**CAPS**

The caps option allows you to see what the arrival delay prediction would be if the capacity level changed for a given time. You can specify the capacity number and the time interval for the capacity. If no time and capacity are set, the system uses the current capacity value set within the TFMS for the airport.

**GA**

The ga option, which stands for General Aviation (GA) estimates, allows you to see what the arrival delay prediction would be if more or fewer flights arrive than are expected at a
certain time. Use this option to specify a time interval and the number of flights per time interval. If no time and value are set, the system uses the current setting in the TFMS. If you find out that the GA estimates for the airport have changed, you can use the GAES command to reset the GA estimate thresholds.

**Every**

The every option sets the time interval (in minutes) of the report. If no interval is specified, the default time of 60 minutes is used. Available interval times are 5, 10, 15, 20, 30, 45, or 60 minutes. For more information on the Every option, see Appendix A, page A-24.

**Displaying the Report**

Unless you specify a different date or time, data in ARRD reports is provided for a five-hour period beginning right after the initial request is made. The sample report below was generated using the following command:

Immediately after you issue the command, a confirmation message is displayed to confirm that your request has been sent. After a short period of time, the program emits a beep and displays a dialog box like the following.

Click **Display** in the dialog box to see the report, similar to the following one.
Reading the Report

The ARRD report header identifies the airport, start date, end date (if different from the start date), start time, stop time, and the time interval into which the report is divided. A line containing the airport name and the time at which you issued the command follows the report header, and a line indicating the stack size follows that. (Unless you use the stak option, the stack size reads “0 STACKED AT 00”.) The list following the stack line is a breakdown of the total number of arrival delays. The first column is always the time in UTC. Each of the remaining nine columns on the ARRD report is described as follows:

- **ARR** Displays the total number of aircraft expected to arrive at the destination airport during the specified time interval. This number includes the stack size, if specified.
- **ACT** Displays the total number of arrivals for which a departure message has been received. This number includes the stack size, if specified.
- **LND** Displays the predicted number of aircraft landing during the specified time interval.
- **CAP** Displays the current arrival capacity setting for the reported airport.
- **GA** Displays the current GA estimate setting for the reported airport.
- **AVERAGE HLD** Displays the average number of aircraft projected to be holding in the terminal area for the specified time interval, calculated with the following formula:

\[
\text{AVERAGE HLD} = \frac{\text{Sum of all aircraft holding for time interval}}{\text{Number of holding aircraft in the time interval}}
\]
- **AVERAGE DLY**
  Displays the average of projected delays attributed to aircraft holdings for the specified time interval, calculated with the following formula:

  \[
  \text{AVERAGE DLY} = \frac{\text{Sum of delays of holding aircraft for time interval}}{\text{Number of holding aircraft in the time interval}}
  \]

- **PEAK HLD**
  Displays the maximum number of aircraft projected to be holding in the terminal area for the specified time interval. A count of holding aircraft is made for every minute of the time interval. The largest of these in each time interval is the PEAK HLD for that period.

- **PEAK DLY**
  Displays the maximum projected delay attributed to aircraft holdings during the specified time interval, that is, the largest projected delay a holding aircraft may have to endure during this interval.

After you have read the report, you can send it to your printer by clicking **Print**. A dialog box opens asking you to confirm the print command or enter the filename and number of copies desired.

**Related Commands**

The following is a list of other flight report commands available through the TSD.

- **Request Area**
  Lists flights traversing a specified sector or multiple sectors.

- **Request Count**
  Lists flight counts for an airport, fix, sector, or ARTCC.

- **Request FIXL**
  Lists flight counts for an arrival fix or for all arrival fixes for an airport.

- **Request LIFP**
  Lists flight plans for specified flights.

- **Request List(o)**
  Lists flight info for an airport, fix, sector, or ARTCC.

- **Request VT**
  Compares actual arrival/departure times with a specified time type.
**Request Count**

The **Request Count** command allows you to request a flight counts report that displays the number of flights departing from, arriving at, or traversing an airport, fix, sector, or Air Route Traffic Control Center (ARTCC). In addition, you may define the report with filter and format options that specify the places, times, dates, airlines, flight times, and other criteria.

**Command Line Interface**

Press ; and enter your command using the following syntax:

(*Indicates optional entry)

For example: **REQ A DFW WED 2000 0000 EVERY 30 COUNT AIRP**

Press <Enter>.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>None</td>
</tr>
</tbody>
</table>

**Specifying Arrivals or Departures**

Enter **A** or **D** to limit the report to arrivals or departures, respectively. If you do not enter **A** or **D**, the report will include both.

**Specifying the Location**

To specify the location for a **Request Count** command you must at least include a Primary Place of Interest (PPI). This may be the FAA designator for an airport, ARTCC, sector, high fix, low fix, or superhigh fix. If the report is for a fix or a sector, only one location designator is allowed; however, for airports and/or ARTCCs, you may enter multiple PPIs (enclosed in brackets), or you may add one or more Secondary Places of Interest (SPI) enclosed in a second pair of brackets. If you include an SPI, the report will be limited to flights traveling between any PPI and any SPI. You may also exclude locations from either category by using a minus sign.

**Note:** If you specify both a primary and a secondary place of interest in your location designator (see the next section), the **A** or **D** refers to arrivals or departures at the primary place of interest.
The following table describes the various methods you may use to designate locations. This table does not show all PPI/SPI combinations; for more information, see Appendix A, page A-6.

### Location Designators

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
<th>What you do</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Airport and ARTCC</td>
<td>Flights going to and from one element (one PPI).</td>
<td>Enter the FAA Designator.</td>
<td>REQ DFW</td>
</tr>
<tr>
<td></td>
<td>Flights going to and from more than one element (more than one PPI).</td>
<td>Enter each FAA designator, all within brackets or parentheses.</td>
<td>REQ [BWI DCA]</td>
</tr>
<tr>
<td></td>
<td>Flights between a primary element and selected others (flights between a PPI and SPIs).</td>
<td>Enter the primary FAA designator, followed by the secondary FAA designator (within brackets if more than one).</td>
<td>REQ ZBW [DFW LAX]</td>
</tr>
<tr>
<td></td>
<td>Flights between a primary element and anywhere except selected others (exclusions from the SPI).</td>
<td>Enter the primary FAA designator, and the secondary elements, each preceded by a minus sign (within brackets if more than one).</td>
<td>REQ JFK [-DFW- ATL]</td>
</tr>
<tr>
<td>Sector</td>
<td>Flights passing through a sector.</td>
<td>Enter the FAA designator.</td>
<td>REQ ZDV32</td>
</tr>
<tr>
<td>High Fix</td>
<td>Flights passing a high fix.</td>
<td>Enter hifix, and the FAA designator.</td>
<td>REQ HIFIX GUP</td>
</tr>
<tr>
<td>Low Fix</td>
<td>Flights passing a low fix.</td>
<td>Enter lofix, and the FAA designator.</td>
<td>REQ LOFIX GUP</td>
</tr>
<tr>
<td>Superhigh Fix</td>
<td>Flights passing a superhigh fix.</td>
<td>Enter sufix, and the FAA designator.</td>
<td>REQ SUFIX GUP</td>
</tr>
</tbody>
</table>

Note: The flight level designator that you enter with a fix must correspond to the actual airspace associated with that fix. For example, the command **REQ SUFIX LIN** is an invalid request, because there is no superhigh sector associated with LIN. Entering an invalid designator results in a report with no data, or with zeroes.
Specifying the Data Source

The default data source for request commands is the Traffic Database (TDB). Because the TDB is the default, you cannot specify the TDB as the data source in a request command. If you want a different source of data, you can specify one of the following.

- OAG allows you to specify that the report use only schedule data as the data source.
- BASE allows you to show the flight count report based on baseline sectors rather than current sectors.
- FCATA allows you to show the flight count or flight list report based on the flights predicted to traverse the FEA/FCA.

For more information on these data sources, see Appendix A, page A-2.

If you wish your reports to come from Hubsite data rather than your own local server, specify HUBSITE or HUB in your requests.

Request Count Options

Time Period

The time period option allows you to change the date and the time span for the report data. By default, the report covers a time period of five hours beginning at the current time on the current day. If you use this option with other command options, you must place it first (immediately after the airport) in the command line. For more information about using dates and times, see Appendix A, page A-8.

Filter

The default flight counts report covers all flights going to and from the location you indicate. However, you can filter the information to reflect only specific flights you want included in the report. There are many options available, and you may use as many as you want for your purposes. For a complete description of these options, see Appendix A, page A-11.

Every

The default flight counts report displays flight data in 15-minute intervals. However, you can use the every option (also known as the time interval option) to specify a different time interval format. For more information about this option, see Appendix A, page A-24.
gstop

- **Total Count**
  Represents the total number of flights that have not yet departed from this airport or center.

- **Controlled Flights**
  Represents the number of flights for which controlled departure times have been issued and which have already been held past their original departure time.

- **Flights on Ground Past ETD**
  Represents the number of flights that have remained on the ground beyond their most recently issued Estimated Time of Departure (whether controlled or not).

The gstop option should be used for arrivals only, and only with the count option COUNT ORIG or COUNT DCENTR. To use this option, type `GSTOP` after ORIG or DCENTR. For example:

```
Count
```

To designate a category of columns that differs from the default format, you may use the count option. To use this option, enter the word `COUNT`, and one of the options described in the Count Option table as found in Appendix A. If you do not want to see all of the columns for the selected category type, you can limit the display by choosing only the columns you want to see. You may also exclude columns by entering a minus sign. When you issue the Request Area command and specify a count option, enter only the name of the option, e.g., `AC_CAT`, without the word count. For a complete description of Count Options, see Appendix A, page A-15.

If you are generating a report of counts by origin airport or center, the gstop option causes the report to show counts of all flights that have not yet departed and those held past their departure times. If you include this option, each count in the report includes a series of three numbers, separated by a slash (/): Total Count / Controlled Flights / Flights on Ground Past ETD.
Displaying the Report

The sample on the following page was generated from this command:

Immediately after you issue the command, a confirmation message is displayed to confirm that your request has been sent. After a short time, the program emits a beep and displays a dialog box like the following.

Clicking Display opens a flight count report like the following for DFW.
Reading the Report

The report has a header that echoes the request you typed in, followed by the day of the month, and the beginning and ending times of the report. The default format lists arrival data and departure data separately. The following describes the columns of information:

- **TIME** Identifies the specific block of time this report provides information on. Report times are the same for both arrivals and departures. By default, the five-hour time period is divided into 15-minute intervals.
- **ACTIVE** Identifies the number of active flights during this time period.
- **PROPOSED** Identifies the number of flights that have not yet departed but are expected for this time period. (This count includes scheduled flights.)

After you have read the report, you can send it to your printer by clicking Print. A dialog box opens asking you to confirm the Print command or enter the filename and number of copies desired.

Sample Report with Count Option

Your report will have a different appearance if you specify one of the count options. The next report was generated using the AIRL option.

This report shows flight counts by airlines, in alphabetical order reading left to right. Use the scrolling keys to view the remaining airlines and departure counts.
You can now choose to print the report at your specified printer or to close the report.

**Secondary Requests**

Secondary requests allow you to use the report name to quickly request additional reports with different specifications for the same location specified in the original report. This feature is very useful when you need detailed information for a specific airport.

You may request a secondary flight counts or flight list report from any type of original flight report except ARRD. For information about using secondary requests, see Appendix A, page A-25.

**Related Commands**

The following is a list of other flight report commands available through the TSD.

- **Request Area**
  Lists flights traversing a specified sector or multiple sectors.

- **Request Count**
  Lists flight counts for an airport, fix, sector, or ARTCC.

- **Request FIXL**
  Lists flight counts for an arrival fix or for all arrival fixes for an airport.

- **Request LIFP**
  Lists flight plans for specified flights.

- **Request List(o)**
  Lists flight info for an airport, fix, sector, or ARTCC.

- **Request VT**
  Compares actual arrival/departure times with a specified time type.
If you wish your reports to come from Hubsite data rather than your own local server, specify HUBSITE or HUB in your requests.

**The FixL Options**

The following three options are available to you when you request a fix loading report:

- Time period
- Every

These options are described briefly below and in further detail in Appendix A.

**Time Period**

The time period option allows you to change the date and the time span for the report data. By default, the report covers a time period of five hours beginning at the current time on the current day. If you use this option with other command options, you must place it first (immediately after the airport) in the command line. For more information about using dates and times, see Appendix A, page A-8.
Every
The default fix loading report displays flight data in 15-minute intervals. However, you can specify a different time interval format. For more information, see Appendix A, page A-24.

Displaying the Reports
The sample below displays the default fix loading report generated from the following command:

Immediately after you issue the command, you receive a confirmation message indicating that the request has been sent. At this time you may continue to use other TSD functions. After a short time, the program emits a beep and displays a dialog box like the following.

Click **Display** in the dialog box to see the report, similar to the following one.

Reading the Reports
The report header identifies the airport or fix, the type of report (fix loading), and the time the report was created (UTC). The following list describes the four columns of information found in the FIXL report:
• **TIME** Identifies each time interval. By default, the report is for a five-hour time period divided into 15-minute intervals, beginning with the current hour.

• **FIX** Identifies the specific arrival fixes for which counts are given. If you specified a fix, every entry in this column will be that fix. If you specified an airport, all of the arrival fixes associated with that airport will appear.

• **DEP** Identifies the number of flights expected to arrive at the departure fix during the time period.

• **ARR** Identifies the number of flights expected to arrive at the fix during the time period.

• **ACT** Identifies the number of active flights within the ARR count.

After you have read the report, you can send it to your printer by clicking **Print**. A dialog box opens asking you to confirm the Print command or enter the filename and number of copies desired.

**Secondary Requests**

Secondary requests allow you to use the report name to quickly request additional reports with different specifications for the same location specified in the original report. This feature is very useful when you need detailed information for a specific airport.

Secondary requests can be made from any original report except for arrival delay prediction (ARRD) reports. However, to make a secondary request, you must use the **Request Count**, **Request List**, or **Request Listo** command. (The resulting secondary report will be either a flight counts or flight list report.) For information about using secondary requests, see Appendix A, page A-25.
Related Commands

The following is a list of other flight report commands available through the TSD.

- **Request Area**
  Lists flight counts for sectors.

- **Request ARRD**
  Helps to assess potential traffic congestion by predicting arrival delay.

- **Request Count**
  Lists flight counts for an airport, fix, sector, or ARTCC.

- **Request LIFP**
  Lists flight plans for specified flights.

- **Request List(o)**
  Lists flight info for an airport, fix, sector, or ARTCC.

- **Request VT**
  Compares actual arrival/departure times with a specified time type.
If you wish your reports to come from Hubsite data rather than your own local server, specify HUBSITE or HUB in your requests.

**Displaying the Reports**

Reports are generated using a command like the following:

Immediately after you issue the command, you receive a confirmation message indicating that the request has been sent. At this time you may continue to use other TSD functions. After a short time, the program emits a beep and displays a dialog box like the following.
Click **Display** in the dialog box to see the report.

![Image of LIFP report](image.png)

### Reading the Reports

The LIFP report header shows an echo of the command you entered, followed by the beginning and end date/time of the report. The following list describes the six columns of information:

- **ACID**  
  The unique alphanumeric aircraft identifier.

- **ORIG**  
  The FAA designator showing the departure airport.

- **ETD**  
  Estimated time of departure, based on best available time from among the other departure time types. A prefix is used to indicate the source of the data that is used to set the ETD; the user can judge the reliability of the data partly on the basis of the prefix, explained below.

  - **S** - Scheduled. TFMS has received no flight plan. Data is based on the OAG and/or user-provided schedule updates.
  
  - **N** - Early Intent. TFMS has received a user-provided early intent route.
  
  - **P** - Proposed. TFMS has received a NAS flight plan.
  
  - **T** - Taxi. TFMS has received a message indicating the flight has pushed off the gate.
  
  - **A** - Active. TFMS has received a NAS or user-provided departure message.
  
  - **E** - Estimated. TFMS has received a message indicating the flight was active, but no departure message was received.
  
  - **R** - The historical route has been replaced by the assigned route.

- **DEST**  
  The FAA designator showing the destination airport.
• **ETA** The estimated time of arrival based on the best available estimate from either the Actual time of arrival (A) or the Estimated time of arrival (E). The ETA is marked with either of these prefixes to indicate which data the estimate is based on.

• **ROUTE** The designators showing the flight plan of each aircraft.

The LIFP report shows flight plans for flights scheduled to fly within the current 24-hour period, beginning exactly 12 hours before you entered this request and ending 12 hours in the future. The line immediately below the column labels identifies the date and time of the beginning of the period, followed by the number of flights listed.

After you have read the report, you can send it to your printer by clicking **Print**. A dialog box opens asking you to confirm the print command or enter the filename and number of copies desired.

### Secondary Requests

Secondary requests allow you to use the report name to quickly request additional reports with different specifications for the same location specified in the original report. This feature is very useful when you need detailed information for a specific airport.

Secondary requests can be made from any original report except for arrival delay prediction (ARRD) reports. However, to make a secondary request, you must use the **Request Count**, **Request List**, or **Request List(o)** command. (The resulting secondary report will be either a flight counts or flight list report.) For information about using secondary requests see Appendix A, page A-25.

### Related Commands

The following is a list of other flight report commands available through the TSD.

• **Request Area**
  Lists flight counts for sectors.

• **Request ARRD**
  Helps to assess potential traffic congestion by predicting arrival delay.

• **Request Count**
  Lists flight counts for an airport, fix, sector, or ARTCC.

• **Request FIXL**
  Lists flight counts for an arrival fix or for all arrival fixes for an airport.

• **Request List(o)**
  Lists flight info for an airport, fix, sector, or ARTCC.

• **Request VT**
  Compares actual arrival/departure times with a specified time type.
Request List

The Request List command allows you to request a flight list report that gives you a list of various types of flight information in columns. You define the standard or default report by specifying a location. In addition, you may use filter options and format options to specify optional information and formatting criteria.

Command Line Interface

Press ; and enter your command using the following syntax:

(* Indicates optional entry)

Note: The keyword BASE is optional and can only be used with sectors.

For example:  
REQ DFW 4/12 2000 0000 AIRL EVERY 30 LIST SORT DEST
Press <Enter>.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>None</td>
</tr>
</tbody>
</table>

Specifying Arrivals or Departures

Enter A or D to limit the report to arrivals or departures, respectively. If you do not enter A or D, the report will include both.

Specifying the Location

To specify the location for a Request List command you must at least include a Primary Place of Interest (PPI). This may be the FAA designator for an airport, ARTCC, sector, high fix, low fix, or superhigh fix. If the report is for a fix or a sector, only a PPI is allowed; however, for airports and sectors, Secondary Places of Interest (SPI) may be added. Multiple PPIs and SPIs may be designated by enclosing the places in brackets. If you include an SPI, the report will be limited to flights traveling between any PPI and any SPI. You may also exclude airports and ARTCCs from either category by using a – sign.

Note: If you specify both a primary and a secondary place of interest in your location designator (see the next section), the A or D refers to arrivals or departures at the primary place of interest.
The following table describes the various methods you may use to designate locations. This table does not show all PPI/SPI combinations; for more information, see Appendix A, page A-6.

### Location Designators

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
<th>What you do</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Airport and ARTCC</td>
<td>Flights going to and from one element (one PPI).</td>
<td>Enter the FAA Designator.</td>
<td>REQ DFW</td>
</tr>
<tr>
<td></td>
<td>Flights going to and from more than one element</td>
<td>Enter each FAA designator, all within brackets or</td>
<td>REQ [BWI DCA]</td>
</tr>
<tr>
<td></td>
<td>(more than one PPI).</td>
<td>parentheses.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Flights between a primary element and selected</td>
<td>Enter the primary FAA designator, followed by</td>
<td>REQ ZBW [DFW LAX]</td>
</tr>
<tr>
<td></td>
<td>others (flights between a PPI and SPIs).</td>
<td>the secondary FAA designator (within brackets if</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>more than one).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Flights between a primary element and anywhere</td>
<td>Enter the primary FAA designator, and the</td>
<td>REQ JFK [-DFW- ATL]</td>
</tr>
<tr>
<td></td>
<td>except selected others (exclusions from the SPI).</td>
<td>secondary elements, each preceded by a minus</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>sign (within brackets if more than one).</td>
<td></td>
</tr>
<tr>
<td>Sector</td>
<td>Flights passing through a sector.</td>
<td>Enter the FAA designer.</td>
<td>REQ ZDV32 or REQ [ZFW28 ZFW92]</td>
</tr>
<tr>
<td>High fix</td>
<td>Flights passing a high fix.</td>
<td>Enter <strong>HIFIX</strong>, and the FAA designer.</td>
<td>REQ HIFIX GUP or REQ [HIFIX GUP HIFIX ABQ]</td>
</tr>
<tr>
<td>Low fix</td>
<td>Flights passing a low fix.</td>
<td>Enter <strong>LOFIX</strong>, and the FAA designer.</td>
<td>REQ LOFIX GUP or REQ [LOFIX TAS LOFIX SAF]</td>
</tr>
<tr>
<td>Superhigh fix</td>
<td>Flights passing a superhigh fix.</td>
<td>Enter <strong>SUFIX</strong>, and the FAA designer.</td>
<td>REQ SUFIX GUP REQ [SUFIX LFK SUFIX LCH]</td>
</tr>
</tbody>
</table>

**Note:** The flight level designator that you enter with a fix must correspond to the actual airspace associated with that fix. For example, the command **REQ SUFIX LIN** is an invalid request, because there is no superhigh sector associated with **LIN**. Entering an invalid designator results in a report with no data, or with zeroes.
Specifying Data Source

The default data source for request commands is the Traffic Database (TDB). Because the TDB is the default, you cannot specify the TDB as the data source in a request command. If you want a different source of data, you can specify one of the following.

- OAG allows you to specify that the report use only schedule data as the data source.
- BASE allows you to show the flight count report based on baseline sectors rather than current sectors.
- FCATA allows you to show the flight count or flight list report based on the flights predicted to traverse the FEA/FCA.

For more information on these data sources, see Appendix A, page A-2.

If you wish your reports to come from Hubsite data rather than your own local server, specify HUBSITE or HUB in your requests.

Request List Options

Time Period

The time period option allows you to change the date and/or the time span for the report data. By default, the report covers a time period of five hours beginning at the current time on the current day. If you use this option with other command options, you must place it first (immediately after the airport) in the command line. For more information about using dates and times, see Appendix A, page A-8.

Filter

The default flight counts report covers all flights going to and from the location you indicate. However you can filter the information to reflect only specific flights you want included in the report. There are many options available, and you may use as many as you want for your purposes. For a complete description, see Appendix A, page A-11.
Using Filter Option

This following sample report retains the default data, but filters information for only United Airline flights going to and from Los Angeles Airport.

Every

The default flight counts report displays flight data in 15-minute intervals. However, you can use the every option (also known as the time interval option) to specify a different time interval format. For more information, see Appendix A, page A-24.
Columns and Sort Options

The flight list report displays columns of information by default in the following order: **ACID, TYPE, ORIG, ETD, DEST, ETA, ETE, and CENTER**. If you want to override the default format, you can request other columns of information and change the order in which you want them to be displayed. To do this, specify the other columns after the keyword list.

The order in which you list the columns determines the order in which the columns appear on the report. For instance, if you wanted to display a flight list report for Baltimore/Washington International Airport and you wanted columns of information (reading left to right) on the aircraft identifier, aircraft type, combined aircraft/equipment type, equipment type, origin airport, destination airport, and remarks data, your command would look like this:

![Example Command Line](image)

By default, the list of flights appears in chronological order under **ETA** (for arrivals) and **ETD** (for departures) for each 15-minute interval. You can specify that the list be ordered under a different category by using the sort option. The items under each category are sorted in alphabetical, numerical, or chronological order, according to what is appropriate for that category.

The first item you enter after the word **SORT** determines the primary sort criterion. If you enter a second item, that item becomes the secondary sort within the first criterion, and so on. For example, to show lists of flights for BWI organized first alphabetically according to origin airports, and next alphabetically by airline within the origin category, you would enter this command:

![Example Command Line](image)

The third and subsequent sort criterion would have similar results. The system allows you to sort up to ten levels deep.
You can sort on most of the column options. The Columns and Sort Options table lists all of the column options and specifies which ones are not available as sort options. Generally, each entry represents one column; however, some entries cause two columns to be displayed.

**Note:** The Column and Sort Options table lists all of the available columns and sort options. This table is available in Appendix A on page A-17.

**Using Columns Option**

For this sample the default format has been altered by requesting other column headers. Note that the columns appear left to right in the order they were specified in the following command:
Using Sort Option

By default, the list of flights appears in chronological order under ETA (for arrivals) and ETD (for departures) for each 15-minute interval. You can specify that the list be ordered under a different category by using the sort option. The items under each category are sorted in alphabetical, numerical, or chronological order, according to what is appropriate for that category.

The first item you enter after the word SORT determines the primary sort criterion. If you enter a second item, that item becomes the secondary sort within the first criterion, and so on. For example, to show lists of flights for BWI organized first alphabetically according to origin airports, and next alphabetically by airline within the origin category, you would enter this command:

```
REQ BWI LIST SORT ORIG ARL
```

The third and subsequent sort criteria would have similar results. The system allows you to sort up to ten levels deep. You can sort on most of the column options. See the Columns and Sort Options in Appendix A on page A-17 for a chart which lists all of the column options and specifies which ones are not available as sort options. In the following sample the default columns are used, but the flights are sorted alphabetically by the airport of origin within each default time interval.
Displaying the Reports

Immediately after you issue the command, you receive a confirmation message indicating that the request has been sent. At this time you may continue to use other TSD functions. After a short time, the program emits a beep and displays a dialog box like the following.

Click Display to see the report.

Reading the Reports

The flight list report separates report information into arrivals and departures. Arrivals are listed at the top, and departures are listed below. Scroll down if necessary, to view all of the data. The header echoes the request you typed in, followed by the day of the month, and the user-defined time stamp. The report groups flight data in 15-minute intervals (UTC) beginning at the current time. The number next to each time indicates the flight count for that interval. The columns of data for each flight are as follows:

- **ACID** The unique alphanumeric aircraft identifier (AAL101, for example).
- **TYPE** The flight's aircraft type (DC10 or B727, for example).
- **ORIG** The FAA designator showing the origin airport. If you are reviewing the departure portion of the report, this column should be the original airport name (DFW, for example).
• **ETD**  Estimated time of departure, based on best available time from among the other departure time types.

  A prefix is used to indicate the source of the data that is used to set the ETD; the user can judge the reliability of the data partly on the basis of the prefix, explained below.

  - **S** - Scheduled. TFMS has received no flight plan. Data is based on the OAG and/or user-provided schedule updates.
  - **N** - Early Intent. TFMS has received a user-provided early intent route.
  - **P** - Proposed. TFMS has received a NAS flight plan.
  - **T** - Taxi. TFMS has received a message indicating the flight has pushed off the gate.
  - **A** - Active. TFMS has received a NAS or user-provided departure message.
  - **E** - Estimated. TFMS has received a message indicating the flight was active, but no departure message was received.
  - **R** - The historical route has been replaced by the assigned route.

• **CTD**  Stands for controlled time of departure. Formerly CGTD.

• **DEST**  The FAA designator showing the destination airport. If you are reviewing the arrival portion of the report, this column should be the original airport name (DFW, for example).

• **ETA**  The estimated time of arrival based on the best available time data.

  The ETA is marked with one of the following prefixes to indicate whether the flight has actually arrived:

  - **A**  Actual arrival time (completed flight)
  - **E**  Estimated arrival time (proposed or active flight)

• **ETE**  The estimated time en route, expressed in minutes.

• **DCENTR or ACENTR**  In the arrival section, the FAA designator showing the departure ARTCC. In the departure section, the FAA designator showing the arrival ARTCC.

• **BEACON**  Beacon code. A four-digit transponder code assigned to an aircraft by a NAS center.

**Secondary Requests**

Secondary requests allow you to use the report name to quickly request additional reports with different specifications for the same location specified in the original report. This feature is very useful when you need detailed information for a specific airport.

Secondary requests can be made from any original report except for arrival delay prediction (ARRD) reports. However, to make a secondary request, you must use the
Request Count, Request List, or Request Lists command. (The resulting secondary report will be either a flight counts or flight list report.) For information about using secondary requests see Appendix A, page A-25.

Related Commands
The following is a list of other flight report commands available through the TSD:

- **Request Area**
  Lists flight counts for sectors.

- **Request ARRD**
  Helps to assess potential traffic congestion by predicting arrival delay.

- **Request Count**
  Lists flight counts for an airport, fix, sector, or ARTCC.

- **Request FIXL**
  Lists flight counts for an arrival fix or for all arrival fixes for an airport.

- **Request LIFP**
  Lists flight plans for specified flights.

- **Request VT**
  Compares actual arrival/departure times with a specified time type.
Request Listo

The Request Listo (List Original times) command produces a flight list report exactly like the one produced with the Request List command, except that the Estimated Time of Arrival (ETA) and the Estimated Time of Departure (ETD) are modified under certain conditions. If a flight is not active and is controlled by a ground delay program, the flight list report reverts to the original arrival and departure times. (Under the same conditions, the Request List command would show the controlled times). You may use the report data for creating a ground delay program, in which case you want to be certain that updated arrival and departure time calculations are not based on any previously existing controlled times. You can also use the Request List and Request Listo commands together to compare or verify data.

Command Line Interface

Press ; and enter your command using the following syntax:

For example:  
REQ A DCA 4/12 1200 2200 LISTO ORIG ETE SORT ORIG  
Press <Enter>.

About the Listo Command Syntax

The syntax and options for this command work exactly the same as the syntax and options for the Request List command, except that you type LISTO instead of LIST. For complete information see Request List.

Displaying the Reports

The sample report on the following page was generated using the following command:
Immediately after you issue the command, you receive a confirmation message indicating that the request has been sent. At this time you may continue to use other TSD functions. After a short time, the program emits a beep and displays a dialog box like the following.

Click **Display** to see the report.

**Reading the Reports**

The flight listo report separates report information into arrivals and departures. Arrivals are listed first, and departures are listed second. Scroll down if necessary to view all of the data. The header echoes the request you typed, followed by the day of the month, and the five-hour time stamp. The format is exactly like the report produced by **Request List** except for variations on two of the columns. For information about the other columns, see the **Request List** command.

**Note:** For **Request Listo** only, if the flight is not active and is controlled by a ground delay program, the ETD does not show the controlled time of departure (CGTD), but reverts to the original time of departure based on PGTD or SGTD.

- **ETD** Estimated time of departure, based on best available time from among the other departure time types.

A prefix is used to indicate the source of the data that is used to set the ETD; the user can judge the reliability of the data partly on the basis of the prefix, explained below.
- S - Scheduled. TFMS has received no flight plan. Data is based on the OAG and/or user-provided schedule updates.
- N - Early Intent. TFMS has received a user-provided early intent route.
- P - Proposed. TFMS has received a NAS flight plan.
- T - Taxi. TFMS has received a message indicating the flight has pushed off the gate.
- A - Active. TFMS has received a NAS or user-provided departure message.
- E - Estimated. TFMS has received a message indicating the flight was active, but no departure message was received.
- R - The historical route has been replaced by the assigned route.

- **CTD** Stands for controlled time of departure. Formerly CGTD.
- **ETA** The estimated time of arrival based on either the Actual time of arrival (A) or the best available estimated arrival time (E). The ETA is marked with either of these prefixes to indicate which data the estimate is based on.

### Secondary Requests

Secondary requests allow you to use the report name to quickly request additional reports with different specifications for the same location specified in the original report. This feature is very useful when you need detailed information for a specific airport.

Secondary requests can be made from any original report except for arrival delay prediction (ARRD) reports. However, to make a secondary request, you must use the *Request Count*, *Request List*, or *Request Listo* command. (The resulting secondary report will be either a flight counts or flight list report.) For information about using secondary requests see Appendix A, page A-25.

### Related Commands

- **Request Area**
  Lists flight counts for sectors.

- **Request ARRD**
  Helps to assess potential traffic congestion by predicting arrival delay.

- **Request Count**
  Lists flight counts for an airport, fix, sector, or ARTCC.

- **Request FIXL**
  Lists flight counts for an arrival fix or for all arrival fixes for an airport.

- **Request LIFP**
  Lists flight plans for specified flights.

- **Request VT**
  Compares actual arrival/departure times with a specified time type.
Specifying the Time Type

To issue the Request VT command you must use one of four time types. The time type you select will always be compared to actual departure and arrival times in the report. Always enter VT before the time type designator, as shown in the table below.

**VT Time types**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>ST</td>
<td>Scheduled departure and arrival times, from the airline schedule.</td>
<td>REQ VT ST DFW</td>
</tr>
<tr>
<td>PT</td>
<td>Proposed departure and arrival times, from individual flight plans.</td>
<td>REQ VT PT DCA</td>
</tr>
<tr>
<td>OT</td>
<td>Original departure and arrival times, as defined by TFMS traffic model processing, without regard to ground delay controls or actual times.</td>
<td>REQ VT OT DFW</td>
</tr>
<tr>
<td>CT</td>
<td>Controlled departure and arrival times, assigned to each flight by a ground delay program.</td>
<td>REQ VT CT ORD</td>
</tr>
</tbody>
</table>
Specifying the Data Source

The default data source for request commands is the Traffic Database (TDB). Because the TDB is the default, you cannot specify the TDB as the data source in a request command. If you want a different source of data, you can specify one. The OAG data source lets you specify that the report use only schedule data. See Appendix A, page A-2, for more information.

If you wish your reports to come from Hubsite data rather than your own local server, specify HUBSITE or HUB in your requests.

Specifying Arrivals or Departures

Enter A or D to limit the report to arrivals or departures, respectively. If you do not enter A or D, the report will include both.

Note: If you specify both a primary and a secondary place of interest in your location designator (see the next section), the A or D refers to arrivals or departures at the primary place of interest.

Specifying the Location

To specify the location for a Request VT command you must at least include a Primary Place of Interest (PPI). This may be the FAA designator for an airport or ARTCC. (You may not specify a fix or sector for this command.) You may enter multiple PPIs enclosed in brackets or you may add one or more Secondary Places of Interest (SPI) enclosed in a second pair of brackets. If you include an SPI, the report will be limited to flights traveling between any PPI and any SPI. You may also exclude locations from either category by using a minus sign.

The following table describes the various methods you may use to designate airports or ARTCCs. This table does not show all PPI/SPI combinations; for more information, see Appendix A, page A-6.
Location Designators

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
<th>What you do</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Airport and ARTCC</td>
<td>Flights going to and from one element (one PPI).</td>
<td>Enter the FAA designator.</td>
<td>REQ VT PT DFW</td>
</tr>
<tr>
<td></td>
<td>Flights going to and from more than one element (more than one PPI).</td>
<td>Enter each FAA designator, all within brackets or parentheses.</td>
<td>REQ VT PT [BWI DCA]</td>
</tr>
<tr>
<td></td>
<td>Flights between a primary element and selected others (flights between a PPI and SPIs).</td>
<td>Enter the primary FAA designator, followed by the secondary FAA designator (within brackets if more than one).</td>
<td>REQ VT PT ZBW [DFW ATL]</td>
</tr>
<tr>
<td></td>
<td>Flights between a primary element and anywhere except selected others (exclusions from the SPI).</td>
<td>Enter the primary FAA designator, and the secondary elements, each preceded by a minus sign (within brackets if more than one).</td>
<td>REQ VT PT JFK - DFW</td>
</tr>
</tbody>
</table>

Time Period

The time period option allows you to change the date and/or the time span for the report data. By default, the report covers a time period of five hours beginning at the current time on the current day. For more information about using dates and times, see Appendix A, page A-8.

Filter

The default flight counts report covers all flights going to and from the location you indicate. However you can filter the information to reflect only specific flights you want included in the report. There are many options available, and you may use as many as you want for your purposes. For a complete description, see Appendix A, page A-11.

Other Options

There are a number of options available to format your time verification report, as described below.

Every

The every (or time interval) option allows you to change the default 15-minute display interval. For more information see Appendix A, page A-24.
List and vtstats

These options allow you to specify whether the report will include the list portion or the summary statistics portion. (If you do not specify List or VTstats, the report will include both.) For example, if you wanted to see only the list section of a time verification report on Logan International Airport comparing actual to proposed time, your command line would look like this:

```
REQ VT PT BOS LIST
```

If you wanted only the vtstats section of a time verification report on Logan International Airport comparing actual to proposed time, your command line would look like this:

```
REQ VT PT BOS LIST VTSTATS
```

Columns

You can use the columns option to specify column headings that are different from those that appear in the default list section, using the same column headings that you can use with the Request List command. This option can be used only if you specify List. The order in which you list the columns after entering List determines the order in which the columns will appear on the report. If you use this option, only the columns you specify will appear. Appendix A contains a complete list of the columns and sort options.

Note: The only time that you should use the columns option with the Request VT report is if you want to customize the column headings in the list section and you want a statistics section. To do so, add the word vtstats to the end of your request. If you just want the list section with customized column headings, you can generate such a report more easily with the Request List command.

Sort

You can use the sort option to display flight data in numerical or alphabetical order within any column you designate. This option is available only if you specify the list option. Appendix A contains a complete list of the columns and sort options on page A-17.
Displaying the Reports

The next report is a sample of the default time verification report format. This report was generated using the Request VT command as shown here:

Immediately after you issue the command, you receive a confirmation message indicating that the request has been sent. At this time you may continue to use other TSD functions. After a short time, the program emits a beep and displays a dialog box like the following.

Click **Display** to see the report, part of which is shown below.
Reading the Reports

The report separates information into arrival and departure information (list section) and arrival and departure statistics tables (vtstats section). The example above shows the list portion. Departure data may not be immediately visible; simply scroll down past the end of the arrival data to review the departure data. Data is divided into 15-minute time intervals. The report header reflects the request you typed on the command line, followed by the day of the month, and the time the report begins.

The columns on the report depend on which time type you selected and whether you are looking at arrivals or departures. The following list describes each of the columns that may appear.

- **DCENTR or ACENTR**
  The departure ARTCC (for arrivals) or the arrival ARTCC (for arrivals).

- **DCENTR or ACENTR**
  The departure ARTCC (for arrivals) or the arrival ARTCC (for departures).

- **ORIG**
  The FAA designator showing the origin airport.

- **DEST**
  The FAA designator showing the destination airport.

- **ACID**
  The unique alphanumeric aircraft identifier (AAL101, for example).

- **SGTD, PGTD, OGTD, or CGTD**
  The scheduled, proposed, original, or controlled gate time of departure, depending on the time type you selected.

- **AGTD**
  The actual gate time of departure.

- **SD_DIF, PD_DIF, OD_DIF, or CD_DIF**
  The discrepancy between the actual gate time of departure and the departure time predicted by your time type selection, along with a designator showing the status of the comparison. For example, if you indicated CT on the command line, this column would show the results of AGTD minus CGTD.

- **SGTA, PGTA, OGTA, or CGTA**
  The scheduled, proposed, original, or controlled gate time of arrival, depending on the time type you selected.

- **AGTA**
  The actual gate time of arrival.

- **SA_DIF, PA_DIF, OA_DIF, or CA_DIF**
  The discrepancy between the actual gate time of arrival and the arrival time predicted by your time type selection, along with a designator showing the status of the comparison. For example, if you indicated CT on the command line, this column would show the results of AGTA minus CGTA.
The following designators appear after the _DIF columns to show the status of each time comparison:

- **EARLY** Arrived or departed more than five minutes prior to predicted time.
- **ON TIME** Arrived or departed between five minutes prior to and 15 minutes after predicted time.
- **LATE** Arrived or departed more than 15 minutes later than predicted time.
- **BLANK** No comparison could be made because one or both of the times used for comparison were not available.

The second part of the report displays summary statistics regarding the number of early, on-time, and late departures and arrivals, as in the following illustration.

![Summary Statistics Table](image)

The first of up to four summary statistics tables appears at the end of each time verification report.

Each table provides statistics on one of the following.

- Arrival times for arriving flights
- Departure times for arriving flights
- Arrival times for departing flights
- Departure times for departing flights

If you specify arrivals or departures only, the report includes only the first two or last two tables on this list, respectively. If you do not specify arrivals or departures only, the report includes all four tables.
Secondary Requests

Secondary requests allow you to use the report name to quickly request additional reports with different specifications for the same location specified in the original report. This feature is very useful when you need detailed information for a specific airport.

Secondary requests can be made from any original report except for Arrival Delay Prediction (ARRD) reports. However, to make a secondary request, you must use the Request Count, Request List, or Request Listo command. (The resulting secondary report will be either a flight counts or flight list report.) For information about using secondary requests see Appendix A, page A-25.

Related Commands

The following is a list of other flight report commands available through the TSD:

- **Request Area**  
  Lists flight counts for sectors.

- **Request ARRD**  
  Helps to assess potential traffic congestion by predicting arrival delay.

- **Request Count**  
  Lists flight counts for an airport, fix, sector, or ARTCC.

- **Request FIXL**  
  Lists flight counts for an arrival fix or for all arrival fixes for an airport.

- **Request LIFP**  
  Lists flight plans for specified flights.

- **Request List(o)**  
  Lists flight info for an airport, fix, sector, or ARTCC.
Preview the Restore Command

You can preview the restoring of flights. When you enter the **Restore Preview** command, a list is displayed showing the flights that would be restored if you issued a real Restore command. You issue a Preview Restore command in the same way that you would enter any Restore commands using the keywords explained on the following pages. The difference is that you enter the word **Preview** after the word **Restore**.

For example: **REST PREVIEW AIRL:COM DAT:0703 ORI:BOS**
# Restore Command Keywords

The following table explains the keywords used when issuing the Restore command. Each keyword must be followed by a colon (:). There should be no space before or after the colon. Date is required and must be entered in every Restore command.

## Restore Keywords

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIRLINE</td>
<td>Three-letter airline code. Either Airline or Flight is required, but not both. Airline can be abbreviated AIRL.</td>
<td>Restore all flights for an airline: REST Airl:Com Dat:0705</td>
</tr>
<tr>
<td>FLIGHT</td>
<td>A full flight call sign. Either Airline or Flight is required. Flight can be abbreviated as FLI. Can have a single value, a range of values, or a list of values. Items within a list of values must be separated by a space.</td>
<td>Restore single flight: REST FlI:Aal123 Dat:0705 Restore all flights in a range of flights: REST FlI:[Arn 8000-Arn8999] Dat:0705 Restore a list of flights: REST FlI:[Aal123 Aal214] Dat:0705</td>
</tr>
<tr>
<td>DATE</td>
<td>A four-digit month/day in mmdd format. This is a required value. Date can be abbreviated DAT. Can have a single value, a range of values, or a list of values. Items within a list of values must be separated by a space. You can also enter ALL in this field to indicate all dates.</td>
<td>Restore flight on a single date: REST FlI:Aal123 Dat:0705 Restore flight for a range of dates: REST FlI:Aal123 Dat:[0705-0708] Restore flight for a list of dates: REST FlI:Aal123 Dat:[0905 0908 0909] Restore flight for all dates: REST FlI:Aal123 Dat:ALL</td>
</tr>
<tr>
<td>AIRPORT</td>
<td>A three- or four- character airport code. Optional entry. The absence of an airport entry indicates all airports. Abbreviated AIRP.</td>
<td>Restore flight operating in or out of multiple airports: REST FlI:Blr999 Dat:0705 Airp:[Bos Jfk Dca] Restore flight operating in or out of a specific airport: REST FlI:Blr999 Dat:0705 Airp:Bos</td>
</tr>
</tbody>
</table>
### Restore Keywords (Continued)

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
</table>
| ORIG    | A three or four-character airport code. Optional. Abbreviated ORI. Can have a single value or a list of values. Items within a list of values must be separated by a space. The absence of an airport entry indicates all airports. Cannot be specified with AIRPORT. | Restore a single leg of a flight from a single origin:  
REST FLI:COM1379 DAT:0705 ORI:BOS  |
| DEST    | A three or four-character airport code. Optional. Abbreviated DES. Can have a single value or a list of values. Items within a list of values must be separated by a space. The absence of an airport entry indicates all airports. Cannot be specified with AIRPORT. | Restore a single leg of a flight from a single destination:  
REST FLT:COM1379 DAT:0705 DES:JFK  |

You can enter up to 20 values in a list of values.

### Confirmation Message

After you issue the Restore command, the system checks the command format and if the format is correct and the site from which you issued the command is authorized to perform a restore, you will see a message showing you which flights have been restored. Otherwise, you will receive an error message.
### Restore Colors

The **Restore Colors** command is used to invoke any set of color and font specifications you have previously saved using the **Save Colors** command.

### Command Line Interface

Press `;` and enter your command using the following syntax:

```
restore_colors filename
```

**Note:** You can also enter the command `RC`.

Press `<Enter>`.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Display menu by clicking <strong>Display</strong> on the main menu or pressing <code>&lt;Alt&gt;</code> D.</td>
<td>None</td>
</tr>
<tr>
<td>2. Click <strong>Adapt</strong> or press A.</td>
<td></td>
</tr>
<tr>
<td>3. Click <strong>Recall</strong> or press R.</td>
<td></td>
</tr>
</tbody>
</table>

### Restore Colors Prompts Dialog Box

If you enter the command with no parameters, the Restore Colors Prompts dialog box opens.

Enter the file name of the color and font set that you want to restore. You may enter the full pathname of the file; otherwise the TSD will retrieve the file from the standard location, which is `/ETMS/tsd/adapt/adapt_resources`.

You may also enter the complete command on one line.
Runway Layout

The Runway Layout command displays an enlarged map of the runways for an airport you specify, as well as the airport’s official name and location. If a certain airport’s runway layout is unavailable to the TSD, only the official airport name and location appear. To remove the map from the screen, click Close.

Command Line Interface

Press ; and enter your command using the following syntax:

(*Indicates optional entry)
For example: RWY DCA
Press <Enter>.

Menu Method | Quick Key Method
---|---
1. Pull down the Maps menu by clicking Maps on the main menu or pressing <Alt> M.
2. Click Runway Layout or press W. | None

Runway Layout Dialog Box

If you enter the command with no parameters, the Runway Layout dialog box opens Runways command. See Runway Layout command. Enter the airport name, as in the following example.

About the Display

After issuing the Runway Layout command, you see a diagram that shows runways displayed against a green background. The runways are labeled and color-coded. They are numbered in relation to their magnetic direction, rounded to the nearest 10 degrees. The labels include standard designations for parallel runways: L (left), C (center), and R.
(right). The color indicates the material from which the runways are built. For example, if you displayed the runways for DCA in Washington, they would show as black, indicating asphalt.

Runways are displayed against a green background. The runways are labeled and color-coded. They are numbered in relation to their magnetic direction, rounded to the nearest 10 degrees. The labels include standard designations for parallel runways: L (left), C (center), and R (right).

When you click **Legend** in the Runway Layout Display, you see the Runway Layout dialog box, which shows the colors and the materials they symbolize.

**Note:** The pale green color that represents concrete may appear to be white against the bright green background. True white (which appears
brighter) is used only for runways constructed on snow (not merely snow-covered).
RVR Report

The RVR Report command lets you display and print Runway Visual Range information. You can generate an RVR report for any airport you specify.

Command Line Interface

Press `;` and enter your command using the following syntax:

```
RVR airport
```

Press <Enter>.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
</table>
| 1. Pull down the Weather menu by clicking **Weather** on the main menu or pressing <Alt> W.  
2. Click **RVR Report** or press V. | None |

RVR Prompts Dialog Box

If you enter the command with no parameters, the RVR Prompts dialog box is displayed.

Enter a three- or four-character location identifier and click **OK** or **Apply**.
Resulting Display
The TSD displays the RVR report, which looks like the following sample.

![RVR Report](image)

The following table describes the columns in the report.

<table>
<thead>
<tr>
<th>Column Header</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RWY</td>
<td>Runway identifier. Numeric values from 01 through 36. A sub-runway value might be appended to the RWY. The sub-runways are defined as L (left), R (right), or C (center). A blank in this field indicates there is no sub-identifier.</td>
</tr>
<tr>
<td>TD MP RO</td>
<td>Runway Visual Range at the touchdown, middle and rollout points. Values range from 0000 to 6000, representing feet. A trend indicator is displayed directly to the right of each displayed RVR value to indicate the trend of the RVR value over the previous five-minute window. A plus sign [+] indicates an increasing trend, a minus sign [-] indicates a decreasing trend and a steady trend is indicated by the absence of an indicator. A blank value indicates that no RVR system visibility sensor is needed for that precision point on the runway based on the instrumentation and landing category of that runway. A value of FFF indicates that a corresponding RVR sensor is off-line or data is invalid.</td>
</tr>
<tr>
<td>E</td>
<td>Runway Edge Light Setting. Values range from 0 (off) to 5 (maximum intensity), or F (sensor is off-line or data is invalid).</td>
</tr>
<tr>
<td>C</td>
<td>Runway Centerline Light Setting. Values range from 0 (off) to 5 (maximum intensity), blank (no centerlines are configured for the runway), or F (sensor is off-line or data is invalid).</td>
</tr>
</tbody>
</table>

**Note:** If data is not currently being received for an airport, the message “Data Not Available” is displayed.
Semicolon Commands: S-Z

Save Colors

The Save Colors command is used to store any color and font specifications you have made using the Background Color or Change Colors and Fonts commands. The Save Colors command prompts you to name the color set filename, so that you may use these same specifications later by issuing the Restore Colors command.

Command Line Interface

Press ; and enter your command using the following syntax:

Note: You can also enter the command as SAVC.

Press <Enter>.

Menu Method | Quick Key Method
---|---
1. Pull down the Display menu by clicking Display on the main menu or pressing <Alt> D.
2. Click Adapt or press A.
3. Click Save or press S. | None

Save Colors Prompts Dialog Box

If you enter the command with no parameters, the Colors Prompts dialog box opens.

Enter the filename in which to save the color and fonts specifications. You may enter the full pathname of the file; otherwise the TSD will save the file in the standard location, which is /ETMS/tds/adapt/adapt resources. You may also enter the complete command on one line.
Script

The **Script** command lets you automate the execution of a series of semicolon and quick key commands by placing them in a script file, which the system can execute. Issuing the **Script** command causes the TSD to sequentially execute the commands contained in the script file you specify.

### Command Line Interface

Press `;` and enter your command using the following syntax:

```
Note: You can also enter the command as SCR or S.
```

Press `<Enter>`.

### Menu Method

1. Pull down the Tools menu by clicking **Tools** on the main menu or pressing `<Alt> T`.

2. Click **Script** or press `S`.

### Quick Key Method

None

### Script Prompts Dialog Box

If you enter the command with no parameters, the Script dialog box opens.

If your script file is not located in the `/ETMS/tsd/data/scripts` directory, you must enter the full pathname of the script file you wish to execute in the Pathname field. For example, if you wish to run the script file *myscript*, located in the `/ETMS/mydir` directory, type `/ETMS/mydir/myscript`. Click **OK** or press `<Enter>` to execute the script file.

If your script file is located in the `/ETMS/tsd/data/scripts` directory, you may enter only the filename.
The Select Alerts command is used to limit the display of alerted elements to a group or groups you choose. By clicking buttons in the dialog box, you can choose to display sectors, fixes, and airports.

### Command Line Interface
Press `;` and enter your command using the following syntax:

```
SELECT ALERTS or SA
```

Press `<Enter>`.

### Menu Method
1. Pull down the Alerts Menu by clicking Alerts on the main menu or pressing `<Alt>` A.
2. Click Select Alerts or press `S`.

### Quick Key Method
None

### Select Alerts for Display Dialog Box
After you issue the Select Alerts command, the Select Alerts for Display dialog box opens.

![Select Alerts for Display Dialog Box](image)
For each item in the dialog box, click one of the following buttons:

### Select Alerts

<table>
<thead>
<tr>
<th>Item</th>
<th>What you do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Airports</td>
<td>Click All to display all alerted airports.</td>
</tr>
<tr>
<td>Sectors: Low, High, Superhigh</td>
<td>Click Low, High, Superhigh, or a combination to specify which type of alerted sectors you want to display. No sectors are selected by default.</td>
</tr>
<tr>
<td>Fixes: Low, High, Superhigh</td>
<td>Click Low, High, Superhigh, or a combination to specify which type of alerted fixes you want to display and click OK. No fixes are selected by default.</td>
</tr>
<tr>
<td>RVSM</td>
<td>Click the button to display RVSM alerts.</td>
</tr>
<tr>
<td>Time Limit</td>
<td>Enter the hours directly, or click the up or down arrows to increase or decrease hours. The maximum time limit is 2:25.</td>
</tr>
</tbody>
</table>

**Command Result**

After you click the desired buttons and click **OK** or **Apply**, only those alerted elements you selected are highlighted.

**Note:** No alerted elements are visible unless you have issued the Show Alerts command.

**Related Commands**

Use the **Examine Alerts** command to display traffic demand information for an airport, fix, or sector. You can receive other types of supplementary information after examining an element.
Select Arrivals

The Select Arrivals command allows you to restrict the display to a subset of incoming flights and to choose a flight icon color for that subset. This command automatically turns Show Flights on if flights were hidden. To restore the display of all flights, use the Select Flights and Color command.

Command Line Interface

Press `;` and enter your command using the following syntax:

(*indicates optional entries)
For example: **ARR YELLOW ATL MEM ZDC**
Press `<Enter>.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Flights menu by clicking <strong>Flights</strong> on the main menu or</td>
<td>None</td>
</tr>
<tr>
<td>pressing <code>&lt;Alt&gt; F</code>.</td>
<td></td>
</tr>
<tr>
<td>2. Click <strong>Select Flights</strong> or press <strong>S</strong>.</td>
<td></td>
</tr>
</tbody>
</table>
Select Arrivals Dialog Box

If you enter the ARR command with no parameters, the Select Arrivals dialog box opens. You may also enter the complete command on one line. Be sure to include a space between each item.
Select a Flight Set Color and Icon

The dialog box allows you to accept the default flight set color or change it by clicking the color button to display a color palette.

Click in the box containing your choice of color for the flight set.

The ICON field in the Select Arrivals dialog box allows you to choose to display the flight set as a dot, airplane, or automatic icon.

About the Display

At the bottom of the dialog box you can choose to display only your specified flight set or add that flight set to the flights currently on the TSD. In the first instance only the flight set you specified is displayed on the TSD, in the color you chose. In the second instance all flights are displayed, with your specified flight set distinguished from the others by color and/or icon type.

Related Commands

The following related commands also automatically turn on Show Flights, even if they are currently hidden.

- Select Departures
- Select Arrivals and Departures
- Select Flight Group Color

The following related commands require that Show Flights be turned on to see the changes.

- Select Data Blocks
- Select Flights
- Select Flights and Color
Select Arrivals & Departures

The Select Arrivals and Departures command combines the effects of the Select Arrivals and Select Departures commands. It allows you to restrict the display to subsets of incoming and outgoing flights for a selected airport or group of airports and to choose a flight icon color for each subset of flights. The command automatically turns Show Flights on if flights were not already displayed.

Command Line Interface

Press ; and enter your command using the following syntax:

```
AD arrival color" departure color" airport(s)" ARTCC(s)"
```

(*Indicates optional entries)
For example:  
```
AD CYAN DULL BLUE ORD LAX DFW
```
Press <Enter>.

Menu Method

1. Pull down the Flights menu by clicking Flights on the main menu or pressing <Alt> F.
2. Click Select Flights or press S.

Quick Key Method

None
Select Arrivals and Departures Dialog Box
If you enter the AD command with no parameters, the Select Arrivals and Departures dialog box opens. You may also enter the complete command on one line. Be sure to include a space between each item.
Select a Flight Set Color and Icon

The dialog box allows you to accept the default flight set colors for both arrival and departure flights or change them by clicking the Color for arrivals or Color for departures buttons to display a color palette. Click in the box containing your choice of color for the flight sets.

![Color Selector](image)

The ICON field in the Select Arrivals and Departures dialog box allows you to choose to display the flight set as dot, airplane, or automatic icons.

About the Display

At the bottom of the dialog box you can choose to display only your specified flight set or add that flight set to the flights currently on the TSD. In the first instance only the flight set you specified is displayed on the TSD, in the color you chose. In the second instance all flights are displayed, with your specified flight set distinguished from the others by color and/or icon type.

Related Commands

The following commands also automatically turn on Show Flights, even if they are currently hidden.

- Select Arrivals
- Select Departures
- Select Flight Group Color

The following related commands require that Show Flights be turned on to see the changes.

- Select Data Blocks
- Select Flights
- Select Flights and Color
Select Data Blocks

The Select Data Blocks command displays data blocks for a group of flights you select. In order to see the results of this command, Show Flights must be ON.

Command Line Interface

Press ; and enter your command using the following syntax:

Press <Enter>

Menu Method | Quick Key Method
--- | ---
1. Pull down the Flights menu by clicking Flights on the main menu or pressing <Alt> F. | None
2. Click Select Flights or press S. | None
Select Data Block Prompts Dialog Box

After issuing the command, the following dialog box opens, with text fields asking for specific information. These fields are described in the table in this command section.
Select a Flight Set Color and Icon

The dialog box allows you to accept the default flight set color or change it by clicking the Color button to display a color palette. Click in the box containing your choice of color for the flight set.

Multiple Entries

If you make entries in more than one field, be aware that flights must logically satisfy at least one item in each field in order to be selected. For example, if you enter ORD at Destination(s), and enter J80 and J56 at Airway(s) used, flights are selected only if they use either airway you selected and are traveling to ORD. Flights traveling to ORD by any other routes would not be included.

Select Data Blocks

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What you do</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Departure point(s):</td>
<td>Limits the selection to flights departing from any listed airport or from any airport within listed ARTCCs.</td>
<td>Enter one or more airport designators, or one or more ARTCC designators, separated by a space. UNKW for unknown departure points.</td>
<td>JFK LGA UNKW</td>
</tr>
<tr>
<td>Destination(s):</td>
<td>Limits the selection to flights traveling to any listed airport or to any airport within listed ARTCCs.</td>
<td>Enter one or more airport designators, or one or more ARTCC designators, separated by a space. UNKW for unknown destination points.</td>
<td>ZLA UNKW</td>
</tr>
<tr>
<td>Airline(s):</td>
<td>Limits the selection to flights of any listed airline.</td>
<td>Enter one or more airline designators, separated by a space.</td>
<td>DAL</td>
</tr>
<tr>
<td>Fix(es) enroute:</td>
<td>Limits the selection to flights traversing any listed fix.</td>
<td>Enter one or more fix designators, separated by a space.</td>
<td>BUCKS VCN</td>
</tr>
</tbody>
</table>
Select Data Blocks (Continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What you do</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sector(s) traversed:</td>
<td>Limits the selection to flights traversing any listed sector.</td>
<td>Enter one or more sector designators, separated by a space.</td>
<td>ZNY 10</td>
</tr>
<tr>
<td>ARTCC(s) traversed:</td>
<td>Limits the selection to flights traversing any listed ARTCC.</td>
<td>Enter one or more ARTCC designators, separated by a space.</td>
<td>ZNY ZBW</td>
</tr>
<tr>
<td>Airway(s) used:</td>
<td>Limits the selection to flights using any listed airway.</td>
<td>Enter one or more airway designators, separated by a space.</td>
<td>J80</td>
</tr>
<tr>
<td>Aircraft type(s)/ac_rmks:</td>
<td>Limits the selection to flights with specific types of aircraft, equipment, and remarks keyword.</td>
<td>Enter one or more specific aircraft types, equipment prefix and suffix data, and remarks keywords.</td>
<td>See Appendix A for a complete list of possible aircraft and equipment types and remarks keywords.</td>
</tr>
<tr>
<td>Lowest flight level:</td>
<td>Limits the selection to flights with current filed, reported, or both filed and reported altitudes at or above a specified altitude.</td>
<td>Specify flight’s altitude as F (Filed), R (Reported), or B (Both filed and reported). Enter altitude in hundreds of feet. *</td>
<td>F200 R250 B250</td>
</tr>
<tr>
<td>Highest flight level:</td>
<td>Limits the selection to flights with current filed, reported, or both filed and reported altitudes at or below a specified altitude.</td>
<td>Specify flight’s altitude as F (Filed), R (Reported), or B (Both filed and reported). Enter altitude in hundreds of feet. *</td>
<td>F350 R375 B375</td>
</tr>
</tbody>
</table>

* Note: Not specifying F, R, or B as a flight’s altitude defaults the altitude to R (Reported). |

About the Display

At the bottom of the dialog box you can choose the icon to be used to display this flight set. You can also choose to display only your specified flight set with its data blocks or add that flight set to the flights currently on the TSD. In the first instance only the flight set you specified with data blocks is displayed on the TSD. In the second instance all flights are displayed, with data blocks only for the group of flights you specified. The other flights will not have data blocks associated with them.
Select Departures

The **Select Departures** command allows you to restrict the display to a subset of outgoing flights and to choose a flight icon color for that subset. This command automatically turns **Show Flights** on if flights were not already displayed.

### Command Line Interface

Press `;` and enter your command using the following syntax:

```
(*Indicates optional entries)
For example:    DEP YELLOW ATL MEM BHM BNA
Press <Enter>.
```

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Flights menu by clicking <strong>Flights</strong> on the main menu or pressing <code>&lt;Alt&gt;</code> F.</td>
<td>None</td>
</tr>
<tr>
<td>2. Click <strong>Select Flights</strong> or press S.</td>
<td></td>
</tr>
</tbody>
</table>

**Select Departures Dialog Box**

If you enter the **DEP** command with no parameters, the Select Departures dialog box opens. You may also enter the complete command on one line. Be sure to include a space between each item.
Select a Flight Set Color and Icon

The dialog box allows you to accept the default flight set color or change it by clicking in the Color box to display a color palette. Click in the box containing your choice of color for the flight set.

![Color Selector](image)

About the Display

At the bottom of the dialog box you can choose the icon to be used to display this flight set. You can also choose to display only your specified flight set or add that flight set to the flights currently on the TSD. In the first instance only the flight set you specified is displayed on the TSD, in the color you chose. In the second instance all flights are displayed, with your specified flight set distinguished from the others by color and/or icon type.

Related Commands

The following related commands also automatically turn on Show Flights:

- Select Arrivals
- Select Arrivals and Departures
- Select Flight Group Color

The following related commands require that Show Flights be turned on to see the changes:

- Select Data Blocks
- Select Flights
- Select Flights and Color
Select Flight Group Color

The **Select Flight Group Color** command allows you to restrict the display to a subset of incoming flights and to choose a flight icon color for that subset. This command automatically turns **Show Flights** on if flights were not already displayed.

Command Line Interface

Press ; and enter your command using the following syntax:

For example: **SC YELLOW**

Press <Enter>.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
</table>
| 1. Pull down the Flights menu by clicking **Flights** on the main menu or pressing <Alt> F.  
2. Click **Select Flights** or press S. | None |
Select Color Prompts Dialog Box

If you enter the Select Flight Group Color command with no parameters, the Select Color dialog box opens. You may also enter the complete command on one line. Be sure to include a space between each item.

Select a Flight Set Color and Icon

The dialog box allows you to accept the default flight set color or change it by clicking the Color button to display a color palette. Click in the box containing your choice of color for the flight set.
**Multiple Entries**

If you make entries in more than one field, be aware that flights must logically satisfy each of those fields to be selected. For example, if you enter **ORD** at Destination(s) and enter **J80** and **J56** at Airway(s) used, flights are selected only if they use either airway you selected and are traveling to ORD. Flights traveling to ORD by any other routes are not included.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What you do</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Departure point(s):</td>
<td>Limits the selection to flights departing from any listed airport or from any airport within listed ARTCCs.</td>
<td>Enter one or more airport designators, or one or more ARTCC designators, separated by a space. <strong>UNKW</strong> for unknown departure points.</td>
<td>JFK LGA UNKW</td>
</tr>
<tr>
<td>Destination(s):</td>
<td>Limits the selection to flights traveling to any listed airport or to any airport within listed ARTCCs.</td>
<td>Enter one or more airport designators, or one or more ARTCC designators, separated by a space. <strong>UNKW</strong> for unknown destination points.</td>
<td>ZLA UNKW</td>
</tr>
<tr>
<td>Airline(s):</td>
<td>Limits the selection to flights of any listed airline.</td>
<td>Enter one or more airline designators, separated by a space.</td>
<td>DAL</td>
</tr>
<tr>
<td>Fix(es) enroute:</td>
<td>Limits the selection to flights traversing any listed fix.</td>
<td>Enter one or more fix designators, separated by a space.</td>
<td>BUCKS VCN</td>
</tr>
<tr>
<td>Sector(s) traversed:</td>
<td>Limits the selection to flights traversing any listed sector.</td>
<td>Enter one or more sector designators, separated by a space.</td>
<td>ZNY 10</td>
</tr>
<tr>
<td>ARTCC(s) traversed:</td>
<td>Limits the selection to flights traversing any listed ARTCC.</td>
<td>Enter one or more ARTCC designators, separated by a space.</td>
<td>ZNY ZBW</td>
</tr>
<tr>
<td>Airway(s) used:</td>
<td>Limits the selection to flights using any listed airway.</td>
<td>Enter one or more airway designators, separated by a space.</td>
<td>J80</td>
</tr>
<tr>
<td>Aircraft type(s)/ac_rmks:</td>
<td>Limits the selection to flights with specific types of aircraft, equipment, and remarks keyword.</td>
<td>Enter one or more specific aircraft types, equipment prefix and suffix data, and remarks keywords.</td>
<td>See Appendix A for a complete list of types and keywords.</td>
</tr>
</tbody>
</table>
Select Color

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What you do</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lowest flight</td>
<td>Limits the selection to flights with current filed, reported, or both filed and reported altitudes at or above a specified altitude.</td>
<td>Specify flight’s altitude as F (Filed), R (Reported), or B (Both filed and reported). Enter altitude in hundreds of feet. *</td>
<td>F200, R250, B250</td>
</tr>
<tr>
<td>Highest flight</td>
<td>Limits the selection to flights with current filed, reported, or both filed and reported altitudes at or below a specified altitude.</td>
<td>Specify flight’s altitude as F (Filed), R (Reported), or B (Both filed and reported). Enter altitude in hundreds of feet. *</td>
<td>F350, R375, B375</td>
</tr>
</tbody>
</table>

* Note: Not specifying F, R, or B as a flight’s altitude defaults the altitude to R (Reported).

About the Display

At the bottom of the dialog box you can choose the icon to be used to display this flight set. You can also choose to display only your specified flight set or add that flight set to the flights currently on the TSD. In the first instance only the flight set you specified is displayed on the TSD, in the color you chose. In the second instance all flights are displayed, with your specified flight set distinguished from the others by color and/or icon type.

Related Commands

The following related commands also automatically turn on Show Flights:

- Select Arrivals
- Select Departures
- Select Arrivals and Departures

The following related commands require that Show Flights be turned on to see the changes:

- Select Data Blocks
- Select Flights
- Select Flights and Color
Select Flights

The Select Flights command allows you to limit the appearance of flight icons to a group of flights that you select. After you issue the command, all non-selected flights disappear from the display. In order to see the results of this command, Show Flights must be turned on.

Command Line Interface

Press ; and enter your command using the following syntax:

```
SELECT FLIGHTS or SF
```

Press <Enter>.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Flights menu by clicking Flights on the main menu or pressing &lt;Alt&gt; F.</td>
<td>None</td>
</tr>
<tr>
<td>2. Click Select Flights or press S.</td>
<td></td>
</tr>
</tbody>
</table>
Select Flights Prompts Dialog Box

When you enter the SF command, the Select Flights Prompts dialog box opens. You may also enter the complete command on one line using the table on page 5-204 to guide your entries. Be sure to include a space between each item.

![Select Flights Prompts Dialog Box]

About the Display

At the bottom of the dialog box you can choose the icon to be used to display this flight set. You can also choose to display only your specified flight set with its data blocks or add that flight set to the flights currently on the TSD. In the first instance only the flight set you specified with data blocks is displayed on the TSD. In the second instance all flights are displayed, with data blocks only for the group of flights you specified. The other flights will not have data blocks associated with them.
Select a Flight Set Color and Icon

The dialog box allows you to accept the default flight set color or change it by clicking the **Color** button to display a color palette. Click in the box containing your choice of color for the flight set.

![Color Selector](image)

Multiple Entries

If you make entries in more than one field, be aware that flights must logically satisfy each of those fields to be selected. For example, if you enter **ORD** at Destination(s) and enter **J80** and **J56** at Airway(s) used, flights are selected only if they use either airway you selected and are traveling to ORD. Flights traveling to ORD by any other routes are not included.

**Note:** Aircraft type(s) and AC_Remarks Keywords are located in Appendix A.
Select Flights

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What you do</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Departure point(s):</td>
<td>Limits the selection to flights departing from any listed airport or from any airport within listed ARTCCs.</td>
<td>Enter one or more airport designators, or one or more ARTCC designators, separated by a space. UNKW for unknown departure points.</td>
<td>JFK LGA UNKW</td>
</tr>
<tr>
<td>Destination(s):</td>
<td>Limits the selection to flights traveling to any listed airport or to any airport within listed ARTCCs.</td>
<td>Enter one or more airport designators, or one or more ARTCC designators, separated by a space. UNKW for unknown destination points.</td>
<td>ZLA UNKW</td>
</tr>
<tr>
<td>Airline(s):</td>
<td>Limits the selection to flights of any listed airline.</td>
<td>Enter one or more airline designators, separated by a space.</td>
<td>DAL</td>
</tr>
<tr>
<td>Fix(es) enroute:</td>
<td>Limits the selection to flights traversing any listed fix.</td>
<td>Enter one or more fix designators, separated by a space.</td>
<td>BUCKS VCN</td>
</tr>
<tr>
<td>Sector(s) traversed:</td>
<td>Limits the selection to flights traversing any listed sector.</td>
<td>Enter one or more sector designators, separated by a space.</td>
<td>ZNY10</td>
</tr>
<tr>
<td>ARTCC(s) traversed:</td>
<td>Limits the selection to flights traversing any listed ARTCC.</td>
<td>Enter one or more ARTCC designators, separated by a space.</td>
<td>ZNY ZBW</td>
</tr>
<tr>
<td>Airway(s) used:</td>
<td>Limits the selection to flights using any listed airway.</td>
<td>Enter one or more airway designators, separated by a space.</td>
<td>J80</td>
</tr>
<tr>
<td>Aircraft type(s)/ac_rmks:</td>
<td>Limits the selection to flights with specific types of aircraft, equipment, and remarks keyword.</td>
<td>Enter one or more specific aircraft types, equipment prefix and suffix data, and remarks keywords.</td>
<td>See Appendix A for a complete list of types and keywords.</td>
</tr>
<tr>
<td>Lowest flight level:</td>
<td>Limits the selection to flights with current filed, reported, or both filed and reported altitudes at or above a specified altitude.</td>
<td>Specify flight’s altitude as F (Filed), R (Reported), or B (Both filed and reported). Enter altitude in hundreds of feet. *</td>
<td>F200 R250 B250</td>
</tr>
<tr>
<td>Highest flight level:</td>
<td>Limits the selection to flights with current filed, reported, or both filed and reported altitudes at or below a specified altitude.</td>
<td>Specify flight’s altitude as F (Filed), R (Reported), or B (Both filed and reported). Enter altitude in hundreds of feet. *</td>
<td>F350 R375 B375</td>
</tr>
</tbody>
</table>

* Note: Not specifying F, R, or B as a flight’s altitude defaults the altitude to R (Reported).
Select Flights & Color

The Select Flights and Color command allows you to select a group of flights and to assign an icon color to those flights. After you issue the command, all non-selected flights disappear from the display. In order to see the results of this command, Show Flights must be turned on.

Command Line Interface

Press ; and enter your command using the following syntax:

For example:  
SFC BLUE
Press <Enter>.

Menu Method | Quick Key Method
---|---
1. Pull down the Flights menu by clicking Flights on the main menu or pressing <Alt> F.
2. Click Select Flights or press S. | None
Select Flights and Color Prompts Dialog Box

After issuing the command, the Select Flights and Color dialog box opens, with text fields asking for specific information.
Select a Flight Set Color and Icon

The dialog box allows you to accept the default flight set color or change it by clicking the Color button to display a color palette. Click in the box containing your choice of color for the flight set.

![Color Selector](image)

Multiple Entries

If you make entries in more than one field, be aware that flights must logically satisfy each of those fields to be selected. For example, if you enter **ORD** at Destination(s) and enter **J80** and **J56** at Airway(s) used, flights are selected only if they use either airway you selected and are traveling to ORD. Flights traveling to ORD by any other routes are not included.
## Select Flights and Color

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>What you do</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Departure point(s):</td>
<td>Limits the selection to flights departing from any listed airport or from any airport within listed ARTCCs.</td>
<td>Enter one or more airport designators, or one or more ARTCC designators, separated by a space. <strong>UNKW</strong> for unknown departure points.</td>
<td>JFK LGAUNKW</td>
</tr>
<tr>
<td>Destination(s):</td>
<td>Limits the selection to flights traveling to any listed airport or to any airport within listed ARTCCs.</td>
<td>Enter one or more airport designators, or one or more ARTCC designators, separated by a space. <strong>UNKW</strong> for unknown destination points.</td>
<td>ZLAUNKW</td>
</tr>
<tr>
<td>Airline(s):</td>
<td>Limits the selection to flights of any listed airline.</td>
<td>Enter one or more airline designators, separated by a space.</td>
<td>DAL</td>
</tr>
<tr>
<td>Fix(es) enroute:</td>
<td>Limits the selection to flights traversing any listed fix.</td>
<td>Enter one or more fix designators, separated by a space.</td>
<td>BUCKS VCN</td>
</tr>
<tr>
<td>Sector(s) traversed:</td>
<td>Limits the selection to flights traversing any listed sector.</td>
<td>Enter one or more sector designators, separated by a space.</td>
<td>ZNY10</td>
</tr>
<tr>
<td>ARTCC(s) traversed:</td>
<td>Limits the selection to flights traversing any listed ARTCC.</td>
<td>Enter one or more ARTCC designators, separated by a space.</td>
<td>ZNY ZBW</td>
</tr>
<tr>
<td>Airway(s) used:</td>
<td>Limits the selection to flights using any listed airway.</td>
<td>Enter one or more airway designators, separated by a space.</td>
<td>J80</td>
</tr>
<tr>
<td>Aircraft type(s)/ac_rmks:</td>
<td>Limits the selection to flights with specific types of aircraft, equipment, and remarks keyword.</td>
<td>Enter one or more specific aircraft types, equipment prefix and suffix data, and remarks keywords.</td>
<td>See Appendix A for a complete list of types and keywords.</td>
</tr>
<tr>
<td>Lowest flight level:</td>
<td>Limits the selection to flights with current filed, reported, or both filed and reported altitudes at or above a specified altitude.</td>
<td>Specify flight’s altitude as <strong>F</strong> (Filed), <strong>R</strong> (Reported), or <strong>B</strong> (Both filed and reported). Enter altitude in hundreds of feet. *</td>
<td>F200 R250 B250</td>
</tr>
<tr>
<td>Highest flight level:</td>
<td>Limits the selection to flights with current filed, reported, or both filed and reported altitudes at or below a specified altitude.</td>
<td>Specify flight’s altitude as <strong>F</strong> (Filed), <strong>R</strong> (Reported), or <strong>B</strong> (Both filed and reported). Enter altitude in hundreds of feet. *</td>
<td>F350 R375 B375</td>
</tr>
</tbody>
</table>

*Note: Not specifying **F**, **R**, or **B** as a flight’s altitude defaults the altitude to **R** (Reported).*
About the Display

At the bottom of the dialog box you can choose the icon to be used to display this flight set. You can also choose to display only your specified flight set with its data blocks or add that flight set to the flights currently on the TSD. In the first instance only the flight set you specified with data blocks is displayed on the TSD. In the second instance all flights are displayed, with data blocks only for the group of flights you specified. The other flights will not have data blocks associated with them.
The **Show Map Item** command allows you to display overlays for individual sectors, TRACONS, fixes, pacing airports, terminals, navaids, or ARTCCs. You may also use the **Move** and **Zoom** commands to get a better view of the overlay if you are currently too far out of range.

### Command Line Interface

Press ; and enter your command using the following syntax:

For example: **SHO ZLC ZMP31 ZDVRC**

Press <Enter>.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
</table>
| 1. Pull down the Maps menu by clicking Maps on the main menu or pressing <Alt> M.  
2. Click Show Map Item or press S. | None |
Show Map Items Dialog Box

If you enter the command with no parameters, the Show Map Items dialog box is displayed.

![Show Map Items Dialog Box](image)

In the ADD field, enter the name of the map item you want to locate. You can enter more than one item in the field by separating each item with a space, as in the example above.

To display these map items, click **Add Typed Items to List**. This moves the items to the List of Map Items to be Shown field. (For more information on this command, see the Show Map Item section in Chapter 4.)
About the Display

After you enter the airway of your choice in the Show Map Items dialog box, the TSD is redrawn and displays a line of labels for each item entered in the dialog box, for example:
The **Site** command displays the network address sites to which your TSD is currently connected. The sites identified by this command are the groups of nodes that your node uses as the source for various types of data. The local site identifier corresponds to a fileserver node at your physical site. (If you have only one fileserver, your site identifier is always the same.) The hubsite site identifier refers to a specific group of nodes at the hubsite in Cambridge, Massachusetts. When you use this command to switch sites, you specify a local site identifier and the system automatically determines which hubsite site identifier to use. Only users at the Air Traffic Control System Command Center (ATCSCC) may switch sites.

### Command Line Interface

Press `;` and enter your command using the following syntax:

To show sites,

```
SITE
```

To switch sites for your TSD only,

```
SITE local site identifier
```

To switch sites for all TSDs on your local site

```
SITE local site identifier ALL
```

For example:

```
SITE CFB
SITE CFB ALL
```

Press `<Enter>`.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Pull down the Tools menu by clicking <strong>Tools</strong> on the main menu or pressing <code>&lt;Alt&gt;</code> T.</td>
<td>None</td>
</tr>
<tr>
<td>2. Click <strong>Network Utilities</strong> or press N.</td>
<td></td>
</tr>
<tr>
<td>3. Click <strong>Site</strong> or press S.</td>
<td></td>
</tr>
</tbody>
</table>
Site Information Dialog Box

If you enter the command with no parameters, the Site Information dialog box opens.

You may also enter the complete command on one line, leaving a space between each item. The following descriptions explain the fields in the dialog box.

- The Local Site field displays the fileserver at your site. You cannot edit this field.
- The Hub Site field displays the hubsite, where the flight data originated. You cannot edit this field.
- The Switch This TSD to Specified Site button lets you switch a single TSD currently running on your node to another FTM site.
- The Switch All TSDs on This Node button lets you switch multiple TSDs currently running on your node to another FTM site.
- The Switch All TSDs on This Site button lets you switch all TSDs for all nodes to a different site at your location.
- The Switch To Site button displays the sites at your location to which you can switch the TSDs. When the TSD has switched to a new site, the Change FTM Site dialog box is displayed to inform you that the TSD has switched to the FTM on a new site.

Related Commands

Use the **Reconnect** command to reacquire all addresses for the current site.
Time Limits

The **Time Limits** govern the interval for which alert icons are displayed. Issuing this command is equivalent to changing the Time Limits field in the Select Alerts dialog box.

Command Line Interface

Press `;` and enter your command using the following syntax:

For example: **TL 1.25**
Press <Enter>

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
</table>
| 1. Pull down the Alerts Menu by clicking Alerts on the main menu or pressing <Alt> A.  
2. Click Select Alerts or press S. | None             |

**Time Limits Prompts Dialog Box**

If you enter the **TL** command with no hours, a dialog box opens. You may also enter the complete command on one line.

Note: This command has no effect on the time range shown in NAS Monitor dialog boxes. It affects the display only of alerted elements on the TSD main window.
Version

The **Version** command displays a message that identifies the current version of the TSD that you are running and the process Id for the version. The process Id is useful when troubleshooting the TSD.

Command Line Interface

Press `;` and enter your command using the following syntax:

```
Command Line
Input Request:
VER
```

Press `<Enter>`

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
</table>
| 1. Pull down the Tools menu by clicking **Tools** on the main menu or pressing `<Alt> T`.  
2. Click **Version** or press V.                  | None             |

Command Result

After you enter the **Version** command, the TSD displays an information box similar to the following.

![Version Information Box](image)

**Note:** The Version command is also available on the Help menu on the TSD Main menu.
WX Report

The **WX Report** command displays a weather report for an airport you specify. The TSD displays the METAR/TAF weather reports. You can enter either the three or 4-character location identifier. The WX.SERVER attempts to match a 3-character identifier to a 4-character identifier. For example, a weather report for JFK is displayed in the sample on the next page as KJFK. This information appears as text in a window. You can use scrolling keys to move about the window.

### Command Line Interface

Press **;** and enter your command using the following syntax:

```
(*Indicates optional entry)
For example: WX JFK or WX KJFK
Press <Enter>
```

### Menu Method

1. Pull down the Weather menu by clicking **Weather** on the main menu or pressing **<Alt> W**.
2. Click **WX Report** or press **X**.

### Quick Key Method

None

### Weather Reports Prompts Dialog Box

If you enter the command with no parameters, the Weather Report Prompts dialog box is displayed.

Enter a three- or four- character location identifier and click **OK** or **Apply**.
Resulting Display
The TSD displays weather reports in two sections. The first part contains Aviation Routine Weather Report (METAR) data. Under the METAR data window is International Aerodrome Forecast (TAF) data.

![Weather Report](image)

**Note:** Use the scrolling arrows to scroll through the weather report if it contains more information than the window can display at one time.

The following table describes METAR and TAF weather data.

<table>
<thead>
<tr>
<th>Report data</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>METAR</td>
<td>Weather report.</td>
</tr>
<tr>
<td>TAF</td>
<td>Aerodrome forecast.</td>
</tr>
<tr>
<td>KJFK</td>
<td>Location identifier. Both LID and KLID are accepted.</td>
</tr>
<tr>
<td>091451Z</td>
<td>Two-digit day of month and four-digit time. Z=UTC time.</td>
</tr>
<tr>
<td>105M or P65M</td>
<td>Visibility (in miles and fractions). P=prevailing.</td>
</tr>
<tr>
<td>FEW036</td>
<td>Cloud height and type. Three-digit height in hundreds of feet. SCT=scattered; BKN=broken; OVC=overcast; TCU or CB=towering cumulus; CLR=clear below 12,000 feet.</td>
</tr>
<tr>
<td>10/02</td>
<td>Temperature (in centigrade)/dew point.</td>
</tr>
<tr>
<td>A3030</td>
<td>Altimeter in inches of mercury.</td>
</tr>
<tr>
<td>RMK A02 SLP261</td>
<td>Remark data. Remarks can include information such as lightning behavior, tornadoes, and funnel clouds.</td>
</tr>
</tbody>
</table>
The **Zoom** command changes the center point of your display to any Air Route Traffic Control Center (ATRCC), TRACON, sector, airport, navaid, fix, Special Use Airspace (SUA), lat/lon point, Fix-radial-distance, or specific flight ID you want and reduces the scope of the display.

### Command Line Interface

Press `;` and enter your command using the following syntax:

(*Indicates optional entries)

For example:

- **Z ORD 1200** (airport)
- **Z LAKES** (fix)
- **Z @UAL123** (flight id)
- **Z DOME** (TRACON)
- **Z 3545/14059** or **Z 3545N/14059W** (lat/lon point)*
- **Z JOT** (fixes and navaids)
- **Z DCA270010** (fix radial distance)**

*You specify a lat/lon point by entering the point in a NAS format: *N coordinate/W coordinate*, with latitude required to be four digits and longitude required to be five digits.

For example, to move to the point 35 45’ N and 104 59’ W enter 3545N/14059W.

**You specify a radial point and distance in relation to a designated fix or airport. This is sometimes called a RHO-THETA point. Use the format: *fix-radial-distance* with no spaces or markers.

For example, to specify 10 miles west of DCA, enter **DCA270010**.

Press `<Enter>`.

<table>
<thead>
<tr>
<th>Menu Method</th>
<th>Quick Key Method</th>
</tr>
</thead>
</table>
| 1. Pull down the Maps menu by clicking **Maps** on the main menu or pressing `<Alt> M`.  
2. Click **Move/Zoom** or press **M**. | None |
Zoom Prompts Dialog Box

If you enter the command with no parameters, the Zoom Prompt dialog box opens. You may also enter the complete command on one line. Be sure to include a space between each item.

![Zoom Prompts Dialog Box](image)

Enter the Place identifier, which may be an ARTCC, TRACON, sector, airport, fix, NAVAID, SUA, lat/lon point, fix-radial-distance, or specific flight ID. Enter the desired width of the TSD display in nautical miles. The allowable range of values is 20 to 12800. If the Zoom width is not specified, the width will be reduced by one half.

About the Display

After you specify the center point and the scope, the display is redrawn with the location you specified as its center and the scope of nautical miles you specified.

Dynamic Sectorization

The TSD centers the display at the center point of the sector as defined by dynamic sectorization if the sector exists. If the sector has been combined into another sector, the TSD centers the display at the center point of the baseline sector.

When the sector is combined, the TSD re-centers the display as specified above and displays a warning dialog box with the appropriate message.

Related Commands

The Move command works like the Zoom command except that you cannot change the scale of the display. The quick key U for Unzoom has the opposite effect from Zoom.
6. Quick Keys

<table>
<thead>
<tr>
<th>Function Name</th>
<th>Quick Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Airports - All*</td>
<td>Y</td>
</tr>
<tr>
<td>Airports - Pacing*</td>
<td>P</td>
</tr>
<tr>
<td>Airways - Jet*</td>
<td>J</td>
</tr>
<tr>
<td>Airways - Victor*</td>
<td>V</td>
</tr>
<tr>
<td>Alerts</td>
<td>%</td>
</tr>
<tr>
<td>Alerts Report and FEA/FCA Report</td>
<td>R</td>
</tr>
<tr>
<td>ARTCCs*</td>
<td>A</td>
</tr>
<tr>
<td>Areas - Alert*</td>
<td>[A]</td>
</tr>
<tr>
<td>Areas - Prohibited*</td>
<td>[P]</td>
</tr>
<tr>
<td>Areas - Restricted*</td>
<td>[R]</td>
</tr>
<tr>
<td>Areas - Warning*</td>
<td>[W]</td>
</tr>
<tr>
<td>Bar Chart for Alerts and</td>
<td>C</td>
</tr>
<tr>
<td>Bar Chart for FEA/FCA** ........</td>
<td></td>
</tr>
<tr>
<td>Boundaries*</td>
<td>B</td>
</tr>
<tr>
<td>Capture (Snapshot)</td>
<td>&lt;PrintScrn&gt;</td>
</tr>
<tr>
<td>Command Line - Close</td>
<td>&lt;Esc&gt;</td>
</tr>
<tr>
<td>Command Line - Display</td>
<td>;</td>
</tr>
<tr>
<td>Command Line - Display</td>
<td>:</td>
</tr>
<tr>
<td>Data Blocks</td>
<td>\</td>
</tr>
<tr>
<td>Delete Flight Icon</td>
<td>\</td>
</tr>
<tr>
<td>Examine Alert and</td>
<td>E</td>
</tr>
<tr>
<td>Examine FEA/FCA</td>
<td></td>
</tr>
<tr>
<td>Examine Flights - Alerts and</td>
<td>=</td>
</tr>
<tr>
<td>Examine Flights - FEA/FCA**</td>
<td></td>
</tr>
<tr>
<td>Fixes - Arrival*</td>
<td>F2</td>
</tr>
<tr>
<td>Fixes - Departure*</td>
<td>F3</td>
</tr>
<tr>
<td>Fixes - Enroute*</td>
<td>F8</td>
</tr>
<tr>
<td>Flights</td>
<td>F</td>
</tr>
<tr>
<td>Flights - Find</td>
<td>@</td>
</tr>
<tr>
<td>Fixe - Arrival*</td>
<td>F2</td>
</tr>
<tr>
<td>Fixe - Departure*</td>
<td>F3</td>
</tr>
<tr>
<td>Fixe - Enroute*</td>
<td>F8</td>
</tr>
<tr>
<td>Flights</td>
<td>F</td>
</tr>
<tr>
<td>Flights - Find</td>
<td>@</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Function Name</th>
<th>Quick Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help - TSD</td>
<td>F1</td>
</tr>
<tr>
<td>History (Trace)</td>
<td></td>
</tr>
<tr>
<td>Initialize</td>
<td>I</td>
</tr>
<tr>
<td>Interrupt Script Processing</td>
<td>&lt;Ctrl&gt;&lt;End&gt;</td>
</tr>
<tr>
<td>Last TZ</td>
<td>*</td>
</tr>
<tr>
<td>Lat/Lon Grid</td>
<td>[L]</td>
</tr>
<tr>
<td>Lat/Lon Point</td>
<td>.</td>
</tr>
<tr>
<td>Lead Lines</td>
<td>/</td>
</tr>
<tr>
<td>Map Labels - All*</td>
<td>~</td>
</tr>
<tr>
<td>MOAs*</td>
<td>[M]</td>
</tr>
<tr>
<td>Move</td>
<td>M</td>
</tr>
<tr>
<td>NAVAIDS - High*</td>
<td>F4</td>
</tr>
<tr>
<td>NAVAIDS - Low*</td>
<td>F5</td>
</tr>
<tr>
<td>NAVAIDS - Other*</td>
<td>F7</td>
</tr>
<tr>
<td>NAVAIDS - Terminal*</td>
<td>F6</td>
</tr>
<tr>
<td>Quit</td>
<td>Q</td>
</tr>
<tr>
<td>Quit (without Confirm dbox)</td>
<td>&lt;Ctrl&gt;Q</td>
</tr>
<tr>
<td>Radar Tops</td>
<td>T</td>
</tr>
<tr>
<td>Range Rings - Create*</td>
<td>&lt;Insert&gt;</td>
</tr>
<tr>
<td>Range Rings - Hide</td>
<td>&lt;Delete&gt;</td>
</tr>
<tr>
<td>Range Rings - Labels</td>
<td>&lt;Ctrl&gt;&lt;Insert&gt;</td>
</tr>
<tr>
<td>Recall</td>
<td>K</td>
</tr>
<tr>
<td>Reconnect</td>
<td>&quot;</td>
</tr>
<tr>
<td>Redraw</td>
<td>D</td>
</tr>
<tr>
<td>Remove Lat/Lon point</td>
<td>D</td>
</tr>
<tr>
<td>Replay - Pause/Resume</td>
<td>$</td>
</tr>
<tr>
<td>Report Manager</td>
<td>&lt;Ctrl&gt; ;</td>
</tr>
<tr>
<td>Reroute - Create</td>
<td>N</td>
</tr>
<tr>
<td>Route - Draw</td>
<td>-</td>
</tr>
<tr>
<td>Sectors - Oceanic*</td>
<td>O</td>
</tr>
<tr>
<td>Sectors - Superhigh*</td>
<td>S</td>
</tr>
<tr>
<td>Show Map Item</td>
<td>#</td>
</tr>
<tr>
<td>Sectors - High*</td>
<td>H</td>
</tr>
<tr>
<td>Sectors - Low*</td>
<td>L</td>
</tr>
</tbody>
</table>
Show Org/Dest....................... +
Snapshot.......................... <PrintScrn>
SUA - Hide All.................... [-
SUA - Show All.......................... [+]
TRACONS*............................... ^
Turn Green.......................... G
Undo Move/Zoom..................... X
Unzoom............................... U
Weather............................... W
Zoom................................. Z
* To toggle labels, press <Ctrl>, then the key(s)
** Timeline must be displayed
The following section lists quick keys in alphabetical and numerical order by quick key.

### By Quick Key Order

<table>
<thead>
<tr>
<th>Function Name</th>
<th>Quick Key(s)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ARTCCs *</td>
<td>A</td>
<td>Toggles display of ARTCC boundaries</td>
</tr>
<tr>
<td>Areas - Alert *</td>
<td>[A]</td>
<td>Toggles outlines of all Special Use Areas (SUAs).</td>
</tr>
<tr>
<td>Boundaries*</td>
<td>B</td>
<td>Toggles the display of perimeters of all the continents, United States and national boundaries.</td>
</tr>
<tr>
<td>Bar Chart for Alerts and Bar Chart for FEA/ FCA**</td>
<td>C</td>
<td>For Alerts: Toggles a graph that compares demands for an airport, sector, or fix with its traffic thresholds. For FEA/FCA: Toggles display of the bar chart</td>
</tr>
<tr>
<td>Redraw Or Remove Lat/Lon Point</td>
<td>D</td>
<td>Refreshes the TSD screen Or Removes Lat/Lon coordinates from display</td>
</tr>
<tr>
<td>Examine Alert and Examine FEA/FCA</td>
<td>E</td>
<td>Opens Alert or FEA/FCA Timeline bar for the element in focus.</td>
</tr>
<tr>
<td>Flights</td>
<td>F</td>
<td>Toggles current display of flight icons</td>
</tr>
<tr>
<td>Turn Green</td>
<td>G</td>
<td>Toggles the color of the item bar segment to let other users know an alert situation is being resolved.</td>
</tr>
<tr>
<td>Sectors - High *</td>
<td>H</td>
<td>Toggles overlay of high sector boundaries.</td>
</tr>
<tr>
<td>Initialize</td>
<td>I</td>
<td>Restores the TSD to its default state.</td>
</tr>
<tr>
<td>Airways - Jet *</td>
<td>J</td>
<td>Toggles jet routes</td>
</tr>
<tr>
<td>Recall</td>
<td>K</td>
<td>Changes the current TSD to customized configuration, previously saved to an adaptation file.</td>
</tr>
<tr>
<td>Sectors - Low *</td>
<td>L</td>
<td>Toggles overlay of low sector boundaries.</td>
</tr>
<tr>
<td>Lat/Lon Grid*</td>
<td>[L]</td>
<td>Toggle display of labels of latitude and longitude lines.</td>
</tr>
<tr>
<td>Function Name</td>
<td>Quick Key(s)</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Move</td>
<td>M</td>
<td>Moves the center point of the display to the location of the pointer.</td>
</tr>
<tr>
<td>MOAs*</td>
<td></td>
<td>M</td>
</tr>
<tr>
<td>Reroute - Create</td>
<td>N</td>
<td>Defines and displays reroutes.</td>
</tr>
<tr>
<td>Sectors- Oceanic *</td>
<td>O &amp; &lt;Ctrl&gt;O</td>
<td>Toggles overlay of oceanic sector boundaries.</td>
</tr>
<tr>
<td>Airports - Pacing *</td>
<td>P &amp; &lt;Ctrl&gt;P</td>
<td>Toggles pacing airport codes</td>
</tr>
<tr>
<td>Areas - Prohibited *</td>
<td></td>
<td>P</td>
</tr>
<tr>
<td>Capture</td>
<td>&lt;PrintScrn&gt;</td>
<td>Takes screen shots of the TSD.</td>
</tr>
<tr>
<td>Quit</td>
<td>Q &amp; &lt;Ctrl&gt;Q</td>
<td>Shuts down the TSD.</td>
</tr>
</tbody>
</table>
| Alerts Report and FEA/ FCA Report | R | For Alerts: creates a flight list for any sector, fix, or airport being examined.  
For FEA/FCA: creates a flight list for any FEA/FCA being examined. |
| Areas - Restricted *       | |R            | Toggles all restricted areas on the TSD.                                   |
| Sectors - Superhigh *      | S & <Ctrl>S  | Toggles overlay of superhigh sector boundaries.                            |
| Radar Tops                 | T            | Displays the altitude of cloud tops in precipitation areas.                 |
| Unzoom                     | U            | Returns the TSD display to the settings before zooming in.                  |
| Airways - Victor *         | V & <Ctrl>V  | Toggles Victor airways                                                     |
| Weather                    | W            | Toggles display of weather data.                                           |
| Areas - Warning *          | |W            | Toggles all prohibited areas on the TSD.                                   |

Note: If the CIWS option is currently selected in the Select Weather dialog box, this quick key is disabled.
### By Quick Key Order (Continued)

<table>
<thead>
<tr>
<th>Function Name</th>
<th>Quick Key(s)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo Move/Zoom</td>
<td>X</td>
<td>Returns to the original center point of the TSD display.</td>
</tr>
<tr>
<td>Airports - All *</td>
<td>Y, &lt;Ctrl&gt;Y</td>
<td>Toggles display of all airports.</td>
</tr>
<tr>
<td>Zoom</td>
<td>Z</td>
<td>Changes the center point of the TSD and reduces the scope.</td>
</tr>
<tr>
<td>Show Org/Dest</td>
<td>+</td>
<td>Toggles origin/destination on data blocks.</td>
</tr>
<tr>
<td>SUAs - Show All</td>
<td>[+], &lt;Ctrl&gt;+]</td>
<td>Outlines all Special Use Areas.</td>
</tr>
<tr>
<td>History (Trace)</td>
<td>–</td>
<td>Toggles history (trace) data on the display. Flight icons display with trace tracks to show most heavily traveled flight paths</td>
</tr>
<tr>
<td>SUAs - Hide All</td>
<td>[-], &lt;Ctrl&gt;-</td>
<td>Removes outlines of all Special Use Areas.</td>
</tr>
<tr>
<td>Command Line - Close</td>
<td>&lt;Esc&gt;</td>
<td>Closes the Command Line dialog box.</td>
</tr>
<tr>
<td>Range Rings - Create *</td>
<td>&lt;Insert&gt;</td>
<td>Displays concentric rings around a specified airport, fix, navaid, lat/lon point, or fix-radial-distance.</td>
</tr>
<tr>
<td>Range Rings - Hide</td>
<td>&lt;Delete&gt;</td>
<td>Deletes range rings.</td>
</tr>
<tr>
<td>Interrupt Script</td>
<td>&lt;Ctrl&gt;&lt;End&gt;</td>
<td>Stops the script from processing.</td>
</tr>
<tr>
<td>Command Line - Display</td>
<td>; or :</td>
<td>Opens the Command Line dialog box.</td>
</tr>
<tr>
<td>Lat/Lon Point</td>
<td>.</td>
<td>Displays the latitude and longitude coordinates for the geographical location where the cursor currently points.</td>
</tr>
<tr>
<td>Alerts</td>
<td>%</td>
<td>Toggles alert icons for airports, fixes, and sectors.</td>
</tr>
<tr>
<td>Help - TSD</td>
<td>F1</td>
<td>Opens help files for the TSD.</td>
</tr>
<tr>
<td>Fixes - Arrival *</td>
<td>F2</td>
<td>Toggles overlay of arrival fix designators</td>
</tr>
<tr>
<td>Fixes - Departure *</td>
<td>F3</td>
<td>Toggles overlay of departure fix designators</td>
</tr>
<tr>
<td>NAVAIDS - High *</td>
<td>F4</td>
<td>Toggles overlay of high navigational aids.</td>
</tr>
</tbody>
</table>
### By Quick Key Order (Continued)

<table>
<thead>
<tr>
<th>Function Name</th>
<th>Quick Key(s)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NAVAIDS - Low *</td>
<td>F5</td>
<td>Toggles overlay of low navigational aids.</td>
</tr>
<tr>
<td>NAVAIDS - Other *</td>
<td>F7</td>
<td>Toggles overlay of other navigational aids.</td>
</tr>
<tr>
<td>NAVAIDS - Terminal *</td>
<td>F6</td>
<td>Toggles overlay of terminal navigational aids.</td>
</tr>
<tr>
<td>Fixes - Enroute *</td>
<td>F8</td>
<td>Toggles overlay of enroute fix designators.</td>
</tr>
<tr>
<td>Examine Flights - Alerts and</td>
<td>=</td>
<td>Displays current locations of flights scheduled to arrive at, depart from,</td>
</tr>
<tr>
<td>Examine Flights - FEA/FCA</td>
<td></td>
<td>or traverse the element being examined in the Alerts or FEA/FCA time line.</td>
</tr>
<tr>
<td>Show Map Item</td>
<td>#</td>
<td>Locates and displays map items.</td>
</tr>
<tr>
<td>Map Labels - All*</td>
<td>~ ~</td>
<td>Toggles all map item labels.</td>
</tr>
<tr>
<td>TRACONS*</td>
<td>^</td>
<td>Toggles display of TRACON boundaries.</td>
</tr>
<tr>
<td>Last TZ</td>
<td>*</td>
<td>Toggles last reported position of all displayed flights and draws a line</td>
</tr>
<tr>
<td></td>
<td></td>
<td>from that point to the appropriate flight icon.</td>
</tr>
<tr>
<td>Flights - Find</td>
<td>@</td>
<td>Displays a specified flight with its data block.</td>
</tr>
<tr>
<td>Delete Flight Icon</td>
<td>\</td>
<td>Removes a single flight icon from the display.</td>
</tr>
<tr>
<td>Lead Lines</td>
<td>/</td>
<td>Shows the projected path of all displayed flights based on the current</td>
</tr>
<tr>
<td></td>
<td></td>
<td>position and speed.</td>
</tr>
<tr>
<td>Data Blocks</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Replay - Pause/Resume</td>
<td>$</td>
<td>Displays flight, weather, and alert data.</td>
</tr>
<tr>
<td>Route - Show</td>
<td>&amp;</td>
<td>Toggles route data on the data blocks.</td>
</tr>
<tr>
<td>Route - Draw</td>
<td>-</td>
<td>Toggles the routes line drawings on the data block.</td>
</tr>
<tr>
<td>Report Manager</td>
<td>&lt;Ctrl&gt; ;</td>
<td>Toggles the Report Manager dialog box on and off the display.</td>
</tr>
</tbody>
</table>
### By Quick Key Order (Continued)

<table>
<thead>
<tr>
<th>Function Name</th>
<th>Quick Key(s)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reconnect</td>
<td>&quot;</td>
<td>Reconnects all network addresses used by your TSD.</td>
</tr>
</tbody>
</table>

* To toggle labels, press <Ctrl>, then the key(s)
In this section the quick keys are presented as they correspond to the TSD menu items and dialog boxes.

**Display Menu Commands**

The following table lists the quick keys that correspond to the commands on the TSD Display menu.

<table>
<thead>
<tr>
<th>Function Name</th>
<th>Quick Keys</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quit</td>
<td>Q</td>
<td>Opens Confirm Quit dialog box</td>
</tr>
<tr>
<td>Quit</td>
<td>&lt;Ctrl&gt; Q</td>
<td>Quit TSD without Confirm Quit dialog box</td>
</tr>
<tr>
<td>Recall</td>
<td>K</td>
<td>Opens Recall file dialog box</td>
</tr>
<tr>
<td>Initialize</td>
<td>I</td>
<td>Opens Initialize dialog box</td>
</tr>
<tr>
<td>Redraw</td>
<td>D</td>
<td>Refreshes the screen</td>
</tr>
<tr>
<td>Replay - Pause/</td>
<td>$</td>
<td>Displays flight, weather, and alert data.</td>
</tr>
<tr>
<td>Resume</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Maps Menu Commands**

The following tables list the quick keys that correspond to commands on the Maps menu.

<table>
<thead>
<tr>
<th>Function Name</th>
<th>Quick Keys</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move</td>
<td>M</td>
<td>Moves center point of display to pointer location</td>
</tr>
<tr>
<td>Zoom</td>
<td>Z</td>
<td>Magnifies center point of display by a factor of 2</td>
</tr>
<tr>
<td>Unzoom</td>
<td>U</td>
<td>Acts to toggle with Zoom</td>
</tr>
<tr>
<td>Undo move/zoom</td>
<td>X</td>
<td>Returns to original center point</td>
</tr>
<tr>
<td>Range Rings - Create*</td>
<td>&lt;Insert&gt;</td>
<td>Displays range rings around pointer location</td>
</tr>
<tr>
<td>Range Rings - Hide</td>
<td>&lt;Delete&gt;</td>
<td>Removes range rings</td>
</tr>
<tr>
<td>Range Ring Labels</td>
<td>&lt;Ctrl&gt;&lt;Insert&gt;</td>
<td>Displays labels representing distance between rings</td>
</tr>
<tr>
<td>Show Map item</td>
<td>#</td>
<td>Opens Show Map Item dialog box</td>
</tr>
<tr>
<td>Lat/Lon Point</td>
<td>.</td>
<td>Displays latitude/longitude coordinates at pointer location</td>
</tr>
<tr>
<td>Remove Lat/Lon point</td>
<td>D</td>
<td>Removes latitude/longitude coordinates</td>
</tr>
</tbody>
</table>
# Map Overlays Dialog Box

The following table lists the quick keys that toggle map overlays and their labels on and off.

<table>
<thead>
<tr>
<th>Map Items</th>
<th>Quick Key</th>
<th>Labels</th>
</tr>
</thead>
<tbody>
<tr>
<td>Map Labels - All</td>
<td>~</td>
<td></td>
</tr>
<tr>
<td>Airports - Pacing</td>
<td>P</td>
<td>&lt;Ctrl&gt; P</td>
</tr>
<tr>
<td>Airports - All</td>
<td>Y</td>
<td>&lt;Ctrl&gt; Y</td>
</tr>
<tr>
<td>NAVAIDs - High</td>
<td>F4</td>
<td>&lt;Ctrl&gt; F4</td>
</tr>
<tr>
<td>NAVAIDs - Low</td>
<td>F5</td>
<td>&lt;Ctrl&gt; F5</td>
</tr>
<tr>
<td>NAVAIDs - Terminal</td>
<td>F6</td>
<td></td>
</tr>
<tr>
<td>NAVAIDs - Other</td>
<td>F7</td>
<td>&lt;Ctrl&gt; F7</td>
</tr>
<tr>
<td>Fixes - Arrival</td>
<td>F2</td>
<td>&lt;Ctrl&gt; F2</td>
</tr>
<tr>
<td>Fixes - Departure</td>
<td>F3</td>
<td>&lt;Ctrl&gt; F3</td>
</tr>
<tr>
<td>Fixes - Enroute</td>
<td>F8</td>
<td>&lt;Ctrl&gt; F8</td>
</tr>
<tr>
<td>Airways - Jet</td>
<td>J</td>
<td>&lt;Ctrl&gt; J</td>
</tr>
<tr>
<td>Airways - Victor</td>
<td>V</td>
<td>&lt;Ctrl&gt; V</td>
</tr>
<tr>
<td>Boundaries</td>
<td>B</td>
<td></td>
</tr>
<tr>
<td>Lat/Lon Grid</td>
<td>[ L</td>
<td></td>
</tr>
<tr>
<td>ARTCCs</td>
<td>A</td>
<td>&lt;Ctrl&gt; A</td>
</tr>
<tr>
<td>Sectors - Low</td>
<td>L</td>
<td>&lt;Ctrl&gt; L</td>
</tr>
<tr>
<td>Sectors - High</td>
<td>H</td>
<td>&lt;Ctrl&gt; H</td>
</tr>
<tr>
<td>Sectors - Superhigh</td>
<td>S</td>
<td>&lt;Ctrl&gt; S</td>
</tr>
<tr>
<td>Sectors - Oceanic</td>
<td>O</td>
<td>&lt;Ctrl&gt; O</td>
</tr>
<tr>
<td>TRACONs</td>
<td>^</td>
<td>&lt;Ctrl&gt; ^</td>
</tr>
<tr>
<td>Areas - Alert</td>
<td>[ A</td>
<td>&lt;Ctrl&gt; [ A</td>
</tr>
<tr>
<td>MOAs</td>
<td>[ M</td>
<td>&lt;Ctrl&gt; [ M</td>
</tr>
<tr>
<td>Areas - Prohibited</td>
<td>[ P</td>
<td>&lt;Ctrl&gt; [ P</td>
</tr>
<tr>
<td>Areas - Restricted</td>
<td>[ R</td>
<td>&lt;Ctrl&gt; [ R</td>
</tr>
<tr>
<td>Areas - Warning</td>
<td>[ W</td>
<td>&lt;Ctrl&gt; [ W</td>
</tr>
<tr>
<td>SUAs - Show All</td>
<td>[ +</td>
<td>&lt;Ctrl&gt; [ +</td>
</tr>
<tr>
<td>SUAs - Hide All</td>
<td>[ ‘</td>
<td>&lt;Ctrl&gt; [ ‘</td>
</tr>
</tbody>
</table>
Flights Menu

The following table lists the quick keys that correspond to the commands on the TSD Flights menu.

<table>
<thead>
<tr>
<th>Function Name</th>
<th>Quick Keys</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flights</td>
<td>F</td>
<td>Toggles current display of flight icons.</td>
</tr>
<tr>
<td>Flight - Find</td>
<td>@</td>
<td>Displays specified flight with its data block.</td>
</tr>
<tr>
<td>Delete Flight Icon</td>
<td>\</td>
<td>Removes a single flight icon from the display.</td>
</tr>
</tbody>
</table>

Customize Flight Display Dialog Box

The following table lists the quick keys that correspond to the Customize Flight Display dialog box.

<table>
<thead>
<tr>
<th>Function Name</th>
<th>Quick Keys</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Blocks</td>
<td></td>
<td>Toggles on all data blocks.</td>
</tr>
<tr>
<td>Show Org/Dest</td>
<td>+</td>
<td>Toggles origin/destination lines on the data blocks.</td>
</tr>
<tr>
<td>Route - Show</td>
<td>&amp;</td>
<td>Toggles route data on the data blocks</td>
</tr>
<tr>
<td>Route - Draw</td>
<td>-</td>
<td>Toggles the routes line drawings on the data block.</td>
</tr>
<tr>
<td>History</td>
<td>_</td>
<td>Toggles history (trace) data off the display.</td>
</tr>
<tr>
<td>Last TZ</td>
<td>*</td>
<td>Toggles last TZ data off the display</td>
</tr>
<tr>
<td>Lead Lines</td>
<td>/</td>
<td>Toggles last lead lines off the display</td>
</tr>
</tbody>
</table>
## Alerts Menu

The following table lists the quick keys that correspond to the commands on the TSD Alerts menu.

<table>
<thead>
<tr>
<th>Function Name</th>
<th>Quick Keys</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alerts</td>
<td>%</td>
<td>Toggles live alerts on and off.</td>
</tr>
<tr>
<td>Examine Alert</td>
<td>E</td>
<td>Opens the NAS Monitor for the element in focus.</td>
</tr>
<tr>
<td>Examine Flights</td>
<td>=</td>
<td>Displays current locations of flights scheduled to arrive at, depart from, or traverse the element being examined in the Alerts time line.</td>
</tr>
<tr>
<td>Turn Green</td>
<td>G</td>
<td>Indicates that you are resolving an alert for a selected time interval for an airport, sector, or fix within your Traffic Management Unit (TMU) airspace. Select the interval first, before pressing the quick key.</td>
</tr>
<tr>
<td>Bar Chart</td>
<td>C</td>
<td>Toggles the display of the bar chart that compares the demands for an airport, sector, or fix with its traffic thresholds. If multiple elements are being examined, position the pointer on the Timeline or Bar Chart of the desired element before pressing the quick key.</td>
</tr>
<tr>
<td>Alerts Report</td>
<td>R</td>
<td>Creates a flight list for any airport, sector, or fix you are examining with Examine Alerts.</td>
</tr>
</tbody>
</table>

## Weather Menu

The following table lists the quick keys that correspond to the commands on the TSD Weather menu.

<table>
<thead>
<tr>
<th>Function Name</th>
<th>Quick Keys</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weather</td>
<td>W</td>
<td>Toggles weather overlays currently selected on the Weather Maps dialog box.</td>
</tr>
<tr>
<td>Radar Tops</td>
<td>T</td>
<td>Toggles the Radar Tops weather overlay.</td>
</tr>
</tbody>
</table>
Reroutes Menu

The following table lists the quick keys that correspond to the commands on the TSD Reroutes menu.

<table>
<thead>
<tr>
<th>Function Name</th>
<th>Quick Keys</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reroute - Create</td>
<td>N</td>
<td>Opens the Create Reroute dialog box</td>
</tr>
</tbody>
</table>

FEA/FCA Menu

The following table lists the quick keys that correspond to the commands on the TSD FEA/FCA menu.

<table>
<thead>
<tr>
<th>Function Name</th>
<th>Quick Keys</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Examine FEA/FCA</td>
<td>E</td>
<td>Opens the FEA/FCA Timeline bar for the element where the pointer is pointed</td>
</tr>
<tr>
<td>Examine Flights</td>
<td>=</td>
<td>Displays current locations of flights scheduled to arrive at, depart from, or traverse the element being examined in the FEA/FCA time line.</td>
</tr>
<tr>
<td>Display</td>
<td>+</td>
<td>Toggles display of FEA/FCA flights</td>
</tr>
<tr>
<td>FEA/FCA Report</td>
<td>R</td>
<td>Creates a flight list for any FEA/FCA you are examining.</td>
</tr>
<tr>
<td>Bar Chart for FEA/FCA</td>
<td>C</td>
<td>Toggles the display of the bar chart. If multiple elements are being examined, position the pointer on the Timeline or Bar Chart of the desired element before pressing the quick key.</td>
</tr>
</tbody>
</table>

Tools Menu

The following table lists the quick keys that correspond to the commands on the TSD Tools menu.

<table>
<thead>
<tr>
<th>Function Name</th>
<th>Quick Keys</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reconnect</td>
<td>“</td>
<td>Opens a Command Line dialog box</td>
</tr>
<tr>
<td>Command Line</td>
<td>;</td>
<td>Opens a Command Line dialog box</td>
</tr>
<tr>
<td>Interrupt Script Processing</td>
<td>&lt;Ctrl&gt;+&lt;End&gt;</td>
<td>Stops script processing</td>
</tr>
<tr>
<td>Report Manager</td>
<td>&lt;Ctrl&gt;</td>
<td>Toggles the Report Manager dialog box on and off the display</td>
</tr>
</tbody>
</table>
## TFMS Basics Commands

The following table lists the quick keys that correspond to the basic commands used on the TSD.

<table>
<thead>
<tr>
<th>Function Name</th>
<th>Quick Keys</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capture (Snapshot)</td>
<td>&lt;PrintScrn&gt;</td>
<td>Takes screen shots of the TSD.</td>
</tr>
<tr>
<td>Help - TSD</td>
<td>F1</td>
<td>Opens help files for the TSD</td>
</tr>
<tr>
<td>Replay - Pause/Resume</td>
<td>$</td>
<td></td>
</tr>
</tbody>
</table>
7. Preference Sets

The Preference Set (Pref Set) Manager application enables you to save your workstation setups and restore a previously saved setup with minimal manual intervention. Using the Pref Set Manager application, you can restore a previously saved setup, not only at the workstation where it was saved, but also at other workstations at the same facility.

Pref Set Manager lets you save the workstation setup as a Preference Set. To help organize and manage the preference sets, the Pref Set Manager lets you store and access saved preference sets in a hierarchy of folders. You can retrieve, edit, or delete any of your site’s preference sets, but you cannot access preference sets saved at a different site.

**Note:** Using the Pref Set Manager requires a knowledge of the Workspace Switcher. For information on managing workspaces, see Using the Workspace Switcher on page 1-5.

Using the Preference Set Manager

The Pref Set Manager application is available on the TFMS Gnome Toolbar menu. There are three sub-menu options available:

- Manage Pref Set
- Restore Pref Set
- Save Pref Sets.

Note that Preference Sets is accessed through the TFMS Menu option on the Gnome menu, not through the Preferences option.
Save Preference Sets

You can use the Save Preference Set option to save a workstation setup as a Preference Set. After you select **Save Preference Set** from the Preference Sets sub-menu, a dialog box like the one below opens. Initially, only the top level folders are displayed.
Creating a New Folder

You can create a top level folder or a subfolder (folder within a folder) in which to store your Preference Sets.

To create a top level folder, make sure that none of the folder names are selected. If they are, click **Collapse All Nodes** or deselect the folders. Then click **New Folder** to open the New Folder dialog box.

Enter a name in the **Folder Name** text box. In the **Description** text box, enter your description of what the folder contains. Click **OK** to add the folder name to the Save Preference Set dialog box, in the top folder level of the Saved Preference Sets section.

To create a new folder within a folder, select that folder in the Saved Preference Sets section by clicking on the folder name and then clicking **New Folder**. The New Folder dialog box opens. Enter the folder name and description. When you click **OK** on the New Folder dialog box, the new folder name appears on the next level in the folder hierarchy. You can have multiple levels of folders within the hierarchy.

**Note:** The New Folder button is disabled (grayed out) if a Preference Set is selected.

Selecting the folder name on the top level or on lower levels of the hierarchy displays the folder name and description. The sample dialog box on the following page illustrates this, as both the folder name and the description are shown when the folder is selected.
Preference Sets

Preference Sets are listed within the folder. Double clicking on the folder name opens the next level, a sample of which appears below with Preference Sets contained within the folder.

Enter the name of a Preference Set in the Pref Set Name text box. Then enter a description of the Preference Set. Clicking Save saves the Preference Set to the selected folder.

Overwriting an Existing Preference Set

You can also save a new workstation setup by overwriting an existing Preference Set file.

1. Select the folder in which you want to store the new Preference Set. The folder name and description display in the Folder Name and Description fields below the Saved Preference Sets list.
2. Select the Preference Set file name. The Pref Set name and description are displayed.

3. Edit the description text box.

4. Click **Save** to save the Preference Set.
   You will be prompted to confirm that you intend to overwrite an existing Pref Set.

**Save Preference Set Buttons**

There are several buttons available on the Save Preference Set dialog box.

- **Collapse all Nodes**
  Closes the Saved Preference Sets list so that only the top level folders are visible.
  This action also deselects all folders.

- **New Folder**
  Enables you to create a folder in which to store a new Preference Set. Clicking the **New Folder** button opens the New Folder dialog box.

  **Note:**  The New Folder button is disabled (grayed out) if a Preference Set is selected. Collapsing all nodes deselects all folders and items and enables the New Folder button.

- **Save**
  Saves the workstation setup.
  If you are overwriting an existing Preference Set file, a warning dialog box notifies you that the file will be overwritten. To overwrite the file, click **Yes**.

- **Cancel**
  Closes the Save Preference Set dialog box without saving any Preference Sets.

- **Help**
  Opens Help for the Save Preference Set dialog box.

**Restore Preference Set**

The Restore Preference Set option lets you restore a previously saved setup not only at the workstation where it was saved but also at other workstations at the same facility. After you select the **Restore Preference Set** option on the Preference Sets sub-menu, the Restore Preference Set dialog box opens.
Using the Restore Preference Set Dialog Box

The top section of the dialog box displays folder names. These folders contain the preference sets created by users at your facility. The sample below shows a selected folder with its preference sets.

The Restore and Advanced Restore buttons become active when you select the Preference Set. Click **Restore**. A Restore Progress dialog box opens showing the progress of the restore. It takes approximately 10 seconds to restore each TSD in a Preference Set.
**Advanced Restore**

After clicking on the Advanced Restore button on the Restore Preference Set dialog box, the Advanced Restore dialog box, similar to the one below, opens.

![Advanced Restore Dialog Box](image)

**Using the Advanced Restore Dialog Box**

There are two major sections on the Advanced Restore dialog box:

1. Allocations of Pref Set Workspaces to Current Workspaces
2. Options for Restoring Pref Set Workspaces.
Allocation of Pref Set Workspaces to Current Workspaces

This section of the Advanced Restore dialog box displays a table with 32 rows, one for each workspace allowed on the Gnome desktop. The vertical scroll bar on the right lets you view all 32 rows.

The left side of this section displays the current workspace allocation with three columns:

- **Workspace Name**
  The name of the workspace currently active on the desktop or “unused” if a workspace is not currently active.

- **TSD Processes**
  The number of TSD processes currently active in each workspace.

- **Reuse**
  Designates whether the workspace currently active will be reused or not used. A check in the Reuse checkbox indicates the workspace will be reused.

The right side of this section displays the New workspace allocation with two columns:

- **Workspace Name**
  The name of the workspace as it was saved in the Preference Set.

- **TSD Processes**
  The number of TSD processes that were active in the workspace when it was saved in the Preference Set.

Advanced Restore Options

There are two options on the Advanced Restore dialog box for restoring Preference Set workspaces:

- **Restore all workspaces**

- **Restore only workspaces that contain TSDs.**

**Restore all workspaces**

When you select this option, all workspaces in your preference set will be restored, whether these workspaces contain TSDs or not. This is the default option. You might want to use this option if all TFMS user applications were shut down and you are logging in and starting up a new set. This option will replace all existing TSDs with a new set of TSDs. Other TFMS applications that are active are unaffected; however, the names of the workspaces in which they are active may be changed.
In the example below, the Advanced Restore dialog box displays the option to restore all workspaces was selected.
**Restore only workspaces that contain a TSD**

When you select this option, only those workspaces in your Preference Set that contain TSDs are restored. Use this option if your workstation is running a full set of TFMS applications and you want to shut down the existing TSDs and start up a new set of TSDs without logging out. In this case, other TFMS applications that are active are unaffected; however, the names of the workspaces in which they are active may change if the workspaces allocated for restoring the Preference Set contain TSDs.

The Pref Set Manager will reuse workspaces currently running a TSD and leave other workspaces untouched. In the example below, the Advanced Restore dialog box shows that the option to restore only workspaces containing a TSD has been selected. Only those workspaces containing a TSD have a check mark in the Reuse column.

![Advanced Restore Dialog Box](image)

The Allocation of Pref Set Workspaces to Current Workspaces list shows that four of the current workspaces contain TSDs. The Pref Set Manager has automatically allocated four Preference Set workspaces that contain TSDs to the four current workspaces that contain TSDs. The remaining Pref Set workspaces that contain TSDs have been allocated to inactive workspaces 6 through 9. The Reuse checkbox for workspace 4 is available for selection. A gray checkbox indicates an inactive workspace that may be automatically assigned for reuse by the Pref Set Manager. You are unable to select or deselect these checkboxes.
If you want to modify the list of workspaces to be included in the restore, you can select or
deselect workspaces for reuse.

**Restoring the Preference Set**

After you review the allocation of Preference Set workspaces to current workspaces and
complete any changes to the restore method, click **Restore** to restore the workstation
setup. If the number of workspaces currently active on the workstation is greater than the
number of workspaces being restored in the Preference Set, the Pref Set Manager will not
reduce the number of workspaces on the workstation. However, depending on the number
of Preference Set workspaces being restored and the restore method, the Pref Set Manager
may increase the number of workspaces on the workstation up to the maximum of 32, if
necessary.

As happened on the Restore Preference Set dialog box, once you click **Restore**, the
Restore Progress message box is displayed.

**Unallocated Pref Set Workspaces**

If all Preference Set workspaces cannot be assigned to workstation workspaces; that is, if
the number of workspaces designated for reuse is less than the number of Preference Set
workspaces, the Pref Set Manager displays the Unallocated Pref Set Workspaces panel on
the Advanced Restore dialog box. This panel provides you with a list of the unallocated
Preference Set workspaces and also provides options for resolving the situation.

After you review the list of unallocated workspaces, you can take one of the following
actions:

- Select additional workspaces to be reused from the Allocation of Preference Set
  Workspaces to Current Workspaces section of the Advanced Restore dialog box.
- Select the option to restore unallocated TSDs to a single workspace and then select
  the workspace number.
- Select the option to not restore unallocated TSDs.

The Unallocated Pref Set Workspaces panel on the Advanced Restore dialog box displays
the list of unallocated Preference Set workspaces in a read-only text box. A vertical scroll
bar on the right of the text box lets you view all items in the list. The panel also displays
two radio buttons for restoring the TSDs associated with the unallocated workspaces or
not restoring the TSDs. If you select the Restore radio button, click the down arrow to the
right of the option and select the number of the workspaces where you want to restore the
unallocated TSDs. You can select a number from 1 to 32.

After reviewing the list of unallocated workspaces and completing any final changes to
the restore method, click **Restore** to restore your workstation setup.
Manage Preference Sets

The Manage Pref Sets option lets you manage Preference Set files and the folders in which they are saved. After you select this option, the Manage Preference Sets dialog box opens.

The Manage Preference Sets dialog box displays a Saved Preference Sets panel with a hierarchical list of folders. Initially, only the top level folders are displayed. To open the display of items within a folder, double click the folder icon. After you select a folder or Preference Set within the list, the description displays in the Description of Folder or Preference Set text box.
There are several buttons on the dialog box. The following descriptions explain the function of each button. Some of these buttons - Rename, Delete, Copy, Move, and Paste - are unavailable until you select a folder or preference set. These buttons are explained in more detail on the following pages.

- **Collapse All Nodes**
  Closes the Saved Preference Sets list so that only the top level folders are visible. This action also deselects all folders.

- **New Folder**
  Lets you create a folder in which to store a new Preference Set. Clicking the New Folder buttons opens the New Folder dialog box, which was described earlier in this section.

- **Rename**
  Lets you rename a selected folder or Preference Set. Clicking this button opens the Rename dialog box.

- **Delete**
  Lets you delete a selected folder or Preference Set. A confirmation dialog box opens asking you to confirm the deletion request.

- **Copy**
  Copies a selected folder or Preference Set for pasting to another location in the Saved Preference Sets list.

- **Move**
  Saves a selected folder or Preference Set file for pasting to a new location in the Saved Preference Sets list. When the folder or Preference set is pasted, it will be removed from its original folder.

- **Paste**
  Pastes a copied or saved item to the selected location in the Saved Preference Sets list. This function is available only after a folder or Preference Set has been copied or saved for moving and a valid folder in which to copy or move the item has been selected.

- **Save Description**
  Saves any changes you make to the description of the folder or Preference Set.

- **Cancel**
  Closes the Manage Preference Sets dialog box.

- **Help**
  Opens Help for the Manage Preference Sets dialog box.
Rename

The Rename dialog box displays text fields for entering a new name and description for the folder or Preference set you want to rename. You can assign the folder or Preference Set any name you want using alphanumeric, dash, or underscore characters only. The Description text box provides a scroll bar to display text that is out of view.

After you enter a new name and/or description, click **OK**. The Pref Set Manager validates that the name is entered in the correct format, closes the Rename dialog box, and updates the Saved Preference Sets list. If the name is not entered in the correct format, an error message appears.
Delete

The Delete button enables you to delete a selected folder or Preference Set. After selecting Delete, the following dialog box displays asking you to confirm the deletion. Click Yes to delete or No to cancel.

Copy, Move, and Paste

The steps for copying and moving an item in the Saved Preference Sets list are similar. Whether pasting a copied item or moving a saved item to another location, you use the Paste button to complete the process.

1. Select the item in the Saved Preference Sets list you want to copy or move.
   - If you are copying an item, click Copy.
   - If you are moving an item, click Move.
2. Click on the folder name into which you want to place the item.
3. Click Paste.
   The Saved Preference Sets list displays the copied or moved item in the new location.
8. Traffic Management Shell

The Traffic Management Shell (TM Shell) is an TFMS tool that allows you to execute many of the non-graphical commands available in the TSD, without any of the graphical displays (overlays, boundaries, flights, etc.) appearing. This tool gives you access to the same data available in the full TSD, while allowing it to be used in a more efficient manner. Within the TM Shell program, you can issue individual commands and also execute script files.

The program includes configuration files that allow you to customize certain features. In addition, TM Shell can execute scripts to request flight reports automatically on a scheduled basis. For information about these features, see the TFMS System Administration Manual.

Invoking TM Shell

TM Shell is invoked from the CDE Toolbar. Move the cursor inside the TM Shell icon, then click the left button. This displays a window looking something like the following. (Your display may show different text depending on your setup.)

![TM Shell Window](image)

The area above the command prompt displays program-related messages, depending on the setup at your site. The command prompt appears at the bottom. You can also invoke TM Shell from `dtterm` by entering `/ETMS/com/start_tmsh` at the `%` prompt. As soon as the command: prompt appears in the window or shell, you can enter TM Shell commands.

TM Shell Commands

You can use any of the commands described in the table beginning on the following page. After typing the command at the prompt, press `<Enter>`.

Some of the commands produce a response just by entering the command name. For example, if you issue the date command, the program displays the current date and time. Most of the commands are used with command arguments. An argument is a keyword, or group of characters, that modifies the effect of the command in a specific way. In some cases command arguments are required, and in others they are optional. A command may have one or more arguments, each of which is separated by a space.

The description of each command in this chapter includes information about arguments and examples of their use.
# Command Descriptions

This section contains a table listing all TM Shell commands. Many of the command names have an alias, or alternative quick key version, as indicated under the command name. For additional information about these commands, see the command description in Chapter 6 of this manual. The description of some commands includes the comment “session only.” This means that the effect of the command is removed when you quit `tmsh`, and the default value is restored.

Three of the commands have supplemental information following the table entries, as indicated in the descriptions. Some of the commands, as noted, are available only at the Air Traffic Control System Command Center (ATCSCC).

**Note:** An asterisk (*) beside a name indicates that the command has an equivalent TSD version. For additional information about these commands, see the command description in Chapter 5 of this manual.

## TM Shell Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Arguments</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>aux</td>
<td>none</td>
<td>The <strong>aux</strong> command lists the definitions of all the auxiliary commands.</td>
<td>aux</td>
</tr>
<tr>
<td>compare</td>
<td>optional</td>
<td>The <strong>compare</strong> command with no arguments compares pair wise the last reports returned on each active site. The <strong>compare</strong> command takes any arguments to be site names and only reports returned on those sites are compared.</td>
<td>compare report1 report2</td>
</tr>
<tr>
<td>credits</td>
<td>none</td>
<td>The <strong>credits</strong> command prints out the authorship information and version number of the TM Shell software being run.</td>
<td>credits</td>
</tr>
<tr>
<td>date</td>
<td>none</td>
<td>Displays the current date and UTC time.</td>
<td>date</td>
</tr>
<tr>
<td>echo</td>
<td>required</td>
<td>The <strong>echo</strong> command echoes back its arguments as a way of generating comments in TM Shell scripts.</td>
<td>echo end of script... wait 5s</td>
</tr>
</tbody>
</table>
## TM Shell Commands (Continued)

<table>
<thead>
<tr>
<th>Command</th>
<th>Arguments</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>edct*</td>
<td>required</td>
<td>The <code>edct</code> command passes its arguments as-is to the EDCT server on the activated sites. The command returns a filename of the report that returns on each site as it comes back or an informational message.</td>
<td>edc list&lt;br&gt;edc summary all&lt;br&gt;edc sum jfk&lt;br&gt;edc cnx airport airline*&lt;br&gt;edc cta airport airline*&lt;br&gt;edc slo airport airline*&lt;br&gt;*airline entry is optional</td>
</tr>
<tr>
<td>edc</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>env</td>
<td>none</td>
<td>The <code>env</code> command displays the value of the variables internal to the TM Shell.</td>
<td>env</td>
</tr>
<tr>
<td>exit</td>
<td>none</td>
<td></td>
<td></td>
</tr>
<tr>
<td>bye</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>q</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>quit</td>
<td></td>
<td>The <code>quit</code> command terminates the tmsh.</td>
<td>q</td>
</tr>
<tr>
<td>stop</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ftm f</td>
<td>required</td>
<td>Command can be SHO or LIF: <strong>LIF</strong> - command to list all legs of a flight in ascii for up to 10 acids. Syntax is <code>F LIF f1 f2 f3 f4 f5</code> where <code>f1</code> to <code>f5</code> are flights to be displayed. <strong>SHO</strong> - user request to show all data on up to five flights in one request. Syntax is <code>F SHO f1 f2 f3 f4 f5</code> where <code>f1</code> to <code>f5</code> are flights to be displayed. <strong>SITE</strong> - user request to show the current configuration of the ftm. Syntax is <code>F SITE</code></td>
<td>ftm sho aal876&lt;br&gt;f lif aal876</td>
</tr>
<tr>
<td>gtp*</td>
<td>required</td>
<td>The <code>gtp</code> command passes its arguments as-is to the delay advisor server on the activated sites. The command returns a filename of the report that returns on each site as it comes back.</td>
<td>gtp airp bos&lt;br&gt;gtp acid ual51 iad</td>
</tr>
</tbody>
</table>
### TM Shell Commands (Continued)

<table>
<thead>
<tr>
<th>Command</th>
<th>Arguments</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
</table>
| **help** | optional  | Displays help for individual commands, when using this format: `help` command. If entered without a command name, displays a list of commands, including auxiliary (user–defined) commands. For information about auxiliary commands, see the System Administration Manual. | help  
help req  
help script |
| **ld**   | optional  | Lists all reports in the default report directory, as defined by the `repd` command. Use arguments to specify groups of reports by report type or by location. | ld  
ld edc  
ld bos list cnt  
ld jfk bos list |
| **lscrdir** | optional | The `lscrdir` command with no arguments indicates the current lscripts directory.  
When a command argument is passed to the `lscrdir` command, the current lscripts directory is changed to the directory specified.  
If the directory does not exist, it is created, provided no other non–directory file system object of the same name exists. | lscrdir  
lscrdir /ETMS/td/adapt/scripts |
| **lscexp** | optional | The `lscexp` command with no arguments indicates the current status of lscript expansion; either ON or OFF.  
The `lscexp` command with the argument on or off turns lscript expansion on or off. When on, `Tmsh` will expand lscripts rather than lstnet. | lscexp off |
| **pause** | required  | The `pause` command echoes back its arguments as a way of generating comments in Tm Shell scripts.  
By default, the command waits for the Enter key to be pressed before continuing. | pause |
<table>
<thead>
<tr>
<th>Command</th>
<th>Arguments</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>pausewait</td>
<td>optional</td>
<td>Within a script, controls a flag that determines whether <code>pause</code> command will wait for the Enter key or not. Use the format: <code>pausewait on/off</code>. Also, see <code>script</code> and <code>wait</code>.</td>
<td>pausewait on/pw off/pw</td>
</tr>
<tr>
<td>print</td>
<td>required</td>
<td>The <code>print</code> command prints the specified file, or if the argument is a single character, it assumes that it is a site name and prints the last report on the specified site or it prints the reports on all active sites if no arguments were specified.</td>
<td>print/print /reports/bos__list.11153401.01/print /myreports/report name/print 1</td>
</tr>
<tr>
<td>prompt</td>
<td>optional</td>
<td>The <code>prompt</code> command with no arguments indicates the current prompt. When a new prompt argument is passed to the <code>prompt</code> command, the prompt is changed to the new prompt specified on the command line.</td>
<td>prompt Command: prompt my prompt: prompt:</td>
</tr>
<tr>
<td>prtcmd</td>
<td>optional</td>
<td>Displays or changes the current pathname for the <code>print</code> command. This pathname determines what HP printer will be used. To change the current settings, use the format <code>prtcmd</code> arguments (session only).</td>
<td>prtcmd/prtcmd/com/prnec -pitch 10</td>
</tr>
<tr>
<td>purge</td>
<td>none</td>
<td>Purges the report directory by removing every file that is older than the purge time (see <code>purget</code>) and having a file containing one of the purge character strings (see <code>purges</code>). Use <code>purget</code> and <code>purges</code> to view or reset the current settings.</td>
<td>purge</td>
</tr>
<tr>
<td>purgeraw</td>
<td>required</td>
<td>When set to on, causes the <code>/rawlist</code> to be purged anytime the TMSH <code>purge</code> command is issued.</td>
<td>purgeraw on/off</td>
</tr>
</tbody>
</table>
### TM Shell Commands (Continued)

<table>
<thead>
<tr>
<th>Command</th>
<th>Arguments</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>purges</td>
<td>optional</td>
<td>The purge string is a list of key words consisting of non–blank characters, one of which must be present in a file name for the <code>purges</code> command to purge that file. To change the current setting, use the format: <code>purges string string (session only)</code>. If no string is specified, displays current strings. See Table Supplement for more information.</td>
<td><code>purges</code>&lt;br&gt;<code>purges list cnts fixl lifp rpt</code>&lt;br&gt;<code>purges jfk bos purges __.</code></td>
</tr>
<tr>
<td>purget</td>
<td>optional</td>
<td>Specifies the minimum number of hours old that a file must be in order to be purged with the <code>purge</code> command. Use the format: <code>purget #hours</code> (session only). If none specified, displays the current value.</td>
<td><code>purget</code>&lt;br&gt;<code>purget 24</code>&lt;br&gt;<code>purget 168</code></td>
</tr>
<tr>
<td>quit</td>
<td>none</td>
<td>Terminates the TM Shell program.</td>
<td><code>exit</code>&lt;br&gt;<code>q</code></td>
</tr>
<tr>
<td>Remove</td>
<td>required</td>
<td>The <code>remove</code> command lets you remove flights from the TFMS database, as though they had never existed. This command is privileged. Only traffic management specialists at the ATCSCC may use this command. Arguments are <code>flight:date:time:airports:orig.</code>.</td>
<td><code>REM AIRL:COM DAT:0703 ORI:BOS</code></td>
</tr>
<tr>
<td>repd</td>
<td>optional</td>
<td>The <code>repd</code> command with no arguments indicates the current reports directory. When a command argument is passed to the <code>repd</code> command, the current reports directory is changed to the directory specified. If the directory does not exist, it is created, provided no other non-directory file system object of the same name exists.</td>
<td><code>repd</code>&lt;br&gt;<code>repd //dsk03/newdir</code></td>
</tr>
</tbody>
</table>
### TM Shell Commands (Continued)

<table>
<thead>
<tr>
<th>Command</th>
<th>Arguments</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
</table>
| req*           | required    | The `req` command is passed as–is to the list server on the activated sites. The command returns a filename of the report that returns on each site as it comes back. | req a bos -1 +1 list  
req ord yesterday  
req vt pt [ord lax ] |
| Restore        | required    | The `restore` command lets you “undo” the effects of the `remove` command. It allows some of all of the flights that you did not want to remove from the database to be restored. Only traffic management specialists at the ATCSCC may use this command. Arguments are airline:flight:date:time:airport:orig:dest | REST AIRL:COM  
DAT:0703  
ORI:BOSMultiple entries must be enclosed in brackets.REST  
FLI:[AAL123 AAL214]  
DAT:0705 |
| Restore Preview| required    | You can preview the restoring of flights. When you enter the `Restore Preview` command, a list is displayed showing the flights that would be restored if you issued a real Restore command. You issue a `Restore Preview` command in the same way that you would enter any `Restore` command. | RESTORE PREVIEW  
AIRL:COM  
DAT:0703  
ORI:BOS |
| scdir          | optional    | The `scdir` command with no arguments indicates the current scripts directory. When a command argument is passed to the `scdir` command, the current scripts directory is changed to the directory specified. If the directory does not exist, it is created, provided no other non-directory file system object of the same name exists. | scdir  
scd ETMS/tsd/adapt/myscripts |
### TM Shell Commands (Continued)

<table>
<thead>
<tr>
<th>Command</th>
<th>Arguments</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>script* s</code></td>
<td>required</td>
<td>The <code>script</code> command executes the commands in the file passed as an argument and interprets them in the same way as if they had been typed in at the keyboard. The <code>script</code> command requires a filename as an argument. All <code>tmsh</code> commands are available in <code>tmsh</code> scripts.</td>
<td><code>script myfile ETMS/tsd/adapt/scripts/myfile</code></td>
</tr>
<tr>
<td><code>showrep sr</code></td>
<td>optional</td>
<td>The <code>showrep</code> command displays the last report on the specified sites or the reports on all active sites if no site was specified.</td>
<td><code>showrep sr</code></td>
</tr>
<tr>
<td><code>site* string</code></td>
<td>optional</td>
<td>The <code>site</code> command with no arguments indicates the list of activated sites. When a sites argument is passed to the <code>site</code> command, the sites specified are activated.</td>
<td><code>site A string A</code></td>
</tr>
<tr>
<td><code>sites</code></td>
<td>none</td>
<td>The <code>sites</code> command indicates the list of available sites.</td>
<td><code>sites</code></td>
</tr>
<tr>
<td><code>timeout</code></td>
<td>optional</td>
<td>Specifies to TM Shell how long to wait for a req to timeout and abort the request. Use the format: <code>timeout minutes m seconds s</code> or <code>timeout seconds s</code> (session only). If no argument is specified, displays the current setting.</td>
<td><code>timeout 30s timeout 1m 15s</code></td>
</tr>
<tr>
<td><code>timer</code></td>
<td>optional</td>
<td>Sets the command timer on or off. When on, the system displays the time taken to execute a TM Shell command. Use the format: <code>timer on</code> or <code>timer off</code> (session only). <strong>Note</strong>: If the <code>verbose</code> command is on, timer is automatically on. Entering timer without arguments displays the current timer mode.</td>
<td><code>timer on timer off timer</code></td>
</tr>
</tbody>
</table>
Table Supplement

As indicated in the table, this section provides some additional information regarding certain specified commands.

**ftm Command**

The Flight Table Manager (FTM) is an TFMS program that maintains the database of flight information for display on the TSD. There are a number of commands available to the TFMS support staff to manipulate or query the FTM program. These commands are not available through the TSD and are not documented elsewhere for TSD users. However TM Shell makes two of these commands, sho and lif, available to TSD users on a restricted basis. For more information, see your System Administrator or call the TFMS hotline: (609) 485-9601.
Purges Command

Purges with no arguments lists the current purge character strings. Purges with arguments specifies a new set of characters that must be present in report file names within the reports directory to be purged with the purge command. The procedure that follows shows an example.

<table>
<thead>
<tr>
<th>What To Do</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Use the purges command</strong></td>
</tr>
<tr>
<td>1. Enter purges at the TM Shell prompt. The following is an example of the program response: Purge string: <em>tsd cnts elis elog esho esub esum info fixl lifp list rpt</em></td>
</tr>
</tbody>
</table>
| 2. Use the command to designate a new set of purge strings, for example: *purges rte list cnts fixl lifp esho esum esub elog elis rpt*  
   Now when you issue the **purge** command, all reports with any string in the new set will be purged |

The effect of purges remains only for the current session. After you quit TM Shell, the default values return.

**Script Command**

To use the script command in TM Shell, you need to create a script file in an appropriate directory. Before starting, issue the scdir command to find out the current scripts directory (the default directory for TM Shell script files is */ETMS/tmsh/adapt/scripts*). The procedure below shows an example of how to create and execute a request script in TM Shell.
What To Do

Create and execute a TM Shell Script

1. Create a window by clicking the arrow above the text editor icon on the CDE Toolbar. This will display another menu bar. Click the terminal icon to display the new window.

2. Change to the proper directory by entering `cd` (space) then the full pathname. For example:
   
   `cd ETMS/tmsh/adapt/scripts`
   
   Press `<Enter>`.

3. Create a new file by entering `touch` (space) then the filename, for example:
   
   `touch myscript`
   
   Press `<Enter>`

   **Note:** This procedure assumes you are working on a node on which TM Shell is installed. If you are working on another node, you must specify the node name using the format: `/nfs/node i.d.` before entering the pathname.

4. Edit the new file, `myscript`, to do the following: turn verbose on, then request an arrivals report for ORD airport, then display the report. You would enter the following:
   
   ```
   verbose on
   req a ord -1 +2 list
   showrep
   ```

5. When you finish entering the TM Shell command(s), save and exit the file. Now you can execute the script at any time by issuing the script command within TM Shell, or by invoking TM Shell and running the script at the same time, as shown in the following step.

6. Execute the script by typing the following at the prompt:
   
   ```
   ETMS/com/start_tmsh myscript
   ```
   
   Press `<Enter>`

   **Note:** If the script does not exist in the default script directory, you must enter the entire pathname. The results of the commands in the script appear within the window where TM Shell is running.

When running a script in TM Shell, the program ignores the ; character. This means that you can run semicolon commands that exist in scripts that were created for use with the TSD, using the format `@ script_name`. (This assumes that the contents of the script have equivalent versions in TM Shell.) For more information about TSD scripts, see Chapter 4, Tools section. For information about request scripts, see Appendix A.
9. TFMS Electronic Mail

TFMS Electronic Mail (EMail) allows you to send advisories or general messages to addresses on the National Airspace Data Interchange (NADIN) Network and Aeronautical Radio Inc. (ARINC) Network or to other TFMS workstations. You may compose a message entirely from scratch, or you can incorporate standard messages, previously used messages, or reports into your message. As described below, certain applications under this command are limited to the Air Traffic Control System Command Center (ATCSCC).

This chapter describes how to use EMail. All of the procedural steps listed below may be performed in the order shown. However, once you invoke EMail, the applications you actually use will depend on your task at hand.

- Invoke EMail from the Gnome Toolbar
- View or Change EMail Setup
- Select a Message Type (ATCSCC only)
- Compose Message
- Save Message
- Specify Addresses
- Print and Send Messages
- Quit EMail

At the end of this chapter is a summary of the EMail features, preceded by a short description of how the TFMS receives and prints incoming messages and notifies you that a message has been received. This includes instructions for acknowledging the notification and accessing the message.

Invoke EMail from the Gnome Toolbar

You invoke EMail from the Gnome Toolbar. Move the cursor to the TFMS menu, and click the left button. Move the cursor to the EMail icon and click the left button. The TFMS Electronic Mail window appears, as shown on the next page. The two blank areas on the left side of the window are the input pads, where you construct your message and enter addresses. The right side of the window displays buttons and other items to select. Upon initialization several information messages may be displayed. A pop-up containing the number of unread messages may also be displayed.

The Connection Status Indicator

The small red or green box located under the Help button indicates the status of the connection between EMail and the communications software, which allows EMail to send messages to other nodes and sites. The color and symbol indicate the status as follows:
It is normal to see a red indicator for a short time when you first invoke EMail or if the connection needs to be re-established. However, if the box does not turn green within a minute, there may be some communication problems, and you should contact your System Administrator.

EMail Basics

The following paragraphs explain some basic procedures that you need to know in order to use the EMail function.

Making Selections and Getting On-line Help

Click any item to select or deselect it. To get on-line help, click Help in the current window or pop-up form. (In some windows, the Help menu is far to the right, as shown above.) To exit on-line help, click Close.
Email Pull–Down Menus

Just below the TFMS Electronic Mail title bar is the main menu bar, which contains File, Edit, Options, and Format pull-down menus. The Format menu gives you the options to display and removes buttons or icons. **Display/Remove buttons** toggles most menu items to the right of the EMail window to either displayed or not displayed. **Display/Remove Icons** displays or removes the icons located above the address pad. The File menu contains the View/Import, Save, Send, Print, Pop Notify, and Quit commands. The Edit menu contains text editing options including **Undo, Cut, Copy, Paste, Clear, Delete**, and **Find**. The Options menu contains message and address pad manipulating options such as **Restore Last Message, Clear Addresses, Undo Clear Addresses, Clear Message, Undo Clear Message, Open Addresses, Group <NAME>,** and **Setup**.

Editing Text

To enter text in the address or message pads in the EMail window, move the cursor to the window, click the left mouse button, and start typing. You can also use any of the text editing options from the Edit menu.

Some buttons when selected display pop-up forms with one-line fields to enter or edit text. To move the cursor from field to field, press `<Tab>` or point and click with the left mouse button. Within a field, you can edit text normally.

Scrolling Through Lists

Some pop-up forms include a list of items to select, as shown in this example:
On the right side of the list is a scroll bar, and the shaded area on the scroll bar indicates the relative position of the items that are displayed within the list. The above illustration, for example, shows the beginning of the list (you can scroll down, but not up), and approximately one third of the entire list is currently displayed.

**Popping the Window**

If while working on the EMail window, you click the left mouse button on any other window, the entire EMail window pops to the back of the selected window. To bring it to the front again, click the left mouse button in the EMail window.

**Viewing or Changing Setup**

The Setup button displays a pop-up form that allows you to view or change certain settings that affect the way EMail works on your node. Once these settings have been made, you should not have to use this feature again until you want them changed. The following illustration shows a sample Setup Options pop-up form.

Note: Not all setup options may be available at your site.

Below the Setup Options banner the current version of EMail is displayed. Select or deselect options as described in the table below to customize the way EMail works on your node. When you have the options set the way you want them, click OK. The Setup Options pop-up form then disappears.
At any time while using the Setup Options pop-up form, you can click the Cancel button to close the form without changing any settings. Any selections you made on the pop-up will be ignored. Click Help to display the Setup Options Help pop-up form.

The following table describes options that may be selected on the Setup Options pop-up form.

### SetupOptions

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Group:</td>
<td>The group selected appears by default in the Group field, and all individual addresses represented will by default on the address pad upon initialization of EMail. When multiple addresses are chosen, the word Multiple appears on the Groups button. Click in the Default Group button, then click an address group. To set to None, click Clear on the pop-up form.</td>
</tr>
<tr>
<td>Verify before sending?</td>
<td>If selected, a pop-up form appears when you click Send. You may continue or cancel.</td>
</tr>
<tr>
<td>Auto–Print on send?</td>
<td>If selected, the system automatically prints a copy of the message on the local printer for this node when you click Send.</td>
</tr>
<tr>
<td>Verify before printing?</td>
<td>If selected, a pop-up form appears when you click Print from the EMail main window. You may continue or cancel.</td>
</tr>
<tr>
<td>Verify before quitting?</td>
<td>If selected, a pop-up form appears when you click Quit. You may continue or cancel.</td>
</tr>
<tr>
<td>Verify if message has been sent or saved?</td>
<td>If selected, a pop-up form appears if you click Quit and have not sent or saved your last message.</td>
</tr>
<tr>
<td>Auto view on file selection?</td>
<td>If selected, clicking a file on the View/Import pop-up form automatically opens it for viewing. Otherwise, click View to see the selected file.</td>
</tr>
<tr>
<td>Always send a copy to my address?</td>
<td>If selected, when you send a message, it automatically goes to the address of the node you are working on. This has the same effect as adding the address this this.</td>
</tr>
<tr>
<td>Print Extra Copy at Node ID:</td>
<td>If selected, when you send a message, it automatically spools for printing at up to four nodes named here.</td>
</tr>
<tr>
<td>Word Wrap:</td>
<td>If selected, the word wrap in the message area is set with predefined values. Options are available for no word wrap and word wrap to a specific column.</td>
</tr>
</tbody>
</table>

### Selecting a Message Type

Near the center of the control area on the EMail main window are two boxes that allow you to choose a message type, with General Message already checked, as shown here:
Note: This section applies only to users at the ATCSCC. Users at other sites may not send numbered advisories.

If Numbered Advisory is selected, the following advisory prefix appears above the message pad:

![Numbered Advisory](image)

When you send the message, the system assigns it an advisory sequence number, which replaces the x string. The advisory sequence number is based on the number of advisories that have already been sent today from the ATCSCC. (The sequence number initializes to one each day at midnight.) The advisory prefix becomes a part of the message that is sent to selected addresses.

If General Message is checked, the words “GENERAL MESSAGE” appear above the message pad with no sequence number.

Either General Message or Numbered Advisory is selected by default, depending on your current EMail setup. You may select a message type at any time before sending a message by clicking the appropriate box.

**Composing a Message**

To compose your message, you may enter text directly and/or use the text from a selected file (which can then be edited as necessary), as described in the following paragraphs.

**Entering and Editing Text**

The message pad, on the bottom left of the EMail window, is where your message is constructed and displayed as you build it. All text on this pad may be edited at any time using standard TFMS editing keys. For information about editing and scrolling through text, see Appendix B. If you are composing a numbered advisory, the advisory prefix cannot be edited.
Using Text from a File

The View/Import button displays a pop-up form that allows you to search for and select a file from one of the following file types:

<table>
<thead>
<tr>
<th>Types</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard Messages</td>
<td>Standard FAA messages or templates. These may be added, edited, or deleted by your System Administrator using Supervisory Mode.</td>
</tr>
<tr>
<td>Saved Messages</td>
<td>Any message or message template that you have named and saved.</td>
</tr>
<tr>
<td>Sent Messages</td>
<td>All messages that have been sent are available until purged by the System Administrator.</td>
</tr>
<tr>
<td>Received Messages</td>
<td>All messages that have been received are available until purged by the System Administrator.</td>
</tr>
<tr>
<td>Unread Messages</td>
<td>All messages that have not been read.</td>
</tr>
<tr>
<td>Reports</td>
<td>All flight reports or other reports that currently reside in the reports directory.</td>
</tr>
</tbody>
</table>

Once you have selected a file, the entire text of that file can be appended to the message that you are currently composing. Once appended, it can then be edited as you would edit any text.
The View/Import pop-up form lets you select the file type, change the pathname, and use text present in the file as a search string. The following procedure explains these steps:

<table>
<thead>
<tr>
<th>What To Do</th>
<th>Select and append a text file to your message</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Click <strong>View/Import</strong>. The View/Import pop-up form appears, as shown in the following illustration.</td>
<td></td>
</tr>
</tbody>
</table>

![View/Import pop-up form](image.png)

2. Click the file type file you want to use. The Search Path field changes to the directory where those files are stored on your node.

3. Modify the Search Path and Contains fields if necessary. For example, to search for all ORD reports on //dsk02, edit the fields to look like this:  
   **Search Path:**
   
   ![Search Path](image.png)
   
   **Contains:**
   
   ![Contains](image.png)

   For instructions on editing fields, see page 11–3.

4. Click **Search**. The system searches for any files matching either the filename or the sample text you entered and displays the filename on the pop-up form.

5. Click the appropriate file. Depending on how EMail is set up on your node, the file may appear in its own window. If not, click **View** to display it. You may also print it by clicking **Print**.

6. Click **Import**. The system appends the entire text of the selected file to the bottom of the message you are constructing, and the pop-up form disappears.
If you need help, click **Help**, which displays the View/Import Help pop-up form. At any time while using the View/Import form, you can click **Close** to close the form without appending any text to your message.

**Clearing the Message Pad**

EMail allows you to clear the message pad and compose a new message. Click **Clear Message** in the EMail window, **Clear Msg** on the View/Import pop-up form, or **Clear Message** on the Options pull-down menu to remove all text in the message pad.

If you have not saved, sent, or printed the message, you can restore text you have cleared. To do this, click **Options** and then click **Undo Clear** message. Text in the address pad is not affected.

**Saving Messages**

The **Save** button displays a pop-up form that allows you to save whatever you have composed in the message pad as a template for future use. You can save a message at any time without sending it.

Messages are saved when you send them. The system stores sent and saved messages in two separate directories.

<table>
<thead>
<tr>
<th>What To Do</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Save the text of your message as a message template</strong></td>
</tr>
<tr>
<td>1. Click <strong>Save</strong>. The Save Message pop–up form appears:</td>
</tr>
<tr>
<td><img src="image" alt="Save Message Pop-up Form" /></td>
</tr>
<tr>
<td>2. Enter a filename.</td>
</tr>
<tr>
<td><strong>Note:</strong> You may use underscore characters and periods. The system does not recognize spaces, and substitutes a space for an underscore.</td>
</tr>
<tr>
<td>3. Press <code>&lt;Enter&gt;</code> or click <strong>Save</strong>. The Save Message pop–up form disappears. If necessary, click <strong>Help</strong> to display the Save Message Help pop-up form.</td>
</tr>
<tr>
<td><strong>Note:</strong> Each time you click <strong>Save Message</strong>, the filename of your last stored message appears in the Save Message pop–up form. After clicking <strong>Clear Message</strong> or <strong>Send</strong>, the Filename field clears.</td>
</tr>
</tbody>
</table>

At any time while using the Save Message pop-up form, you can click **Cancel** (or press `<Esc>`) to close the form without saving your message.
Specifying Addresses

To specify addresses, you may enter them directly in the address pad and/or select them from lists of individual addresses and address groups. The addresses you specify must be valid addresses on one (or more) of the following networks:

- **National Airspace Data Interchange Network (NADIN)**
  Used to send messages and advisories to ARTCCs, Flight Service Stations, Canadian Centers, and U.S. Military sites. These addresses are limited to the ATCSCC.

- **Aeronautical Radio Inc. Network (ARINC)**
  Used to send messages and advisories to airlines. These addresses are limited to the ATCSCC.

- **Traffic Management System network (TMS)**
  Used to send messages and advisories to any TFMS node at an TFMS site.

Entering or Editing Addresses Directly

The address pad, at the top left of the window, is where you specify mail addresses. All text on this pad, whether typed directly or supplied by the system, can be edited at any time using standard TFMS editing keys.

To enter addresses directly, type individual address identifiers for one or more of the three networks. If you are not sure about the correct address format, select your addresses from a list. Do not enter the name of an address group on the address pad.

Selecting Individual Addresses

The Open Addresses button displays a pop-up form that allows you to select individual addresses from pre-defined lists and copy them to the address pad. Every time you use this form to copy addresses to the address pad, it adds them to the addresses that are already there. Once the addresses are on the address pad, you can edit them as necessary.
What To Do

Select individual addresses from a list

1. Click Open Addresses.
The Select Addresses pop–up form appears.

<table>
<thead>
<tr>
<th>ETMS</th>
<th>NADIR</th>
<th>ARINC</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACE ALL</td>
<td>ZAB</td>
<td>ADX0068</td>
</tr>
<tr>
<td>ADV ALL</td>
<td>ZAU</td>
<td>ADBRMET</td>
</tr>
<tr>
<td>AEA ALL</td>
<td>ZBW</td>
<td>ALLLQHP</td>
</tr>
<tr>
<td>AGA ALL</td>
<td>ZDC</td>
<td>ALLDOWN</td>
</tr>
<tr>
<td>ANE ALL</td>
<td>ZDV</td>
<td>ALLKATW</td>
</tr>
<tr>
<td>ANI ALL</td>
<td>ZFW</td>
<td>ALLKQTYW</td>
</tr>
<tr>
<td>ASC ALL</td>
<td>ZHI</td>
<td>ALLMSUS</td>
</tr>
<tr>
<td>ASW ALL</td>
<td>ZID</td>
<td>ALLRP</td>
</tr>
<tr>
<td>ATL ALL</td>
<td>ZJK</td>
<td>ALLOOTW</td>
</tr>
<tr>
<td>AWP ALL</td>
<td>ZKC</td>
<td>ARADDGP</td>
</tr>
<tr>
<td>BOS ALL</td>
<td>ZLA</td>
<td>ASAFCEV</td>
</tr>
<tr>
<td>BW ALL</td>
<td>ZLC</td>
<td>ATOFUA</td>
</tr>
<tr>
<td>C3 ALL</td>
<td>ZMA</td>
<td>ATLODC</td>
</tr>
<tr>
<td>CLI ALL</td>
<td>ZME</td>
<td>ATLDOOL</td>
</tr>
<tr>
<td>CVG ALL</td>
<td>ZHP</td>
<td>ATLFAE</td>
</tr>
<tr>
<td>DCA ALL</td>
<td>ZNY</td>
<td>ATLNEA</td>
</tr>
<tr>
<td>DEH ALL</td>
<td>ZOA</td>
<td>ATLDOOL</td>
</tr>
<tr>
<td>DEF ALL</td>
<td>ZOB</td>
<td>ATLAYS</td>
</tr>
<tr>
<td>DFW ALL</td>
<td>ZSE</td>
<td>ATLOEFA</td>
</tr>
<tr>
<td>DFW ALL</td>
<td>ZIL</td>
<td>AVSDQOD</td>
</tr>
<tr>
<td>EDMONTON ALL</td>
<td>ZIL</td>
<td>AVPCCUS</td>
</tr>
<tr>
<td>FSC ALL</td>
<td>FSD ALL</td>
<td>AVPDWTW</td>
</tr>
</tbody>
</table>

2. Click the addresses for your mail from one or more of the lists.

   Note: ATCSCC users may select from any list while other users must select from the TFMS list only, as the other two lists are blank.

   • To clear selections and start over, click Clear.
   • To clear address already shown in the address window, click Clear Addresses.

3. Click OK (or press <Enter>).
The system writes all of the selected addresses in the address pad, and the pop–up form disappears. If any text was already in that pad, the new addresses are appended next to the existing text.

At any time while using the Select Addresses pop-up form, you can click Cancel to close the form without appending any addresses to your address pad.
# Selecting Address Groups

An address group is a pre-defined list of addresses identified by a single keyword. Standard address groups used throughout the system are maintained on your node and may be viewed or edited by your System Administrator.

The **Group** button and field, shown here, are located on the EMail main window, at the bottom of the Select Addresses pop-up form and on the Options pull-down menu. The field indicates any selected address groups.

![Group: NONE](image)

This field cannot be edited directly, but clicking **Group** displays a pop-up form that allows you to choose an address group from a list. Every time you use the pop-up form to copy addresses to the address pad, it adds them to the addresses that are already there. Once the addresses are on the address pad, you may edit them as necessary.

<table>
<thead>
<tr>
<th>What To Do</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Select one or more address groups</strong></td>
</tr>
<tr>
<td>1. Click <strong>Group</strong>. The Address Groups pop–up form appears.</td>
</tr>
<tr>
<td>2. Click one or more address groups from the list.</td>
</tr>
<tr>
<td>3. Click <strong>OK</strong> or press &lt;Enter&gt;. The pop–up disappears and the name of the address group you selected appears in the Group field.</td>
</tr>
</tbody>
</table>

If the Select Addresses pop–up form appears, click **OK** to display your addresses in the main window.

If you did not go through the Select Addresses pop–up form, your addresses already appear in the main window.

All of the individual addresses represented by the group you selected are written in the address pad. If text was already on that pad, the new addresses are appended next to the existing addresses.

**Note:** Depending on how EMail is set up at your site, this form may display only a subset of the address groups that are available on the system. To display all available addresses, click **Show Std**; it toggles to **Show All**, or back to the subset.
At any time while using the Address Groups pop-up form, you can click Cancel (or press <Esc>) to close the form without appending addresses to your address pad.

If you choose more than one address group at the same time, the Group field displays the word Multiple to indicate that more than one address group has been selected.

**Clearing the Address Pad**

EMail allows you to clear the address pad and specify new addresses. Click **Clear Addresses** in the EMail window, on the Select Addresses pop-up form, or on the Options pull-down menu to remove all text in the address pad.

If you have not saved, sent, or printed the message, you can restore text you have cleared. To do this, click the **Options** pull-down menu and click **Undo Clear Addresses**. Text in the message pad is not affected.

**Printing and Sending Messages**

When you have completed selecting a message type, composing a message, and specifying addresses, your completed EMail window should resemble the following illustration.
Printing
You may print a message without sending it at any time, as long as there is text in the message pad. To do this, click Print. Depending on your EMail setup, you may see the following confirmation message:

Are you sure you want to print this message?

OK Cancel

If the confirmation pop-up form appears, click OK. All text in the message pad prints on the local printer for this node.

Sending
By clicking Send, you can send a message if text appears on the message pad and at least one valid address identifier appears on the address pad. Depending on your EMail setup, you may see the following confirmation message:

Are you sure you want to send this message?

Send Now Return to Mail

If the confirmation message appears, click Send Now. The following happens to your message:

- It is sent to all valid addresses specified on the address pad.
- It is saved in the /ETMS/email/data/sent_msgs directory.
- It prints on your local printer if Auto-Print is specified in your setup.

If this is a numbered advisory, the system assigns an advisory number, which prints on the message at all destinations and in the copy that is saved on line.

When you send messages, the Notify icon in the upper right corner of the EMail window should flash and momentarily display the words Msg Sent. A beep sounds when the message transfer is successful.

Error Handling
If you click Send without first specifying addresses, the system displays an alert message and does not send, save, or print the message.

An error message appears in the Notify window for each invalid address when you click Send, while the system sends the message to the valid addresses on the pad.

If you click Send or Print when the message pad is empty, the system displays an alert message and does not proceed.
**Quitting EMail**

To quit EMail at any time, click Quit. Depending on your EMail setup, you may see the following confirmation message:

![Confirmation Message]

Clicking **Yes** makes the EMail window disappear without saving messages. When you quit EMail, currently displayed text or addresses will not reappear the next time you start the program. If you want to hold work-in-progress while you go to another function, you should minimize the EMail window. Any changes you made on the Setup Options pop-up form during this session are saved and in effect the next time you invoke EMail.

**Receiving Messages**

Whenever your node receives a message from another TFMS site, the following actions occur.

The Notify icon on the EMail interface turns to medium priority status. The word Read appears on the icon and a beep sounds to indicate that you received a message.

![Notify Icon]

The message prints on the local printer for your node. However, your System Administrator may configure your node so that messages do not print automatically, or so that only one node at your site prints messages automatically.

The message is saved in the directory `/ETMS/shared/data/rcvd_msgs`. It is now available for your use in future EMail sessions.
Summary of EMail Features

The following table describes the actions that result when you select each item appearing in the EMail window.

### EMail Items

<table>
<thead>
<tr>
<th>Item</th>
<th>What it does</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Displays a pull–down menu from which you may select View/import, Save, Send, Print, Pop Notify, or Quit.</td>
</tr>
<tr>
<td>Edit</td>
<td>Displays a pull–down menu from which you may select editing functions.</td>
</tr>
<tr>
<td>Options</td>
<td>Displays a pull–down menu from which you may select address and message functions.</td>
</tr>
<tr>
<td>Format</td>
<td>Displays a pull–down menu from which you may select buttons or icons to Display or Remove messages.</td>
</tr>
<tr>
<td>Help</td>
<td>Displays on–line help.</td>
</tr>
<tr>
<td>Clear Addresses</td>
<td>Clears all addresses from the address pad and any group selection.</td>
</tr>
<tr>
<td>Open Addresses</td>
<td>Displays a pop–up form that allows you to select individual addresses.</td>
</tr>
<tr>
<td>Group</td>
<td>Displays a pop–up form that allows you to select address groups.</td>
</tr>
<tr>
<td>Clear Message</td>
<td>Clears all text from the message pad, including the advisory prefix.</td>
</tr>
<tr>
<td>View/Import</td>
<td>Displays a pop–up form that allows you to select standard, saved, sent, or received messages, or reports and appends them to the message.</td>
</tr>
<tr>
<td>Numbered Advisory</td>
<td>Causes an advisory prefix to appear at the top of the message. An advisory number is assigned to the message when it is sent.</td>
</tr>
<tr>
<td>General Message</td>
<td>Removes advisory prefix from the top of the message.</td>
</tr>
</tbody>
</table>
### EMail Items (Continued)

<table>
<thead>
<tr>
<th>Item</th>
<th>What it does</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send</td>
<td>Sends the current message to the selected addresses, saves the message in the Sent Messages directory, and prints the message to the local printer if Auto–print is selected in setup. May require you to validate if specified in EMail setup.</td>
</tr>
<tr>
<td>Save Messages</td>
<td>Saves the text of the message for future use. Displays a prompt asking for a filename.</td>
</tr>
<tr>
<td>Print</td>
<td>Prints the entire contents of the message pad and the advisory prefix on the local printer. May require you to validate if specified in EMail setup.</td>
</tr>
<tr>
<td>Setup</td>
<td>Displays a pop–up form that allows you to view or change EMail setup options.</td>
</tr>
<tr>
<td>Pop Notify</td>
<td>Pops the Notify icon into a window This is equivalent to Pop Notify icon in the CDE Toolbar.</td>
</tr>
<tr>
<td>Quit</td>
<td>If specified in the EMail Setup window, you will have to respond to a confirmation message asking if you want to quit.</td>
</tr>
</tbody>
</table>
Using Background EMail

You can send a brief message from the Shell prompt without opening the graphical EMail icon by following the procedure below.

<table>
<thead>
<tr>
<th>What To Do</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Use EMail without the display</strong></td>
</tr>
<tr>
<td>1. Enter your EMail message at the % system prompt, using the following format: ETMS/email/email —a destination address —m ”your message”</td>
</tr>
<tr>
<td>2. Press <strong>Enter</strong>.</td>
</tr>
<tr>
<td>To see a list of EMail arguments, issue the help command.</td>
</tr>
<tr>
<td>/ETMS/email/emaildg/ —h</td>
</tr>
<tr>
<td>The EMail help window appears, looking like the following:</td>
</tr>
</tbody>
</table>

```
ETMS Email version V6.17
Usage: email [-h] [-a address ...] -t type [-m message]

-a address  - specifies address(es) to send
-ag group   - specifies address group(s) to send
-t type     - specifies message type
              A message type can be of type adv or gen
-m message  - specifies a message or a file to send
              A message must be in quotes. A field must start with a /.
-h          - displays this help message

Note: Start with no options to display the user interface
```
10. TFMS Autosend

TFMS Autosend automatically constructs the advisories and data files needed to implement a ground delay program, using FADT reports. Constructed files include delay times as well as advisories to be sent through the National Airspace Data Interchange (NADIN) Network and Aeronautical Radio Inc. (ARINC) Network or to other TFMS workstations. Once you have created the advisory, you can send it through TFMS EMail.

This chapter describes how to use Autosend. All of the procedural steps listed below may be performed in the order shown. However, once you invoke Autosend, the applications you actually use will depend on your task at hand.

- Invoke Autosend from the Gnome Toolbar
- Search for a Fuel Advisory Delay Table (FADT) report
- Edit the files
- Specify addresses
- Quit Autosend

At the end of this chapter is a short description of how the TFMS receives and prints incoming messages and notifies you that a message has been received. This includes instructions for acknowledging the notification and accessing the message.

Invoking Autosend from the Gnome Toolbar

You invoke Autosend from the Gnome Toolbar. Move the cursor to TFMS menu and click the left mouse button, then move to the Autosend icon, and click the left mouse or trackball button. The TFMS Autosend window appears, as shown on the next page.

The Connection Status Indicator

The small red or green box located under the Help button indicates the status of the connection between Autosend and the communications software. The color and symbol indicate the status as follows:

- GREEN: Connected
- Red: Not Connected
It is normal to see a red indicator for a short time when you first invoke Autosend or if the connection needs to be re-established. If the box does not turn green within a minute, there may be some communication problems. Contact your System Administrator.

**Autosend Basics**

The following paragraphs explain some basic procedures that you need to know in order to use the Autosend function.

### Making Selections and Getting On-line Help

To select or see help on any button or other item, move the cursor to that item and proceed as follows:

- To select the item, click the left mouse button. To de-select an item in a list that is already selected, click it again. In this section, “click” or “select” are used interchangeably. Unless otherwise indicated, this means to click with the left mouse or trackball button.

- To see online help, click the **Help** button of the current popup. This displays online help for the current popup. To remove online help, click **Close**.

You can also see general online help for the Autosend function by selecting the **Help** pull-down menu at the top-right of the window (using the left mouse or trackball button).
Autosend Pull–Down Menus

Just below the TFMS Autosend banner is another banner which contains a series of pull-down menus. They are labeled File, Edit, and Options.

- The File pull-down menu contains functions such as Import FADT, Make Subfiles, Send, Pop Notify, Print, and Quit.
- The Edit pull-down menu contains text editing functions such as Cut, Copy, Paste, Find etc.
- The Options pull-down menu contains file manipulating functions such as Revert FA file, Revert EDCT Hub/ARTCC file, and Revert EDCT Airline file.

Editing Text

The displayed SCDT file is not editable, but for the other files appearing in pads in the Autosend window, you can edit text in these pads as you would any text file. Move the cursor to the exact location you want, click the left mouse button, and start typing.

Some buttons and menus, when selected, display pop-up forms with one-line fields to fill in or edit. A cursor marker appears in the first field. This shows you where text will appear when you type. For example:

Pathname: [reports/]

To move the input cursor from field to field, press <TAB> or point and click with the left mouse or trackball button. Within a field, you can edit text normally.

Scrolling Through Lists

Some popup forms include a list of items to select, as shown in this example:

On the right side of the list and bottom is a scroll bar, and the shaded area on the scroll bar indicates the relative position of the items that are displayed within the list. The above illustration, for example, shows the beginning of the list (you can scroll down, but not up), and approximately one third of the entire list is currently displayed.

You can scroll through a list in the following ways:

- Click the scroll bar. (This scrolls to the position marked by the cursor.)
- Click the up arrow or down arrow on the scroll bar.
Popping the Window

If, while working on Autosend, you click the mouse on any other window, the entire Autosend window pops to the back of the selected window. To bring it to the front again, click the mouse on the Autosend window.

To enlarge the window display to the full screen size, click the button to the far right of the Autosend banner.

Popping the Notify Window

Selecting the File menu on the Autosend display and clicking Pop Notify pops the notify icon into a window, or pops the notify window into an icon.

Using the Autosend Function

The following procedure describes generally how to use the Autosend function to view an SCDT report and use the FADT report to implement delays. This procedure assumes that the Autosend form is already displayed. Detailed instructions on performing each step follow this procedure.

<table>
<thead>
<tr>
<th>What To Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit the FADT files using Autosend</td>
</tr>
<tr>
<td>1. Choose an FADT report to work with. You may use the FADT report associated with the SCDT report or choose a different report by selecting the File pull-down menu and clicking Import File. This displays a popup form that allows you to search for and select additional reports.</td>
</tr>
<tr>
<td>2. Create subfiles from the displayed report by selecting the Make Subfiles button. If subfiles already exist, a popup appears with the choice of using existing subfiles or creating new ones. Select the appropriate button and observe that the files are now displayed.</td>
</tr>
<tr>
<td>3. Edit the text of any of the displayed files using the HP editing keys.</td>
</tr>
<tr>
<td>4. Send the files to specified locations by selecting the Send button. This displays a popup of the following selections:</td>
</tr>
<tr>
<td>• To display a popup of address keywords that allow you to choose where to send the EDCT section, select the EDCTs… button.</td>
</tr>
<tr>
<td>• To display a popup with choices that allow you to choose where to send the FA section, select the FA… button.</td>
</tr>
<tr>
<td>• To send the EDCTs and FAs to the centers and airlines, select the All button.</td>
</tr>
<tr>
<td>• To remove the popup without making a selection, select the Cancel button.</td>
</tr>
<tr>
<td>• To display help, select the Help button.</td>
</tr>
<tr>
<td>5. Exit Autosend at any time by selecting the File pull-down menu and clicking the Quit button.</td>
</tr>
</tbody>
</table>
Choosing an FADT Report

The Autosend display shows the current FADT report, with the name shown above the displayed report. To see a list of other reports, select the File pull-down menu and clicking the Import FADT button. This displays the following popup form:

![Popup Form]

The popup displays all available reports, sorted by the last time modified. Scroll through the list of reports, if necessary, until you see one you wish to use. Move the cursor onto the report name and click the left mouse button. Then click **Open**. This removes the popup and displays the report on the Autosend form.

You may also search for other reports by entering a different pathname at the Pathname: prompt, and selecting the **Search** button. This updates the list of files using the given pathname. Selecting the **Cancel** button removes the popup form without taking any action. Selecting the **Help** button displays help on the popup.

**Making Subfiles**

Once you have a report to work with, select the Make Subfiles button to create subfiles from the displayed report. This displays the following popup if subfiles already exist:

![Subfiles Popup]

Selecting the **Cancel** button removes the popup without taking any action. Selecting **Help** displays help on the popup. Select the **Use Existing** button to use the existing subfiles, or
select the Create New button to see a new set of subfiles, which are displayed in the following illustration:

![Image of subfiles]

**Editing the Files**

Each of the three pads contains a subfile of the report. The text in each window may be edited at any time.

**Sending the Files**

Once you have edited the files, select the Send button to send the files to specified locations. The following popup is displayed.

![Image of send popup]

Selecting the Cancel button removes the popup without taking any action. Selecting the Help button displays help on the popup. The other buttons are described below.
EDCTs Button

Selecting the **EDCTs...** button displays the following popup of address choices:

![Address Popup](image)

This popup contains a checklist of each airline and ARTCC listed in the report, as well as a checklist of all TFMS Hub locations. A gray area at the top or bottom of each scroll bar indicates that there are more selections to be scrolled through. Select the center or airline that you want to send information to by moving the cursor on the airline or location name and click the left mouse or trackball button.

When you have selected all the desired addresses, select the **Send Selected** button. Depending on your Autosend setup, you may see the following confirmation message:

![Confirmation Message](image)

Selecting the **Send Now** button sends the EDCT files to the specified addresses. Selecting **Cancel** removes the popup without sending anything.
FA Button

Selecting the FA... button displays the following popup:

![FA Button Popup](image)

Select the addresses where you want the FA files sent from the displayed list. When you have selected all the desired addresses, you may send it to the Hosts, the TMUs or both by selecting the appropriate button. Selecting the Cancel button removes the popup without making any choices. Selecting Help displays help on the popup.

All Button

To send the EDCT file and the FA file to all addresses as described above, select the ALL button.

Ending the Autosend Session

To end the Autosend session, select the File menu. Click the left mouse button on Quit. This returns you to the regular display without saving any work in progress.
11. Route Manager

The Route Manager (RMGR) is an TFMS tool that provides static information on airport/navaid/fix identifiers, preferred routes, major traffic flows, and parsed routes. This information includes the location name and identifier, location latitude/longitude, geographic location, and Air Route Traffic Control Centers (ARTCCs).

Invoking Route Manager

Route Manager is invoked from the CDE Toolbar. Move the cursor inside the Route Manager icon, then click the left mouse or trackball button to display the following window. (Your display may show different text depending on your setup.)

The area in the top half of the window displays program-related messages. The bottom half displays the Route Manager Menu, containing the available RMGR commands, and the Make Selection prompt. You can also invoke RMGR from a dtterm by entering `/ETMS/com/start_rmgr` at the prompt. As soon as the selection prompt appears in the window or shell, you are ready to enter commands.

Route Manager Commands

This section explains the use of each of the following Route Manager commands:

- Decode an identifier
- Encode an identifier name
- Display preferred routes
- Display major traffic routes over a fix
- Display route parsing data
- Display expanded preferred routes
- Quit the Route Manager function
You issue the command at the cursor after the Make Selection prompt on the Route Manager Client window. You can do this in one of the following ways:

- Enter the appropriate letter from the Route Manager Menu item, indicated by parentheses ( ).
- Enter the number to the left of the menu item.

After issuing a command, press <Enter> at any time to return to the Main Menu.

**Decode an Identifier**

Issuing this command checks the specified identifier(s) against national and international listings of aeronautical locations and provides some of the following types of data:

- Latitude/longitude, location name, and ARTCC designator for an airport.
- Latitude/longitude and location name for a weather location, fix, navaid, or flight service station.

The following procedure explains how to decode an identifier.
What To Do

Use the decode command

1. After the Make Selection prompt of the Main Menu, press D <Enter>. The Decode Menu appears:

   Decode Menu
   Press <Return> to return to the Main Menu
   Enter the identifier(s).

2. Respond to the prompt, for example: DFW, <Enter>
   Data for the Dallas/Fort Worth airport is displayed, as in the example:

   ![Decode Menu Example](image)

   You can enter several identifiers. Separate each one with a space.
   For example: DFW DCA JFK SFO, press <Enter>
   Data for all of the specified identifiers is displayed. You may have to use the scroll bars to see all of the data.

3. Repeat the procedure as many times as needed to encode more identifiers.
4. To return to the Main Menu, press <Enter>.

   Note: Representative identifiers are labeled here for your convenience. Refer to them if necessary when looking at other examples of command screens within this chapter.

Encode an Identifier Name

Issuing this command provides the following information for a specified location name(s):

- Latitude/longitude, location name, and ARTCC designator for an airport.
- Latitude/longitude and location name for a weather location, fix, navaid, or flight service station.
The following procedure explains how to encode an identifier name.

**What To Do**

**Use the encode command**

1. At the Make Selection prompt of the Main Menu, press **E <Enter>**
   
   The Encode Menu appears:

   ![Encode Menu](image)

   **Encode Menu**
   
   Press <Return> to return to the Main Menu
   
   Enter the name(s) or part of the name

   **Note:** You can also issue just part of the name, e.g., phila.

2. Respond to the prompt, for example: **BANGOR <Enter>**
   
   Data for this location name is displayed, as in the following example:

   ![Location Data](image)

   You can enter several locations on one line, using a comma to separate each location, as in the following example:

   **BANGOR, SEATTLE, TRISH, press <Enter>**

   Data for all of the specified identifier names is displayed. You may have to use the scroll bars to see all of the data.

   3. Repeat the procedure as many times as needed to encode more identifiers.

   4. To return to the Main Menu, press **<Enter>**.
Display Preferred Routes

Issuing this command displays data on preferred routes between specified points and includes the ARTCCs that the preferred routes pass through. The following procedure explains how to display preferred routes.

What To Do

Use the preferred routes command

1. At the Make Selection prompt of the Main Menu, press P <Enter>

   The Preferred Route Menu appears:

   What is the origination airport (or all)?:

   Preferred Route Menu
   Press <Return> to return to the Main Menu
   What is the origination airport (or all)?:

2. Respond to the origination airport prompt,
   for example: MSP <Enter>

   Note: Entering all in step 2 displays preferred routes from all possible airports to the destination entered in the next prompt.

3. Respond to the destination airport prompt, for example: ORD, press <Enter>

   Entering all in step 3 displays preferred routes from the origination airport you entered to all possible destination airports.

   Data for the selected preferred route is displayed, as in the following example:

   MSP-> ORD: MSP PSU JUL STAR ORD
   Centers: 2MP 7 ZAU
   MSP-> ORD: MSP U2 U7 KRENA ORD
   Centers: 2MP ZAU ZAU

4. Repeat the procedure as many times as needed to see more preferred routes.

5. To return to the Main Menu, press <Enter>.
Display Major Traffic Flows over a Fix

Issuing this command provides information on the major traffic flows over one or more points. The following procedure explains how to display major traffic flows over a fix.

**What To Do**

**Use the major traffic flows command**

1. At the Make Selection prompt of the Main Menu, press M <Enter>
   The Over Fix Menu appears:

   **Over Fix Menu**
   Press <Enter> to return to the Main Menu.
   Enter the identifier(s) of a valid fix or press <Enter>.

2. Respond to the prompt, for example: J522, press <Enter>
   Data is displayed, as in the following example:

   ```
   EDL -> MSP: EDL CTR CUN STR J547 BUF VOT J603 TUC J522 GBD NICKL-STAR MSP
   GOS -> MSP: GOS MNT CTR STR J547 BUF VOT J603 TUC J522 GBD NICKL-STAR MSP
   BUF -> EWR: BUF V14 BESTS J522 ENK SHAF-STAR EWR
   BUF -> EWR: BUF V14 BESTS J522 ENK Y267 WEESP V499 COATE EWR
   BUF -> LGA: BUF V14 BESTS J522 EXOTL RKA MOBISTAR LGA
   BUF -> LGA: BUF V14 BESTS J522 EXOTL STAR LGA
   EWR -> MSP: EWR GAVEL J555 BUV YOT J603 TUC J522 GBD NICKL-STAR MSP
   EWR -> MSP: EWR GAVEL J555 BUV YOT J603 TUC J522 GBD NICKL-STAR MSP
   JFK -> MSP: JFK GAVEL J555 BUV YOT J603 TUC J522 GBD NICKL-STAR MSP
   LGA -> MSP: LGA GAVEL J555 BUV YOT J603 TUC J522 GBD NICKL-STAR MSP
   PVD -> MSP: PVD PUT CTR CUN STR J547 BUV YVI J603 TUC J522 GBD NICKL-STAR MSP
   ROC -> EWR: ROC V14 BESTS J522 EXOTL SHAF-STAR EWR
   ROC -> EWR: ROC V14 BESTS J522 EXOTL WEESP V499 COATE EWR
   ROC -> LGA: ROC V14 BESTS J522 EXOTL RKA MOBISTAR LGA
   ROC -> LGA: ROC V14 BESTS J522 EXOTL RKA MOBISTAR LGA
   YTZ -> LGA: YTZ V232 RKB V14 BESTS J522 EXOTL RKA MOBISTAR LGA
   ```

   You can enter several identifier codes on one line at the prompt, using a comma to separate each code, for example: MSP, J522, NICKL-STAR, <Enter>
   Data for all of the major traffic flows is displayed on the screen. You may have to use the scroll bars to see all of the data.

3. Repeat the procedure as many times as needed to see more major traffic flows over fixes.
4. To return to the Main Menu, press <Enter>. 
Display Route Parsing Data

Issuing this command parses a route and then provides some of the following data:
ARTCCs that the original route passes through.
Preferred routes between endpoints.
ARTCCs that the preferred routes pass through.
The following procedure explains how to parse a route and display the data.

What To Do

Use the route parsing command

1. At the Make Selection prompt of the Main Menu, press R <Enter>
The Route Parsing Menu appears:

Note: Route refers to the route between origination and destination points.

2. Respond to the prompt, for example: JFK ORD <Enter>
Data for the route you entered is displayed, for example:

Note: A ? indicates that no ARTCC information is available for the specified identifier.

You can enter several route originations and destinations on one line. Leave a space between the origination and the destination, and use a comma between each route in a multiple route entry. For example:

JFK ORD, PHL ORD <Enter>

Data for all of the specified routes is displayed on the screen. You may have to use the scroll bars to see all of the data.

3. Repeat the procedure as many times as needed to display more route parsing data.
4. To return to the Main Menu, press <Enter>.
Display Expanded Preferred Routes

Issuing this command provides expanded data on preferred routes between two specified points, including the following:

- FAA-assigned location code
- FAA-assigned location name
- ARTCC location
- Geographic location: city, state

The following procedure explains how to display expanded information about a preferred route.
What To Do

Use the expanded preferred routes command

1. At the Make Selection prompt of the Main Menu, press X <Enter>

   The Expanded Preferred Route Menu appears:

   | Expanded Preferred Route Menu |
   | Press <Enter> to return to the Main Menu |
   | What is the origination airport? : |

2. Respond to the origination airport prompt, for example: **MSP <Enter>**
   Respond to the destination airport prompt, for example: **ORD <Enter>**
   Data for the preferred route you entered is displayed, for example:

   ```
   | Expanded preferred route: MSP -> ORD |
   | MSP ZEP MINNEAPOLIS-ST PAUL INTL/VOLD-CHANCELLOR/ MINNEAPOLIS, Minnesota |
   | RST ZEP ROCHESTER VOR/DME ROCHESTER, Minnesota |
   | FUL-STAR |
   | ORD ZAU CHICAGO O’HARE INTL CHICAGO, Illinois |
   | Expanded preferred route: MSP -> ORD |
   | MSP ZEP MINNEAPOLIS-ST PAUL INTL/VOLD-CHANCELLOR/ MINNEAPOLIS, Minnesota |
   | PV |
   | KSI |
   | KSI ZAU State: Illinois |
   | ORD ZAU CHICAGO O’HARE INTL CHICAGO, Illinois |
   ```

   You can enter several expanded preferred route originations and destinations on one line. Leave a space between the origination and the destination, and use a comma between each route in a multiple route entry. For example, at the What is the origination airport? prompt, enter the following:

   **JFK ORD, PHL ORD <Enter>**

   Data for all of the expanded preferred routes is displayed. You may have to use the scroll bars to see all of the data.

3. Repeat the procedure as many times as needed to see more expanded preferred routes information.

4. To return to the Main Menu, press <Enter>.

Quit the Route Manager Function

Issuing this command lets you exit Route Manager.
What To Do

**Quit Route Manager**

At the Make Selection prompt on the Main menu, press **Q **<Enter>**.

**Note:** If you are not at the Main Menu, press **<Enter>**.
Appendix A: Request Command Reference

This appendix describes the following data sources, options and features, which are common to several or all of the Request commands:

**Data Source Alternatives**

- OAG data  
- Base (baseline) data  
- FCATA data  
  
**Request Command Options**

- Arrivals/Departures option  
- Multiple Locations  
- Time Period option  
- Filter options  
- Count options  
- Column and Sort options  
- Remarks Keywords  
- Equipment Types  
- Every option  
- Setlen option  
- Secondary Requests  
- Request Scripts  

You should use this appendix in conjunction with the references for the individual Request commands in Chapter Five of this manual. Chapter Five includes a complete description of each command and options that are unique to individual commands.
Data Source Alternatives

The default data source for request commands is the Traffic Database (TDB). Because the TDB is the default, you cannot specify the TDB as the data source in a request command. If you want a different source of data, you can specify one of the following:

OAG

The OAG data source applies only to Request ARRD, Request Count, Request List, and Request Listo.

You can specify OAG data (from the Schedule Database) as the source of data regardless of the time of the request. (Normally, data comes from the Schedule Database only if the time period for your request is beyond the scope of the Flight Database; that is, if it is more than 15 hours in the future.) To specify the OAG as the data source, type **OAG** immediately after the word **REQ**. For example:

![Command Line](image)

BASE

The Base (Baseline) data source allows you to show the flight count or flight list report based on baseline sectors rather than current sectors. Current sectors are shown by default in the flight count or list reports.

The following example provides a request for a sector flight count. Without a data source identified, the report will provide data on the current sectors.

![Command Line](image)
The default flight count report is shown below.

Adding the word **BASE** before the sector name allows you to show the flight count report based on Baseline sectors. The following sample shows a request for a flight count of sector ZMP20 in its baseline configuration.
The baseline flight count report is shown below.

To request a default flight list using current sector data, you would issue a command like the following: **REQ ZMP20 LIST**. To request a flight list based on Baseline sector data, you would issue a command like the following: **REQ BASE ZMP20 LIST**.

**FCATA**

The FCATA data source allows you to show the flight count or flight list report based on the flights predicted to traverse the FEA/FCA.

To specify the FCATA as the source, type **FCATA** immediately after the word **REQ**. For example:
Secondary Option

Selecting FCATA as the data source allows you to obtain a report of the flights predicted to traverse the FEA/FCA that match one or more of the secondary filters using the following formats.

\[
\text{REQ FCATA fea/fcaname date (mm/dd) start_time (hhmm) end_time (hhmm))}
\]

\[
\text{SECONDARY name(s) of secondary filters}
\]

\[
\text{REQ FCATA fea/fcaname date (mm/dd) start time (hhmm) end time (hhmm) filters SECONDARY name(s) of secondary filters LIST}
\]

Request command filter parameters must be specified before the \text{SECONDARY} keyword, as in the following examples.

\[
\text{REQ FCATA FCA_DEN 0622 0130 0530 SECONDARY SLC_DEP}
\]

\[
\text{REQ FCATA FCA_DEN 0622 0130 0530 SECONDARY SLC_DEP LIST}
\]

You can enter options with requests using FCATA in the same way that you would in other Request commands. For information on using options and additional information about the specific reports, see the Request List Options section, starting below.

If you wish your reports to come from Hubsite data rather than your own local server, specify HUBSITE or HUB in your requests.

Request Report Options

Arrivals/Departures Option

This section applies to Request Count, Request List, Request Listo, and Request VT.

If you are requesting a report on an airport or Air Route Traffic Control Center (ARTCC), you can limit the report to arrivals only or departures only by entering \text{A} or \text{D} on the command line. If you do not enter \text{A} or \text{D} on the command line. If you do not enter \text{A} or \text{D}, the report includes both. If you include this option, it should appear immediately before the location identifier, as shown here:
If you specify both a primary and a secondary place of interest in your location designator (see the next section), the A or D refers to arrivals or departures at the primary place of interest. For example, the following command is requesting a report for arrivals to ORD which are departing from LAX:

![Command Line]

**Multiple Locations**

For flight counts, flight list, and time verification reports, you can specify multiple locations by enclosing them in brackets. This section applies to Request Count, Request List, Request Listo, and Request VT.

The location in a Request command has a two-part structure; a primary place of interest, and a secondary place of interest. These terms are described below.

**Primary Place of Interest (PPI)—required**

This is the location for which the report is being requested. It may consist of a single location or multiple locations. If the PPI consists of more than one location name, enclose the entire PPI expression in a single set of brackets, for example:

![Command Line]

In this example, the report will show all flights arriving at any of the three airports listed. If the first element in the PPI expression is an ARTCC, you may exclude one or more airports within that ARTCC by preceding the airport name with a minus sign (-), for example:

![Command Line]

In this example, the report will show all flights arriving at the airport in the ZDC center except BWI or IAD. The minus (-) sign does not work with fixes or sectors.
Secondary Place of Interest (SPI)—optional

The SPI expression follows the PPI expression and limits the flights included in the report. If an SPI is included, the report will include only those flights that travel between any PPI and any SPI location. The SPI may be a single location name, for example:

![Command Line](image1)

In this example, the report will show all flights arriving at LAX (the PPI) from SFO (the SPI). If the SPI consists of more than one location name, enclose the entire SPI expression in brackets, for example:

![Command Line](image2)

In this example, the report will show all flights between BOS and MIA and between BOS and JAX. If each location name in the SPI expression is preceded by a minus sign (-), the report will be for flights between the PPI and any location except those listed in the SPI. The next two examples show the use of the minus sign to exclude airports and ARTCCs.

![Command Line](image3)

In this example, the report will include flights between MEM and any airport except those in the ZME center. In the next example, the report will include all flights departing from ORD and all flights departing from ZOB, except those that will be arriving at CLE or PIT.

![Command Line](image4)

Note: The minus (-) sign does not work with fixes and sectors.
Using Brackets

As the preceding examples show, you must use brackets to group locations together into PPI and SPI expressions whenever you have multiple locations in either expression. Locations with and without minus signs (-) may appear in the same set of brackets. Never use more than two sets of brackets in the same request. Only one set of brackets may be used with fixes or sectors, and the minus (-) sign does not apply.

The following two examples illustrate the importance of using brackets to distinguish between PPI and SPI expressions. In the first example, both airports are part of the PPI expression, and all flights to and from ORD or IND are included in the report. In the second example, IND is considered an SPI and all flights between ORD and IND are included.

Time Period Option

This section applies to all Request commands except Request LIFP.

Days and Dates

Specifying days and dates does not apply to Request ARRD or Request Fix1.

By default, each of these reports covers a time period of five hours beginning at the current time on the current day. The time period option allows you to change these default values for report data.

You may specify a different day. Days can be entered in any one of the following ways:

- Numerical (mm/dd) 4/12
- Abbreviated month NOV. 23
- Abbreviated Day of week WED.
- Yesterday YESTERDAY
- Tomorrow TOMORROW
Hourly Periods

You may also specify an hourly period within the current day, which must be expressed in terms of a four-digit Universal Coordinated Time (UTC). Time periods can be entered with any one of the following:

- **Space** 1800 2300
- **To** in the middle 1800 to 2300
- **From** and **To** From 1800 to 2300
- **From** in the front From 1800 (five hours after time)
- **To** in the front To 1800 (five hours before time)

For example, if you want a FIXL report on Miami International Airport for April 12 from 0600 to 1200, your request would look like this:

```
Input Request:
REQ FIXL Mia 4/12 0600 1200
```

Only one day and one date may be specified for each request. If the report period is to span two days, use the day when the report period starts.

If a day of week is given but no date is specified, the system assumes that the request is made for the current or an upcoming date. For example, if a request is made for **THU**, and the current day is Thursday, information is provided for that day. If on Thursday, however, a request is made for **WED**, information is provided for the Wednesday following the current day.

If you specify **YESTERDAY** or yesterday's date, be sure that the specified time is within 15 hours in the past, as explained in the next section.

**Time Periods and Data Availability**

There are practical time limits within which you should restrict your requests when using the Time period option. You may not request flight information further than 15 hours in the past. Also, any requests beyond 15 hours in the future will not return information about fixes or sectors. Requests beyond the scope of the Schedule Database (approximately 45 days in the future) will generate an empty report.
Relative Time Periods

You can specify times relative to the current time (rounded down to the previous hour). To do so, type a plus sign (+) followed by the number of hours after the current hour or a minus sign (-) followed by the number of hours before the current hour. This is sometimes referred to as an offset from the current time.

For example, if the current time is 1449, the following command generates a report for the four-hour time period from 1300 (one hour before 1400) to 1700 (three hours after 1400):

```
REQ DCA -1 3 LIST
```

To specify times relative to the current quarter hour (rounded down), include the tilde character (~). For example, if you add a tilde to the previous example (using the same current time of 1449), the command generates a report for the period from 1345 to 1645.

```
REQ DCA -1~ 3~ LIST
```

Relative times can be mixed with absolute times, as shown in the following examples:

```
REQ MEM -1 1400 LIST
```

```
REQ SEA 1600 -2 LIST
```
In any request, the two times specified must be in chronological order (the second time must fall later than the first). If using relative times would otherwise cause the second time to be earlier than the first, the system interprets the second time as falling on the following day. (For example, if the current time is 1800, the system interprets 1700 -2 to be the period from 1700 today to 1600 tomorrow.)

**Filter Options**

This section applies to Request Count, Request List, Request Listo, and Request VT. The default reports for the commands listed above display flight data for all flights traveling to or from the place or places you indicate. However, you can filter the information to reflect only specific flights you want included in the report.

Many different filter options are available. These options should appear after the location designator(s) and, if included, the time period option. Filter options are described in the two tables that follow. (The examples in the table show Request Count commands.)

### Filter Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>What you do</th>
<th>Example</th>
</tr>
</thead>
</table>
| Airway       | Includes only flights that use specified airway(s) [or excludes flights that use specified airway(s) from report]. | Enter AIRWAY, then the name of one or more airways, each separated by a space. (To exclude, precede each airway with -.) | REQ SFO AIRWAY J80
               |                                                                            |                                                                            | REQ SFO AIRWAY - J80                                        |
| Center       | Includes only flights that traverse specified center(s) (ARTCCs) [or excludes flights that traverse specified center(s) from report]. | Enter CENTER, then one or more ARTCC designators, each separated by a space. (To exclude, precede each ARTCC with -.) | REQ MEM CENTER ZAU
               |                                                                            |                                                                            | REQ MEM CENTER - ZAU                                        |
| Destination  | Includes only flights whose destination airports are unknown (or excludes flights whose destinations are unknown). | Enter DEST UNKW. (To exclude, precede UNKW with -.)                        | REQ LAX DEST UNKW
| Unknown      |                                                                            |                                                                            | REQ LAX DEST –UNKW                                          |
| DFIX         | Includes flights departing from a specified departure fix                  | Enter DIFX, then the name of the fix                                         | REQ D BOS DFIX LUCOS                                        |
| DVALL        | Includes all flights that have been diverted.                              | Enter DVALL and an airport identifier in a Request Count, List/Listo or VT report. | REQ A MIA DVALL LIST                                        |
Filter Options (Continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>What you do</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>DVREC</td>
<td>Includes airborne and grounded flights that are recoveries of flights that have been diverted.</td>
<td>Enter DVREC and an airport identifier in a Request Count, List/Listo or VT report.</td>
<td>REQ A JFK DVREC A LIST</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>REQ A JFK DVREC G LIST</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>REQ A JFK DVREC A G LIST</td>
</tr>
<tr>
<td>Fix</td>
<td>Includes only flights traversing specified fix(es) [or excludes flights that traverse specified fix(es) from report].</td>
<td>Enter FIX, then the name of one or more fixes, each separated by a space. (To exclude, precede each fix with -.)</td>
<td>REQ BOS FIX MHTREQ BOS FIX -MHT</td>
</tr>
<tr>
<td>Origin Unknown</td>
<td>Includes only flights whose origin airports are unknown (or excludes flights whose origin airports are unknown).</td>
<td>Enter ORIG UNKW. (To exclude, precede UNKW with -)</td>
<td>REQ ORD ORIG UNKWREQ ORD ORIG - UNKW</td>
</tr>
<tr>
<td>Sector</td>
<td>Includes only flights traversing specified sector(s) [or excludes flights that traverse specified sector(s) from report].</td>
<td>Enter SECTOR, then the name of one or more sectors, each separated by a space. (To exclude, precede each sector with -.)</td>
<td>REQ IAD SECTOR ZDC17REQ IAD SECTOR -ZDC17</td>
</tr>
<tr>
<td>Arrival Fix</td>
<td>Includes flights arriving at a specified arrival fix.</td>
<td>Enter AFIX, then the name of the fix.</td>
<td>REQ A BOS AFIX PVD</td>
</tr>
<tr>
<td>Aircraft Categories</td>
<td>Includes specified categories only (or excludes specified categories from report).</td>
<td>Enter AC_CAT, then the category designator(s): J for jet, P for propeller, and T for turbo prop. (To exclude, precede designator with -.)</td>
<td>REQ BOS AC_CAT JREQ JFK AC_CAT -J</td>
</tr>
<tr>
<td>Aircraft Classes</td>
<td>Includes specified classes only (or excludes specified classes from report).</td>
<td>Enter CLASS, then the class designator(s): H for heavy, L for large, and S for small. (To exclude, precede designator with -.)</td>
<td>REQ DCA CLASS HREQ DCA CLASS -L</td>
</tr>
<tr>
<td>Flight times and conditions</td>
<td>Includes flights for only specified arrival/departure time types and actual time periods.</td>
<td>Enter Specific time type, then a time qualifier (see next table).</td>
<td>(See Table below)</td>
</tr>
<tr>
<td>Aircraft Types</td>
<td>Includes specified aircraft types only (or excludes specified types from report.)</td>
<td>Enter TYPE, then the aircraft type designator(s), each separated by a space. (To exclude, precede designator with -.)</td>
<td>REQ IAH TYPE B747</td>
</tr>
</tbody>
</table>
Filter Options (Continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>What you do</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Airlines</td>
<td>Includes flights for specified airlines only (or excludes specified airlines from report).</td>
<td>Enter AIRL, then the airline identifier(s), separated by a space. (To exclude, precede each identifier with -.)</td>
<td>REQ JFK AIRL USA REQ ATL AIRL -DAL</td>
</tr>
<tr>
<td>RVSM</td>
<td>Includes RVSM flights that are either conformant or non-conformant.</td>
<td>Enter RVSM, then a space, followed by C to include conformant flights and –C to include non-conformant flights.</td>
<td>REQ A BOS RVSM -C</td>
</tr>
<tr>
<td>User Categories</td>
<td>Includes flights for specified user categories only (or excludes specified user categories from report.)</td>
<td>Enter USER, then the user designator(s): T for air taxi, F for cargo, C for commercial, G for General Aviation, and M for Military, (To exclude, precede each designator with -.)</td>
<td>REQ IAH USER M FREQ BWI USER -M -F</td>
</tr>
</tbody>
</table>
Flight Times and Conditions

You can filter reports according to the flight times and conditions by using one of the options listed below, in combination with the LT (less than) or GT (greater than) flight time condition. The resulting report will include only those flights with times less than or greater than a time you specify (in UTC). To use the ETE option, enter the estimated time enroute in minutes instead of specifying a UTC. You may use this option with any of the other filter options.

### Flight Times and Conditions

<table>
<thead>
<tr>
<th>What you enter</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>ARTA time condition</td>
<td>Actual runway time of arrival</td>
<td>REQ A IAD ARTA LT 1400</td>
</tr>
<tr>
<td>ARTD time condition</td>
<td>Actual runway time of departure</td>
<td>REQ D IAD ARTD GT 1400</td>
</tr>
<tr>
<td>CTA time condition</td>
<td>Controlled gate time of arrival</td>
<td></td>
</tr>
<tr>
<td>CTD time condition</td>
<td>Controlled gate time of departure</td>
<td></td>
</tr>
<tr>
<td>ETA time condition</td>
<td>Estimate based on best available time from among the other arrival time types</td>
<td></td>
</tr>
<tr>
<td>ETD time condition</td>
<td>Estimate based on best available time from among the other departure time types</td>
<td></td>
</tr>
<tr>
<td>ETE condition</td>
<td>Estimated time enroute, in minutes</td>
<td>REQ DCA ETE LT 120</td>
</tr>
<tr>
<td>ORTA time condition</td>
<td>Original runway time of arrival</td>
<td>REQ A BOS ORTA LT 1100</td>
</tr>
<tr>
<td>ORTD time condition</td>
<td>Original runway time of departure</td>
<td>REQ D BOS ORTD GT 1100</td>
</tr>
<tr>
<td>PGTA time condition</td>
<td>Proposed gate time of arrival</td>
<td>REQ A JFK PGTA LT 1100</td>
</tr>
<tr>
<td>PGTD time condition</td>
<td>Proposed gate time of departure</td>
<td>REQ D JFK PGTD GT 1100</td>
</tr>
<tr>
<td>SGTA time condition</td>
<td>Scheduled gate time of arrival</td>
<td>REQ A ZLA SGTA LT 0900</td>
</tr>
<tr>
<td>SGTD time condition</td>
<td>Scheduled gate time of departure</td>
<td>REQ D ZLA SGTD LT 0900</td>
</tr>
<tr>
<td>TGTA time condition</td>
<td>Gate time of arrival based on TFMS Total Traffic Model (TTM).</td>
<td>REQ A DFW TGTA GT 0900</td>
</tr>
<tr>
<td>TGTD time condition</td>
<td>Gate time of departure based on TFMS Total Traffic Model (TTM).</td>
<td>REQ D DFW TGTD LT 0900</td>
</tr>
</tbody>
</table>
Count Options
You may use the count option to designate a category of columns for an Area report that differs from the default format. To use this option, enter the word **COUNT**, then one of the options described in the following table.

## Count Options

<table>
<thead>
<tr>
<th>Count by</th>
<th>What you do</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aircraft Category</td>
<td>Enter COUNT AC_CAT&lt;br&gt;You may limit the display to selected categories by adding J for jet, P for propeller, and/or T for turbo prop. Precede with - to exclude.</td>
<td>REQ IAH COUNT AC_CAT&lt;br&gt;REQ IAH COUNT AC_CAT T&lt;br&gt;REQ IAH COUNT AC_CAT -P -T</td>
</tr>
<tr>
<td>Standard keywords</td>
<td>Enter COUNT AC_RMK&lt;br&gt;You may limit the display to selected keywords by adding a list of standard keywords. Precede with - to exclude.</td>
<td>REQ ORD COUNT AC_RMK&lt;br&gt;REQ ORD COUNT AC_RMK</td>
</tr>
<tr>
<td>Airline</td>
<td>Enter COUNT AIRL&lt;br&gt;You may limit the display to selected airlines by adding a list of airlines. Precede with - to exclude.</td>
<td>REQ BWI COUNT AIRL&lt;br&gt;REQ BWI COUNT AIRL AAL&lt;br&gt;REQ BWI COUNT AIRL -UAL -AAL</td>
</tr>
<tr>
<td>Airport (by origin</td>
<td>Enter COUNT AIRP&lt;br&gt;You may limit the display to selected airports by adding a list of airports. Precede with - to exclude.</td>
<td>REQ ZMA COUNT AIRP&lt;br&gt;REQ ZMA COUNT AIRP [ DCA ATL&lt;br ]REQ ZMA COUNT AIRP [-LAX -SFO]</td>
</tr>
<tr>
<td></td>
<td>for arrivals, by destination for departures)</td>
<td></td>
</tr>
<tr>
<td>Aircraft Class</td>
<td>Enter COUNT CLASS&lt;br&gt;You may limit the display to selected classes by adding H for heavy, L for large, and/or S for small. Precede with - to exclude.</td>
<td>REQ DCA COUNT CLASS&lt;br&gt;REQ DCA COUNT CLASS H S&lt;br&gt;REQ DCA COUNT CLASS -S -L</td>
</tr>
<tr>
<td>Destination Airport</td>
<td>Enter COUNT DEST</td>
<td>REQ ZSE COUNT DEST</td>
</tr>
<tr>
<td>Origin Airport</td>
<td>Enter COUNT ORIG</td>
<td>REQ ZNY COUNT ORIG</td>
</tr>
<tr>
<td>Departure Center</td>
<td>Enter COUNT DCECTR</td>
<td>REQ ZNY COUNT DCECTR</td>
</tr>
<tr>
<td>Aircraft Type</td>
<td>Enter COUNT TYPE&lt;br&gt;You may limit the display to selected types by adding a list of types. Precede with - to exclude.</td>
<td>REQ JFK COUNT TYPE&lt;br&gt;REQ JFK COUNT TYPE DC10&lt;br&gt;REQ JFK COUNT TYPE -DC10 -B747</td>
</tr>
</tbody>
</table>
## Count Options (Continued)

| User Category | Enter COUNT USER  
|----------------|------------------------------------------|
|                | You may limit the display to selected user categories by adding T for air taxi, F for freight/cargo, C for commercial, G for general aviation, and M for military. (Category labeled O for Other appears if no user category listed above applies). Precede with - to exclude. | REQ JFK COUNT USER  
|                |                                            | REQ JFK COUNT USER T G  
|                |                                            | REQ ZSE COUNT USER -F -C |

| Estimated Time Enroute | Enter COUNT ETE SPAN ###*  
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>(Specify time in hours and minutes. The example on the right is for one hour and 20 minutes.)</td>
</tr>
</tbody>
</table>

* If you use the ete span option, the report will not be displayed by time intervals.
### Column and Sort Options

The following is a list of all of the columns and sort options available with the Request List and Request VT commands.

#### Columns and Sort Options

<table>
<thead>
<tr>
<th>Label</th>
<th>Column Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC_CAT</td>
<td>Aircraft categories (jet, propeller, turbo prop).</td>
</tr>
<tr>
<td>ACTR**</td>
<td>Arrival Center.</td>
</tr>
<tr>
<td>ACID</td>
<td>Unique alphanumeric aircraft identifier (Same as IDENT option).</td>
</tr>
<tr>
<td>AC_RMK</td>
<td>Standard keywords representing flights remarks data. See Remarks Keywords in this section.</td>
</tr>
<tr>
<td>AFIX</td>
<td>Arrival fixes.</td>
</tr>
<tr>
<td>AIRL</td>
<td>Airline(s).</td>
</tr>
<tr>
<td>AIRP</td>
<td>Two columns: Origin and Destination airports.</td>
</tr>
<tr>
<td>AIRWAY*</td>
<td>A listing of airways traversed.</td>
</tr>
<tr>
<td>ALT</td>
<td>Altitude (hundreds of feet).</td>
</tr>
<tr>
<td>ARTA</td>
<td>Actual runway time of arrival. Formerly called AGTA.</td>
</tr>
<tr>
<td>ARTD</td>
<td>Actual runway time of departure. Formerly called AGTD.</td>
</tr>
<tr>
<td>ASECTR</td>
<td>Arrival sector.</td>
</tr>
<tr>
<td>BEACON*</td>
<td>A four-digit transponder code assigned to an aircraft by a NAS center. It is forwarded to the TFMS in a Beacon code (BZ) message subsequent to a flight plan and usually prior to a departure message (DZ). It is also transmitted to the TFMS prior to a center hand-off message (UZ).</td>
</tr>
<tr>
<td>CALT*</td>
<td>Current Altitude</td>
</tr>
<tr>
<td>CA_DIF*</td>
<td>The difference between ARTA and CTA, with a designator showing the status of the comparison.</td>
</tr>
<tr>
<td>CD_DIF*</td>
<td>The difference between ARTD and CTD, with a designator showing the status of the comparison.</td>
</tr>
<tr>
<td>CENTER**</td>
<td>Departure center for arrivals. Arrival center for departures.</td>
</tr>
<tr>
<td>CENTRL*</td>
<td>Listing of centers traversed.</td>
</tr>
<tr>
<td>CLASS</td>
<td>Aircraft classes (heavy, large, and small).</td>
</tr>
<tr>
<td>CTA</td>
<td>Controlled time of arrival. Corresponds to a runway arrival time. Formerly called CGTA.</td>
</tr>
<tr>
<td>CTD</td>
<td>Controlled time of departure. Corresponds to a runway departure time. Formerly called CGTD.</td>
</tr>
<tr>
<td>CTL_ELEM</td>
<td>Controlled element. Shows controlled airport, sector, or fix.</td>
</tr>
<tr>
<td>Label</td>
<td>Column Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>DCTR**</td>
<td>Departure Center.</td>
</tr>
<tr>
<td>DEST</td>
<td>Destination airport.</td>
</tr>
<tr>
<td>DFIX</td>
<td>Departure Fix.</td>
</tr>
<tr>
<td>DP*</td>
<td>Departure Procedures.</td>
</tr>
<tr>
<td>DSECTR</td>
<td>Departure sector.</td>
</tr>
<tr>
<td>DTRSN*</td>
<td>DP transition fixes.</td>
</tr>
<tr>
<td>DV_REC*</td>
<td>Diversion recovery.</td>
</tr>
<tr>
<td>EAFT</td>
<td>Estimated Arrival Fix Time.</td>
</tr>
<tr>
<td>EDFT*</td>
<td>Estimated Departure Fix Time.</td>
</tr>
<tr>
<td>EFTA</td>
<td>Estimated fix time of arrival.</td>
</tr>
<tr>
<td>ENTRY</td>
<td>Sector entry times (use with sectors only).</td>
</tr>
<tr>
<td>EQUIP</td>
<td>Equipment type, represented by prefix or suffix. (Equipment Type Prefixes and Suffixes are explained in a table on page A-22.)</td>
</tr>
</tbody>
</table>
| ETA       | Estimated time of arrival, based on best available time from among the other arrival time types. A prefix is used to indicate whether the flight has actually arrived:  
  • A - Actual arrival time (completed flight)  
  • E - Estimated arrival time (proposed or active flight) |
| ETD       | Estimated time of departure, based on best available time from among the other departure time types. A prefix is used to indicate the source of the data that is used to set the ETD; the user can judge the reliability of the data partly on the basis of the prefix, explained below.  
  • A - Active. TFMS has received a NAS or user-provided departure message.  
  • E - Estimated. TFMS has received a message indicating the flight was active, but no departure message was received.  
  • N - Early Intent. TFMS has received a user-provided early intent route.  
  • P - Proposed. TFMS has received a NAS flight plan.  
  • R - The historical route has been replaced by the assigned route.  
  • S - Scheduled. TFMS has received no flight plan. Data is based on the OAG and/or user-provided schedule updates.  
  • T - Taxi. TFMS has received a message indicating the flight has pushed off the gate. |
| ETE       | Estimated time enroute.                                                              |
| E_TYPE    | Complete aircraft equipment type. Includes both aircraft type (TYPE) and equipment type data (F/B757/A). |
| EXIT      | Sector exit times (use with sectors only).                                           |
| FIX*      | A listing of fixes traversed.                                                       |
### Columns and Sort Options (Continued)

<table>
<thead>
<tr>
<th>Label</th>
<th>Column Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GS*</td>
<td>Stands for Ground Stop, a traffic management action that halts departures for a given airport. Also refers to ground speed.</td>
</tr>
<tr>
<td>IDENT</td>
<td>Flight identifier (same as ACID option).</td>
</tr>
<tr>
<td>IGTA*</td>
<td>Initial Gate Time of Arrival</td>
</tr>
<tr>
<td>IGTDT</td>
<td>Initial Gate Time of Departure.</td>
</tr>
<tr>
<td>IN*</td>
<td>Actual time reported by the airlines for gate arrival.</td>
</tr>
<tr>
<td>LGTA</td>
<td>Airline gate time of arrival.</td>
</tr>
<tr>
<td>LGTD</td>
<td>Airline gate time of departure.</td>
</tr>
<tr>
<td>LRTA</td>
<td>Airline runway time of arrival.</td>
</tr>
<tr>
<td>LRTD</td>
<td>Airline runway time of departure.</td>
</tr>
<tr>
<td>OA_DIF*</td>
<td>The difference between ARTA and ORTA, with a designator showing the status of the comparison.</td>
</tr>
<tr>
<td>OD_DIF*</td>
<td>The difference between ARTD and ORTD, with a designator showing the status of the comparison.</td>
</tr>
<tr>
<td>OETA</td>
<td>Indicates a previously saved ETA. Formerly called OGTA</td>
</tr>
<tr>
<td>OETD</td>
<td>Indicates a previously saved ETD. Formerly called OGTD.</td>
</tr>
<tr>
<td>OFF*</td>
<td>Actual time reported by the airlines for wheels up.</td>
</tr>
<tr>
<td>ON*</td>
<td>Actual time reported by the airlines for wheels down.</td>
</tr>
<tr>
<td>ORIG</td>
<td>Origin airport.</td>
</tr>
<tr>
<td>OUT*</td>
<td>Actual time reported by the airlines for gate pushback.</td>
</tr>
<tr>
<td>PA_DIF*</td>
<td>The difference between ARTA and PGTA, with a designator showing the status of the comparison.</td>
</tr>
<tr>
<td>PD_DIF*</td>
<td>The difference between ARTD and PGTD, with a designator showing the status of the comparison.</td>
</tr>
<tr>
<td>PGTA</td>
<td>Proposed gate time of arrival.</td>
</tr>
<tr>
<td>PGTD</td>
<td>Proposed gate time of departure.</td>
</tr>
<tr>
<td>RAL</td>
<td>Last reported altitude, as displayed in a data block.</td>
</tr>
<tr>
<td>RTE*</td>
<td>Flight route.</td>
</tr>
<tr>
<td>RVSM</td>
<td>Reduced Vertical Separation Minimums. RVSM flights are conformant or non-conformant.</td>
</tr>
<tr>
<td>SA_DIF*</td>
<td>The difference between ARTA and SGTA, with a designator showing the status of the comparison.</td>
</tr>
</tbody>
</table>
### Columns and Sort Options (Continued)

<table>
<thead>
<tr>
<th>Label</th>
<th>Column Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SD_DIF*</td>
<td>The difference between ARTD and SGTD, with a designator showing the status of the comparison.</td>
</tr>
<tr>
<td>SECTOR*</td>
<td>A listing of sectors traversed.</td>
</tr>
<tr>
<td>SGTA</td>
<td>Scheduled gate time of arrival.</td>
</tr>
<tr>
<td>SGTD</td>
<td>Scheduled gate time of departure.</td>
</tr>
<tr>
<td>SPD</td>
<td>Air speed filed in a flight plan.</td>
</tr>
<tr>
<td>STAR*</td>
<td>Standard Terminal Arrival Route.</td>
</tr>
<tr>
<td>STRSN*</td>
<td>STAR Transition fixes.</td>
</tr>
<tr>
<td>STAT</td>
<td>Two columns: active and proposed flights.</td>
</tr>
<tr>
<td>TRTA</td>
<td>Gate time of arrival based on TFMS Total Traffic Model (TTM). Formerly called TGTA.</td>
</tr>
<tr>
<td>TRTD</td>
<td>Gate time of departure based on TFMS Total Traffic Model (TTM). Formerly called TGTD</td>
</tr>
<tr>
<td>TIME</td>
<td>Two columns: ETD and ETA.</td>
</tr>
<tr>
<td>TT_FCA*</td>
<td>Displays for custom FEA/FCAs the Time to Reach FCA data, which is estimated in minutes.</td>
</tr>
<tr>
<td>TYPE</td>
<td>Aircraft type (B747, etc.)</td>
</tr>
<tr>
<td>USER</td>
<td>User Category (air taxi, cargo, commercial, general aviation, military, and other).</td>
</tr>
</tbody>
</table>

* indicates the option is not available as a Sort option.

** ZXX in column means no FS or FZ message has been received.
Remarks Keywords

The following table contains the standard keywords for flight remarks data.

<table>
<thead>
<tr>
<th>Remarks Keywords</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NRP</td>
<td>National Route Program flight</td>
</tr>
<tr>
<td>CAT3</td>
<td>Flight has CATIII landing equipment</td>
</tr>
<tr>
<td>LIFEGUARD</td>
<td>Lifeguard or MEDEVAC flight</td>
</tr>
<tr>
<td>SWAP</td>
<td>Swapping flight from a standard to a nonstandard route. Usually done due to inclement weather</td>
</tr>
<tr>
<td>WXRTE</td>
<td>Flight has been rerouted due to severe weather</td>
</tr>
<tr>
<td>DVRSN</td>
<td>Diversion recovery leg</td>
</tr>
<tr>
<td>ADCUS</td>
<td>Advise Customs about this flight</td>
</tr>
<tr>
<td>ALTRV</td>
<td>Altitude Reservation. Usually a military request</td>
</tr>
<tr>
<td>FCA</td>
<td>Flight has been rerouted around a Flow Constrained Area.</td>
</tr>
<tr>
<td>HAR</td>
<td>High-altitude Airspace Redesign</td>
</tr>
<tr>
<td>PTP</td>
<td>Point to Point</td>
</tr>
</tbody>
</table>

Using Remarks Keywords

You can display columns of information for all Remarks keywords or columns for only one or more keywords. You can also exclude keywords.

Examples:

Display all remarks columns: `REQ BFI LIST ACID AC_RMK`
Display remarks column(s): `REQ BFI LIST ACID AC_RMK |NRP`
`REQ BFI LIST ACID AC_RMK |NRP |SWAP`
Exclude remarks column(s): `REQ BOS LIST ACID AC_RMK -|NRP`
`REQ BOS LIST ACID AC_RMK -|NRP |SWAP`
## Equipment Types

### A/C Type Filter Options

<table>
<thead>
<tr>
<th>What you enter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Aircraft Types</strong></td>
<td></td>
</tr>
<tr>
<td>H</td>
<td>Heavy</td>
</tr>
<tr>
<td>L</td>
<td>Large</td>
</tr>
<tr>
<td>S</td>
<td>Small</td>
</tr>
<tr>
<td>M</td>
<td>Military</td>
</tr>
<tr>
<td>C</td>
<td>Civilian</td>
</tr>
<tr>
<td>J</td>
<td>Jet</td>
</tr>
<tr>
<td>P</td>
<td>Prop</td>
</tr>
<tr>
<td>T</td>
<td>Turbo–prop</td>
</tr>
</tbody>
</table>

| **Equipment Type Prefix** | |
| T/                  | TCAS       |
| H/                  | Heavy      |
| B/                  | Both Heavy and TCAS |
| L/                  | B757 with TCAS |
| F/                  | B757 without TCAS |

### Equipment Type Suffix

<table>
<thead>
<tr>
<th>Suffix</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>NO DME</strong></td>
<td></td>
</tr>
<tr>
<td>/X</td>
<td>No transponder</td>
</tr>
<tr>
<td>/T</td>
<td>Transponder with no Mode C</td>
</tr>
<tr>
<td>/U</td>
<td>Transponder with Mode C</td>
</tr>
</tbody>
</table>

| **DME** | |
| /D     | No transponder |
| /B     | Transponder with no Mode C |
| /A     | Transponder with Mode C |

| **TACAN ONLY** | |
| /M     | No transponder |
| /N     | Transponder with no Mode C |
| /P     | Transponder with Mode C |
### Equipment Type Suffix (Continued)

<table>
<thead>
<tr>
<th>Suffix</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>AREA NAVIGATION (RNAV)</strong></td>
<td></td>
</tr>
<tr>
<td>/Y</td>
<td>LORAN, VOR/DME, or INS with no transponder</td>
</tr>
<tr>
<td>/C</td>
<td>LORAN, VOR/DME, or INS, transponder with no Mode C</td>
</tr>
<tr>
<td>/I</td>
<td>LORAN, VOR/DME, or INS, transponder with Mode C</td>
</tr>
<tr>
<td><strong>ADVANCED RNAV WITH TRANSPONDER AND MODE C</strong> (If an aircraft is unable to operate with a transponder and/or Mode C, it will revert to the appropriate code listed above under Area Navigation.)</td>
<td></td>
</tr>
<tr>
<td>/E</td>
<td>Flight Management System (FMS) with DME/DME and IRU position updating</td>
</tr>
<tr>
<td>/F</td>
<td>Flight Management System (FMS) with DME/DME position updating</td>
</tr>
<tr>
<td>/G</td>
<td>Global Navigation Satellite System (GNSS), including GPS and WAAS, with enroute and terminal capability</td>
</tr>
<tr>
<td>/R</td>
<td>Required Navigational Performance. The aircraft meets the RNP type prescribed for the route segment(s), route(s) and/or area concerned.</td>
</tr>
<tr>
<td><strong>Reduced Vertical Separation Minimum (RVSM)</strong>. Prior to conducting RVSM operations within the U.S., the operator must obtain authorization from the FAA or from the country of registry, as appropriate.</td>
<td></td>
</tr>
<tr>
<td>/H</td>
<td>RVSM conformant with a transponder problem.</td>
</tr>
<tr>
<td>/J</td>
<td>/E with RVSM</td>
</tr>
<tr>
<td>/K</td>
<td>/F with RVSM</td>
</tr>
<tr>
<td>/L</td>
<td>/G with RVSM</td>
</tr>
<tr>
<td>/Q</td>
<td>/R with RVSM</td>
</tr>
<tr>
<td>/W</td>
<td>RVSM</td>
</tr>
</tbody>
</table>
Every

This section applies to all Request commands except Request LIFP.

The every (or time interval) option allows you to change the time interval into which flights are grouped and counted in the various reports. You can specify a time interval different from the default for each report type by entering EVERY followed by the number of minutes you would like to set as the time interval. For example, to specify 30-minute time intervals in a flight counts report on Los Angeles International Airport, enter this command:

For the following commands: Request Count, Request List, Request Listo, Request Area, and Request VT, the default interval is 15 minutes. You can set the time interval to any value in increments of one minute. For Request ARRD the default time interval is 60 minutes. However you are restricted to the following interval options: 5, 10, 15, 20, 30, 45, or 60.

Setlen

The setlen option affects reports generated by Request LIFP, Request List, Request Listo, Request Area, and Request VT. Flight counts, arrival delay prediction reports, and the counts portion of the time verification reports override the setlen option and are not affected by what you enter.

This option allows you to set the length (in characters) of each line in the report being generated and for all subsequent reports. This determines the point at which each line wraps to the next line (default is 80 characters). Use this option by entering SETLEN anywhere after REQ on the command line, followed by a space and the desired line length in characters. For example, if you wanted a LIFP report on United Airlines flight 100 set in a line length of 120 characters, your response would look like this:

Once you use this option, it will stay in effect for subsequent reports until you reissue it or quit the TSD.
Secondary Requests

This section applies to the Request Count, Request List, and Request Listo commands.

Secondary requests allow you to use information requested in an original report to generate subsequent flight list or flight counts reports for the same location. The TFMS retrieves and saves all of the information that is available for the flights included in your report, even if that information does not appear on the original report. This feature is useful when, for example, you make a request about an airport for which you need a lot of information. Detailed information can be formulated much faster using a secondary request because the source information has already been retrieved and stored.

Secondary requests can be made from any original report except for arrival delay prediction (ARRD) reports. However, to make a secondary request, you must use the Request Count, Request List, or Request Listo command. (The resulting secondary report will be either a flight counts or flight list report.)

You may use any filter and format options that apply to either of these commands. However, the secondary report cannot include information on flights that were filtered out by the original request.

Note: Secondary requests cannot be created on reports created with the hubsite option.

What To Do

Issue a secondary request on a flight count report

1. Press ; to access the command prompt.
2. Enter the input request in the Command Line dialog box and press <Enter>.
3. Click Display in the Report dialog box when it appears.

Note: The original report shows .01, indicating that this is the first report for the request. For secondary requests, the version number at the end of the report name increments according to each additional request.

4. Click the Reports checkbox in the Command Line dialog box. The dialog box drops down to display a list of reports.
5. Highlight the report in the list to select it.
6. Enter another command in the Input Request field.
7. Click the Command History checkbox.
8. Click Send Secondary from the Requests pull-down menu. The secondary Report dialog box opens with .02 appended to the report name.
9. Click Display in the Report dialog box to display the secondary report.
Request Scripts

This section applies to **ALL Request** commands.

Request scripts are **Request** commands that have been stored as text files on your user node. They are stored in the directory `/ETMS/list/adapt/lscripts`. Each request script can either be a complete **Request** command just as you would enter it on your command line (except for the word **REQ**) or it can be any part of the command after the word **REQ**.

Standard Request Scripts

A number of standard request scripts are provided with the TSD. Three of these scripts are automatically invoked by the system when you are examining an element and you issue the **Alerts Report** command. The rest are provided for you to invoke for your use in any request. Each of these scripts is described in the following table.

**Note**: These are standard scripts used throughout the system, and the originals should not be edited. If you need to edit one of these scripts, make a copy of it first and then edit the copy.

Other request scripts, created by personnel at your site, may also be available on your node. Ask your System Administrator about using these scripts.

### Standard Request Script

<table>
<thead>
<tr>
<th>Script name</th>
<th>Text of script</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>airfmt</td>
<td>list acid time airp rte sort time</td>
<td>Invoked by Alerts Report if you are examining an airport.</td>
</tr>
<tr>
<td>all</td>
<td>list acid type alt orig dcentr dsectr egtd sgtd pgtd tgtd ctd artd dest acentr asectr afix egta sgta pgta tgta cta arta etc</td>
<td>Creates a flight list report that includes more information (more columns) than the standard report.</td>
</tr>
<tr>
<td>ete</td>
<td>list acid orig egtd dest egta etc</td>
<td>Creates a flight list report that includes the ETE of each flight.</td>
</tr>
<tr>
<td>fcafmt</td>
<td>list acid stat entry exit orig dest rte sort stat entry exit</td>
<td>Invoked by FCA Report if you are examining an FCA.</td>
</tr>
<tr>
<td>fixfmt</td>
<td>list acid stat entry exit orig dest rte sort stat etc</td>
<td>Invoked by Alerts Report if you are examining a fix.</td>
</tr>
<tr>
<td>fixl</td>
<td>list acid type orig etd afix etd etc dcentr ctd cta sort eta afix</td>
<td>Creates a flight list report with fix loading information, including a column identifying the arrival fix that each incoming flight traverses, and columns showing controlled arrival and departure times.</td>
</tr>
<tr>
<td>fp</td>
<td>every 60 list acid type speed orig etd alt rte</td>
<td>Creates a flight list report that includes the route text of each flight.</td>
</tr>
<tr>
<td>Script name</td>
<td>Text of script</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td><code>gstop.c</code></td>
<td>a every 15 count dcentr gstop</td>
<td>Creates a flight counts report of arrivals to show flights still on the ground at each departure center. Shows the total count, controlled flights, and flights past their ETD at each center.</td>
</tr>
<tr>
<td><code>gstop.l</code></td>
<td>every 15 list acid etd ortd dest eta dcentr sort dcentr ortd</td>
<td>Creates a flight list report that includes the original departure times, sorted by departure center and original departure time.</td>
</tr>
<tr>
<td><code>gstop.o</code></td>
<td>a every 15 count orig gstop</td>
<td>Creates a flight counts report of arrivals to show flights still on the ground at each origin airport. Shows the total count, controlled flights, and flights past their ETD at each airport.</td>
</tr>
<tr>
<td><code>times</code></td>
<td>list acid orig egtd artd dest eta egta artd sgta pgta tgta cta</td>
<td>Creates a flight list report with information about the various departure and arrival times assigned to each flight by the system.</td>
</tr>
<tr>
<td><code>ltype</code></td>
<td>list acid type orig egtd artd dest egta arta</td>
<td>Creates a flight list report that shows both actual and estimated times of departure and arrival.</td>
</tr>
<tr>
<td><code>rte</code></td>
<td>list info acid type orig etd dest eta ete rte every 60 setlen 93</td>
<td>Creates a flight list report that includes the route text of each flight and also the etd, eta, and ete. Sets a line length slightly longer than default.</td>
</tr>
<tr>
<td><code>scdt</code></td>
<td>every 60 list acid type orig etd dest eta ete dcentr cta sort eta</td>
<td>Creates a flight list report in the format needed for input to the SCDT program, used by ATCSCC.</td>
</tr>
<tr>
<td><code>secfmt</code></td>
<td>list acid stat entry exit orig dest rte sort stat entry exit</td>
<td>Invoked by Alerts Report if you are examining a sector.</td>
</tr>
<tr>
<td><code>x</code></td>
<td>list info acid type orig sgtd pgtd ortd ctd artd dest eta arta ete dcentr ac_cat every 60</td>
<td>Creates a flight list report that includes all possible departure times, estimated and actual times of arrival, departure center, and aircraft category. Could be used to analyze effects of ground delay programs.</td>
</tr>
</tbody>
</table>
Creating a Request Script

To create your own request script, create a text file in the /ETMS/list/adapt/lscripts directory. Be sure to choose a unique name. Then edit this file so that it contains the Request command options that you want to use. You may use upper or lower case.

Invoking a Request Script

To invoke a request script, begin to enter a request on the command line as usual, but at the end of the request, type @ followed immediately by the name of the script you want to invoke (@scriptname). Be sure that @scriptname appears at the place in the command where the text of the script would otherwise appear if you were typing the complete command. For example, if the text of a script called myscript is the following, place it after the location and time, as shown below:

Note: Although it is possible to create a request script that should be embedded within a request (for example, to define an often-used set of filter options), request scripts are usually placed at the end of a request, in order to define columns, sort order, etc. All of the standard request scripts listed in the previous table should be placed at the very end of the request.

Invoking a Standard Request Script

To use any of the standard request scripts, enter the location(s), followed by @scriptname for the script you want to use. For all standard scripts except gstop.c and gstop.o, you may also include the A or D option, time period option, and filters option, if desired. The following example shows how to invoke the fp script:

For the gstop.c or gstop.o scripts, do not include the A or D option.
Appendix B: Diagnostic Messages

The diagnostic messages that appear in this appendix are those associated with the TSD.

Sources of Help

Whenever you run into trouble while using the TFMS, you should keep these sources of help in mind:

- Your System Administrator is the person at your site responsible for keeping the TFMS configured and running properly. He or she should be your first source of help when trouble arises. If your System Administrator is not available, a more experienced TFMS user may be able to help.

- The TFMS Hotline, at ATCSCC headquarters in Herndon, Virginia, is staffed by FAA personnel. It is manned from 8:00AM to 5:00PM EST Monday through Friday. An answering machine records messages when personnel are unavailable. (The TFMS Hotline phone number should be posted at your site.)

- TFMS Support Services in Cambridge monitor the system 24 hours a day, 7 days a week. Generally, you should call Cambridge only if TFMS Hotline personnel are not available or if you have been specifically directed to do so. (The TFMS Support Services telephone number should be posted at your site.)

TFMS Diagnostic Messages

The following table is an alphabetical list of the diagnostic messages that you might receive while using the TSD, including an explanation of each message and, where applicable, instructions on what to do when you see each message. For syntax errors, check the command entry carefully, referring if necessary to the appropriate section in the TFMS Reference Manual or even the TFMS Tutorial, and reissue the command. If you try a command again and it still does not work, contact your System Administrator.

Variable names that appear in diagnostic messages (such as specific server names, element names, or in some cases command names) are represented in this table by italic typeface between angle brackets (<>). For example, if you see this message:

```
Cannot connect to Flight Table Manager.
```

it would appear in this table as “Cannot connect to <server>.”

**Note:** Several entries in the What to Do column of this table ask you to contact your System Administrator. If your System Administrator is not available or unable to solve the problem, call the TFMS Hotline for assistance. If the hotline is closed, call TFMS Support Services at the hubsite in Cambridge.
## TFMS Diagnostic Messages

<table>
<thead>
<tr>
<th>Diagnostic Message</th>
<th>Explanation</th>
<th>What to Do</th>
</tr>
</thead>
</table>
| A character may not be placed after an *                                          | The system finds that a character has been placed after the *.
|                                                                                  |                                                                                                                                                                                                              |                                                                                                      |
| A time period must be selected in the Examine Timeline for the Turn Green command | A time period was not indicated by positioning the cursor over a timeline button in a Timeline Dialog box when the "G" key is pressed.                                                                           |                                                                                                      |
| Active EDCT string not responding                                                 | EDCT process on active string is not answering requests or a timeout condition occurred when an EDCT message was sent.                                                                                       | Wait a few minutes and try again, same for 2nd condition                                               |
| ACTV FAILED: Can’t open map file for cancel, add, or inhibit linked list          | The system cannot process your request due to a communication error.                                                                                                                                          | Notify your System Administrator and try again later.                                                |
| ACTV FAILED: Invalid type: not add, cancel, or inhibit                            | The system cannot process your request due to an invalid parameter.                                                                                                                                             | Reissue the command, checking the syntax of your entry.                                               |
| ACTV FAILED: The flight ID was not found in the list map file                     | The system cannot find the flight you requested.                                                                                                                                                                | Reissue the command, checking the flight ID.                                                          |
| ACTV FAILED: The list map file is empty                                           | The system has no data to process your request.                                                                                                                                                                | Notify your System Administrator and try                                                              |
| Adding all items would cause the list to exceed its limit of 256                  | The system determines that the number of items added to the list exceeds 256.                                                                                                                                   |                                                                                                      |
| At most 256 flights can be found                                                 | The system determines that the number of found flights exceeds 256.                                                                                                                                              |                                                                                                      |
| Beep parameter must be an integer from one to 10                                  | Beep parameter is invalid.                                                                                                                                                                                      |                                                                                                      |
| Cannot connect to Delay Advisor                                                  | The TSD could not access the Delay Advisor on the active string.                                                                                                                                                |                                                                                                      |
| Cannot connect to SDB                                                            | The TSD could not access the SDB on the active string.                                                                                                                                                           |                                                                                                      |
| Cannot connect to TDB                                                            | The TSD could not access the TDB on the active string.                                                                                                                                                           |                                                                                                      |
| Cannot create adaptation files of that name                                       | The TSD tries to create an adaptation file using a specified file name that already exists as the name of an adaptation subdirectory.                                                                        |                                                                                                      |
| Cannot unzoom any further                                                        | Current unzoom scale is already at the maximum 12,800.                                                                                                                                                           |                                                                                                      |
| Cannot zoom any further                                                          | Current zoom scale is already at the minimum 20.                                                                                                                                                                |                                                                                                      |
| Command is not valid at this time                                                | One of the Replay semicolon commands was issued when the command is disabled.                                                                                                                                   |                                                                                                      |
| CXSD FAILED: Can’t open cancel list map file                                     | The system cannot get the data it needs to process your request.                                                                                                                                                 | Notify your System Administrator and try again later.                                                |
| CXSD FAILED: Flight ID mismatch                                                   | The system does not recognize the flight you entered.                                                                                                                                                             | Reissue the command, using a different flight ID.                                                     |
| CXSD FAILED: Flight is not effective within 12 hour range                        | You have entered an unacceptable parameter.                                                                                                                                                                     | Reissue the command, using a different time range.                                                    |
| CXSD FAILED: Can’t open cancel list map file                                     | The system cannot get the data it needs to process your request.                                                                                                                                                 | Notify your System Administrator and try again later.                                                |
## TFMS Diagnostic Messages

<table>
<thead>
<tr>
<th>Diagnostic Message</th>
<th>Explanation</th>
<th>What to Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>CXSD FAILED: Flight ID mismatch</td>
<td>The system does not recognize the flight you entered.</td>
<td>Reissue the command, using a different flight ID.</td>
</tr>
<tr>
<td>CXSD FAILED: Flight is not effective within 12 hour range</td>
<td>You have entered an unacceptable parameter.</td>
<td>Reissue the command, using a different time range.</td>
</tr>
<tr>
<td>CXSD FAILED: Unknown flight leg</td>
<td>You have entered an unacceptable parameter.</td>
<td>Reissue the command, using a different</td>
</tr>
<tr>
<td>EDCT check failed. Data not available: <code>&lt;ident airport&gt;</code></td>
<td>The system is having a problem accessing the data for this flight.</td>
<td>Check your request entry data and reissue the command.</td>
</tr>
<tr>
<td>EDCT check failed. Flight not controlled: <code>&lt;ident airport&gt;</code></td>
<td>You have requested a report on a flight which is not controlled.</td>
<td>N/A</td>
</tr>
<tr>
<td>EDCT LOG - No data found</td>
<td>You are requesting flight data that does not exist in the data file.</td>
<td>N/A</td>
</tr>
<tr>
<td>EDCT LOG - Unable to decode supplied date</td>
<td>You have entered an invalid date in your request.</td>
<td>Check the date and reissue the command.</td>
</tr>
<tr>
<td>EDCT NOT PURGED ON ALL STRINGS-RESEND</td>
<td>Requested action could not be executed on all strings.</td>
<td>Wait a few minutes and resend.</td>
</tr>
<tr>
<td>EDCT PURGE ALL - No current programs found</td>
<td>You have tried to purge controls for uncontrolled airports.</td>
<td>N/A</td>
</tr>
<tr>
<td>EDCT PURGE - <code>&lt;airport&gt;</code> is not currently controlled</td>
<td>You have tried to purge controls for an uncontrolled airport.</td>
<td>N/A</td>
</tr>
<tr>
<td>EDCT purge failed: Bad controlled airport</td>
<td>The system does not recognize the entered airport name.</td>
<td>Check the airport name entry and reissue the command.</td>
</tr>
<tr>
<td>EDCT purge failed: Bad controlled time</td>
<td>You are entering an unacceptable parameter in your request.</td>
<td>Change the time entry and reissue the command.</td>
</tr>
<tr>
<td>EDCT purge failed: No flight controls for any airports</td>
<td>You have tried to purge all controls but none exist.</td>
<td>N/A</td>
</tr>
<tr>
<td>EDCT purge failed: PURGE ALL requires word &quot;PROGRAMS&quot;</td>
<td>You have left a necessary parameter out of your request.</td>
<td>Reissue the command, and include the word PROGRAMS.</td>
</tr>
<tr>
<td>EDCT purge failed: Unable to decode purge time</td>
<td>You are entering an unacceptable parameter in your request.</td>
<td>Reissue the command, changing the time.</td>
</tr>
<tr>
<td>EDCT <code>&lt;command&gt;</code> failed: Logical error in processing for <code>&lt;airport&gt;</code></td>
<td>The system has made an error in completing your request.</td>
<td>Reissue the command, checking the syntax.</td>
</tr>
<tr>
<td>EDCT <code>&lt;command&gt;</code> failed: No EDCT programs for airport</td>
<td>There are no programs for the airport, so your request is invalid.</td>
<td>N/A</td>
</tr>
<tr>
<td>EDCT <code>&lt;command&gt;</code> failed: No flight controls for <code>&lt;airport&gt;</code></td>
<td>No controls exist for this airport.</td>
<td>N/A</td>
</tr>
<tr>
<td>EDCT <code>&lt;command&gt;</code> failed: No flight controls for today</td>
<td>You have tried to get a report, but no data exists.</td>
<td>N/A</td>
</tr>
<tr>
<td>EDCT <code>&lt;command&gt;</code> failed: No airports controlled</td>
<td>No controls exist for any airports.</td>
<td>N/A</td>
</tr>
<tr>
<td>EDCT <code>&lt;command&gt;</code> failed: No valid data in EDCT headers for <code>&lt;airport&gt;</code></td>
<td>You are making a request for which there is no information.</td>
<td>N/A</td>
</tr>
<tr>
<td>EDCT <code>&lt;command&gt;</code> failed: Problem building datafile for <code>&lt;airport&gt;</code></td>
<td>The system is having a problem creating an output file.</td>
<td>Contact your System Administrator.</td>
</tr>
<tr>
<td>EDCT SUB NOT DONE ON ALL STRINGS-RESEND</td>
<td>Requested action could not be executed on all strings.</td>
<td>Wait a few minutes and resend.</td>
</tr>
<tr>
<td>EDCT SUB PRINT failed</td>
<td>You have tried to print, but the system is unable to open the file.</td>
<td>Contact your System Administrator.</td>
</tr>
<tr>
<td>Diagnostic Message</td>
<td>Explanation</td>
<td>What to Do</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------</td>
<td>------------</td>
</tr>
<tr>
<td>Element &lt;illegal entry&gt; is invalid</td>
<td>The TSD could not find the NAS element specified in the Alarms Specification dialog box or in the ALARM ON/OFF command.</td>
<td></td>
</tr>
<tr>
<td>Element &lt;illegal entry&gt; is not in the Alarm Database</td>
<td>The element specified in the ALARMS OFF command is not included in the current Alarm Database and hence cannot be removed.</td>
<td></td>
</tr>
<tr>
<td>Element Name must be followed by an A, F, or S</td>
<td>The ALARM ON/OFF command is invalid.</td>
<td></td>
</tr>
<tr>
<td>&lt;entry 1&gt;, &lt;entry2&gt; not found</td>
<td>The system finds one or more entries are invalid or one or more entries in the Add text field it cannot identify.</td>
<td></td>
</tr>
<tr>
<td>ERROR: An error was encountered deleting FCA: &lt;list of FCAs not deleted&gt;</td>
<td>You may not be authorized to delete the FCA or the FCA may not exist.</td>
<td>The RRHUB sends this message if no FCAs could be deleted.</td>
</tr>
<tr>
<td>ERROR: FCA &lt;fca name&gt; already exists.</td>
<td>If the request message will create an FCA that has the same name as an existing FCA of the same type, the RRHUB returns this message.</td>
<td></td>
</tr>
<tr>
<td>ERROR: failed to find Listserver</td>
<td>The system cannot locate Listserver on your node.</td>
<td>Start up Listserver.</td>
</tr>
<tr>
<td>ERROR: from Listserver</td>
<td>The system does not recognize the Listserver file.</td>
<td>Contact your System Administrator.</td>
</tr>
<tr>
<td>ERROR: from TDB.text</td>
<td>Specific problem within the TDB.</td>
<td>Wait a few minutes and restart.</td>
</tr>
<tr>
<td>ERROR: Invalid FCA ID &lt;fca_id&gt;</td>
<td>The RRSVR returns this error when the request message from the TSD contains an invalid fca_id.</td>
<td>Check the FCA ID for validity and try to re-enter it.</td>
</tr>
<tr>
<td>Error reading file: &lt;file name&gt;</td>
<td>An error occurs when the TSD attempts to read and display a file.</td>
<td></td>
</tr>
<tr>
<td>Error, unmatched bracket or parenthesis</td>
<td>You are specifying more than one airport in your request command, therefore, the airports must be enclosed in brackets or parentheses.</td>
<td>Verify that all brackets or parentheses are consistent and reissue the command.</td>
</tr>
<tr>
<td>ERROR: You are not authorized to modify FCA &lt;FCA name&gt;</td>
<td>The RRHUB returns this message if it rejects an Update message from the TSD because the TSD is not authorized to modify the Public FCA database.</td>
<td></td>
</tr>
<tr>
<td>F must be followed by an S, H, or L</td>
<td>The ALARM ON/OFF command is invalid.</td>
<td></td>
</tr>
<tr>
<td>File Cannot Be Deleted</td>
<td>The system encounters problems deleting a file or attempts to delete a subdirectory that is not empty.</td>
<td></td>
</tr>
<tr>
<td>File Cannot Be Found or Accessed</td>
<td>The file name specified cannot be found or accessed,</td>
<td></td>
</tr>
<tr>
<td>File name not found: pathname</td>
<td>The script file or alarm file specified by the user does not exist.</td>
<td></td>
</tr>
<tr>
<td>File Name (filename) Not Found</td>
<td>Script file does not exist.</td>
<td></td>
</tr>
</tbody>
</table>
## TFMS Diagnostic Messages

<table>
<thead>
<tr>
<th>Diagnostic Message</th>
<th>Explanation</th>
<th>What to Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>FPSD FAILED: Bad aircraft type found in request</td>
<td>You have entered an unacceptable parameter.</td>
<td>Reissue the command, using a different aircraft type.</td>
</tr>
<tr>
<td>FPSD FAILED: Bad ETE found in request</td>
<td>You have entered an unacceptable parameter.</td>
<td>Reissue the command, using a different estimated time enroute.</td>
</tr>
<tr>
<td>FPSD FAILED: Cannot perform simultaneous editing to [dep/arr times operational days effective period equipment]</td>
<td>You have entered too many parameters for the command to be effective.</td>
<td>Reissue the command, changing only one parameter at a time.</td>
</tr>
<tr>
<td>FPSD FAILED: Flight ID already exists</td>
<td>The command has already been used on this flight.</td>
<td>N/A</td>
</tr>
<tr>
<td>FPSD FAILED: It is past scheduled departure time for flight</td>
<td>This command will not work, since the flight has taken off.</td>
<td>N/A</td>
</tr>
<tr>
<td>FPSD FAILED: Map file is full</td>
<td>You cannot add any more commands to the database until some information is deleted.</td>
<td>Notify your System Administrator and try again later.</td>
</tr>
<tr>
<td>Invalid alarm file; pathname</td>
<td>The file specified by the user is not a valid alarm file.</td>
<td></td>
</tr>
<tr>
<td>Invalid capacity specification</td>
<td>You are using the CAPS command to set flight capacities at a value that is invalid.</td>
<td>Try setting the capacity at a different value and reissuing the command.</td>
</tr>
<tr>
<td>Invalid Color Name</td>
<td>The color name entry does not match any of the valid color names: the TSD substitutes the default aircraft color.</td>
<td></td>
</tr>
<tr>
<td>Invalid &lt;command&gt; syntax</td>
<td>The system cannot read your request the way it was entered.</td>
<td>Check the syntax of your request and reissue the command.</td>
</tr>
<tr>
<td>Invalid day for given month</td>
<td>You are using the request command to request data based on a day and month that do not match.</td>
<td>Use a current calendar to verify the day and month and reissue the command.</td>
</tr>
<tr>
<td>Invalid Date/Time</td>
<td>Either the Start/Date time is not before the current time or the Stop Date/Time is not after the Start Date/Time.</td>
<td></td>
</tr>
<tr>
<td>Invalid EDCT server response. Please inform operations.</td>
<td>The EDCT server is not connecting properly.</td>
<td>Contact the operations people.</td>
</tr>
<tr>
<td>Invalid Entry</td>
<td>The TSD detects an error when validating the entries in the fields in the Select Flights or the Flight Set Filter dialog boxes.</td>
<td></td>
</tr>
<tr>
<td>Invalid File</td>
<td>The TSD detects that the file specified by the user is not an adaptation file or the TSD has problems reading or processing the file.</td>
<td></td>
</tr>
<tr>
<td>Invalid File Name File name cannot begin with &quot;/&quot;</td>
<td>File name specified in the Snapshot Options dialog box begins with a &quot;/&quot;</td>
<td></td>
</tr>
<tr>
<td>Invalid File Name</td>
<td>The TSD displays this message when the file name specified in the File Save dialog box indicates a space or is invalid.</td>
<td></td>
</tr>
<tr>
<td>Invalid File Name.</td>
<td>The file name specified in the File Save dialog box includes a space or is otherwise invalid.</td>
<td>Specify a valid file name.</td>
</tr>
</tbody>
</table>
## TFMS Diagnostic Messages

<table>
<thead>
<tr>
<th>Diagnostic Message</th>
<th>Explanation</th>
<th>What to Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invalid list or sort phrase</td>
<td>You are using the <strong>request</strong> command to request a list report that is sorted in a specific order, but one or all of the elements used in the request are invalid element options.</td>
<td>Make sure all phrase elements come after the sort element. If they do, then check the remaining elements in that phrase.</td>
</tr>
<tr>
<td>Invalid location for <code>&lt;data type&gt;</code> data files</td>
<td>The TSD cannot access the pathname specified for the Node or Directory prompt.</td>
<td></td>
</tr>
<tr>
<td>Invalid stack size in ARRD request</td>
<td>You are using the request ARRD stak option to set stacked flights at a value that is invalid.</td>
<td>Change the value and reissue the command.</td>
</tr>
<tr>
<td>Invalid stack time in ARRD request</td>
<td>You are using the request ARRD stak option to specify a time to set a stack size, but the time period is invalid.</td>
<td>Time periods must be entered in whole hours and in Universal Coordinated Time. Check the time, then reissue the command.</td>
</tr>
<tr>
<td>Invalid time specification in Caps phrase</td>
<td>You are using the CAPS command to set capacities for a start time or end time that is invalid.</td>
<td>Make sure both time periods are in Universal Coordinated Time, then reissue the command.</td>
</tr>
<tr>
<td>Invalid type for examined element</td>
<td>The location type specified in the Examine semicolon command is invalid.</td>
<td></td>
</tr>
<tr>
<td>Invalid zoom scale</td>
<td>Specified zoom scale was greater than 12,800 or less than 20.</td>
<td></td>
</tr>
<tr>
<td>Location not found</td>
<td>The TSD could not find the location specified in the Move/Zoom command.</td>
<td></td>
</tr>
<tr>
<td>Location is invalid</td>
<td>The TSD cannot find the location specified for the center point of range rings in the Static Database.</td>
<td></td>
</tr>
<tr>
<td>No flight data to replay</td>
<td>The TSD can access all of the pathnames specified but cannot locate any flight data files that match the time period specified.</td>
<td></td>
</tr>
<tr>
<td>No Flight Set Has Been Selected</td>
<td>The Flight Set&gt; Copy or the Flight Set&gt; Top menu option is invoked and no flight sets have been selected.</td>
<td></td>
</tr>
<tr>
<td>No flights matching XXXXXXXX can be found</td>
<td>No active flights match the entry in the Find Flight field.</td>
<td></td>
</tr>
<tr>
<td>No locations for undo move/zoom</td>
<td>The Undo Move/Zoom quick key is pressed when there are no locations stored in the Move/Zoom stack.</td>
<td></td>
</tr>
<tr>
<td>No more than 256 characters are allowed in a field</td>
<td>User entered more than 256 characters in a text field in the Alarms Specification dialog box.</td>
<td></td>
</tr>
<tr>
<td>No Range Rings set has been selected</td>
<td>The TSD finds no range rings sets selected in the Range Rings dialog box for any function that requires selection.</td>
<td></td>
</tr>
<tr>
<td>No report selected</td>
<td>No report was selected when the user clicked on the Display or Remove buttons in the Reports section of the Command Line Interface.</td>
<td></td>
</tr>
</tbody>
</table>
TFMS Diagnostic Messages

<table>
<thead>
<tr>
<th>Diagnostic Message</th>
<th>Explanation</th>
<th>What to Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>No report selected for secondary request. Request canceled</td>
<td>No report was selected when the user requested that a secondary request be sent.</td>
<td></td>
</tr>
<tr>
<td>No reports match the filter criteria</td>
<td>No reports are found that match the filter criteria.</td>
<td></td>
</tr>
<tr>
<td>No response from WX Server</td>
<td>The WX Report request timed out.</td>
<td></td>
</tr>
<tr>
<td>No Snapshot files were found</td>
<td>No files are found in the standard snapshot directory that have an “xwd” extension.</td>
<td></td>
</tr>
<tr>
<td>No Timeline dialog box has focus</td>
<td>The “=” quick key is pressed when no Timeline dialog box has focus.</td>
<td></td>
</tr>
<tr>
<td>Original request not saved--cannot process</td>
<td>You are making a secondary request on a report that was not saved; therefore, the secondary request has no source data and cannot be processed.</td>
<td>Recreate the original report and try your secondary request again.</td>
</tr>
<tr>
<td>Print command must be provided</td>
<td>A print command is not provided.</td>
<td></td>
</tr>
<tr>
<td>Problem accessing data</td>
<td>The system cannot access the data you requested.</td>
<td>Contact your System Administrator or call the TFMS Hotline.</td>
</tr>
<tr>
<td>Redundant exclusion in airl or type phrase</td>
<td>You are using a request command to exclude information that has already been excluded in another phrase element.</td>
<td>Check each airline or aircraft type element in your request for redundancy and reissue the command.</td>
</tr>
<tr>
<td>Replay cannot extend into the future</td>
<td>The Stop Date/Time is after the current time.</td>
<td></td>
</tr>
<tr>
<td>Replay Date/Time is outside the range specified</td>
<td>The user entered a Date/Time that is before the Start Date/Time or after the End Date/Time.</td>
<td></td>
</tr>
<tr>
<td>REQ ERR: AFIX must be preceded by airport name</td>
<td>The request syntax is unacceptable as is.</td>
<td>Enter the required airport name before AFIX.</td>
</tr>
<tr>
<td>REQ ERR: A sector cannot be mixed with non–sectors as a place of interest</td>
<td>The request syntax is unacceptable as is.</td>
<td>Enter either a sector or a non–sector as a place of interest.</td>
</tr>
<tr>
<td>REQ ERR: Bad time in &lt; &gt; data file</td>
<td>The data file for the FTM, SDB, or TTM cannot be read.</td>
<td>Contact your System Administrator or call the TFMS Hotline.</td>
</tr>
<tr>
<td>REQ ERR: Bad time or time range</td>
<td>You have entered an unacceptable parameter.</td>
<td>Reissue the command, changing the time.</td>
</tr>
<tr>
<td>REQ ERR: CANNOT CONNECT TO NODESWITCH, ERROR INQUIRING CLASS ON SITE</td>
<td>Without a connection to nodeswitch, the system cannot process your request.</td>
<td>Contact your System Administrator or call the TFMS Hotline.</td>
</tr>
<tr>
<td>REQ ERR: CANNOT CONNECT TO NODESWITCH, ERROR ON CLASS LOOKUP</td>
<td>Without a connection to nodeswitch, the system cannot process your request.</td>
<td>Contact your System Administrator or call the TFMS Hotline.</td>
</tr>
<tr>
<td>REQ ERR: Conflicting inclusion/exclusion in equipment phrase</td>
<td>You have included or excluded contradictory equipment data.</td>
<td>Check each element in your request and reissue your request command.</td>
</tr>
<tr>
<td>REQ ERR: Conflicting inclusion/exclusion in remark phrase</td>
<td>You have included or excluded contradictory remark data.</td>
<td>Check each element in your request and reissue your request command.</td>
</tr>
<tr>
<td>REQ ERR: Data analysis type not specified for VT function</td>
<td>You have not entered a necessary parameter.</td>
<td>Check each element in your request and reissue your request command.</td>
</tr>
<tr>
<td>REQ ERR: Data base request message undeliverable. Request canceled</td>
<td>The system is having a communication problem.</td>
<td>Contact your System Administrator or call the TFMS Hotline.</td>
</tr>
<tr>
<td>Diagnostic Message</td>
<td>Explanation</td>
<td>What to Do</td>
</tr>
<tr>
<td>----------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>REQ ERR: Data file contained no data for given request</td>
<td>No information is available for this request.</td>
<td>N/A</td>
</tr>
<tr>
<td>REQ ERR: Empty brackets &quot;[]&quot; found- no data between brackets</td>
<td>You have entered an unacceptable parameter.</td>
<td>Reissue the command, entering something between the brackets or remove them from the request.</td>
</tr>
<tr>
<td>REQ ERR: Entered date does not fall on given day</td>
<td>You have entered an unacceptable parameter.</td>
<td>Reissue the command, checking the date.</td>
</tr>
<tr>
<td>REQ ERR: Error establishing a report number</td>
<td>The system is having a communication problem.</td>
<td>Contact your System Administrator or call the TFMS Hotline.</td>
</tr>
<tr>
<td>REQ ERR: Error in &lt; &gt; data retrieval, request canceled</td>
<td>The system is having a communication problem.</td>
<td>Contact your System Administrator or call the TFMS Hotline.</td>
</tr>
<tr>
<td>REQ ERR: Error initializing the Parser</td>
<td>The system is having a communication problem.</td>
<td>Contact your System Administrator or call the TFMS Hotline.</td>
</tr>
<tr>
<td>REQ ERR: Error in LSTNET request to FTM. Request canceled</td>
<td>The system is having a communication problem.</td>
<td>Contact your System Administrator or call the TFMS Hotline.</td>
</tr>
<tr>
<td>REQ ERR: Error in request to HUBSITE LSTNET. Request canceled</td>
<td>The system is having a communication problem.</td>
<td>Contact your System Administrator or call the TFMS Hotline.</td>
</tr>
<tr>
<td>REQ ERR: Error opening airline file.</td>
<td>The system is having a communication problem.</td>
<td>Contact your System Administrator or call the TFMS Hotline.</td>
</tr>
<tr>
<td>REQ ERR: Error opening channel to the Com Server</td>
<td>The system is having a communication problem.</td>
<td>Contact your System Administrator or call the TFMS Hotline.</td>
</tr>
<tr>
<td>REQ ERR: Error opening FIXL data file</td>
<td>The system is having a communication problem.</td>
<td>Contact your System Administrator or call the TFMS Hotline.</td>
</tr>
<tr>
<td>REQ ERR: Error opening report or data dump file</td>
<td>The system is having a communication problem.</td>
<td>Contact your System Administrator or call the TFMS Hotline.</td>
</tr>
<tr>
<td>REQ ERR: Error setting logical name</td>
<td>The system is having a communication problem.</td>
<td>Contact your System Administrator or call the TFMS Hotline.</td>
</tr>
<tr>
<td>REQ ERR: Error processing ARRD request</td>
<td>The system is having a communication problem.</td>
<td>Contact your System Administrator or call the TFMS Hotline.</td>
</tr>
<tr>
<td>REQ ERR: Error transmitting response. Request canceled</td>
<td>The system is having a communication problem.</td>
<td>Contact your System Administrator or call the TFMS Hotline.</td>
</tr>
<tr>
<td>REQ ERR: Error, unmatched Brackets or Parentheses</td>
<td>You have entered an unacceptable parameter.</td>
<td>Reissue the command, carefully entering the brackets or parentheses.</td>
</tr>
<tr>
<td>REQ ERR: Error with ios open</td>
<td>The system is having a communication problem.</td>
<td>Contact your System Administrator or call the TFMS Hotline.</td>
</tr>
<tr>
<td>REQ ERR: Fault in DB Interface Module -- Exiting LP34</td>
<td>The system is having a communication problem.</td>
<td>Contact your System Administrator or call the TFMS Hotline.</td>
</tr>
<tr>
<td>REQ ERR: Fault in Parser Module -- Exiting LP</td>
<td>The system is having a communication problem.</td>
<td>Contact your System Administrator or call the TFMS Hotline.</td>
</tr>
<tr>
<td>REQ ERR: Found an unexpected right bracket &quot;]&quot;</td>
<td>You have entered an unacceptable parameter.</td>
<td>Reissue the command, removing the extra bracket.</td>
</tr>
<tr>
<td>REQ ERR: FTM timed out building response file. Request canceled</td>
<td>The system is having a communication problem.</td>
<td>Contact your System Administrator or call the TFMS Hotline.</td>
</tr>
<tr>
<td>REQ ERR: HUBSITE LSTNET file transfer failed. Request canceled</td>
<td>The system is having a communication problem.</td>
<td>Contact your System Administrator or call the TFMS Hotline.</td>
</tr>
<tr>
<td>REQ ERR: HUBSITE requests are obsolete; request canceled</td>
<td>The system no longer allows HUBSITE requests.</td>
<td>N/A</td>
</tr>
<tr>
<td>REQ ERR: Invalid &lt; &gt; file supplied to LSTSRV. Request canceled</td>
<td>The system is not accepting the file being supplied to the Listserver.</td>
<td>Contact your System Administrator or call the TFMS Hotline.</td>
</tr>
</tbody>
</table>
# TFMS Diagnostic Messages

<table>
<thead>
<tr>
<th>Diagnostic Message</th>
<th>Explanation</th>
<th>What to Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>REQ ERR: Invalid aircraft type specification</td>
<td>You have entered an unacceptable parameter.</td>
<td>Reissue the command, changing the aircraft type.</td>
</tr>
<tr>
<td>REQ ERR: Invalid airline specification</td>
<td>You have entered an unacceptable parameter.</td>
<td>Reissue the command, changing the airline.</td>
</tr>
<tr>
<td>REQ ERR: Invalid Primary Place of Interest specification, UNKW</td>
<td>UNKW is valid only as a Secondary Place of Interest (SPI).</td>
<td>Reissue the command, entering UNKW as an SPI.</td>
</tr>
<tr>
<td>REQ ERR: Invalid airway name</td>
<td>You have entered an unacceptable parameter.</td>
<td>Reissue the command, changing the airway name.</td>
</tr>
<tr>
<td>REQ ERR: Invalid AREA format option specified</td>
<td>You have specified an option not supported by this command.</td>
<td>Reissue the command, using valid option.</td>
</tr>
<tr>
<td>REQ ERR: Invalid ARRD format option specified.</td>
<td>You have specified an option not supported by this command.</td>
<td>Reissue the command, using valid option.</td>
</tr>
<tr>
<td>REQ ERR: Invalid arrival fix name</td>
<td>You have entered an unacceptable parameter.</td>
<td>Reissue the command, changing the fix name.</td>
</tr>
<tr>
<td>REQ ERR: Invalid capacity specification in Caps phrase</td>
<td>You have entered an unacceptable parameter.</td>
<td>Reissue the command, changing the capacity specification.</td>
</tr>
<tr>
<td>REQ ERR: Invalid center name</td>
<td>You have entered an unacceptable parameter.</td>
<td>Reissue the command, changing the center name.</td>
</tr>
<tr>
<td>REQ ERR: Invalid data file name</td>
<td>You have entered an unacceptable parameter.</td>
<td>Reissue the command, changing the data file name.</td>
</tr>
<tr>
<td>REQ ERR: Invalid day for given month</td>
<td>You have entered an unacceptable parameter.</td>
<td>Reissue the command, changing the day.</td>
</tr>
<tr>
<td>REQ ERR: Invalid end time in request</td>
<td>You have entered an unacceptable parameter.</td>
<td>Reissue the command, changing the end time.</td>
</tr>
<tr>
<td>REQ ERR: Invalid ete span value, format HHMM</td>
<td>You have entered an unacceptable parameter.</td>
<td>Reissue the command, changing the format to hours and minutes.</td>
</tr>
<tr>
<td>REQ ERR: Invalid fix name</td>
<td>You have entered an unacceptable parameter.</td>
<td>Reissue the command, changing the fix name.</td>
</tr>
<tr>
<td>REQ ERR: Invalid FTM file supplied to LSTNET. Request canceled.</td>
<td>You have entered an unacceptable parameter.</td>
<td>Reissue the command, changing the FTM file name.</td>
</tr>
<tr>
<td>REQ ERR: Invalid hash table type.</td>
<td>You have entered an unacceptable parameter.</td>
<td>Reissue the command, changing the type.</td>
</tr>
<tr>
<td>REQ ERR: Invalid interval specification in ARRD report Request</td>
<td>You have entered an unacceptable parameter.</td>
<td>Reissue the command, changing the interval.</td>
</tr>
<tr>
<td>REQ ERR: Invalid interval specification in request</td>
<td>You have entered an unacceptable parameter.</td>
<td>Reissue the command, changing the interval.</td>
</tr>
<tr>
<td>REQ ERR: Invalid LIFP cmd; no airline name entered</td>
<td>You have not entered an airline name.</td>
<td>Reissue the command, entering an airline name.</td>
</tr>
<tr>
<td>REQ ERR: Invalid LIFP file supplied to LSTNET. Request canceled.</td>
<td>You have entered an unacceptable parameter.</td>
<td>Reissue the command, changing the LIFP file name.</td>
</tr>
<tr>
<td>REQ ERR: Invalid list/sort phrase. Precede by LIST cmd.</td>
<td>You have made a request with an entry the system does not accept.</td>
<td>Reissue the command, entering the word LIST before the modifiers.</td>
</tr>
<tr>
<td>REQ ERR: Invalid month in date</td>
<td>You have entered an unacceptable parameter.</td>
<td>Reissue the command, entering a proper month.</td>
</tr>
<tr>
<td>REQ ERR: Invalid request</td>
<td>You have entered an unacceptable parameter.</td>
<td>Check each element in your request and reissue your request command.</td>
</tr>
<tr>
<td>REQ ERR: Invalid SDB file supplied to LSTNET. Request canceled</td>
<td>You have entered an unacceptable parameter.</td>
<td>Reissue the command, changing the SDB file name.</td>
</tr>
<tr>
<td>REQ ERR: Invalid sector name</td>
<td>You have entered an unacceptable parameter.</td>
<td>Reissue the command, entering a proper sector name.</td>
</tr>
<tr>
<td>Diagnostic Message</td>
<td>Explanation</td>
<td>What to Do</td>
</tr>
<tr>
<td>--------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>REQ ERR: INVALID SET LEN command. No line length given.</td>
<td>You have not entered a necessary parameter.</td>
<td>Check each element in your request and reissue your request command.</td>
</tr>
<tr>
<td>REQ ERR: Invalid stack size in ARRD request</td>
<td>You have entered an unacceptable parameter.</td>
<td>Reissue the command, changing the stack size.</td>
</tr>
<tr>
<td>REQ ERR: Invalid stack time in ARRD request</td>
<td>You have entered an unacceptable parameter.</td>
<td>Reissue the command, changing the stack time.</td>
</tr>
<tr>
<td>REQ ERR: Invalid start time in request</td>
<td>You have entered an unacceptable parameter.</td>
<td>Reissue the command, changing the start time.</td>
</tr>
<tr>
<td>REQ ERR: Invalid TDB file supplied to LSTNET. Request canceled.</td>
<td>You have entered an unacceptable parameter.</td>
<td>Reissue the command, changing the TDB file name.</td>
</tr>
<tr>
<td>REQ ERR: Invalid time or date phrase</td>
<td>You have entered an unacceptable parameter.</td>
<td>Reissue the command, changing the time or date phrase.</td>
</tr>
<tr>
<td>REQ ERR: INVALID time period, too far in PAST</td>
<td>You have entered an unacceptable parameter.</td>
<td>Reissue the command, changing the date to a more current one.</td>
</tr>
<tr>
<td>REQ ERR: Invalid time specification in Caps phrase</td>
<td>You have entered an unacceptable parameter.</td>
<td>Reissue the command, changing the time.</td>
</tr>
<tr>
<td>REQ ERR: LOCAL/REMOTE FLAG NOT SET, EXITING LSTNET</td>
<td>The system is having a communication problem.</td>
<td>Contact your System Administrator or call the TFMS Hotline.</td>
</tr>
<tr>
<td>REQ ERR: Location duplicated</td>
<td>You have entered an unacceptable parameter.</td>
<td>Check each element in your request and reissue your request command.</td>
</tr>
<tr>
<td>REQ ERR: Location in FIXL is not an Airport or a Fix</td>
<td>You have entered an unacceptable location.</td>
<td>Reissue the command, changing the location.</td>
</tr>
<tr>
<td>REQ ERR: LSTNET has no data after timeout. Request canceled.</td>
<td>The system is having a communication problem.</td>
<td>Contact your System Administrator or call the TFMS Hotline.</td>
</tr>
<tr>
<td>REQ ERR: More than two places of interest- use brackets to clarify</td>
<td>You must enter information in order to have your request acted upon.</td>
<td>Add brackets where necessary to specify your places of interest.</td>
</tr>
<tr>
<td>REQ ERR: No airport associated with given fix</td>
<td>You have entered a fix not associated with a monitored airport.</td>
<td>Reissue the command, changing the fix.</td>
</tr>
<tr>
<td>REQ ERR: No data has been supplied to process request</td>
<td>You must enter information in order to have your request acted upon.</td>
<td>Reissue the command, entering the required data.</td>
</tr>
<tr>
<td>REQ ERR: No data supplied to process Secondary Request</td>
<td>You must enter information in order to have your request acted upon.</td>
<td>Reissue the command, entering the required data.</td>
</tr>
<tr>
<td>REQ ERR: No fix level specified; REQUEST canceled</td>
<td>You must enter information in order to have your request acted upon.</td>
<td>Reissue the command, entering the required data.</td>
</tr>
<tr>
<td>REQ ERR: No fix names available for given airport</td>
<td>You are requesting fix information on an airport without available fixes.</td>
<td>N/A</td>
</tr>
<tr>
<td>REQ ERR: No location specified in ARRD Request</td>
<td>You must enter information in order to have your request acted upon.</td>
<td>Reissue the command, entering the required location.</td>
</tr>
<tr>
<td>REQ ERR: &lt; &gt; not responding, request canceled</td>
<td>Either the Schedule Database, the Traffic Demands Database or the Flight Table Manager is having a connection problem.</td>
<td>Contact your System Administrator or call the TFMS Hotline.</td>
</tr>
<tr>
<td>REQ ERR: Only primary places of interest are allowed in REQ AREA</td>
<td>You have entered an unacceptable parameter.</td>
<td>Check each element in your request and reissue your request command.</td>
</tr>
<tr>
<td>REQ ERR: Only sectors are valid in a REQ AREA</td>
<td>You have entered an unacceptable parameter.</td>
<td>Check each element in your request and reissue your request command.</td>
</tr>
<tr>
<td>REQ ERR: Original request not saved - cannot process current</td>
<td>The system is having a communication problem.</td>
<td>Contact your System Administrator or call the TFMS Hotline.</td>
</tr>
<tr>
<td>REQ ERR: Place of interest included and excluded in same list</td>
<td>You have entered an unacceptable parameter.</td>
<td>Check each element in your request and reissue your request command.</td>
</tr>
<tr>
<td>TFMS Diagnostic Messages</td>
<td>Explanation</td>
<td>What to Do</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------</td>
<td>------------</td>
</tr>
<tr>
<td>REQ ERR: Primary place of interest missing or is exclusion only</td>
<td>You have entered an unacceptable parameter.</td>
<td>Reissue the command, specifying a primary place of interest.</td>
</tr>
<tr>
<td>REQ ERR: (LIST) Program Fault trap. Request canceled.</td>
<td>List Server crashed or someone killed the process using sigp or ctrl q. Message appears if there is an outstanding request.</td>
<td>Contact your System Administrator or call the TFMS Hotline.</td>
</tr>
<tr>
<td>REQ ERR: (LSTHUB) Program Fault trap. Request canceled.</td>
<td>List Server crashed or someone killed the process using sigp or ctrl q. Message appears if there is an outstanding request.</td>
<td>Contact your System Administrator or call the TFMS Hotline.</td>
</tr>
<tr>
<td>REQ ERR: (LIST) Rcvd QUIT cmd. Request canceled.</td>
<td>Outstanding request was being processed by List Server as a reconfigure QUIT command took place.</td>
<td>Contact your System Administrator or call the TFMS Hotline.</td>
</tr>
<tr>
<td>REQ ERR: (LSTHUB) Rcvd QUIT cmd. Request canceled.</td>
<td>Outstanding request was being processed by List Server as a reconfigure QUIT command took place.</td>
<td>Contact your System Administrator or call the TFMS Hotline.</td>
</tr>
<tr>
<td>REQ ERR: Redundant exclusion in air or type phrase</td>
<td>You have excluded data twice, causing the system confusion.</td>
<td>Check each element in your request and reissue your request command.</td>
</tr>
<tr>
<td>REQ ERR: Redundant exclusion in equipment phase</td>
<td>You have excluded equipment data more than once, causing the system confusion.</td>
<td>Check each element in your request and reissue your request command.</td>
</tr>
<tr>
<td>REQ ERR: Redundant exclusion in remark phrase</td>
<td>You have excluded remark data more than once, causing the system confusion.</td>
<td>Check each element in your request and reissue your request command.</td>
</tr>
<tr>
<td>REQ ERR: Redundant inclusion in equipment phrase</td>
<td>You have included equipment data more than once, causing the system confusion.</td>
<td>Check each element in your request and reissue your request command.</td>
</tr>
<tr>
<td>REQ ERR: Redundant inclusion in remark phrase</td>
<td>You have included remark data more than once, causing the system confusion.</td>
<td>Check each element in your request and reissue your request command.</td>
</tr>
<tr>
<td>REQ ERR: Secondary requests can only be made using local reports.(CR)</td>
<td>Secondary requests cannot be made off this primary report type.</td>
<td>N/A</td>
</tr>
<tr>
<td>REQ ERR: Sectors in the PPI cause a SPI to be invalid</td>
<td>You have entered an unacceptable parameter.</td>
<td>Check each element in your request and reissue your request command.</td>
</tr>
<tr>
<td>REQ ERR: Sectors in the PPI cause exclusions to be invalid</td>
<td>You have entered an unacceptable parameter.</td>
<td>Check each element in your request and reissue your request command.</td>
</tr>
<tr>
<td>REQ ERR: TDB file transfer failed, request canceled</td>
<td>The system is having a communication problem with the Traffic Demands Database file.</td>
<td>Contact your System Administrator or call the TFMS Hotline.</td>
</tr>
<tr>
<td>REQ ERR: Transmitted file cannot be accessed. Request canceled.</td>
<td>The system is having a communication problem.</td>
<td>Contact your System Administrator or call the TFMS Hotline.</td>
</tr>
</tbody>
</table>
# TFMS Diagnostic Messages

<table>
<thead>
<tr>
<th>Diagnostic Message</th>
<th>Explanation</th>
<th>What to Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>REQ ERR: Unable to process request; HUBSITE LSTNET not responding</td>
<td>No LSTHUB process is running at the hubsite, or request timed out waiting for LSTHUB.</td>
<td>Contact your System Administrator or call the TFMS Hotline.</td>
</tr>
<tr>
<td>REQ ERR: Unable to process request; LOCAL LSTNET not responding</td>
<td>No List process is currently running at a remote site.</td>
<td>Contact your System Administrator or call the TFMS Hotline.</td>
</tr>
<tr>
<td>REQ ERR: Unclear use of brackets—must be non-imbedded pairs</td>
<td>You have entered an unacceptable parameter.</td>
<td>Check each element in your request and reissue your request command.</td>
</tr>
<tr>
<td>REQ ERR: Unknown word in request</td>
<td>You have made a request with an entry the system does not accept.</td>
<td>Check each element in your request and reissue your request command.</td>
</tr>
<tr>
<td>REQUEST FAILED: Unknown command found in request</td>
<td>You are using an invalid command.</td>
<td>Check each element in your request and reissue your request command.</td>
</tr>
<tr>
<td>REQ ERR: Use of location specifier is invalid after LIST or LISTO</td>
<td>You have entered an unacceptable parameter.</td>
<td>Check each element in your request and reissue your request command.</td>
</tr>
<tr>
<td>Request Server is not up yet</td>
<td>You cannot get request information until the system has communication with the Request Server.</td>
<td>Wait for the “Request Server Up” message or try again later.</td>
</tr>
<tr>
<td>Request Server not running. Make request again.</td>
<td>The system did not make the connection with the Request Server, which processes your request.</td>
<td>Try making the request again. If the Request Server is still not running, contact your System Administrator.</td>
</tr>
<tr>
<td>REQ STATUS: Waiting on Missing Data being Filled</td>
<td>The system needs more time to complete your request.</td>
<td>Wait for the system to process your request.</td>
</tr>
<tr>
<td>REQ USER INFO: This is a complex request and may take longer than usual</td>
<td>The system needs more time to complete your request.</td>
<td>Wait for the system to process your request.</td>
</tr>
<tr>
<td>REQ WARNING: End time out of range, bounds reset by LSTNET.</td>
<td>You have entered an unacceptable parameter.</td>
<td>Accept the reset bounds or reissue the command and choose a different time.</td>
</tr>
<tr>
<td>REQ WARNING: LIST/COUNT report has partial FTM data</td>
<td>The system is having a communication problem.</td>
<td>Contact your System Administrator or call the TFMS Hotline.</td>
</tr>
<tr>
<td>REQ WARNING: Start time out of range, bounds reset by LSTNET.</td>
<td>You have entered an unacceptable parameter.</td>
<td>Accept the reset bounds or reissue the command and choose a different time.</td>
</tr>
<tr>
<td>Runway data is not available for XXXX</td>
<td>The identifier entered does not match an airport for which the database has runway data.</td>
<td></td>
</tr>
<tr>
<td>S must be followed by an S, H, or L</td>
<td>The ALARM ON/OFF command is invalid.</td>
<td></td>
</tr>
<tr>
<td>Sent request to &lt;server&gt;</td>
<td>This is a message notifying you that your request has been sent to the appropriate server. There are five different types of servers: flight, schedule, request, communications, and weather.</td>
<td>The message you receive is based on the type of command you issue. If you are using the request command, for example, your message should say “Sent request to Request Server.”</td>
</tr>
<tr>
<td>Starting Request Server</td>
<td>You cannot yet issue your request, since the server is just beginning to process.</td>
<td>Soon you will receive a message that says the Request Server is up, then you will be able to send your request.</td>
</tr>
<tr>
<td>TDB Not RespondingRequest has timed out</td>
<td>A request for TFMS data times out.</td>
<td></td>
</tr>
<tr>
<td>The defaults files cannot be deleted.</td>
<td>The TSD defaults files have been specified for deletion.</td>
<td>Do not delete the defaults file.</td>
</tr>
</tbody>
</table>
## TFMS Diagnostic Messages

<table>
<thead>
<tr>
<th>Diagnostic Message</th>
<th>Explanation</th>
<th>What to Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>The folder cannot be deleted because it is not empty.</td>
<td>The TSD recognizes that a folder has been specified for deletion but it is not empty.</td>
<td>Empty the folder before deleting it.</td>
</tr>
<tr>
<td>The following actions have been taken:&lt;FCA Name&gt;: Not deleted-authorization failed,&lt;FCA Name&gt;: Not deleted-FCA doesn’t exist,&lt;FCA Name&gt;: Successfully deleted</td>
<td>The RRHUB receives this FCA Delete message from the TSD, sends a confirmation message back to the TSD using the same message ID used in the request, and logs the event. This confirmation message lists all FCAs that were deleted and any that were not.</td>
<td>N/A</td>
</tr>
<tr>
<td>The maximum number of range rings sets cannot exceed 64.</td>
<td>The TSD recognizes the maximum number of defined range rings sets in the Create Range Rings and the Add Range Rings dialog box.</td>
<td>Do not define more than 64 range rings sets in a single dialog box.</td>
</tr>
<tr>
<td>Time Limit value must be in the range from 0.25 to 9.0 hours</td>
<td>The time limit value specified in the Time Limits semicolon command or the Time Limits function for examined elements is invalid.</td>
<td></td>
</tr>
<tr>
<td>Unknown projection</td>
<td>The projection region specified by the user does not uniquely match one of the valid projections.</td>
<td></td>
</tr>
<tr>
<td>Warning: Existing file &lt;file name&gt; will be overwritten! Proceed?</td>
<td>The TSD displays this warning if a file may be overwritten by the File Save command.</td>
<td>Select OK to overwrite the file or Cancel not to overwrite it.</td>
</tr>
<tr>
<td>Warning: DEFAULTS file will be overwritten! This is NOT recommended! Proceed?</td>
<td>An existing defaults file may be overwritten.</td>
<td>Select OK to overwrite the defaults file or Cancel not to overwrite it.</td>
</tr>
<tr>
<td>WX timeout</td>
<td>The system was checking files for information, but did not find them within a specified time.</td>
<td>Try again and if it happens once more, contact your System Administrator.</td>
</tr>
</tbody>
</table>
Glossary

Many of the terms included in this glossary have more than one meaning, and the definition given may not always be the most common one. These definitions refer to how the terms are used in relation to the TSD.

**A**
Stands for arrival.

**AAR**
Stands for Airport Arrival Rate, the number of arriving aircraft an airport can accommodate during a certain period of time.

**Absolute Time Range**
With Absolute Time Range mode, a selected time range remains the same as current time advances. The TSD provides users the capability to determine whether selected time intervals display in Relative or Absolute time in the NAS Monitor, Monitor All Reroutes, and Examine FEA/FCA.

**AC**
Stands for Adaptive Compression.

**accelerator**
A shortcut method that uses a key combination shown on the X window control menu to select options.

**AC_CAT**
Stands for aircraft categories (jet, propeller, turbo prop).

**ACENTR**
Stands for arrival center.

**ACID**
Unique alphanumeric aircraft identifier. Also known as call sign.

**AC_RMK**
Stands for standard keywords representing flights remarks data.

**active**
Refers to flights in the air.
**ACTV**
Activates a flight or airline in the TFMS airline database, thus removing a restriction that was previously set with the INHB command.

**adaptation file**
An external file you can create in order to tailor the initial TSD appearance to your own needs by including TSD command instructions in the file.

**Adaptive Compression**
Intended to avoid slots being wasted. Moves flights up to fill those slots.

**Ad Hoc**
Reroutes class letting you create reroutes from scratch, from the Coded Departure Routes (CDR) database, or from a combination of both.

**adjust colors palette**
A row of six colored blocks, each of which may be moved up or down in order to alter the intensity of the color within the TSD display.

**ADL**
Stands for Aggregate Demand List. When Volpe National Transportation Systems Center receives updated flight schedules and other NAS information from participating DCDM AOCs, Volpe send the information back to the users in the form of an Aggregate Demand List.

**ADR**
Stands for Airport Departure Rate, the number of departing aircraft an airport can accommodate during a certain period of time.

**AFIX**
Stands for arrival fixes.

**AFP**
Stands for Airspace Flow Program. Controls departure times of flights arriving at a Flow Constrained Area (FCA)

**AGT**
Stands for actual ground time, the difference between the ARTD and the PGTD.

**AGTA / AGTD**
Stands for actual gate time of arrival / actual gate time of departure. Renamed to ARTA and ARTD.
**aircraft type**
An FAA abbreviation for a particular make of aircraft; appears as one of the fields in a flight data block and as one of the request command options.

**AIRL**
Stands for airline.

**AIRP**
Stands for airport.

**airplane icon**
The representation of an aircraft by the illustration of a small airplane on the TSD, either when you have zoomed in significantly far, or when you have distinguished a flight or group of flights from the others in some way. See also automatic icon, dot icon, flight icon heavy icon, and prop icon.

**Air Route Traffic Control Center**
See ARTCC.

**Air Traffic Control System Command Center**
See ATCSCC.

**airway**
Refers to a listing of airways traversed; also a pre-defined route over which flights may travel. See also jet airways and victor airways.

**Alert**
Indicates area of concern to traffic management. It occurs when the TSD software projects that the amount of air traffic will exceed a pre-defined threshold for a given element.

**alert area**
A type of Special Use Airspace in which pilot training or other non-hazardous flight activities occur.

**alerted elements**
Elements over which the amount of air traffic is projected to exceed a pre-defined threshold.

**alerted flights**
See examined flights.
**Altitude (ALT)**

Altitude listing on the TSD designate where the strongest winds are measured, in hundreds of feet. Thus, 338 represents an altitude of 33,800 feet.

**ARINC**

Stands for Aeronautical Radio Inc.

**ARRD**

Stands for Arrival Delay prediction.

**arrival fix**

The point at which responsibility for control of arriving flights passes from an Air Route Traffic Control Center to a Terminal Control Area.

**arrivals/departures option**

Allows the user to limit information in reports to arrivals only or departures only.

**ARTA / ARTD**

Stands for Actual Runway Time of Arrival (formerly AGTA) and Actual Runway Time of Departure (formerly AGTD).

**ARTCC**

Stands for Air Route Traffic Control Center, a facility devoted to air traffic control of en route aircraft operating on IFR flight plans. There are 20 ARTCCs within the CONUS.

**ASD**

Stands for Aircraft Situation Display, the former TFMS function that allowed you to communicate with the TFMS databases. Replaced by the TSD, the Traffic Situation Display.

**ASECTR**

Stands for arrival sector.

**ASLOT**

Arrival slot currently assigned to a flight. Includes the arrival airport and slot time in six-digit format.

**AT**

Refers to Atlantic Ocean, one of three geographic regions around which the display can be oriented.
**ATCSCC**

Stands for Air Traffic Control System Command Center, the national traffic management facility located at FAA headquarters in Washington, D.C. It is known informally as Central Flow. The top of the traffic management hierarchy, it manages air traffic problems on a national level and coordinates and approves actions taken by other traffic management facilities.

**ATMS**

Stands for Advanced Traffic Management System, a research and development program.

**audible alarm file**

Specifies elements that, when alerted, cause the TSD to sound an audible alarm or flash an alert signal. This file may also contain information defining how the alarm sounds or appears.

**automatic icon**

When the automatic icon (A) is specified for a flight set under the Select Flights dialog box, a flight is represented by one of three icons, whichever is appropriate: heavy icon for heavy aircraft, prop icon for prop aircraft, or airplane icon for all other aircraft.

**bar chart**

A graphical method of comparing an element's demands with its traffic thresholds. This comparison is displayed for each 15-minute time interval in the current time bar. In the case of airports, two bars appear for each time interval: one for arrivals and one for departures.

**Beacon Code**

A four-digit transponder code assigned to an aircraft by a NAS center. It is forwarded to the TFMS in a Beacon code (BZ) message subsequent to a flight plan and usually prior to a departure message (DZ). It is also transmitted to the TFMS prior to a center hand-off message (UZ).

**BETA / BETD**

Stands for Beginning Estimated Time of Arrival (wheel time) and Beginning Estimated Time of Departure (wheel time).

**BLKT**

Refers to Blanket, which is a type of control applied to all flights that are part of a specific ground delay program.

**boundaries**

Within the TSD, refers to geographical boundaries. These depict national boundaries as well as state borders within the United States.
**BZ**
See Beacon Code.

**C**
Refers to Runway Centerline Light Setting. Its values range from 0 (off) to 5 (maximum intensity), ASCII blank (no centerlines are configured for the runway), or F (sensor failure).

**CA_DIF**
Refers to the difference between ARTA and CTA, with a designator showing the status of the comparison.

**call sign**
See ACID.

**CALT**
Stands for Current Altitude.

**capacity**
The demand threshold at an airport, sector, or fix. When exceeded by a projected demand, causes an alert status. See also demand data, threshold.

**CAPL**
Stands for capacities list and refers to the TSD command that shows you the current capacity settings for any airport, fix, or sector.

**CAPS**
Stands for capacities set and refers to the TSD command that allows you to set the arrival or departure limit of any airport, fix, or sector for periods of time that you specify.

**CCFP**
Stands for Collaborative Convective Forecast Product which identifies areas for predicted thunderstorms.

**CD_DIF**
Refers to the difference between ARTD and CTD, with a designator showing the status of the comparison.

**CDR**
Stands for Coded Departure Routes.
**CDM**
Stands for Collaborative Decision Making, a joint government/industry initiative with the goal of improving air traffic management through increased information sharing, common situational awareness, and equitable resource allocation.

**CDT**
See controlled departure time.

**center**
Refers to departure center for arrivals; arrival center for departures.

**centrl**
Refers to a listing of centers traversed.

**CGTA / CGTD**
Stands for Controlled Gate Time of Arrival and Controlled Gate Time of Departure. Renamed to CTA and CTD.

**CIWS**
Stands for Corridor Integrated Weather System, a suite of weather display products that provide short-term accurate convective weather forecasts and storm depiction.

**class**
Refers to aircraft classes (heavy, large, and small).

**close**
A menu control option that exits the TSD window. This function shuts down any program running in this window. It is not recommended that you close the TSD this way. When you want to exit the TSD, you should use the TSD's Quit command for a more orderly shutdown.

**CNX**
A report listing all flights cancelled in EDCT programs for a selected airport of FCA.

**color palette**
Refers to a checkerboard-like display of 30 colors from which you may choose to depict a variety of TSD icons including those for flights, lightning, and jet stream.

**color set name**
A name that you specify when saving a color set.
columns option
Allows user to request columns of information other than the default columns in the flight list report. With this option the user can also specify the order of display.

command history
Refers to a function that lets you display a list of previously entered commands. When the list of commands is selected, you can click on one of them to highlight it and place it in the Input Request field.

command line
A command that lets you issue TSD commands, display previously issued commands, and display a list of reports that have been received during the current TSD session.

command line interface
Refers to pressing the semicolon (;) key or selecting Command Line from the Tools menu to display the command line dialog box and entering a command in it to generate TSD functions.

COMP
Stands for compression, a process for filling open slots with available aircraft or for moving aircraft to later slots they can use, when aircraft are unable to use an earlier slot.

connection status indicator
The small red or green box located to the right of the Send button that indicates the status of the connection between Autosend and the communications software.

controlled airport
Airport currently controlled by ground delay programs.

controlled arrival time
The time of arrival for a flight currently controlled at an airport by ground delay programs.

controlled departure time
The time of departure for a flight currently controlled at an airport by ground delay programs.

controlled flight
Flight currently controlled by ground delay programs.

CONUS
Stands for both CONtinental United States and CONtiguous United States. Refers to the TSD graphic representation of the U.S. borders with the state outlines shown.
**CT messages**
Stands for control time messages issued by the TSD to implement the control time for each flight.

**CTA / CTD**
Stands for Controlled Time of Arrival. (formerly CGTA) and Controlled Time of Departure (formerly CGTD).

**CTL-ELEM**
Stands for Controlled Element.

**customize**
A dialog box that allows you to change the colors and font sizes of the TSD.

**CX**
Stands for cancel flag identifier.

**CXSD**
Stands for cancel flight from schedule database and refers to the TSD command that allows you to cancel the current day's flight plan for a flight number you specify. A flight canceled with the CXSD command will not appear in alert or request server reports.

**D**
Stands for Departure.

**DAS**
Stands for Delay Assignment. The default delay assignment mode, formerly known as FA Delay.

**database commands**
Let you display and revise airport, fix, and sector capacity settings; display and revise airport General Aviation estimates; and maintain the airline schedule database.

**data block**
A collection of flight information for each aircraft that can be displayed on the TSD. It includes the aircraft call sign, altitude, aircraft type, number of minutes to arrival, and the groundspeed.

**data source option**
A combination of actual and scheduled flight times used to calculate report data.
**DCENTR**

Stands for departure center.

**default**

A command that restores the display to the customized configuration that appeared when the TSD was started, or to another specified adaptation.

**Delay Advisor**

A tool that provides access to the Ground Time Predictor (GTP), a system that predicts flight departures based on historical data.

**demand data**

Figures representing the amounts of air traffic for airports, sectors, or fixes. They can be illustrated on the TSD in the form of either charts or reports. Demands are defined as the numbers of arrivals and departures at an airport, the number of flights in a sector at the same time, or the number of flights crossing a fix.

**Dep**

Departure airport.

**departure fix**

The point at which responsibility for control of departing flights passes from a Terminal Control Area to an Air Route Traffic Control Center.

**DEST**

Destination airport.

**DFIX**

See departure fix.

**display–only fixes**

Fixes whose FAA designators can be displayed on the TSD but will not be recognized by the TSD when specified in Move, Zoom, Range Rings, or other TSD commands. Any named fix that is not a navaid, airport, arrival fix, or departure fix is probably a display-only fix. Most display-only fix designators can be seen only when the airways along which they appear have been displayed.

**distance**

A button in the Create Manual Reroutes dialog box used to display the distance (in nautical miles) along a reroute.
**DME**
A command that displays the distance in nautical miles between specified points on the TSD and draws a line connecting the points.

**dot icon**
The representation of an aircraft by a small dot on the TSD, appearing when you have unzoomed so far that aircraft icons would obliterate the screen. The dot icon also appears on the.

**DP**
Stands for Departure Procedure.

**Draw Reroute**
The capability available in the Create and Edit Reroute commands that allows you to draw a reroute on the TSD map.

**DSECTR**
Stands for departure sector.

**DTRSN**
Stands for DP (Departure Procedure) Transition Fixes.

**DV_REC**
Stands for Diversion Recovery.

**DVT**
Stands for Diversion Recovery.

**Dynamic List**
An FEA/FCA Report that includes only flights that are predicted to intersect the FEA/FCA during the selected time intervals. The Dynamic List is updated each time the FEA/FCA is updated.

**Dynamic Projection**
Dynamic Projection can be selected in the Projection command in the Maps menu to reduce distortion of the map overlay. This enables the projection center point to change automatically to be equal to the display center point and to change accordingly.

**E**
Refers to Runway Edge Light Setting. Its values range from 0 (off) to 5 (maximum intensity), or F (sensor failure).
**EAFT**
Stands for Estimated Arrival Fix Time.

**ECR**
Stands for EDCT Change Request, used to view and update an arriving flight’s control time during a GDP.

**EDCT commands**
The Estimated Departure Clearance Time commands control the departure times of flights that will arrive at a specific airport and provide information about controlled flights and airports.

**EDCT server**
The Estimated Departure Clearance Time server keeps track of all ground delay programs and allows the user to review their status. This function can be accessed through the TSD.

**EDFT**
Stands for Estimated Departure Fix Time.

**EDT**
Stands for Estimated Departure Time, based on either actual departure time or proposed departure time.

**EFTA**
Stands for Estimated Fix Time of Arrival.

**EGT**
Stands for Estimated Ground Time, predicted by Ground Time Predictor (GTP).

**element**
A named NAS facility or airspace component that can be displayed on the TSD. Examples are sectors, airports, fixes, and airways.

**element name**
The FAA name used to identify a NAS element on the TSD. For instance, BWI is the element name of the Baltimore Washington National Airport.

**element type**
Identifies a class of NAS elements displayed on the TSD (for example, sector, fix, and airport).
**EMA**
Stands for Equity Metric for Airlines, a metric that indicates how equitable a proposed initiative is for the airlines.

**EMail**
Electronic Mail (EMail) allows you to send advisories or general messages to addresses on the National Airspace Data Interchange (NADIN) Network and Aeronautical Radio Inc. (ARINC) Network or to other workstations.

**EMF**
Stands for Equity Metric for Flights, a metric that indicates how equitable a proposed initiative is for all the flights.

**ENTRY**
Refers to sector entry times.

**EQUIP**
Refers to equipment type, represented by prefix or suffix (H/R).

**ERAM**
Stands for En Route Automation Modernization.

**ERTA / ERTD**
Stands for the Earliest Runway Time of Arrival and Earliest Runway Time of Departure. This is the earliest CTA or CTD that the airline would accept for the flight.

**ETA / ETD**
Stands for Estimated Time of Arrival and Estimated Time of Departure, based on a flight's actual or estimated time of arrival or departure.

**ETE**
Stands for Estimated Time Enroute.

**ETMS**
Stands for Enhanced Traffic Management System and is an automated data processing system which supports the FAA traffic management functions. Based on prototype software developed for the Advanced Traffic Management System (ATMS).

**E_TYPE**
Refers to complete aircraft equipment type. Includes both aircraft type (TYPE) and equipment type data.
**EX**
Exempt flag. Indicates whether the flight was considered exempt when the last controls were computed by FSM. Values are Y or N.

**examined flights**
Flights predicted to arrive at, depart from, or traverse any element being examined during the time range currently selected on the alerts time bar.

**EXIT**
Refers to sector exit times.

**external file**
A file that you create from outside the TSD.

**FAA**
Stands for Federal Aviation Administration.

**FAA designator**
Abbreviation or other identifier assigned by the FAA to an individual location or item.

**FA Delay**
See DAS (Delay Assignment)

**FADT**
Stands for Fuel Advisory Delay Table, which specifies delays that apply to pop-up flights arriving at a controlled airport during a controlled interval.

**fake data**
A TSD flight data representation based on a stored file of static flight positions.

**FCA**
Stands for Flow Constrained Area, a graphic overlay showing an area where flight rerouting may be necessary.

**FDB**
Stands for Flight Database.

**FEA**
Stands for Flow Evaluation Area, a graphic overlay showing an area where flight rerouting may be necessary.
file server node
The node on which TSD programs and data files are stored.

filter options
Allow users to select for display and inclusion in reports flights that meet specified criteria.

fix
A referable position on the surface of the earth. May be identified by latitude and longitude, an adapted name, or a fix-radial-distance.

FIXL
Stands for Fix Loading.

fix loading report
Counts flights traversing a specified arrival fix or all arrival fixes for a specified airport.

fix–radial–distance
A fix defined by reference to a navaid. The fix location is determined by following the given heading (radial) from the given navaid (fix) for the given distance.

flagpole
The line that connects a data block with the flight icon it describes.

flight counts report
Displays the number of flights departing from, arriving at, or traversing an airport, fix, or sector.

flight data update
The time at which flight icons disappear from the TSD display and reappear in their newly reported positions.

flight icon
Either of four graphic representations of flights. Airplane icons look like swept-wing airplanes and represent flights either when you have zoomed in beyond a certain point or when you have specified the icon for a particular flight set. Dot icons are smaller and appear only when you have unzoomed to a certain point. Heavy icons look like wedges and represent heavy aircraft when the automatic icon has been specified for a flight set. Prop icons look like straight-wing airplanes and represent prop aircraft.
flight level
Means of describing the altitude at which planes fly, expressed in hundreds of feet. Thus, a flight level of 250 is equal to 25,000 feet.

flight list report
Includes all flights projected to traverse an alerted area for each 15-minute interval during the alert time period denoted by the time bar.

flight path
A graphic depiction of a flight's route on the TSD.

FPSD
Stands for Flight Plan Schedule Database and refers to the TSD command that allows you to add a flight plan record to the Official Airline Guide (OAG) database. The flight plan will remain in the database marked as an “added flight” until the next OAG update.

FSM
Stands for Flight Schedule Monitor.

FTM
Stands for Flight Table Manager and is a program that maintains the database of flight information used for the TSD display.

full application modal
Means that users can interact with any window except those that are part of the same application as the modal window.

FZ messages
NAS flight plan messages, which are received by the TFMS and include the proposed departure time of each flight.

GA
Stands for General Aviation and refers to the category of flights that is unscheduled and non-commercial. For example, both civilian and military flights are General Aviation flights.

GAAP
Stands for General Aviation Airport Program, a delay assignment mode used during a GDP when current demand does not meet capacity but it believed that unknown traffic will meet or near capacity.
**GAEL**
Stands for General Aviation Estimates List and refers to the TSD command that allows you to view the estimated number of General Aviation (GA) flights that will arrive and depart within each 15-minute interval from an airport you specify.

**GAES**
Stands for General Aviation Estimates Set and refers to the TSD command that allows you to change the estimated number of General Aviation (GA) flights that will arrive and depart during each 15-minute interval from an airport you specify for periods of time that you specify.

**GCD**
Stands for Great Circle Distance, the distance between the origin airport and arrival airport.

**GDP**
Stands for Ground Delay Program, a specific operation that assigns delay (control times) to the departure times of flights that will be arriving at a specific airport.

**GDT**
Stands for Ground Delay Tools, components that aid users in looking at various operational or air traffic scenarios.

**general aviation**
See GA.

**ghost**
An outline of an aircraft icon, representing a flight about which no position information has been received for over seven minutes.

**GOES**
Stands for Geostationary Operational Environmental Satellite data, used in satellite mosaic in weather displays.

**graphic image format**
See Snapshot.

**ground speed**
Flight speed measured relative to the ground, expressed in knots.
**GS**
Stands for Ground Stop, a traffic management action that halts departures for a given airport. Also refers to ground speed.

**gstop option**
Allows user who is generating reports of counts by origin airport or center to show counts of all flights that have not yet departed and those flights held past their original departure times.

**GTM**
Stands for ground time method, a method for making predictions of flights.

**GTP**
Stands for ground time predictor.

**GTP ACID**
Stands for ground time predictor aircraft identifier. Lets you display information about as many as 14 of the most recent departures for a specified flight from a specified airport.

**GTP AIRP**
Stands for ground time predictor airport. Lets you display a summary overview of ground times experienced by flights at specified airports over a 24-hour period.

**GUFI**
Stands for Global Unique Flight Identifiers. GUFI makes it possible for all flight data systems to have consistent, accurate data about what flights are operating, when, on what routes, and under what constraints. ERAM assigns the GUFI to the flight when a flight plan is received and then provides it to TFMS along with the flight plan.

**heavy icon**
The representation of a heavy aircraft by the illustration of a small wedge on the TSD. These icons only appear when the automatic icon (A) has been specified for a flight set on the Select Flights dialog box.

**high sectors**
Volumes of airspace defined for controlling high altitude flights. High sector altitude limits generally cover from 24,000 to 33,000, or 24,000 to 60,000 feet.

**history**
Displays a dotted line that traces the flight path from the time the tracing begins until either the flight lands or you turn the function off.
**HP**
Stands for Hewlett Packard, the source of the computer hardware used by the TSD.

**Hubsite**
Also referred to as Hub, it is the source of request data in Cambridge, Massachusetts. Used as a data source with request commands.

**Icon**
See flight icon.

**IDENT**
Stands for flight identifier (same as ACID option).

**IFR**
Stands for Instrument Flight Rules, and indicates flights that are positively tracked and controlled by en route air traffic control.

**IGTA / IGTD**
Stand for Initial Gate Time of Arrival and Initial Gate Time of Departure, the arrival time (or departure time) when the flight was first created. It is used to positively identify a flight leg.

**import**
Lets you import reroute definitions from one TSD to another.

**IN**
Actual Time reported by the airlines for gate arrival.

**information boxes**
Similar to a query box but it gives you a brief message and asks for an acknowledgement.

**INHB**
Stands for inhibit flight in schedule database and refers to the TSD command that allows you to inhibit (or cancel temporarily) either a specific flight or all flights for a specific airline in the schedule database.

**initialize**
Returns TSD display to its default state.

**input device**
Hand-held input devices, the mouse and the trackball, provide an alternative to the keyboard as a means of communicating with the computer.
**intersections**
A button in the Create Manual Reroutes dialog box employed to label all points where jet routes used in the reroute intersect ARTCC boundaries and other jet routes.

**item settings**
Refers to a number of map overlays whose colors and font sizes can be changed.

**jet airways**
Pre-defined airways to be used by flights at altitudes of 18,000 feet and above. Also known as jet routes.

**keyboard**
A checkerboard-like display of 30 different colors from which you may choose when issuing one of the colors commands.

**lat/lon**
Refers to latitude/longitude coordinates that may be entered in the Move or Zoom commands to center the point of the display.

**leader line**
The line that connects a data block with the flight icon it describes.

**lead lines**
Dotted lines leading away from the noses of the aircraft icons on the TSD. They indicate where the flights will be either in a certain period of time or at a certain distance from their current positions, assuming the flights continue traveling in the same direction and at the same speed.

**legend**
A command that allows you to display text at the bottom of a TSD window.

**LGTA / LGTD**
Stands for Airline Gate Time of Arrival and Airline Gate Time of Departure.

**LIFP report**
Lists flight plans of selected aircraft.

**locid**
Stands for location identifier and refers to a prompt often used to request a place name. It can refer to an airport, navaid, fix, sector, ARTCC, or other FAA place designator.
**low sectors**
Volumes of airspace defined for controlling low altitude flights. Low sector altitude limits generally cover from ground level to 23,000 feet, unless over a TRACON, where the low sector limits cover from 18,000 to 23,000 feet.

**LRTA / LRTD**
Stands for Airline Runway Time of Arrival and Airline Runway Time of Departure.

**main menu**
The main menu displayed at the top to the TSD display.

**MAP**
Monitor Alert Parameter refers to the threshold that determines the alert status of sectors, airports, and fixes.

**METAR**
Stands for Aviation Routine Weather Report, a type of weather report produced through the Report command in the Weather menu.

**military areas**
A term used within the TSD program to mean Special Use Airspace (SUA); SUA does not refer only to Military Operations Areas.

**military operations area**
See MOA.

**minutes to arrival**
One of the fields in a data block. It indicates how many minutes are expected to pass from the time currently displayed in the time box until the flight is projected to land.

**MIT (Miles In Trail) Restriction**
An MIT Restriction is an air traffic management initiative used to space aircraft.

**mnemonics**
Underlined letters on a menu indicating that pressing one or more keys can display a pull-down menu from the keyboard or can select a menu option from the pull-down menu.

**MOA**
Stands for military operations area and is a type of Special Use Airspace reserved for military activities.
Modeling
The TSD capability to display the impact of a proposed reroute on the projected state of the NAS.

Monitor Alert
This function displays and enables analysis of the airports, sectors, and fixes on alert status.

Moving FEA/FCA
Shows how the FEA/FCA started and how it moves during the course of the time limit you specified. Contains shadows of the original FEA/FCA representing past and future locations of the FEA/FCA.

MP
Refers to Runway Visual Range from the middle point of the runway. Its values range from 00 to 60+, representing hundreds of feet.

NADIN
Stands for National Airspace Data Interchange.

NAS
Stands for National Airspace System.

NAS Monitor
Displays peak counts and the alert status for NAS elements.

Nav aids
Stands for NA Vigational AIDS, usually fixes at which visual devices, radio beacons, or other electronic devices have been placed to help pilots identify their flight positions.

NCWF
Stands for National Convective Weather Forecast, a weather service that provides one-hour extrapolation forecasts of thunderstorm locations.

nodename
A name of a computer, beginning with two slashes usually followed by a combination of letters and numbers. Typical node names include //fs01, //ws06, and //ETMS10.

no radar symbol
Appears in the upper left corner and in the ARTCC designation if the overlay is on and indicates that no TZ messages have been received from one or more ARTCCs for three successive updates.
**NOWRAD**
The NOWRAD command displays a color-coded graphic overlay of areas of precipitation. The display, updated every five minutes, shows up to six levels of precipitation, ranging from very light to very heavy.

**NRP**
Stands for National Route Program, a flight that files for a more direct route, but is considered to be a preferred route (as designated by the FAA).

**OA_DIF**
Refers to the difference between ARTA and ORTA, with a designator showing the status of the comparison.

**OAG**
Stands for Official Airline Guide and refers to the publisher of the standard airline schedule information. Used as a data source with request commands.

**oceanic sectors**
Volumes of airspace defined for controlling air traffic, beginning three miles offshore and extending further out over the oceans.

**OCTA / OCTD**
Stands for Original Control Time of Arrival and Original Control Time of Departure.

**OD_DIF**
Refers to the difference between ARTD and ORTD, with a designator showing the status of the comparison.

**OETA / OETD**
Stands for Original Estimated Time of Arrival (wheel time) and Original Estimated Time of Departure (wheel time).

**OFF**
Actual time reported by airlines for wheels up.

**OGTA / OGTD**
Stands for Original Gate Time of Arrival and Original Gate Time of Departure. Renamed to ORTA and ORTD.

**ON**
Actual time reported by airlines for arrival on the runway.
**ORIG**
FAA designator showing the airport of origin.

**ORTA / ORTD**
Stands for Original Runway Time of Arrival (formerly OGTA) and Original Runway Time of Departure (formerly OGTD).

**OUT**
Actual time reported by airlines for gate pushback.

**overlay**
A map illustration that can be displayed on the TSD. Because many of these maps can appear on the display at one time without obliterating the others, they are called overlays: you can increase the amount of information on the display by laying another map over the ones you have already displayed.

**pacing airport**
One of approximately 30 larger airports whose arrival and departure traffic sets the pace for all air traffic throughout the CONUS.

**PA_DIF**
Refers to the difference between ARTA and PGTA, with a designator showing the status of the comparison.

**palette**
See color palette.

**pathname**
A pathname identifies not only a file name, but also the name of the directory and node in which the file is stored. For example, the following pathname indicates that the file adaptation is stored in the static_data subdirectory, which is located in the graphic directory on node //ws10://ws10/graphic/static_data/adaptation.

**PD_DIF**
Refers to the difference between ARTD and PGTD, with a designator showing the status of the comparison.

**peak demand**
The greatest number of flights projected to be within a sector at any instant during a given time period. Also called peak load.
**PGTA / PGTD**
Stands for Proposed Gate Time of Arrival and Proposed Gate Time of Departure.

**Playbook**
Categories of plays, displayed on Create Reroute, Edit Reroute, and Copy Reroute dialog boxes.

**POI (Point of Interest)**
A term referring to the location on a reroute segment at which the pointer is browsing.

**POI Count**
The number of flights that will cross a Point of Interest (POI) on a reroute segment.

**POI Timeline**
A POI Timeline displays a single number representing the total number of flights in a reroute that would cross the POI or as a timeline showing the hourly or quarter-hourly flight counts over the POI.

**Pop-up menu**
See Right-click menu.

**PPI**
Stands for Primary Place of Interest, used in some Command Line requests.

**preselect**
Refers to placing the pointer on a map item, such as an airport or navaid, causing that item to become highlighted. If the label is not currently displayed, preselecting also displays the label of the highlighted item. When an item is preselected, clicking the left button selects it, which means that a dotted line is drawn around the item and its label.

**preview**
Found in the Customize Dialog Box. Allows you to view the changes you make to TSD map items before permanently applying these changes to the TSD. If you want to make adjustments, you can then use the Undo button and restore the previous color.

**Preview Mode**
The TSD state of operation when previewing a reroute.

**Preview Reroute**
The capability available in the Create and Edit Reroute commands that allows you to draw a reroute in the TSD map and generate flight counts.
**pri**
Stands for print in an EDCT Sub Print command.

**primary place of interest (PPI)**
Refers to the location(s) specified for the Request Count command.

**prohibited area**
Special Use Airspace in which no flight is allowed.

**projection**
This command allows the user to choose a specific geographic region to appear in an accurate perspective on the TSD.

**prompt**
Character, word, or phrase the computer displays to let you know that it is ready to receive your response or command.

**prop icon**
The representation of a prop aircraft by the illustration of a straight-wing on the TSD. These icons only appear when the automatic icon (A) has been specified for a flight set on the Select Flights dialog box.

**proposed flights**
Flights that have a filed flight plan but have not yet left the ground.

**protected segment**
Used in the definition and monitoring of reroutes and refers to that portion of an assigned route that should be adhered to carefully in order to achieve the goal of the Traffic Management Initiative (TMI).

**quick key command**
A command that can be issued through one or two keystrokes and is usually not interactive.

**QWERTY keyboard**
Name given to a standard typewriter keyboard, whose top line of letter keys reads Q, W, E, R, T, Y, etc.

**radar labels overlay**
A summary of information provided to the TFMS by the Forecast Systems Laboratory (FSL) to show detailed information about precipitation areas.
**radar tops**
Displays the altitude of cloud tops within precipitation areas in hundreds of nautical feet. This information is updated every ten minutes.

**radio button**
A push button that the user clicks to select the item corresponding to that button. Only one button in a group of radio buttons can be selected at any time.

**RAL**
Stands for last reported altitude, as displayed in a data block.

**range rings**
A set of concentric circles, drawn at specified distances from a given location that facilitate the determination of how far flights are from location.

**reconnect**
A command that disconnects from all TFMS and other servers and then connects with the servers. You can use this function to reestablish communication with TFMS services in case a connection is lost and the automatic reconnection is not successful.

**relative time**
Time made relative to the current time by entering a plus sign (+) followed by the number of hours after the current hour. Relative time may be used in commands.

**replay**
A command that lets you display past flight, weather, and alert data. You can specify the amount of time by which the replay clock increases at each update.

**report manager**
A command from the Tools menu that lets you find, view, and manage reports in the reports directory.

**report name icon**
A boxed name given to your report, appearing as an icon in the upper right hand corner of the display. It identifies the directory, the element, time/date, and version number.

**reports**
A function that lets you display a list of reports that have been received during the current TSD session.
**request commands**
Enable you to request reports on specific groups of flights. You define these groups by specifying the elements, report types, times, dates, airlines, flight times, and other criteria you want to include in the report.

**request script file**
A special data file containing specifications to be accessed through the request commands.

**request server**
TFMS process that takes flight list, flight counts, and ARRD report requests and formats them as specified through the request command.

**resize**
A method of changing the size of a window by using the Window Control size option or moving the pointer to any corner of the window and resizing the window.

**restore**
A menu control option that returns the window to its previous size.

**restricted area**
Special Use Airspace through which flight must be authorized.

**Right-click menu**
Once an item is preselected or selected, you can click the right mouse button to access right-click menus, which vary according to the item.

**RMGR**
Stands for Route Manager.

**RO**
Refers to Runway Visual Range from the Rollout point of the runway. Its values range from 00 to 60, representing hundreds of feet.

**route**
Can refer either to an airway or to an individual aircraft's path of flight. If it refers to an individual aircraft's route of flight, it can mean either the written notation of the route or a graphic depiction of the flight path. See also airway, jet airway, victor airway, flight path.

**route text**
The written description of a route, usually as taken from field 10 of a NAS message.
**RRIA**

Stands for Reroute Impact Assessment, a function which allows you to view reroutes and their impact on the NAS in Preview mode and Model mode.

**RTE**

Stands for flight route.

**RVR**

Refers to Runway Visual Range.

**RVSM**

Refers to Reduced Vertical Separation Minimums. RVSM allows controllers to separate properly equipped aircraft in the FL290 and FL410 airspace by as little as 1000 feet vertically, rather than the 2000 foot minimum that is currently required.

**RWY**

Refers to Runway identifier. Its numeric values are from 01 through 36. A sub-runway value might be appended to the RWY. The sub-runways are defined as L (left), R (right), or C (center).

**SA_DIF**

Refers to the difference between ARTA and SGTA, with a designator showing the status of the comparison.

**SD_DIF**

Refers to the difference between ARTD and SGTD, with a designator showing the status of the comparison.

**save**

A function on some TSD dialog boxes that allows you to save selected values to a specified filename.

**schedule database**

Database of airline schedule information based on information received from the Official Airline Guide (OAG). The schedule database is updated with new OAG data every two weeks.

**SCS**

Stands for Slot Credit Substitution, a situation that commonly occurs during GDPs where an operator has a flight f0 with a slot at time t0, and flight f0 cannot use its slot because it is delayed or cancelled. In these situations, SCS provides a mechanism for an operator to
substitute other operator’s flights to bridge the slot from an unusable time to a time that the operator can use to his/her advantage.

**secondary request**
Allows user to use the report name icon to quickly request additional reports with different specifications for the same location specified in the original report.

**sector**
A volume of air space corresponding to one air traffic control area of responsibility. There are many sectors within an ARTCC. Generally, one team of air traffic controllers is responsible for each sector.

**semicolon commands**
A class of interactive commands that usually require you to respond to a series of prompts and give detailed instructions. They are called semicolon commands because you must press the semicolon key in order to tell the TSD you want to issue one of these more detailed commands.

**send secondary**
A menu option that allows you to use information requested in an original report to generate subsequent flight list, flight count, or flight plan reports for the same location.

**SGTA / SGTD**
Stands for Scheduled Gate Time of Arrival / Scheduled Gate Time of Departure.

**SH**
Refers to the Slot Hold Flag.

**SI messages**
Stands for Substitution processing messages received from airlines.

**site**
This command displays the network address sites to which your TSD is currently connected. The sites identified by this command are the groups of nodes that your node uses as the source for various types of data.

**site identifier**
The local site identifier corresponds to a fileserver node at your physical site. (If you have only one fileserver, then your site identifier is always the same.) The hubsite site identifier refers to a specific group of nodes at the hubsite in Cambridge, Massachusetts.
**size**
A menu control option that changes the pointer to a cross icon. You can then place it on a window border and resize by moving the pointer in another direction and clicking and releasing the left mouse button.

**snapshot**
A command that lets you save the TSD screen to a graphic image format (GIF).

**sort option**
Allows user to order a list of flights in a report in alphabetical, numeric, or chronological order under ETA (arrival) and ETD (departure) for each 15-minute interval.

**SPD**
Refers to the ground speed filed in a flight plan.

**special use airspace**
See SUA.

**SPI**
Stands for Secondary Place of Interest, used in some command line requests.

**Stak**
The stak option sets up an initial condition involving a specified number of arrivals held over the airport.

**STAR**
Stands for Standard Terminal Arrival Route.

**STAT**
Refers to flights status.

**streamlines**
A display of the Jet Stream command that indicate the direction of high winds.

**SUA**
Stands for special use airspace and refers to volumes of airspace for which aircraft flight has been limited for one reason or another. They include alert areas, MOAs, prohibited areas, restricted areas, and warning areas.

**Subs**
Data from the EDCT Sub Show command, showing you the status of Substitution processing (SI) for all airports.
**superhigh sectors**
Defined volumes of airspace, which in general, have altitudes greater than 35,000 feet.

**system modal**
Users are unable to interact with any window in any application except the modal window.

**TAF**
Stands for International Aerodrome Forecast, a type of weather report produced through the Report command in the Weather menu.

**TCA**
Stands for terminal control area and refers to a volume of airspace above an airport in which all flights are subject to operating rules and pilot and equipment requirements.

**TD**
Refers to Runway Visual Range at the touchdown point. Values range from 00 to 60+, representing hundreds of feet.

**TDB**
Refers to Traffic Database.

**Tear-off menus**
A feature that enables you to treat menus as separate windows and move them.

**terminals**
Another term for airports.

**TFMS**
Stands for Traffic Flow Management System and is an automated data processing system which supports the FAA traffic management functions. Based on prototype software developed for the Traffic Management Modernization System (TFMMS).

**threshold**
The level of demand at an airport, sector, or fix which, when exceeded by a projected demand, will cause an alert to be indicated. See demand data.

**TIME**
Refers to two columns, ETD and ETA.
**time bar**
An illustration that appears at the bottom of the TSD display when live alerts are displayed. When an alerted element is examined, the time bar indicates which intervals are alerted.

**time interval**
The segments of time for which the monitor/alert projects and displays traffic demands. The default size of the time intervals is currently defined as 15 minutes.

**time interval option**
Allows user to specify a time interval format different from that of the default flight counts report.

**time in sector**
Graphically depicts the flights that cross the sector during a six-hour interval.

**Time Limit**
Governs the interval of time, set between one-quarter of an hour and six hours, for the display of alert icons.

**timeline**
Refers to a graphic display of the total number of flights projected to arrive at, depart from, or traverse the specified alerted element at 15-minute time intervals. The color of the button denotes the status of the alert for that time interval.

**time period option**
Allows user to change the default time period of five hours for reports.

**time range**
Appears in the NAS Monitor dialog box and the corresponding bar chart. (maximum is 6 hours)

**time types**
The time verification report includes four time types for arrivals and departures: scheduled, proposed, original (defined by TFMS traffic model processing without regard to ground delay controls or actual times), and controlled (assigned by ground control program).

**time verification report**
Shows discrepancies between actual arrival and departure times and those predicted by a specified time type.
**title bar**
Displays the name of the dialog box and can be used to drag the dialog box to a different location.

**TMI**
Stands for Traffic Management Initiative.

**TMU**
Stands for Traffic Management Unit. Each ARTCC TMU manages air traffic problems within the range of its center. Each TRACON TMU manages air traffic problems specific to the one or more airports under its control.

**Tool Manager**
The TFMS Tool Manager is the program that displays an icon for each main TFMS function. It allows the user to start an TFMS function by clicking on the appropriate icon.

**top**
A function that establishes the priority order in which flights that meet criteria for more than one flight set are displayed.

**Top-down search**
The act of finding a certain word or other combination of characters by searching from the beginning of the file to the end of the file until it finds the first occurrence of the character combination.

**trace**
See history.

**TRACON**
Stands for Terminal Radar Approach Control facilities. These facilities control arriving and departing flights at a terminal or set of terminals.

**Traffic Management Unit**
See TMU.

**Traffic Model functions**
Sometimes called Total Traffic Management Model (TTM), these functions perform detailed flight modeling and determine traffic demands and alerts based on NAS messages. The functions consist of the Parser, the FDB, and the TDB.
**TRTA / TRTD**
Stands for Gate time of arrival and Gate Time of Departure based on TFMS Total Traffic Model (TTM). Formerly called TGTA and TGTR.

**TSD**
Stands for Traffic Situation Display, the function of the Enhanced Traffic Management System that allows you to communicate with the TFMS databases through a graphic display representing flight positions and NAS elements such as ARTCCs, sectors, and fixes.

**TSTM**
Thunderstorm.

**TT-FCA**
For custom FEA/FCAs, displays the Time To Reach FCA data, which is estimated in minutes.

**TYPE**
Refers to type of control last applied to this flight. Types include GDP, GS, SUB, UPD, FA, COMP, BLKT; or refers to aircraft type (B747, DC10, etc.).

**TZ messages**
Messages transmitted from the ARTCCs, which update the position and speed of each airborne flight every five minutes. Based on the NAS track tables.

**Undo**
Found in the Customize Dialog Box. Allows you to remove or reverse any changes that you make to a map item. This button is available only after you have used the Preview button.

**Universal Coordinated Time**
See UTC.

**unnamed point**
A non-labeled point along an experimental route that when added to the route as a fix will be identified by its longitude/latitude coordinates.

**UPD**
Stands for Update in an EDCT Update command.
**update**
Usually refers to a flight data update, the time at which flight icons disappear from the TSD display and reappear in their newly reported positions.

**USER**
Refers to the User Category (air taxi, cargo, commercial, general aviation, military, and other.)

**UTC**
Stands for Universal Coordinated Time, the time zone used as the basis of worldwide standard time. Formerly called Greenwich Mean Time.

**version**
A command that displays a dialog box showing what version of the TSD you are currently running.

**victor airways**
Pre-defined airways to be used by flights at altitudes below 18,000 feet. Also known as Victor routes.

**void time**
A field in the Create Manual Reroutes dialog box used to designate a time (in four-digit UTC) at which you want the route definition to expire.

**VTstats**
In the Verify Time command this entry produces the summary statistics portion of the Verify Time report.

**warning area**
Special Use Airspace that has been defined as potentially hazardous international airspace.

**weather symbol menu**
Display of weather symbols that depict current weather conditions. Included in this menu are weather, precipitation, and storm symbols that can be used for drawing a weather map.

**wind speed**
Contour lines and numbers identify wind speed in knots. The outermost lines define the areas within which winds aloft have been measured at 70 knots or more. Within these areas contour lines define areas of even higher winds, placed at intervals of 20 knots.

**WSI**
Stands for Weather Services International
**WX**

Refers to a report command that lets you display and print weather information; abbreviation for weather.

**XFS**

Stands for Execution of Flow Strategies, a function that enables the amending of a flight’s route to make it conformant with a reroute. The XFS function lets traffic managers use the TSD to submit route amendments for non-conformant flights to En Route Automation Modernization (ERAM) and provides other features related to monitoring and executing reroutes.
Index

A

Absolute Time Range, 4-235
Accuracy Scores dialog box (CIWS), 4-164
Adapt commands, 4-7
  Change Colors and Fonts command, 4-14
  Delete command, 4-11
  Initialize command, 4-13
  Recall command, 4-7
  Save command, 4-9
Advanced Sort
  Flight List Tab (Reroute), 4-359
  MIT Flight list, 4-414
  POI Flight List, 4-385
  Reroute Monitor, 4-259
Advisory (ADZ) Button, 4-213
ADZ number button, 4-211
Alarms command, 4-79
Alert Time Limit, 4-91
Alerts menu
  Alarms command, 4-79
  Examine Alerts command, 4-75
  Preferences command, 4-134
  Select Alerts command, 4-73
  Show NAS Monitor command, 4-82
  Show/Hide Alerts command, 4-69
Assign to Time Segments
  in Reroute Monitor, 4-235
Assigned Route, Create/Edit Reroute, 4-367
Autosend
  defined, 10-1
  EDCT button, 10-7
  FA button, 10-8
  FADT report, 10-5
  functions, 10-4
  subfiles, 10-5

B

Bar chart
  FEA/FCA, 4-485
  NAS Monitor, 4-116

C

Cancel Reroute Advisory dialog box, 4-224
Cancellation Flight List, 4-225
Cancellation Messages, 4-217
Capture command, 4-517
CCFP
  Legacy weather, 4-183
  Tops overlay (in legacy weather), 4-196
CCFP Forecast (in CIWS), 4-180
Change Colors and Fonts command, 4-14
Characteristics (Create/Edit Reroute), 4-311
CIWS
  Accuracy Scores, 4-164
  CCFP Forecast, 4-180
  Echo Top Tags, 4-175
  Echo Tops Forecast Legend, 4-160
  Echo Tops Legend, 4-159
  Echo Tops Mosaic, 4-157
  Echo Tops Show Topped, 4-158
  Forecast Accuracy Scores, 4-163
  Forecast Contours, 4-167
  Forecast Loop Control, 4-150
  Growth and Decay Trends, 4-172
  Home Airports, 4-163
  Jet Stream, 4-178
  Lightning, 4-177
  PRECIP Forecast, 4-148
  PRECIP Forecast Loop Parameters, 4-148
  PRECIP Standard Mode, 4-144
  PRECIP Winter Mode, 4-146
  Precipitation legend (standard mode), 4-144
  Precipitation Mosaic Colors, 4-155
  Radar Coverage Map, 4-166
  San Juan NOWRAD, 4-147
  Satellite Mosaic, 4-167
  Select Weather dialog box, 4-140
  Storm Motion, 4-173
  Verification Contours, 4-169
  Weather overlays, 4-141
Command Line command, 4-538
  Requests menu, 4-540
  Secondary Request, 4-541
Control Panel
  in Reroute Monitor, 4-231
Copy FEA/FCA, 4-440
Copy Reroute (Select Reroutes), 4-218
Corridor Integrated Weather System, see CIWS
Create FEA/FCA command, 4-442
   Lat/Lon Edit tab, 4-470
   Parameters tab, 4-445
   Preferences tab, 4-473
   Primary Filter tab, 4-459
   Right-click menu, 4-475
   Secondary Filters, 4-462
   Shared Sites tab, 4-468
Create Reroute command, 4-282
Create/Edit MIT, 4-394
   Data block, 4-409
   Destination Filter, 4-398
   FEA/FCA Secondary Filter Panel, 4-405
Create/Edit Reroute
   Assigned Route, 4-367
   Characteristics, 4-311
   Create Public FEA/FCA Reroutes, 4-304
   Destination Segments for Split Routes, 4-319
   File menu, 4-288
   Flight Count, 4-343
   Flight Filters, 4-316
   Flight List tab, Normal mode, 4-320
   Functions menu, 4-291
   Identify Flights based on, 4-305
   My Routes, 4-303
   Playbook, 4-296
   Reroute Definition tab, 4-295
   Route Grids, 4-312
   Route Search, 4-300
Customize Columns
   Dynamic list (FEA/FCA), 4-496
   MIT Flight list, 4-414
   POI Flight list, 4-385
   Reroute Flight List, 4-362
   Reroute Monitor, 4-251
Customize command, 4-63
   Lead Lines specification, 4-66
Customize menu
   NAS Monitor System Summary, 4-88

Customize menu (NAS Monitor), 4-132

D

Data Block Displays (Select Flights), 4-53
Database commands, 4-532
Delete command, 4-11
Delete FEA/FCA, 4-440
Delete Reroute (Select Reoutes), 4-223
Destination Filter
   in Create/Edit MIT, 4-398
Display menu
   Adapt commands, 4-7
   Change Colors and Fonts command, 4-14
   Delete command, 4-11
   Initialize command, 4-13
   Legend command, 4-18
   Minimize command, 4-4
   Quit command, 4-22
   Recall command, 4-7
   Redraw command, 4-17
   RVSM command, 4-19
   Save command, 4-9
   Show/Hide Times command, 4-5
DME (Distance Measurement) command, 4-42
   Lat/Lon Position, 4-43
Draw a Reroute, 4-339
Dynamic list
   Sort Columns, 4-495
Dynamic list (FEA/FCA Timeline), 4-491
Dynamic Projection
   in Projection command, 4-44
Dynamic Sectorization
   in Maps menu, 4-25

E

Echo Top Tags (in CIWS), 4-175
Echo Tops
   Forecast Legend, 4-160
   Legend, 4-159
   Mosaic (CIWS), 4-157
   Mosaic colors, 4-161
   Show Topped, 4-158
Edit FEA/FCA, 4-438
Edit Reroute (Select Reroutes), 4-215
Edit Reroute See Create/Edit Reroute
Email
   Connection status indicator, 9-1
   help, 9-2
   Printing/sending messages, 9-13
   Quick Email, 9-18
   Saving messages, 9-9
   Setup options, 9-4
   summary of features, 9-16
Estimated Departure Clearance Time (EDCT) commands, 4-534
Examine Alerts command, 4-75
   Map On and Map Off Parameters, 4-76
   RVSM, 4-78
   Show/Hide Baseline, 4-77
Examine FEA/FCA
   in Model Mode, 4-424
Examine FEA/FCA command, 4-480
   FEA/FCA Timeline Functions, 4-483

F

FEA/FCA Bar Chart
   in Model Mode, 4-426
   Show/Hide, 4-485
FEA/FCA Entry
   in Reroute Monitor, 4-235
FEA/FCA menu
   Create FEA/FCA command, 4-442
   Examine FEA/FCA command, 4-480
   Preferences command, 4-500
   Recall FEA/FCA File command, 4-477
   Select FEA/FCA command, 4-435
   Show/Hide FEA/FCAs command, 4-433
FEA/FCA Report, 4-490
FEA/FCA right-click menu, 4-475
FEA/FCA Timeline
   Dynamic List, 4-491
   Functions menu, 4-483
   RVSM counts, 4-482
File menu
   Alarms Specification, 4-81
   Basic instructions, 2-3
   Command Line command, 4-540
Create/Edit Reroute, 4-288
Customize Colors and Fonts, 4-16
Dynamic List, 4-495
FEA/FCA Preferences, 4-512
Find Flight, 4-61
MIT Flight list, 4-417
Nas Monitor Preferences, 4-135
POI FLight list, 4-385
Range Rings, 4-32
Reroute Monitor, 4-241
Reroute Preferences, 4-332
Select FEA/FCA, 4-437
Show Map Items, 4-29
View Reroute, 4-222
Find Flight command, 4-60
Flight Count (Create/Edit Reroute), 4-343
Flight filters (Create/Edit Reroute), 4-316
Flight List
   in Reroute Monitor, 4-236
Flight List tab
   Advanced Sort, 4-359
   Normal mode, 4-320
   Preview/Model mode, 4-356
Flight Set Filter, 4-54
Flights menu
   Customize command, 4-63
   Find Flight command, 4-60
   Select Flights command, 4-50
   Show/Hide Flight Count command, 4-59
   Show/Hide Flights command, 4-47
Forecast Accuracy Scores, 4-163
Forecast Contours (CIWS), 4-167
FSM
   Traffic Management Shell (TM Shell), 8-1
Functions menu
   Create/Edit Reroute, 4-291
   Dynamic list (FEA/FCA)
      , 4-496
   FEA/FCA Timeline, 4-483
   MIT Flight list, 4-417
   NAS Monitor, 4-110
   NAS Monitor System Summary, 4-87
   POI Flight list, 4-385
   Range Rings, 4-32
   Reroute Monitor, 4-243
   Select FEA/FCA, 4-438
Select Reroutes, 4-215
Time in Sector, 4-114
View Reroute, 4-222

G
Growth and Decay Trends (in CIWS), 4-172

H
Help
in Email, 9-2
TSD, accessing help, 1-9
Hold/Resume Updates
in Reroute Monitor dialog box, 4-260
Home Airports
in CIWS Forecast Accuracy Scores, 4-163

I
Identify Flights based on (Create/Edit Reroute), 4-305
Info button, 4-211
Initialize command, 4-13
Issue Reroute dialog box, 4-217

J
Jet Stream
in CIWS, 4-178
in Legacy Weather, 4-197

L
Lat/Lon Edit tab, 4-470
Lat/Lon Point command, 4-39
Lat/Lon Position
in DME command, 4-43
Lead Lines specification, 4-66
Legend command, 4-18
Lightning
in CIWS, 4-177
in Legacy Weather, 4-195
Loop Parameters
in CIWS PRECIP Forecast, 4-148

M
Map On and Map Off Parameters, 4-76
Maps menu
DME command, 4-42
Dynamic Projection, 4-44
Dynamic Sectorization, 4-25
Lat/Lon Point command, 4-39
Move/Zoom command, 4-25
Overlays command, 4-35
Projection command, 4-44
Range Rings command, 4-30
Runway Layout command, 4-40
Show Map Item command, 4-27
Miles In Trail (MIT) Restrictions, 4-391
Minimize command, 4-4
MIT data block, 4-409
MIT Flight list, 4-413
Timeline, 4-414
MIT Status button
in Model mode, 4-382
Model mode, 4-369
Disabled TSD Functions, 4-369
Examine FEA/FCA, 4-424
FEA/FCA Bar chart, 4-426
Flight List tab, 4-356
MIT Flight list, 4-413
MIT Restrictions, 4-391
MIT Status button, 4-382
Model Mode indicators, 4-370
NAS Monitor, 4-418
NAS Monitor Bar Chart, 4-422
Notification of TMIs, 4-373
POI Flight List, 4-384
Reroute Analysis tab, 4-374
Restrictions tab, 4-392
Returning to Normal Mode Functioning, 4-417
Right-click menu, 4-351
Select Reroutes command, 4-430
Model Reroute Cancellation, 4-381
Monitor All Reroutes command, 4-228
Monitor Reroute(s) (Select Reroutes), 4-226
Move/Zoom command, 4-25
Dynamic Sectorization, 4-25
My Routes (Create/Edit Reroute), 4-303

N

NAS Monitor
  Bar Chart, 4-116
  colors of alerted elements, 4-78
  Customize menu, 4-132
  Functions menu, 4-110
  in Model Mode, 4-418
  Right-Click menu, 4-99
  RVSM, 4-78, 4-101
  Select Monitored Elements, 4-102, 4-103
  Select Sectors, 4-104
  System Summary, 4-86
  Time In Sector, 4-111

NAS Monitor Bar Chart
  in Model Mode, 4-422

NAS Monitor Control Panel, 4-90

NAS Monitor Functions Menu
  Bar Chart, 4-116
  Show System Summary, 4-110

NAS Monitor Preferences, 4-134

National Convective Weather Forecast (NC-WF)
  in legacy, 4-192

Network Utilities command, 4-522
  Reconnect command, 4-524
  Replay command, 4-525

No Radar symbol (Show/Hide Flights), 4-49

NOWRAD (in Legacy weather), 4-182

O

Overlays command, 4-35

P

Parameters tab
  Create FEA/FCA, 4-445

Playbook
  Create/Edit Reroute, 4-296

POI Flight List, 4-384

POI Timeline
  right-click menu, 4-390

PRECIP Standard Mode, 4-144
PRECIP Winter mode, 4-146

Preference Set (Pref Set) Manager, 7-1

Preference Set Manager
  Advanced Restore, 7-8
  Allocation of Pref Set Workspaces, 7-8
  Delete, 7-15
  Manage Pref Sets, 7-12
  Rename, 7-14
  Restore Preference Set, 7-5
  Save Preference Set, 7-2

Preferences command, 4-134, 4-327

Preferences command (FEA/FCA), 4-500
  Shared Sites tab, 4-511

Preferences tab
  Create FEA/FCA, 4-473

Preview mode, 4-342
  Draw a Reroute, 4-339
  Flight List tab, 4-356
  Right-click menu, 4-351
  TSD display, 4-344

Primary Filter tab (Create FEA/FCA), 4-459

Print command, 4-520

Projection command, 4-44
  Dynamic Projection, 4-44

Protected segments
  in Show/Hide Reroutes command, 4-207

Public FEA/FCA Reroutes, 4-304

Q

Quit command, 4-22

Quitting the TSD, 2-18

R

Radar Coverage Map, 4-166

Range Rings command, 4-30

Recall command, 4-7

Recall FEA/FCA File command, 4-477

Reconnect command, 4-524

Red Hat Linux operating system, 1-1

Redraw command, 4-17

Relative and Absolute Time Range
  in Reroute Monitor, 4-234
Replay command, 4-525
Report Manager command, 4-542
Reroute Advisory text, 4-213
Reroute Analysis tab, 4-374
Reroute Definition tab
   Create/Edit Reroute, 4-295
Reroute Impact Assessment, see RRIA
Reroute menu
   Create Reroute command, 4-282
   Monitor All Reroutes command, 4-228
   Preferences command, 4-327
   Select Reroutes command, 4-209
   Show/Hide Reroutes command, 4-205
Reroute Monitor
   Absolute Time Range, 4-235
   Advanced Sort, 4-259
   Assign Time to Segments, 4-235
   Control Panel, 4-231
   Customize Columns, 4-251
   FEA/FCA Entry, 4-235
   File menu, 4-241
   Flight List, 4-236
   Functions menu, 4-243
   Hold/Resume Updates, 4-260
   Relative and Absolute Time Range, 4-234
   Reroute Flight Filters, 4-247
   Route Prefixes in Flight List, 4-237
   Show/Hide Flights, 4-279
   Timeline, 4-233
   View menu, 4-279
Restore Preference Set, 7-5
Restrictions Tab
   in Model mode, 4-392
Right-click menu
   Basic instructions, 2-7
   Create/FEA/FCA, 4-475
   MIT restriction, 4-412
   NAS Monitor, 4-99
   POI Timeline, 4-390
   Preview and Model mode, 4-351
Route Grids (Create/Edit Reroute), 4-312
Route Manager (RMGR), 11-1
Route Prefixes, 4-368
   Create/Edit Reroute, 4-368
   in Reroute Monitor, 4-237
Route Search
   Create/Edit Reroute, 4-300
RRIA
   Draw a Reroute, 4-339
   MIT Restrictions, 4-391
   Model mode, 4-369
   POI Flight List, 4-384
   Preview mode, 4-342
   Returning to Normal Mode Functioning, 4-417
   TSD in Preview mode, 4-344
   Ungroup route segments, 4-354
Runway Layout command, 4-40
RVR Report command, 4-201
RVSM
   Display options, 4-20
   FEA/FCA Timeline, 4-482
   in NAS Monitor, 4-78, 4-101
   RVSM command, 4-19
S
San Juan NOWRAD
   in CIWS, 4-147
   in Legacy weather, 4-182
Satellite Mosaic, 4-167
Save and Recall Reroutes Parameters, 4-208
Save command (Display menu), 4-9
Save Preference Set, 7-2
Script command, 4-544
Second Filters tab (Create FEA/FCA), 4-462
Secondary filters
   in Create/Edit MIT, 4-405
Select Airports
   in NAS Monitor, 4-105
Select Alerts command, 4-73
Select FEA/FCA command, 4-435
   Copy FEA/FCA, 4-440
   Delete FEA/FCA, 4-440
   Edit FEA/FCA, 4-438
   File menu, 4-437
   Functions menu, 4-438
   Sort By, 4-441
Select Flights command, 4-50
   Data Block Displays, 4-53
   Flight Set Filter, 4-54
Select Monitored Elements, 4-103
   in NAS Monitor, 4-102
Select Reroute command
   ADZ button, 4-213
Select Reroutes command, 4-209, 4-213
   ADZ number button, 4-211
   Copy reroute, 4-218
   Delete Reroute, 4-223
   Edit Reroute, 4-215
   Functions menu, 4-215
   in Model Mode, 4-430
   Info button, 4-211
   Model Reroute Cancellation, 4-227, 4-381
   Monitor Reroute(s), 4-226
   Reroute Information (Info) button, 4-214
   Sort by, 4-227
   View Model, 4-227
   View Reroute, 4-220
Select Sectors
   in NAS Monitor, 4-104
Select Weather command, 4-138
Select Weather dialog box - CIWS Version, 4-140
   Accuracy Scores, 4-164
   CCFP Forecast, 4-180
   CIWS Echo Tops Show Topped, 4-158
   CIWS Forecast Loop Control, 4-150
   CIWS legend standard mode precipitation, 4-144
   CIWS PRECIP Forecast, 4-148
   CIWS PRECIP Mosaic, 4-144
   CIWS PRECIP Standard Mode, 4-144
   CIWS PRECIP winter mode, 4-146
   CIWS weather overlays, 4-141
   CIWS Winter Mode Precipitation Legend, 4-146
   Echo Top Tags, 4-175
   Echo Tops Forecast Legend, 4-160
   Echo Tops Legend, 4-159
   Echo Tops Mosaic, 4-157
   Echo Tops mosaic colors, 4-161
   Forecast Accuracy Scores, 4-163
   Forecast Contours, 4-167
   Growth and Decay Trends, 4-172
   Home Airports, 4-163
   Jet Stream, 4-178
Lightning, 4-177
PRECIP Forecast Loop Parameters, 4-148
Precipitation Mosaic Colors, 4-155
Radar Coverage Map, 4-166
San Juan NOWRAD, 4-147
Satellite Mosaic, 4-167
Storm Motion, 4-173
Verification Contours, 4-169
Select Weather dialog box - Legacy Version, 4-181
   CCFP display, 4-183
   Jet Stream, 4-197
   Lightning, 4-195
   NCWF Display, 4-192
   NOWRAD, 4-182
   Tops overlay, 4-196
Shared Sites tab
   Create FEA/FCA, 4-468
   FEA/FCA Preferences, 4-511
   Reroute modeling, 4-427
Show Map Item command, 4-27
Show NAS Monitor
   Alert Time Limit, 4-91
   Version and Site Info, 4-92
Show NAS Monitor command, 4-82
   NAS Monitor Control Panel, 4-90
   System Summary, 4-86
Show System Summary in NAS Monitor Functions menu, 4-110
Show/Hide Alerts command, 4-69
   Alert Element symbols, 4-72
Show/Hide Baseline in Examine Alerts command, 4-77
Show/Hide FEA/FCA Bar Chart, 4-485
Show/Hide FEA/FCAs command, 4-433
Show/Hide Flight Count command, 4-59
Show/Hide Flights
   Reroute Monitor, 4-279
Show/Hide Flights command, 4-47
Show/Hide Reroutes command, 4-205
   Save and Recall Reroutes Parameters, 4-208
Show/Hide Times command, 4-5
Show/Hide Weather command, 4-137
Show/Hide Reroutes command
   Protected segments, 4-207
Site command, 4-522
Snapshot commands, 4-517
  Capture command, 4-517
  Print command, 4-520
  View command, 4-519
Sort by (FEA/FCA), 4-441
Sort by (Select Reroutes), 4-227
Sort Columns
  Dynamic list, 4-495
Split Routes (Create/Edit Reroute), 4-319
Storm Motion (in CIWS), 4-173
System Summary, 4-86
  Customize menu, 4-88

T

Time in Sector
  Functions menu, 4-114
  in NAS Monitor, 4-111
Timeline
  in Reroute Monitor, 4-233
Times information box, 4-5
TMI warning icon, in Model mode, 4-373
Tools menu commands
  Capture command, 4-517
  Command Line command, 4-538
  Database commands, 4-532
  EDCT commands, 4-534
  Network Utilities command, 4-522
  Print command, 4-520
  Reconnect command, 4-524
  Replay command, 4-525
  Report Manager command, 4-542
  Script command, 4-544
  Site command, 4-522
  Snapshot commands, 4-517
  Version command, 4-548
  View command, 4-519
Tops Overlay (legacy weather), 4-196
Traffic Flow Management System (TFMS)
  Autosend, 10-1
  Email, 9-1
  Reference Manual Conventions, Intro-5
  Route Manager (RMGR), 11-1
  Traffic Management Initiative (TMI), in re-
route modeling, 4-373
Traffic Situation Display (TSD)
  dialog boxes, 2-12
  Help, 1-9
  Managing Workspaces, 1-4
  pull-down menus, 2-2
  Quitting the TSD, 2-18
  Starting the TSD, 2-1
  Terminology, Intro-7
  Workspace Switcher, 1-5
TSD Functions, disabled in Model mode, 4-369
TSD in Preview mode
  in RRIA, 4-344
Turn Green command
  effect on TSD, 4-130

U

Ungroup, Route segments, 4-354

V

Verification Contours (in CIWS), 4-169
Version and Site Info, 4-92
Version command, 4-548
View command, 4-519
View menu
  Create/Edit Reroutes, 4-294
  Reroute Monitor, 4-279
View Model (Select Reroutes), 4-227
View Reroute (Select Reroutes), 4-220
View Reroute Dialog Box, 4-221

W

Weather menu
  RVR Report command, 4-201
  Select Weather command, 4-138
  Show/Hide Weather command, 4-137
  WX Report command, 4-198
WX Report command, 4-198